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Basics
This section describes the basics of Optimizely Campaign to get started.
l

Introduction. Introduction to this document and information about the security functions.

l

Getting started. Learn more about Optimizely Campaign and create a campaign.

l

Logging in. Work with the Optimizely Campaign user interface, including logging in and

out.
o

Start page

o

Lists and folders

l

User management. Set up user accounts and permissions.

l

Roles. Create permission profiles.

l

Clients. Layout of the Optimizely Campaign working environment.

l

Deliverability basics. Information and best practices for a successful deliverability of emails.

l

Exclusive IP addresses. Information on dedicated IP addresses.

l

ISO 27001 certification. Gives you the guarantee that Optimizely's safety management for

l

operation, service and development of email marketing platform complies with internationally recognized standards regarding data and information security.
Service description. Overview of standard functions and upgrade options.

Introduction
Online help describes the features and functionality of the Optimizely Digital Experience
platform and covers Optimizely CMS for content management, Optimizely Commerce for ecommerce functionality, Optimizely Campaign for omnichannel campaigns, Optimizely
Search & Navigation for extended search, Optimizely Visitor Intelligence for visitor profiles
and customer segments, Product and Email Product Recommendations, and Triggered
Messages for personalized product recommendations, and Optimizely add-ons.
You access the online help from within the Optimizely platform or from Optimizely World.
The online help is also available in PDF format for users who prefer PDF or want to print the
documentation.
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This PDF describes the features and functionality of Optimizely Campaign, which you can
find on Optimizely World. Developer guides and technical documentation also are found on
Optimizely World.
The user guide is intended for editors, administrators, marketers and merchandisers, working with tasks as described in Roles and tasks.

Features, licenses and releases
The user documentation is continuously updated and covers the latest releases for the
Optimizely platform.
Optimizely CMS is the core part of the Optimizely platform providing
advanced content creation and publishing features for all types of website content. CMS features are available in all Optimizely installations.
Optimizely Commerce adds complete e-commerce capabilities to the
core functionality in CMS. It requires a specific installation and license.

© Optimizely 2022
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Optimizely Campaign lets you orchestrate omnichannel campaigns from
a single screen, and send triggered emails based on real-time behavior.
Campaign requires additional license activation.
Optimizely Search & Navigation adds advanced search functionality to
websites. It is included in the Optimizely Cloud services; for on-premises
installations it requires a specific installation and license.
Optimizely Visitor Intelligence is a user interface for viewing and filtering
visitor profiles, and creating customer segments that can be used in
omnichannel marketing campaigns. It requires a specific installation and
license.
Product Recommendations lets you create and configure a merchandising campaign with personalized product recommendations from
the personalization portal. It requires a specific installation and license.
Email Product Recommendations lets you include personalized product
recommendations in any email, including cart abandonment and retargeting emails, from the personalization portal. You can also work with
behavioral triggers to detect on-site behaviors and act upon them
through automated, personalized emails. It requires a specific installation and license.
Add-ons extend the Optimizely capabilities with features like advanced
search, multi-variate testing, and social media integration. Some add-ons
are free, others require license activation. Add-ons by Optimizely are
described in the online help.
Note: Due to frequent feature releases, this user guide may describe
functionality that is not yet available on your website. See What's new
to find out in which area and release a specific feature became available.

Images and screenshots
The Optimizely user guide uses images and screenshots to visually guide you through the
features of the Optimizely platform. Due to different versions, continuous updates, and specific system permissions, images and screenshots may differ from the actual appearance.
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Notes
Three types of notes are color marked throughout the user guide: tips, notes and warnings.
Tip: Green indicates tips that might show you an easier way to perform a task.

Note: Yellow indicates important information that may affect your
work and should not be missed.

Warning: Red indicates warnings. If these warnings are ignored, serious errors or problems may occur.

Copyright notice
© Optimizely 1996–2022. All rights reserved.
All information and content within this document is the sole copyright of Optimizely which
includes all companies and affiliates in the Episerver group. Changes to the contents, or
partial copying of the contents, may not be done without permission. The document may
be freely distributed in its entirety, digitally or in printed format, to all users of Optimizely
and Episerver Software. Optimizely assumes no liability or responsibility for any errors or
omissions in the content of this document. Optimizely reserves the right to alter functionality and technical system requirements. ‘Optimizely’ is a registered trademark of
Optimizely Inc. Ektron is a registered trademark of Episerver Inc.

What's new?
This user guide describes functionality available in the latest release of a standard implementation of the Optimizely platform software and services. New features are continuously
made available. See Optimizely updates.
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Note: Due to frequent feature releases, this user guide may describe
functionality that is not yet available to you. Contact your system
administrator for information about products and versions in your
Optimizely implementation.
This release of the Optimizely User Guide describes features available in Optimizely as of
2022-03-14. See release notes (below) for update history. See Archived documentation in
the online version of the user guide for previously released user guides and for older
release notes.

Release notes 2022
Released

Area

Features and updates

2021-10-21

Campaign

You can now create webhooks for the spam
complaint event.

2021-10-15

Campaign

The new topic, Setting up the List-Help
header, has been added.
As part of the rebranding, the images and
attachments feature was redesigned. It is now
complete and includes the option to delete created images and attachments. (update 379)

2021-09-30

Campaign
When creating or editing users, you can now
specify allowed IP addresses and IP ranges
to restrict access to the user account. See
Managing users. (update 379)

2021-09-28

CMS

The Reports view is no longer supported and is
removed. (update 378)

2021-09-28

CMS

The admin view is redesigned. (update 378)

2021-09-28

CMS

Visitor groups user interface is redesigned.
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Released

Area

Features and updates
Criteria previously included in the add-on
Visitor Group Criteria Pack are now
included in Optimizely CMS by default, see
Built-in visitor group criteria. (update 378)

CMS

The dashboard is no longer supported and is
removed. Gadgets are now only installed in the
navigation or assets panes. (update 378)

2021-09-28

Commerce

The Commerce Manager administration system is removed, and replaced with a new
Administration view, from where you can
define markets and warehouses, index catalogs, configure taxes, shipping, and payments,
and work with dictionary properties. (update
378)

2021-09-28

Commerce

A new Customers view replaces the legacy
Customer Management in Commerce Manager. (update 378)

2021-09-28

Some functionality, previously managed from
Commerce Manager, is now managed through
code:
l

l

2021-09-28

Commerce

l

l

Dictionaries. Adding currencies, countries,
and return reasons.
Dictionaries. Adding values for organizations and contacts.
Catalog batch updates and catalog
import/export.
Management of business objects, and
catalog and meta-classes fields.

See Optimizely World for technical details,
and previous versions of the user guide for
the removed legacy functionality. (update
378)
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Released

2021-09-23

Area

Features and updates
Mailings Classic and Reports will be deactivated on 2022-03-01. To migrate your mailings to Smart Campaigns, see Mailings Classic.
To migrate your reports to the Performance
Dashboard and Deep Analytics, see Reports.
(update 377)

Campaign

The current Apple operating system versions
include the Apple Mail Privacy Protection,
which restricts the transmission of tracking
information to Optimizely Campaign. See
Apple Mail Privacy Protection.

Campaign

You can now merge mailing content from different campaigns into a new campaign. See
Merge content. (update 377)

2021-09-02

Campaign

When importing recipients, you can now merge
the contents of recipient list fields of type
"String" and "Text". You can either append or
prepend the content or replace the old content with the new one. (update 376)

2021-08-12

Marketing automation connectors

The configuration settings screen of the
Microsoft Dynamics CRM connector was
updated.

Campaign

The redesigned user interface has been
released. Optimizely Campaign screenshots in
the user guide have been updated. See Start
page.

Marketing automation connectors

The Pardot connector has a breaking change
when you upgrade to version 6. The configuration screen has new fields to create new
connectors. Configurations made with older
versions of the Pardot connector will no longer
work.

2021-09-09

2021-08-02

2021-07-22
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Released

Area

Features and updates

2021-07-20

Campaign

You can now create webhooks for the unsubscribe event. (update 373)

2021-07-13

Email Product Recommendations

New strategy: Recommendations from categories of purchased products (last 365 days)

2021-06-24

Campaign

If you use the coupon system, you can now
optionally create QR codes. You can also use
field functions to generate QR codes that refer
to specific recipient list fields. (update 371)

2021-06-17

Campaign

See Deliverability basics for information about
the BIMI email authentication standard.

2021-06-14

B2B Commerce

Spire roles documented.

2021-06-09

B2B Commerce

Adyen payment gateway plug-in documented.

2021-05-27

Marketing automation connectors

Fields were added to the Acoustic (Silverpop)
Connector setting screen to include database
lists. (update 368)

Campaign

In Deep Analytics, you can use separate groupings for the name and ID of mailings, recipient
lists, and clients. See Groupings. (update 366)

Triggered Messages

A new feature was added to the Targeted Discount daily trigger to enable the trigger to fire
if products were added to a basket but not purchased within the last 30 days.

2021-05-13

2021-04-29

You can now create webhooks for the bounce
event. (update 364)
2021-04-22

Campaign

See Deliverability basics for information
about list bombing and learn how to recognize these cyberattacks and protect yourself.
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Released
2021-04-15

Area
Campaign

Features and updates
See Deliverability basics for a glossary of the
most important terms related to deliverability.
The beta phase of the webhook feature has
been expired. You can now create webhooks
for the sent event and optionally submit the
Basic HTTP Authentication header. You can
also verify and update webhooks via REST API.
See Webhooks. (update 362)

2021-03-31

Campaign

You can now display background images in
grouping paragraphs and sidebars in the
mobile newsletter version. You can also automatically stretch or crop the image to fill the
entire paragraph area. See Grouping paragraph. (update 362)
The beta phase of the A/B tests for transactional mails feature has been expired. This
feature is now available for all users on
request.

2021-03-25

2021-03-25

Visitor Intelligence

Campaign

Visitor Intelligence now comes with a set of
built-in filter definitions. It is also possible to
add time and occurrence filters to segments to
further limit matching profiles. See Creating a
segment based on filter definition. (update 360)

In the Optimizely Campaign start menu under
Scheduled jobs, you can find an overview of
the scheduled jobs configured in your client.
(update 360)
If you use the coupon system, you can generate bar codes based on the values of your
recipient list fields via field functions.

2021-02-18

Campaign

In the Marketing Automation's Advanced node,
you can specify which recipients are passing
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Released

Area

Features and updates
through the Marketing Automation campaign
at which time. You can now define even more
precisely when Optimizely Campaign should
check the criteria. For example, if you set the
interval to Every 2 months, each 1st from 14:00,
Optimizely Campaign checks the criteria on
the first day of every second month at 14:00.
(update 355)

2021-02-04

2021-01-21

Campaign

If you use the recipient list management, you
can now change the field name of recipient list
fields. See Editing recipient list fields. (update
352)

B2B Commerce

The end user documentation for
B2B Commerce and Optimizely PIM has now
been integrated in this user guide. See sections Optimizely B2B Commerce and Optimizely PIM.
Edit and publish blocks in a quick edit view,
which lets you edit relevant block properties
without leaving the current context. (update
350)

2021-01-21

CMS

2021-01-21

Commerce

Customer service representatives can create
notes associated with carts, orders, and sub-
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Released

Area

Features and updates
scriptions (update 349).
l
l

2021-01-21

Personalization
l

2021-01-21

Create reusable email templates
Export CSV data in localized format for the
selected language
Users (with authorization) can change the
currency selection

You can now run A/B tests for transactional
mails to send different variants of a transactional mail and check which variant performs
better.

Campaign

Archived documentation
If your Optimizely implementation is not on the latest version, you can access previous versions of the Optimizely User Guide under Archived documentation in the online version of
the user guide.

Getting started
This topic introduces Optimizely Campaign and describes step-by-step how to set up
Optimizely Campaign, configure the newsletter subscription on your website and create
simple campaigns and mailings.

Setting up Optimizely Campaign
Optimizely Campaign is a service set up by Optimizely. The onboarding setup involves configuring one or more clients, adapted recipient lists, and a feature set depending on your
service contract. Furthermore, your marketeers will get user accounts, including personalized permission setups.
To send emails via Optimizely Campaign using the sender domain of your hosted website
or web shop, see Setting up your domain for Optimizely Campaign on Optimizely World.
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When the setup is done, you can log in to Optimizely Campaign, set up the newsletter subscription and start creating campaigns.

Setting up the newsletter subscription
The newsletter subscription is a fundamental step to attract new mailing recipients for
your campaigns. You create newsletter subscriptions using an opt-in process, where the
recipient consents to receive promotional emails from you.

Opt-in recipient list
To manage recipients who have subscribed via a form on your website, you need an opt-in
recipient list. You can request this recipient list through Optimizely Campaign customer
support or create it yourself using the recipient list management.
If you create the recipient list yourself, select Opt-in as the list type. Assign at least the
Email recipient list field to the recipient list. The more recipient list fields you add and the
more recipient data you collect, the more precisely you can personalize your mailing. For
example, create additional recipient list fields for first name, last name, and salutation.
Note: The assigned recipient list fields must match those in the subscription form.

Opt-in process
The safest and most common opt-in method is the double opt-in method. With this
method, the recipient gives their consent to receive promotional mailings. The recipients
receives an email with a double opt-in link, which they must click as confirmation in order
to be registered for the newsletter. Then the data entered in the subscription form is
added to the recipient list. For more information, see Opt-in.
To create an opt-in process, open the Optimizely Campaign menu and select Campaigns >
Opt-in Processes. The opt-in process must contain the previously created opt-in recipient list and an opt-in email including a double opt-in link. See Opt-in processes.
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Subscription form
Set up a form on your website to gather the website visitor's contact information. For each
input field, there must be a corresponding field in your opt-in recipient list into which the
data is imported. Also, set up error messages if, for example, the email address is not
entered or entered incorrectly.
For more information on designing and implementing subscription forms, see Creating subscription and unsubscribe forms.

Submitting the recipient data
To submit the contact information that your website visitors enter in the subscription form
to the opt-in recipient list, you can use the Optimizely Campaign HTTP API. With the Subscribe operation you add the new recipients to your recipient list, see HTTP API on Optimizely World.
Alternatively, you can also use the Optimizely Campaign REST API operation POST/{clientId}/recipients/{recipientListId}. For this, set up the REST API in your client first, see REST
API on Optimizely World.
Tip: To learn how to set up the REST API request and connect it to
your subscription form, see the blog post Setting up a newsletter subscription via REST API on Optimizely World.

Creating a campaigns
In Optimizely Campaign, a campaign is the structure, relations, and process flow of elements like recipients, email message, and actions like wait or limit. With Smart Campaigns,
you can create and visualize one-shot-campaigns using drag-and-drop functionality.
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Campaign preparations
Usually a campaign is preceded by significant preparations. You need to plan the message,
the target groups, the channels to use, and revenue goals if any. Use the Smart Campaign
feature to visualize the different steps in your campaign. Creating landing pages in Optimizely CMS may also be part of the preparations, as well as preparing associated products, if
you have Optimizely Commerce.
If you use other analytic tools for monitoring campaign performance, KPIs (key performance indicators) for these may need to be configured for the specific campaign.
You can tailor campaign messages for selected target groups, to create a more engaging
experience and increase conversion. Use visitor groups in Optimizely CMS, to personalize
campaign content. With Triggered Messages, you can also configure mailings to trigger on
certain recipient actions.

Campaign basics
Smart Campaigns is a powerful tool for visualizing the campaign flow, and orchestrating

messages, channels and actions. A message can be distributed using multiple channels.
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Email is the most common, but you can also use, for example, SMS and push messages.
These are the fundamentals of a mailing:
l
l
l
l

Recipients. The target group for the campaign message mailing.
Email. The content message with conversion links leading to desired actions.
Campaign. The elements and actions required to distribute the message.
Analytics. The tools to monitor and follow-up on campaign performance.

When working with mailings, it is important to consider best practices regarding deliverability, to ensure high delivery and opening rates for your campaigns.

Campaign process flow
Below is an example procedure when preparing and launching a campaign with Optimizely
Campaign.
1. Recipient data. Define your message audience from recipient lists.
2. Email message. Create the email design and content. Use a copy of an existing mailing,
the Template Kit delivered with Optimizely Campaign or your own layout.
3. Create the campaign using the Smart Campaigns flow visualization. You can update the
campaign as needed, when working with the associated elements.
4. Test mailing. Test and validate email design and content, send out mailing to selected
test recipients.
5. Start campaign. Activate and send the campaign to launch a full sendout on time, monitor statistics, bounces and replies.
6. Analyze result. Evaluate campaign KPIs, visualize click-tracking, and generate reports.
7. Post-launch work. clean-up recipient lists, manage blocklists, and responses.
Many campaign elements can be reused in future campaigns, thereby reducing the
amount of preparation work, and speeding up the creation process.

Example: Email campaign "Fall Fashion Sale"
You have a website with Optimizely CMS and Optimizely Commerce, and want to make
newsletter subscribers aware of our upcoming "Fall Fashion Sale". You have prepared a set
of content, products in Commerce and a landing page in CMS. These associated content
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items have been scheduled to be published just before the email, with links to the landing
page, is sent out.
Create a simple mailing campaign with a recipient list, and an email message. Test the mailing and launch it, and then follow-up on the result.
1. Create the campaign structure.
a. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
In the next window, click Create… and select Empty draft. Confirm by clicking
Apply.
b. Drag and drop the Recipients node into the campaign area, and select the opt-in
recipient list you have previously created for the double opt-in process. This
ensures that only recipients who have subscribed to your newsletter receive the
mailing.

c. The campaign can be of different types depending on channels. To add an email
message, drag and drop an Email node into the campaign area, and give it an intuitive name.
d. Connect both nodes and click Save. Give the campaign an appropriate name and
click Save in the validation dialog box. This will display missing details, if any. As
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long as the validation finds missing details, the campaign will be stored in Incomplete state.
2. Edit the email message.
a. In the campaign area, select edit for the Email node, and click Edit Content….
Select a template in the displayed list, to use for the mailing, and click Next.
b. To modify the sender and subject, click Sender, subject, attachments to the upper
left, update the information in the section to the right, and click Apply.
c. To adapt content (text, images and links), click a paragraph's name and update it in
the right area, then click Apply.
d. To add images via a Text/Image paragraph, select the tab Image and upload the
file. You can also add assigned links. Links in the message will automatically be
included in the default tracking, to follow-up on clicks and page openings when the
campaign has been launched.
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e. You can preview the output using different options in the top menu, for example
Mobile or Online Version.
3. Test the email message prior to launch.
a. The mailing can be tested using predefined test recipients. Click Test Message…,
select a test group, or individual recipients, and click Send Email.
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b. You can also send HTML-only or text versions. Test messages can also be sent from
the message node in the campaign area, or from the Smart Campaigns overview.
4. Launch the campaign.
When all message items are correctly configured, and you are comfortable with the
incoming test emails, you can launch the campaign. Campaigns must be activated
before they can be started. Campaigns with a specified sending time are sent automatically once activated.
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a. Save the campaign, and go to Campaigns > Smart Campaigns.
b. Select the campaign in the list and click Activate. The campaign and all associated
elements will receive the status Activated.
c. To start the campaign, click Start, and Start campaign to confirm. The sending of
the mailing to the associated recipient list starts, and the campaign status changes
to Sending. When completed, the status changes to Sent.
5. Analyze the results.
After sending, you can begin monitoring the campaign to see how many emails were
opened, number of clicks on links, and bounce rates. You can create reports, and visualize links clicked in the email message.
a. Go to Smart Campaigns in the Campaign overview, select the campaign, and click
Analysis to see a result summary including rates for bounces, clicks and opened
emails.
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b. With Deep Analytics you can generate reports with your KPIs. Reports can be created manually or automatically. You can use existing report templates, or create
your own.
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c. You can visualize clicked links as heat maps in the message. The image can be
saved, for inclusion in reports. Select Visual link analysis under Analytics to access
this feature.
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More features
There are many more features in Optimizely Campaign that you can work with to further
extend, automate, and optimize your campaigns. Below are a few examples.
l

l

l

l

l

l
l

Template Kit. Use your corporate design styles and turn these directly into mailings,

without any special knowledge of graphic design or composition.
A/B test. Optimize your message by sending variants of an email, and comparing key figures to determine which one works the best.
Send time optimization. Customize the sending time of your mailing, automated for each
individual recipient, to increase the chances of the email being opened.
Marketing Automation. Create multi-step campaigns with action and event-based mailings
by using the drag and drop graphical interface.
Target groups. Define the recipients of your campaigns by specific rules and conditions,
and personalize the mailing content.
Click profiles. Define recipient groups based on click behavior in previous mailings.
Recipient history. Evaluate the entire timeline of individual recipients, to see which messages you have sent to whom, and in which format.

Logging in and out
This topic describes how to activate your user account, log in to Optimizely Campaign,
reset password and PIN, and log out.

Activating the user account
Note: Before your first login, activate your account by referencing
two emails from Optimizely: an activation email containing your personal activation key and a second confirmation email.
1. Open the activation email and click Activate user account.
2. Enter the activation key provided in the second email, then click Continue.
3. Complete the fields and click Continue.
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4. Create a password and a PIN and click Save.
After you complete the entries, you receive another email asking you to confirm your
activation.
5. In that email, click Confirm activation.
You can now log into Optimizely Campaign at http://www.campaign.episerver.net/.

Logging in
Use the login screen to verify your identity and prevent malware intrusion.
1. Go to www.campaign.episerver.net.
2. Enter your user name and password.
3. Into the row labeled PIN, enter digits of your PIN in the open positions by clicking numbers on the onscreen keyboard.
Note: The virtual keyboard's numbers are in random order.
For example, if your PIN is 123456 and the login screen appears as below, enter 1 into
the first position (from the left) and 3 into the third position. Notice that positions 2
and 4-6 are filled with black dots, indicating you do not need to enter those characters.
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4. Click Log In.
Tip: If your browser or the network from which you are accessing
Optimizely Campaign does not support SSL, contact customer support.
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Tip: If you forget your user name, contact the person at your company from whom you received your login data or Optimizely customer
support.

Resetting password and PIN
If you forget your password or PIN:
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1. Click the Forgot Password or PIN link.
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2. In the Reset Password and PIN dialog box, enter your user name.

3. Under CAPTCHA, enter the four digits using the virtual keyword.
4. Click Submit. Optimizely Campaign sends an reset password email to the email
address associated with the user name.
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5. Go to the inbox of your email account and open the email from Optimizely Campaign.
Note: For security reasons, you will not get an error message if
Optimizely Campaign could not send the reset password email
(for example, if the user name does not exist). Contact customer
support if the email does not reach you.
6. In the email, click the Reset password link.
7. In the Optimizely Campaign Reset Password and Pin dialog box, enter a new password and confirm it in the Repeat New password field.
Note: The password must have at least eight characters and
must contain either a number or a special character (&, @, $, §,...).
8. Click Next.
9. In the Reset Password and Pin dialog box, enter the digits of your current or new PIN
in the blank fields using the virtual keyboard, and confirm it in the fields below.
10. Click Submit.
If the entered passwords match and fulfill the requirements, you will receive a confirmation message. Return to the login screen and enter your user name and the new
password.

Logging out
End each session by clicking Logout to prevent third parties from accessing the system.

Start page
After logging in to Optimizely Campaign, the start page appears showing a dashboard with
information and data on your latest campaigns.
Tip: To customize the diagram display of the dashboard widgets, see
Widget features.
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The top bar lets you navigate Optimizely Campaign and access the profile area. The menu
bar to the left lets you access all available features based on your user account, the package, and your permissions.

Top bar
The top bar lets you navigate Optimizely Campaign.
l

Window chooser.
o
o

The stack icon displays the number of open windows.
The drop-down list lets you choose among open windows.
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Tip: To return to the start page at any time, click the Optimizely
logo in the upper left corner.

Note: Do not use the forward and back buttons in your browser
because any unsaved work may be lost; use the window chooser
to navigate among windows.
l

l

l

Client chooser. A drop-down list lets you choose among clients set for your user account.

Profile area. To open the profile area, click
.
Help. To access the contextual help in the Optimizely User Guide and see further documentation, click

.

Profile area
In the profile area, you can manage your user settings.
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You can make the following settings and changes:
l

Click Back to Classic User Interface to switch to the classic Optimizely Campaign user
interface.
Tip: For documentation of the deprecated Optimizely Campaign
user interface, see Optimizely User Guide 21-3.

l

l
l
l

Click Login Notifications to enable or disable login notifications, which inform you about
login attempts.
Click Change Password to change it. An email confirmation is sent to you.
Click Change PIN to change it. An email confirmation is sent to you.
Click the displayed language to change it to German (Deutsch), English, Dutch (Nederlands), Polish (Polski) or French (Français).
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Warning: Save your work before changing the language.
Unsaved changes are lost if you change the language of Optimizely Campaign.
l

Click Change time zone next to the time zone to change it. The Change Time Zone window opens.
1. Select a region from the Region drop-down list.
2. Select a time zone from the Time Zone drop-down list.
3. Click Change Time Zone.
Note: System time
If the time zone support is not activated in your client, the profile
area shows the system time of the Optimizely data center. This
corresponds to central European time (CET), which may be different from time at your location.
For example, if you are in London (one hour behind CET) and set
a dispatch time of 17:00, then Optimizely Campaign sends the
message at 18:00 your time. On the other hand, if you are in Istanbul (one hour ahead of CET) and set a dispatch time of 17:00,
Optimizely Campaign sends your message at 16:00 your time.
Also, daylight savings time may vary by an additional hour compared to your time zone.
Dates are entered in the format YYYY-MM-DD and correspond to
the ISO 8601 international standard. Example: 15th May 2017 is
displayed as 2017-05-15.

l

Click Logout to end your session.
Warning: Save your work before logging out. Unsaved changes
are lost when you confirm the logout.
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Menu bar
The permanently visible menu bar on the left lists all available Optimizely Campaign features.
Note: Mailings Classic and Reports are not included. You can still
access Mailings Classic and Reports via the classic user interface.

l

Campaigns. Tools for creating campaigns, for example, in Smart Campaigns and Marketing Automation.

l

l

Recipients. Manage your recipients and target groups.
Responses. Manage and act upon direct replies from your recipients, auto-responders, and bounces.

l

Blocklist. Manage recipients who no longer want to receive messages.

l

Analytics. Access reporting tools.

l

Administration. Manage user roles and permissions, your APIs, and field functions.

l

More. Access custom features such as e-commerce integrations and the coupon system.

l

Search. Search for features available in the menu.

l

Help. Access the Optimizely User Guide and see further documentation.

Lists and folders
In many areas of Optimizely Campaign, information is displayed in lists and organized in
folders, such as mailings in Smart Campaigns.
Note: You need permission to display all records of a recipient list,
response list or blocklist; otherwise, only the first 60 records appear.
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All lists in Optimizely Campaign work in the same way. A status bar at the bottom shows
the number of elements on the page, the number of selected elements, and your current
list position (for example, Page 2 of 10).
By default, each page displays up to 20 elements, although this is adjustable. If a list has
more than 20 elements, display other pages by clicking Next (>) and Previous (<) in the
status bar.

Customizing the list view
l

l

l
l

Change column width. Drag the separator between columns to change column width.
Show and hide columns. Click the down arrow
in the upper right corner to determine which columns appear.
Arrange columns. Click a column header and drag the column to the desired position.
Sort elements. Click a column header to change its sorting from ascending to descending
order. Text fields are sorted alphabetically; numeric fields by value, date fields by date.
Tip: If multiple selection is possible in a list and at least one element is selected, you can click Sort by selection
selected elements to the top of the list .

to sort the

Exporting records
To export records from a list to a CSV file, click Download
the destination folder.
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Note: To export recipients, responses, or blocklists, you need appropriate permission.

Opening CSV files with Microsoft Excel
Note: Optimizely Campaign creates CSV files in UTF-8 without BOM.
Microsoft Excel incorrectly interprets the format as ISO-88591.
To correctly open a CSV file in Excel, follow these steps.
1.
2.
3.
4.
5.

Open a blank Excel spreadsheet.
Click the Data tab.
Select Get Data > From File > From Text/CSV.
Select the file downloaded in Export records and click Import.
Set the File Origin to Unicode (UTF-8) and select Semicolon as Delimiter.

6. Click Load.

Updating lists
If several people are making changes to Optimizely Campaign, you can update any list by
clicking the Refresh button on the status bar.

Modifying elements
If you select an element, it is highlighted, indicating that you can edit or delete it.
l

l

l
l

Select multiple elements. You can select multiple list elements if a check box appears
next to each item and in the header.
Add element. Many lists have a button to add elements, for example Create recipient.
Click this button to create a new row. Click a field to enter data. Click Submit when finished. Each new data record is automatically sorted into its correct position.
Edit element. Double click a row to edit it. Click Submit to save changes.
Delete element. Click Delete element to do that.
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Printing lists
To print a list, click the printer icon in the status bar.
Note: To print recipients, responses, or blocklists, you need appropriate permission.

Using folders
In some parts of Optimizely Campaign, such as Smart Campaigns and target groups, a
tree hierarchy appears to the left of a main list. The additional hierarchy lets you organize
elements into folders.
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Drag or double click the separator bar between the two screen areas to show or hide the
folders. If you hide them, the main list occupies the width of the screen.
Initially, the folder area contains only the All folder, a meta folder showing existing elements. You cannot delete the All folder.
Each folder displays the number of elements in it; the number does not include subfolder
elements.
l

Create new folder. Click Add

l

Delete folder. Select the folder and click Delete

l

Rename folder. Select the folder and click Rename
.
Move folder. Select a folder and drag it to the folder to which you want to move it.
Move one or more list elements to a folder. Select an element, click Move selection

l
l

, enter a folder name, and click Submit

.

.

and click the folder to which you want to move it.

Managing users
This topic describes how to set up and manage user accounts, and grant user permissions.
User permissions apply to clients and or sub-clients. You can grant to the same user different permissions for different sub-clients (if sub-clients are being used) via roles. For
example, grant the following permissions:
l
l
l
l
l
l
l
l
l

Create mailings
Edit mailings
Send mailings
Import recipients
Clear recipient lists during import
Export active recipients
Export responses
Export unsubscribers
Export blocklist
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See Managing permissionsin the Optimizely User Guide for more information about how to
manage access rights for other parts of the Optimizely platform.

Managing users by clients
To manage users by clients, open the Optimizely Campaign menu and select Administration > Users. The Manage Users window appears.

Creating users
1. In the Client drop-down list, select the client you want to create a user for.
2. Click Create User….

3. Enter the user's email address (which serves as the user name), language, gender, first
name, last name, and telephone number.
Tip: You can optionally specify allowed IP addresses and IP
ranges to restrict access to the user account.
Enter one or more comma-separated IP addresses. The IP
address must consist of four numbers between 0 and 255 separated by a period. The IP range is limited to a maximum of 65536
different addresses. Example: 1.13.145.255,11.1.0-255.0-255.
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4. Optional: To send an activation email to the user (or to reset a user's password and
PIN), select Send Activation Email. You can also start the activation process manually
in the Manage Users window.
Note: To enable this feature, contact customer support.

5. Click Manage Permissions….
6. In the Assign Roles area, you can assign one or more roles to the user.
Tip: You cannot assign or revoke individual permissions. Create a
new role or contact customer support.

a. In the Available Roles list, on the left side of the screen, click the roles you want to
assign to the user and then click >.
The following roles are available:
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Role

Properties

Administrator

Has all available permissions (except for additional functions) and
can create additional users.

Editor

Standard user including permission to manage recipient lists and
recipient history.

Author

Editor without sending rights.

Assistant Author

Editor without sending, export and import rights.

Report Analyst

Can create and output reports with Deep Analytics. Has no other
permissions.

Interface Programmer

Has access to all relevant areas for working with Optimizely's APIs.

Note: You can only see and assign roles if you have all permissions for this role. You can create your own roles under
Administration > Roles. You cannot assign or revoke roles
that contain permissions that you do not have yourself.
b. In the Assigned Roles list, select the role that you just assigned and, in the Valid
From and Valid To boxes, specify the period during which the role is effective. If
the role is to be assigned for an indefinite period, check the Non-Expiring box.
7. Click Confirm. A summary appears.
8. Click Finish. An overview of the assigned user permissions appears.
Tip: The new user must activate the user account with a personal
activation key. To get the activation key contact customer support.
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Editing users
1. Open the Manage Users window.
2. In the Client drop-down list, select the client whose user you want to edit.
3. Select one or more users and click Manage Permissions….
Note: You can only assign roles when editing multiple users. You
cannot grant or revoke individual permissions.
4. In the Assign Roles area, you can assign one or more roles to the user.
Tip: You cannot assign or revoke individual permissions. Create a
new role or contact customer support.
a. In the Available Roles list, on the left side of the screen, click the roles you want to
assign to the user and then click >.
b. In the Assigned Roles list, select the role that you just assigned and, in the Valid
From and Valid To boxes, specify the period during which the role is effective. If
the role is to be assigned for an indefinite period, check the Non-Expiring box.
5. Click Confirm.
6. Click Finish.

Editing user properties
To edit user properties, such as language, gender, name or telephone number, do the following:
1. In the Client drop-down list, select the client whose user you want to edit.
2. Select a user and click Edit User Properties….
3. Edit the user properties and click Finish.

Managing clients for users
To display the clients for which a specific user is authorized, open the Clients for Users
tab and click the appropriate user in the Users list.
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Tip: To assign a new client to a user, click Assign New Client…. The
Manage Permissions window opens.

To edit an existing client, select one or more client check boxes that you want to assign to
the user.
1. Click Manage Permissions….
2. In the Assign Roles area, you can assign one or more roles to the user.
a. In the Available Roles list, on the left side of the screen, click the role you want to
assign to the user and then click >.
Note: You cannot assign or revoke roles that contain permissions you do not possess yourself.
b. In the Assigned Roles list, select the role that you just assigned and, in the Valid
From and Valid To boxes, specify the period during which the role is effective. If
the role is to be assigned for an indefinite period, check the Non-Expiring box.
3. Click Confirm. A summary appears.
4. Click Finish. A summary appears.
Tip: You cannot assign or revoke individual permissions. Create a
new role. If you require additional permissions for your work with
Optimizely Campaign, or if you need permissions for additional clients or sub-clients, contact an administrator or customer support.
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Managing roles
This topic describes how to manage roles. A role is a permission profile you can assign to
individual users. A role may contain the same permissions as an individual user. Permissions
cannot be inherited, as in user management.
In your client, you can define roles for specific tasks or projects to simplify the process of
managing individual users. After defining a role, you can assign it to a user permanently or
for a specified period of time, for example, for holiday replacements or temporary users.
Note: Permissions in roles do not apply if
l
l

l

A permission is explicitly revoked from the user.
A main permission is explicitly revoked from the user, and this is inherited to
the sub-permissions.
A main permission, that is inherited to the current client, is explicitly
revoked from the user in a main client.

To manage roles, open the Optimizely Campaign menu and select Administration > Roles.

Creating roles
Tip: If you create roles in a client with sub-clients, these roles automatically apply to the sub-clients.
1. In the Roles window, click Create….
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2. In the Role Name field, enter a name for the role.
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3. In the Permissions area, click the permission you want to assign to this role.
Tip: You can only assign permissions, not revoke them. In other
words, roles contain only positive permissions.
4. Click Create.

Editing roles
Note: If you change a role that is assigned to one or more users, the
change immediately affects those users.
1. In the Manage Roles window, select a role and click Edit….
2. In the Permissions area, click the permission you want to assign to this role.
Tip: You can only assign permissions, not revoke them. In other
words, roles contain only positive permissions.
3. Click Save.

Deleting roles
Note: You can delete a role only if no users are assigned to it. To see
how a role is being used, click Show Usages.
1. In the Manage Roles window, select a role and click Delete. A confirmation window
opens.
2. Click OK.

Showing usages
In the Manage Roles window, select a role and click Show Usages. The Role Usage window opens, displaying a list of users who are assigned this role.
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Tip: You can also use this window to edit a user's permissions. To do
so, select a user and click Edit User Permissions…. Next, follow the
steps described in Users.

Clients
A client is the working environment of Optimizely Campaign; a stand-alone and closed system that organizes your mailings. You can use one or more clients.

Client hierarchy
When using multiple clients, you can assign each to a different tier or organize them hierarchically.

Coordinated clients
If you set up multiple clients on a single tier, you should create a main client for rights management purposes. This setup lets you centrally control user access rights to clients.
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Subordinated clients
You can organize clients hierarchically. Each client inherits access rights and any blocklist
from its parent clients.

Single versus multiple clients
Each user has client-wide permissions, which enable the user to view and edit the client's
mailings and recipient lists.
If you publish several newsletters and different editors work on them, create different clients so that editors can only change content for which they are responsible.
The following tables list the advantages and disadvantages of working with single versus
multiple clients.
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User
Theme

Single client

Multiple clients

User

If you manage several brands in a single client,
a user working on one brand can access mailings for other brands within the client.

If you manage each brand in a different client, users working on a
brand only see its mailings.

User rights

Apply to entire client. Depending on the scenario, you can allow or prevent access to recipient lists or mailings.

Inherited by sub-clients. To define
user rights separately for each
user, contact customer support.

Recipients
Theme

Single client

Multiple clients

Recipient lists

You can send different newsletters using different recipient lists. For example, a recipient list
can represent a brand, country, or business unit.

The possibilities increase
accordingly with multiple
clients.

Blocklists

Blocklist entries apply to an entire client. This
functionality cannot be changed.

Blocklist entries are inherited by, and apply to, subclients. This functionality
cannot be changed.

Subscription cancellations

Subscription cancellations apply to the entire client. To adjust this functionality so that cancellations only apply to the recipient lists
concerned, contact customer support.

Cancellations generally
apply to individual clients.

Bounces

Recipients that exceed the bounce limit are
removed from future sending attempts for the
entire client. This functionality cannot be
changed.

Also applies if multiple clients are in use.
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Domain
Theme

Sending
domain

Tracking
domain

Single client

Multiple clients

You can use only one sending domain in a client by default
(for example, @example.de). To modify this functionality to
use many sending domains (with a tracking domain), contact
customer support.

Each client can use
its own domain
with a respective
tracking domain.

In principle, you can only use one tracking domain per client.
This functionality cannot be changed.

You can use an
additional tracking
domain for each
additional client.

Mailing
Theme

Single client

Multiple clients

Field functions

Field functions can
be used by default.

Field functions can be inherited by sub-clients by default.
To adapt each field function separately, contact customer
support.

Deep Analytics

You can create
reports from within
a client.

You can create reports from within a master client for subclients.

Client setup
The client setup includes the following tasks and topics:
l
l
l
l
l

Recipient lists
Users
Templates
Field functions
Report templates
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l
l
l
l
l
l
l
l

Bounce handling
Dispatch domain
Opt-in processes
Unsubscribe link
Web forms
API (application programming interface) access
Post-click tracking
...customizations and add-ons

For each new client, Optimizely runs a mandatory, random check of recipient records. The
dispatch is only enabled after this check, but you can use other client functions before the
check is finished.

Setting up sub-clients and additional clients
If you have a Optimizely Campaign client and want to set up another client (or sub-client),
contact customer support to discuss which settings can be inherited or copied from the
existing client to speed up the process.

Deliverability basics
This section provides basic information and best practices for a successful deliverability.
Email can be personalized, automated, tested, measured and more. Email marketing is still
one of the most effective options to marketers, especially when they tap into the best practices for enhancing deliverability.

Delivery vs. deliverability
Email delivery refers to the successful delivery of an email to the receiving server.
Email deliverability refers to the ability to deliver email to the intended recipient’s inbox.
It’s possible to have good delivery but poor inbox placement, because the email lands in
the spam folder rather than the inbox.
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Key figures of deliverability
An email is bounced when the receiving server, mostly the ISP (internet service provider),
rejects it. Based on the error message the receiving server sends back, the rejection can
either be a soft bounce, which is a temporary error, such as mailbox full, spam related, or
time out; or a hard bounce, which is a permanent error, such as the email address is no
longer valid.
Optimizely Campaign has an overall delivery rate of 99.8%. Without knowing what percentage of emails arrives in the inbox and what percentage in the spam folder, Optimizely
can make inferences by analyzing key metrics for the emails.
The following measures give marketers insight about the reaction and engagement of their
audience.
l

Bounce rate

=

Bounces
------------------------Number of sent emails

x 100%

Tip: Depending on the business model, it is recommend to keep
the bounce rate under 3%.
l

Open rate

=

l

Number of opened emails
------------------------------Number of delivered emails

x 100%

Unsubscribe rate

=

Number of unsubscribes
------------------------------Number of delivered emails

x 100%

Tip: Generally, an unsubscribe rate below 0.5% is good for an
email campaign.
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l

Click-trough rate

=

Number of click-throughs
------------------------------Number of delivered emails

x 100%

An email click-through is defined as the number of recipients who click links in an
email and land on the sender's website, blog, or other desired destination.
l

l

Spam complaints: Reports made by email recipients against emails they do not want in
their inbox.
Spam trap hits
o

Recycled spam traps are email addresses that were used by a person and then abandoned. Typically, if an email address has been dormant for the last year, many ISPs convert it into a spam trap.
Sending to recycled spam traps shows that you have poor list hygiene, or you are
not removing unengaged users.

o

Pristine spam traps are set up by ISPs and anti-spam organizations in order to
catch spammers. No one should be sending email to those addresses.

Marketing opt-in
There is a big difference between having a list of email addresses and having permission to
email to that list. There are three types of permissions:
1. Single Opt-in (SOI): the interested party leaves his email address in a form, which is
considered explicit consent to receive email newsletters regularly.
2. Confirmed Opt-in (COI): after a single opt-in, an email is sent to subscriber’s email
address as confirmation of the registration.
3. Double Opt-in (DOI): after single opt-in, an email with a confirmation link is sent. To
complete the subscription process, the subscriber must verify the registration by clicking the link.
Sending email to non-permission-based lists results in high bounce rates, low open rates,
high unsubscribe rates, high spam complaints and high spam trap hits, all of which indicate
an unsuccessful email.
For more information on the opt-in method, see Opt-in.
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Sender reputation
Having the ideal ratio of text to images, considering the placement of the content elements, using an eye-catching font, personalizing the content for the target audience, and
selecting the optimum sending frequency are all key factors in a successful email.
However, all that effort is wasted if the intended audience never opens the email because
it does not reach their inbox.
Filtering mechanisms are becoming increasingly sophisticated in determining if an email is
important, junk or spam. Some check the content, while others focus on the recipients’
engagement. However, from an ISP’s perspective, the sender’s reputation plays a greater
role in the analysis.
Here are typical factors that determine a sender’s reputation:
l
l
l
l
l
l
l
l
l

Total number of emails sent
Number of emails sent to invalid email addresses
Number of recipients who mark the emails as spam
Domain from which the emails are sent
Whether this domain has authentication records
IP address from which the emails are sent
whether the IP address is blocked anywhere
whether the IP address is dedicated
whether the IP address has authentication records

Email authentication
Authentication allows the mailbox provider to confirm that the sender is the one who he
pretends to be. There are four primary methods of authentication:
1. Reverse DNS, which implies determining which host and domain name belong to a
given IP address. If a Reverse DNS Lookup returns a no domain associated, the email
will likely bounce to the sender, or be deleted or filtered. This entry is set by default on
the Optimizely sending infrastructure.
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2. SPF is Sender Policy Framework, which states which IPs are authorized to send on
behalf of the "From" domain. SPF allows the receiver's host to verify that the email is
being sent from the server it asserts it is sent from.
3. DKIM is Domain Keys Identified Mail. The recipient uses this to determine that the message has not been altered in transmission. The public and private keys must match to
ensure that nothing happened to the message in transit.
4. DMARC is Domain-Based Message Authentication, Reporting, and Conformance.
DMARC ensures that the legitimate email is properly authenticating against established DKIM and SPF standards, and that fraudulent activity appearing to come from
domains under the organization’s control (active sending domains, non-sending
domains, and defensively registered domains) is blocked.

List management and hygiene
Marketers must ensure their emails are sent to an interested audience and, at the same
time, care about the audience experience.
It’s important to nurture new subscribers and make them feel welcome, while also rewarding active subscribers and maintaining their interest.
It’s also important to regularly check in with less active subscribers and give them the
opportunity to re-engage or opt out. If left unchecked, the number of inactive people will
grow. Continuing to send emails to them will negatively affect the sender’s reputation and
impact deliverability, even to active subscribers.
So, the best way to segment the recipient list is by engagement level.
l
l
l
l
l

Sending to highly engaged recipients frequently, even on a daily base.
Sending less frequently to less engaged recipients.
Using reactivation campaigns to recipients who have not been engaged for 3-6 months.
Blocklisting recipients who complained that the email was spam.
Deactivating recipients who did not engage within a certain amount of time (1 year, 20
months and so on). Do this once a year.

Constantly monitoring the activity and engagement level of subscribers allows marketers
to better understand what the subscriber wants and tailor emails to cater to their needs.
For more information and best practices, see:
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l
l
l
l
l
l
l
l
l
l
l
l

Deliverability best practices
Email content best practices
Sender reputation guide
CSA guidelines
IP warming
Email authentication and encryption
Blocklists and blocklisting
SMTP codes and error messages
DMARC implementation
List bombing
BIMI piloting
Deliverability glossary

Deliverability best practices
Good deliverability is no coincidence. High delivery and open rates are mainly a result of
the general email marketing strategy and the associated adherence to industry best practices. After all, what is the point of fancy features if the email is not delivered and the recipient never sees it? The following is an overview of best practices as represented by
internet service providers (ISPs) and valid in the email sector.

Clean contact acquisition process
Use contacts who actively signed up to receive your promotional mailings. This is legally
required and provides the best delivery rates, as you would expect the best user engagement from them.
Avoid recipient sources such as purchased lists, lead generation, or affiliate marketing partners, as the quality of contacts is often poor, legally non-compliant, and negatively
impacted by lack of concrete opt-ins and questionable acquisition methods.
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Clear expectations from the beginning
l

l
l

At the time of collecting his email address, is the recipient aware of what kind of commercial emails you will send?
Lack of clarity can lead to poor open rates and spam complaints.
Let the recipient actively manage preferences and desired frequency, for example by
means of a preference center.

Double opt-In
A double opt-in process is the only way to protect your database from unauthorized thirdparty registrations, as recipients are actively verified by clicking the activation link in their
email account. Spam traps can be prevented from being introduced into the database as
no confirmation click is expected from them. Storage and documentation of the complete
registration data as required by the GDPR (general data protection regulation) legislation
can only be guaranteed by a double opt-in process.

For more information on the double opt-in process and how to implement it with Optimizely Campaign, see Opt-in.
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Registration forms with Captcha
Captcha is the best way to protect your registration forms against misuse. Especially in the
age of bot and list bombing attacks, it has become indispensable. Integrating a Captcha
protects your database from malicious addresses and the systems involved against DDOS
attacks.
Your recipients attach great importance to data protection and will understand this as a
confidence-building security measure.

User-friendly unsubscription process
An easy-to-find unsubscribe link should be present in every commercial email. A recipient's opt-out request of should be respected. You should allow the unsubscription from
any marketing communication through a maximum of two clicks: on the link itself and, if
necessary, a second time in a preference center.
Refrain from requesting additional logins or sending unsubscribe confirmation emails, as
these may lead to frustration and spam complaints.
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List hygiene
l

l

l

Each contact should be sent to at least once every 6 months to sustainably clean up the
database and avoid a high number of hard bounces.
Exclude recipients who were not active in the newsletter in the last 12 months from regular
mailings. These email accounts might be converted into spam traps by the ISPs after that
amount of time.
Legacy data often results in low open rates and, related to that, a loss of good deliverability performance.

Focus on engaged recipients
Your email marketing activities should focus on your active recipients because they are
responsible for good open and delivery rates, and also form the basis of your revenue generation. These include contacts who were recently active in your emails, on your website
and other channels; recipients who opened and clicked several times; and users who
browsed your website and bought products from your shop. Only they should receive
email from you regularly.

Exclude and reactivate inactive users
Exclude from the regular newsletter contacts who do not open for a long period of time.
Lack of feedback leads ISPs to believe that your emails are uninteresting or even unintentional to the major part of your recipients, and they may punish you with spam folder
delivery.
Inactive recipients, however, may occasionally be sent to with winback campaigns.
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Relevant content through segmentation and personalization
l

l

l

l

Take advantage of Optimizely Campaign's segment feature and work with as many target
groups as possible.
You can generally apply filtering to many areas, such as user engagement, regions,
interests, purchased products and age groups.
Do not only send the same mailings exclusively to the complete database. Variation leads
to more relevant content and thus better email performance KPIs.
Irrelevant content causes poor open rates, unsubscriptions, and spam complaints in the
long term.

Transparent mailing content
Your emails aim to build a relationship of trust with your brand. Therefore, they should contain an unsubscribe link, a link to the privacy policy, and a full legal imprint.
Email content should look trustworthy not only to the recipient but also to the ISP and its
spam filter. Therefore, make sure your emails are not empty, do not contain any phishinglike links, and that you have an appropriate HTML / text ratio and identical HTML and text
versions.
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Tip: To learn how email content affects your email deliverability and
how you can improve your content strategy, see Email content best
practices.

Adequate frequency
Adjust the sending frequency to your business model, but do not overwhelm your recipients. Bombarding recipients with emails can lead to high levels of spam complaints, unsubscriptions, and public complaints in anti-spam forums, which have a negative impact on
your sender reputation and deliverability.
Be clear about how often your newsletter will be sent, comply with it, and give your recipients the opportunity to adjust frequency according to their needs.

Stable sending volume
Heavily changing sending volume is a typical characteristic of spammers. Since the emails
of ordinary senders might be also misclassified in such cases, avoid large irregularities of
the volume sent. If you need to send much larger quantities of emails due to seasonal
requirements, a slow and steady increase is recommended.
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Email content best practices
Creating good email content increases the general success of the ability to maintain good
inbox placement. ISPs (internet service providers) protect their users by using spam content filters, which work by analyzing a message before it is sent to the recipient’s inbox.
Spam filters are used by ISPs to score incoming messages based on algorithms that find
thousands of characteristics, misspellings, the similarity of words that occasionally show
up within the spam folder. Legitimate emails can end up into the spam folder if their messaging contains any similar characteristics or commonly used tactics by spammers.
Refining your content to industry standards will allow you to stand a more robust chance
of reaching the inbox.
This topic describes how content affects your email deliverability and provides insights
into how you can improve your content strategy. Following some best practices can facilitate a successful email campaign, some smart rules include:

HTML syntax errors
Using out-of-date or invalid code will influence if your emails are accepted by domains like
Hotmail, Gmail and AOL are blocked or delivered to the spam folders.
Your finished email might render well among these ISPs but if the hypertext mark-up language email doesn’t comply with W3C standards (World Wide Web Consortium) you may
find deliverability problems. HTML syntax and formatting errors are common tricks spammers use to get past content filters.

Text image ratio
ISPs often block emails that contain only images as a means to fight against spam. Image
only emails have been known to have higher abuse complaints, higher bounces, lower
email engagement. The most common used guideline is no more than 40% image and a minimum of 60% text.
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Unsubscribe link
Including an unsubscribe link within your email is a fundamental rule for email marketing.
The unsubscribe link should be clearly visible, with a one or two click process, allowing the
recipient to remove themselves from the database instantly. If a recipient is unable to find
your unsubscribe link, they are more likely to click the “this is spam” button, which can lead
a mark being left on your sender reputation.

Privacy policy page and imprint URL
A privacy policy is a legal requirement for all websites that collect or use personal information from users. Adding a privacy policy link to the intended recipient destination shows
ISPs that you are a sender that complies with regulatory guidelines.
Adding an imprint to your email template maintains transparency, it is recommended to
include name of the authorized sender, email address, phone number, postal address and
business registration number to the footer of your emails.

Attachments
Adding email attachments as a bulk sender are prohibited, doing so will flag your emails as
spam. Attachments are often used to hide malware and viruses. ISP tend to block emails
containing attachments to protect recipients and infrastructure.
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Avoid spammy words and phrases
ISPs have become smarter about how they distinguish a spam email from a legitimate
email by scanning spam words and phrases. As an email marketer doing adequate testing
before a send and removing common spam words from your copy such as Click here! or
Free can assist in better inbox placement. A good way of knowing what to exclude is to
review the content within your personal spam folder.
An example of spammy content include:

l

Excessive use of exclamation points
Dear Friend
Order Now, Risk-Free
Discount
Offer
Sale, Buy, Free, Cheap
Keep the following signs to a minimum: ?, %, $
Exclude the use of ALL CAPS

l

The use of bright red/green colored fonts

l
l
l
l
l
l
l

Link shorteners
Link shorteners are appealing since they make your links more manageable, but in reality,
using such tools increases the chance of your emails being flagged as spam. The reason
behind this is that link shorteners mask your destination URL, this technique is often used
by spammers to prevent recipients and the ISPs from knowing your actual website domain.

Avoid mismatched URLs
Mismatched URLs are a clear sign of a phishing attempt, avoid looking like a phisher by
removing unintentionally mismatched URLs. This occurs when the link text is a URL and
does not match the URL in the link HREF that the recipient is directed to.
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Remove blocked URLs
Domains listed on blocklists should not be used. If it is a client’s domain, then the client
should investigate with his domain host. If it is a third-party domain the client links to (for
example tumblr.com), it should not be used anymore due to a bad reputation.

Plain text version
There are many good reasons to include a text version of an email, in the event that HTML
version is not accepted or cannot be rendered, the message will still be able to be displayed in text format. Text versions should be identical with the HTML version in terms text
content and links.

Domain alignment
All domains that you use for sending, tracking or in e-mail content should be aligned. You
can set up the alignment in relaxed or strict mode. Both modes are accepted throughout
the industry and prevent emails from being classified as spam or phishing attempts by
spam filters and at the same time create more trust on the recipient side.
With relaxed domain alignment, the domains used must be the same, at least at the organizational domain level. Example for relaxed domain alignment:
Visible sender
domain

Technical return
path domain

Tracking/image domain

Domain in email content

example.com

mail.example.com

tracking.example.com

shop.example.com

With strict domain alignment, the domains must also be aligned at the subdomain level.
Example for strict domain alignment:
Visible sender
domain

Technical return path
domain

Tracking/image
domain

Domain in email content

mail.example.com

mail.example.com

mail.example.com

mail.example.com
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Using similar but not exactly the same domains, such as mail-example.com or
exampleshop.de, is strongly discouraged. For a spam filter, these give the impression that
they are part of a spamming or phishing campaign and can have a negative effect on delivery.

Bad content creates low engagement
The messaging within your emails also has an influence on your inbox placement, it is
essential to ensure that you are sending email content that your recipients want to read.
ISPs will analyze how engaged your recipients are by looking at opens, clicks, bounce
rates, unsubscribes, and spam complaints. Low performing emails are usually sent to the
spam folder. Good practices to keep your recipients engaged include providing personalizing content based on your recipient’s needs, adding CTA (call-to-action) points,
keeping subject lines short, content messaging less salesy, segments, personalization, and
dynamic content.
A/B testing is an important technique that can help you understand, how your recipients
respond to different content, and which campaigns are most effective with engagement
metrics. See A/B test (Optimizely Campaign) and A/B testing in the Optimizely CMS
section.

Other recommendations
l

l
l

l

An email message size should be less than 200 KB in general. Redundant code, increased
image sizes, template height /width can influence the overall size of your email. (Email size
to Gmail should be a maximum of 102 KB.)
The subject line should have a maximum length of 50-60 characters.
Add a comment to your emails, requesting your recipients to add your email address to
their safe senders list.
Remove any iframes from your templates.

In conclusion, we have seen that content influences not only the value to your recipients,
but following the above tips, improves your ability to gain better inbox placement and a
better performing sender reputation as ISPs start to trust you as a bulk sender.
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Sender reputation guide
Keeping your reputation is the most important part of sending emails. As a sender, you
want to gain high performance and inbox placement. Sender reputation is how ISPs measure the trustworthiness of a senders IP or domain, by analyzing a variety of metrics. ISPs
use sender reputation to determine whether an email should be accepted via inbox and
spam filter placement.
This topic describes how to achieve and keep up a good sender reputation. Before moving
on, it is of help to understand the basics of email and spam filtering.

Email filtering and spam filter systems
Email filtering is a technique to filter a server's inbound and outbound email traffic. This
technique is used by ISPs and organizations such as your internal IT department to filter
and scan messages sent to their recipients. The spam filter systems have a various amount
of classifications for incoming mail. Some include virus, adult content or spam, among others.
Most spam filter systems have the ability to perform the following:
l

l

l

l

Allow or decline incoming mails based on history of IP sending analysis, engagement activity and Realtime Blocklist listings.
Allow or decline emails coming from IPs that have/have not been allowed. The majority of
ISPs no longer support IP allowlisting.
Antivirus support to prevent mailings from entering the recipient’s inbox that have malicious code/attachments.
Allow or decline emails based on content analysis. These systems use their own internal
algorithms to block mailings based on words used, attachments sent or HTML syntax concerns to name a few. For more information on how to avoid content flaws, see Email content best practices.

Developing a sender reputation
Reputation is primarily based on your businesses sending behavior, and how your recipients engage with your email. Think of it like having a credit: if you do not follow the best
practices, for example paying on time and keeping low debts, this will negatively impact
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your credit score, leaving you unable to gain certain financial benefits. In the same way,
ISPs will rate you based on your sending behavior.

Email service providers and email filtering systems work together to monitor sending of
unwanted email in order to reduce email spam.

Your data is an important part of your reputation and the way you attained your marketing
list is one of the main factors that can affect your sending reputation. If you are sending to
a list with inactive email addresses (for example closed email accounts, typo addresses,
spam traps) you will experience future reputation issues.
It is essential to always send a double opt-in confirmation email before sending to a list,
where there is a high possibility of inactive addresses. Marketers with a good data list will
see good sender reputation and inbox placement, and those with poor reputation will
often see emails entering the spam folder or blocked entirely.

Factors that affect your sender reputation
l
l
l

High abuse complaints
Recipient engagement, opens, click-through rates performance
Recipient list quality, including spam traps and unknown users
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l
l
l
l
l
l
l
l
l
l
l
l

Infrastructure and authentication (SPF, DKIM, DMARC)
Content
High unsubscribe rates
Sending history
Engagement
IP permanence
Inconsistencies in the volume of emails sent
Number of recipients that mark your emails as spam
Times you have hit spam traps
Blocklisting of your IP/Domain
Number of bounces you receive
ISPs track engagement, low opens, reply to emails, forwards, as well as high deletes and
unsubscribes

Tips for achieving good sender reputation
ISPs' main goal is to protect their users from malicious content and to accept only emails
that a recipient really wants to read and engage in.
Follow these tips to achieve a good sender reputation:
l

l

l

l

l

l

Send a welcome email to start off, a series of emails to gather an insight into your recipient’s engagement behavior.
As months pass, keep an eye on recipients who have not opened your emails yet, occasionally removing them from your recipient list.
Ensure you are targeting your users based on information and content they would like to
receive, using targeting and marketing segmentation techniques.
Review your list hygiene process, implement form verification tools such as CAPTCHA and
form validation through API. Ensure your data has been attained through a permissionbased process such as DOI and stay away from third party or bought lists.
If a recipient keeps receiving an email each day from the same sender, they will end up
unsubscribing, or making a complaint. Consistency is important, review the frequency of
your emails, limiting recipients from receiving no more than 1-2 emails per week.
Send emails based on recipient engagement: Low engagement impacts your reputation.
Ensure you are sending to recipients with high opens and click rates.
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Maintaining your reputation means continuously taking a proactive step to follow best
practices. If in doubt of a marketing list, avoid to send to that data. The result from a bad
send could either have a negative effect on your delivery immediately or later down the
line.

CSA guidelines
Optimizely is a partner of the Certified Senders Alliance (CSA) and takes part in their allowlisting program, which complies with GDPR (general data protection regulation) and
ensures legal conformity of the sender's email marketing processes. CSA allowlisting offers
preferred delivery and better inbox placement at participating Internet Service Providers.
Participation in the program involves technical and legal standards that are decisive pillars
of the program, which must be fulfilled by each sender. The following sections provide an
overview of the CSA’s legal standards and how to implement them.

Opt-in requirements
Newsletters based on GDPR article 6
Generally, marketing emails that contain any type of advertising and aim at a sale need the
recipient's consent. Double opt-in (DOI) is a requirement for Optimizely Campaign to comply with GDPR and CSA documentation requirements because it is the only procedure that
grants traceability to ensure that only authorized user can subscribe.

Product recommendations based on EU directive 2002/58/EC (41)
Alternatively, recommendations about similar products and services may be sent to customers who made a purchase without their explicit consent. However, because this type of
email is usually a source of spam complaints, stricter formal requirements apply.
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Newsletter registration form requisites
Must haves
l
l
l
l

l
l

Consent must be given actively; pre-checked check boxes are not allowed.
Consent must not be coupled with subscriptions to other services.
It must be clear from whom the subscriber is going to receive what content.
A remark indicating that unsubscription is possible at any time and by which methods, at
least an Unsubscribe link and email address, must be clearly visible when the email
address is collected.
A maximum of 10 third parties, including sponsors, must be explicitly named.
The email address is the only mandatory field; all other fields must be optional. (This refers
to pure newsletter registration forms only; account registration or checkout forms may
have more mandatory fields.)

Nice to haves
l
l

A link to the privacy policy in every contact acquisition form.
The recipient should be informed about the newsletter frequency.
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Newsletter content
l

l

A full legal imprint needs to be in the email footer including: physical address, email
address, phone number, authorized representative and business registration number.
Unsubscribe and privacy policy links need to be in the email footer.

Customer relationship requisites for checkout acquisition forms
Must haves
l

l
l

l

l

The address was acquired through a purchase; a transaction was made, and the product
was not returned.
The address is used for direct advertising of own similar goods or services.
The customer has not objected to this use, meaning there was no previous unsubscribe
from commercial emails.
A remark stating that emails about similar products or services will be sent must be clearly
visible when the email address is collected.
The form must contain information that one can unsubscribe at any time “without costs
other than the transmission costs pursuant to the basic rates being incurred in this
regard” or similar and by which methods, at least unsubscribe link and email address.
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Nice to haves
l
l

Include a link to the privacy policy every contact acquisition form.
Inform the recipient about the newsletter frequency.

Product recommendation content
l

The products advertised need to be similar to the product purchased. “Similar” means
they have the same sense and can be used in the same way. No other advertising must be
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l

l
l

included.
A full legal imprint is in the email footer: physical address, email address, phone number,
authorized representative and business registration number.
Unsubscribe and privacy policy links are in the email footer.
The email also contains information that one can unsubscribe from it "without costs other
than the transmission costs pursuant to the basic rates being incurred in this regard".

Imprint requisites
l
l

An imprint page must be present on the website and accessible.
The imprint page must contain: physical address, email address, phone number, VAT identification number, and authorized representative.

Privacy policy requisites
Must haves
l
l

A privacy policy page must be present on the website and accessible.
The recipient must be informed from which sender he or she is going to receive which
type of emails.
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Newsletter
l

l

A remark must be present that indicates that unsubscription is possible at any time and by
which methods (at least unsubscribe link and email).
A maximum of 10 third parties, including sponsors, must be explicitly named.

Customer relationship
l

l

A remark stating that emails about similar products or services will be sent must be clearly
visible.
The privacy policy must contain the information that one can unsubscribe at any time
“without costs other than the transmission costs pursuant to the basic rates being
incurred in this regard” or similar and by which method, at least unsubscribe link and email
address.

Nice To haves
l

The recipient should be informed about the frequency of the newsletters or product
recommendations.
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Unsubscribe requisites
l
l
l
l

Unsubscription must be easy and requires no more than two clicks.
Unsubscription must be free.
No further login must be required.
No persuasive language must be used.

Registration data requisites
Must haves
l
l
l
l

Context of contact acquisition (newsletter, customer relationship and so on).
URL / screenshot of online registration form or scan of offline registration form / contract.
Type of opt-in given, if applicable (double opt-in, single opt-in and so on).
Date and time of registration, and DOI confirmation.

Newsletter
l

Declaration of consent as presented when email address is collected.

Customer relationship
l

l

Remark informing recipient that contradiction to this type of advertising is possible at any
time as presented .
Purchase data.

Nice to haves
l

IP address of registration and of DOI confirmation

IP warming
New sending IPs (Internet Protocol address) have no sending history and are considered a
cold IP. At this point, they need to acquire a good reputation with ISPs (internet service
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providers).
Hotmail, Yahoo!, AOL, Gmail need to see that you are sending important, consent-based
messages to permit your mailings into your recipient's inbox.
IP warming is the process used to build a good reputation with ISPs. ISPs monitor your IP
to track your sending behavior and are likely to accept your messages based on a good
sending reputation.
The IP warming process includes sending consistent, low volume email campaigns, gradually increasing this volume over time until you reach your full volume capacity. ISPs then
gain confidence in you as a sender.
It can take 4-6 weeks to complete the IP warming phase. This depends on your volume
amount and how well your recipients engage with your messaging.
During the warming process, ISPs set receiving limits on your IP until you meet their standards of good reputation.
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Getting started with IP warming
l

l
l

l

l

l

l

l

l

l

Allowlist the Optimizely sending IP with your internal corporate network to ensure emails
are not blocked by your internal spam filter.
Ensure your IT team updates your DNS authentication records.
Clean your data using segment and email validation tools. Warm your most active users
only during IP warming phase. Active emails addresses consist of those who have recently
opened, clicked an email in the last 9 months or opted-in to your mailings using a double
opt-in database. Focus primarily on recipients who are less likely to report spam complaints. Never send to a bought or an old, unverified email list.
If you don’t have engagement data to identify active email address, focus on recent
signup data.
Create email content that encourages recipient engagement and that is specific to the
recipient's interests. See also: Email content best practices.
Send a welcome email to your recipients. This reminds your recipients that they have
opted-in and generates engagement for your first send out.
As a new sender, it is normal to see some blocking and bulking in the first instance of sending. ISPs are trying to determine your legitimacy. As you continue to send to good, active
email addresses and increase user engagement, bulking should end.
Review your engagement data (opens, clicks). A decrease in engagement can lead to your
messages being bulked by the ISP. Remove recipients from your marketing campaigns
who are consistently not engaging.
Frequency is important. ISPs like to see consistency in your sending and user engagement
metrics.
Reputation systems store reputation history for 30 days. Ensure that you do not go
without 30 days of sending from an IP. Doing so may require restarting the warming process.

IP warming schedule
Following an IP warming schedule assists in gradually establishing a reputation with ISPs
as a legitimate email sender. Start with small email volumes, and gradually increase volume
each day according to the two-week set schedule. The following schedule suggests a maximum of 40 percent to 100 percentage increase in volume per day. This however greatly
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depends on factors including list hygiene, how engaged your recipients are, and spam complaints among other things.

Day

Daily sending volume

1

500

2

1000

3

2500

4

5000

5

10000

6

20000

7

40000

8

60000
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Day

Daily sending volume

9

100000

10

150000

11

200000

12

250000

13

300000

14

400000
Continue to double your volume until you have reached your target daily volume.

Tips during the IP warming process
l
l

l

l

Ensure that you are sending consistently and keep to that frequency.
ISPs (internet service providers) like AOL want to see spam complaints less than 0.2%.
Review email engagement on each send and remove recipients who are not opening.
Once your IP (Internet Protocol address) exceeds the threshold set by the ISPs, the ISP
may start to soft bounce the emails. If you experience a higher than normal soft bounce
rate, stop sending and re-start the send later in the day.
Start the day with recipients who are very likely to open your emails.

What can cause delivery issues during IP warming
l

l
l
l
l

High spam complaints. This occurs when a recipient clicks "this is spam" button which is
shown within the email client.
Invalid email addresses (hard bounce).
IP address and domain blocklistings on RBLs (public blocklists).
Spam traps located within your data list.
Unexpected volume increases.
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What ISPs like to see
l
l
l
l

Consistent opens and clicks
Consistent email frequency
Email best practices are in place, as detailed in Deliverability best practices.
Emails are authenticated (SPF, DKIM, DMARC)

Warming a sending domain
A sending domain requires a good sending reputation for messages to enter your recipients’ inboxes. Domain warming is similar to IP warming, as it represents mailing practices
and volume. The same warming approach mentioned above can be applied to warming up
sender domains. The difference however is that domain warming focuses on recipient
engagement, which is the key factor to focus on.

Email authentication and encryption
Online abuse may occur in many ways, this includes spoofing of sender domains or email
content and the sending of spam messages on behalf of someone else. To prevent this
from happening, Optimizely applies a number of email authentication and encryption techniques.

Email authentication
A major aspect of the email delivery is the email authentication. ISPs (Internet Service Providers) and most email servers, in general, decide the credibility and authenticity of your
email based on the email security policies that you have in place. Furthermore, email
authentication is a technical method for identifying spam and verifying that an email is
actually sent by the sender, which refers to technical standards. ISPs and organisations
use these technical standards to block harmful emails such as phishing and spam.

IP-based authentication
Optimizely adheres to email technical standards to ensure we provide the utmost delivery
of emails, this includes the authentication of our sending IP infrastructure. Our
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authentication standards are intended to improve security and trust when sending emails
using the Simple Mail Transfer Protocol (SMTP).
Reverse DNS (rDNS or PTR)
The Reverse DNS record, also called PTR record, resolves an IP address to a host name. It
adds tracing to the origin of an email and thus, credibility to an outbound email server. If
the Reverse DNS lookup returns a ‘no domain associated’, the email will likely be filtered,
bounced or deleted by the receiving ISP.
Tip: Reverse DNS (PTR) records are set by default. No further action
from your side is required.

Domain-based authentication
To help keep deliverability at its best, Optimizely requires that each sending domain is configured to enable Optimizely to send verified messages on behalf of your chosen domain.
Records are added to your DNS managed by your IT administrator.
Tip: For information on domain delegation and setting up sending
domains, including the required DNS records, see Optimizely World.

Sender Policy Framework (SPF)
The SPF record prevents email spam by recognising email spoofing. The domain published
in the “include” record contains all Optimizely sending IP ranges. Confirming the sender's
IP addresses, SPF enables the domains administrators to determine which hosts are permitted to send emails on behalf of the given domain.
The SPF record is created as a TXT record on the technical return path domain like t.example.com.

Mandatory Optimizely SPF record
Type: TXT
Value: v=spf1 include:spf.srv2.de -all
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DomainKeys Identified Mail (DKIM)
DKIM utilises the information published by the domain proprietor. The information permits
the accepting server to check if the email message was sent by the proprietor of the
domain. Using a digital signature, the receiver also verifies that the message was not
changed during transmission.
For digitally signing a message, two keys are necessary. A private key that is stored in our
infrastructure and signs outgoing messages, and a public key that is published in the DNS
settings of a sender domain to be used. The domain of the Optimizely DKIM record contains this public key.
The DKIM record is set up as a CNAME record on both your technical return path like t.example.com and visible sender domain example.com.

Mandatory Optimizely DKIM record
Type: CNAME
Value: dkim.srv2.de

Domain-Based Message Authentication Reporting and Conformance (DMARC)
Tip: For more information about the DMARC implementation, see
DMARC implementation.
The DMARC record tells the receiving server which email authentication methods were
used by the sender, and what an ISP should do with a message if it fails those authentication methods.
Possible DMARC policies:
l

l

l

p=reject tells the receiver to reject an email that cannot authenticate with SPF and DKIM
(Recommended)
p=quarantine tells the receiver to quarantine an email that cannot authenticate with SPF
and DKIM
p=none tells the receiver to apply no special policy to an email that cannot authenticate
with SPF and DKIM
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Using the reject policy, emails that an unauthorized third party tries to send on your behalf
as part of a spam attack would simply be blocked by the ISP. Furthermore, DMARC allows a
sender to set up a reporting mechanism. Like that you will be notified each time an authentication failure and potential abuse of your domain is taking place.
The DMARC record is stored as TXT record with the prefix _dmarc in the DNS settings of
your sender or organizational domain.

Mandatory Optimizely DMARC record
Domain: _dmarc.example.com
Type: TXT
Value: v=DMARC1; p=reject; rua=mailto:dmarc@example.com;

Brand Indicators for Message Identification (BIMI)
Note: To use BIMI, contact customer support.
BIMI uses a text record which is stored on your DNS server and works together with
DMARC to indicate to participating email clients that you are the true sender. The difference between BIMI and other authentication methods is that it uses front end visualisation by having the email provider show your branded logo within the users inbox.
When a message is sent, the recipients ISP will look for the BIMI text file. When the ISP has
successfully located the file for verification, your company’s logo is shown in the recipient’s inbox. Currently participating mailbox providers include Gmail, Comcast, and Verizon
(Yahoo, AOL, and so on).
A BIMI setup currently has the following requirements:
l
l

DMARC record with either reject or quarantine policy
Logo to be displayed as .svg file (Scalable Vector Graphic)

The BIMI record is stored as TXT record with the prefix _bimi in the DNS settings of your
sender or organizational domain. Furthermore, the domain starts with the BIMI selector, for
now this is limited to the value default.
Example domain: default._bimi.example.com
Example BIMI record: v=BIMI1; l=https//www.example.com/logo.svg; a=;
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Email encryption
Encryption is a security mechanism for converting information into code in order to prevent access to this information through unauthorized third parties. It is also used to protect data in transit. To protect it, the information itself and/or the transport of it are
converted into a ciphertext and only authorized parties will be able to translate it back into
plain, readable information. This is also how email encryption works.

Transport Layer Security (TLS)
Transport Layer Security (TLS) is the upgrade of Secure Sockets Layer (SSL), a protocol
that used to communicate securely over computer networks. TLS Protocol secures a connection security, then using TLS Handshake, the protocol authenticates both sending and
receiving servers. This prevents snooping during message transmission, protecting the content from being read by unauthorized third parties.
Based on the TLS protocol, there is the STARTTLS email protocol command, that tells the
receiving server that for the transmission of the email an existing insecure connection shall
be turned into a secure one.
With the opportunistic TLS mechanism that Optimizely is using, the recipient server is
asked during transmission if it is able to process TLS encrypted messages and if the
answer is yes, then the email gets sent using TLS encryption. If it’s not possible, the email is
sent without encryption. Optimizely uses TLS version 1.2 by default as it offers the
strongest encryption, unless it is necessary to use a lower version in specific cases.
Tip: TLS encryption is enabled by default. No further action from
your side is required.

Digital signature
Using DKIM, you already have one digital signature mechanism in place. DKIM signatures
are applied by Optimizely’s sending server and verified by the receiving server of the ISPs.
They guarantee the authenticity of your sending domain.
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Additionally, it is possible to also sign emails in order to verify the actual sender and not
only the domain. To do this, you can set up an S/MIME certificate that will then be visible
to and verified by your recipients.

Secure/Multipurpose Internet Mail Extensions (S/MIME)
Secure multipurpose internet mail extension is an email signing protocol used to improve
email signing, by enabling you to prove the actual sender of an email through a
timestamped digital signature and to encrypt and decrypt the content of their emails.
S/MIME helps ensure that files stay authentic and protected when sending between networks.
Remark: Digital signatures only ensure data integrity and do not apply to confidentiality.
Emails protected with a digital signature are still sent as plain text. Message encryption of
the S/MIME standard is not supported.
See Sending S/MIME-signed emails.
Note: S/MIME encryption is an optional feature. To use S/MIME, contact customer support.

Blocklists and blocklisting
What is a blocklist?
An email blocklist is a real-time database, usually of an organization of the anti-spam community, that uses criteria to determine if an IP address or a domain is sending email that is
considered to be spam and must therefore be prevented from further malicious activities.
It helps the business using it to decide if emails received should be delivered to the final
recipient or if they should rather be blocked because the sender is not trustworthy.

Public blocklists
When speaking of blocklists, a blocklist mostly refers to public blocklists that any business
can include into their set of anti-spam measures. In this context, these are often called
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Domain Name System-based Blackhole Lists (DNSBL) or Real-time Blackhole Lists (RBL),
simply because they are operated and updated in real-time.
Blocklists are used by organizations like Internet Service Providers (ISPs), Free Mailbox Providers (MBPs) and anti-spam vendors but also private businesses as well as institutions of
the public or educational sector to keep spam away from their infrastructure and their
user’s mailboxes.

ISP-internal blocklists
Since often heavily targeted by spammers, Internet Service Providers also have their own
internal blocklists that a sender can get listed on when spammy behaviour is noticed. Any
potential blocklisting in this regard only impacts sending to the corresponding ISP however.

Optimizely Campaign blocklist
Not a blocklist in that sense is the internal Optimizely Campaign blocklist. This is a socalled suppression list where you can manage recipients who no longer want to receive
messages from you.

Types of blocklistings
Blocklistings are generally applied to the sending IP or the sender domain of a potentially
untrustworthy sender.

IP-based blocklisting
An IP blocklisting applies to the IP address used for sending - the unique number given to
every computer, server or other device when connecting to a network. If potential spam
emails keep coming from the same IP address, it will then be added to a blocklist as an
indication of junk. In most cases this means that further emails from the same IP address
will also be blocked. Sometimes a spam issue can be so severe that an entire IP range is
blocklisted.
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Domain-based blocklisting
A domain blocklisting applies to the sender domain, no matter which IP addresses the
potential spam emails are sent from. If a lot of spam originating from a certain domain is
detected, this domain will be blocked. Even if you switch to a different IP, if the domain is
still blocked, your emails will not be delivered.

How do I get blocked?
Blocklists are kept up to date usually in real-time with data provided by ISPs. An IP or a
domain is quickly blocked if repeated signs of spamming behavior are noticed. However,
even reputable senders can also be blocked, if one or more of the following problems have
occurred:
l

l

l

l

Sending to spam traps. Spam trap email addresses do not belong to any real person,
they are honey pots set up by the Internet Service Providers or blocklist operators to
identify senders that do not respect opt-in or do not practice list hygiene. These could
have been harvested from websites or alternatively, these might have been old, inactive
email accounts that were converted into spam traps after a too long time of inactivity.
High user complaints. Spam complaints are reports ISPs receive when your recipients
click the spam button in your emails. These make ISPs assume that the emails you send
are unwanted, be it due to a lack of opt-in, too high email frequency, insufficient relevance
of the email content or a lack of list hygiene. The more complaints, the more likely the
responsible sending domain or IP address will be blocked.
Sending to a high number of inactive email accounts. Sending to inactive email
addresses often leads to high hard bounce rates. This is an indicator for an ISP that a big
part of your recipient list is either very old or has not been acquired using double opt-in.
Big surge in recipient list size. A good email marketing list will grow sustainably over
time as new customers or leads sign up to receive your emails. When a list grows disproportionately in a short period of time, ISPs might suspect that it has been purchased or
crawled. Furthermore, big spikes in sending volume are a typical sign of spammers and are
therefore often distrusted.

If your sending activities are in line with the Optimizely Campaign Deliverability best
practices, no blocklistings are expected.
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Important blocklists
Nowadays, there are countless blocklists which are used by the anti-spam industry, Internet Service Providers, and major businesses around the world. However, some of them
have a much greater impact on deliverability than others. Optimizely and Optimizely's customers must ensure collaboratively that the sending IPs and domains are not listed, otherwise this can have a very negative impact on your deliverability. The most important
blocklists are listed in the table below.

Blocklist

Description

Spamhaus

Spamhaus runs numerous lists that are used by companies and ISPs around the world – such as Spamhaus
Block List (SBL), Domain Block List (DBL), and Policy
Block List (PBL). SBL is the one that most senders are
likely to run into through the sending of marketing
emails to ISPs. Spamhaus includes sending domains and
IPs of known spam sources as well as spam trap
addresses commonly found in purchased lists into their
detection mechanisms.

Invaluement

The Invaluement blocklist consists of the ivmURI list
which lists URLs that have been identified as malicious,
the ivmSIP list that is based on IP addresses from known
botnets and snowshoe spammers as well as the
ivmSIP/24 list that lists entire IP ranges or sub-nets
where spamming activities have been detected. Invaluement mostly relies on spam complaint data provided by
web hosts and mailbox providers to generate blocklistings which are used by a variety of reputation systems and anti-spam appliances.

SpamCop

The SpamCop Blocking List (SCBL) lists IP addresses
that have transmitted reported spam to SpamCop users.
With the SpamCop Domain Blocking List (SCdBL)
SpamCop have also started to offer domain-based blocklisting, which occurs based on the sender domain and
signature used. SpamCop is mostly known as an anti-
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Impact on deliverability

High
Affects delivery
to ISPs, antispam appliances
and B2B
addresses

High
Affects delivery
to ISPs, antispam appliances
and B2B
addresses
mostly in the UK,
US, and Nordic
countries
Medium
Affects delivery
to B2B
addresses
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Blocklist

Description

Impact on deliverability

spam service one can report spam to, but they also analyse email sent to spam traps. Furthermore, SpamCop
applies a scoring system to weigh reported email before
an IP or domain is listed.

SORBS

Spam and Open Relay Blocking System (SORBS) is a
blocklist that mainly works with spam traps and a hit of
one of their traps leads to the blocking of single IP
addresses or entire IP ranges.

Barracuda

The Barracuda Reputation Block List (BRBL) is a service
operated by the security and anti-spam vendor Barracuda Networks. It mainly lists IP addresses that have
transmitted email to spam traps. If an IP address passes
some basic tests, such as for proper server configuration, the email is then scored against the Barracuda Reputation System which takes into account any
potential threats detected by the Barracudas anti-spam
appliances and if considered spam, immediately added
to the BRBL.

Low
Affects delivery
to B2B
addresses

Low
Affects delivery
to B2B
addresses

Low

NiX Spam

NiX Spam is a German blocklist that also works with
spam traps and blocks the IP address used for sending
the email that hit their traps.

Affects delivery
to B2B
addresses
mostly in the
DACH region
Low

UCEPROTECT

UCEPROTECT is a spam protection database founded
in Germany which is mostly used by their members in
Germany, Austria and Switzerland. It mostly affects
domains of public bodies and private businesses and is
based on spam trap hits and spam complaints. Listings
may occur to single IP addresses (level 1), multiple IP
addresses (level 2) and finally all IPs of entire IP networks (level 3).
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Affects delivery
to public bodies
and B2B
addresses
mostly in the
DACH region
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Optimizely proactively monitors hundreds of known blocklists, keeps you updated on blocklistings that could potentially impact your sending and provide strategy consulting on how
to avoid them.

SMTP codes and error messages
This topic gives an introduction to the SMTP protocol and describes status codes and possible reasons for SMTP errors.

SMTP protocol
SMTP stands for Simple Mail Transfer Protocol, which provides mechanisms for the transmission of emails and is the technical standard behind the sending, relaying and receiving
of these.
When you start a mailing in Optimizely Campaign, it is transferred to the Optimizely Campaign sending SMTP server, a so-called Mail Transfer Agent (MTA). The MTA relays your emails to the receiving server of the target ISP or domain owner via the SMTP protocol,
which ultimately delivers the individual e-mails to the corresponding mailboxes.

In an ideal world, your email gets accepted by the ISP and delivered to the intended recipient's inbox. Having some experience with email marketing, you already know that this is
not always what happens. Your emails may get delayed, land in the spam folder, or may be
dropped or returned to you as a bounce.
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SMTP status codes
Since there are many potential outcomes of a sending attempt, standard mechanisms for
the reporting of mail system errors were developed to make processing and analysis of
these easier and more transparent. The result of this is a list of possible SMTP status codes
that you will often see included in bounce messages when analyzing your returns.
In most cases, the mailbox providers return two pieces of information in the event of a
bounce, a traditional SMTP response status code and an enhanced mail system status
code. Both provide information about the reason for the rejection and help in finding a
solution.

Traditional SMTP respone status codes
According to the first scheme developed, the traditional SMTP response status codes
defined in RFC 5321, the receiving SMTP server of an ISP or domain owner responds to the
sender using a three-digit code. All SMTP response status codes are separated into five
classes and the first digit of the status code defines the class of response:
l
l
l
l
l

1xx (Informational). The request was received, continuing process.
2xx (Success). The request was successfully received, understood, and accepted.
3xx (Redirection). Further action needs to be taken, in order to complete the request.
4xx (Persistent transient failure). The request contains bad syntax or cannot be fulfilled.
5xx (Permanent errors). The server failed to fulfill an apparently valid request.

A successfully delivered e-mail has the status code 250 Requested mail action okay completed.
The SMTP response status codes to be applied are defined by the host of a server. Different ISPs, mailbox providers or domain owners may define them differently. Therefore,
there is no unique presentation.
SMTP status code

Error message

420

Timeout

421

<domain> Service not available
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SMTP status code

Error message

422

Unprocessable Entity

431

Not enough space on the disk

432

Recipient's incoming mail queue has been stopped

441

Account is over data quota

442

Connection Refused

446

The maximum hop count was exceeded for the message

447

Timeout

449

Routing error

450

Requested mail action not taken: mailbox unavailable

451

Requested action aborted: local error in processing

452

Requested action not taken: insufficient system storage

471

An error of your mail server

500

Syntax error, command unrecognised

501

Syntax error in parameters or arguments

502

Command not implemented

503

Bad sequence of commands

504

Command parameter not implemented

510

Bad email address
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SMTP status code

Error message

511

Bad email address

512

Host server for the recipient’s domain name cannot be found in DNS

513

Address type is incorrect

521

<domain> does not accept mail

523

Size of your mail exceeds the server limits

530

Access denied

541

The recipient address rejected your message

550

Requested action not taken: mailbox unavailable

551

User not local

552

Requested mail action aborted: exceeded storage allocation

553

Requested action not taken: mailbox name not allowed

554

Transaction failed

Enhanced mail system status codes
Since the information provided in the traditional codes is limited and there was a need for
reporting mechanisms richer than these, a new set of enhanced mail system status codes
was proposed in RFC 3463. The enhanced mail system status codes are based on the SMTP
theory of reply codes and adopt the success, permanent error, and transient error
semantics of the first value, with a further description and classification in the second:
l

2.XXX.XXX (Success). Success specifies that the DSN is reporting a positive delivery
action. Detail sub-codes may provide notification of transformations required for delivery.
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l

l

4.XXX.XXX (Persistent Transient Failure). A persistent transient failure is one in which
the message as sent is valid, but persistence of some temporary condition has caused
abandonment or delay of attempts to send the message. If this code accompanies a delivery failure report, sending in the future may be successful.
5.XXX.XXX (Permanent Failure). A permanent failure is one which is not likely to be
resolved by resending the message in the current form. Some change to the message or
the destination must be made for successful delivery.

A successfully delivered e-mail has the status code 2.0.0 (success).
Just like the traditional SMTP response status codes, the application of these varies from
mailbox provider to mailbox provider. For undelivered emails, are may transmitted bounce
codes as below. These can appear as a persistent transient failure starting with a 4, or as a
permanent failure starting with a 5.
SMTP status code

Error message

X.0.0

Other undefined status

X.1.0

Other address status

X.1.1

Bad destination mailbox address

X.1.2

Bad destination system address

X.1.3

Bad destination mailbox address syntax

X.1.4

Destination mailbox address ambiguous

X.1.5

Destination address valid

X.1.6

Destination mailbox has moved, No forwarding address

X.1.7

Bad sender's mailbox address syntax

X.1.8

Bad sender's system address

X.2.0

Other or undefined mailbox status
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SMTP status code

Error message

X.2.1

Mailbox disabled, not accepting messages

X.2.2

Mailbox full

X.2.3

Message length exceeds administrative limit

X.2.4

Mailing list expansion problem

X.3.0

Other or undefined mail system status

X.3.1

Mail system full

X.3.2

System not accepting network messages

X.3.3

System not capable of selected features

X.3.4

Message too big for system

X.3.5

System incorrectly configured

X.4.0

Other or undefined network or routing status

X.4.1

No answer from host

X.4.2

Bad connection

X.4.3

Directory server failure

X.4.4

Unable to route

X.4.5

Mail system congestion

X.4.6

Routing loop detected

X.4.7

Delivery time expired
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SMTP status code

Error message

X.5.0

Other or undefined protocol status

X.5.1

Invalid command

X.5.2

Syntax error

X.5.3

Too many recipients

X.5.4

Invalid command arguments

X.5.5

Wrong protocol version

X.6.0

Other or undefined media error

X.6.1

Media not supported

X.6.2

Conversion required and prohibited

X.6.3

Conversion required but not supported

X.6.4

Conversion with loss performed

X.6.5

Conversion Failed

X.7.0

Other or undefined security status

X.7.1

Delivery not authorized, message refused

X.7.2

Mailing list expansion prohibited

X.7.3

Security conversion required but not possible

X.7.4

Security features not supported

X.7.5

Cryptographic failure
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SMTP status code

Error message

X.7.6

Cryptographic algorithm not supported

X.7.7

Message integrity failure

Reasons for SMTP errors
Just as there are a multitude of SMTP codes, they also come from a multitude of possible
causes. These are the most commonly observed:
l

l

l

l

l

Unknown users. Sending to inactive email accounts leads to permanent SMTP errors that
are handled as hard bounces.
Suspected sending of spam. The spam filter and/or reputation metrics of an ISP or mailbox provider have detected bad sender reputation or spammy sending patterns with
regard to email content and/or user feedback and rejects your emails with SMTP errors
categorized as soft bounces.
Incorrect DNS setup. Sending with unauthenticated sender domains may result in SMTP
errors classified as soft bounces. See Email authentication and encryption.
Full mailboxes. Overflowing recipient mailboxes lead to SMTP errors handled as soft
bounces.
Technical failures. Connection or performance issues on the recipient's side are generally treated as transient errors and do not immediately bounce. Optimizely undertakes
various delivery attempts and only if these are not successful within several days, they
lead to soft bounces.

SMTP errors and bounce issues can be greatly reduced by following the Deliverability
best practices.
Optimizely's bounce management recognizes all common SMTP error codes and messages
received by the ISPs or mailbox providers and classifies them in the appropriate bounce
category. They are regularly reviewed and updated to provide you bounce processing
according to the latest industry standards.
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DMARC implementation
DMARC stands for Domain-Based Message Authentication Reporting and Conformance
(DMARC) and is a mechanism that is intended to counteract so-called email spoofing.
Email spoofing is the sending of spam emails with fake sender domains, mostly on behalf of
well-known companies and brands that are not even aware of this abuse. These often lead
to high bounce rates, spam trap hits and spam complaints, which are technically attached
to the real domain owner and have a negative effect on the reputation of his domain and
thus on the mailings sent from it.
DMARC therefore makes a major contribution to protecting the online reputation of your
domains and your brand by preventing or at least reducing domain abuse. Participating
Internet Service Providers also attribute senders using DMARC a better reputation and
thus enable better delivery results. In addition, DMARC is a basic criterion for setting up
BIMI (Brand Indicators for Message Identification).
DMARC is supported by the following ISPs (extract): Gmail, Yahoo, AOL, Microsoft, Netease
(126.com, 163.com), Tencent (qq.com), Mail.ru, Comcast, AT&T, British Telecom, Virgin
Media, Italia Online. 1&1 (GMX, Web.de) is currently implementing DMARC.

Functionality and requirements
The handling of potential spam emails is generally the responsibility of the receiving ISP
that works with a variety of security metrics, including Sender Policy Framework (SPF) and
DomainKeys Identified Mail (DKIM), to protect its recipient’s mailboxes from spam, scam or
phishing emails.
Using DMARC, you as the sender can now independently tell the receiving mailbox provider how they should proceed with emails if they cannot authenticate themselves via SPF
and DKIM. DMARC is considered a third layer of protection, which is based on the existing
authentication mechanisms SPF and DKIM and supplements them. The implementation of
these two authentication standards is required at Optimizely during onboarding or when
setting up additional sending domains.
In addition, the DMARC reporting functionality makes cases of domain abuse visible for the
first time. This helps you to understand current delivery trends of your emails and to monitor your reputation.
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DMARC record
DMARC can generally be set up for the entire organizational domain or specifically for a
subdomain used for email sending. Ideally, DMARC is set for the organizational domain to
protect the entire domain, all associated subdomains and thus the brand as a whole. The
important part for the delivery of your emails is the application of DMARC on the sender
domain.
The DMARC record is inherited by the subdomains belonging to the DMARC domain. If it is
set on the organizational domain, it is automatically applied to all associated subdomains
of this domain.
To set DMARC, a subdomain with the name _dmarc must be created for the domain for
which DMARC should ultimately be used. The Optimizely recommended entry is as follows:
l
l
l
l

Example domain. example.com
DMARC domain. _dmarc.example.com
Record type. TXT
DMARC record. v=DMARC1; p=reject; rua=mailto:dmarc@example.com;

DMARC policies
One of the most important parts of the DMARC is the policy tag. With this, the domain
owner specifies how a DMARC-supporting mailbox provider should handle emails that cannot authenticate correctly with SPF and DKIM. The following three policies can be set.
Optimizely recommends setting the reject policy.
l

l

l

p=reject. Instructs the receiver to reject an email that cannot authenticate with SPF and
DKIM.
p=quarantine. Instructs the receiver to deliver an email to the spam folder that cannot
authenticate with SPF and DKIM.
p=none. Instructs the receiver not to apply any special policy to an email that cannot
authenticate with SPF and DKIM.

Using the reject policy, emails that an unauthorized third party tries to send on your behalf
as part of a spam attack, would simply be blocked by the ISP.
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DMARC tags
The following table provides an overview of the possible DMARC tags. The Optimizely
DMARC record only contains three of them.
Tag

Definition

Recommendation

v

Version

The version must be set with v=DMARC1.

p

Policy

The DMARC policy must also be set. Optimizely recommends setting the strongest policy p=reject to reject spam emails from your
domain.

sp

Subdomain
Policy

If another DMARC policy is to apply to your subdomains, this can
be specified with the sp tag, such as sp=quarantine. This setting
is optional.

rua

Aggregate
Report

Optimizely recommends specifying a reporting address for receiving aggregated DMARC reports, such as ruaa=mailto:dmarc@example.com.

ruf

(Forensic) Failure
Report

Optimizely recommends not using forensic reports. They contain
email addresses of spam recipients and are therefore possibly
not GDPR-compliant.

adkim

DKIM Alignment

No separate tag is necessary, so the default setting applies:
adkim=r (Relaxed).

aspf

SPF Alignment

No separate tag is necessary, so the default setting applies: aspf=r (Relaxed).

rf

Reporting
Format

No separate tag is necessary, so the default setting applies: rf==afrf.

ri

Report Interval

No separate tag is necessary, so the default setting applies:
ri=86400 (1 Tag).

Percentage

No separate tag is necessary, so the default setting applies: pct-

pct
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Tag

Definition

Recommendation
=100.
No separate tag is necessary, so the default setting applies: fo=0.
The following options generally exist:
fo=0. A report should be sent if the SPF and DKIM check fail
at the same time.

l

fo

Failure Reporting Options

fo=1. A report should be sent if either the SPF or the DKIM
check fails.

l

l

fo=d. A report should be sent if only the DKIM check fails.

l

fo=s. A report should be sent if only the SPF check fails.

DMARC Identifier Alignment
The DMARC check itself is based on the DMARC Identifier Alignment. This requires that at
least one of the domains that are authenticated via SPF and DKIM matches the visible
sender domain.
In case of the SPF alignment, the technical domain (RFC5321), also called return path or
envelope-from, must correspond to the visible sender domain (RFC5322), also called fromdomain or header-from, and meet one of the two variants:
l

l

Relaxed SPF Alignment. The technical and the visible domain have the same organizational domain.
Strict SPF Alignment. The technical and the visible domain have the same subdomain.

In case of the DKIM alignment, the domain that is signed with DKIM and can therefore be
found in the d= parameter in the email header must correspond to the visible sender
domain and meet one of the two variants:
l

l

Relaxed DKIM Alignment. The DKIM domain and the visible domain have the same organizational domain.
Strict DKIM Alignment. The DKIM domain and the visible domain have the same subdomain.
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Tip: DMARC Identifier Alignment is set up by default with Optimizely
Campaign.

DMARC reporting
An additional feature that SPF and DKIM do not offer is the creation of DMARC reports.
DMARC reporting notifies you if authentication errors of the SPF and DKIM are detected in
emails sent with your domain, which means that your domain is potentially abused.
DMARC reports can help you to understand whether and to what extent domain abuse is
taking place. Spam emails that are sent in your name and with your domain ultimately also
have a negative effect on your sender reputation and delivery performance. In addition,
DMARC reports can provide you with information about the origin of spam attacks and
help you to fight them.
Optimizely recommends setting up so-called aggregated reports.
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Source: DMARC.org
The report contains general information about the sender and the period under review in
the <report_metadata> area. Furthermore, in the <policy_published> area, you will see the
DMARC policy applied and other tags used such as domain alignment or DMARC percentage. The last and most important section <record> contains the sending IP and
domain, which caused an SPF and/or DKIM error. <dkim>fail</dkim> indicates that the
domain signature could not be verified, and on the other hand, <spf>fail</spf> indicates
that the sending IP was not contained in the SPF record of the sending domain.
In addition to the aggregated report, there is also a second reporting format, the forensic
failure report. However, this report contains personal data such as the email addresses of
unrelated recipients and is therefore classified as not GDPR-compliant and not recommended to be used.

Implementing DMARC
To implement DMARC, perform the following steps:
1. Selecting the domain
2.
3.
4.
5.

Checking the domain
Selecting an email address
Setting up the DMARC record
Analyzing the results

Selecting the domain
Select the domain on which you want to set DMARC. You can
l

l

set DMARC on a domain that is solely used for sending with Optimizely. This is usually a
subdomain.
set DMARC on your organizational domain. This may or may not be the sending domain set
up at Optimizely.

In order for DMARC to have an impact on your deliverability, it must at least be set for the
sending domain used with Optimizely. However, it is recommended to set up DMARC on
your organizational domain to protect the entire domain and brand.
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Tip: DMARC is inherited on all subdomains of the DMARC domain.

Checking the domain
When using a domain that is used for sending with Optimizely, domain alignment and both
authentication mechanisms SPF and DKIM are set by default. If you are unsure:
l

l

Send test emails and check in the email header whether your sending domain corresponds to the returnpath domain or the DKIM domain, listed under the d= header, at
least at the level of the organizational domain.
Check in the email header whether your email authenticates with SPF and DKIM. If you
cannot find a warning about an incorrect DNS setup in your Campaign account, the emails
are most likely correctly authenticated.
Note: For the implementation of DMARC on the organizational
domain, other mail streams such as emails via your own infrastructure
or other email service providers must be taken into account and
domain alignment, SPF and DKIM must be implemented correctly for
all of them. Otherwise DMARC can lead to unwanted blocking of
these emails.

Selecting an email address
To receive DMARC reports, you need to set an email address. The reporting address should
be based on the same organizational domain like your DMARC domain. Since you will possibly receive a lot of reports, it makes sense to create a separate mailbox for them.
If you want to use an official tool for DMARC analysis, you will likely be provided with a
reporting email address.

Setting up the DMARC record
A TXT record with the prefix _dmarc must be created for the domain for which DMARC is
ultimately to be used. The Optimizely recommended entry is as follows:
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l
l
l
l

Example domain. example.com
DMARC domain. _dmarc.example.com
Record type. TXT
DMARC record. v=DMARC1; p=reject; rua=mailto:dmarc@example.com;

Send a test email and check the email header to see if it authenticates using SPF, DKIM
and DMARC. This is particularly easy to see in a Gmail header.

Analyzing the results
If your domain is abused to send spam emails, you will receive DMARC reports to your specified reporting email address. Ideally, this will allow you to draw conclusions about your
current deliverability situation. At the same time, you learn how many potential spam
emails were blocked and never reached any recipient.
The following tools can be used for analysis and visualization:
l

Dmarcian

l

DMARC Analyzer

l

Valimail DMARC Monitor

l

Postmark DMARC Monitor

The use of these tools may cause costs. The application of DMARC itself is free of charge.

Options for gradual implementation
Optimizely recommends targeting the full application of the reject policy.
If you are unsure whether all your mail streams from your DMARC domain are already
authenticated with SPF and DKIM, or whether you are sending further legitimate emails
without authentication, you can work with a test phase and evaluate your reports first. If a
phased introduction is planned, this can be implemented as follows:
l

l

Policy level. Start with a none policy so DMARC will not affect sending. Once you have
verified that the functionality works as intended, change the policy tag to quarantine and
finally to reject.
Percentage level. Implement the reject policy but apply DMARC to a limited percentage
of the sending volume, such as 10%. The percentage can be slowly increased over time.
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You can find more information on DMARC.org.

List bombing
Your subscription process is the beginning of your relationship with your recipients.
However, subscription forms can be misused by malicious parties to send spam, with a
method called list bombing.

List bombing as a form of cybercrime
List bombing refers to a practice of abusing and attacking email list subscription pages by
bombarding them with a large number of new email addresses at the same time. For you, it
looks like a spike in subscriptions. In reality, it is a cyberattack.
Bots are being used to register innocent email addresses through open or poorly secured
web subscription forms in high volumes. These subscriptions are made possible by the fact
that the web forms use no measures and accept all email addresses entered without any
verification. These may be either generated or collected by bots to flood your business'
lists. In this case even using double opt-in (DOI) does not help much, because the volume
of confirmation emails alone is enough to cause a substantial problem.
The first list bombing was detected in August 2016 by Spamhaus, a prominent anti-spam
organization. According to Spamhaus, 22,000 subscriptions took place at a single ESP, targeting 3,000 different domains, resulting in a volume of sometimes over 100 messages a
minute to some addresses. One company saw nine specific addresses registered over
9,000 times over the course of two weeks, creating 81,000 confirmation emails. Spamhaus
then listed tens of networks, including ESPs, on the Spamhaus Block List (SBL).
Optimizely continuously monitors its sending infrastructure to detect and advise you
about list bombing incidents before they have an impact on your deliverability.

Am I being list bombed?
There are several signs that will help you identify if your subscription forms are being used
for list bombing.
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Unexpected increase in subscribers
Sudden increase in subscribers, especially if these cannot be traced back to a marketing
campaign, are a sign of subscription form abuse. Have a look at your data and try to
identify email addresses that repeatedly registered in a short period to one or more of your
lists.

Subscriptions from the same IP address
If you see multiple tens or hundreds of subscriptions from a single IP address, it is safe to
say that an attack is taking place. It is best to directly block that IP address and to delete
the newly registered email addresses via that IP address from your database.

High bounce rate of opt-in emails
Opt-in emails such as DOI mailings can bounce every now and then, as recipients sometimes register with an incorrect email address. If these bounce rates are also regularly at a
high level, one can assume that the subscription form is being abused.

Subscriptions from unexpected regions
Based on the geographical region your business operates in, you usually send more emails
to some ISPs than others. High numbers of opt-in emails or even bounces of these at ISP
domains that are less common in your region can indicate subscription form abuse.
Example: If you send mainly in the DACH region, a high volume of subscriptions and DOI
emails to Russian or Chinese mailbox providers or even global ISPs like AOL or Yahoo is
generally possible but unlikely and might indicate abuse.

Spam complaints about DOI emails
Should you receive spam complaints about your opt-in mailings, check your latest subscriptions as your forms may be under attack.
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Danger of list bombing attacks
When someone list bombs your site, they corrupt your data. Not only invalid, but also valid
email addresses are fraudulently added to your email lists, which can damage your sender
reputation and deliverability performance.
As outlined in the Sender reputation guide, ISPs collect data about mailing practices to
determine if a sender is a good or a bad sender and based on this data they decide how
your emails should be handled. The key metrics analyzed include:

Subscription form abuse might produce unexpectedly high email volume. Sending to a
high number of inactive users will lead to high hard bounces. If spam trap addresses are
registered, sending to these might cause listings at public or ISP-internal blocklists and in
the worst case a blocking of all your emails. Sending to existing email addresses that were
signed up by a spammer will lead to annoyed recipients, low user engagement and potentially spam complaints.
All these factors have a negative impact on your sender reputation. Therefore, measures
against list bombing attacks are essential for every subscription form.

Measures for protection
If you notice you have been list bombed, do not panic. There are several possible solutions.
Identify the day/hour the attack started and remove all new users that were added to your
list after that. If you already use DOI, simply remove new subscribers, who have not confirmed their opt-in yet.
To prevent throwing away entire days or weeks' worth of subscriptions to ensure you have
truly gotten rid of all bad data from a list bombing attack, we recommend implementing at
least one or more of the following measures to protect your subscription forms.

© Optimizely 2022

126 | Optimizely Campaign User Guide 2022-03-14

l

l

l

l

l

l

Implement a CAPTCHA. CAPTCHAs can distinguish user subscriptions from automated
subscriptions through bots. There is a variety of CAPTCHA providers on the market offering solutions based on different mechanisms and compliance levels, e.g., with GDPR.
Integrate a honeypot field. A honey pot in subscription forms is an additional content
field invisible to human beings but indistinguishable for a bot. If you detect that the field
has been filled, the subscription was not done by a human being and the process can be
canceled immediately. See Integrating honeypots.
Change field names in HTML source. Bots look for text fields in the source code of a
website. Make it harder for them and change the field names to something other than
standard, e.g., from First name, Last name, Email to First_Banana, Last_Apple, Em_Orange.
That will prevent most bots from locating them.
Measure form submission times. Measure the time needed for form submissions by
integrating a field that looks at a time stamp or generated key for the page load. A human
being may need several minutes to fill out a form, a bot only a second. If a particularly
short time is detected, break the subscription process.
Add IP rate limits. Work with rate limits in your subscription form, which prevent the same
form from being submitted multiple times from the same IP address in a certain period of
time.
Manage allowed form input. Implement a lock for certain entries in your subscription
form, such as special characters, URLs and HTML tags or regularly clean your list of new
subscribers. Spammers may insert URLs leading to malicious or illegal websites that may
be unintentionally included in your emails and then clicked by inattentive recipients.

Integrating honeypots
You can integrate honeypot fields in subscription forms as follows:
<input type="email" name="email-confirmation-field1" class="hidden" placeholder="Your email address" required="required" autocomplete="off">
/* Email field visible to the recipient */
<input type="email" name="email-field1" class="required" placeholder="Your
email address" id="required" autocomplete="off">
/* Honeypot field */
<input type="text" name="birthday-field1" class="optional" autocomplete="off">
/* Honeypot field */
<input type="text" name="name-field1" class="required" autocomplete="off">
/* Honeypot field */
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<input type="text" name="city-field1" class="optional" autocomplete="off">
/* Honeypot field */

Note:
l
class="hidden". Adjust your CSS style sheet for the subscription
page to make this class visible.
l
autocomplete="off". Is intended to prevent form fields from
being filled in automatically. However, this setting is not supported by all web browsers. Therefore, change the field names to
something other than standard, for example, birthday-field1.
l
Adjust your CSS style sheet for the subscription page so that all
other classes and IDs are not visible. For example, use the following commands:
o

visibilty:none;

o

display:none;

o

width:0px;

o

height:0px;

BIMI piloting
BIMI stands for Brand Indicators for Message Identification and is an email authentication
standard that allows you to display a verified company logo in your recipients' inboxes
when sending a properly authenticated email. They can immediately trust that it is an
actual email from you and not a dangerous phishing attempt. BIMI does not guarantee
100% deliverability, but it can help you achieve more brand recognition and trust, a higher
sender reputation and ultimately better email KPIs.

Current state of adoption
The BIMI standard is relatively new and still in the piloting phase at many Internet Service
Providers (ISPs). The distribution and further development are being driven by the AuthIndicators Working Group, which offers further information on the current status at Bimigroup.org.
State of adoption as of October 2020:
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A full implementation is already possible with the mobile and web clients from Yahoo and
AOL as well as Google. To send authenticated emails with BIMI, see Implementing BIMI.

Functionality and requirements
To set up BIMI, the basic authentication standards must be in place, including Sender
Policy Framework (SPF), DomainKeys Identified Mail (DKIM) and Domain-Based Message
Authentication Reporting and Conformance (DMARC). See Email authentication and
encryption.
The BIMI standard expects a DMARC setup on the organizational domain. Many ISPs who
are implementing BIMI or who are considering BIMI support in the future recommend that
senders start to prepare now and implement DMARC. See DMARC implementation.
The BIMI setup itself is done by creating a BIMI text record on the domain which is to be
authenticated with the company logo in the future. The record will contain a reference to
the company logo and possibly a so-called Verified Mark Certificate (VMC) that officially
validates the logo. The logo itself must be delivered as a Scalable Vector Graphic (SVG
Tiny 1.2 Portable/Secure) with further specific format requirements. VMCs are required to
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use BIMI with Google and can currently be purchased from Entrust or Digicert. At Yahoo
and AOL they are not currently required.
When attempting to deliver an email, the participating ISPs will verify the DMARC setup on
the one hand and the BIMI setup on the other. If both checks are successful, the ISPs will
pull the logo from the URL in the BIMI record to display the BIMI image in the inbox next to
your email. ISPs state that a good sender reputation is essential for this.

Technical specifications
BIMI record
To use BIMI, a BIMI record must be created for your sending domain which should benefit
from the verified logo display in the end. This can be a subdomain or an organizational
domain.
Example BIMI record:
Example domain. example.com

l

BIMI domain. default._bimi.example.com
Record type. TXT
BIMI record. v=BIMI1; l=https://www.example.com/logo.svg;

l
l
l

Available BIMI tags
The following table provides an overview of the possible BIMI tags and the implementation
options.
Tag

Definition

Implementation

v

Version

The v tag is required and must be set with v=BIMI1.

l

Location

The l tag is required and indicates the location of the logo you want to
display. It is specified as a URL with HTTPS. HTTP will not work.

a

Trust authorities

The a tag is required for the BIMI setup with Google and is used to validate domain ownership using a Verified Mark Certificate. The accep-
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Tag

Definition

Implementation
ted values are:
l

l

l

self. No validation option, similar to not having an a tag.
cert. Provides an HTTPS URL to a Verified Mark Certificate
that can be used to validate the logo in the l tag.
mva. Specifies an HTTPS URL to an API endpoint that can be
queried for validation.

Image requirements
The BIMI standard requires the creation of a logo in the image format SVG Tiny 1.2 Portable/Secure, in short SVG P/S.
The SVG P/S format is stricter than SVG Tiny 1.2 and requires the image to be a centered,
square image of your official company logo without any additional text on a background of
solid colour. Additionally, the image should be as small as possible, not exceed 32 KB and
further resources like external links, scripts or interactive elements must not be included.
You can find a full list of the required elements at Bimigroup.org.

BIMI selector
The BIMI domain default._bimi.example.com in this example, starts with the BIMI selector. It
serves the mailbox provider to identify and look up the associated BIMI record and logo.
The standard selector name is called default and is the only one that is currently accepted
by the supporting ISPs, Yahoo & AOL in particular.
Theoretically, if you plan on rolling out BIMI to multiple brands using the same sending
domain, there is also the option to work with several selectors. However, different selectors
would also make a technical adjustment to the email itself necessary. Since this option is
still under development and is currently not supported anyway, you should work with different sender domains and thus separate BIMI records to differentiate between brands.

Implementing BIMI
To implement BIMI, do the following:
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1.
2.
3.
4.
5.

Authenticating emails
Creating an SVG logo
Acquiring a VMC
Setting up the BIMI record
Analyzing the results

Authenticating emails
BIMI requires the authentication of your emails with SPF, DKIM and DMARC. If you are
unsure, you can send a test email and check in the email header whether the authentication requirements are met or simply ask your IT administrator. For further information
on the required DNS setup, see Setting up your domain on Optimizely World. For information on how to implement DMARC, see DMARC implementation.
The BIMI standard requires DMARC on the organizational domain with a DMARC policy set
to either p=quarantine or p=reject. Optimizely strongly recommends the p=reject policy.
Additionally, parameters that weaken the DMARC application such as sp=none or any percentage below 100 pct<100 are not allowed.
Note: The BIMI implementation can currently be implemented with
the web and mobile clients of Yahoo, AOL and Gmail. For Yahoo and
AOL, the DMARC record on the sending domain, even though it is
sub domain, is currently sufficient. Gmail, on the other hand, requires
the DMARC record on the organizational domain, as is generally
defined for the BIMI standard. So that you are on the safe side with
future developments, you should implement DMARC on the organizational domain.

Creating an SVG logo
To implement BIMI, you need to create a company logo as a Scalable Vector Graphic. The
exact version supported by BIMI is SVG Tiny 1.2 Portable/Secure (SVG P/S). The SVG BIMI
logo must
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l
l
l
l

be squared and centered
only include your logo without text and the background should be of a solid color
should be as small as possible and not exceed 32 KB
not include external links, scripts, animation, or other interactive elements

Once created, store the SVG image in HTTPS and it is ready to be added to your BIMI
record.
Tip: At Bimigroup.org you can find further information on creating
SVG BIMI logos and SVG conversion tools.

Acquiring a VMC
The BIMI standard generally provides for the BIMI logo to be validated by a certification
body so that its authenticity can be guaranteed. With a Verified Mark Certificate (VMC)
they certify the logo owner and make the proof of the certification in the DNS of the
sender domain accessible.
A VMC is currently only required for using BIMI at Google, Yahoo and AOL do not require a
certificate. So far, the following certification authorities are available:
l

Entrust

l

Digicert

The BIMI Working Group expects that the acquisition of VMCs will also be possible with
other partners in the future.

Setting up the BIMI record
A TXT record with the prefix default._bimi must be created for the sender domain for
which BIMI is ultimately to be used. The Optimizely recommended entry is as follows:
l
l
l
l

Example domain. example.com
BIMI domain. default._bimi.example.com
Record type. TXT
BIMI record. v=BIMI1; l=https://www.example.com/logo.svg; a=https://www.example.com/vmc/logo.pem;
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Replace example.com with your sender domain and l=https//www.example.com/logo.svg
with the image URL of your SVG image. Note that the URL must be based on HTTPS.
If you do not want to use a certificate and only want to implement BIMI with AOL and
Yahoo, the parameter a=https://www.example.com/vmc/logo.pem can be omitted.

Analyzing the results
There are tools that you can use to create your BIMI record and/or to verify it afterwards.
One of them is the BIMI Inspector provided by Bimigroup.org.
After the successful implementation of the BIMI record, your SVG logo should now be displayed in the participating email clients. Check over time whether the implementation has
reduced phishing attempts and improved your email KPIs.

Deliverability glossary
This topic explains the most important terms related to deliverability.
Term

Definition

A

A Record

A record is short for address records. They are used to map hostnames to
an IP address of the host. For the delegated domains in Optimizely Campaign, the A record is set as 193.169.180.193.

Allowlist

An allowlist (formerly whitelist) is a list of IP addresses or domains, that
have been verified by email providers or spam filters for sending high quality emails. Senders listed on an allowlist usually benefit from better delivery results.

AMP 4 Email

AMP 4 Email is a technology developed by Google, that allows interactive
elements like confirmation, purchase buttons, likes and so on to be added
to an email without visiting a website.

ARC

ARC stands for Authenticated Received Chain and helps solve the problem
that the DKIM and SPF break during email forwarding.
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Term
Authentication

Definition
Authentication in email is a process to verify the identity of a sender using
several mechanisms such as SPF, DKIM, DMARC and BIMI.

B
BIMI

BIMI stands for Brand Indicators for Message Identification. It is a standard
that attaches your brand’s logo to your authenticated email messages.

Blocking

A blocking occurs when incoming emails are rejected by the receiving mailbox provider. This is typically due to a temporary reason, such as IP blocklisting or an email content issue. It can affect a mailing, a domain, an IP
address, or a whole range of IP addresses.

Blocklist

A blocklist (formerly blacklist) is a list of IP addresses or domains, that
have been blocked by email providers or spam filters for sending spam
emails, hitting spam traps or a high level of user complaints.

Bot

A bot, short for "robot", is a computer program that operates as a user or other
program to automate certain tasks.

Bounce

An email is unable to be delivered. There are two types of bounces: hard and
soft.

Bounce Message

An automated message sent by the receiving provider when email delivery
fails.

Bounce Rate

The percentage of the non-delivered emails out of the total sent emails.

C
CAPTCHA

A CAPTCHA is a mechanism implemented in registration forms that allows the
owner of the form to distinguish a human being from a bot.

Click Rate

The percentage of the generated clicks out of the total delivered emails.

CNAME

CNAME stands for canonical name. A CNAME record in DNS maps one
domain name to another. In Optimizely Campaign the DKIM record of your
domains is set as a CNAME record.

© Optimizely 2022

Basics | 135

Term

Definition

COI

COI is short for confirmed opt-in. When a subscriber signs up for an email service, an email is sent to the subscriber’s email address as confirmation of the
registration.

CSA

The Certified Senders Alliance (CSA) is an organization of the German Association of the Internet Industry (eco) that manages a whitelist for bulk mailers.
It acts as a neutral interface between mailbox providers and senders of commercial emails.

D

DANE

DANE stands for DNS-Based Authentication of Named Entities. It is a protocol, that lets you securely specify exactly which TLS/SSL certificate an
application or service should use to connect to your site. It requires the
application of DNSSEC.

Dedicated IP

Dedicated IPs are IPs used exclusively by one sender.

Deliverability

The process of ensuring that email is delivered to the inbox as opposed to
being blocked or ending up in the spam folder.

Delivery

Technical delivery occurs when an email is successfully transmitted to the
correct email address. Even if your email was delivered to the spam folder, it
still counts as a delivery.

DKIM

DKIM stands for DomainKeys Identified Mail. It is a protocol to ensure using a
digital signature that the sender is authorized to use the domain for sending
and that the message was not tampered with in transit.

DMARC

DMARC stands for Domain-Based Message Authentication, Reporting & Conformance. It is a protocol that uses SPF and DKIM to determine the authenticity of an email message. DMARC can tell a receiving server to or not to
accept an email from a particular sender to prevent phishing and spoofing.

DNS

DNS stands for domain name system. It translates domain names into IP
addresses and is considered the phonebook of the internet.

DNSSEC

Domain Name System Security Extensions are a set of protocols for securing
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Term

Definition
information provided in the Domain Name System (DNS).

DOI

DOI stands for double opt-in. A subscriber must confirm his subscription two
times before his address is added to a recipient list.

Domain

A domain is the registered name that emails are sent from.

E
Encryption

Encryption in email means to convert a message to be sent into code to prevent unauthorized access through third parties during transit.

ESP

ESP is short for email service provider. An ESP is a company that offers email
marketing solutions or bulk mail services. Optimizely is considered an ESP.

F

Feedback Loop

Some ISPs offer a so-called Complaint Feedback Loop that allows senders to
receive a report every time someone marks their email as spam or junk. Recipients who mark your email as spam are then automatically added to the
account blocklist in Optimizely Campaign.

G

GDPR

The General Data Protection Regulation is designed to protect the privacy of
all EU citizens, including when those citizens engage with businesses located
outside the European Union, by imposing regulations around personal data.

Google Postmaster
Tools

Google’s reputation monitoring tool is used to monitor IP reputation, domain
reputation, spam complaint rate, authentication success and more for campaigns sent to Gmail.

Greylisting

Email greylisting is a method of protecting email users from suspicious emails
with a temporary block. By the next retries, the mails will be accepted. A legitimate SMTP server makes multiple attempts to resend these emails, while its
use is uncommon among spammers.
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Term

Definition

H
Hard bounce

A hard bounce is a permanent bounce that occurs when an email account is
no longer valid.

Header

An email header is a code snippet that contains information about the sender,
the recipient, the email’s route to the final mailbox, authentication details and
other important information.

Honeypot

A honey pot in registration forms is an additional content field invisible to
human beings but usually filled out by bots during a list bombing attack. It is
isolated and used to detect and block abusive attacks on registration forms.

HTML email

HTML stands for Hyper Text Markup Language. An HTML email is designed
with graphics, colors, tables, links and more.

I
Inbox Placement

An email is accepted into an ISP’s network and is delivered to the inbox.

IP Address

An IP address is a number listed in the domain name system that sends mail
on behalf of a domain name. In email marketing, the IP address identifies the
sender and carries a reputation that helps ISPs determine whether they
should deliver a senders emails or not.

ISP

ISP stands for internet service provider. An ISP is an organization that
provides services for accessing, using, or participating on the internet. It is the
place where recipients have set up their email accounts.

L

List bombing

List bombing refers to a practice of abusing and attacking email list subscription pages by bombarding them with a large number of email addresses
at the same time.

List help

The list-help header is an email header that can be added to emails sent via
Optimizely Campaign. It includes a URL showing further details on the receipt
of the email.
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Term

Definition

List hygiene

List hygiene is the practice of continuously cleaning and maintaining a contact list to ensure all email addresses are actively engaging with the content
and are receiving their emails without issues.

List unsubscribe

The list-unsubscribe header is an email header added to emails sent using
Optimizely Campaign. It allows subscribers to see an embedded unsubscribe
button or link they can click if they would like to stop receiving further emails.

M
MTA

A Mail Transfer Agent (MTA) is a mail server software for sending business-critical high-volume emails.

MTA-STS

MTA-STS stands for Mail Transfer Agent Strict Transport Security and is a
mechanism instructing SMTP servers to only communicate with encryption.

MX record

MX record is short for mail exchange record. It maps a domain name to a list
of mail transfer agents for that domain. For the delegated domains in Campaign, the MX record and thus, Optimizely's mail server receiving responses
for example, is set to mail.srv2.de.

O
One-click-unsubscribe

One-click-unsubscribe allows a subscriber to opt out simply by clicking a link
in the email and taking no further action or confirmation. The list-unsubscribe
header is intended to be "one-click".

Open rate

The percentage of subscribers who opened an email out of the total number
of subscribers that received it.

Opt-in

A person subscribes to an email list and explicitly gives a brand permission to
send them emails.

Opt-out

A recipient withdraws the advertising permission from the sender, for example
by clicking the unsubscribe link, in order not to receive any further promotional emails from the sender.
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Term

Definition

P

Phishing

Phishing is a cybercrime in which targets are contacted by email, telephone,
or text message by someone posing as a legitimate institution to lure individuals into providing sensitive data such as personally identifiable information, credit card details and passwords.

Pristine spam trap

A pristine spam trap is an email address that was never a real email address in
the first place. Instead, it is an address that was set up by an email provider or
security company for the sole purpose of monitoring and catching spammers.

PTR record

See Reverse DNS.

R
Recycled spam
trap

Recycled spam traps are email addresses that were previously owned by legitimate subscribers. Since owners abandoned them for an extended period,
they were converted into spam traps by the mailbox provider.

Re-engagement
campaign

A re-engagement campaign is a focused effort to reactivate your inactive
leads, usually by including incentives.

Return path

The return path is an email header that indicates where and how bounced
emails will be processed.

Return path certification

The Return Path Certification, now part of Validity Inc., is based on a commercial allowlist providing delivery benefits at major mailbox providers like
Microsoft.

Reverse DNS
(rDNS)

Reverse DNS, also called the PTR record, does the opposite of DNS. It
resolves an IP address to a host name.

S
Sender domain

A sending domain is a domain that is used to indicate who an email is from via
the "From:" header.
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Term

Definition

Sender reputation

Sender Reputation is a score assigned to a sender based on the quality of his
emails, including metrics like spam complaint rates, spam trap hits and email
authentication. Based on this score, the ISP decides if an email will be
delivered to the inbox, the spam folder, or not at all.

Shared IP

Shared IPs are IP addresses that multiple senders use.

SMTP

SMTP stands for Simple Mail Transfer Protocol for transferring emails over
TCP/IP networks.

SNDS

Smart Network Data Services is the name of the Microsoft reputation monitor,
providing the data needed to understand and improve sender reputation at
Microsoft domains, such as Outlook and Hotmail.

Soft bounce

A soft bounce usually occurs due to server-related problems, such as technical issues on the receiver side, spam-related issues like suspicious content
elements or a problematic sending strategy and is typically temporary.

SOI

SOI stands for single opt-in. A subscriber is added to a mailing list right after
he enters his email address and clicks "Subscribe".

Spam

Unsolicited emails.

Spam complaint

Recipients mark an email as spam or junk or report it to an anti-spam organization.

Spam filter

A software that processes all incoming emails, detects potentially dangerous
elements such as viruses, malware but also spammy content elements and
prevents them from being forwarded to recipient mailboxes.

Spam trap

A spam trap is an email address that is owned or used by ISPs, anti-spam
organizations or blacklist operators to detect and catch spammers.

SpamCop

SpamCop is a spam reporting service. Any users who receive unsolicited
email can report these to SpamCop. Once SpamCop has identified the sender
as spammer, the sending IP is added to the SpamCop Blocklist.

Spamhaus

Spamhaus is a non-profit organization to track email spam. They operate vari-
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Term

Definition
ous blocklists including SBL (Spamhaus Block List), XBL (Exploits Block List),
PBL (Policy Block List), and DBL (Domain Block List). These lists are used by
public ISP and can lead to extensive blocking.

SPF

SPF stands for sender policy framework and is an email authentication
method used by mail servers to verify the sender during the delivery of the
email. The SPF record lists all IP addresses authorized to send on behalf of
the "From" domain.

Spoofing

Email spoofing is the forgery of a brand, of email content and/or the email
header so that the message appears to have originated from a person or
entity either known or trusted by the receiver.

Sub domain

Sub domains are parts of primary domains and are created with a sub domain
name and a dot before the primary domain. For instance, the primary domain
example.com could have a sub domain called web.example.com.

Subject line

The headline of an email that appears in an inbox before a subscriber opens
it.

Subscription

See Opt-in.

T
Throttling

Some ISPs limit (throttle) the amount of email they accept from a particular
sender, during a specified period of time.

Tracking pixel

A tracking pixel is an HTML code snippet which is loaded when a user visits a
website or opens an email. Using tracking pixels, activity can be measured.

Transactional
email

Transactional emails are real-time, automated emails sent to users after a certain action takes place on a platform, app, or website. These are also called
triggered emails.

Trusted Dialog

Trusted Dialog is a quality standard for mass digital communication provided
by United Internet. It ensures the inbox placement at 1&1 domains and
Freenet.
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Term
TXT record

Definition
TXT record stands for text record. TXT records hold free form text of any type
and are used to set mechanisms for email authentication.

U
Unknown user

The term unknown user or invalid user, especially in bounce messages, refers
to non-existing email addresses.

Unsubscription

See Opt-out.

User engagement

User engagement includes all sorts of activity carried out by recipients in
emails, such as opens, clicks, forwards, but also spam markings and deletion. It
is a metric used by ISPs to decide about a sender's reputation.

UWG

The German Law Against Unfair Competition (Gesetz gegen den unlauteren
Wettbewerb) that regulates unreasonable harassment and the sending of
commercial emails without opt-in as an exception.

W

Warming

The warming is the process used to build a good reputation with ISPs, especially when starting as a new sender. It is especially important if you are sending from a dedicated IP address and/or dedicated sending domain.

Exclusive IP addresses
Note: To enable this feature, contact customer support.
If you want to send mailings from exclusive IP addresses instead of the default Optimizely
IP address pool, you can lease one or more IP addresses. These addresses are reserved to
send mailings exclusively from your client. Within 30 days, a reputation trend is visible. The
dispatches of other clients have no influence on the reputation of your IP addresses.
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Tip: A Return Path certification requires exclusive IP addresses.

ISO 27001 certification
Optimizely Campaign's safety management
The ISO/IEC 27001:2013 certification by TÜV Süd gives you as a user the guarantee that
Optimizely's safety management for operation, service and development of email marketing platform complies with internationally recognized standards regarding data and
information security.
In external, multi-stage audits, processes sensible to set up, implement, execute, control,
maintain and optimize information security are evaluated.
In addition to the evaluation of the technical and organizational processes, the handling of
information within the company was scrutinized, for human error has to be taken into
account and made safe.

Your advantages
The internationally recognized certification for information systems according to ISO/IEC
27001:2013 gives you safety and comparability with other systems when choosing the
email marketing service provider that suits you best. With this certification, you can be
sure that your data is hosted, stored and protected against unauthorized access at Optimizely according to defined, approved standards. The certification also covers the operation
and support of Optimizely's dispatch infrastructure. In these aspects, Optimizely Campaign
scores with a highly available, fail-safe and powerful system.

What does ISO/IEC 27001:2013 mean?
ISO/IEC 27001:2013 is a standard for an information security management system that
checks and evaluates the following areas and assets:
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1. Information security management. Information security management evaluates processes, their functionality and infrastructure of Optimizely Campaign by identifying
possible threats, risk handling and responsibilities. It represents the current state and
serves as a base for the PDCA guidelines for continuous improvement of information
security.
2. PDCA guidelines for continuous improvement of information security. These
guidelines for the Plan-Do-Check-Act process define in four phases the suitable measures to determine and evaluate information security; the measures to be implemented
and realized; how these measures and their effectiveness can be verified constantly;
and finally how these measures can be maintained, improved and fixed during operation.
3. Inventory sheet. Assets of the company are registered here. Each asset is evaluated
regarding its priority for information security. Next, a procedure directory is created,
which contains and describes all processes related to this asset.
4. Risk measure matrix. In this matrix, all implemented security measures are correlated
to a concrete risk. With this matrix, the remaining risk can be determined and thus
assured that only a minimal acceptable remaining risk will occur at any time in any process.
5. Compliance. This aspect ensures that all processes are defined within the legal range
and in compliance with the standards set by the legislature.

Who certifies all this and how is the process conducted?
The certification is a multi-stage process and is executed by an external service provider.
The certification of Optimizely Campaign was executed by TÜV Süd. The certification process involves the following steps and phases:
1. Assessment for certifiability. Done prior to the actual certification.
2. Certification audits by TÜV Süd. Multi-stage audits in all security relevant areas and
divisions of the company.
3. Verification audits. Yearly audits, which guarantee the compliance with all standards.
These audits also verify that the information security management is being improved
and developed further. This is a requirement for the certification.
4. Recertification. Every three years, the certification is renewed in an audit similar to
the certification audit (see number 2).
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Apple Mail Privacy Protection
Apple's current operating system versions iOS 15, iPadOS 15, macOS Monterey and
watchOS 8 include the Apple Mail Privacy Protection. The new privacy features restrict the
transmission of tracking information to Optimizely Campaign.
Other email and webmail apps, such as Gmail or Outlook, are not affected by Apple Mail Privacy Protection. However, if your email recipients use Gmail account via Apple Mail, for
example, the privacy features - if activated - also affect them.
Tip: For more information, see Apple Mail Privacy Protection FAQ.

How it works
Apple users decide in Apple Mail whether to enable Apple Mail Privacy Protection. If
enabled, Apple Mail Privacy Protection prevents Optimizely Campaign from tracking email
recipients' opens by using invisible tracking pixels.
Apple caches tracking pixels and external content and automatically generates email
opens. Apple masks the IP address of the email recipient via proxy servers and prevents
the identification of the location and the device as well as the link with other online activities.
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How it affects your email marketing
The open rate in connection with Apple Mail loses considerable significance. Since Apple
caches the emails and fakes opens, the open rates will be higher and the click-to-open
rate (CTOR) lower.
Affected are marketing processes and strategies that use the open rate as a trigger or segmentation criterion, as well as A/B tests in which, for example, a decision is made between
two email subject line variants.
Tip: You can still perform subject line and A/B tests. Note the following tips:
l

l
l
l

Select larger segments (based on the proportion of Apple Mail
users in your mailing list)
Exclude detected Apple Mail users
Use the adjusted open rate as a criterion
Use clicks or conversions instead of opens as a criterion

Further impact:
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l

l

l

Send time optimization. The click behavior of the recipients concerned is considered the
decisive criterion instead of the opens.
Cluster recipients by activity. This feature is less accurate when only the open rate is
considered.
Dynamic content. The loading time when opening dynamic content (e.g. product recommendations or animated GIF countdowns) is falsified.

Measures by Optimizely Campaign
Optimizely Campaign detects automatically generated opens and excludes them from the
KPI analysis for reports, which reduces the open rate. The more users use Apple's new operating system versions, the greater the proportion of automatic opens that are filtered out.
Tip: You can download all automatic opens as a CSV file using
response data export. To do this, contact customer support.
By filtering automatic opens, opens in Apple Mail are determined based on clicks only. This
means that Apple Mail users are not included as synthetic opens in reporting until they
click within the email.
Note: Target groups and triggers that check for non-openers will
(incorrectly) classify more recipients as non-openers than before and
will no longer be reliable. Therefore, adjust your target groups and
campaigns.

Planned measures
Optimizely Campaign is continuously working on solutions to best respond to the Apple
Mail Privacy Protection. The following measures are planned:
l

Target groups for evaluation and segmentation of the distribution list based on automatic

opens
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l

Automatic opens as a measure in Deep Analytics
Tip: You can determine the proportion of Apple Mail users in
Deep Analytics by using the Opens (Absolute) measure and the
Operating System > iOS or Mac and the Operating System Version groupings for your report. See Creating report templates.

Service description
Optimizely Campaign lets you run dialog marketing campaigns on channels and send professional marketing messages by email, Mobile Push, Web Push, or SMS from a single software package.
Optimizely Campaign comes fully integrated with the tools for one-to-one dialogs with
your customers:
l

Omnichannel marketing campaigns

l

One-shot campaigns

l

Marketing Automation

l

Transactional mails

l

Easy creation of professional mailings

l

Opt-in processes

l

Recipient management

l

Powerful segmentation and analysis tools that let you analyze the success of your mailings
for each recipient, and generate reliable data for your marketing research.

Optimizely Campaign communicates with your web shop, customer relations management
system or web analytics service provider to do the following:
l
l
l
l

Automatically display products from your web shop in your messages

Create target groups
Create personalized product recommendations
Consolidate your customer relationships through successful closed-loop marketing
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Optimizely Campaign is TÜV-certified as compliant with ISO 27001 and a member of the
Certified Senders Alliance (CSA).

Omnichannel marketing
Reach your customers on channels with flexible tools for successful omnichannel marketing – using a single provider.
l
l
l
l
l

Email campaigns
SMS campaigns
Push campaigns
Multi-channel campaign automation
Separate blocklist management for each channel

Email
Optimizely Campaign virtually sends your emails in real time. Optimizely Campaign also
comes with deliverability management, which significantly increases deliverability rates.
Range of features
l

l

l

l
l
l
l
l
l

Sending speeds of up to 50 million emails per hour; more than 90% of emails delivered
within the first minute.
Comes with email throttling to let you, for example, avoid unusually high traffic to your
website and stagger customer visits for campaigns that are likely to attract a lot of interest
(such as special offers, prize draws, or surveys)
Enhanced HTML layout for ensuring emails are correctly displayed in webmailers and
email programs
Mobile Fusion provides responsive design for optimized display on mobile end devices
Auto generated text version
Auto generated online version
Landing pages
Can be personalized
Web forms for allowing recipients to register and recipient management
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l

SWYN (share with your network) provides sharing mailing content on social networks
(Facebook, Twitter, WhatsApp, Xing) and via email.

SMS
SMS provides seamless integration of messaging to reach your customers.
l
l
l
l
l
l
l

Supports GSM and UCS2 coding for international character sets
Capable of sending multi-part SMS (concatenated SMS)
Direct message routing to 12 countries
Standard number-based sender identification
Speed-dial number-based sender identification
Alphanumeric character-based sender identification
Can be personalized

Mobile Push
Mobile Push sends automated push messages and reaches every customer who has your

app on their smart phone or tablet.
l
l
l

Available for Android and iOS
App-based opt-in methods
Can be personalized

Web Push
Web Push sends automated push messages and reaches your customers when they open a

web browser.
l
l
l

Available for the most important web browsers
Can be personalized
Preview function
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Campaign management
Smart Campaigns
Smart Campaigns have a convenient front-end for one-shot campaigns. Navigation paths

and click paths are optimized for maximum efficiency.
l
l
l
l
l
l
l
l
l
l
l
l

Create campaigns with drag and drop
A/B tests and automatic send function for the best performing message
Six criteria for selecting the best split
Allows campaigns to be worked on by several users simultaneously
Designed for creating email, SMS and push campaigns
Create campaigns from message templates
Reuse successful campaigns with a single click
Integrated pre-campaign recipient-path-analysis
Integrated post-campaign reporting
Select send dates and delayed delivery in line with A/B test results
Send messages to specific target groups or a limited number of recipients
Optimizely Campaign throttling

Marketing Automation
Marketing Automation lets you automate frequently recurring customer dialogs, such as
welcome and happy birthday messages, reactivation campaigns, abandoned cart emails,
and much more. Marketing Automation event and date-triggered mailings increase conversion rates and let you analyze recipient flows and activities in real time. Marketing Automation furthermore comes with an automated feature for changing recipient data and
moving or copying recipients to different recipient lists.
l
l

l
l

Create Marketing Automation campaigns with drag and drop
Omnichannel. Send out email, SMS, Web Push and Mobile Push messages to different end
devices and target groups from a single Marketing Automation campaign
Create automatic lifecycle marketing campaigns
Send out activity and event-based mailings from a single campaign
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l
l

l
l
l

l

Actively run multiple campaigns simultaneously
Link multiple campaigns, for example, by automatically assigning recipients from one campaign to another
Modify campaigns while active
Post-click-triggered campaigns
Integrated campaign recipient-management (updating, moving and copying recipients/recipient data)
Integrated campaign reporting for active campaigns – monitor the number of recipients
who passed the individual campaign nodes at any time

Transactional mails
Transactional mails are triggered by recipient actions or events, such as an anniversary.

Optimizely Campaign sends transactional mails using a high-performance API (application
programming interface). Transactional mails can be activated in Marketing Automation or
sent through the REST, SOAP or HTTP API.
l
l
l
l
l

Sent through Marketing Automation
Can be sent as email or SMS
Sent in real time using high-performance interfaces
Can be personalized
Can send personalized attachments (HTTP API only)

Opt-in processes
Opt-in processes lets you create and manage your opt-in mailings with Optimizely Cam-

paign and make them reflect your corporate design. The integrated reporting feature lets
you check the number of recipients who completed the registration process.
l
l
l
l

Creation and administration of multiple opt-in mailings in your Optimizely Campaign client
Sent in real time using the transaction API
Edit contents while the registration confirmation is active
Can be personalized
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Content management
Our intuitive content management system (CMS) lets you create appealing, ready-to-send
mails in no time. The modular design makes it easy to insert text and images. You can preview content on different devices (email, web, mobile) while editing. The content management system also can be used to define personalized and group-specific content.

l

WYSIWYG (what you see is what you get) editor
Source text editing

l

Import mailings as zip archives

l

l

Automatic text version generator
Creating, managing, and changing landing pages
Content reports for link validation
Automatic link extensions for click tracking
Manage HTML, text, and mobile link tracking
Personalized and target group-specific subject lines
Automatically creates online version

l

Attachments

l
l
l
l
l
l

Note: The following features are optional. Contact customer support for more information.
l
l

Sending images with offline HTML
Personalized attachments (only when used with transactional mails and the HTTP API)

Template Kit
Template kit lets you define the layout and appearance of the elements in your mailing, to

which you can copy or move content blocks via drag and drop. The basic mailing elements
(such as, sender information) are predefined to create new mailings and make them less
error-prone.
l
l

Predefined pre-header, header, body and footer sections
Grouping paragraphs for creating flexible layouts (1- or 2-column)
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l

Paragraph types for essential applications

l

Target groups and click profiles for use at paragraph level
Nine fonts to choose from

l

RSS feed integration

l

Content interface

l

l
l

l
l

l
l
l

Adding links to social networks (SWYN)
Mobile Fusion for responsive web design – to ensure that your mailings are optimally displayed on mobile devices, with a preview function for conventional device formats
Separately editing HTML, text, and mobile mail versions
Click2Go is a button generator for adding buttons or call-to-action elements in a designconsistent layout, conveniently and directly to your template
Easy edit – split-screen view for previewing the mailing
Inline editing – editing texts directly in the mailing preview
Easy Copy lets you copy and paste individual elements from other mailings or clients
Note: The following features are optional. Contact customer support for more information.

l
l

Installing additional standard web fonts
Custom fonts – installing user-defined fonts

Custom mailing content templates
Custom content templates are set up by customer support on request. Custom templates

are based on your corporate design and style guide and ensure that your newsletters
appear exactly as intended on recipient devices.
l
l
l
l

Template with your corporate design
Template modules designed in line with your design specifications
Layout and design principles based on your style guide
Available features in the Template Kit can be integrated into individual templates
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Coupon system
Coupon system lets you reward mailing recipients with promo coupons. Adding a machine-

readable bar code or QR code to your mailings will allow your customers to redeem
coupons at their local store.
l

l

l
l
l
l
l

Uploading static coupon blocks – if you want to define the structure of individual codes
and number of codes per block
Dynamically generated coupon blocks – if you want Optimizely Campaign to automatically
generate a new, unique coupon code for every email
Bar code blocks with editable layouts (width, height, line weight) based on EAN 13
Creating QR codes
Static block thresholds for triggering mails
Deleting unused codes from static blocks
Downloading coupon code assignments

Countdown timers
Countdown Timers display the days, hours, minutes and seconds remaining to when your

offer ends to increase the attention of your recipients and conversion rate.

l

Supports static and animated countdown timers
Editor for designing, editing, and managing countdown timers

l

Field function for mailing integration

l

Segmentation
Target groups
Successful dialog marketing: Target, attract, inform and engage your customer segments
with custom content. Optimizely Campaign helps you define target groups to ensure that
your mailing content and subject lines are relevant to every one of your recipients.
l
l

Recipient-based filter criteria, which can be based on any recipient list field
Action-based criteria, such as clicks, open, hard and soft bounces, and post clicks
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l
l
l
l
l
l
l

Campaign-based criteria for linking several Marketing Automation campaigns
Use of operators: contains, starts with, ends with, equals
Use of mathematical operators for numeric fields
Use of time-based operators for date fields
Boolean operators (true or false)
Instant target group analyses
Ad-hoc target groups created from Live Analytics segments with a single click

Click profiles
Categorize your recipients’ clicking behavior with click profiles. Rule-based click profiles
provide information about your campaign's performance, instead of complex individual
mailing and campaign analyses.

l

Cross-campaign click profiles
Manually assign click profiles
Rule-based click profile assignments based on wildcards

l

Rule-based click profile assignments based on regular expressions

l
l

Analysis tools
Performance Dashboard (Beta)
The Performance Dashboard (Beta) lets you display KPIs using charts for visually appealing
presentations of your mailing activities.
l
l
l

Various charts available: KPI chart, basic chart and bubble chart
Time-based and mailing-based analysis
Individually customizable

Deep Analytics
Deep Analytics provide in-depth and highly detailed mail-based reports about your cam-

paigns’ success to effectively targeting your recipients and further develop your
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omnichannel marketing.

l

User-friendly report builder with graphical interface
Create reports with drag and drop
Choose from up to 28 analysis measures

l

13 groupings

l
l

l

Predefined basic reports for campaign and progression-based analyses
Automatic raw data analyses for reports based on high-performance database algorithms
Post-click analyses with external web analytics tools
Global report parameters based on clients, time intervals, target groups, mailings and mailing types
Choose from different diagrams (bar charts, line charts, regional and pie charts)

l

Aggregation of comprehensive reports in pivot tables

l
l
l
l

l
l
l

Seamless integration with Microsoft Excel
Configurable report templates in your corporate design
Automatic report generation and distribution by email

Live Analytics
Live Analytics lets you generate recipient-based reports and create real-time RFM analyses

to boost your campaigns’ profitability and return on investment (ROI).
l
l
l
l
l
l

Analyze data by recipient lists, list fields, and target groups
Edit analysis fields in real time in the detail view
RFM analyses for boosting your sales
Graphical representations and segment
Funnel analysis segments of a diagram with a single click
Create target groups with a single click

Deliverability preview
The deliverability preview lets you check your mailing before dispatch, whether the contents are displayed correctly and whether your mailing has been classified as spam by the
most common email providers.
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l

l

Preview how the graphics and fonts in your mailing are displayed by the most common
email providers and browsers
Check spam suspicion with the most common email providers

Post-click tracking
Post-click tracking lets you analyze actions by email recipients on your website, like clicks
on products or canceling of orders. Use Deep Analytics to analyze and display the generated data.
l
l
l

Filter by date or time range
Import mailing-independent customer actions
Integrate external web analytics software

Visual link analysis
Visual link analysis instantly shows the number of times the links in a mailing were clicked.

The analysis is performed directly inside the mailing itself, which means that you can see
whether links in particular locations are clicked more or less frequently.

l

Analyzes absolute and unique clicks
Proportional analysis based on recipients or clicks

l

Visual link analysis of post clicks

l

Attention analysis
Attention analysis let you assess the impact of your mailings, templates, and landing pages’

layout on viewers. Based on eye-tracking, this tool graphically represents analysis results
which indicate if the most crucial elements of your mailing (logo, offer price and period,
call-to-action) are located to effectively attract the viewer’s attention.
l
l
l

Perception map analyzes which features of a mail a viewer focuses on first
Attention map for analyzing which elements in your mail attract the most attention
Visual attention prediction for predicting the order in which mailing elements attract attention
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l

Analysis of draft layouts of existing mailings or screen shots means layouts can be optimized during the design phase

Activity overview
Activity overview shows mailings for a defined period in a single, clearly laid-out screen.

This lets you obtain information relevant for evaluating your marketing activities, such as
which customer dialogs you have sent, are currently sending, and are about to send.
l
l
l

Evaluate multiple clients at once
Filter by mailing types, media types (marketing channels) and mailing status
Transactional mails and registration confirmations are supported

Integrations and additional functions
Optimizely Campaign seamlessly integrates all major web analytics, e-commerce and CRM
systems. You can use programming interfaces (APIs) and extend Optimizely Campaign with
various additional functions. In addition, Optimizely constantly develops new custom features for you.

Web analytics integration
Optimizely Campaign seamlessly integrates commonly available web analytics tools. Benefit from bi-directional data exchange: The most important statistics are sent to the analytics software, and segments relevant for your Optimizely Campaign remarketing
campaigns are available in the feedback channel.

Google Analytics
You can use Google Analytics to monitor the success of your marketing campaigns and further optimize them. Optimizely Campaign sends mailing and campaign parameters to
Google Analytics. The Google Analytics dashboard gives you access to campaigns and an
overview of the costs and revenues related to your campaign.
l
l

Unidirectional data exchange
Mailing ID, mailing name and description, mailing type, and dispatch date are transmitted
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l
l

Recipient list fields are transmitted
Time and campaign-based analyses available in Google Analytics

Google Tag Manager
With Google Tag Manager you can implement tracking codes and conversion pixels on your
website and create data about user actions. By using the integration you can transfer this
data to Optimizely Campaign.
l
l
l

Identification of customers/recipients via the RecipientID
Data transfer to Optimizely Campaign
Creation of target groups in Optimizely Campaign

intelliAd
IntelliAd integration for Optimizely Campaign lets you evaluate your email campaigns using

intelliAd.
l
l
l

Unidirectional data exchange
Link tracking using link extension
Analysis of clicks over time for just the email channel or together with other marketing
activities in the intelliAd dashboard

E-commerce integration
Securely send order and dispatch notifications, double-opt-in emails, or entire campaigns.
Seamless and automatic E-commerce integrations with Optimizely Campaign matches
recipient data and recipient status and imports product data directly into your message
template. You further benefit from the performance and reputation of Optimizely's dispatch infrastructure.

Magento 1 integration and Magento 2 integration
Take advantage of the performance available from Optimizely Campaign in combination
with the Magento e-commerce platform. The Integration includes synchronization of recip-
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ient data including logins and logouts, export of the product catalog, and sending transactional mails via SMTP and HTTP.
l
l
l
l

l
l
l
l
l
l
l

Available for Magento CE 1.7 to 1.9, Magento EE 1.12 to 1.14, Magento CE 2.0 to 2.1
Processing of subscriptions and unsubscriptions via Optimizely Campaign
Synchronization of recipient status between the shop system and Optimizely Campaign
Transfer of further recipient data from the shop to Optimizely Campaign to personalize
your mailings
Adaptability of the data model for data exchange
Multi-client capability through support of subshops and storefronts
Sending transaction mails via the SMTP API
Sending transaction mails via the HTTP API using the templates in Optimizely Campaign
Export of the product catalog as CSV file for use during mailing creation
Configurable confirmation pages
Transfer of further data fields from the web shop to Optimizely Campaign for further personalization of your mailings

Shopware
Take advantage of the performance available from Optimizely Campaign in combination
with the Shopware e-commerce platform. Recipient data is automatically synchronized –
including registrations and canceled subscriptions.
Shopware integration also exports the product catalog from your web shop to Optimizely
Campaign and makes product data available in your template via a content interface. Use
the features of Optimizely Campaign to personalize, automate and evaluate newsletters for
targeted cross and up-selling. Benefit from high delivery rates and the reputation and performance of Optimizely's dispatch infrastructure.
l
l
l
l
l
l

Available for Shopware Professional and Professional Plus
Newsletter registrations and subscription cancellation processes
Newsletter containing dynamic shop products
Configuration of multiple clients
Automated, cyclical product data import
Send transactional mails via Optimizely Campaign
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CRM integration
Bi-directional CRM integration lets you send campaigns to your contacts and leads using
Optimizely Campaign. Personally address your customers with customized content and
evaluate the success of your campaigns directly from within your CRM system.

Mirosoft Dynamics CRM
Plan, start, evaluate successful campaigns in Mirosoft Dynamics CRM and benefit from the
power and above-average delivery rates of Optimizely Campaign: Use your comprehensive
CRM database to create email and SMS newsletters with high conversion rates. Use your
data to generate extensive and original customization. Delivery and a perfect layout are
guaranteed. The bi-directional connection means you can monitor success directly from
within your CRM system.
l
l
l
l
l
l
l

Available for Mirosoft Dynamics CRM and On-Premises
Supports Mirosoft Dynamics CRM versions 2015, 2016 and Mirosoft Dynamics 365
Omnichannel campaigns via email and SMS
High-performance dispatch infrastructure with excellent delivery rates
Precisely measure the success of CRM campaigns
Transfer personal data from the CRM such as salutation, name, city and post code
Import response data in your CRM such as openings, clicks, returned emails, canceled subscriptions and bounces

Salesforce
Plan, start, evaluate successful campaigns in Salesforce and benefit from the power and
above-average delivery rates of Optimizely Campaign: Use your comprehensive CRM database to create email and SMS newsletters with high conversion rates. Use your data to generate extensive and original customization. Delivery and a perfect layout are guaranteed.
The bi-directional connection means you can monitor success from within your CRM system.
l
l

Available for Enterprise Edition, Unlimited Edition, and Performance Edition
Omnichannel campaigns via email and SMS
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l

l
l
l

Export standard segmentation and personalization fields from Salesforce into Optimizely
Campaign
Export additional customer-specific fields to Optimizely Campaign
Multi-stage campaigns in Salesforce
Automatic response data synchronization

APIs
Smart and flexible: Optimizely Campaign offers a range of comprehensive programming
interfaces (APIs) to automate your marketing activities.

REST-API
The REST API is a convenient alternative to the SOAP API that lets you manage and control
Optimizely Campaign features from external systems by using HTTPS requests. In contrast
to the SOAP API, you can also manage Smart Campaigns. In total, Optimizely provides
more than 200 operations in over 16 different web services for this purpose. You can
retrieve data from and send data to Optimizely Campaign via REST API. See the Optimizely
Campaign SOAP API documentation for information.
l
l
l
l

Bi-directional secure data exchange
Almost all features of Optimizely Campaign can be executed
Over 16 web services and more than 200 operations available
Webhooks for receiving real-time event data on your mailings

SOAP API
The SOAP API lets you control Optimizely Campaign from external systems using a variety
of programming languages and environments. More than 250 operations in 18 different
web services are provided for this purpose. The interface is bi-directional. Data can be
both retrieved from and sent to Optimizely Campaign. See the Optimizely Campaign
SOAP API documentation for information.
l
l
l

Bi-directional secure data exchange
Almost all features of Optimizely Campaign can be executed
18 web services and more than 250 operations available
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l

Optimizely Campaign provides pre-configured programming libraries for Java and PHP to
make connecting external systems easier

HTTP API
The HTTP API can be used to register new recipients, manage blocklists and subscription
cancellation lists, for personalized tracking and for sending trigger and transactional mails
– also with personalized attachments. The HTTP API operations can be embedded into
emails, web forms and online shops. See the Optimizely Campaign HTTP API documentation for information.
l
l
l
l
l
l
l

Secure integration and data exchange
Easy to configure API calls
Confirmation of execution is returned for each operation
Can be used in emails and web forms
Transfer personal data for sending personalized transactional mails
Personalized attachments (for example PDFs)
High-performance transactional API for high volume dispatch

SMTP API
The SMTP API offers a simple solution for sending campaigns via the high-performance
infrastructure and lets you benefit from the reputation of the Optimizely Campaign server.
After setting up a special SMTP client, you can continue to create your mailings using your
usual software package. Mailings are sent via Optimizely's high-performance server that is
recognized by major providers. You benefit from the reputation and performance of Optimizely Campaign with minimal modifications.
l
l
l
l

Above-average high email delivery rate and sender reputation
Monitor the mailing process using Optimizely's deliverability experts
Seamless integration into existing system architectures
Mailing creation and recipient management continue to be carried out in your current system—no need to retrain staff
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Additional interfaces
Content interface
Link external product databases to the content interface or content management system to
display your shop products in your mailings. Just a few clicks are needed to create your
product offer: the Optimizely Template Kit provides pre-configured paragraphs for linking
and creating layouts for product data according to your corporate design guidelines.
l
l
l
l
l
l
l

Product paragraph for embedding individual products
Content interface paragraph for embedding several grouped products
Up to 10 text elements per article
Up to 3 links per article
Up to 6 images per article
XML and CSV formats
HTML/CSS formatting

Translation interface
The translation interface from Optimizely Campaign lets you send the texts for your mailing
to a translation service provider. The service provider returns the translated content. Your
mailing templates apply the relevant language to ensure that a localized mailing is sent to
each target market.
l
l
l
l

Data exchange using standard XML format
Link to practically all translation providers
Automatic creation of mailings in target language
Automatic requests for the status of a translation ensures that mailings are only sent when
the translation is complete

Closed-loop Interface
The bi-directional and flexible closed-loop interface lets you integrate data from your data
warehouse or campaign management system into Optimizely Campaign. The import module is used to send selected recipients and personal data to Optimizely Campaign. A
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mailing filled with this data is then sent. The export module provides send and response
data for the feedback channel. This data is automatically fed back to your system.
l
l
l
l
l

Secure data exchange over SFTP or SOAP API
Import and export using the standard CSV format
Referencing of content, for example, image stored on remote systems possible
Import personalization information and product recommendations
Automatically generate a send log and response data (openings, clicks, returned emails,
canceled subscriptions) for export to the feedback channel

FTP interface
This high-performance and universal interface lets external data storage systems to
securely synchronize with Optimizely Campaign.
l
l
l
l
l

Import and export large amounts of data in CSV format
Secure data transfer via an SFTP connection
Import data at regular intervals or when changes are made
Automatic further processing of data by clients
Import and export recipients, canceled subscribers, blocklists and multiplier lists

Dispatch and deliverability
Dispatch
You can send messages (even high volumes of messages) immediately or use delayed dispatch. You can also split mailings and send different content to different target groups.
In addition, you can test every message before sending it. To do so, select a number of test
addresses and lists, start separate tests for text, HTML, and multi-part messages, and simulate the messages’ dispatch to the different groups.
l
l

l

Sending speeds of up to 50 million emails per hour
Throttled dispatch (for example, for campaigns likely to drive a high level of traffic to your
web shop). Throttled dispatch lets you control and manage follow-up traffic.
email can use international ISO-8859-1, ISO-8859-2 or UTF8-compliant character sets
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l

SMS message routing to 12 countries
o

SMS delivery using international GSM and UCS2 data coding
Note: The following features are optional. Contact customer
support for more information.

o
o

Target group-based SMS delivery to specific regions using telephone dialing codes
SMS delivery with sender recognition using individual short codes (on request, exclusive code) or long codes

Send time optimization
Customize the time your messages are sent. The send time optimization identifies when
your recipients interact with their inbox, and sends your message when they are most
attentive.
l
l
l
l
l
l

Available for Smart Campaigns
Available for A/B tests
Self-learning algorithm, continuously adapts to recipient behavior
Very flexible, virtually infinitely adjustable for up to 7 days
Analysis function evaluates individual dispatch times
Fallback time for new recipients for whom behavior data is not yet available

Deliverability management
Optimizely’s deliverability team monitors mail delivery and takes proactive action to ensure
high sending rates. This includes collaborating with providers and organizations to develop
optimal strategies for improving deliverability – regardless of the growing complexities of
spam filters. See also Best practices for good deliverability.
l
l

l
l

Active deliverability management and monitoring
On-boarding deliverability – Optimizely's deliverability team performs an advance analysis
of the requirements for ensuring the deliverability of your messages
Optimizely is a member of the Certified Senders Alliance (CSA)
Provider relations and Optimizely server allowlisting ensure high delivery rates
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l
l

l
l

l

Mails comply with formatting standards for email headers and HTML
Automatic steering of the optimal sending speed – ensuring that emails are accepted by
providers
Automatic server switch in case of delivery problems to prevent email loss during sending
Blocklist monitoring – Optimizely's deliverability team constantly monitor the blocklists of
major providers and takes immediate action if an Optimizely IP is accidentally listed there
24/7 open and click rate monitoring and provider comparisons for messages
Note: The following features are optional. Contact customer support for more information.

l

l
l
l

Progression analysis of open and click rates in your clients to identify and resolve deliverability issues
SSL certificate for your sending domain
Multiple sending domains for your use
Dedicated IP pool for your exclusive use

Security and availability
You benefit from maximum data safety and consistent Optimizely software and service
availability.
l

l
l
l
l
l
l
l
l

ISO 27001 certified by TÜV to guarantee the security of the operation, service, and devel-

opment of the software
Hosted in a Tier IV, high-security data center
Redundant server structure
Continually updated firewall hardware for blocking hackers
SSL-encrypted connections
Split-second main database replication
Daily data backup
Automatic application and service availability monitoring
24/7 system administrator helpline
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Recipient management
Systematically collecting and analyzing customer data is key to running effective email
and omnichannel campaigns. Optimizely Campaign comes with a number of options for processing different data sources and using these to boost your performance.

l

Easy-to-use list-based recipient management
Unlimited number of potential recipients

l

Unlimited number of recipient lists

l

Manual recipient import using standard CSV

l

l
l

l
l
l
l

l
l
l

l

l

Automatic duplicate identification during import
Automatic data validation during import (mandatory fields, correct email addresses and so
on)
Download of duplicates and faulty datasets for reviewing and archiving purposes
Export complete and filtered recipient lists
Integrated subscription process based on double opt-in or confirmed opt-in emails
Tracking opt-out option that enables recipients to disable personal data tracking in accordance with statutory regulations. This does not impact anonymized campaign-specific data
tracking.
Integrated unsubscribe request management in accordance with statutory regulations
Fully integrated unsubscribe links in mailing templates
Records subscriptions, opt-ins, and unsubscribe requests with IP and time stamp for your
records
Recipient data enrichment with third-party system data, such as web analytics, CRM, ecommerce, recommendation engines, and other data sources using high-performance
automated interfaces
Recipient history: Entire message history for each recipient in an easy-to-read format,
including action data (opens and clicks)
Note: The following features are optional. Contact customer support for more information.

l

Automatically import and export recipients using FTP protocol and standard CSV file

l

Recipient data encryption
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l
l
l
l
l

Subscription form
Preference Center form
Delayed subscription confirmation emails
Separate recipient list data storage available on request
Development of an individual data management concept by Optimizely consultants

Blocklist
Recipients whose email addresses are on the blocklist are no longer sent any mails. This
also applies if these recipients subscribe to emails again later, even if they do so multiple
times.
l
l
l
l
l
l
l
l
l
l

Client-wide blocklist
Blocklist inheritable by sub-clients
Manually add recipients to the blocklist
Manually import blocked recipients from a CSV
Search the blocklist for datasets
Delete datasets from the blocklist
Use of wildcards to block entire domains or email addresses using key words
Global blocklist with email addresses that may not be contacted
Automatic feedback-loop recognition and addition to blocklist
Automatic external blocklist cross-checks via interfaces or linked databases

Responses and bounce management
Regardless of whether they are hard or soft bounces, or genuine replies, Optimizely Campaign automatically filters and processes responses by category.
l

l
l

Integrated response management with a display function for viewing responses or
responses associated with a specific mailing
Automatic response analysis using more than 150 filter rules
Automatic hard bounce, soft bounce, autoresponder, genuine reply/other, suspected
spam categorization
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l

l

l
l
l

l
l
l

Create special categories using defined rules, for example, returned emails that contain
the word order
On request, responses from selected categories can be forwarded to freely selectable
email addresses
Content display and print function for responses or genuine replies
Integrated bounce management divided by hard and soft bounces
Recipients are disabled when reaching the specified bounce limit to protect the reputation of your mailings
Individually adjustable bounce limits for hard and soft bounces
Bounce statistics for email and SMS
On request, you can automatically export bounces using FTP protocol and standard CSV
file

System user and permission management
As the administrator of your client, you can create new users and define user permissions
down to the smallest detail.

l

Easy-to manage user roles
Assign permissions and user roles for specific periods
Assign each user permissions for every client
Assign each user a number of user roles for every client
User permissions are inheritable by sub-clients

l

Assign permissions separately for each marketing channel (email, Push, SMS)

l

Password and PIN-protected user logins

l

Users can change passwords

l
l
l
l

Service
Working with Optimizely Campaign means benefiting from the advantages of powerful and
intuitive software, and comprehensive customer service and support services.
l

l

Expert customer services delivered by project managers, engineers, and strategy-oriented
marketing experts
Multilingual customer services in German, English and Polish.
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l
l
l
l

Helpline team available Mon-Fri, 9 AM - 6 PM CET, by telephone, email and fax
Free regular webinars
Manuals, specialist documentation, and best practice guides
Manuals available offline as PDFs
Note: The following services are optional. Contact customer support for more information.

l

Full-service campaign package. On request, Optimizely offers complete project man-

l

agement of your newsletter mailing campaign – from creating to analyzing your campaign
Customized campaign strategies, designs and analyses with Optimizely consulting
Knowledge transfer in practice-oriented seminars and workshops

l
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Campaigns
This section shows how to create, edit, or test campaigns and send out mailings through
channels: email, text messages and push messages.
l

Smart Campaigns. Create, edit, and send one-shot campaigns.

l

Omnichannel campaigns. Special notes for Web Push, Mobile Push and SMS.

l

Marketing Automation. Automate campaigns.

l

Transactional mails. Set up and edit transactional mails.

l

Opt-in processes. Create and manage opt-in mailings.

l

Message templates. Create and edit message templates.

l

A/B test. Set up and execute A/B tests.

l

Send time optimization. Deliver your message at the exact moment when recipients open

l

their inbox and read their email.
Validate mailing prior to dispatch. Information on the automatic parameter test before dispatch.

l

Send automatic notification after dispatch. Information on automatic notification after dis-

patch.
l

Mailings Classic. Information about the classic, one-shot campaign. (This feature is deprec-

ated and replaced by functions of Smart Campaigns)

Smart Campaigns
Smart Campaigns is a marketing tool for sending out one-shot-campaigns, such as an
event invitation or special Christmas offers. In Smart Campaigns, you can send messages
via the following channels: email, SMS, Mobile Push and Web Push.
Use Smart Campaigns to create, start, monitor and evaluate regular campaigns. You create
and edit these campaigns on a graphic desktop, and access the elements that make up a
campaign (recipients, target groups, A/B test and the message) from the tool list in the left
panel.
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To use Smart Campaigns, open the Optimizely Campaign menu and select Campaigns
> Smart Campaigns.

A list of Smart Campaigns appears in the top half of the window. The Status column shows
whether a campaign was activated or sent.
Because a Smart Campaign's elements and parameters are displayed visually, you can control and optimize it. After you activate a campaign, the Smart Campaigns working area displays feedback on it.

Campaigns and messages
Every Smart Campaign must have at least one message. Both campaigns and messages
appear in the Campaign Overview in the Smart Campaigns window. A message begins
with three dots (...) and is located below its campaign. The following conditions and relationships apply:
l
l
l

l

A message must belong to a campaign.
To send a campaign, you must include a message.
A message's media type (email push or SMS) must match its campaign's marketing channel.
If your campaign uses the A/B Test (split test) node, you must create two versions of the
message. See A/B test.

Campaign types
You can select from the following campaign types, each of which is sent via different channels. A Smart Campaign's recipient list must be compatible with its marketing channel.
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l
l
l

l

Email. Sends email to recipient of type Email or a multiple list.
SMS. Sends SMS message to recipient of type SMS or a multiple list.
Mobile Push. Sends push messages to the Android or iOS device to a recipient of type
Push or a multiple list.
Web Push. Sends push messages that appear in the recipient's web browser. The recipient list must be a multiple list or of type Push.

Campaign status
l

l

l

l
l

l
l

Incomplete. Elements are missing or necessary parameters are not defined. You cannot
activate or start a campaign in this status.
Activation required. Contains necessary elements and parameters. To send campaigns
manually, activate the campaign before starting it.
Activated. The campaign is activated and can be started (sent). Campaigns with a specified sending time are sent automatically when activated.
Sending. A campaign 's messages are being sent.
Paused. The sending process is paused manually, or the splits of an A/B test with manual
optimization are ended. Click Start to restart the campaign or Cancel to end it.
Canceled. The campaign is canceled and cannot be restarted.
Sent. The campaign is sent.

Actions
Use the buttons below the campaign overview to perform these actions:
l

Create

l

Copy

l

Edit

l

Delete

l

Start/Activate

l

Copy to client

l

Merge content

l

Analysis

l

Send test message
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Note: Some actions are not available for incomplete or sent campaigns.

Create
Creates a new campaign. See Creating and editing a campaign.

Copy
1. Click a campaign in the list.
2. Click Copy….
Use Copy if you regularly send similar campaigns. You can quickly make minor adjustments to values in the copied campaign. Campaign elements (recipients, target groups,
messages, and so on) are applied.
Note: Limitations
l
l
l

Individual messages in the list cannot be copied.
Messages are not stand-alone; they belong to a campaign.
You can reuse messages by selecting a message in the Selecting the type of
content step.

Note: To migrate Mailings Classic mailings to Smart Campaigns, see
Mailings Classic.

Edit
To edit a campaign:
1. Click a campaign in the list.
2. Click Edit….
See also Creating and editing a campaign.
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To edit a message:
1. Click a message in the list.
2. Click Edit….
Note: Limitations
l
l
l

Sent campaigns cannot be edited.
Individual messages cannot be copied.
Messages belong to a campaign.

Delete
To delete a campaign:
1. Click a campaign in the list.
2. Click Delete.
To delete a message:
1. Click the campaign to which the message belongs.
2. Click Edit….
3. Hover over the message node and click

.

Note: Limitations
l
l
l

Sent campaigns cannot be deleted.
Individual messages cannot be deleted.
Messages belong to a campaign.

Activate/Start
After a campaign is completely defined, its status changes to Activation required, and
the Activate button appears.
Before you can start a campaign, you first need to activate it.

© Optimizely 2022

178 | Optimizely Campaign User Guide 2022-03-14

1. Select the campaign and click Activate.
Note: After you activate a campaign, messages linked to a Wait
node are automatically started at the specified time.
2. Click Activate Campaign in the dialog box. The button changes to Start.
Tip: When activated, the campaign is validated along with parameters (recipients, target groups, message).
3. Click Start to begin sending a campaign's messages with the specified parameters (target groups, reductions in sending speed, and so on).
l
l
l

You can activate campaigns only, not messages.
Incomplete campaigns cannot be activated or started.
You can start either a campaign or its associated messages.

Tip: You can automatically send a notification to an email address
after a mailing is sent. See Sending automatic notification after dispatch.

A/B tests on activating/starting a campaign
If a campaign includes an A/B test, you will be able to start the splits for this campaign individually.
If you have selected the Start optimization manually option in the A/B test, then select
all campaign splits after the campaign has been sent, and then click Optimize to send the
optimized message to the rest of the distribution list.

Copy to client
Copy campaigns to other clients. Recipient lists and target groups are not transferred to
the target client.
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Note: Prerequisites
l

l

The registered user must have permission to create mailings in the target
client.
The target clients must have the template used in the campaign that you
want to copy.

1. In the campaign overview, select the campaign and click Copy to Client…. The Copy
Campaign to Client window opens.
2. In the New Campaign Name in the Target Client field, enter the name for the copy
of the campaign in the target client.
3. In the Target Clients area, select the client to which you want to copy the campaign.
Tip: To select all available target clients, check the box in the
menu bar.
4. Click Copy.

Merge content
Merge mailing content from different campaigns into a new campaign. Recipient lists and
target groups are not transferred to the target client.
Note: Prerequisites
l

l

The registered user must have permission to create mailings in the target
client.
The mailing of the target campaign must have the same content elements
as the template you want to merge.

1. In the campaign overview, select the mailing and click Merge Content…. The Merge
Content window opens.
2. In the New Campaign Name in the Target Client field, enter the name for the copy
of the campaign in the target client.
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3. In the Content Elements area, select one or more content elements from the template you want to merge with the target campaign. The corresponding content elements of the target campaign's mailing will be replaced with these content elements.
4. In the Target Campaign area, select the target campaigns with which you want to
merge the template's content elements. The new campaign will be created in the client of the target campaign.
Tip: In the Target Campaign area, the last 10 created campaigns
per client are displayed. You can select multiple campaigns. To
select all available campaigns, check the box in the menu bar.
5. Click Merge.

Analysis
1. In the campaign overview, click a campaign then Analysis. The Campaign Analysis
window opens.

At the top right, a summary of the campaign is displayed. Additionally, the number of
recipients is displayed for each individual node.
2. To update the analysis, click New Analysis.
3. To view the Send Time Optimization Overview (additional feature), click the corresponding Wait node or A/B test node.

Message preview
To preview a message, click the corresponding message node. The content preview opens.
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The following options are available in the preview:
l

l

Displays available subject lines.
Target Groups. When active, select one or more target groups and click Submit Selection to display only the paragraphs assigned to the selected target groups.
The buttons only become active when you use a target group in at least one para-

l

graph.
o

Click

to show the respective assigned target groups in the individual paragraphs.

o

Click

to deactivate the display of assigned target groups.

If you do not want to enable or disable the display of target groups, but rather just the
display of a single target group, click the relevant paragraph.
l

Container paragraph. Paragraphs that contain several sub-paragraphs with their own target groups are marked in the content preview as container paragraphs. Container paragraphs are highlighted with a yellow border.
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Note: The target groups applied in container paragraphs are automatically carried over to sub-paragraphs included. If you hide target groups in container paragraphs using the button target
groups, not only is the container paragraph hidden, but also the
sub-paragraphs it contains.

Note: Paragraphs that contain several sub-paragraphs without
their own target groups are not marked as container paragraphs
or highlighted in yellow, but instead are displayed with a simple
gray banner. However, the target groups for these paragraphs are
also carried over to sub-paragraphs.
l

l

l

Recipient Selection for Personalized View. To display a personalized preview with the
data of a specific recipient, in the left column, select a recipient list. Then, in the right
column, select the recipient.
Change View. The tab bar on the upper left border includes the HTML, mobile and text
message previews. In the HTML preview, the mailing appears as it will later appear in the
recipients’ inboxes. Under the Mobile tab, you can view the message as it appears on
mobile devices. The Text tab displays the automatically-generated text version of the mailing.
Save Result as Image or Save Result as PDF. Click to save the message template as an
image.

Send test message
Send a test message to check the appearance of the mailing before the actual dispatch.
See Smart Campaigns nodes.

Creating and editing campaigns
This topic describes how to create and edit a campaign in Smart Campaigns. A campaign
consists of campaign elements (nodes) that you configure and connect together. Also learn
how to use campaign drafts.
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Creating a campaign
1. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
2. Click Create….

3. In the Select a Campaign Draft window, in the Draft drop-down list:
l
l

To create a new campaign, click ---Empty draft--- then Apply.
To edit an existing draft, select one from the drop-down list and click Apply.
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4. Drag the nodes from the left action area to the working area on the right. See Editing
nodes.
5. Click Save or Save and Close.
6. In the dialog box, enter a name for the campaign and click Save.

If you neglect to insert elements or parameters, a notification appears. To save the campaign anyway and complete the missing details later, click Force Save, or Keep
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Editing and complete the missing details. The new campaign is displayed in the Smart
Campaigns overview.

Editing a campaign
To edit an existing campaign, select the required campaign from the list in the Campaigns
window and click Edit. Proceed as described from step 4 in the Creating a campaign section.

Editing nodes
The campaign modules for Smart Campaigns are called nodes, and they appear in the left
action area.
Required elements:
l

Recipients

l

Message (Email, SMS, , Web Push or Mobile Push)

Optional elements:
l

Wait

l

Block

l

Throttle

l

Limit

l

Segment

l

Target Groups

l

A/B Test

Tip: For details, see Smart Campaign nodes and elements.
Editing options for nodes and connections include:
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l

l

Insert. Drag and drop a node to the working area.

Connect. Click the node and draw a connection to the target node. Each node has connection points at the right, left, upper, and lower side and in the middle.
Note: A campaign node must connect other nodes.
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l

Delete. Hover over the item and click

. Alternatively, select the item and press [Del].
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l

Properties. Hover over the item and click

. Alternatively, double click the item.

Editing tools
l

Undo (CTRL + Z) . Revoke the last action. Every additional click revokes another
action.

l

Redo (CTRL + Y). Restore previously-revoked action. Every additional click restores
another action.

l

Cut (CTRL + X). Cut out selected items and temporarily copy them to the clipboard.

l

Copy (CTRL + C). Copy selected items to the clipboard.

l

Paste (CTRL + V). Insert elements you previously cut out or copied.
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Navigating tools
l

Zoom in. Zoom in the working area. Each click magnifies the working area to the next
zoom level.

l

Zoom out. Zoom out the working area. Each click reduces the working area to the next
zoom level.

l

l

l

Actual size. Restore original view.
Fit on screen (Show all). Display all items in the working area.
Minimap. Navigate a campaign by dragging the yellow rectangle in the left action area to
the place you want to go to. To zoom in or out of the working area using the minimap, click
and drag the bottom right corner of the yellow rectangle either to the left (zoom in) or
right (zoom out).

Campaign drafts
When you create or edit a Smart Campaigns, a draft version is saved periodically. If the
campaign is closed unintentionally, you can retrieve the latest version. To do that, click
Create and select the draft from the Select Campaign Draft window.
Note: Drafts are saved with the date and time. You can use the
timestamp to find even unnamed campaigns that have not been
manually saved.

Smart Campaigns nodes
This topic describes required and optional elements in Smart Campaigns. Nodes define
those elements and transfer them to the connected node. By connecting nodes in a logical
manner, you define the sequence of activities that make up a campaign.
For example, use the Recipients node to select one or more recipient lists and transfer
their recipients to the message node. When you start the campaign, this message is sent to
the transferred recipients.
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Grayed out node
A node may be grayed out for several reasons.
l

l

l

l

A campaign already used one media type (marketing channel). For example, if you drag an
Email node to the desktop, the Print and SMS nodes are deactivated.
You already used that node type. The Recipients, Limit, Target Groups and A/B Test
nodes can only be used once per campaign.
You lack permissions. For example, you have permission to send email campaigns but not
SMS campaigns.
The marketing channel is not configured in your client.

Required elements
A campaign must include a Recipients node and a message node (Email, SMS, Mobile Push,
Web Push), before you can start it.

Recipients
Parameter

Description
Select one or more recipient lists to which to send the messages.

Recipient Lists

Note: The recipient list type must be compatible
with the message type being sent. For example,
you can only send a print message to a print recipient list (or a multiple recipient list).
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Email
Parameter

Description

Name

Enter a name for the message. This name is only used internally.

Description

Enter an optional message description.

Edit Content…

Click to add content, then perform the steps described in Editing message content.
1.

Click to start a test dispatch. The Send Test Message window opens.

2.

In the Recipient List drop-down list, select a list with test recipients.

3.

If you want to simulate a target group, select a target group in the Simulate Target Group drop-down list.
Tip: The test recipients selected in the next step
can also belong to other target groups.

Test Email…

4.

In the Recipients list, select one or more test recipients.

5.

Click Send Email to send the test messages in multi-part format, or click
Send HTML Version or Send Text Version if you want to test only one
format.

SMS
For more information, see SMS.
Parameter

Description

Name

Enter an internal name for the message.

Description

Enter an optional message description.

Edit Content…

Click to add content, then perform the steps described in Editing message con-
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Parameter

Description
tent.

Test SMS…

1.

Click this button to start a test dispatch. The Send Test SMS window
opens.

2.

In the Recipient List drop-down list, select a recipient list with test
recipients.

3.

In the Recipients list, select one or more test recipients.

4.

Click Send SMS to start the test dispatch.

Mobile Push
For more information, see Mobile Push.
Parameter

Description

Name

Enter an internal name for the message.

Description

Enter an optional message description.

Edit Content…

Click to add content, then perform the steps described in Editing message content.

Test Message…

1.

Click this button to start a test dispatch. The Send Mobile Push Test
Message window opens.

2.

In the Recipient List drop-down list, select a recipient list with test
recipients.

3.

In the Recipients list, select one or more test recipients.

4.

Click Send Mobile Push Message to start the test dispatch.

Web Push
For more information, see Web Push.
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Parameter

Description

Name

Enter an internal name for the message.

Description

Enter an optional message description.

Edit Content…

Click to add content, then perform the steps described in Editing message content.

Note: You must set up the Web Push test dispatch in
advance. See Web Push test dispatch on Optimizely
World.
Test Message…

1.

Click this button to start a test dispatch. The Send Web Push Test Message window opens.

2.

In the Recipient List drop-down list, select a Web Push test recipient
list.

3.

In the Recipients list, select one or more test recipients.

4.

Click Send Web Push Message to start the test dispatch.

Optional elements
You can include the following elements in a campaign.
l

Wait

l

Block

l

Throttle

l

Limit

l

Segment

l

Target Groups

l

A/B Test
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Wait
Specify a message's start time. You can manually activate a campaign containing a Wait
node. If you do, the messages are sent at the specified time.
Note: Limitations
l

Wait is not available for transactional mails or confirmations.

Tip: Use Wait in combination with an A/B test to define the sending
time of each split.
Parameter

Description

Wait until...

Specify the date on which a message or split is sent.

at ...

Specify the time when a message or split is sent.
If you are using the closed-loop interface, activate this option to send the
messages after the recipient import.

Wait until import has
finished

Start at ... after
import has been finished

Note: If you enable this option, do not activate
the campaign.

If you are using the closed-loop interface, activate this option to send the
messages after the recipient import at the time specified here.
Note: If you enable this option, do not activate
the campaign.

Note: If you use Send time optimization, you must also specify a
Wait option in the Send date area as a time reference point. Also,
the fallback time is determined for recipients for whom there is not
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enough behavioral data to determine an optimal send time. See Configuring send time optimization in the Wait node.
Parameter

Description

Send time optimization

Select the check box to enable automatic send time
optimization.

24 hours/7 days (only when the selected wait option is Wait until ...)

Select the period of time during which the send time can
be optimized.

Date slider

Use the date slider or the arrow keys to change the start
and end times of the send time optimization.

Block
Note: Limitations
l
l
l

Block is not available for confirmations.
Block is only available for email.
Block only works with custom blocklists.

Suspend recipients on custom blocklists from a mailing. Place the Block node in your campaign and click Properties . Then, select one or more custom blocklists from the dropdown list. The recipients on those blocklists will not get a message.

Throttle
Note: Throttle is not available for transactional mails, or
confirmations.
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Tip: You can also use the Throttle node for A/B tests. See A/B Test
node.
Specify the dispatch rate. Sometimes you should select a lower dispatch rate, such as
when you send a coupon in email. Unless you reduce the dispatch rate, your web shop may
get overloaded.
Parameter
Decrease the
Dispatch Rate

Description
Specify the dispatch rate per hour for messages. The lowest rate is 1000 messages per hour. If you set 1000 messages per hour, 1000 recipients are distributed evenly throughout the hour.

Limit
Note: Limit is not available for transactional mails or confirmations.
Specify how many recipients (percentage or absolute value) you want to contact. Place
the Limit node in front of the message node.
Parameter

Description

Percent

Specify the percentage (1 to 100) of recipients to be contacted. The number of
recipients is calculated on the global number of recipients from recipients
lists selected in the Recipients node (=100 %). Other limiting elements, like target groups, are not considered.

Recipients

Specify the actual number (absolute value) of recipients to be contacted. If this
value is higher than the number of possible recipients, all recipients are contacted.

Limit and target groups node
If you use a Limit and Target groups node in a campaign, consider the following notes:
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l

l

Limit node after target groups node. If you use a Limit node after a Target Groups
node, the limit affects the number of recipients filtered by the target groups node. See the
following example:

Target groups node after limit node. If you use a Target Groups node after a Limit
node, unexpected numbers of recipients may occur.
In the following example, the 100 recipients in the Shop customers recipient list are limited to 50 percent. The remaining 50 recipients are then filtered by gender. Since the
Women target group refers to the initial recipient list, which contains 60 women, the
mailing is sent to 50 female recipients.

Segment
Note: Limitations
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l
l

This node is not available for transactional mails or confirmations.
To make Optimizely Visitor Intelligence segments available in Optimizely
Campaign, you first have to create segments in Optimizely Visitor Intelligence. See Creating a marketing segment.

Use marketing segments from Optimizely Visitor Intelligence as a target group for your
campaign.
To add an Optimizely Visitor Intelligence segment to your campaign, drag and drop the
Segment node onto the desktop. To edit this node, click Properties
desired segment from the drop-down list.

and select the

Target Groups
Note: Target Groups is not available for transactional mails or confirmations.
Limit the selection of recipients based on additional criteria (see Target group definition).
Place Target Groups between the Recipients node and the message node.
Target Groups contains no additional parameters. To specify a target group, create an outgoing connection, click it, and define a target group or select an existing one.
Parameter
Target Group

Description
Enter an internal name for the target group and the target group definition. See
Target group definition.

A/B Test
Optimize the dispatch of your message. In an A/B test, two variants (A and B) of an email
are sent, which differ in a factor (such as the subject line). By comparing key figures (such
as the opening rate when testing the subject line), you can determine which variant
worked better. See A/B test.
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Note: Limitations
l
l

A/B test is not available for confirmations.
If you add an A/B test to the campaign, you must create at least two variants of the message. The more successful variant (automatically selected
by one of these criteria – open, click, bounce or unsubscribe rate, or revenue, or manually selected) is sent.

You configure the A/B test in two steps:
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1. Activate automatic optimization in the A/B Test node.
Parameter
Activate automatic optimization

Description
Enable to select the most successful message in the splits based on
one of the criteria in the following line.
Select one.
l

l

l

l

Type of Optimization
l

l

Best effective click rate. Sends message with best ratio of
unique openings to unique clicks.
Best unique click rate. Sends message that generated the
highest percentage of clicks from individual recipients.
Best unique open rate. Sends message opened by highest percentage of recipients.
Lowest unique unsubscribe rate. Sends message that generated
the lowest percentage of unsubscriptions from individual recipients.
Lowest bounce rate. Sends message that generated the lowest
percentage of return messages.
Highest turnover. Sends message that generated the most
turnover.
Note: This option is only available if you are
using Post-click tracking, or either web analytics or e-commerce integrations.

If you activated the automatic optimization function, select an option
to trigger the sending of the optimized message to the rest of the recipients.
Sending Date
for the Optimized Message

l

l

Date and Time. Send your optimized message at a specified time;
for example, you always send messages at 3 PM on Thursdays, and
your recipients are used to receiving your messages at this time.
Delay After Last Split. Ensure that your recipients have enough
time to open a message and to click the links (regardless of when
you start the optimization). You can draw conclusions from this for
the optimization of your campaign. For example, if your recipients
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Parameter

Description
read a message and click links in the first two days following
receipt.
l

Manual. Send the optimized message when you want. Then, once
splits are complete, click Optimize to start the optimization process in the Campaigns window.

2. Create the split mailings and connect them with the A/B Test node.
A/B Test also lets you branch the path of your campaign. For example, to send different messages to different target groups.
Parameter

Priority

Description
Specify to which target group is to be sent first. The branches are processed hierarchically. The branch with the lowest number has the
highest priority and is executed first.
Specify the number of recipients to which the connected split is to be
sent:

Number of
Recipients

l

Percent. Specify the percentage of recipients to be contacted.

l

Recipients. Specify the number of recipients to be contacted.

l

No limit. Do not limit the number of recipients.

Optionally specify which target group is used by referring to an existing
target group:
a.

In the box under Target Group, enter a name.

b.

In the Target Group list on the right, select the desired target group.

Target Group

If you create a new target group, define the filters (see Target group
definition).
c.

Click Save Target Group
. The message is sent only to recipients of the selected target group.
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l

l

If you filter a target group by actions over a period of time and set an A/B
test with different send times, unexpected numbers of recipients may
occur. Recipients are always calculated at the actual send time of each A/B
test message.
When you use the send time optimization, you must also specify a date and
time or select the Manual option under Sending Date of the Optimized
Message. See Configuring send time optimization in the A/B test node.

A/B Test and Throttle node
If you activate automatic optimization for an A/B test and place a Throttle node before the
message nodes, the message variant that is sent after the A/B test applies the Throttle
node setting.

Editing message content
To configure a message and add content, move the cursor to the message you want to
edit, click Properties
> Edit Content…. The Edit Content window opens, and you can
perform the following steps:
1. Selecting the type of content
2. Configuring the message
3. Adjusting layout settings and content
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Step 1. Selecting the content type
l

Email

l

SMS

l

Mobile Push

l

Web Push

Email
If you edit an email for the first time, select a template:
1. From the Template drop-down list, select one of these options.
New. Creates a message from a template (for example, the Optimizely Template Kit)
or enter your own HTML into the free-text template.
l
Message. Applies content from existing message you select from the list. You can
select new or sent messages.
l
Message template. Send messages regularly with the same sender number (such
as "Our offers of the week"). Select the required template from the list. The subject,
sender information and attachments are already configured in the message templates. If you select this option, go to Configuring the message. See also Message
templates.
2. Click Next.
l

SMS
To edit an SMS message, see Configuring the message.

Mobile Push
To edit a Mobile Push message, see Configuring the message.

Web Push
To edit a Web Push message, see Configuring the message.
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Step 2. Configuring the message
l

Email

l

SMS

l

Mobile Push

l

Web Push

Email
See also: Editing mailing content
l

Sender information
1. Open the Edit Content window.
2. Click Sender, Subject, Attachments.
3. In the Sender area, enter the name and email address that you want mailing recipients to see.
4. In the Reply To area, enter the reply-to name to be displayed in the recipient's
email program.
Tip: You can use field functions to adapt the sender and reply-to
address to specific values in the recipient list. Example: You want
customers to reply to the branch of your company where they are
registered. For more information, see field functions.

l

Subject
1. Open the Edit Content window.
2. Click Sender, Subject, Attachments.
3. In the Subject area, enter a subject for your message.
You can use personalizations in the subject line, and send messages to target groups
with different subject lines.
o

To create personalized subject lines, click Insert field function
and select the
required recipient list field or the required field function from the list.

© Optimizely 2022

Campaigns | 205

o

To add a target-group-specific subject line, click Add Subject… and enter the text
into the new field. Then, select a target group for whom you want to use this subject
line. You can add as many additional subject lines and target groups as you like.
Tip: The additional feature Prefix or suffix subject line lets you
automatically add a prefix or suffix to the subject line of any mailing. See Prefix or suffix subject line.

You can use Unicode characters in the subject line to increase the recipients' attention. Instead of using a plain text subject line, like
NEW! Bikini "Malibu" now in the shop, you can enhance it with Unicode characters:
NEW! Bikini "Malibu" now in the shop
.
At www.unicode.org you can find a list of Unicode characters that are supported by
most web browsers and email clients. Copy the desired symbol from the list and paste
it into the subject line. Also set the character set to UTF-8 to display Unicode characters correctly. See Encoding.
Note: Unicode characters are displayed differently by different
operating systems (iOS, Android, and so on) and email clients
(Gmail, Outlook, and so on) Therefore, always send a test message to check the appearance before sending.
l

Attachments
1. Open the Edit Content window.
2. Click Sender, Subject, Attachments.
3. Open the Attachments tab.
Select one of the following attachments to messages.
o

Attach a previously-uploaded file
a. Click the file that you want to send.
b. Click Apply. You attached the selected file to your message. The name and size
of the file are shown below the message's subject.
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o

Upload files from your hard drive
a.
b.
c.
d.

Click New….
Select the option Upload from hard drive if not already selected.
In the Select File area, click Browse....
Go to the file you want to upload and confirm your selection. The File Name
field in the Properties area shows the file name. You can change the file name.
e. In the Properties area, in the Description field, enter a description.
f. Click Save.
Tip: Optimizely Campaign creates a copy of your file. If
you delete the file from your hard drive, the copy remains
in Optimizely Campaign.

g. To attach the uploaded file to your message, select it and click Apply.
The file name and size are appear below the message's subject.
o

Link to an externally stored file
a.
b.
c.
d.
e.

Click New….
Select the Use URL option.
In the Select File area, in the URL field, enter the URL that refers to the file.
In the Properties area, in the File Name field, enter the file name.
In the Properties area, in the Description field, enter a description.

f. Click Save. The file to which you linked is displayed in the Attachments area.
g. To attach the linked file to your message, select the file and click Apply.
The name and size of the externally stored file appears under your message's
subject. Optimizely Campaign loads the linked file from the external source
shortly before sending and attaching it to your message.
l

Encoding
Specify the character set with which you want to encode your mailing. In addition to
standard characters (Latin letters, numbers, punctuation characters), the character set
also includes special characters (such as German umlauts). Characters that would be
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displayed incorrectly or not at all on the recipient's computer can be correctly interpreted in this way. To configure the message encoding, follow these steps.
1. At the top right side of the Edit Content window, click More > Encoding/Offline
HTML.
2. Select the required character set.
ISO-8859-1. For recipients in German-speaking regions, Western European
countries, and North America.
o ISO-8859-2. For recipients in Central/South-Eastern European countries, for
example in Poland, Croatia or Slovakia.
o UTF-8. The UTF-8 format supports most of the special characters found in all
languages. Select this encoding if you are contacting recipients in other parts
of the world, for example, in Eastern Europe or Turkey.
3. Click Apply.
Offline HTML
o

l

This option attaches images and style sheets directly to the email. This option may
provide a better representation of your mailing in a recipient's email client, but may
also result in a worse deliverability of your email. Also, offline HTML may increase the
price because the overall size of every email grows. In addition, open tracking is disabled (clicks are counted as opens anyway).
To activate the offline HTML option, do the following:

l

1. At the top right side of the Edit Content window, click More > Encoding/Offline
HTML.
2. Select the check box in the Offline HTML section.
3. Click Apply.
Tracking
Opens and clicks are tracked as standard in both the HTML and text versions of a message. You can apply these settings globally or configure the tracking function for each
link in a message. To configure the tracking of openings and clicks, follow these steps.
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1. At the top right side of the Edit Content window, click More > Edit tracking links.

2. To globally deactivate the tracking of opens or clicks, clear the Track opens or
Track clicks check boxes.
3. To deactivate the tracking of links for the HTML version or the text version of the
message, click Tracking disabled next to Default setting for HTML links or
Default setting for text links.
4. To configure tracking for individual links, click the link in the Edit Tracking Links
list then Edit Link….

© Optimizely 2022

Campaigns | 209

5. In the Track in HTML column, select one of the following options:
Default setting. Applies the global settings to this link.
o Enabled. Activates tracking for this link, even if tracking is globally deactivated.
o Disabled. Deactivates tracking for this link, even if tracking is globally activated.
Proceed in the same way in the Track in text column.
Modify the automatically-generated link descriptions in the Description column to
help decide whether to allocate a link URL to a topic or a landing page.
The Occurrences column indicates how frequently a link appears in the message.
You can enter a click profile for this link in the Click Profiles column.
o

6.
7.
8.
9.

Tip: You can also assign click profiles automatically in a rulebased manner.
10. Click Apply.
Note: Using HSTS
If you use HSTS in your web server (to which the links refer),
either disable HSTS in your web browser or create an SSL certificate.
For this, provide the following information:
o

o

o

Domain. The domain (such as, "example.com") for which
the certificate needs to be created.
IT contact person. A contact person from your IT department (First name, last name, company name, address,
postal code, phone number, email address, and fax number).
Organizational contact person. An organizational contact
(First name, last name, company name, address, postal
code, phone number, email address, and fax number).
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o

Administrative email address. An email address that you
use to manage the certificate. An email address that is
assigned to your domain is required for this purpose. For
example, if you use the domain newsletter.example.com,
the email address must be either admin@example.com,
administrator@example.com, hostmaster@example.com, or
webmaster@example.com. Only the local parts admin, hostmaster, webmaster or administrator may be used.

Tip: The Anonymize tracking feature lets you deactivate personalized tracking of opens and clicks for a recipient. If you do,
the recipient is no longer included in action-based target groups.
See Recipients overview. You can also use the Optimizely Campaign HTTP API to set up the tracking opt-out option in your mailings. See HTTP API on Optimizely World.
l

Import mailing content
If you use the free-text template as content type, you can upload a ZIP file with the
entire mailing content including HTML and text file as well as graphics. Do the following:
Note: Specify the relative paths to the linked graphics in the
HTML files.
1. At the top right side of the Edit Content window, click More > Import mailing content.
2. In the File area, click Browse... and select a ZIP file in the file browser.
3. Click Select Contents.
4. In the Assignments area, select the respective file from your ZIP file for each content type.
Tip: If you do not select a file for one or more content types,
the content will not be overwritten.
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5. Select the encoding for each content type.
Tip: UTF-8 is selected by default.
6. Click Finish.
You can edit the uploaded mailing content afterwards.

SMS
See also: SMS
1. If multiple telephone numbers are configured as sender information in your client, in
the Edit Content window, select a number from the Sender Number drop-down list. If
just one sender number is configured, you need not select anything here.
2. In the Limitation of SMS messages drop-down list, select the maximum number of
messages to be sent to ensure that the content is not longer than the selected limit.
You receive a warning message if the content exceeds the limit.
3. In the Content box, enter the message text.
4. To enter personalized text, click Insert field function
field or the required field function from the list.

and select the recipient list

Note: You can use personalizations to add the name of the recipient to the message (for example "Hello John Doe..."). When using
personalized text, the maximum specified message count may be
exceeded if the added text (for example, name of recipient) is too
long. In this case, the message is sent in full, but charges may be
incurred for more SMS messages per recipient than specified in
the setting for the message limit.
5. Click Save.

Mobile Push
See also: Mobile Push
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1. Title. Enter the title of the push message. To create a personalized title, click Insert
field functions
and select the required recipient list field or the required field function from the list.
Note: This title is displayed on Android devices only. iOS devices
show the name of your app. Nevertheless, enter a title.
2. Content Enter the message text. To enter personalized text, click Insert field functions
and select the required recipient list field or the required field function from
the list.
3. Add an image to be displayed in the push message. You can use the image upload or
specify an external image URL.
Note: To display images on Apple devices, you must integrate
the iOS SDK. See Mobile Push iOS integration on Optimizely World.
l

Image Upload. Upload an image using drag and drop or file upload.
Note: The following formats are supported: .jpg, .png and .gif.
Maximum file size is 1 MB.

External Image URL. Enter the URL that points to the image file.
4. Deep Link. Define what should happen after the message is opened, such as landing
pages to be opened in your app. Combine several actions such as opening a page
along with playing a specific sound stored in your app by clicking + to add information.
To insert personalized deep links, click Insert field functions and select the
required field function from the list.
l

Note: Reserved deep links and prefixes
Do not use the following reserved deep links:
l
l
l
l

from
dry_run
restricted_package_name
delivery_receipt_requested
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l
l
l
l
l

delay_while_idle
content_available
message_id
notification_key
registration_ids
Also, do not use the following prefixes in deep links:

l
l

google
gcm

5. Expiry Date. Define the validity of the message (for example, to promote time-limited
special offers) .
l

l

On. Specify the last date to deliver the message to the recipient's device. After this
date, the message is not delivered. For example, if you define 2022-03-12 but the
recipient activates his/her end device on 2022-03-13, the message is not displayed
on the recipient's device.
Non-expiring. Select this option to deliver this message for an unlimited period.
Note: On Android devices, the maximum validity period is
four weeks.

6. Preview. Switch between Android and iOS and Banner and Lockscreen to display a
preview of your message on the respective device.
7. Click Save.

Web Push
See also: Web Push
1. Title. Enter the title of the push message. To create a personalized title, click Insert
field functions
and select the required recipient list field or the required field function from the list.
2. Content. Enter the message text. To enter personalized text, click Insert field functions
and select the required recipient list field or the required field function from
the list.
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3. Add an icon to be displayed in the push message. You can use the icon upload or specify an external icon URL.
Tip: If you do not add an icon, the default icon of the respective
web browser is displayed.
Icon Upload. Upload an image in PNG format and with the maximum dimensions
512x512 pixels using drag and drop or file upload. The maximum file size is 1 MB.
l
External Icon URL. Enter the URL that points to the image file.
4. Add an image to be displayed in the push message. You can use the image upload or
specify an external image URL.
l

Note: Mozilla Firefox does not support images in Web Push messages.
l

Image Upload. Upload an image using drag and drop or file upload.
Note: The following formats are supported: .jpg, .png and .gif.
Maximum file size is 1 MB.

External Image URL. Enter the URL that points to the image file.
5. Landing Page URL. Specify the website the recipient goes to by clicking the push message.
6. Payload. Specify what additional information (such as tracking parameters) is transmitted when the recipient clicks the push message. To add more information, click +.
To personalize the payload, click Insert field functions and select the required field
function from the list.
7. Expiry Date. Define the validity of the message (for example, to promote time-limited
special offers).
l

On. Specify the last date to deliver the message to the recipient's device. After this
date, the message is not delivered. For example, if you define 2022-03-12 but the
recipient activates his/her end device on 2022-03-13, the message is not displayed
on the recipient's device.
l
Non-expiring. Select this option to deliver this message for an unlimited period.
8. Click Save.
l

© Optimizely 2022

Campaigns | 215

Step 3. Adjusting layout settings and content
Depending on the selected message type, you can adjust the layout and add content elements.
Message
type

Description

E-Mail

See Edit mailing content. If you are using the Template Kit, see Template Kit.

SMS

In SMS messages, you can only send text-only messages. Enter the text in the Content box. See SMS.

Mobile Push

With Mobile Push, you can send messages to mobile devices and trigger predefined actions. Enter the text in the Content box and optionally upload an image.
See Mobile Push.

Web Push

With Web Push, you can send text messages that appear in the recipient's web
browser. Enter the text in the Content box, and optionally upload an image and an
icon. See Web Push.

Omnichannel campaigns
This section contains special notes for the following channels:
l

SMS

l

Mobile Push

l

Web Push

Mobile Push
A Mobile Push message is delivered from a software application to a mobile device, and
appears on the device without a specific request from the recipient. Use Mobile Push, for
example, to inform your customers about the current shipping status and delivery time of
an ordered product. Or send appointment reminders.
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l
l

l
l
l

Automated dispatch through Smart Campaigns and Marketing Automation.
Customize Mobile Push messages by setting time limits and fields for individual target
links. See Configuring a Mobile Push message.
Add an image and personalize the Mobile Push message by using field functions.
Integrated preview function.
Optimizely Campaign integrations for Mobile Push are available for Android and iOS operating systems.

For information on setting up Mobile Push, see Optimizely World.

Web Push
A Web Push message appears in the recipient's web browser without a specific request.
With Optimizely Campaign, you can make Web Push messages part of your campaign.
For example, use Web Push together with to send your web shop customers a reminder
when items are in the shopping cart but the order has not been completed. Or send personalized product recommendations created with .
l
l

l
l

Automated dispatch through Smart Campaigns and Marketing Automation.
Customize Web Push messages by setting time limits and fields for individual target links.
See Configuring a push message.
Add an image and personalize the Web Push message by using field functions.
Integrated preview function.

For information on setting up Web Push, see Optimizely World.

SMS
With SMS, you can use mobile marketing, for example to reach new target groups or to
reach your customers prominently on mobile devices. For interactive direct communication with customers, use it to receive incoming SMS. Optimizely's portfolio includes
generation of short codes and standard numbers for two-way, mobile customer communication.
In most countries where this is possible, Optimizely SMS uses direct routes to network operators and offers exceptional quality, speed, and availability. Thus, Optimizely SMS is suited
to the delivery of transactional and commercial messages.
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A personalized message is possible at all times. For effective international SMS communication, Optimizely supports relative character sets and data formats, which support
country-specific characters.
For example, use SMS to send:
l
l
l
l

appointments
PINs
billing, delivery or order information
personal and customized special offers
Note: The sending of SMS messages requires a special opt-in.

Text length and number of characters
SMS messages are pure text messages. The maximum number of characters per message
depends on the coding and special characters. Modern mobile phones can receive SMS
messages which are too long (concatenated SMS) with no problem, and display these as a
single message.

GSM character set
The GSM 7-Bit default alphabet was developed for sending and receiving SMS via the cellular mobile network. This standard contains a simple character set for sending SMS messages of up to 160 characters. The following characters are available:
"#$%&'()*+,,-./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz_
¡£¤¥§¿ÄÅÆÇÉÑÖØÜßàäåæèéìñòöøùü

...plus the following non-visible characters:
l
l
l

space
new-line
carriage return
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The GSM standard character set includes an extension. Each character in the extension
requires two characters:
^[]{}\|€~

UCS2 character set
The sending of SMS via Optimizely Campaign also supports the UCS2 character set. This
set covers most modern languages, as defined in International Standard ISO/IEC 10646.
See Universal Coded Character Set.
Note: When UCS2 is used, an SMS message cannot exceed 70 characters because each character requires 16-bits; more than double
the storage required by a character in the GSM 7-bit default alphabet.

Determining which character set is used
The characters in an SMS message determine if it is GSM-coded (7-bit) or UCS-coded (16bit). Each SMS can have only one encoding, which is performed automatically. If an
SMS uses one 16-bit encoded character, the entire message is 16-bit encoded, even if
other characters can be encoded using 7-bit.

Country-specific features
The sending of SMS, subject to country-specific regulations, primarily includes these functions:
l
l
l

Sender identifier
Sending length (multi-part) SMS
Supported character sets

Moreover, as the customer, you are likewise subject to restrictions which vary by country.
For example, you must comply with country-specific regulations on consent to advertising,
privacy and competition regulations.
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Note: Limitations
l

l

l
l

Optimizely does not support the delivery of binary content, such as ringtones or images.
Optimizely does not support certain mechanisms in language tables for Portuguese, Turkish, Bengali and Hindi, the locking-shift or single-shift tables
in GSM standard.
Not every character is available in every country.
In some countries, the characters used are restricted by law or network
operators. Moreover, especially among discount telephone operators, the
characters in an SMS may not be delivered correctly. This can lead to display errors.

Multipart SMS (concatenated SMS)
You can send a message with more than 160 or 70 characters (depending on character
set), but the text is sent as multiple, individual SMS messages. Modern devices may display
these SMS messages as a single SMS. The previous procedure corresponds to the GSM protocol Concatenated SMS. For longer texts, several individual SMS messages are used and
counted for billing purposes.
The maximum number of characters per SMS is reduced for concatenated SMS messages.
Thus, only 153 or 67 characters (respectively) per SMS are available. The maximum lengths
appear in the following table:

SMS encoding

max characters per 1
message

max characters per 2
messages

max characters per 3
messages

max characters per 4
messages

GSM 7-bit
(default
alphabet)

160

306

459

612

each plus
153 characters

UCS2

70

134

201

268

each plus 67
characters
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Note: Recommended maximum number of characters
Do not send more than 10 SMS messages 1,530 characters) for a Concatenated SMS. If you send more than 10 SMS, or 1,530 characters, a
multiple part message may not be sent or received correctly.

Note: Field functions and placeholders in SMS
If you use field functions and placeholders in an SMS message, the
text length of the SMS sent cannot be calculated in advance. If placeholder text is replaced by personalized content (for example, the
recipient name), SMS messages may become multi-part messages
and incur higher costs. So, before sending, check how many characters are included in your datasets and how long an SMS can be.
You can also read the example in the Personalizations section.

Checking costs
Billing is calculated per SMS sent. For example, for a two-part SMS mailing, two text messages (SMS) are billed per recipient.
For a cost overview, Optimizely Campaign lets you enter the number of SMS messages –
and thus the maximum number of characters – you want to send. If the text is too long for
the selected setting (for example, 160 characters (1 part)), an error message is displayed.

Sender identification
SMS is implemented based on phone provider. In addition to telephone numbers, you can
use up to 11 alphanumeric character strings as sender identification. with Optimizely SMS,
you can use the following sender identification formats:
l

Alphanumeric sender identification. String of letter and number characters. The sender
identification must begin with a letter. Avoid the use of umlauts and special characters.
Alphanumeric sender identifications can only be used to send (not receive) SMS.
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l

l

l

Exclusive short codes. Short sequences of numbers, for example 23232, for direct twoway customer communication. See German Federal Telecommunication Network Agency
(Bundesnetzagentur) for the short code format for Germany. You can use exclusive short
codes only within the country where they were assigned. International routing is not possible.
Non-exclusive short code. A short code is simultaneously used by multiple service providers. You may provide keywords for response capability. You receive only forwarded messages that contain the keyword you provided.
Long code. A long code is a customary mobile number that you can route internationally.
For example, +4915112345678. The advantages of a standard number are cost and international usability.

Personalizing messages
You can insert placeholders for recipient list fields (such as "Hello {first name}!") or field
functions (for example, salutation logic) into SMS messages. Upon delivery, these are
replaced by the corresponding name (such as Hello Andrea!) or salutation format (Dear Mr.
Miller).
If you use placeholders or field functions, the display of used/remaining characters cannot
provide precise results. This is because Optimizely Campaign can only determine message
length after the placeholder or field function is replaced by the individual value, which
occurs directly after sending. So, a message intended to be sent as a single SMS might be
divided into two messages, which results in higher delivery charges.
Example
The following message contains a placeholder for the recipient 's first name and has 163
characters:
Hello {firstname}! Have you checked out our current holiday deals
at www.example.com yet? They are only available today (before
midnight) in our web shop. Act fast!

When sending, the placeholder is replaced with the recipient’s name, and could look like
this:
1) Hello Max! Take a look at our current holiday deals at www.example.com! Only available
today (before midnight) in our web shop. Act fast!
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2)Hello Maximilian! Take a look at our current holiday deals at www.example.com! Only
available today (before midnight) in our web shop. Act fast!
In the first example, the sent message has 145 characters and is sent as a single SMS. In
the second example, the message has 162 characters and is divided into two SMS messages, so two SMS messages are billed.

Analyzing bounces
You can analyze bounces from SMS recipients. A bounce is generated when:
l
l
l

the mobile phone is switched off or unreachable during dispatch
the mobile phone's inbox is full
the number is invalid or no longer in use

Blocking numbers with a blocklist
If you want to send SMS mailings via your client, the client's blocklist is adjusted accordingly. You can block complete numbers or specific parts of numbers (such as area codes).
You should block satellite phone numbers, because the cost for such a message is substantially more expensive (more than 1 euro per SMS).

SMS processes
SMS processes enable your customers to request or stop a service by sending an SMS with
a predefined keyword. For example, your customers can send an SMS with the keyword
Help to request help or Stop to unsubscribe from promotional SMS. For more information,
see SMS processes.

SMS processes
SMS processes enable your customers to request or stop a service by sending an SMS with
a predefined keyword. For example, your customers can send an SMS with the keyword
Help to request help or Stop to unsubscribe from promotional SMS.
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Prerequisites
To use SMS processes, you need one or more inbound numbers. Inbound numbers are telephone numbers or short codes that forward incoming messages to a target system. To set
up an inbound number at a telephone provider and configure it for your clients, contact
customer support.
You can choose from up to three types of inbound numbers depending on the country you
are in:
l
l
l

Long code. A customary mobile number, for example +4915112348765.
Exclusive short codes. A short sequence of numbers, for example 11221 .
Non-exclusive short code. A short code that you can use for several clients (shared
code). The telephone provider assigns several provider keywords to a short code, for
example 11221 / kids and 11221 / baby. Depending on the provider keyword, SMS are
delivered to different Optimizely Campaign clients.
Note: For non-exclusive short codes, senders must enter in the
SMS both the provider keyword and the service keyword , such as
baby stop.

For further information about the different code types, see the chapter SMS under Sender
identification.
Note: Depending on the type of inbound number selected, the costs
for setup and operation by the telephone provider vary.

Tip: In some countries you have to purchase inbound numbers yourself. If you are a resident of the USA, you can obtain inbound numbers from the website https://usshortcodes.com/.
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SMS process overview
To open the SMS process overview, open the Optimizely Campaign menu and select
Administration > SMS Processes.

In the SMS process overview, you can find information about all created SMS processes,
such as process type, name and mailing ID. You can also view the current status of each
SMS process:
l
l

New. A new process that has not yet been started.
Started. The process has been started and is running.
Note: If you edit a started process and click Save and Close,
your changes are immediately applied to the running process.

l

Paused. The process was paused and is not running.

SMS process actions
Note: Some actions are not available for new or incomplete SMS processes.
l
l
l
l

Create…. Create new SMS processes. See Creating SMS processes.
Edit…. Edit an SMS process as described under Creating SMS processes.
Delete. Delete an SMS process to permanently remove it.
Start. Start an SMS process. The process changes its status to Started and is running.
Inbound SMS from your customers can then be covered by the SMS process.
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l

Pause. Pause an SMS process. Your customers' inbound SMS messages are then no longer
covered by the process. You can restart paused SMS processes at any time.
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Creating SMS processes
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1. Click Create… in the SMS process overview. The Create SMS Process window opens.
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2. Select one of the following process types from the Type drop-down list:
l

l

Unsubscribe. The sender is added to the internal unsubscribe list for the SMS
channel and no longer receives advertising SMS.
Help. The sender receives the message that you select under Message.
Note: You can only create one unsubscribe and one help SMS
process for each inbound number / provider keyword. This is to
ensure a distinct assignment for every SMS process.

3. Enter an internal name for the SMS process under Name.
4. Select an inbound number from the Inbound Number / Provider Keyword drop-down
list. If you use a non-exclusive inbound number, the keyword assigned by the provider
will also be displayed (such as 11221 / Shoes).
5. Optional: Under Custom Keywords, enter a keyword that is to be added to the predefined default keywords. Click the Add button to add the new keyword.
Note: Custom keywords must not contain numbers, special characters or spaces.
6. Under Message, select the message to be sent automatically to the sender of the
inbound SMS. To do this, create a transaction mail of type SMS. See Transactional Mails.
Note: The sending of a message is mandatory for SMS processes
of type Help, optional for processes of type Unsubscribe.

Warning: Depending on the country of the recipient, sending a
confirmation SMS after successful unsubscription is either mandatory, optional or even prohibited. Before starting an unsubscribe process, inform yourself about the respective country
regulations and separate SMS processes according to the destination country.
7. Click Save and Close.
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Marketing Automation
Develop multi-step campaigns with action- and event-based mailings; perfectly adapted
to a highly diverse set of target groups using fully automated distribution cycles. You can
create campaigns based on your customer database, then refine them once the campaign
is up and running. You have access to the entire platform, so you can concentrate on the
ad message design.
l
l
l
l

Lifecycle marketing made easy via drag and drop.
Sustainable, automated cultivation of customer relations.
Effective dialog marketing through customized triggered emails.
Higher revenues through automated cross and upselling campaigns.

To create and manage Marketing Automation campaigns, open the Optimizely Campaign
menu and select Campaigns > Marketing Automation.
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Marketing Automation campaigns for a better customer
engagement
Using Optimizely's Marketing Automation, it’s easy to analyze potential customers, promotions, and your customer contact histories then incorporate that information into your
campaigns. Optimize your customer dialog through a process that lets you improve and
refine your marketing strategy. Information gathered during a campaign can be used to
augment an existing database. This, in turn, lets you more accurately define segments then
roll out more finely-tuned campaigns.

Campaign examples
l

Welcome mailings. Welcome new subscribers through targeted welcome mailings. These
are based on a multi-stage campaign aimed to introduce potential purchasers to your
brand and what it has to offer. First impressions are very important in campaigns of this
kind. It’s an ideal phase for introducing your line of products and opening a dialog. Ask
new subscriber to complete their data and to enter their interests and preferences. In this
way, you know early on whether an addressee would be interested in special promotional
offers. And the Preference Center (profile self-administration) lets you inquire whether the
subscriber prefers to be contacted on a weekly or monthly basis. Under certain circumstances, it may be worthwhile to include a sweepstakes mailing as part of the series of
welcome mailings – to turn an interested consumer into a new customer.
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l

Trigger and transactional mails. Trigger mails help nurture existing customer relationships, ensure consistent sales, and initiate new customer relationships. Distribution is
triggered by a special event relating to the subscriber – with Optimizely Campaign automatically sending out trigger mails according to predefined criteria or at a specified pointin-time. In campaigns created with Marketing Automation, each node through which mailings are sent is a trigger mail. This provides a simple tool for automatically contacting customers individually under a variety of scenarios. Transactional mails, on the other hand, are
emails sent out subsequent to an order, a purchase, or similar customer action (transactions). See also Triggers in the Triggers User Guide.
If you use post-click tracking, you can use Optimizely's Marketing Automation to send
transactional mails. See also Post-click tracking.

l

l

Cross and upselling offers. Product recommendations offer enormous potential. These
mailings are prompted by a purchase, a registration or similar action, with contents automatically adapted accordingly. The goal is to encourage follow-up purchases, the purchase of higher-quality and higher-priced goods, or a wider variety of purchasing choices.
Cross- and upselling recommendations are made available through a database and content interface or via established web-analysis software in Optimizely Campaign.
Customer care. Establish an ongoing dialog with regular customers through a proactive
approach to customer care that goes beyond regular communications. You can measure
customer satisfaction, for instance, by means of statistical analyses based on scorings.
Ideally, this lets you predict the likelihood of cancellation on a case-by-case basis. Specially incentivised customer-binding mails are sent when certain tolerance limits are
exceeded. Concurrently, you can also include targeted customer satisfaction surveys that
solicit suggestions on how to improve your services.
Also, be sure to closely track changes to customer status. If a customer has a change
of address, for example, you can send a mailing with information and promotions
tailored to the new location. If you know your customer's age, select mailings with content appropriate to his or her age-bracket. React to the first signs of inactivity by inquiring whether the customer elects to suspend mailings for a time or prefers receiving
them less frequently. Contact Optimizely with any requests.

l

Reactivation. Reactivation by email is an important component of effective lifecycle marketing. Successful reactivation depends on the effective monitoring of subscribers. Early
detection of sagging interest or excessive contact frequency helps to avoid customer
inactivity and, ultimately, customer withdrawal.
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First, define at what point a customer is to be considered inactive. Set a timeframe to
indicate when a customer fails to open or click your emails to determine his or her
status. Possible indicators include not only failure to open or click mails but also a failure to log in to user accounts and communities, or user data not being updated. The
timeframe you employ depends on the natural lifespan of your products, services and
promotions. Successful re-activations are normally the result of multi-stage campaigns.
For example, you may want to request that the addressee update his or her customer
information. Those who click the link receive a shopping coupon. And you can incentivise addressees who did not respond your first email by sending a second one.
Tip: Marketing Automation guide
See helpful information, tips, tricks, and examples for successful Marketing Automation campaigns in Marketing Automation guide.

Marketing Automation packages (only DACH)
Note: The various Marketing Automation packages are only available
for customers in the DACH region. For non-DACH customers, all services of the Ultimate package are available.
Optimizely's Marketing Automation contains three packages. If a node is grayed out (deactivated) when creating or editing a campaign or you cannot add nodes to a campaign, you
have not licensed that package. To upgrade your package, contact customer support.
l

l

Starter package. Contains everything you need to set up the most relevant campaigns
using Marketing Automation (for example, welcome message series, birthday mailing, reactivation campaign). A maximum of 50 start or branching points (nodes) can be in use per client.
Advanced package. Includes the Starter package plus the following services:
o
o

o

Up to 250 start or branching points (nodes).
Using the A/B Test node, you can split campaign recipients by percentage then distribute them to various mailing routes, allowing you to optimize your campaign.
Using the Change Recipient, Copy Recipient and Move Recipient nodes, you can
change the recipients' data and copy or move recipients to other recipient lists.
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l

Ultimate package. Includes the Advanced package plus the following services:
o
o

Multiple start or branching points (nodes).
The Start In and From Campaign nodes are two more powerful nodes with which you
can combine multiple campaigns.

See Marketing Automation nodes.
Node

Starter

Advanced

Ultimate

Recipient New

✓

✓

✓

Open

✓

✓

✓

Click

✓

✓

✓

Reply

✓

✓

✓

Post Click

✓

✓

✓

Advanced

✓

✓

✓

From MA Campaign

✘

✘

✓

Wait

✓

✓

✓

Send Message

✓

✓

✓

Switch

✓

✓

✓

A/B Test

✘

✓

✓

Change Recipient

✘

✓

✓

Copy Recipient

✘

✓

✓

Move Recipient

✘

✓

✓
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Node

Starter

Advanced

Ultimate

Start In

✘

✘

✓

Done

✓

✓

✓

Total number of active nodes per client

max. 50

max. 250

unlimited

Creating and editing campaigns
This topic describes how to create and edit a Marketing Automation campaign. Also learn
how to start and pause a campaign, delete campaign drafts and delete a campaign permanently.

Creating a campaign
1. Open the Optimizely Campaign menu and select Campaigns > Marketing
Automation.
2. Click Create.
l
l

To create a new campaign, click New….
To use an existing campaign as a template, click Copy… in the drop-down list,
choose your client and campaign, and click Apply.
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3. Drag the nodes from the left action area to the working area on the right.
4. Connect the nodes and enter the desired settings. See Editing nodes and Marketing
Automation nodes.
5. Click Save Draft….
6. In the dialog box, enter a name for the campaign and click Save.
Tip: If you already saved a draft of a campaign and want to display
the running or paused version of it, open the campaign report. See
Marketing Automation campaign report.

Warning: Marketing Automation does not guarantee that mailings
are sent in real time. Note the following hints on sending Marketing
Automation messages.
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l

l

l

Use the HTTP API for time-sensitive mailings (for example, order confirmations
or password reminders), because Marketing Automation mailings cannot
always be processed in real time.
Target groups within the same campaign that check on the dispatch of the
message in a node may give false results because the mailing may not be sent.
If you use such target groups behind the Send message node, there may be
undesirable effects, as the target groups may not work. To avoid this, place a
Wait node, which delays the execution of the action, in front of such nodes.
If you place a Send message node behind a Move recipient node, you also
should place a Wait node in front of the Move recipient node. Otherwise, the
recipient may be removed from the recipient list before the message is sent.

Editing a campaign
To edit an existing campaign, select the required campaign from the list in the Marketing
Automation window and click Edit. Proceed as described from step 3 in the Creating a
campaign section.

Starting or pausing a campaign
To start a Marketing Automation campaign in the Marketing Automation window, select
the campaign and click Start. Next, Optimizely Campaign validates the campaign's content. If errors are found, correct them by editing the campaign.
To pause a campaign, in the Marketing Automation window, select the campaign and
click Pause. To resume the campaign, click Start.
Note: If your Marketing Automation campaign contains a Wait node
and you pause the campaign, the time specified in the node is not
paused. That is, if the waiting time of the node elapses during pausing, the next action is executed as soon as the campaign is restarted.

© Optimizely 2022

Campaigns | 237

Deleting a draft
To delete a version of a running or paused Marketing Automation campaign, in the Edit
Campaign window, click Delete Draft.
Warning: Deleting a draft reverts the current changes and all
changes made since the start of the campaign. To revert the current
changes, close the Edit Campaign window.

Deleting a campaign
To delete a Marketing Automation campaign in the Marketing Automation window, select
the campaign and click Delete.

Marketing Automation nodes
The process of a campaign is defined by nodes that determine when a recipient passes
through the campaign, and what actions are executed for the recipient. With the help of
connections, you can link the nodes and specify the process of your campaign. The arrow
at the end of each connection points to the succeeding node and the associated action.
Tip: For the DACH region, a licensing model applies. If a node is
grayed out (disabled), the Marketing Automation package has not
been licensed. See Marketing Automation packages.
Start nodes define events that initiate the process of a campaign for a recipient. The following start nodes are available:
l

Recipient New

l

Open

l

Click

l

Reply

l

Post Click
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l

From MA Campaign

l

Advanced

Action nodes specify which actions are executed during a campaign. The following action
nodes are available:
l

Wait

l

Send Message

l

Switch

l

A/B Test

l

Change Recipient

l

Copy Recipient

l

Move Recipient

l

Start In

l

Done

Start nodes
Recipient New
Starts the process of the campaign for a recipient added to the recipient list.
Parameters

Description and values
Specify which recipients are passing through the campaign
l

Starts the Marketing
Automation Campaign
l

if recipient never passed through this MA campaign: Recipients pass through the campaign if they
o

are newly added to the recipient list.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this campaign:
Recipients pass through the campaign if they are
o

newly added to the recipient list.

o

not currently passing through the campaign.
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Parameters

Description and values

Note: Recipients who already passed
through a campaign but are newly
added to the recipient list may pass
through the campaign again.
l

always: Anyone newly added to the recipient list passes through
the campaign.

Only recipients of this recipient lists are passing through this campaign.
Start Only for Recipients
In(mandatory)

Start Only For

Note: To start the campaign, you must specify a recipient list here.

Only recipients of this target group are passing through this campaign.

Note: Recipients moved from one recipient list to another are considered new unless both recipient lists have been set up as opt-in
lists. In this special case, the Recipient-New node would not include
the moved recipients.

Open
Starts the process of the campaign for a recipient who opened the message.
Parameters

Description and values
Specify which recipients are passing through the campaign.

Starts the Marketing
Automation Campaign

l

if recipient never passed through this MA campaign: Recipients pass through the campaign if they
o

opened the message.
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Parameters

Description and values

l

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign:Recipients pass through the campaign if they
o

opened the message.

o

are not currently passing through the campaign.
Note: Recipients who already passed
through the campaign and who open
the message again may pass through
the campaign again.

l

always: Any recipient who opens the message pass through the
campaign.

Specify the mailings in which recipients must click a link. You can

Mailings

Start Only For

l

specify a mailing, or

l

limit the mailing selection to
o

a mailing type.

o

a folder that contains the mailings.

o

the mailing's send date.

Only recipients of this target group are passing through this campaign.

Click
Starts the process of the campaign for a recipient who clicked a link in the message.
Parameters
Starts the Marketing
Automation Campaign

Description and values
Specify which recipients are passing through the campaign.
l

if recipient never passed through this MA campaign: Recip-
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Parameters

Description and values
ients pass through the campaign if they

l

o

clicked a link in the message.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign: Recipients pass through the campaign if they
o

clicked a link in the message.

o

are not currently passing through the campaign.
Note: Recipients who already passed
through the campaign and who click a
link in the message again may pass
through the campaign again.

l

always: Any recipient who clicks a link in the message pass
through the campaign.

Specify the mailings in which recipients must click a link. You can

Mailings

l

specify a mailing, or

l

limit the mailing selection to
o

a mailing type.

o

a folder that contains the mailings.

o

the mailing's send date.

Links

Specify the links the recipients must click to pass through the campaign.

Click Profile

Specify the click profiles whose links the recipients must click to pass
through the campaign.

Start Only For

Only recipients of this target group are passing through this campaign.
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Reply
Starts the process of the campaign for a recipient who replied to the message or to whom
the message could not be delivered.
Parameters

Description and values
Specify which recipients are passing through the campaign.
l

l

Starts the Marketing Automation
Campaign

if recipient never passed through this MA campaign: Recipients pass
through the campaign if they
o

replied to the message or created a bounce.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign: Recipients pass through the campaign if they
o

replied to the message or created a bounce.

o

are not currently passing through the campaign.
Note: Recipients who already passed through the
campaign and who reply to the message or create
a bounce again may pass through the campaign
again.

l

always: Any recipient who replied to the message or created a bounce pass
through the campaign.

Specify the mailings in which recipients must click a link. You can

Mailings

Type

l

specify a mailing, or

l

limit the mailing selection to
o

a mailing type.

o

a folder that contains the mailings.

o

the mailing's send date.

Select one ore more response categories of the reply.
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Parameters

Description and values

Start Only For

Only recipients of this target group pass through this campaign.

Minimum Interval

Select an interval that checks whether the recipient already passed this campaign (triggered by this start node). If the recipient has passed through the campaign since the last check, the recipient will not pass through the campaign
until the next check.

Post Click
Starts the process of the campaign for a recipient that created a post click.
Parameters

Description and values
Specify which recipients are passing through the campaign.
l

Starts the Marketing Automation
Campaign

l

if recipient never passed through this MA campaign: Recipients pass
through the campaign if they
o

created a post click.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign: Recipients pass through the campaign if they
o

created a post click.

o

are not currently passing through the campaign.

Recipients that already passed through the campaign and that create
a post click again may pass through the campaign again.
l

always: Any recipient that created a post click pass through the campaign.

Specify the mailings in which recipients must click a link. You can
Mailings

l

specify a mailing, or

l

limit the mailing selection to
o

a mailing type.
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Parameters

Description and values
o

a folder that contains the mailings.

o

the mailing's send date.

Post Click

Select the post-click service. This is either the proprietary post-click tracking
or the web analytics software you are using.

Start Only For

Only recipients of this target group pass through this campaign.

Include imported post clicks
without recipient list

Select Replacement Recipient
List

Select this check box if you want to evaluate imported post clicks the recipients of which cannot be assigned to any recipient list in Optimizely Campaign.
This is, for example, the case when post clicks are imported from external
sources or the recipient is logged in the web shop at the time of the post click,
but has not registered for the newsletter. This setting does not apply to post
clicks that can be uniquely allocated to recipients in existing recipient lists.
With such post clicks, in which the email address is known, Optimizely Campaign checks whether this corresponds to a recipient in the replacement
recipient list. Select the replacement recipient list in the next step. If the
email address is found in this recipient list, this recipient is considered in
the further course of the Marketing Automation campaign and can receive
messages (provided that the other conditions are met).
Select the recipient list here to which the recipients of the imported post
clicks are compared. Post-clicks that could not be assigned to a recipient from
any existing recipient list at the time of their capture (see the previous parameter) are compared to this recipient list and are assigned with the matching
email addresses. Imported post clicks that cannot be assigned to any recipient
of this list are discarded.
Note: You should create a Standard recipient list
that contains the registered recipients and select
this recipient list here. As a result, there is a high possibility that a post click can be assigned to a recipient.
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From MA Campaign
Starts the process of this campaign for a recipient from another Marketing Automation
campaign.
Parameters

Description and values
Specify which recipients are passing through the campaign.
l

l

Starts the Marketing
Automation Campaign

if recipient never passed through this MA campaign: Recipients pass through the campaign if they
o

come from another campaign.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign: Recipients pass through the campaign if they
o

come from another campaign.

o

are not currently passing through the campaign.
Note: Recipients that already passed
through the campaign and that come
from another campaign again may pass
through the campaign again.

l

Start Only For

always: Any recipient that comes from another campaign pass
through the campaign.

Only recipients of this target group pass through this campaign.

Advanced
Starts the process of the campaign for a recipient that matches specific criteria.
Parameters
Starts the Mar-

Description and values
Specify which recipients are passing through the campaign.
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Parameters

Description and values
l

l

keting Automation
Campaign

if recipient never passed through this MA campaign: Recipients
pass through the campaign if they
o

match the criteria of this node.

o

are not currently passing through the campaign.

o

never passed through the campaign.

if recipient is not currently passing through this MA campaign:
Recipients pass through the campaign if they
o

match the criteria of this node.

o

are not currently passing through the campaign.
Note: Recipients that already passed through
the campaign and that matches the criteria of
this node again may pass through the campaign again.

l

always: Any recipient that matches the criteria of this node pass
through the campaign.

Only recipients of this recipient lists are passing through this campaign.

Start Only for
Recipients In (mandatory)

Note: To start the campaign you have to specify a
recipient list here. If you select multiple recipient
lists, no recipient cross check will take place.
Therefore the same recipients can run the campaign several times if they are in multiple recipient lists.

Specify the maximum number of recipients to be contacted. If this value is
higher than the number of possible recipients, all recipients are contacted.
Limit the Number
of Recipients To

Note: The maximum number of recipients
depends on the defined interval. Example: If you
limit the maximum number of recipients to 1000
and define a weekly interval, a maximum of 1000
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Parameters

Description and values

recipients are contacted each week.

Specify how often the criteria should be checked. You can set a daily,
weekly or monthly interval and specify it even further. Optimizely Campaign
checks at the specified time which recipients meet the criteria — these
recipients then pass through the campaign.
Interval

Example 1: If you set the interval to Every 2 months, each 1st from 14:00,
the criteria is checked on the first day of every second month at 14:00.
Example 2: If you set the interval to Every 1 weeks, on Wednesday from
15:00, the criteria is checked every Wednesday at 15:00.
Only recipients of this target group pass through this campaign.
Note: To start the campaign you have to specify a
target group here.

Start Only For (mandatory)
Note: The examination of the criteria may take
time to complete, so the following actions may be
delayed.

Only recipients that are included in the selected Visitor Intelligence segments are passed through this campaign.
Filter by Recipients
Included in All
Selected Visitor
Intelligence Segments

Note: To make Visitor Intelligence segments available in Optimizely Campaign, you first must create
segments in Optimizely Visitor Intelligence. See
Creating a marketing segment.
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Action nodes
Wait
During this time no action is taken.
Parameters

Description and values

Waiting Time

Specify how long no action is taken. After this time, the following action is
executed.

Wait Only if Target
Group Is

For recipients of this target group, no action is taken during this time.
Remaining recipients skip this action.

Send Message
Sends a message to the recipient.
Warning: For performance reasons, messages are sent asynchronously to the course of the recipient in the campaign.
Note the following hints on sending Marketing Automation messages.
l

l

Target groups within the same campaign, that check on the dispatch of the
message in this node, may give false results because the mailing may not be
sent. If you use such target groups behind the Send Message node, there
may be undesirable effects, as the target groups may not work. To avoid this,
place a Wait node, which delays the execution of the action, in front of such
nodes.
If you place a Send Message node behind a Move Recipient node, you also
should place a Wait node in front of the Move Recipient node. Otherwise, the
recipient may be removed from recipient list before the message is sent.
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Parameters

Description and values
Select the message to be sent to the recipient. Messages that you link here
need to be created beforehand. Two functions are available for this purpose:
l

l

Mailing

If you are working with Mailings Classic: Open the start menu and select
Campaigns > Mailings Classic and create a mailing of the type Special/API.
If you are working with Smart Campaigns: Open the Optimizely Campaign
menu and select Campaigns > Transactional Mails, and create a new message.
Note: You cannot use a Mobile Push message and a
Web Push message in the same Marketing Automation
campaign. Create separate campaigns.

Send Only To

A message is sent only to recipients of this target group. Remaining recipients
skip this action.

Switch
Allows the branching of a campaign based on target groups. The branches are processed
hierarchically. That is, the lowest numbered branch has the highest priority and is
executed first.
Parameters

Description and values
Create a connection to the node whose action must be executed for a specific
target group and specify this target group. You can connect nodes using different target groups.

Target Group

Note: If a recipient matches a target group, the corresponding action is executed. Optimizely Campaign
does not check if the recipient matches another target group.
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Parameters
All remaining
recipients

Description and values
Create a connection to the node whose action will be executed for remaining
recipients.

A/B Test
Allows the branching of the campaign based on predefined probabilities.
Parameters

Description and values

Percentage

Create a connection to the node whose action has to be executed for the recipients, and specify the probability of recipients passing through this node. You
can connect nodes using different probability values.

All remaining
recipients

Create a connection to the node whose action has to be executed for the
remaining recipients.

Change Recipient
Changes a recipient's data. To use this node, you need the permissions that let you evaluate action-based data at user level.
Parameters
Recipient List

Description and values
Select the recipient list where you want to change recipient data.
Specify the changes that have to be made.

Changes

1.

In the first list, select a recipient list field.

2.

In the second list, select the action to be performed.
l

set value to: Replace current value with new value.

l

append suffix: Append value to existing value.

l

prepend prefix: Prepend value to existing value.

l

toggle: Toggle between current and counter value.
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Parameters

Description and values

Tip: This option is only available for boolean fields.
These fields contain two values: true and false. If,
for example, the "male" field contains the value
true, it is replaced with the value false.
l

l
l

l

3.

Perform
Action Only
For

time of pass-through: Replace the current value with the time of
the pass-through. The value is set to the time when the recipient
passes through this node.
increment value by: Increment the current value by a certain value.
decrement value by: Decrement the current value by a certain
value.
clear: Delete the current value.

In the last text field, enter a value. To change multiple recipient list
fields, click + and repeat the steps.

Changes are made only for recipients of this target group. Remaining recipients
skip this action.

Copy Recipient
Copies the recipient into another recipient list. To use this node, you need the permissions
that let you evaluate action-based data at user level.
Parameters

Description and values

Copy To (mandatory)

Select the recipient list to which to copy this recipient.

Overwrite existing recipient

Check the box to overwrite the recipient in the target recipient list (if the recipient is already contained in this recipient list).

Copy Only

Only recipients of this target group are copied to the recipient list. Remaining
recipients skip this action.
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Move Recipient
Moves a recipient to another recipient list. To use this node, you need the permissions that
let you evaluate action-based data at user level.
Parameters

Description and values

Move To (mandatory)

Select the recipient list to which to move the recipient.

Overwrite existing recipient

Check this box to overwrite the recipient in the target recipient list (if the recipient is already contained in this recipient list).

Move Only

Only recipients of this target group are moved to the recipient list. Remaining
recipients skip this action.

Start In
Starts the process of another campaign for a recipient. The recipient remains in the current
campaign and passes though the other campaign in parallel. The other campaign must contain the From Campaign start node.
Parameters

Description and values

Marketing Automation
Campaign (mandatory)

Select the campaign that the recipient has to pass through.

Beforehand Copy To

Optionally select if the recipient must be copied to another recipient
list before he passes through the campaign.

Overwrite existing recipient

Check this box to overwrite the recipient in the target recipient list (if
the recipient is already contained in this recipient list).

Perform Action Only For

Only recipients of this target group are passing through the other campaign. Remaining recipients skip this action.
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Done
Marks the end of the campaign. This is an optional node.

Campaign report
To view the campaign report, open the Marketing Automation window, select a running
or paused campaign, and click Report.

The Marketing Automation campaign report shows in the left overview area the number of
successful, active, and failed runs of the campaign as well as the average opening and
click rate of the campaign mailings.
At the individual campaign nodes you can also find information about the successful runs
and failed runs

.

At the Send message action node you can furthermore see opens

, clicks

and the

open and click rates
. For the No restrictions period, you can optionally display the
unique opens, clicks and the unique open and click rate by selecting the Show unique KPI
values check box.
If you use a Wait node in your campaign, the currently-waiting recipients
played.
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Tip: If a recipient did not receive the message via a Send Message
action node (for example, because the recipient is blocked or
exceeded the bounce limit), this event appears as an error for the
node. You can find information about the recipients of a marketing
automation campaign in the recipient history under Marketing Automation history.

Marketing Automation guide
Create more effective email marketing using a graphic interface with drag-and-drop functions to develop multi-step campaigns based on action- and event-based mailings. These
campaigns are perfectly adapted to a highly diverse set of target groups, using automated
distribution cycles.
Optimizely Campaign's graphic editor lets you create elaborate campaigns for your customer database, then refine them after the campaign is running. This guide provides actual
examples that you can use "as is" or with minor adjustments.

Benefits
l
l
l
l
l
l
l

Lifecycle marketing made easy via drag and drop
Sustainable, automated cultivation of customer relations
Maximum flexibility of campaign design
Increased revenue through automated cross-selling and upselling campaigns
Optimal visibility and precise timing; supports several parallel campaigns
Focused on individual recipients and simple content filtering options
Practical real-time analyses by overlay

What is lifecycle marketing?
Email content should be oriented to a recipient's interests and personal circumstances.
Lifecycle marketing shapes each customer relationship by communications that pass
through a series of phases. Each phase is characterized by changing expectations that can
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be divided into segments, such as new customer, regular customer, and inactive customer.
You want to draw potential consumers to your company’s brand and products, and transform general interest into a willingness to purchase, supported by appropriately targeted
inducements. When a consumer becomes a customer or a long-term regular customer, you
want to provide new impulses through well-defined and properly-dosed emails. By applying the right analysis strategy to an ever-expanding database, you can obtain a better picture of your customers and target measures such as periodic incentives or post-profiling.
When you win back inactive customers, the lifecycle marketing strategy is complete.

Cultivating customer lifetime value
Lifecycle marketing tries to cultivate customer lifetime value (CLV) into a viable concept
that benefits your company and its products. To do this, Optimizely Campaign creates a
series of automated mailings for events and target groups. CLV is the profit contribution
that a customer realizes during his "lifetime" as a customer. In addition to past revenue, it
considers anticipated future revenue and customer potential. CLV thus exceeds
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conventional campaign performance measurements. Moreover, this indicator includes customer sales trends, allowing for targeted email marketing aimed at generating appropriate
purchasing inducements.

You want to find a profitable means of addressing a variety of customer scenarios over the
long term. For example, an automated reactivation campaign is preferable to a one-time
effort at winning back regular-but-currently inactive customers. Such a campaign systematically solicits this customer group over an extended time period. This approach also
helps ensure that no customer “falls through the cracks,” preserving customer value. Marketing managers can devote considerably more time to the content of their promotions
and continued development of campaigns.

Marketing Automation for every need
Maintaining customer relationships is more complex than winning over new customers.
Customer care in lifecycle marketing means consistently addressing the customer according to their status and interests. A contact strategy should be evolutionary, methodical,
and forward-looking. Direct prompts and incentives toward obtaining desired responses
and targeted feedback are initiated. Effective Marketing Automation improves customer
care. Successful campaigns produce higher customer satisfaction and provide for targeted
responses to the needs of regular customers.
While conventional approaches can support a few standard segments and customer lifetime phases, Optimizely Campaign makes more effective use of your customer data to customize implementation. You can decide to display an entire customer lifetime cycle in a
central campaign, or roll out several individual campaigns.
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From concept to the campaign
A user-friendly interface lets you turn an idea into a campaign. Use your computer mouse
to mark starting and ending points. Then, with the aid of nodes and branches, retrieve your
parameters in Optimizely Campaign and incorporate them into a campaign.

Each node stands for an action or event (such as sending birthday email as trigger-mail), or
for filtering addressees by target group. By linking two nodes, you create a sequencing
plan that anyone can follow. You can assign parameters to any node, such as click profiles,
target groups or individual mailings. Marketing Automation automatically checks link logic
among nodes and verifies that no nodes lead to dead ends.
You can add partial or intermediate steps for specific addressee groups. For example, if
you want to communicate with only addressees who opened their discount mailing three
weeks earlier, select the appropriate target group as parameter. Other addressees in your
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distribution list are unaffected but may be considered for a different discount mailing. As
you get to know you customers better through additional campaigns and analyses, you
can create additional segments and reconfigure the way you communicate benefits.
Developing the perfect campaign takes time and analysis. You can modify and refine a campaign to properly align your marketing goals while moving toward perfection. You can save
modifications as drafts then transfer them to a running campaign with no downtime.

Campaign building blocks
Blocks

Description
Start node
Defines the action or event that triggers
by the campaign, such as a registration, a
clicked link, or a post click. Also defines
recurring events, such as an addressee’s
birthday.
Start nodes use blue icons.

Prerequisites
Set each campaign so it runs once or several times. You can also specify that an
addressee cycles through a campaign
only once at any given time.
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Blocks

Description

Action nodes
A campaign may contain multiple action
nodes. Each action node stands for one
action.
You can send out mailings, segment target groups, or set it to wait. If an action
node is assigned to a target group, the
action goes to addressees in that group
only; other addressees skip this node and
continue to the next node.

Loop
Campaigns may contain loops that an
addressee cycles through several times
until a criterion set for that loop either
applies or no longer applies. The built-in
campaign validation function evaluates
whether an endless loop is inadvertently
included in the campaign. If so, it prevents that campaign from being initiated.

Promoting on anniversaries
Anniversaries are opportunities to contact your customers and maybe include a coupon.
You can use the dates of registering with your site, newsletter signup, or a birthday,
provided in an optional form field.
For example, set up a target group formatted as recipient list field: birthday: is
anniversary. You may want to include a coupon in a birthday mailing. Create three mailings:
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l
l
l

one with an image for men
one with an image for women
one (labeled "fallback" in the image below) with a neutral image for recipients whose
gender is unknown

The following steps set up this example.
1. Use the Advanced node as the starting node. This queries target groups at set intervals. With birthday mailings, a target group should be screened daily for has birthday.
2. Create a branch node to sort recipients by gender.
3. Each group receives the appropriate birthday mailing.
4. Recipients whose gender is unknown receive the third mailing.
Tip: You may set up an anniversary campaign in the same manner.
Change the target group to has anniversary.
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After-sales recommendations
Prompt customers who made previous purchases to order more products through aftersales recommendations.
The following example uses customers of an online drugstore who purchased sunscreen
the previous year. You want to contact customers whose last purchase is more than 10
months ago, remind them of the sunscreen's expiration date, and suggest they obtain a
fresh supply.
For this campaign, first incorporate post-click tracking in the drug store's web shop. This
provides information about when a customer purchased a product in the category sunscreen. Next, set up a target group with the filter: recipient purchased a product in the
category sunscreen exactly 300 days ago. This group generates a mailing that includes
a notification about the expiration date, product recommendations, and a coupon for sunscreen. This mailing is called Has your sunscreen expired? – Buy now and save!
To set up this campaign, follow these steps.
1. Because this campaign responds with a time delay rather than a transaction, use an
Advanced start node rather than a Post-click node. The parameter for the node is the
previously-specified target group. The campaign is started daily.
2. Recipients filtered by this node receive the previously-created mailing.
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Reactivation campaigns
Contact customers who recently ignored your promotions. Reactivating inactive customers offers multiple means for increasing revenue while maintaining and cultivating your
customer master list.
A reactivation campaign should investigate reasons for inactivity, offer incentives to
become an active customer again, and allow those interested to confirm their interest in
your newsletter. A recipient who does not respond, that is, does not renew his opt-in, is
preferable to a recipient who remains inactive. You may also want to offer inactive recipients an option to receive your newsletter less frequently (for example, monthly rather than
weekly) or temporarily suspend receipt.
A reactivation campaign should consider these factors and provide flexible responses that
correspond to customer reactions. The point at which a recipient is considered inactive varies depending on the product being advertised in the newsletter. For a travel agency, you
can presume a 12-month purchasing cycle. That is, you expect a recipient to make largescale travel plans once a year and seek suitable offers accordingly. For other business sectors, the cycle may be considerably shorter.
Based on this definition of an inactive recipient, you would create a target group with two
qualifiers, one of which should apply in each case:
l

Addressee has not clicked on any mailing in the past 730 days (2 years)
OR

l

Addressee has not opened a mailing in the past 365 days.

Planning a multi-stage campaign
When planning a multi-stage campaign, several mailings are necessary.
l
l

l

Haven’t heard from you in a while. Contains the latest travel offers.
How can we serve you better?. Requests that the recipient update his or her user information.
Receive our newsletter once a month. Lets recipients switch newsletter frequency to
monthly rather than weekly. Another button is Suspend newsletter for 6 months.
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Both buttons are linked to a landing page that confirms the change. You can also configure a preference center with these features.
l

l

l

A coupon for you. Recipients who clicked an item during the first reactivation campaign
receive a coupon.
Thanks for your feedback! Recipients who click the link to the preference center receive
this mailing.
Please confirm your subscription. Lastly, recipients who responded to none of the previous
mailings should be prompted to renew their opt-in. The mailing should include an opt-in
link.
Note: Mailings used in conjunction with Marketing Automation must
be set up as Transactional mails and be in Send status.

Setting a reactivation campaign
1. Start with an Advanced node.
This node type inquires once a week whether a recipient is in the Inactive recipient target group.
l
In the node, select the qualifier Addressee has never cycled through the campaign, because each recipient should cycle through the campaign only once.
The mailing Haven’t heard from you in a while is sent out, then wait 7 days. The Wait
node is assigned the target group has not responded to 1st reactivation, so recipients who click that mailing are directed to the next node.
Recipients who click an offer in the mailing Haven’t heard from you in a while receive a
coupon for other compatible offers. The reactivation campaign is over for these recipients.
Recipients who did not respond to the first reactivation campaign (neither opened nor
clicked) receive the second reactivation campaign, How can we serve you better?,
then wait another 7 days. The Wait node is assigned to the has not responded to the
2nd reactivation target group, so recipients who click the preference center link in
this mailing are directed to the next node.
Addressees who clicked the link to the preference center in the second reactivation
mailing also receive a coupon for offers suitable to their preferences.
l

2.

3.

4.

5.
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6. The recipients’ preferences are modified in accordance with their selection: For those
recipients who clicked the link Receive newsletter monthly, the frequency recipient
list field is set to monthly. A confirmation mail is sent regarding the mailing frequency
change.
7. For recipients who clicked the suspend delivery for 6 months link, the suspend recipient list field is set to true. Insert a Wait node with a value of 6 months. Then, the suspend recipient list field is reset to false, and a Welcome back message is sent to the
recipient.
8. Other recipients who have not responded to a reactivation mailing receive the Please
confirm your subscription mailing. Insert a Wait node with a waiting period of 7 days.
The Wait node is associated with a target group has not responded to 3rd reactivation, so recipients who confirm their opt-in are immediately directed to the next
node.
9. Recipients who click the opt-in link also receive a Thank you for your feedback mailing,
along with a coupon. Other recipients are marked as unsubscribed.
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Multi-stage series of welcome messages
A series of welcome emails can help develop customer value. Use multistage campaigns to
acquaint new subscribers with your products and services. Recipients are particularly
receptive to receiving a newsletter immediately after registration. This series of emails
should comprise welcome messages followed by email with relevant content. Of most
importance is a sustained, persuasive effort in the form of individual, premium offers.
The following example uses a travel service’s online portal for which you want to establish
trust by recipients and learn more about their specific interests. To this end, begin by creating suitable mailings, click profiles, target groups, and coupons for the campaign.
The initial mailing should be a welcome mail without promotional content that summarizes
the portal's products and services. The mailing includes test/user ratings and short statements from other rating portals that give the recipient a better understanding of what the
portal offers. This mailing might be called Welcome to Travel Deluxe.
A second mailing, to be sent two days after the Welcome to mail, includes an incentive in
the form of a coupon and additional information about travel preferences. So, you can offer
several coupons, each tied to a different travel destination.
In addition, click profiles are created for secondary links that divide the offer into three categories: Hiking & Nature, All inclusive and Culture. This is placed under a mailing named
Our Gift to You.
Note: Mailings to be used with Marketing Automation must be set up
as Transactional mail and be in Send status.
When these steps are taken, review how this campaign looks in association with Marketing
Automation. The campaign should begin via the Recipient New start node for recipients
newly added to the main recipient list (either through self-registration or import).
1. A multi-stage series of welcome mails begins via the start node Recipient New. This
ensures that only recipients who are new newsletter subscribers and recently added to
the recipient list are cycled through this campaign.
2. Drag the Send Message action node into the workspace, select the type of mailing to
be distributed in the node's Properties field, then link the start node to it.
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3. After the recipient receives the first welcome email, he gets a short breather using the
Wait action node. The duration is set in the properties window of the Wait node once
it is linked to the previous node. In this example, the count is 3, and the unit is days. So,
the recipient waits 3 days before the next action is carried out.
4. Select the subsequent mailing using the Send Message action node. This mailing contains the coupon offers including click profiles, as described above. This sends out individual, follow-on emails with reinforcing messaging. To do this, drag the action node
into the workspace, select the mailing, and link the node.
5. To give the recipient sufficient time to read and click, drag the Wait node to the workspace and set up 3 days.
6. This step is essential for distributing the follow-up mailings. The action node Switch
lets the recipient receive different mailings based on target groups. In this case, four
mailings will be employed following the branch. These mailings are placed behind the
Switch node with the aid of the Send Message node, as shown in the diagram. Next,
individual branches are set and linked to the nodes. One target group is allocated to
each branch.
In this case, three branches are assigned to target groups, while one branch is defined
for recipients who correspond to none of the target groups. If a target group does not
match the Send Message node with which it is associated, it skips over this node, and
the mailing is not sent to the recipient.
7. As required, the recipient should receive a feedback mailing 28 days after registering.
If you subtract the 2x3 days employed by the wait-nodes from this 28 day period, you
should place a Wait node with a value of 22 days.
8. After being on the recipient list for 28 days, by using an additional Send Message
node, the recipient receives this campaign's final mail.
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Cross- and upselling
Lifecycle marketing builds increased interest and purchasing incentives through campaign
emails, trigger mails, and themed mailings. It provides added value by supplying the customer with relevant and helpful purchase or reservation information.
For example, while booking a flight, provide recommendations for hotel, car rental, area restaurants, and other activities. On returning from the trip, offer a photo album that can be
purchased online to use for vacation snapshots.
To use cross- and upselling offers, set up post-click tracking in your web shop to provide
the following data:
l
l
l
l

Which product did the customer purchase?
Was the purchase completed?
Arrival and departure dates
Optionally, the value of the order
Tip: To set up post-click tracking, contact customer support.
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Allocating target groups and mailings
To later select the correct mailing with corresponding hotel and rental agency recommendations, allocate a target group to each destination. The target group definition would
be: Addressee generated a post click in the category flight with the value Mallorca / Grand
Canary Islands / Sardinia / Athens / Antalya / and so on.

An additional target group checks if the date-of-return matches the current date.
Next, allocate a mailing to each travel destination (or create a mailing with a paragraph
about each destination) and associate it with a target group. In the following example, a
paragraph is included in the mailing for each target group set up during the previous step.
To keep promotions up-to-date, this paragraph is linked to a content interface. You also
need a mailing to distribute when a customer returns home, which looks the same to all
recipients:
l
l

Before you fly: Our hotel recommendations
Welcome back! Here's a place to put your vacation pictures
Note: Target groups compiled with the help of post-click data look
different depending upon the configuration of the post-click tracking
or the web-analysis software. For instance, with some web-analysis

© Optimizely 2022

Campaigns | 269

products, you can select the product purchases category then specify greater detail. The example here is based on a post-click configuration tracking where a post click is produced only after an order
is completed, eliminating the need for that pre-selection.
The following image shows how to create the Before you fly: Our hotel recommendations
mailing.
1. Use the Post-click node and set the parameter category same as flight.
2. The selection of destination, and corresponding hotel accommodations, in the mailing
occurs by target group. So, choose this mailing and send it to the recipients.
To expand this campaign to include other promotions, such as for rental cars, modify
the mailing and the paragraphs within it.
3. Incorporate a loop that inquires daily whether the return date equals that day’s date. A
Wait node is set with a value of 1 day and, after it, a branch that filters the target group
return date is today. This group receives the mailing, Welcome Back: Now here’s a
place to put your pictures with a coupon to order the photo album. Other recipients
are reset to the Wait node.
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Dealing with canceled transactions
Customers abort orders, purchases, and other transactions for many reasons. If a customer
places a product in a shopping cart, that usually indicates interest in that product. A targeted campaign can give the customer an incentive to complete the transaction.
In the example below, customers who abort transactions are sent a coupon and recommendations for related items. Web analysis filters out recipients who put a trip/tour in a
shopping cart but did not complete the transaction. You can use a web-analysis tool to
transfer records of sales/reservation cancellations directly to Optimizely Campaign.
Tip: Web-analysis tools let you simultaneously generate suitable
recommendations for transaction cancellations, transfer those to
Optimizely Campaign, then create a campaign aimed at this grouping. Contact customer support about connecting web-analysis software to your client.
Using categories and target groups, create paragraphs in a mailing that describe trips/tours similar to the canceled one. Send this mailing to those who canceled transactions.
Recipient generated a post click in service "Analytics" with a value of "Mallorca" /
"Grand Canary Islands" / "Sardinia" / "Athens" / "Antalya" / in the category
"Transaction cancellation".

You must assign a target group to each destination.
The campaign is carried out in two steps, requiring two mailings: a coupon mailing, and a
mailing containing recommendations:
l
l

May we recommend
Book now and redeem your coupon

A separate paragraph is inserted into the mailing for each target group created in the previous step.
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The target groups for this campaign are the same used for the cross- and upselling campaign, except that the transaction cancellations category is tracked. Using web-analysis
software, the target group looks something like this:
1.
2.
3.
4.
l
l
l
l
l
l

Addressee generated a post click
In the service Analytics
In the transaction cancellation category
Using the word
Mallorca
Gran Canary Islands
Sardinia
Athens
Antalya
...

The following steps show how to create a campaign for transaction cancellations.
1. Use a Post click node. The Analytics service and the transaction cancellations target group are set as parameters for the node.
2. Filter recipients by this node to get recommendations relating to the trip/tour previously considered. Target groupings determine the recommendations in the mailing.
3. Set a Wait node to a value of 3 days.
4. Set a branch. For each target group, recipients who purchased a trip/tour are filtered
out using the has purchased target group created previously. For these recipients,
the campaign is concluded.
5. Recipients who did not make a purchase get a coupon mailing.
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Multi-stage campaigns
This type of campaign introduces regular recipients to products and services. It requires
little effort to execute because the mailing content remains essentially the same. By modifying the subject lines and the order of paragraphs in a mailing, you can highlight a
product's benefits and characteristics.
Use post-click tracking to conduct a multistage campaign, which uses target groups to filter recipients who generated a conversion.
Note: Alternatively, you can configure target groups that filter recipients who clicked the registration link for your web shop in an email.
This type of target group produces less precise results because it
includes recipients who clicked a link but did not complete the registration or purchasing process.

Prerequisites
For multi-stage campaigns you need various mailings and target groups:
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Mailings
l

l

l

l

Principal mailing (type: regular) with two split mailings, each with a modified subject line
(re: A and B).
2 copies of the principal mailing (type: special), each with a different subject line (attract
interest, call-to-action) (re: C and D).
Alternate version of the principal mailing (type: special) with the content rearranged or
modified to shift the mailing's focus (re: E).
Copy of this variant (type: special) with a different subject line urging call-to-action (re: F).

Target groups
l
l
l
l
l

l

Recipients who received the principal mailing or one of the split mailings.
Recipients who did not open the principal mailing.
Recipients who did not open the second mailing.
Recipients who did not open the third mailing.
Target group that analyzes post clicks and matches recipients who generated a conversion (for example, completed registration or purchase).
Recipients who opened a mailing but did not generate a conversion.

Creating a subject line split mailing
The first stage of the campaign consists of a classic A/B split test, used to determine the
subject line that generates the greatest number of openings or clicks. The mailing that performs best is then sent to the remaining recipients. The automated campaign begins 24
hours later, when recipients are sent additional mailings in several stages.
1.
2.
3.
4.

Create a principal mailing with desired content.
Prepare a split mailing from the principal mailing, with subject line version A.
Prepare a second split mailing from the principal mailing, with subject line version B.
Go to Automatic selection of best split for principal mailing and select best
unique opening rate or best unique click rate, and set a 1-day delay for automated
distribution of the principal mailings.
5. Save the settings.
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6. Launch the split mailings, either manually or automatically.
Note: The following campaign must be created before the split
mailing is launched, and mailings in this campaign must be set as
Transactional mail.

Following up with automated distribution mailings
Create a campaign that launches after the principal mailing is sent out.
1. Start with an Advanced node to filter recipients who received the principal mailing or
one of the two split mailings. Initially, the standby time is set to four days to provide
recipients sufficient time to respond.
2. Recipients who have not opened this mailing and have not completed registration
receive the modified subject line C. They are given another 4 days to respond.
3. Recipients who open the first mailing during this period, but have not generated a conversion, do not receive mailing C. Instead, they are sent the two-stage reminder that
concludes the campaign. The campaign terminates for recipients who generate a conversion.
4. Recipients who have not opened mailing C are sent another mailing with subject line
D.
5. As in step 3, recipients who opened mailing C during this period, but who have not generated a conversion, are sent the two reminder mailings. The campaign terminates for
recipients who generated a conversion.
6. After another 4 days, recipients who completed registration are filtered. For them, the
campaign terminates. Recipients who opened mailing D but did not generate a conversion receive the first reminder mailing. This mailing, with subject line E, contains content from the principal mailings in a different order or with a different focus. Recipients
who have not yet opened any mailings are disregarded from this point on.
7. After a week, recipients who did not open the first reminder receive a second reminder.
This mailing is identical to the first, but contains another version of the subject line
with a call-to-action. The campaign then terminates.
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Transactional mails
Transactional mails are sent automatically as a result of actions or events. There are two
scenarios for transactional mails:
l

l

API mails. Result from an API call, such as placing an order from the web shop. For this
type of transactional mail, you need the REST API, SOAP API or HTTP API.
Campaign mails. Used in a Marketing Automation campaign. While editing the Send message node, select the appropriate transactional mail in the Marketing Automation function.

When started, transactional mails remain in Sending status. Transactional mails are sent in
real-time via the Optimizely Campaign transaction API.
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Transactional mails overview
To open the transactional mails overview, open the Optimizely Campaign menu and select
Campaigns > Transactional Mails.

In the transactional mail overview, you can find information about all created transactional
mails, such as media type, name, ID and creation date. You can also view the current status
of each transactional mail:
The transactional mail overview displays the status of each transactional mail.
l
l

l
l

New. Fully configured but not started.
Incomplete. Elements are missing or necessary parameters are not defined. Complete the
configuration then start the transactional mail.
Sending. Active and sending mails.
Canceled. Sending was canceled and cannot be restarted.

Transactional mail actions
Note: Some actions are not for new or incomplete transactional
mails.
l
l

l

Create. Create new transactional mails. See Creating transactional mails.
Copy. Copy a transactional mail. Elements (recipients, target groups, messages, and so on)
are applied.
Edit. Edit a transactional mail as described under Creating transactional mails.
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l

l

l

Delete. Delete a transactional mail. You can delete only new or incomplete transactional
mails.
Start. Select a transactional mail and click Start. Confirm the start by clicking Start Mailing.
Copy to Client. Copy transactional mails to other clients. Recipient lists and target
groups are not transferred to the target client.
Note: Prerequisites
o

o

The registered user has permission to create mailings in the target client.
The target clients have the same template used in the transactional
mail that you want to copy.

1. In the campaign overview, select a transactional mail and click Copy to Client….
The Copy Transactional Mail to Client window opens.
2. In the Transactional Mail area, in the New Transactional Mail Name in the Target Client field, enter the name for the copy of the transactional mail in the target
client.
3. In the Target Clients area, select clients in which you want to copy the transactional mail.
Tip: To select all available target clients, check the box in the
menu bar.

l

l

4. Click Copy.
Analysis. Select an active transactional mail (in Sending status) and click Analysis to
check how many mails were already sent via an ongoing transactional mail. You can also
see additional parameters such as opens, clicks, bounces, or unsubscribers.
Send Test Message. Send a test message to check the appearance of the mailing before
the actual dispatch. See Test email.
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Creating transactional mails
1. In the transactional mails overview, click Create….

2. From the left action pane, drag the Recipients node into the workspace.
3. In the Recipient lists drop-down list in the context menu, select your transaction
recipient list.
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Note: Customer support has set up a separate transaction recipient list for you. Make sure you use this transaction recipient list,
instead of a regular recipient list. To see if a recipient list is a
transactional recipient list, check the column Transaction API.
4. Optional: From the left sidebar, drag the Block node into the workspace. Click Properties
and select one or more custom blocklists from the drop-down list. The recipients on those blocklists do not get a message.
Note: The Block node only works with custom blocklists and is
only available for the email media type.
5. From the left sidebar, drag the message node for the desired media type into the workspace. The marketing channel must be compatible with recipient list type.
You can select the following marketing channels for transactional mails:
Marketing channel

Delivers

Required recipient list type

Mail

email

Mail or multiple list

SMS

SMS

SMS or multiple list
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Marketing channel

Delivers

Required recipient list type

Mobile Push

push message to a mobile
device

Push or multiple list

Web Push

push message that appears in
the recipient's web browser

Push or multiple list

6. In the Name box in the context menu, enter a name for your transactional mail (for
example Order confirmation).

7. In the context menu for the message node, click Edit Content….
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8. In the Template list, select the desired template and confirm your selection by clicking
Next.
9. Configure the template for the transactional mail according to your requirements. For
more information, see Editing mailing content.
10. Click Apply.
11. Click Close.
12. Connect the Recipients node with the message node.
13. Click Save and Close.
Tip: To run A/B tests to send different variants of a transactional mail
and check which variant performs better, see A/B tests for transactional mails.

Setting up the List-Help header
This topic describes how to switch from the List-Unsubscribe header to the List-Help
header for transactional mails.

List-Unsubscribe header
Currently, every email you send via Optimizely Campaign contains a List-Unsubscribe
header. This is an unsubscribe link that can be executed via the email header. Some ISPs
such as Gmail or Microsoft additionally display an unsubscribe button based on this
header in the inbox overview, from which the recipients can simply unsubscribe with one
click without having to open the mailing. The normal unsubscribe link in the mailing footer
is a separate feature and is not related to the List-Unsubscribe header.
Example List-Unsubscribe header
List-Unsubscribe: <mailto:listoff-1234567-ABCDEFG-123ABCD@your.domain.com?subject=unsubscribe>,<https://your.domain.com/gu/0/1234567ABCDEFG-7654321-GFEDCBA-00.html
List-Unsubscribe-Post: List-Unsubscribe=One-Click>
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List-Help header for transactional mails
However, the List-Unsubscribe header does not make sense in every mailing, e.g., in nonlist-based emails such as activation emails, order confirmations or password reset emails.
The List-Help header may be used instead for ad-free, transactional mails. It is also part of
the email header, but instead of an unsubscribe link it contains a URL to a website that
explains to the recipients why they have received this mailing, how they can unsubscribe
or why unsubscribing from it is neither possible nor necessary.
An unsubscribe button is not displayed. There is also the option of adding a contact email
address in the List-Help header area, which is optional. The use of the List-Help header is
compliant with CSA guidelines and industry best practices.
Example List-Help header
List-Help: <https://your.domain.com/unsubscribe.html>,<mailto: unsubscribe@your.domain.com>

Requirements
To switch from List-Unsubscribe header to List-Help header, note the following requirements for the mailing in which this is to be used, as well as for the List-Help URL itself:

Mailing requirements
l

l

l

The implementation is only possible for mailings of type "transactional mail" or "confirmation mail".
In terms of content, the mailings must contain transactional content triggered by the recipient, e.g., activation emails, order confirmations, invoices or password reset emails.
The mailing must not contain any advertising content. This includes product advertising,
newsletter advertising, advertising for the online shop, vouchers and all measures aimed
at a (further) purchase. Company branding can be used.

List-Help URL/website requirements
l
l

The List-Help URL must lead to an active website via HTTPS, HTTP is not sufficient.
The website must contain the information as to why the recipient received the mailing.
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l

The website must contain information on how to unsubscribe from further emails or why
unsubscribing is neither possible nor necessary.

Setup
To switch from the List-Unsubscribe header to the List-Help header, contact customer support.
Provide customer support with the following information:
l
l
l
l

Reason for request
Name / ID of the Optimizely Campaign client
Name / ID of the mailing
List-Help URL

Opt-in processes
This topic describes how to create and manage opt-in processes and registration confirmations (opt-in emails). Opt-in emails are necessary to obtain permission from recipients
to send them advertising mailings.
Opt-in emails are sent in real-time via the Optimizely Campaign transaction API (application programming interface) when a recipient registers for your newsletter. For more
information on the opt-in method, see Opt-in.

Opt-in process overview
To open the opt-in process overview, open the Optimizely Campaign menu and select Campaigns > Opt-in Processes.
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In the opt-in process overview, you can find information about all created opt-in processes, such as ID, name, type and confirmation page URL. You can also view the current
status of each opt-in process:
l

l

Sending. Active opt-in processes. Opt-in emails are sent. Newly created opt-in processes
start automatically and are in Sending status.
Canceled. Inactive opt-in processes. No opt-in emails are sent.

Opt-in process actions
l
l
l

Create…. Create new opt-in processes. See Creating opt-in processes.
Edit…. Edit an opt-in process as described under Creating opt-in processes.
Start. Start a previously canceled opt-in process. The opt-in process must be in Canceled
status.
Tip: You can view the opt-in process status in the Status column
of the opt-in process overview.

l
l

l

Cancel. Cancel an active opt-in process. The opt-in process must be in Sending status.
Analysis. Check how many opt-in emails were sent. You can also see additional information such as openings, clicks, bounces or unsubscribers.
Send Test Message…. Send a test message to check the appearance of the mailing
before the actual dispatch. See Test message.

Creating opt-in processes
1. In the opt-in process overview, click Create….
2. Drag the Recipients node from the left action area to the working area on the right.
3. Select one or more recipient lists.
Note: You can only use recipient lists of the Opt-in type.
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4. Drag the Opt-in Email message node from the left action area to the working area on
the right.
5. Configure the opt-in process.
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l

Type. In the drop-down list, select the opt-in type. Double is selected by default.
Tip: For information on the different opt-in methods, see Optin.

l
l
l

Name. Enter a name for the opt-in process.
Description. Optional: Enter a description for the opt-in process.
Confirmation Page URL. Enter the URL of the confirmation page.
Note: The confirmation page URL is required for opt-in processes of the Double type.

Optional: You can append the parameters bmrecipientid, bmrecipientlistid
and mailing to the confirmation page URL and use them for tracking and analysis. To do this, select the respective check box.
6. Edit the opt-in email by clicking Edit Content…. See Editing mailing content.
o

Note: Opt-in emails for double opt-in processes must contain a
double opt-in link. Insert the {Double Opt-in Link} field function into the mailing text or add it to the HTML code, for example
<p>To confirm your newsletter subscription, click the
following link: <a href="{Double Opt-in Link}">Confirm subscription</a><p>.

7. Connect the nodes.
8. Click Save and Close.
Tip: Newly created opt-in processes start automatically and are in
Sending status. If you want to cancel a running opt-in process,
select it in the opt-in process overview and click Cancel.
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Message templates
Use message templates to create messages for sending via Smart Campaigns as well as
transactional mails and skip the configuration steps.
You can create message templates and configure these by yourself with sender information, recipient lists, and other parameters. You can create a new message template by
using an existing message template, directly via HTML code or by using an existing message as basis.
To open the template overview, open the Optimizely Campaign menu and select Campaigns > Message Templates.

Actions
l

Create

l

Copy

l

Edit

l

Delete

Create
1. To create a new message template, click Create….
2. From the drop-down list, select an option.
l

New. Create a new message template based on a free-text template or another
message template. Click New in the left column, then select a message template
from the list on the right.
Note: The selected message template must support the targeted marketing channel, for example email.

l

Message. Apply content from an existing message to this message template. Click
Message in the left column then select a message from the list on the right.
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Tip: Messages you created with Mailings Classic are also available.
Message template. Apply the content and configuration of an existing message
template. Click Message template in the left column, then select the template
from the right.
3. Click Next to edit the message template.
l

Copy
1. To create a new message template and apply the content and configuration from an
existing message template, click a message template in the list that has parameters
that you want to apply.
2. Click Copy…. The message content appears on the screen.
3. Modify as needed the click Save.

Edit
To edit an existing message template, click a message template in the list, then Edit….
Note: If you save the message template under a different name after
editing, the message template is renamed when you save it. No automatic copy is created.

Delete
To delete a message template, click a message template in the list, then Delete.

Configuring message templates
A message template usually contains sender information, a personalized subject line and
other parameters such as character sets that can be reused. For information how to configure messages, see Configuring the message.
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For information how to add content to the message template that you want to reuse in
messages (for example, header and disclaimer), see:
l

Email message templates. See Edit mailing content.

A/B test
With an A/B test, you can test a mailing in different variants on a small portion of the recipient list before you start the actual dispatch. The variant that performs best in the criteria
you defined is then optionally sent to the remaining recipients.
The variants (split mailings) usually differ only in few parameters from another. The most
common variations include:
l
l

l

l

Subject line. Test how different subject lines affect the opening rate.
Header image, title, intro paragraph. Test various headers, titles and introductory paragraphs.
Target group-specific testing. Test a mailing or a mailing variant to different target
groups (for example, male and female recipients).
Time of dispatch. Test the optimal time to send the master mailing.

A/B test in Smart Campaigns
To perform a A/B test in Smart Campaigns, do the following:
1. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
2. Click Create…
3. From the left action pane, drag the Recipients node into the workspace and select
one or more recipient lists.
4. Drag an A/B Test node from the left action area and drop it onto the desktop.
5. Connect the Recipients node to the A/B Test node.
6. Drag a message node (Email or Mobile Push) onto the desktop. Create a new message
or edit an existing message.
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7. Drag another message node of the same type onto the desktop. Select the message
that you used for the first message node and change the content according to the criteria that you want to test.
8. Add further message nodes if necessary and follow the description in point 7.
9. Connect each message node to the A/B Test node.

10. In the A/B Test node, optionally activate Activate automatic optimization and/or
Send time optimization. For example, you can configure that the mailing with the
best unique opening rate is automatically sent to the rest of the recipient list two days
after the dispatch of the split mailings. For more information, see A/B Test node and
Configuring send time optimization in the A/B Test node.
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11. In the Edit menu
of the respective connection, you can set, among other things,
how many recipients should receive the split mailing. For example, if you select 10% for
two split mailings, the mailing will be sent to the remaining 80% of the recipient list
after the A/B test has been completed. For more information, see A/B Test node.
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12. Click Save and Close. After the successful validation, you can activate the A/B test
campaign.

A/B test for transactional mails
Note: To enable this feature, contact customer support.
With an A/B test, you can send different variants of a transactional mail and use the key figures to determine which variant performs better. To evaluate the mailing key figures, for
example, you can use the Deep Analytics analysis tool.
Note: You cannot use transactional mails from A/B tests in Marketing
Automation.
To create an A/B test with transactional mails, do the following:
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1. Open the Optimizely Campaign menu and select Campaigns > Transactional Mails.
2. Click Create….

3. From the left action pane, drag the Recipients node into the workspace.
4. In the Recipient Lists drop-down list in the context menu, select a transaction recipient list.
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Note: Customer support has set up a separate transaction recipient list for you. Make sure you use this transaction recipient list,
instead of a regular recipient list. To see if a recipient list is a
transactional recipient list, check the column Transaction API.
5. From the left sidebar, drag the A/B Test node into the workspace.
6. Connect the Recipients node with the A/B Test node.
7. From the left sidebar, drag at least two message nodes for the desired media type into
the workspace. The marketing channel must be compatible with recipient list type.
You can select the following marketing channels for A/B tests with transactional mails:
Marketing channel

Delivers

Required recipient list type

Mail

email

Mail or multiple list

SMS

SMS

SMS or multiple list

Mobile Push

push message to a mobile
device

Push or multiple list

Web Push

push message that appears in
the recipient's web browser

Push or multiple list
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8. In the Name box in the context menu, enter a name for the transactional mail (for
example Split 1).
9. In the Description box, optionally enter a description for the transactional mail (for
example Optimized subject line).
10. Click Edit Content… and configure the message as described in Selecting the content
type and Editing mailing content.

11. Connect the A/B Test node with the message nodes.
12. Click Properties
on the outgoing connections.
13. Specify to how many recipients the split mailing is to be sent.
l

Percent. Enter the percentage of recipients who should receive the split mailing.
Note: The sum of the percentages in all outgoing connections must be 100 percent.

l
l

Recipients. Enter the number of recipients who should receive the split mailing.
No limit. Select this option if you do not want to limit the number of recipients.
Note: You can select this option only for one outgoing connection.
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Tip: For example, if you enter 20% in the first split mailing and
select No limit in the second split mailing, the second split
mailing will be sent to the remaining 80% of recipients.

14. Click Save and Close.
15. To activate your transactional mails and start the sending process, select the mailing in
the transactional mail overview and click Start.
Tip: To configure reports on each split mailing in Deep Analytics or
to create target groups for segmentation, select the Transactional
message mailing type.

A/B test in Mailings Classic
A split mailing in Mailings Classic is a variation of a regular mailing where a subset of recipients is "split off". You can edit every split mailing like a regular mailing and can also have a
completely different look to the master mailing.
Note: A split mailing is associated with a master mailing, even if the
master is moved to another folder.
To create split mailings in Mailings Classic, do the following:
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1. In the Mailings window, select the desired mailing – which is called the master mailing
– and click Split. The Split Dispatch window opens.
2. You have two options.
l

l

Click Add split (master mailing) to create an exact copy of the master mailing
with the same content. Edit this mailing by changing content elements, subject
line, and so on.
Click Add split (new mailing) to create a new mailing with no content. Add the
desired content as described in Mailings-Classic.

In the Splits area, you can see the new split and existing splits of the selected master
mailing. You can edit some parameters in the Split section of the Split Dispatch window, including:
Name. This name is used internally. By default, the split receives the same name as
the master mailing.
l
Subject. Enter your desired variation to test different subject lines against one
another.
l
Maximum number of recipients. Specify the number of recipients whom the split
should be sent (relative to master mailing recipients, in absolute numbers or a percentage).
l
Target groups. Select up to three target groups for the split. See Target groups.
l
Sending date. Set the dispatch date for each split. See Dispatch order.
3. Click Save settings. The split is displayed in the mailing list.
l

In the list, splits appear indented below the master mailing they belong to. In the Type
column, they are designated as Split.

Recipients
To perform an A/B test, during which the best option between split A and B is selected and
sent out as master mailing, splits are typically sent to a subset of total recipients. Each
split can be sent to an absolute number of recipients, or a percentage of total recipients. If
percentage is selected, it is based on the number of master mailing recipients. This principle also applies if a split uses a recipient list other than the master mailing.
For selecting a subset of recipients from a recipient list:
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l

Percentage. Enter a percentage in the Maximum recipients field. The number of recipients is based on the total number of master mailing recipients.
Or, enter an absolute value. If the split contains the corresponding number of recipients, it is sent to exactly that number.

l

Random. Recipients are randomly selected from the list. If you do not use this option,
emails are sent to split recipients according to their order on the list.

In both instances, recipients who receive one split email will not be sent another. Similarly,
recipients who are on several lists only receive one email. Optimizely Campaign monitors
email addresses during dispatch to ensure that each recipient only receives one email
(split or master mailing).

Recipient lists
In most cases, the same recipient lists are used for the master mailing and splits. However,
for a split, you can use a recipient list other than master mailing. The master mailing recipient list is the basis for calculating the number of split recipients.
To use different recipient lists for the master and split mailing, in the Split Dispatch window, select off from the Automatically use the best split for the master mailing dropdown list.
If you are using different recipient lists in combination with recipient data-based target
groups, be aware of potential conflicts between the different recipient lists. See Target
groups.

Calculating recipients
The total number of recipients (master mailing and splits) is calculated every time before a
mailing – including individual splits – is sent. The following illustration shows how subsets
of recipients and the total number of recipients are calculated during dispatch.
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Recipient calculation
l
l

l

l

The symbol signifies that a subset of the total is being created.
If a percentage is given for the number of split recipients, discrepancies between individual splits are possible, as cancellations and bounce overflows are taken into account for
each case. This reduces the number of possible total recipients and the correspondingly
calculated percentages.
The number of possible recipients also considers the master mailing's target groups. If a
target group with the recipient list of the master mailing contains fewer addresses than
the same target group with the recipient list of the split, the number of recipients to be
sent emails is the number calculated for the target group and recipient list of the master
mailing.
If the total recipient number is reached during the dispatch of a split, the subsequent
splits and the master mailing are not be sent (see example 1 and example 2).
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Target groups
Target groups used in the master mailing are inherited by the split mailings. You can add
target groups to split mailings by linking with the target groups of the master mailing using
AND logic.
The number of matches of a target group in the recipient list of the master mailing furthermore determines the maximum possible number of recipients for this target group. If
the recipient list of a split contains more matching recipients for this target group, the
total number of recipients sent an email will not exceed the number previously calculated
on the basis of the target group and recipient list of the master mailing.
Note: Master mailing vs. split target groups
Avoid target groups in the main and split mailings that exclude each
other (for example, Male and Female), because no recipients will be
selected for the split.
Note that the creation of target groups using recipient-based criteria can only apply when
the corresponding criteria is also defined as a list box. Furthermore, if using a different
recipient list for the split than for the master mailing, ensure that it incorporates the same
data structure as the master mailing list – or at least that the list boxes for the master mailing target group can also be found in the split. The description of the corresponding list
boxes must be an exact match, including capitalization.

Example
If a target group is used in the master mailing with the criteria Recipients with interest
"Football", the recipient lists of both the master mailing and the split must contain a common corresponding field, such as Interests.

Dispatch
To send a split mailing in the Split window, click Start Split or select the check box below
Mailing schedule and specify a dispatch date using the calendar.
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Dispatch order
Set the order of splits in the lower section of the Split Mailing window via arrow keys to
the right of each split. Splits associated with a master mailing are part of a hierarchy, which
is determined by the order of the splits. This split hierarchy is referenced when calculating
recipients of splits and the master mailing.
Note: Split hierarchy vs. sending order
When individual splits are manually started, the split hierarchy
applies, without regard for dispatch order. For example, if the last
split in a list is sent first, the recipients for the split and master mailings are calculated on the basis of the overall split hierarchy.
Under certain circumstances, this may lead to a split being sent to
fewer or even no recipients despite having started first. This is
because the splits higher up on the list are allocated the complete
number of recipients, and no recipients remain for the subordinate
split. For more information, see Split mailing examples.
If the split dispatch is started automatically, the split mailings are
sent in the order of the split hierarchy.

Optimizing and sending the master mailing
An A/B test lets you analyze each split's performance and send the best performing variation as a master mailing.
Optimizely Campaign also offers an automatic optimization. To activate it, select one of the
following criteria from the Automatically use the best split for the master mailing
drop-down list. This criterion determines which split is chosen for the master mailing.
Note: Which criterion you use depends on mailing type, the quality
of recipient data, and your marketing goals.
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l
l
l
l
l

l

Best unique open rate. Split most opened by recipients (percentage).
Best unique click rate. Split most clicked by recipients.
Best effective click rate. Split with the best unique opens/unique clicks rate.
Lowest unique unsubscribe rate. Split that created the fewest unsubscribes.
Highest turnover. Split that created the highest revenue. This criterion only delivers valid
results if post-click tracking was configured for your client; otherwise splits have the result
0.
Lowest bounce rate. Split that created the fewest bounces.

There are three options to start the master mailing.
l

l

l

Save mailing and start it manually later. Start the master mailing manually by clearing
the check boxes and selecting the default option when editing the mailing in the Options
tab.
Sending date for the master mailing. Set a sending date for the master mailing and
select the check box to activate this option. Use this option if you usually send your newsletter at a certain day and time.
Sending delay for the master mailing after the last split mailing has been sent. Set a
delay between the sending of the last split mailing and the master mailing. Select the
check box to activate this option.
Tip: Use this option to get reliable opens and click rates based on
the split mailings, because not all recipients open and click the mailing immediately upon receiving it.

Split mailing examples
The following examples to help you understand the split module by showing recipient calculations and their results. They illustrate the hierarchies and dependencies of the master
mailing and splits.
In all examples, it is assumed that recipients are valid (that is, no one is blocked, has canceled, or exceeded the bounce limit).
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Example 1
The master mailing and splits are sent to the same recipient list. A limit on the recipient
number is set in the master mailing. The splits comprise A/B testing (split A against split B)
with different target groups. The recipient list contains 100 recipients (40 male, 40 female,
20 unspecified).
Mailing

Recipient list

Max. number of recipients

Target group

Sent emails

Master mailing

A

28% (= 28 recipients)

—

0

Split 1

A

—

male

28

Split 2

A

—

female

0

Result: The total number of recipients, as defined in the master mailing, was reached during the dispatch of split 1. No emails are sent to Split 2 and the master mailing.

Example 2
Master mailing and splits are sent to different recipient lists. A limit for the total number of
recipients is defined in the master mailing. Recipient list A (master mailing) contains 200
recipients (60 male, 60 female, 80 unspecified). Recipient list B (splits) contains 100 recipients (40 male, 40 female, 20 unspecified).
Mailing

Recipient list

Max. number of recipients

Target group

Sent emails

Master mailing

A

28% (= 56 recipients)

-

0

Split 1

B

—

male

40

Split 2

B

—

female

16

Result: The total number of recipients is determined by recipient list A and the limit of
recipients defined in the master mailing. Split 1, only sent to male recipients with no send-
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ing limit, is sent to male recipients in list A. Split 2 is subsequently sent to 16 female recipients from the same list. At this point, the total number of recipients limit is reached.

Example 3
The master mailing and splits are sent to the same recipient list. Recipient list A contains
100 recipients (20 male, 20 female, 60 unspecified). Three splits are created.
l
l
l

Split 1 has the target group "male"
Split 2 "female"
Split 3 has the target group "male OR female" (so gender must be specified).

The master mailing does not define a target group. Split 3 is to be sent first.

Mailing

Max. number of recipients

Recipient list

Sent
emails

Target group

Master mailing

A

—

—

60

Split 1

A

10%

female

10

Split 2

A

10%

male

10

Split 3

A

10%

unspecified

0

Result: While the first two target groups are subsets of the master mailing target group,
the target group for split 3 and the master mailing exclude one another. To select recipients who did not specify gender, the target group of the master mailing should be "males
OR females OR blank field".
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Send time optimization

Send time optimization detects when recipients actually check their inbox, and sends your
message to each individual at a time that matches the rhythms of their life. As a result,
your email appears at the top of the inbox. Send time optimization ensures that your mailing is received during key, attention-grabbing minutes, and does not get lost at the bottom
of the inbox with a bunch of other messages.
Send time optimization can increase the open rate for your messages by up to 25 percent.
As a marketer, you benefit from the undivided attention of your recipients, which increases
your return on investment.
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Why should you automate optimization?
Many marketers follow three simple rules to determine the best send time for their campaigns, based on the findings of various studies.
l

l

l

Tuesday is the best day to send out mailings. Thursdays and Wednesdays are the next
best days (the response rate by recipients is the highest in most industries on these days).
Around 10 AM is better than early morning, afternoon, or evening (recipient responses are
the highest at this time for most industries).
Workdays are better than weekends.

Although the rules are based on many studies and billions of data sets, they are derived
from average values, and do not consider each recipient's preferences (and also do not
apply to every industry). Do not rely on average values or the assumption that "one size fits
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all" – rather, learn about the particular lifestyles of your customers. Adjust your send times
to accommodate the preferences of your recipients.

How it works
Send time optimization creates a personal profile for each recipient then analyzes their
response behavior. Machine learning: The longer the customer relationship, the more
accurate the optimized send time. And, if a recipient changes their behavior, their profile is
updated accordingly.
The self-learning algorithm also analyzes click behavior and message opens, because
opens by themselves do not provide sufficient evidence of whether a recipient is interacting with their inbox.
Around 70 percent of users now own a smart phone, and reach for it an average of 88 times
a day to check their inbox or open a message, if only to reduce their unread message
count to zero. When users check messages, they are much less likely to read emails in
depth or to follow interesting links. Therefore, send time optimization considers the click
behavior of recipients to determine when they are focused and responsive, not just clicking off a notification.
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Benefits
l
l
l
l

l
l

l
l
l
l

Increase the open rate for your emails by up to 25 percent.
Decrease likelihood that your message will go unnoticed.
Your advertising messages are perceived as less obtrusive.
The service adjusts to the recipient's behavior, and changes the send time when a recipient changes habits.
Send time optimization is automated.
It has a low learning curve. The feature integrates with the familiar, standard features of
Optimizely Campaign.
Virtually infinitely adjustable for up to 7 days.
A fallback time can be set for new recipients for whom behavioral data is not yet available.
Available for Smart Campaigns (including A/B tests).
Analysis function to evaluate individual send times.

Setting up time optimization
Note: Send time optimization is available only for the Email channel.
To set up send time optimization, contact customer support. The feature as an extension:
l
l
l

in the Wait node for Smart Campaigns
in the A/B Test node for Smart Campaigns
in the campaign analysis

Configuring send time optimization in the Wait node
This topic describes how to enable and configure the send time optimization in the
Wait node within Smart Campaigns.
Note: The send time optimization feature is available only for the
Email channel.
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Once configured, your message is sent to recipients with sufficient behavioral data at a
personalized send time. Recipients who lack sufficient behavioral data receive your message at the fallback time.
To configure send time optimization in the Wait node, do the following:
1.
2.
3.
4.

Under Send Date, specify a fallback.
Enable send time optimization.
Select the maximum length of time for the send time optimization.
Adjust the start and end times of the send time optimization and, if necessary, shorten
the preset maximum length.
5. Check your settings in the info area.

Specifying a fallback time
If there is insufficient data about individual recipients to determine a personalized send
time, your message is sent to these recipients at the set fallback time. To specify a fallback
time, perform the following steps:
1. In the Create Campaign window or the Edit Campaign window within Smart Campaigns, drag a Wait node from the left action pane into the workspace between the
Recipients node and the message node. A context menu opens.
2. Under Send Date, select an option and specify the fallback time.
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Option

The fallback time is set to

Configuration

Wait until ...

A fixed time.

Specify a date and
a time.

Wait until import has been
finished

Immediately after the recipient
import is completed.

No configuration
needed

Start at ... after import has
been finished

A fixed time after the recipient
import is completed.

Specify a time.

Note: The Wait until import has been finished and Start at ...
after import has been finished options are only available if the
closed-loop interface is configured in your client. If the closedloop interface is not configured, only the Wait until ... option is
available.

Warning: If the Wait until import has been finished or Start at
... after import has been finished option is selected, you cannot
enable the campaign.

Enabling send time optimization
In the context menu of the Wait node, select the check box next to Send time optimization.
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Specifying the maximum length of time
Set the maximum length of time that Optimizely Campaign can use to optimize the mailing
dispatch.
You can select 24 hours or 7 days.
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Adjusting start and end times
You can adjust the start and end times of the send time optimization in 15-minute increments by using the date slider. If you make no changes, the start and end times are set so
that the fallback date is the midpoint of the selected maximum length of time.
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To adjust the start and end times and reduce the maximum length of time, click and grab
the corresponding date tab with the computer mouse.
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Checking settings in the info area
Your current send time optimization settings appear in the info area. After completing the
configuration, verify your settings in the info area, and change them if necessary.
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Configuring send time optimization in the A/B test node
This topic describes how to enable and configure the send time optimization in the A/B
Test node within Smart Campaigns.
Note: The send time optimization feature is available only for the
Email channel.
Send time optimization in the A/B Test node is used only to determine the personalized
send time of the optimized message (the main mailing). To optimize the time of sending of
individual split mailings, use a separate Wait node for each split mailing and configure the
send time optimization in the Wait node.
To configure send time optimization in the A/B test node, do the following:
1. Under the Send Date specify a Fallback time.
2. Enable the send time optimization.
3. Select the maximum length of time for the send time optimization.
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4. Adjust the start and end times of the send time optimization and, if necessary, shorten
the preselected maximum length.
5. Check your settings in the info area.

Specifying a fallback time
If there is insufficient data about individual recipients to determine a personalized send
time, your optimized message is sent to these recipients at the fallback time. To specify a
fallback time:
1. In the Create Campaign window or the Edit Campaign window within Smart Campaigns, drag an A/B Test node from the left action pane to the workspace, between
the Recipients node and the Wait node/ message node. A context menu opens.
2. To enable automatic optimization, select the check box next to Activate automatic
optimization.

3. In the Type of Optimization drop-down list, select one of the following types:
l
l
l

Best effective click rate
Best unique click rate
Best unique open rate
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Lowest unique unsubscribe rate
l
Lowest bounce rate
4. Under Sending Date of the Optimized Message, select an option and specify the fallback time.
l

Option

The fallback time is set to

Configuration

Date and Time

A fixed time.

Specify a date and a time.

Delay After Last Split

Immediately after the delay.

Specify the delay time.

Manual

The manual start time.

No configuration step needed.

Enabling send time optimization
In the context menu of the A/B Test node, select the check box next to Send time optimization.
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Setting maximum length of time
Set the maximum length of time that Optimizely Campaign can use to optimize the sending
of optimized messages/main mailings.
Tip: This option is only available for the fallback Date and Time.
You can select 24 hours or 7 days.
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Adjusting start and end times
You can adjust the start and end times of the send time optimization in 15-minute increments by using the date slider. If you make no changes, the start and end times are set so
that the fallback date is the midpoint of the selected maximum length of time.
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To adjust the start and end times and reduce the maximum length of time, click and grab
the corresponding date tab with the computer mouse.
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Tip: You can adjust the 24 hours and 7 days defaults downwards
and shorten the maximum length of time from 7 days to 3 days. For
example, for editorial purposes or short-term promotions.
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Checking settings in the info area
Your current send time optimization settings appear in the info area. After completing the
configuration, verify your settings in the info area, and change them if necessary.

A/B test node examples
You can configure send time optimization in one of three ways for an A/B test:
l

l

l

Only optimized message/main mailing. To only configure the send time optimization for
the optimized message or the main mailing, configure the send time optimization in the
A/B Test node only.
Only split mailings. If you want to send split mailings using a send time optimization, use
a separate Wait node for each split mailing, and configure the send time optimization in
each Wait node.
Split mailings and optimized message or main mailing. If you want to configure a send
time optimization for both split mailings and the optimized message or main mailing, configure the send time optimization in the A/B Test node and in the Wait node of the split
mailing.
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Tip: See also Smart Campaigns nodes and A/B test.

Analyzing mailing send times
If send time optimization is set up in your client, you will have access to the Send time
optimization Overview, an additional analysis feature of Smart Campaigns.
The overview analyzes the distribution of mailing send times and peak send times. The
overview also displays the number of recipients to whom your message is sent at the fallback time because there was insufficient data to determine a personalized send time.
To generate and view the send time optimization overview, do the following:
1. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
2. Select a campaign and click Analysis.

3. In the Campaign analysis window, click New Analysis. A new campaign analysis containing the Send Time Optimization Overview is created.
Note: It may take a few minutes to generate the analysis.

Send time optimization overview
In the Campaign analysis window, you can see context menus with data about recipients
and the campaign nodes.
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To view the send time optimization overview, click the corresponding Wait node or A/B
Test node.
The Send Time Optimization Overview display the distribution of mailings, peak send
times, and number of recipients to whom your message was sent at the fallback time.

In the Send Time Optimization Overview, you have the following options:
l

l
l

Zoom. To zoom in on the graphic, click and drag the computer mouse over the desired
time window.
Reset zoom. To return to the default view, click Reset Zoom.
Close. To close the Send Time Optimization Overview, click Close
corner.

© Optimizely 2022

in the upper right

Campaigns | 325

Validating mailing prior to dispatch
Note: To enable this feature, contact customer support.
This add-on validates whether predefined parameters of a mailing are met. The validation
is carried out prior to dispatch or when the mailing is saved. You can configure this automatic test for virtually any parameter of a mailing. You can validate against a defined value
or check if a parameter is set.
For example, you can validate the mailing against the following conditions:
l
l
l

Mailing must contain an attachment
Maximum number of emails per hour is set for dispatch and lies within a defined range
Target group is selected

Sending automatic notification after dispatch
Note: To enable this feature, contact customer support.
This add-on sends a notification to an email address after a mailing is sent. The notification
contains sending date and time, number of recipients, and additional mailing details.

Sending S/MIME-signed emails
Note: To enable this feature, contact customer support.
Send S/MIME signed emails via Optimizely Campaign and increase your recipients’ confidence. Thanks to your digital signature, your recipients can rest assured that the mes-
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sages were sent by you, and the content was not subsequently manipulated. The digital
signature includes components of an email, for example, attachments.
Note: Digital signatures only ensure data integrity and do not apply
to confidentiality. Emails protected with a digital signature are still
sent as plain text. Message encryption of the S/MIME standard is not
supported.

Prerequisites
To send S/MIME-signed emails via Optimizely Campaign, you need a S/MIME certificate
issued by a certification body, which certifies the authenticity of the respective email
address, for each email address used to send messages.
Tip: To get an S/MIME certificate for your email, contact the certification body.

Importing S/MIME certificates
To import one or several S/MIME certificates, perform the following steps.
Note: The certificate file must be in PKCS12 format. If it is not available that format, convert the file to that required format.
1. Open the Optimizely Campaign menu and select Administration > S/MIME Certificates. The S/MIME Certificates window opens.
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2. Click Import PKCS12 Keystore…. The Import PKCS12 Keystore dialog box appears.

3. Click Browse... and select the certificate file to upload.
4. In the Password box, enter the backup password for your certificate file.
5. Click Import.
You can find the certificate file in the list in the overview. See the list for information
about the associated email address, the certificate's validity date, the creation and
modification dates, and when the certificate is uploaded or changed.
Tip: If you stored a S/MIME signature for your sender address,
the notification signed with S/MIME is displayed in the Edit
Content window above your sender address any time you edit a
message.

Deleting S/MIME certificates
1. In the S/MIME Certificates window, select the S/MIME certificate you want to delete.
2. Click Delete. A confirmation window opens.
3. Click Delete Certificate.
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Mailings Classic
Note: Mailings Classic will be deactivated on 2022-03-01.
To migrate Mailings Classic mailings to Smart Campaigns and edit
them there, follow these steps.
1. In Smart Campaigns, select a Mailings Classic mailing from the list and
click Copy. The selected mailing is duplicated and displayed as a campaign
in the Smart Campaigns editing window.
2. Edit the campaign if necessary.
3. Click Save and Close. The Save campaign dialog box opens.
4. Enter a new name if required.
5. Click Save.

Note: Mailings Classic is only available in the classic Optimizely Campaign user interface. See Start page.
Open the start menu and select Campaigns > Mailings Classic. The window shows mailings that were created with this client/account.
l

l
l

Status. Indicates whether the mailing was sent, is being sent, or is still being worked on
(status = new).
Start date. Only filled in if a date is set for a mailing.
Type. If your account is authorized to display the type, the corresponding column displays
the specific type of each mailing. Types may be selected from the following:
o
o

o
o

Regular: Standard mailings.
Special/API. Mailings that are unique and activated using an interface (API) or an
event. For example, a prepared mailing that every recipient receives once each year,
such as on his or her birthday.
Registration confirmation. Prepared greeting mails are sent to new recipients.
Templates. Pre-configured mailings that contain sender information or content to simplify new mailing creation. Mailings of this type cannot be started.
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Mailing action buttons
The buttons below the mailing list start one of these actions.
l

l

l
l
l
l

Create. Create a new mailing and configure the mailing within a few steps. If your client is
configured for different marketing channels, you can create emails and short messages.
Copy. Copy an existing mailing. The entry fields (subject, content, recipient list and so on)
are filled with the same values as the source mailing.
Edit. Change the values in a mailing, only if sending is not started.
Delete. Delete a mailing that was not sent.
Start. Start a mailing.
Abort sending. Cancel the sending of a mailing.
Note: You cannot restart an aborted mailing.

l
l

Split: See A/B test.
Preview. Display a personalized preview of a mailing with the following steps:
1.
2.
3.
4.

In the Mailing drop-down list, select a mailing.
Click Preview.
In the Recipient list drop-down list, select a recipient list then a recipient.
Click Show.

Information area
The area in the below half of the screen offers information about your mailings. Select a
mailing from the list above.
l

l

Details. Displays data about the selected mailing, such as ID, name, creation date, sending
date, recipient lists and target groups.
Report: Displays the most important report data for the mailing. Until the mailing is started, fields are empty or zero.
Note: Some fields show two values. The italic value indicates a
unique value, such as a unique user action. If a recipient clicks
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one link several times, this counts as one unique click because the
same recipient clicked the same link.
If percentages for Gross-... are indicated, the value is related to
the total number of recipients for a mailing. If the Gross-... prefix
is not used, the value relates to the number of Recipients w/o
bounces. The latter is the more practical count, because it refers
to recipients who received the mailing and could react, either in
the form of opens or clicks.
The following values are displayed in the summary:
Tip: The following list is only a summary of the most important core
indicators.
l

l

l

l

l

l
l
l
l

l
l

l

Recipients. Number of recipients to whom Optimizely Campaign attempted to send a mailing.
Recipients w/o bounces. Number of recipients whose email addresses did not produce a
bounce (message of non-deliverability).
Recipients skipped. Number of recipients to whom the mailing could not be sent
because their addresses were false.
Recipients in queue. Only applies to mailings currently being sent. Number of recipients
who were not sent a mailing.
Unique bounces. Number of unique non-deliverability messages received by Optimizely
Campaign after a mailing.
Unique bounce rate. Percentage of unique bounces.
... of which are hard bounces. Percentage of hard bounces.
... of which are soft bounces. Percentage of soft bounces.
Unique opens. If a recipient opens a mailing several times, this option only counts them
as one unique open.
Opens. Number of opens.
Unique open rate. Percentage of unique opens in relation to the number of recipients
w/o bounces.
Open rate. Percentage of opens in relation to the number of recipients w/o bounces.
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l

l
l

l
l

l
l

l
l
l
l

l

l

Unique gross open rate. Percentage of unique opens in relation to the number of recipients.
Gross open rate. Percentage of opens by recipients.
Unique clicks. Number of unique recipients that clicked an arbitrary link in a mailing. It
does not matter how often and which link was clicked.
Clicks. Number of clicks.
Unique click rate. Percentage of unique clicks in relation to the number of recipients w/o
bounces.
Click rate. Percentage of clicks in relation to the number of recipients w/o bounces.
Unique gross click rate. Percentage of unique clicks in relation to the total number of
recipients.
Gross click rate. Percentage of clicks of recipients.
Effective unique click rate. Percentage of unique clicks in relation to the unique opens.
Unique unsubscribes. Number of clicks on the unsubscribe link.
Unique unsubscribe rate. Percentage of clicks on the unsubscribe link in relation to the
number of recipients w/o bounces.
Unique gross unsubscribe rate. Percentage of clicks on the unsubscribe link in relation
to the total number of recipients.
Content preview. Displays the mailing and its subject line.

Step 1. Name and description
Note: This data is used internally by Optimizely Campaign. It is not
part of emails sent to mail recipients.
Enter a name to identify your mailings, such as "Customer Newsletter from May 23, 2018"
or "Product Information for Ball Bearing 234/3 Rollout".
The Description field is optional. Content here shows up in the Overview menu item.
Select a mail format:
l
l

Text only. Use for most personal emails. You cannot include images, colors, or bold text.
HTML only. Use to mail in HTML. Be aware that recipients may receive unreadable emails
if they have older email software that cannot display HTML.
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l

Multipart. Contains content in text and HTML formats. The HTML version is shown to
most recipients. If the recipient's email software cannot display HTML, the text version is
displayed.
Tip: Some people prefer HTML mail because of additional features
and information (images, color highlighting and so on), while others
prefer text email to read without graphical distractions. Consider letting recipients choose between text and HTML format when subscribing to your newsletter, and save this information in your
database.

Step 2. Recipients and sender
Recipients
You can select one or more recipient lists for mailing by enabling the associated check
boxes. Optimizely Campaign ensures that recipients on several lists only receive the mailing once.
You can select a target group to address a subset of a recipient list. Use target groups to
guarantee that each test mailing is addressed to different recipients, and no recipient will
receive two mailings. To do this:
1. Send the first test mailing.
2. Create a target group with the definition Recipient did not receive [name of the
first test mailing].
3. When sending the second mailing, select this target group.
4. When sending the mailing to the remainder of the list, continue in this manner.
In this case, the target group should be defined as Recipient did not receive [name of
the first test mailing] AND Recipient did not receive [name of the second test mailing].
To display the number of recipients, click Calculate the number of possible recipients.
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Determining the order of recipients in a mailing
By default, recipients are addressed in the order in which they were entered into the list.
To use a random selection of available recipients, select the Random selection check box.

Testing different versions of a mailing
1.
2.
3.
4.
5.
6.

In the Maximum number of recipients box, specify a number of recipients.
Copy the mailing.
Modify one or more parameters (subject, content, and so on).
Send that version to a different part of your list.
Compare results (clicks, openings, and so on).
Copy the mailing with the best performance to be sent to the remaining recipients.

Sender
You can specify which sender address should appear in the recipient's email software
when your message is received.
l

l

Email address. Enter the address section of the sender in this field. The domain section
(behind the @) is fixed and cannot be changed.
Name. This is typically your company name.

For example, "Example Inc. [info@example.com]": "Example Inc." is the name and
"info@example.com" is the email address.
Tip: Be consistent in your sender address. Changing your email
address or name may cause the recipient's email program to treat
your mailings differently, and negatively impact your mailing's success.
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Step 3. Subject and content
Editing content
Content management system (CMS), the Optimizely template kit or HTML code: read
about editing tools for your mailings in Editing message content.

Subject
Your mailing's subject line appears next to the sender address in the recipient's email program. The sender and subject most strongly influence a mailing's open rate. You should
limit the subject's length, such as 45-60 characters, because some email programs might
cut off longer lines.
Tip: The additional feature Prefix or suffix subject line lets you automatically add a prefix or suffix to the subject line of any mailing. See
Prefix or suffix subject line.

Unicode characters
You can use Unicode characters in the subject line to increase the recipients' attention.
Instead of using a plain text subject line, like NEW! Bikini "Malibu" now in the shop, you can
enhance it with Unicode characters: NEW! Bikini "Malibu" now in the shop
.
At www.unicode.org you can find a list of Unicode characters that are supported by most
web browsers and email clients. Copy the desired symbol from the list and paste it into the
subject line. Also set the character set to UTF-8 to display Unicode characters correctly.
See Character set.
Note: Unicode characters are displayed differently by different operating systems (iOS, Android, and so on) and email clients (Gmail,
Outlook, and so on) Therefore, always send a test message to check
the appearance before sending.
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Content templates
The content of your mailing is created using content templates in Optimizely Campaign.
Use the Free Text template if you create your mailings externally (outside of Optimizely
Campaign), for example, through your agency or yourself using an HTML editor. This template lets you copy prepared text and HTML content directly.
However, if your mailings will have the same appearance (as is usually the case for newsletters), you can save time using specially-prepared content templates. The templates are
designed to your specifications by Optimizely. Or, you can use the Template Kit.
Using content templates, you can create the content of your mailing using predefined modules. When creating a new mailing, just enter the text and upload images. Optimizely Campaign creates a completely formatted mailing. No knowledge of HTML is needed.
To use a template for your mailing, select it and click Edit.
Tip: About templates
See Designing a newsletter about email design using templates. Get
tips and instructions for design and examples and suggestions from
template developers.

Content attachments
To send attachments with a mailing, click the Attachments tab. If you have already sent
mailings with attachments, the attachment files appear in the overview. To send one of
these files as an attachment to the current mailing, select the check box next to the file
description.
To send a new file as an attachment, follow these steps.
1. Click New. The assistant for uploading attachment opens.
2. Select whether to upload a file from your computer, or a URL that links to a file. If you
choose Upload from hard drive, a copy of the file is created in the Optimizely Campaign server. If you choose Use URL, make sure that the file is available when the mailing is sent.
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3. Click Next.
4. Click Browse... and select the file to be uploaded. If you link a file using a URL, enter
the full URL.
5. Click Next.
6. Complete the File name and Description boxes. Optimizely Campaign uses the name
and description for internal management of the attachments, but not for the sending.
7. Click Save to make the file available as an attachment. After you upload or link the file,
it appears in the list and can be sent as attachment for current and future mailings.
Note: Special characters in file names of attachments
Do not use an umlaut and ß in the file name. Some email clients
remove special characters from the file name. Nevertheless, the recipients can still open and save the attachments. Only the name is
changed.

Warning: Do not delete files from the list of attachments even if they
only were attached to a single mailing. If you delete the file from the
file server, it will no longer be available to recipients when they open
the email.

Note: Send attachments in offline HTML mode
Attachments sent in this mode are loaded immediately upon receipt
of the email. So, do not send large files in this mode, as this may delay
the receipt of the email.
Due to a bug in the Apple email client, attachments sent in HTML offline mode do not appear in Apple Mail and on iPhones. If you send
attachments in standard mode, there is no such problem.

Personalized Attachments
Use Personalized Attachments to send attachments to particular recipients. Before sending the email, you must transmit such attachments to Optimizely Campaign using HTTP
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API. The uploaded attachments can be used when sending transaction emails. For
example, you can send invoices and order confirmations to your recipients. See the HTTP
API manual.

Character set
Use the drop-down list Character set ("Encoding") to select the character set to be used
for encoding your mailing.
l

l

l

ISO-8859-1. For recipients in German-speaking, Western European and North American
countries.
ISO-8859-2. For recipients in Central-South-Eastern Europe, for example in Poland, Croatia or Slovakia.
UTF-8. Supports most special characters of all languages. Select this encoding if you are
writing to recipients in other regions of the world, such as Eastern Europe or Turkey.

Step 4. Tracking
Track opens and clicks of your mailings and use the data to analyze and optimize your campaigns.

Opens
If you check the Track opens box, Optimizely Campaign monitors how many recipients
opened your mailing. This number is available in a report generated later.
When sending a mailing, Optimizely Campaign inserts at the bottom of each email a reference as a 1x1 pixel, transparent graphic. This reference contains a unique ID for each
recipient. When the recipient opens the email, the program loads the graphic from the
Optimizely server. Optimizely Campaign then receives the recipient ID, so it can track that
the user opened the email.
This measurement is only possible if the user opens an HTML mail (text mail does not support graphics) and is online at that time. So, you should perceive the rate of opens as relative, not absolute. If, for example, the open rate doubles from one mailing to the next, you
probably selected an enticing subject line.

© Optimizely 2022

338 | Optimizely Campaign User Guide 2022-03-14

Tip: The Anonymize tracking feature lets you deactivate personalized tracking of opens for a recipient. If you do, the recipient is
no longer included in action-based target groups. See Recipients
overview. You can also use the Optimizely Campaign HTTP API to set
up the tracking opt-out option in your mailings. See HTTP API on
Optimizely World.

Clicks
If you check the Enable link tracking box, clicks on links in the mailing are recorded. This
number can be retrieved in a subsequent report.
Optimizely Campaign displays a list that includes links you used. In the Occurrence
column, you can see how many times each link is used in the text or HTML section. The
Description column better identifies the link in subsequent reports.
Because URLs can be long and cryptic, you can enter a clear label for each link here. To do
that:
1. Mark the line you want to modify.
2. Click Edit link.
3. In the description field, enter the name for the linked page (such as Homepage, Order
form and so on).
4. Click Apply.
The HTML on or Text on column lets you determine whether to record clicks for each link
and content type (Text/HTML). Normally, it is useful to track each link in HTML email. But in
plain text email, you may want to keep URLs clean and readable instead of transforming
them into cryptic tracking links. For example, in "For information, click www.example.com,"
the link is more likely to be clicked than a tracking link consisting of symbols and numbers.
Tip: The Anonymize tracking feature lets you deactivate personalized click tracking for a recipient. If you do, the recipient is no
longer included in action-based target groups. See Recipients overview. You can also use the Optimizely Campaign HTTP API to set up
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the tracking opt-out option in your mailings. See HTTP API on Optimizely World.

Click profiles
In the Click profiles column, you can assign a link to a click profile. To do so:
1.
2.
3.
4.

Select a link.
Click Edit link.
Click the Profile field.
In the Assign click profile window, select one or more profiles and click OK.

Rule-based click profiles are displayed without having them assigned to the respective
link, because they are assigned automatically. You may add more profiles, though, to rulebased profiles.
Rule-based profiles cannot be removed from a link to which they are assigned. But, you
can assign a link that does not match the rule to the profile based on the rule.

Step 5. Test email
Before sending any mailings, send a test mail. This topic explains the test lists configured
for your account. Normally, there is one list of people who can receive a test mail (you, your
co-workers, superiors and so on).
When you select a test list, its recipients are displayed below. To add a recipient, click Add
recipient.
To send a test email, select recipients by checking the box and clicking either
l
l
l

Send email. Sends a multi-part message
Send HTML version. Sends a HTML message
Send text version. Sends a text message

If the format is Text or HTML, you cannot send a multi-part test email. If your default
format is Multipart, you should test all three options because your email client does not
let you decide whether you want to receive a multi-part email as plain text or HTML.

© Optimizely 2022

340 | Optimizely Campaign User Guide 2022-03-14

Click Test email to target group to open a wizard that helps you send target groupbased versions of your mailing, even if they do not match the target group criteria.
Tip: If you use a personalized subject line, make sure that your test
list contains the same fields used for personalization (for example,
name). Otherwise, the test emails have the default subject line,
because no personalization field is available to create a personalized
subject line.
If you want to change the mailing after receiving test email, go back to step 3, change the
content, then send a new test mail.

Step 6. Sending options
In the Options tab, select the mailing's sending time and speed. Furthermore, you can
select a folder in which to save your mailing.
Whether you send your mailing now or later, it is saved in this step. If you select the option
Save mailing and start it at the following date and time or Save mailing and start it
manually later, you can edit your mailing until it is sent. But mailings that start immediately cannot be changed.

Saving mailing and starting it manually later
Use this option if you, for example, are waiting for a release for your mailing, or if you know
that changes need to be made, or if the sending time is not determined. Any time after saving the mailing, you can use the Overview menu item to call up and change it.

Saving mailing and starting it at a later date and time
If your mailing is to be sent at a predetermined time, set the desired start date and time in
this Mailings window field. To do so, click the arrow next to the current date. A calendar
opens, from which you can select the mailing date and time. You can also change the mailing after it is saved (and before the specified starting time).
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Saving mailing and delaying start after all split mailings are sent
This option lets you set a delay between the sending of last split mailing and the main mailing. It is helpful, for instance, to get reliable opens or click rates, because not all recipients
open and click a mailing upon receiving it. The delay should be from a couple of hours to a
couple of days.

Starting mailing immediately
Use this option if you tested your mailing and want to send it immediately. Be aware that
the mailing starts immediately after clicking Save. Afterward, you cannot make corrections.

Saving mailing in a folder
To choose a folder in which you want to save your mailing, click the Folder field and select
a folder. Alternatively, click the plus icon + in the status bar to create a new folder.

Setting the sending rate
Optimizely Campaign sends up to 50 million emails per hour. In some cases, this is too fast.
For example, you have a large mailing list, and the mailing encourages recipients to call a
telephone number. Your call center could get overloaded. In such a case, set a maximum
number of mails to send per hour. The minimum is 1,000 per hour.
If you leave the field blank, your mailing is sent at maximum speed.

Offline HTML
This option attaches images and style sheets directly to the email. This option may provide
a better representation of your mailing in a recipient's email client, but may also result in a
worse deliverability of your email.
Also, offline HTML may increase the price because the overall size of every email grows. In
addition, open tracking is disabled (clicks are counted as opens anyway).
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Managing content
The Optimizely Campaign’s content management system lets you create, edit and manage
mailing content, and design interactive and personalized content.
l

Edit mailing content. Use the integrated content editor.

l

Template Kit. Create and edit mailings with the mailing kit.

l

Field functions. Script and use field functions.

l

Coupon system. Create coupon blocks and embed coupons in mailings.

l

Countdown timers. Create countdown timers and embed them in mailings.

l

Click2Go. Create call-to-action buttons and embed them in mailings.

l

Easy Copy. Copy mailing content.

l

Mobile Fusion. Optimize mailings for mobile display.

l

Attachments. Upload and edit attachments.

l

Prefix or suffix subject line. Enable text to be automatically added to subject lines.

l

Uploading files. Upload files manually.

l

Publish mailing. Copy mailings to other clients.

l

Video emails. Embed videos in mailings.

l

Designing a newsletter. Layout tips for newsletter design.

Editing mailing content
This topic describes how to use the Easy Edit CMS with integrated rich text editor to edit
mailings in the Template Kit. The mailing is displayed as it will look when sent.
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Editable content elements have a menu bar with buttons for editing, moving, copying and
deleting. Depending on your template configuration, you might be able to, for example,
edit some elements, but not move or delete them. In this case, the menu bar shows only
the Edit button

.

Tip: Click Tour next to the action buttons at the upper right edge of
the editor window for an interactive tour of the Template Kit.

Tip: On the left side above is the sender, subject, attachments
area. You must enter a sender, a sender email address and a reply-to
email address to send the mailing. For more information, see Smart
Campaigns Step 2. Configuring the Message.

Paragraphs
On the left side, you can find a preview of your message template with its paragraphs (content elements). Paragraphs can contain various content types (text, images, banners, lists,
and so on). In a template, content is included as a paragraph. You can add,import, edit,
move, copy, and delete paragraphs.
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Add
The New: ... button appears wherever you can insert a new paragraph. Click it to insert
one. Depending on the complexity of your template, you must select a sub-type of the
inserted paragraph in the next step. Click Save to add the new element to your mailing.

Import
See Easy Copy.
1. Click New: ....
2. Click Import paragraph and select the source.
3. In the Source client drop-down list, select a client. If you only use one client, it is
already selected.
4. In the Source content drop-down list, select a message or message template and
click Next. Importable paragraphs from the source are shown.
5. Check the boxes of paragraphs you want to import.
6. Click Import paragraphs.

Edit
To edit a paragraph click Edit

. The edit area opens in a new layer on the right side.

You can edit texts by using the rich text editor.
Paragraph types contain several tabs and input fields for entering content, setting the layout, and assigning target groups or click profiles. See Template Kit.

Inline editing
Instead of using the rich text editor, you can edit texts directly by clicking the text below a
paragraph. The editor toolbar with buttons for text formatting appears.
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Tip: The rich text editor has an additional Source button that lets you
edit the text's HTML code.

Move
Tip: Some paragraphs cannot be moved everywhere, or can only be
moved within a certain section. You can only add new paragraphs at
the end of a content section (header, footer, paragraph group and so
on).

To move a paragraph, click Move
and move the cursor where you want to insert it.
When the message Click here to move the selected paragraph above this paragraph
appears, click again.

Copy
To copy a paragraph, click Copy
then move the cursor to the position where you want
to insert it. When the message Click here to copy the selected paragraph above this
paragraph appears, click again to drop and insert the copied paragraph.
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Delete
To delete a paragraph, click Delete

.

Tip: Some paragraphs cannot be deleted.

Working with the rich text editor
For any text input (except headlines, subtitles or links), templates provide a rich text editor.
The rich text editor opens in the right side configurations window when clicking the name
of a paragraph or when creating a new content paragraph with optional text.
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The editor toolbar has buttons for simple text formatting similar to those in text processing
software.
Change the content and click Apply; a preview appears on the left side. You can change
the view mode to HTML, mobile, text and online preview of the mailing.

Editing source code
To edit the HTML code of the text, click Source. To return to the text view, click Source
again.
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Inserting field functions
In the editor toolbar, click Insert field function to insert a field function. Field functions
can insert the content of a recipient list field, a personalization algorithm, or other personalized content.
Tip: Personalized links
You also can use field functions to create personalized links in your
mailings. You can use field function placeholders in the domain part
or path of a URL and in URL parameters. The link tracking of personalized links works as in regular links.

Changing background color
When working in the rich text editor with a white font or very light font, change the editor
background color to make editing easier. Click Change background color
in the toolbar of the relevant text field. Click the button again to change the background back to
white.

Inserting images
You can insert images directly into the text field by clicking Image

.

Some paragraph types also let you insert an image, either in the General tab or in Image
tab. If an image can be inserted, you find a Browse... button and an Alternative URL field.
Images can either be uploaded from your computer or referenced via a URL. If you choose
the latter option, make sure the image is available at the indicated server when the mailing
is being sent. Otherwise, the sending cannot be done.
l
l

Image files can be formatted as .jpg, .jpeg, .png or .gif.
Images used in a mailing are automatically scaled to the size defined in the template. For
the best image quality, however, you should resize images to fit before uploading them.

To delete an image, click Delete then Save.
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Creating anchor links
You can use anchors to refer to places within the mailing. To create anchor links, do the following:
1. Place the cursor in the text in the rich-text editor where you want to place the anchor.
2. Click Anchor
on the editor toolbar and enter a name for the anchor.
3. Select the text in the rich-text editor where you want the link to the anchor.
4. Click Link
on the editor toolbar.
5. In the Link dialog box, in the Link Type drop-down list, select Link to anchor in the
text.
6. Under Select an Anchor, select the anchor.

Changing view
You can change the view mode of the mailing preview to HTML, Mobile, Text and Online
Version. To change the view mode, click one of the tabs at the top left.
l

l

In HTML preview mode, menu bars and buttons are hidden, and you see the mailing as it
will appear to recipients.
The Mobile tab displays a preview of your newsletter on several mobile devices and with
various display modes. See also: Previewing on a mobile device.

© Optimizely 2022

Managing content | 351

l
l

The Text tab shows the text-only version of the mailing.
The Online Version tab shows the mailing as recipients will see it when they click the
online version link on top.

Previewing on a mobile device
The Mobile tab lets you preview your mailing on mobile devices. If you use a template with
integrated mobile version/Mobile Fusion, the optimized layout for each device is automatically shown. If you do not use a Mobile Fusion template, the HTML version appears
and scales to fit the display of the selected mobile device.
Note: The preview of a mailing serves only to test content and layout
of the mobile version. The actual appearance on the devices may differ due to software versions and settings. To implement a preview for
a mobile device not listed here, contact customer support.
To test different devices and display modes, perform the following steps:
1. In the list above the preview, click a mobile device. The mailing preview for this device
is displayed.
2. Hover over the mailing preview; the arrow changes to a hand icon.
3. Click and move the mailing to scroll down and up in the preview.
4. Click Rotate device
to switch between portrait and landscape mode.
5. Move the slider on the right to change the scale of the preview.

Action buttons

l

Target Groups. Does not become active until at least one content element uses a target
group. Click Target Groups, select one or more target groups, and click Submit
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l

Selection. In the mailing preview, only the content elements that are assigned to the
selected target groups are displayed.
Test Message…. Send a test message to check the appearance of the mailing before the
actual dispatch. For a test email, do the following:
1. In the top toolbar in the editor, click Test Message….
2. In the Recipient List drop-down list, select a test list.
Note: Only use test lists and no real customer data. See also
Recipient lists.
3. If you want to simulate a target group, select a target group in the Simulate Target Group drop-down list.
Tip: The test recipients selected in the next step can also
belong to other target groups.
4. In the Recipients list, select one or more recipients.
To create a new test recipient, click Create Recipient… and enter the necessary
recipient data. Then click Submit.
5. Click Send Email to send the test messages in multi-part format, or click Send
HTML Version or Send Text Version if you want to test only one format.
Tip: If you want to send a test message of type SMS or Mobile
Push, see Nodes and elements.

l

Landing Pages…. Create a new landing page or manage existing ones. If you create a new
landing page, the layout of the selected mailing template is used. You can edit landing
pages like a mailing in the editor and use your own layouts.
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To link to a landing page in the mailing, enter the placeholder {Landing page:n°} in
the URL box. In this placeholder, substitute the n° element with the landing page number (for example, {Landing page:1}). You can find the landing page number under
Landing Pages in the list of available landing pages.
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l

More. Contains further options:
o
o
o
o

o

o

Content report. Get a content report for link validation.
Print. Print the mailing preview.
HTML (PNG). Save the HTML preview of the mailing as an image in PNG format.
Encoding/Offline HTML. Specify the character set with which you want to encode
your mailing and attach images and style sheets directly to the email. See Encoding/Offline HTML.
Edit tracking links. Opens and clicks are tracked as standard in both the HTML and
text versions of a message. You can apply these settings globally or configure the
tracking function for each link in a message. See Tracking.
Retrieve RSS feeds. Retrieve the data of all RSS feeds within this mailing.
Note: Already existing RSS feeds will be deleted and manual
changes are undone.
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o

o

Import mailing content. If you use the free-text template as content type, you can
upload a ZIP file with the entire mailing content including HTML and text file as well as
graphics. See Import mailing content.
Edit directly. See Edit directly (HTML).
Note: The rich text editor cannot be used after the Edit directly option is enabled.

Tip: Closing the editor window automatically saves changes.

Edit directly (HTML)
Warning: If you activate the Edit directly mode, the original template cannot be edited afterwards. If you switch back from the Edit
directly mode to the template editor, changes made in this mode are
lost.
Instead of editing a template, you can edit the mailing's HTML source code. In the editor
window's top toolbar, click the action button More > Edit directly.
Edit the HTML source code or the text version of your mailing. Select the tab to edit the
desired version. Before you save changes, select the Activated check box.
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When editing HTML code, you have the following options:
l
l

Format Content. The code is reformatted, inserting line breaks and indenting the tags.
Compress Content. Remove the line breaks and indented tags before saving. This
removal ensures that velocity elements in the HTML code (for example, field functions)
work correctly.
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Template Kit
Tip: Mailings created with the Template Kit are displayed correctly
by the most common email clients and web browsers. Optimizely regularly checks compatibility, but individual email clients may cause display errors.
The generic Template Kit provides a flexible way to create newsletters. You can use it outof-the box and with your corporate design style guide. Optionally, you can add Mobile
Fusion to the Template Kit to optimize mailings for mobile devices.
l

Transferring design specifications into the Template Kit
If your company works with design specifications, use the Template Kit to turn these
directly into mailings with no special knowledge of graphic design or composition.
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Studies show that most design specifications can be mapped using the Template Kit.
The layout of structural and content elements follows a logical pattern found in most
newsletters. Optimizely uses standard terminology for the individual elements, so you
can work with the Template Kit whether you are a graphic designer, editor, or project
manager.
l

Content inherits basic settings
When basic preferences (such as text, background colors, spacing, and so on) are set,
they are applied to content matter. This provides a consistent layout without needing
to set additional preferences for content elements. The principle of hierarchical acquisition guarantees a layout-compliant/CI-compliant newsletter without the need to
define each parameter. But If you need a different layout, whether at a structural or a
content level, you can design each element.

l

Separation of structure and content
When developing the Template Kit, Optimizely implemented the systematic separation
of structural and content elements. This feature provides the highest level of flexibility
when designing newsletters.

l

Configuration paragraphs for organizing your newsletter
Configuration paragraphs greatly expand your design options. Each configuration paragraph functions like a section of the newsletter, which you supply with its own layout
and content. Header and footer segments are also set up as configuration paragraphs.

l

Flexible tables of contents
The table of contents is the recipient's point-of-entry to your newsletter's content, and
greatly impacts conversion rate. The Template Kit provides full control over the table
of contents. Each configuration paragraph can have its own table of contents.
o

Single or two-column grids
Optimizely provides multiple column layouts. You can set column width, position
and spacing. You can set the configuration paragraphs individually, whether they
are part of a single or two column layout.
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If your mailing needs both layouts, be sure to use them efficiently and rationally.
For example:
A two column editorial with a table of contents in a sidebar: Make the most important content visible immediately without having to scroll, and place it in a prominent position next to the editorial, where references can be made to them.
n A single column product area: A sidebar is not needed in the product area. Use a
single column layout to take maximum advantage of the newsletter's full width.
Fully equipped and seamlessly integrated
n

l

You can assign each element to a target group. You can also design pre-headers and
newsletter headers and footers for specific target groups.
o

Click profiles
The assignment of click profiles is integrated into the elements, so you can obtain
valid data about recipient click behavior.

o

Sharing content via social networks
You control what content is shared (SWYN), and the layout of share buttons and
redirection.

o

Create landing pages
You can create landing pages with a single click, edit them in the template editor,
and link them to the desired location. Using the SWYN feature, landing pages are
created and linked automatically.

o

Use pre-headers for a personalized approach
You can include a greeting, a special offer, or a keyword specifically tailored to a
target group.

o

Integrate your favicon
Favicons are small icons, logos or symbols (such as your company logo) of 16×16 or
32×32 pixels. Typically, browsers display them in the address bar, on tabs, next to
bookmarks, or in your history. You can integrate a favicon into the online version of
your message with Optimizely Campaign.
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Designing newsletters
Using templates, you can create mailings in a CI-compliant layout – with no graphics or
HTML skills required. Templates offer you the flexibility you need by letting you design
each element individually. And you do not have to worry about losing your overall layout,
because templates store settings inherited from higher-level elements. Benefit: Text and
mobile versions of your HTML mailings are generated automatically and can be edited subsequently.
Tip: Lacking inspiration? Optimizely can create your newsletter
for you.
Optimizely can design your message template. On request, we can
also implement your message template into Optimizely Campaign.
For more information, contact customer support.

Layout fundamentals
Each paragraph in a template and even the template itself provides a range of design
options that can affect the layout of your newsletter:
l
l
l
l
l

Background color of the newsletter and newsletter background
Background color or images incorporated into individual paragraphs
Width of the newsletter
Number of columns
Margins and spacing of individual paragraphs

Examples and comments
l

Pre-Header. The pre-header contains a link to the online version. You can add pre-headers to display information prominently so that it is likely to catch the reader's eye.
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l

l

Header. The header contains an image and the newsletter's title. You can insert additional
elements, such as date and issue. A graphics editor lets you incorporate elaborate text
effects.

Sidebar. The sidebar produces a two-column layout. In this example, the sidebar is given a
different color to set it apart from the main body of the newsletter. If you choose this type
of layout, set an inner margin to create a space between the box and the text. Similarly, set
a margin between the sidebar and the main body of the newsletter so that the text/image
block in the main body does not "cling" to the sidebar.
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l

l

l

Main area. The main area has the same color as the entire newsletter. The text/image paragraph runs across the total available width and does not require an inner margin. The
image is centered between the title and the text. A teaser text links to a landing page.
Table of contents. The table of contents is a separate type of paragraph and can be
placed anywhere in the template. You can set a table of contents in a fixed position in individual mailing templates. You can enter the text that the table of contents displays into
the individual paragraphs – or use the paragraph headings (standard).
Image position. Here, the image is positioned on the left next to the heading. Larger
images should be scaled down to 50 % of the available width. Images are positioned relative to text, link and heading. If you choose to position an image to the left below the
heading, as opposed to the position shown here, then the heading will not be incorporated, which means it will appear across the full width of the paragraph.
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l

l

l

l

l

l

Inline block. Paragraphs with narrower widths are placed next to one another until the
maximum width is filled. This way, you can create a layout with consecutive, variable
columns. If the width is set to a particular portion of the total available width, then the individual blocks fill out the space precisely as indicated, generating a column layout.
Empty column. In contrast to a single column layout, the sidebar is left blank, if no content is to be entered.
Single column. With a single-column layout, a paragraph spans the entire width of the
newsletter. To create a template with a variety of layouts (for example single-column or
two-column), you will need to use paragraph outlines or special paragraphs.

Background color. A single background color (the same as used for the sidebar) is chosen
for these paragraphs. Set an inner margin to add space between the text block and the
paragraph frame.
Variable footer. A footer can contain multiple paragraphs. You can treat footer paragraphs the same as content paragraphs.
Fixed footer. This footer contains the site notice and contact information for the newsletter. This usually also includes the unsubscribe option required by law. The paragraph is
permanently stored and normally does not need to be adapted or edited further.
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l

Newsletter width. The ideal newsletter width depends on the recipient's device (responsive design):
o
o

Desktop version. 600 to 650 pixels.
Mobile version. 480 pixels (see Mobile Fusion).

Supported fonts
The Template Kit supports the following fonts.
l
l
l
l

Arial
Comic Sans
Courier New
Georgia
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l
l
l
l
l

Lucinda Sans Unicode
Tahoma
Times New Roman
Trebuchet MS
Verdana

You can store other fonts as an image in the Template Kit. Texts used this way cannot be
edited with the Template Kit.
Note: Images in the mailing are visible only after loading.

Design options
You cannot display color and background gradients and shadowing, but you can round off
edges. If you want to create the message template in Optimizely Campaign yourself, do
this in the relevant grouping paragraphs using the Border option.

Mobile Fusion
The Template Kit lets you preview your mailing on selected smart phones and tablets. So,
you can check the vertical and horizontal mobile appearance of your newsletter.
Mobile content elements appear below one another, so a mobile reader does not have to
scroll sideways, but can scroll up and down. And, you can specify whether images or text is
shown first in content areas. You also have the option to show or hide content areas on the
desktop versus the mobile version.
For more information, see Mobile Fusion.

General settings
Click Settings on the top border of the template editor to define fonts, basic grid, color
schemes and other settings that affect the template. The assistant for these settings
opens in a new layer with the tabs described in this topic.
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General
These settings affect the general layout of the newsletter and content, unless you overwrite them in Content paragraphs. For example, use general settings to adapt your company's corporate design to this template.
Parameter

Description

Newsletter title
Text

Appears in the browser window title of the online version.

Layout

Width of the
content area

Enter between 100 to 650 pixels to ensure that most email clients display the
newsletter properly. If you set a greater value, test the newsletter with the deliverability preview.

Alignment

Set the alignment for the entire newsletter. But, you define the alignment of content elements in each content paragraph.

Margin

Specify up to 1/8 of the total newsletter width; larger margin distance negatively
affects the layout.

Padding

Specify up to 1/8 of the total newsletter width to define space between borders
and content (text or images). Padding is only effective if different background colors or images are defined for the newsletter and content elements.

Space
between
grouping paragraphs

If no other pixel value is set here, the Padding value is used.

Space
between texts
and images

Specify up to 20 pixels.

Image quality

If High-resolution is selected, the uploaded image must be at least double
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Parameter

Description
the width of the image in the mailing. Example: For a 640 pixel wide image in
the mailing you need an image with a width of 1280 pixels. This ensures that
images do not lose sharpness during rendering of the mailing.

Favicon
URL

If desired, enter the URL of an externally-stored favicon for the online version of
your message.

Inherit

Header

The inherit header value affects landing pages, including automatically generated ones. To enter content different from the newsletter header in the respective areas of your landing pages, clear this check box.

Footer

The inherit value affects landing pages, including automatically generated ones.
To enter content different from the newsletter footer in the respective areas of
your landing pages, clear this check box.

Font settings
Define font types, size and line height for headings, text and links.
Parameter

Description

Headings

Font type

Define several font types in a comma-separated list. The browser or email client
tries to use the first font in this list. If this font is not installed on the system, the
next is tried. The last option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Size

Define the size (integer) of heading text.
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Parameter

Description

Line height

You can set an integer value greater than the font size; the default integer value
is set by recipient's web browser or email client.

Underline

Select to underline headings.

Bold

Select to bold headings.

Text

Font type

Define several font types in a comma-separated list. The browser or email client
tries to use the first font in this list. If this font is not installed on the system, the
next is tried. The last option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Size

Define the size (integer) of the text.

Line height

You can set an integer value greater than the font size; the default integer value
is set by recipient's web browser or email client.

Links

Font type

Define several font types in a comma-separated list. The browser or email client
tries to use the first font in this list. If this font is not installed on the system, the
next is tried. The last option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Size

Define the size of link text.

Line height

You can set an integer value greater than the font size; the default integer value
is set by the web browser or email client of the recipient.
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Parameter

Description

Underline

Select to underline links.

Bold

Select to bold links.

Table of contents with links to paragraphs

Font type

Define several font types in a comma-separated list. The browser or email client
tries to use the first font in this list. If this font is not installed on the system, the
next is tried. The last option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Size

Define the size of TOC links.

Line height

You can set an integer value greater than the font size; the default integer value
is set by the web browser or email client of the recipient.

Underline

Select to underline TOC links.

Bold

Select to bold TOC links.

Menu items in the navigation menu

Font type

Define several font types in a comma-separated list. The browser or email client
tries to use the first font in this list. If this font is not installed on the system, the
next is tried. The last option should define a generic font.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser. If you leave the field blank, the color you specified in
the Links area is displayed.

Size

Enter the font size for the menu item labels in pixels. If you leave the field blank,
the font size you specified in the Links area will be used.
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Parameter

Description

Line height

Enter the row height for the menu item labels in pixels. If you leave the field blank,
the line height is automatically set by the email client of the recipient.

Underline

Select to underline menu items.

Bold

Select to bold menu items.

Custom fonts
Note: To enable this feature, contact customer support. When setting
up, provide the path (URL) to your custom fonts. This can be your
own server or the server of a font provider (such as Google Fonts). If
you want to use a server from Optimizely, Optimizely needs the font
files. Optimizely itself cannot provide fonts.
Custom fonts are special fonts (such as your corporate font) that are downloaded from an
external source when the email is opened. If you have configured custom fonts in your client, you can find an overview of the available fonts in the yellow box at the top of the edit
area.
To use custom fonts, enter the font name in the desired input field in the Font Settings
tab. Additionally define alternative fonts, for example Fugaz One, Georgia, serif.
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Outlook fallbacks
Outlook does not support custom fonts. In the Custom Fonts tab under Outlook Fallbacks, specify which alternate fonts Outlook should use. You can find an overview of the
defined Outlook fallbacks in the yellow box at the top of the edit area.
Parameter

Description

Outlook fallbacks
Headings

Set Outlook fallbacks for Headings.

Text

Set Outlook fallbacks for Text.

Links

Set Outlook fallbacks for Links.

Table of contents with
links to paragraphs

Set Outlook fallbacks for Table of contents with links to paragraphs.

Menu items in the navigation menu

Set Outlook fallbacks for Menu items in the navigation menu.

Buttons

Set Outlook fallbacks for Buttons.

Note: Outlook only uses the defined fallbacks (except for Buttons) if
you have set a custom font in the corresponding area in the Font settings tab. If you set a custom font without defining a fallback,
Outlook uses an alternate font.

Color settings
Define general background colors or images and border colors in this tab. You can overwrite these settings in each content block.
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Parameter

Description

Newsletter background

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser. If you leave the field blank, the color you specified in
the Links area is displayed.
Because email clients do not support the display of background images, they
should not contain important information.

Image

If you use a background image, the parameters Alignment and Repeat
become effective.
Be aware that a background image is only visible at border areas and free
spaces, being masked by content and other backgrounds.

Alignment

Only effective if a background image is uploaded. Sets alignment for the entire
newsletter. Alignment of the content elements is defined in the content paragraphs.

Repeat

Only effective if a background image is uploaded. Repeats the background image.

Content area background

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser. If you leave the field blank, the color you specified in
the Links area is displayed.

Border
Show

Check to apply a border around the paragraph.

Border width

Enter an integer value in pixel. If you set this value to 0, no border will be displayed. The default border thickness is 1 pixel.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser. If you leave the field blank, the color you specified in
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Parameter

Description
the Links area is displayed.

Layout

Specify whether the newsletter should be displayed with or without pre-header,
header and footer.

Lists
Parameter

Description

Options
To use a simple bullet, under List type, select Bullet list.
List type

Custom bullet
character

To use a custom bullet character, upload an image and, under List type,
select List with custom bullet character.
Upload a bullet character or, in the Alternatively external URL field, enter an
image URL pointing to the image source. The bullet character can be up to 30pixels wide. Wider graphics are proportionally reduced to this size.

Separator
Use separator paragraphs to structure your newsletter and group paragraphs. Separators
may contain a top link for a simple navigation, a separator line, the top link, an image, and
free space. You can activate each elements individually in each separator paragraph.
Parameter

Description

Separator line

Width

The maximum width equals the total newsletter width minus padding. If a top link
icon with text is set on the separation line, the width of the line is reduced by the
width of this element.

Alignment

The alignment parameter is only effective if the width is smaller than the total
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Parameter

Description
available width.

Border width

Enter an integer value in pixel.

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Mobile
Width of the
separator

Set the width (in percent) of the separator line for the mobile version.

Top link

Icon

You can replace the default icon with an uploaded custom icon. The maximum
width equals the maximum width of the newsletter minus padding. Be aware that
if you use wide graphics, the separator line, if used, is proportionally smaller.
Graphics larger than the maximum width are scaled down.

Text

The text is shown. If the recipient's email client does not display the icon, the
recipient sees only the text.

Text position

Select the position of the link text relative to the icon.

Position

Select the vertical position of the top link (text AND icon) relative to the separator
line. By default, the top link is placed on the separator line.

Alignment

Select the horizontal position of the top link (text AND icon).

Image
Image

Upload an image from your computer or enter an image URL in the Alternatively
external URL field that points to the image file.

Alternative

This text appears if a recipient blocks or disables images in his/her email client, or
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Parameter

Description

text

if the image cannot be displayed for another reason. You should enter an alternative text containing a short description of the image.

Link

You can link the image to a landing page or a page from your website. If you
entered a text link in this paragraph, use the same link for the image.

Position

Specify the positioning of the image relative to the separator line and the top link.
This positioning affects only the appearance if at least one or both of these elements are selected in a separator.

Alignment

Select the horizontal position of the image. If the image occupies the entire width,
this parameter has no effect.

Spacing
Above separator

You can optionally add this space later in each separator paragraph to improve
the clarity of the newsletter.

Between top
link and separator line
and/or icon

You can optionally add this space later in each separator paragraph to improve
the clarity of the newsletter.

Below separator

You can optionally add this space later in each separator paragraph to improve
the clarity of the newsletter.

Button template
See Click2Go.

SWYN
If you use the share function for social networks (SWYN), define the general appearance of
your newsletter's SWYN.
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Parameter

Description

Introduction
Enter an introduction text that is shown together with the network icons. This text
may contain a call-to-action for recipients to share content in their networks.
Text
Each paragraph for which the SWYN function is activated displays this text
and the network icons.
Layout
Space
between elements

By default, the Space between texts and images setting from the General
tab is used. The maximum space is 20 pixels.
Select Same as image quality in template settings to use the image quality
specified under Settings > General. The Normal and High-resolution options
allow you to set the image quality independently of the template settings.

Image quality

If High-resolution is selected, the uploaded image must be at least double
the width of the image in the mailing. Example: For a 640 pixel wide image in
the mailing you need an image with a width of 1280 pixels. This ensures that
images do not lose sharpness during rendering of the mailing.

Icons
Note: SWYN must be enabled for each symbol to be displayed in the
mailing. The maximum width of the SWYN icons is 30 pixels, or 60 pixels if
you select High-resolution for image quality.

Facebook

Upload a custom Facebook icon or enter a URL pointing to your custom Facebook
icon.

Twitter

Upload a custom Twitter icon or enter a URL pointing to your custom Twitter icon.

WhatsApp

Upload a custom WhatsApp icon or enter a URL pointing to your custom WhatsApp icon.
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Parameter

Description

Email

Upload a custom email icon or enter a URL pointing to your custom email icon.

Xing

Upload a custom Xing icon or enter a URL pointing to your custom Xing icon.

Products
This paragraph type contains common fields to enter product details, such as old/current
price, product category, description, and so on. You can define the order of these fields.
By default, no formatting is used in the designated fields. To format the text entered in
these fields, use the editor's formatting tools. Or, if you use a content interface, commit
HTML formatting tags.
Parameter

Description

Order
Position 1

Enter a product name or title.

Position 2

Enter the product category, article group or genre. If you do not enter anything
here, this position is not displayed.

Position 3

Enter an author, artist or manufacturer of the product or work. If you do not enter
anything here, this position is not displayed.

Position 4

Enter a description of the product or work. If you do not enter anything here, this
position is not displayed.

Position 5

Use this field in combination with the field Current Price for price reductions, bargains, special offers, and so on.

Position 6

Enter the current or new price here.
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Content interface
This tab lets you define up to five alternative layouts for content of the content interface
by freely inputting HTML or text. You can select the required layout from within the content interface paragraph.
Source text entered here is adopted into the newsletter with no additional checks.
Text and link formatting must be prepared in HTML format. You need HTML knowledge, particularly HTML in email, to create new layouts or edit the default one. Using corrupt or
unsupported code may cause severe errors in the newsletter display.
Parameter

Description

Layout 1-5
Desktop version

Enter the source text for the desktop version.

Mobile version

Enter the source text for the mobile version.

Text version

Enter the source text for the text version.

Inserting content
The following Velocity variables are available:
l
l
l

Status. Information on current item paragraphs
Present. For using queries that check for the presence of an element
Value. For issuing the content

Notes for the creation of new layouts
l

l

Font definitions. If you are using an alternative layout variant, font definitions must exist
in the HTML you entered. The texts are not formatted by the Template Kit to give you complete freedom in visual design.
Widths. Specify a fixed width or a width in percent. You should enter a percentage,
because this prevents elements from sticking out of the layout.
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l

Danger of display errors. If you edit the layouts without in-depth knowledge of HTML,
serious display errors may occur in your mailings.
Parameter

Default

Description

$first

Boolean

true if it is the first item in the content interface paragraph; otherwise false.

$index

Integer

The position of the item within the content interface paragraph
as a number (1 for the first item, 2 for the second item...).

$last

Boolean

true if it is the last item in the content interface paragraph; otherwise false.

Variable

Type

Description

$text1Present

Boolean

true if content is present for the Text 1 field; otherwise false.

$text2Present

Boolean

true if content is present for the Text 2 field; otherwise false.

$text3Present

Boolean

true if content is present for the Text 3 field; otherwise false.

$text4Present

Boolean

true if content is present for the Text 4 field; otherwise false.

$text5Present

Boolean

true if content is present for the Text 5 field; otherwise false.

$text6Present

Boolean

true if content is present for the Text 6 field; otherwise false.

$text7Present

Boolean

true if content is present for the Text 7 field; otherwise false.

$text8Present

Boolean

true if content is present for the Text 8 field; otherwise false.
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Variable

Type

Description

$text9Present

Boolean

true if content is present for the Text 9 field; otherwise false.

$text10Present

Boolean

true if content is present for the Text 10 field; otherwise false.

$link1TextPresent

Boolean

true if content is present for the Text field in the
Link 1 group; otherwise false.

$link1UrlPresent

Boolean

true if content is present for the URL field in the
Link 1 group; otherwise false.

$link2TextPresent

Boolean

true if content is present for the Text field in the
Link 2 group; otherwise false.

$link2UrlPresent

Boolean

true if content is present for the URL field in the
Link 2 group; otherwise false.

$link3TextPresent

Boolean

true if content is present for the Text field in the
Link 3 group; otherwise false.

$link2UrlPresent

Boolean

true if content is present for the URL field in the
Link 3 group; otherwise false.

$image1ImageUrlPresent

Boolean

true if content is present for the Image field in the
Image 1 group in the Images tab; otherwise false.

$image1AltTextPresent

Boolean

$image1LinkPresent

Boolean

true if content is present for the Link field in the
Image 1 group in the Images tab; otherwise false.

$image2ImageUrlPresent

Boolean

true if content is present for the Image field in the
Image 2 group in the Images tab; otherwise false.

true if content is present for the Alternative text

field in the Image 1 group in the Images tab; otherwise false.
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Variable

Type

Description
true if content is present for the Alternative text

$image2AltTextPresent

Boolean

field in the Image 2 group in the Images tab; otherwise false.

$image2LinkPresent

Boolean

true if content is present for the Link field in the
Image 2 group in the Images tab; otherwise false.

$image3ImageUrlPresent

Boolean

true if content is present for the Image field in the
Image 3 group in the Images tab; otherwise false.

$image3AltTextPresent

Boolean

$image3LinkPresent

Boolean

true if content is present for the Link field in the
Image 3 group in the Images tab; otherwise false.

$image4ImageUrlPresent

Boolean

true if content is present for the Image field in the
Image 4 group in the Images tab; otherwise false.

$image4AltTextPresent

Boolean

$image4LinkPresent

Boolean

true if content is present for the Alternative text

field in the Image 3 group in the Images tab; otherwise false.

true if content is present for the Alternative text

field in the Image 4 group in the Images tab; otherwise false.
true if content is present for the Link field in the
Image 4 group in the Images tab; otherwise false.
true if content is present for the Image field in the

$image5ImageUrlPresent

Boolean

Image 5 group in the Images tab; otherwise
false.
true if content is present for the Alternative text

$image5AltTextPresent

Boolean

$image5LinkPresent

Boolean

field in the Image 5 group in the Images tab; otherwise false.
true if content is present for the Link field in the

Image 5 group in the Images tab; otherwise
false.
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Variable

Type

Description
true if content is present for the Image field in the

$image6ImageUrlPresent

Boolean

Image 6 group in the Images tab; otherwise
false.
true if content is present for the Alternative text

$image6AltTextPresent

Boolean

field in the Image 6 group in the Images tab; otherwise false.
true if content is present for the Link field in the

$image6LinkPresent

Boolean

Variable

Image 6 group in the Images tab; otherwise
false.
Type

Environment

Description
The unchanged content from the Text 1
field.

$text1Value

String

Desktop, mobile,
text

$text1FormattedValue

String

Desktop, mobile

The edited content
from the Text 1 field.

$text1FormattedAsHeadlineValue

String

Desktop, mobile

The edited content
from the Text 1 field.
The text is provided in
the formatting for
headings, and is linked
to the URL for Link 1.

$text2Value

String

Desktop, mobile,
text

The unchanged content from the Text 2
field.

$text2FormattedValue

String

Desktop, mobile

The edited content
from the Text 2 field.

$text3Value

String

Desktop, mobile,
text

The unchanged content from the Text 3
field.

© Optimizely 2022

Managing content | 383

Variable

Type

Environment

Description

$text3FormattedValue

String

Desktop, mobile

The edited content
from the Text 3 field.

$text4Value

String

Desktop, mobile,
text

The unchanged content from the Text 4
field.

$text4FormattedValue

String

Desktop, mobile

The edited content
from the Text 4 field.

$text5Value

String

Desktop, mobile,
text

The unchanged content from the Text 5
field.

$text5FormattedValue

String

Desktop, mobile

The edited content
from the Text 5 field.

$text6Value

String

Desktop, mobile,
text

The unchanged content from the Text 6
field.

$text6FormattedValue

String

Desktop, mobile

The edited content
from the Text 6 field.

$text7Value

String

Desktop, mobile,
text

The unchanged content from the Text 7
field.

$text7FormattedValue

String

Desktop, mobile

The edited content
from the Text 7 field.

$text8Value

String

Desktop, mobile,
text

The unchanged content from the Text 8
field.

$text8FormattedValue

String

Desktop, mobile

The edited content
from the Text 8 field.
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Variable

Type

Environment

Description

$text9Value

String

Desktop, mobile,
text

The unchanged content from the Text 9
field.

$text9FormattedValue

String

Desktop, mobile

The edited content
from the Text 9 field.

$text10Value

String

Desktop, mobile,
text

The unchanged content from the Text 10
field.

$text10FormattedValue

String

Desktop, mobile

The edited content
from the Text 10 field.

$link1TextValue

String

Desktop, mobile,
text

The unchanged content from the Text
field in the Link 1
group.

$link1UrlValue

String

Desktop, mobile,
text

The unchanged content from the URL field
in the Link 1 group.

String

Desktop, mobile

The edited content
from the Text field in
the Link 1 group. The
text is provided in the
formatting for links,
and is linked to the
URL for Link 1.

$link2TextValue

String

Desktop, mobile,
text

The unchanged content from the Text
field in the Link 2
group.

$link2UrlValue

String

Desktop, mobile,
text

The unchanged content from the URL field

$link1FormattedValue
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Variable

Type

Environment

Description
in the Link 2 group.

$link2FormattedValue

String

Desktop, mobile

The edited content
from the Text field in
the Link 2 group. The
text is provided in the
formatting for links,
and is linked to the
URL for Link 2.

$link3TextValue

String

Desktop, mobile,
text

The unchanged content from the Text
field in the Link 3
group.

$link3UrlValue

String

Desktop, mobile,
text

The unchanged content from the URL field
in the Link 3 group.

$link3FormattedValue

String

Desktop, mobile

The edited content
from the Text field in
the Link 3 group. The
text is provided in the
formatting for links,
and is linked to the
URL for Link 3.

$image1ImageUrlValue

String

Desktop, mobile

The image address of
Image 1.

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 1 group.

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 1 group.

$image1AltTextValue

$image1LinkValue
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Variable

$image1FormattedValue

$image1FullFormattedValue

Type

String

String

Environment

Description

Mobile

The complete HTML
source text from
Image 1 with alternative text and link. The
image width is set to
100% (available width).

Desktop

The complete HTML
source text from
Image 1 with alternative text and link. The
maximum image width
is the available paragraph width.

$image1HalfFormattedValue

String

Desktop

The complete HTML
source text from
Image 1 with alternative text and link. The
maximum image width
is half of the available
paragraph width.

$image2ImageUrlValue

String

Desktop, mobile

The image address of
Image 2.

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 2 group.

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 2 group.

Mobile

The complete HTML
source text from
Image 2 with alternative text and link. The

$image2AltTextValue

$image2LinkValue

$image2FormattedValue

String
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Variable

Type

Environment

Description
image width is set to
100% (available width).

$image2FullFormattedValue

String

Desktop

The complete HTML
source text from
Image 2 with alternative text and link. The
maximum image width
is the available paragraph width.

$image2HalfFormattedValue

String

Desktop

The complete HTML
source text from
Image 2 with alternative text and link. The
maximum image width
is half of the available
paragraph width.

$image3ImageUrlValue

String

Desktop, mobile

The image address of
Image 3.

$image3AltTextValue

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 3 group.

$image3LinkValue

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 3 group.

Mobile

The complete HTML
source text from
Image 3 with alternative text and link. The
image width is set to
100% (available width).

$image3FormattedValue

String
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Variable

$image3FullFormattedValue

Type

String

Environment

Description

Desktop

The complete HTML
source text from
Image 3 with alternative text and link. The
maximum image width
is the available paragraph width.

$image3HalfFormattedValue

String

Desktop

The complete HTML
source text from
Image 3 with alternative text and link. The
maximum image width
is half of the available
paragraph width.

$image4ImageUrlValue

String

Desktop, mobile

The image address of
Image 4.

$image4AltTextValue

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 4 group.

$image4LinkValue

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 4 group.

Mobile

The complete HTML
source text from
Image 4 with alternative text and link. The
image width is set to
100% (available width).

Desktop

The complete HTML
source text from
Image 4 with alternative text and link. The

$image4FormattedValue

$image4FullFormattedValue

String

String
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Variable

Type

Environment

Description
maximum image width
is the available paragraph width.

$image4HalfFormattedValue

String

Desktop

The complete HTML
source text from
Image 4 with alternative text and link. The
maximum image width
is half of the available
paragraph width.

$image5ImageUrlValue

String

Desktop, mobile

The image address of
Image 5.

$image5AltTextValue

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 5 group.

$image5LinkValue

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 5 group.

Mobile

The complete HTML
source text from
Image 5 with alternative text and link. The
image width is set to
100% (available width).

Desktop

The complete HTML
source text from
Image 5 with alternative text and link. The
maximum image width
is the available paragraph width.

$image5FormattedValue

$image5FullFormattedValue

String

String
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Variable

Type

Environment

Description

$image5HalfFormattedValue

String

Desktop

The complete HTML
source text from
Image 5 with alternative text and link. The
maximum image width
is half of the available
paragraph width.

$image6ImageUrlValue

String

Desktop, mobile

The image address of
Image 6.

String

Desktop, mobile,
text

The unchanged content from the Alternative text field in the
Image 6 group.

String

Desktop, mobile,
text

The unchanged content from the Link field
in the Image 6 group.

Mobile

The complete HTML
source text from
Image 6 with alternative text and link. The
image width is set to
100% (available width).

Desktop

The complete HTML
source text from
Image 6 with alternative text and link. The
maximum image width
is the available paragraph width.

Desktop

The complete HTML
source text from
Image 6 with alternative text and link. The

$image6AltTextValue

$image6LinkValue

$image6FormattedValue

$image6FullFormattedValue

$image6HalfFormattedValue

String

String

String
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Variable

Type

Environment

Description
maximum image width
is half of the available
paragraph width.

$editBar

String

Desktop, mobile

Inserts the paragraph
button bar. This is
required to integrate
the button bar into the
table, such as when
implementing adjacent
items. If this variable is
not available, the button bar is placed
above the item.

Examples of alternative layout variants
The examples show the source text for the default layout and can be adapted for alternative layout variants.
Remove HTML comments, blank lines and spaces when transferring HTML into the Template Kit. If you do not do this, then these elements are included when sending, and will
cause the newsletter source text to "swell".
<table width="100%" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="100%">
#set($displaySeparator = false)
#if("$text1Present" == "true")
$text1FormattedAsHeadlineValue
#set($displaySeparator = true)
#end
#if("$image1ImageUrlPresent" == "true")
#if("$text1Present" == "true")
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#set($displaySeparator = false)
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#end
<table border="0" cellspacing="0" cellpadding="0" align="right">
<tr>
<td width="10"></td>
<td>
#if("$image1LinkPresent" != "true" &&
"$link1UrlPresent" == "true")
<a href="$link1UrlValue" target="_blank">
#end
$image1HalfFormattedValue
#if("$image1LinkPresent" != "true" &&
"$link1UrlPresent" == "true")
</a>
#end
</td>
</tr>
</table>
#end
#if("$text2Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text2FormattedValue
#set($displaySeparator = true)
#end
#if("$text3Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text3FormattedValue
#set($displaySeparator = true)
#end
#if("$text4Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text4FormattedValue
#set($displaySeparator = true)
#end
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#if("$text5Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text5FormattedValue
#set($displaySeparator = true)
#end
#if("$text6Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text6FormattedValue
#set($displaySeparator = true)
#end
#if("$text7Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text7FormattedValue
#set($displaySeparator = true)
#end
#if("$text8Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text8FormattedValue
#set($displaySeparator = true)
#end
#if("$text9Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
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</tr>
</table>
#end
$text9FormattedValue
#set($displaySeparator = true)
#end
#if("$text10Present" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$text10FormattedValue
#set($displaySeparator = true)
#end
#if("$link1TextPresent" == "true" && "$link1UrlPresent" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$link1FormattedValue
#set($displaySeparator = true)
#end
#if("$link2TextPresent" == "true" && "$link2UrlPresent" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$link2FormattedValue
#set($displaySeparator = true)
#end
#if("$link3TextPresent" == "true" && "$link3UrlPresent" == "true")
#if($displaySeparator)
<table width="10" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="10" height="10"></td>
</tr>
</table>
#end
$link3FormattedValue
#set($displaySeparator = true)
#end

© Optimizely 2022

Managing content | 395

</td>
</tr>
<tr>
<td width="100%" height="10"><!-- --></td>
</tr>
</table>
#set($displaySeparator = false)
#if("$text1Present" == "true")
$text1FormattedAsHeadlineValue
#set($displaySeparator = true)
#end
#if("$image1ImageUrlPresent" == "true")
#if("$text1Present" == "true")
<div style="height: 10px;"></div>
#set($displaySeparator = false)
#end
<div style="float: right; margin-left: 10px; max-width: 50%;">
#if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
<a href="$link1UrlValue" target="_blank">
#end
$image1FormattedValue
#if("$image1LinkPresent" != "true" && "$link1UrlPresent" == "true")
</a>
#end
</div>
#end
#if("$text2Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text2FormattedValue
#set($displaySeparator = true)
#end
#if("$text3Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text3FormattedValue
#set($displaySeparator = true)
#end
#if("$text4Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text4FormattedValue
#set($displaySeparator = true)
#end
#if("$text5Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
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$text5FormattedValue
#set($displaySeparator = true)
#end
#if("$text6Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text6FormattedValue
#set($displaySeparator = true)
#end
#if("$text7Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text7FormattedValue
#set($displaySeparator = true)
#end
#if("$text8Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text8FormattedValue
#set($displaySeparator = true)
#end
#if("$text9Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text9FormattedValue
#set($displaySeparator = true)
#end
#if("$text10Present" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$text10FormattedValue
#set($displaySeparator = true)
#end
#if("$link1TextPresent" == "true" && "$link1UrlPresent" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$link1FormattedValue
#set($displaySeparator = true)
#end
#if("$link2TextPresent" == "true" && "$link2UrlPresent" == "true")
#if($displaySeparator)
<div style="height: 10px;"></div>
#end
$link2FormattedValue
#set($displaySeparator = true)
#end
#if("$link3TextPresent" == "true" && "$link3UrlPresent" == "true")
#if($displaySeparator)
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<div style="height: 10px;"></div>
#end
$link3FormattedValue
#set($displaySeparator = true)
#end
<div style="clear: both; height: 10px;"><!-- --></div>
#set($displaySeparator = false)#if("$text1Present" == "true")#if($displaySeparator)
#end$!{null}$text1Value#set($displaySeparator = true)#end$!{null}#if
("$text2Present" == "true")#if($displaySeparator)
#end$!{null}$text2Value#set($displaySeparator = true)#end$!{null}#if("$text3Present" == "true")#if($displaySeparator)
#end$!{null}$text3Value#set($displaySeparator = true)#end$!{null}#if("$text4Present" == "true")#if($displaySeparator)
#end$!{null}$text4Value#set($displaySeparator = true)#end$!{null}#if("$text5Present" == "true")#if($displaySeparator)
#end$!{null}$text5Value#set($displaySeparator = true)#end$!{null}#if("$text6Present" == "true")#if($displaySeparator)
#end$!{null}$text6Value#set($displaySeparator = true)#end$!{null}#if("$text7Present" == "true")#if($displaySeparator)
#end$!{null}$text7Value#set($displaySeparator = true)#end$!{null}#if("$text8Present" == "true")#if($displaySeparator)
#end$!{null}$text8Value#set($displaySeparator = true)#end$!{null}#if("$text9Present" == "true")#if($displaySeparator)
#end$!{null}$text9Value#set($displaySeparator = true)#end$!{null}#if("$text10Present" == "true")#if($displaySeparator)
#end$!{null}$text10Value#set($displaySeparator = true)#end$!{null}#if("$link1TextPresent" == "true" && "$link1UrlPresent" == "true")#if($displaySeparator)
#end$!{null}$link1TextValue
$link1UrlValue#set($displaySeparator = true)#end$!{null}#if("$link2TextPresent"
== "true" && "$link2UrlPresent" == "true")#if($displaySeparator)
#end$!{null}$link2TextValue
$link2UrlValue#set($displaySeparator = true)#end$!{null}#if("$link3TextPresent"
== "true" && "$link3UrlPresent" == "true")#if($displaySeparator)
#end$!{null}$link3TextValue
$link3UrlValue#set($displaySeparator = true)#end$!{null}#if("$image1ImageUrlPresent" == "true" && "$image1AltTextPresent" == "true"
&& ("$image1LinkPresent" == "true" || "$link1UrlPresent" == "true"))#if($displaySeparator)
#end$!{null}$image1AltTextValue
#if("$image1LinkPresent" == "true")$image1LinkValue$!{null}#else$!
{null}$link1UrlValue#end#end$!{null}

RSS feeds
You can define one or more layout variants for RSS feed articles. Within the RSS feed paragraph you can select the layout to be used.
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Source code entered in this tab is rendered into the newsletter without further checking.
The formatting of text and links must be written in HTML code.
Warning: You need knowledge of HTML and particularly of HTML in
emails to setup this paragraph. Using corrupt or not supported code
in a layout may cause severe errors in the newsletter display.
Parameter

Description

Placeholder for the RSS feed URL
Value for {placeholder1}...Value for {placeholder1}

In the RSS feed paragraph, open the RSS feed tab and insert the placeholder {placeholder1}, {placeholder3} or {placeholder3} in the URL box.
Before the RSS feed is retrieved, this placeholder is replaced with the
value entered here.

Order (default layout)
Position 1

Select the content to be displayed here.

Position 2

Select the content to be displayed here.

Position 3

Select the content to be displayed here.

Position 4

Select the content to be displayed here.

Layout 1-5
Desktop version

Enter the source code for the desktop version of your newsletter.

Mobile version

Enter the source code for the mobile version of your newsletter.

Text version

Enter the source code for the text version of your newsletter.
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Inserting content
Content from an RSS feed is present as velocity variables and can be inserted in the
source text this way. These include
l
l
l

status variables (information on current article paragraphs)
present variables (for using queries that check the presence of an element)
value variables (for releasing content)
Note: Important notes
l

l

l

l

l

Font definitions. When using alternate layout options, font definitions
must be set in your HTML. The Template Kit does not format the text, allowing you to choose a design. Conversely, this means that links in continuous
text (if used) must be formatted accordingly in the RSS feed.
Width specifications. RSS feed paragraphs may vary in width. When using
an alternate layout, you should preferably only work with percentages, or
not apply width specifications. Otherwise, you can work with fixed widths as
long as the RSS feed paragraph is used in the same configuration, or a separate layout variant is defined for each different paragraph width.
Aspect ratio. The Template Kit can only edit images to a limited degree if
an alternative layout option is used (whatever content width is present is
applied as the maximum width). You should provide images with the
required width. Also, you can also scale the image by setting a specified
width in HTML. This is not recommended, however, because some applications (such as Microsoft Outlook) ignore this information and display the
image in its original size.
Link alignment/Image position. These options are inoperative when using
an alternative layout. The arrangement/positioning of elements is set by
the HTML
Risk of display errors. When manually entering HTML for desktop and
mobile versions, make sure that the content displays properly in a variety of
email programs and web mailers. Otherwise, this can lead to serious display
errors.
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Variable

Type

Description

rssItemFirst

Boolean

Is true, if it is the first article of the RSS feed paragraph, otherwise false.

rssItemIndex

Integer

Shows the position of the article within the RSS feed paragraph
as a number (1 for the first article, 2 for the second article and so
on).

rssItemLast

Boolean

Is true, if it is the last article of the RSS feed paragraph, otherwise false.

Variable

Type

Description

rssTitlePresent

Boolean

Contains true, if content is present for the
Title box, otherwise false.

rssTextPresent

Boolean

Contains true, if content is present for the
Text box, otherwise false.

rssAuthorPresent

Boolean

Contains true, if content is present for the
Author box, otherwise false.

rssDatePresent

Boolean

Contains true, if content is present for the
Date box, otherwise false.

rssCategoriesPresent

Boolean

Contains true, if content is present for the
Categories box, otherwise false.

rssLinkTextPresent

Boolean

Contains true, if content is present for the
Text box in the Link group, otherwise false.

rssLinkUrlPresent

Boolean

Contains true, if content is present for the
URL box in the Link group, otherwise false.

rssCommentsLinkTextPresent

Boolean

Contains true, if content is present for the
Text box in the Link to the comments group,
otherwise false.
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Variable

Type

Description

Boolean

Contains true, if content is present for the
URL box in the Link to the comments group,
otherwise false.

rssImageUrlPresent

Boolean

Contains true, if content is present for the
Image box (Upload file) in the Image tab, otherwise false.

rssImageAltTextPresent

Boolean

Contains true, if content is present for the
Alternative text box in the Image tab, otherwise false.

rssImageLinkPresent

Boolean

Contains true, if content is present for the
Link box in the Image tab, otherwise false.

rssCommentsLinkUrlPresent

Variable

Type

Description

rssTitleValue

String

Text for the Title box.

rssTextValue

String

Text for the Text box.

rssAuthorValue

String

Text for the Author box.

rssDateValue

String

Text for the Date box.

rssCategoriesValue

String

Text for the Categories box.

rssLinkTextValue

String

Text for the Text box in the Link group.

rssLinkUrlValue

String

Text for the URL box in the Link group.

rssCommentsLinkTextValue

String

Text for the Text box in the Link to the comments group.

rssCommentsLinkUrlValue

String

Text for the URL box in the Link to the comments
group.
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Variable

Type

Description

rssImageUrlValue

String

Image URL (Upload Image) for the Image tab.

rssImageAltTextValue

String

Text for the Alternative Text for the Image tab.

rssImageLinkValue

String

Text for the Link box for the Image tab.
Inserts the button bar for the RSS feed article.

editBar

String

This is necessary when placing articles side-byside, for example, to integrate the button bar
into the table. If this variable is not present, the
button bar is placed above the article.

Example for an alternative layout
The example creates a two-columned layout using a width of 580 pixels.
Note: Remove HTML comments, whitespaces, and blank lines when
copying the HTML to the Template Kit. They may be sent along with
the newsletter and, thus, expand the newsletter source code.
<!-- This query ensures that content is only displayed if the contents used for
this layout are available. -->
#if($rssTitlePresent || $rssImageUrlPresent || $rssAuthorPresent ||
$rssDatePresent || $rssTextPresent || ($rssLinkTextPresent &&
$rssLinkUrlPresent))
<!-- To enable the two-column layout, a border table is opened in the first
RSS feed article. -->
#if($rssItemFirst)
<table border="0" cellpadding="0" cellspacing="0">
<tr>
#end
<!-- For every article, a table cell with half the width is created. This
table cell contains the entire contents of the RSS feed item. -->
<td width="280" align="left" valign="top">
<!-- The button bar is placed here so it is displayed above the corresponding RSS feed article. -->
$editBar
#if($rssTitlePresent)
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<font size="2" face="Arial, sans-serif" color="#000001" style="fontsize: 14px;"><b>
#if($rssLinkUrlPresent)
<a href="$rssLinkUrlPresent" style="color: #000001; text-decoration: none;" target="_blank">
#end
<font size="2" face="Arial, sans-serif" color="#000001" stylee="font-size: 14px;"><b>$rssTitleValue</b></font>
#if($rssLinkUrlPresent)
</a>
#end
</b></font>
<table width="100%" cellspacing="0" cellpadding="0" border="0">
<tr>
<td width="100%" height="10"></td>
</tr>
</table>
#end
#if($rssImageUrlPresent)
#if($rssImageLinkPresent)
<a href="$rssImageLinkValue" target="_blank">
#end
#if(!$rssImageLinkPresent && $rssLinkUrlPresent)
<a href="$rssLinkUrlValue" target="_blank">
#end
<!-- An image width of 130 pixels is specified. You should provide an
image that already have the required width. Otherwise it will be stretched or compressed. -->
<img src="$rssImageUrlValue" alt="$rssImageAltTextValue" width="130"
border="0" align="right" style="display: block; float: right;" />
#if($rssImageLinkPresent || $rssLinkUrlPresent)
</a>
#end
#end
#if($rssAuthorPresent || $rssDatePresent || $rssTextPresent)
<font size="1" face="Arial, sans-serif" color="#666666" style="fontsize: 11px;">
#if($rssDatePresent || $rssAuthorPresent)
<span style="font-size: 10px;">
$rssDateValue
#if($rssDatePresent && $rssAuthorPresent)
|
#end
$rssAuthorValue
</span>
<table width="100%" cellspacing="0" cellpadding="0" border="0">
<tr>
<td width="100%" height="10"></td>
</tr>
</table>
#end
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$rssTextValue
</font>
#end
#if($rssLinkTextPresent && $rssLinkUrlPresent)
<font size="1" face="Arial, sans-serif" color="#666666" style="fontsize: 11px; line-height: 11px;">
&ndash;
<nobr>
<a href="$rssLinkUrlValue" style="line-height: 11px; color:
#666666; text-decoration: underline;" target="_blank">
<font size="1" face="Arial, sans-serif" color="#666666"
style="font-size: 11px;">
<u>$rssLinkTextValue</u>
</font>
</a>
</nobr>
</font>
#end
<!-- After every first (left-aligned) RSS feed article, the table cell is
closed and a new one is opened. -->
#if($rssItemIndex % 2 == 1)
</td>
<td width="20"></td>
<!-- After every second (right-aligned) RSS feed article, the above opened
table is closed, some space is inserted and a table is opened. -->
#else
</td>
</tr>
</table>
#if(!$rssItemLast)
<table width="580" border="0" cellpadding="0" cellspacing="0">
<tr>
<td width="580" height="20"></td>
</tr>
</table>
#end
<table border="0" cellpadding="0" cellspacing="0">
<tr>
#end
<!-- After the last RSS feed article the table is closed. -->
#if($rssItemLast)
</tr>
</table>
#end
#end
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Facebook
The Facebook paragraph contains a default layout for the visual design of Facebook articles. If you want, you can store up to 2 additional layouts as HTML code. You can select
custom layouts from a drop-down list in the Facebook paragraph (see Facebook layouts).
Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
mailings.
Parameter

Description

Order (default layout)

Position 1–3

Specify where to display the date, author, and text by selecting the desired
option from the drop-down list. To specify distance between them, in the General
tab under Layout, change the value of Space between texts and images.

Layout 1 and 2
Desktop version

Enter the source code for the desktop version.

Mobile version

Enter the source code for the mobile version.

Text version

Enter the source code for the text version.

Twitter
The Twitter paragraph contains a default layout for the visual design of your Tweets. If you
want, you can store up to 5 additional layouts as HTML code. You can select custom layouts from a drop-down list in the Twitter paragraph. (See Twitter layouts).
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Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
mailings.
Parameter

Description

Order (default layout)

Position 1 – 3

Specify where to display the date, author, and text by selecting the desired
option from the drop-down list. To specify the distance between these information, in the General tab under Layout, change the value of the Space between
texts and images box.

Layout 1 and 2
Desktop version

Enter the source code for the desktop version.

Mobile version

Enter the source code for the mobile version.

Text version

Enter the source code for the text version.

Navigation menu
The navigation menu paragraph contains a default layout for the visual design of navigation menu. If you want, you can store up to 5 additional layouts as HTML code. You can
select custom layouts from a drop-down list in the navigation menu paragraph. (see Navigation menu layouts).
Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
mailings.
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Parameter

Description

Layout 1-5
Desktop version

Enter the source code for the desktop version.

Mobile version

Enter the source code for the mobile version.

Text version

Enter the source code for the text version.

Structured data
Add structured data to your mailing to present the email more prominently and attractively in the recipient's inbox or to add additional functions. The recipient's email program
must support structured data for this. If this is not the case, the structured data is ignored
and the email is displayed regularly in the recipient's inbox.
Select the checkbox in the Gmail Promotions tab section to place the email prominently
in the Gmail Promotions tab using structured data. Depending on the provided content,
Gmail will add a company logo, an image banner, a coupon code and a timer to the email
preview.
Note: The structured data generated by Optimizely Campaign is in
conformance with Gmail's specifications. However, Optimizely has no
influence on how the structured data is ultimately interpreted in
Gmail's inbox. For more information on the Gmail Promotions tab, see
Gmail developer website.
Alternatively, you can enter structured data directly as JSON-LD script in the JSON-LD
source code section. Note that no validation takes place and that even a small error in the
JSON-LD source code can result in the structured data not being read. In any case, test
the display in advance using a test dispatch.
Parameter

Description

Gmail Promotions tab
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Parameter

Description
Check to add structured data to your mailing. By clicking Apply, a yellow box at
the top of the edit area labeled Structured data is activated for this mailing
appears. Click Display to display the JSON-LD script in the head section of the
HTML code.

Activate
Tip: If you have knowledge of JSON-LD, you can use
the code preview to review, copy, and modify the code
in the JSON-LD source code section.

Start date

To promote a limited time offer, you must specify a start date. The start date must
lie before the mailing's send date to ensure that Gmail considers the structured
data. Use the indicated date format.

Start time

Define a start time. Use the time format hh:mm:ss.

End date

From the end date and end time, Gmail calculates the timer until the end of the
offer. The end date must lie after the mailing's send date to ensure that Gmail considers the structured data. Use the indicated date format.

End time

Define the end time of the offer. Use the time format hh:mm:ss.

Time zone

Select the time zone to which your time specifications refer. Gmail uses this to calculate the end time for the recipient's time zone. Example: An offer that ends at
10:00 AM in the UK ends at 6:00 PM in Japan.

Logo

Upload your company logo. The logo will be displayed next to the mailing preview. Alternatively, you can enter an external URL where the logo can be found.
Use a square image format with an image size of at least 40 x 40 pixels.

Coupon
description

Enter a description to your coupon code. Example: 30% discount.

Coupon code

Insert a coupon code or placeholder depending on how you generate the coupon
code. For information on how to create and include coupon codes with Optimizely Campaign, see Coupon system.

Image

Upload an image that will be displayed below the text in the email preview. Altern-
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Parameter

Description
atively, you can enter an external URL where the logo is to be found. Use a rectangular image format with an image size of at least 324 x 83 pixels.

Tracking
You can extend outgoing links with tracking parameters. With the help of web analytics
software, you can use these parameters to analyze click behavior. You can define up to five
tracking parameters. Each consists of a key (parameter name) and value.
Parameter

Description

Parameter 1-5
Key

Enter the name of the parameter.

Value

Enter the value of the parameter (integer or string).

Text version
If you do not want to use the automatically generated text version, created from content
you enter in the template editor, enter a text version for the complete newsletter. If you
enable this option, no content is converted automatically into the text version.
Parameter

Description

Alternative text version

Activated

By default, this check box is cleared, and the text version is created automatically.
If you check this box, you must enter a text version manually in the field below.
Otherwise, no text version is sent with your mailing.

Text

Enter the newsletter text. You cannot use HTML or other formatting in the text
version. Only line breaks and special characters (such as ****** or ++++++) can be
used to structure the newsletter.
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Mobile
Activate an optimized version of your mailing for mobile devices. This version is sent
together with the desktop version and displayed on smart phones and tablets.
Parameter

Description

General

Activate
mobile version

Check to create a mobile version of the newsletter. By default, newsletter content
is included in the mobile version. For each paragraph, you can define whether it is
displayed or omitted in the mobile version. Note that the size of each email that
contains a mobile version will increase by approximately 50-100 KB.

Click profile

Select a click profile that is assigned to each recipient who clicks in the mobile
version. Use the click profile to analyze the usage of the mobile version or to create target groups containing mobile users.

Activate link
extension

If you want to track mobile version links separately so that they are available in
advanced reports, check this box. If you do, an additional parameter mobile with
a value of 1is appended to mobile newsletter links.
You can also use click profiles to achieve more convenient reporting.

Pre-header
The pre-header is the first text part of a newsletter, positioned above the content. In most
cases, the pre-header presents a link similar to If this message is not displayed correctly,
click here, which redirects to the online version of the newsletter. This is useful as many
email programs and providers (such as Outlook, Hotmail, Gmail) block images by default.
Other examples of pre-headers are an unsubscribe link, or a hint about adding the sender
to the recipient's address book.
To insert a pre-header, click New: Pre-Header in the template editor. You can use several
pre-headers and assign them to target groups to restrict the pre-header to certain recipient segments.
Change the settings described below as desired and confirm by clicking Apply.
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General
Parameter

Description

Content
Text

Enter the pre-header text, such as a reference and link to the online version.

Show in Online
Version

Select to include this paragraph in the online version.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing.

Options
Use these settings to define a pre-header layout that is from the default newsletter settings.
Parameter

Description

Layout
Width

Enter an integer value in pixels.

Alignment

Select a value from the drop-down list.

Background

To define the color, enter a hexadecimal value preceded by # (such as
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Parameter

Description

Color

#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Padding

Enter an integer value.

Mobile
Width

Enter the width of the mobile newsletter in percentage.

Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Setting up a pre-header for emails
If a subscriber clicks the link to the online version or reloads the newsletter images (that is,
right-mouse clicks the blocked images), these steps may result in a premature closing of
the newsletter by deleting it or marking it spam.
During the first weeks of subscription, use a pre-header to ask recipients to add your mailing address to their email address book. If they do, email sent from known addresses is
immediately displayed in full, including images, by many email programs and providers
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(such as Gmail, Hotmail, Outlook). Such recipients also see your newsletter in email preview.
Adding your mailing address to a subscriber's address book also improves deliverability,
since the email program classifies your newsletter as trustworthy. This is also very important with regard to "smart mailboxes" that some email providers are using.
To implement a pre-header into your emails, select recipients, adapt the email's HTML
code, and create a filter.

Selecting recipients
You should only send a pre-header to new subscribers. Recipients who have received your
newsletter for a time may have already updated their address book, or might not want to.
So, create a filter for the pre-header that selects recipients who registered for the newsletter in the last three to four weeks. Adjust the time period to the sending frequency of
your newsletter. Send on a monthly basis instead of every week, or try 60 days.

Adapting the email
The pre-header should contain a short text, asking the recipient to take action:
Please add our mailing address "newsletter@example.com" to your address book!

Creating a filter
To show this text to newly-registered recipients only, create a new Field function using the
filter, or use a script. For example, many email marketing programs support the Velocity
scripting language, which lets you add logic to HTML code to perform recipient-dependent
dynamisations.
Depending on how flexibly the pre-header is supposed to be used, fixed filters could be
linked, or the filter and/or the registration period for the filter could be designed as selectable.
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Adapting the text version
In the first line of the text version of the newsletter, you should also prompt subscribers to
add the mailing address to their address book.
Testing your changes
1. Create an email address for testing.
2. Send an email to the address whose opt-in date falls within the relevant time period.

Header
By default, the header contains a text/image paragraph with a logo and issue number. Complete this information and upload your company logo.

l

The newsletter contains only one header element.
The header can contain several paragraphs.
You can select the same paragraph types as in the content section.

l

You can remove the header if not needed.

l
l

To add a new paragraph in the header, click Header; see Content paragraphs.
To define the layout and select other options, click Header; see Grouping paragraphs.

Footer
The footer usually contains contact and legal information and an imprint.
l
l
l

You can add more paragraphs to the footer.
The newsletter contains only one footer element.
You can remove the footer if not needed.

To add a new paragraph in the footer, click New: Footer Paragraph; see Content paragraphs.
To define the layout and select other options in the footer, click Footer; see Grouping paragraphs.
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Grouping paragraph
Grouping paragraphs serve to structure the newsletter, but do not contain any content.
From a high-level perspective, a newsletter only contains pre-header, header, footer, and
grouping paragraphs. You can add to a mailing several grouping paragraphs, then insert
content paragraphs into them.
Each grouping paragraph can contain its own table of contents, or you can create one
table of contents for all grouping paragraphs. Grouping paragraphs provide additional layout options, such as a sidebar.
l

l

l

To add a grouping paragraph, click New: Paragraph then Grouping Paragraph. Configure it as described below.
To add content to a grouping paragraph, click New: Content Paragraph, click a paragraph type, and edit it; see Content paragraphs.
To add a new separator, click New: Paragraph then Separator. Configure the separator;
see Separator paragraph. To add the separator to the newsletter, click Apply.

Main area
Parameter

Description

Layout
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:
Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Space Between

Specify the space (vertical and horizontal) between content paragraphs within a
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Parameter
Content Paragraphs

Description
grouping paragraph.

Border
Show

Select if you want to apply a border around the grouping paragraph.
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border Width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

Rounded
Corners

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Show must be selected for this parameter to be effective. The radius value is the
same as the padding value set for this paragraph. If no padding value is set, a
value of 10 pixels is assumed.
If you select this option, only a single value for border width is used. If more
than one value is defined, only the first one is used for all sides.

Background

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Image

The correct display of background images is not supported by all email clients.
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Parameter

Description
So, the background image should contain no important information.
If you use a background image, the parameters Alignment and Repeat
become effective. Note that background images are only visible at the border
areas and at free spaces. Otherwise, they are covered by content and other
backgrounds.

Alignment

Only effective if a background image is uploaded. Sets the alignment for the
whole newsletter. Alignment of the content elements is defined in the content
paragraphs.

Repeat

Only effective if a background image is uploaded. Repeats the background
image.

Background (mobile)
Show Background Image

Select this option to display the background image also in the mobile version of
the newsletter.

Fit Background
Image to Area

Select this option to automatically stretch or crop the background image to fill
the entire paragraph area.

Sidebar
Optionally, grouping paragraphs can be displayed in a two-column layout, with a main area
and a sidebar. The sidebar can contain the same content paragraphs as the main area.
Parameter

Description

Layout
Show

Select to show a sidebar in this grouping paragraph.

Width

The value cannot exceed the total width of the content area.

Position

The sidebar may appear to the left or the right of the main area.
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Parameter

Description
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Space Between
Content Paragraphs

Specify the space (vertical and horizontal) between content paragraphs within a
grouping paragraph.

Space Between
Sidebar and
Main Area

Specify the space between the sidebar and the main area.

Mobile

Position

In the mobile version, the sidebar is positioned above or below the main area,
due to the reduced available space. Select the desired position from the dropdown list.
This option is only in effect if the mobile version is activated in the general settings.

Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side individually.

Border Width
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:
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Parameter

Description
l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

Rounded
Corners

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Show must be selected for this parameter to be effective. The radius value is
the same as the padding value set for this paragraph. If no padding value is
set, a value of 10 pixels is assumed.
If you select this option, only a single value for border width is used. If more
than one value for border width be defined, only the first one is assumed for
all sides.

Background

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
The correct display of background images is not supported by all email clients.
So, the background image should contain no important information.

Image

If you use a background image, the parameters Alignment and Repeat
become effective. Note that background images are only visible at the border
areas and at free spaces. Otherwise, they are covered by content and other
backgrounds.

Alignment

Only effective if a background image is uploaded. Sets the alignment for the
whole newsletter. Alignment of the content elements is defined in the content
paragraphs.

Repeat

Only effective if a background image is uploaded. Repeats the background
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Parameter

Description
image.

Background (Mobile)
Show Background Image

Select this option to display the background image also in the mobile version of
the newsletter.

Fit Background
Image to Area

Select this option to automatically stretch or crop the background image to fill
the entire paragraph area.

Options
Parameter

Description

Layout
Background
Color (Outer
Area)

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Description

Target Groups

To show this paragraph to one or more target groups only, select them. If more
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Parameter

Description
than one target group is selected, just one must match (OR logic). See Target
groups.
Note: For paragraphs in the header and footer you cannot select target groups, because these elements are
considered mandatory in every mailing.

Content paragraphs
Within your mailing's Grouping paragraphs, you can insert the following types of content
paragraphs and fill them with content. To do this, click New: Content Paragraph and
select the desired type.
l

l

l
l
l

l

l

l
l
l

l

Product paragraph (legacy). Adds a paragraph with predefined fields for product details.
See also: General settings.
Product paragraph with content interface (legacy). Imports product data, such as offer texts

and product images, from your webspace or server into the Template Kit.
Content interface paragraph. Add items from your web shop to a mailing.
Source code paragraph. Enter HTML and a separate text version.
Text or image paragraph. Contains a text area and an image, which you can place relative to
a text block and headline.
Table of contents paragraph. Automatically creates a table of contents from the headlines

of content paragraphs or a grouping paragraph. It is placed in content paragraphs in the
newsletter. Content paragraphs excluded from the table of contents are ignored.
Image bar paragraph. Create a vertical or horizontal image bar with up to 10 images. The
images are scaled down automatically; so, the more images you include, the smaller each
image is displayed.
Separator paragraph. Only for structuring purposes; contains no content.
RSS feed paragraph. Load content from an RSS feed into your mailing.
Recommendations paragraph. Adds automatically generated individual
recommendations for each recipient through a URL. You need a software that generates
recommendations based on a recipient's actions.
Facebook paragraph. Integrate current Facebook posts into your message.
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l

Twitter paragraph. Integrate current tweets into your message.

l

Navigation menu. Creates navigation bars with links to landing pages or deep links.

Product paragraph (legacy)
Use the product paragraph to add items from your web shop to a mailing. The paragraph
contains input fields for:
l
l
l
l
l
l

Product name
Description
Category
Old price
Current price
Manufacturer

Define the order of the fields in the general settings. You can use your own categories
instead of the standard categories. In this case, contact customer support before setting up
the template.
Product paragraph fields have no formatting by default. To manually edit the paragraph,
use the editor. Or, when using a content interface, use HTML, which can be transferred
together with the contents.

Creating a product paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Product.

3. In the configuration window, click Apply. The new product paragraph appears in the
preview window on the left.

Configuring a product paragraph
1. On the left, in the menu bar of the product paragraph, click Product. The configuration
window opens on right.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Image

l

Button
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l

SWYN

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Content
Heading

Enter a heading for this paragraph.

Name

Enter a product title or a work title.

Category

Enter a product category or a genre.

Author/Artist/Manufacturer

Enter the name of the author, artist, or manufacturer.

Text

Enter a product description or an abstract of a work.

Old Price

If you want to create a promotional campaign, a bargain, or a special offer, enter product's old price.

Current Price

Enter the product's current price.

Show in Desktop Version

Select to include this paragraph in the desktop mailing.

Show in Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate mobile version setting in the general settings
must be activated for this option to take effect.

Show in Text Version

Select to show the paragraph in the text version of the mailing.

Link
Text

Text entered here is linked to the URL below.
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Parameter

Description

URL

This could be a landing page or a product details page from your
web shop.

Alignment

The link can be aligned right, left, or center.

Image
Parameter
Image

Alternative
Text

Description
Upload an image or enter an image URL in the field Alternatively External URL
that points to the image file.
This text is displayed if a recipient blocks or disables images in the email client, or
if the image cannot be displayed for another reason.
Enter alternative text containing a short description or title for the image.

Link

You can link the image to a landing page or a page on your verbosity you entered
a text link in this paragraph, you should use the same link for the image.

Subtitle

Enter an optional image subtitle.

Position

You can place the image in a separate column next to the heading and text block,
or in a separate column next to the text block but below the headbanging most
cases, these positions are recommended.
If you use large images that cover the entire width of a paragraph or area, center them below the heading, the text, or the link.

Button
See Click2Go.
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SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
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Parameter

Description
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.
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Options
For each content paragraph, you can define a layout that is different from the general
newsletter layout.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Background
Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Border
Show

Check to apply a border around the paragraph.

© Optimizely 2022

Managing content | 429

Parameter

Description
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border Width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Table of Contents
Show in Table
of Contents

Select to display the paragraph in the table of contents for the section.

Alternative
Table of Contents Entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.
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Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Product paragraph with content interface (legacy)
Note: During setup, tell customer support the directory on your web
space or your server where you will store your product data. This directory must allow HTTP requests. If the product data directory is only
accessible with authentication, disable the authentication. If desired,
you can only allow specific IP addresses to access product data.
The product paragraph with content interface imports product data, such as offer texts
and product images, from your web space or server to the Template Kit. It lets you create
product offers in your merchandise management system then transfer them to the Template Kit. You can recommend products, offer discounts, provide notifications of new
releases, create a new product paragraph, and import product offers with just a few clicks.
You can store product data statically as XML files on your server, have your server dynamically generate XML files as requested by the content interface. Optimizely Campaign
retrieves your product data and makes it available to your messages.
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Tip: The content interface paragraph is the further development of
the product paragraph with content interface and supports both
CSV and XML formats.

Configuring the content interface
When the feature is enabled, a new button with a folder icon
of the product paragraph.

appears on the menu bar

Default values
The product paragraph can load the following product data through the content interface:
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1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

unique ID
name
category
authors/performers/manufacturers/providers
description
old price
current price
URL link to the product, such as in your web shop
text label for the URL link, for example, "Book now"
an image URL, for displaying a product image

The following image shows the individual components of a sample product offer.

Making product data available as XML
An HTTP request is used to load product data from your web space or server to the Template Kit and start the import into Optimizely Campaign.
When the request is made, your product data must:
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l

exist on your web space or server as an XML file (static product data)
or

l

be generated dynamically in an XML format (dynamic product data)
Tip: Your company's environment determines whether you import
static or dynamic product data. Contact your system administrator to
learn which implementation is in use.

Saving static product data as XML on the server
To save product data statically as XML files on your webspace or server, each product
must be saved in an XML file. You cannot group multiple products into a single XML file. To
save a product as an XML file, perform the following steps.
1. Open a text editor, such as Notepad (Windows) or Textedit (macOS/OS X).
2. Create a new document.
Warning: Set your text document to use UTF-8 character encoding. If you use another encoding, the text may not be represented
properly.
3. Copy the following code into the document.
Code sample
<element>
<property name="id"><![CDATA[123456]]></property>
<property name="name"><![CDATA[Name]]></property>
<property name="category"><![CDATA[Category]]></property>
<property name="manufacturer"><![CDATA[Author/Artist/Manufacturer]]></property>
<property name="text"><![CDATA[Product description]]></property>
<property name="oldPrice"><![CDATA[<s>EUR 29.99</s>]]></property>
<property name="currentPrice"><![CDATA[<b>EUR 19.99 EUR</b>]]></property>
<property name="linkText"><![CDATA[Add to shopping cart]]></property>
<property name="linkUrl"><![CDATA[http://www.example.com/product/123456]]></property>
<property name="imageUrl"><![CDATA
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[http://img.example.com/product/123456.jpg]]></property>
</element>

Tip: The following steps guide you through customizing this code
for your setup. Only product ID (in code, the property id) and
product name (in code, the property name) are mandatory. Other
values are optional. Delete any unused values.
Example: You do not want to specify product manufacturer, so
delete the following line:
<property name="manufacturer"><![CDATA[Author/Artist/Manufacturer]]></property>

Alternatively, leave unneeded lines of code empty. For example,
you want to enter the information later. If you do not want to specify the product manufacturer and want to leave the code in the
document, the line looks like this:
<property name="manufacturer"><![CDATA[]]></property>

Tip: You can use HTML source code in these properties: name,
category, manufacturer, text, oldPrice, currentPrice. For
example, you want to insert links into the product description.
4. In the first property row, enter the product ID between the square brackets after
CDATA.
Example: The product ID is ParisTrip01.
<property name="id"><![CDATA[ParisTrip01]]></property>

Note: Use only alphanumeric characters (letters and numbers) in
the product ID. If you use special characters, you may encounter
problems importing product data.
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5. In the second property line, enter the product name between square brackets after
CDATA.
<property name="name"><![CDATA[Unwind in Paris]]></property>

6. In the third property line, enter the product category between square brackets after
CDATA.
<property name="category"><![CDATA[City travels]]></property>

7. In the fourth property line, enter the product manufacturer (or, depending on product,
author, artist, operator, manufacturer, and so on) between square brackets after
CDATA.
<property name="manufacturer"><![CDATA[Sun Worshipers Travel]]></property>

8. In the fifth property line, enter the product description, for example text and a website
link, between the square brackets after CDATA.
<property name="text"><![CDATA[Eiffel Tower, Champs-Élysées, Louvre: Treat
yourself to some time out in Paris!”]]></property>

9. In the sixth property line, enter the product 's old price between <s> and </s>.
<property name="oldPrice"><![CDATA[<s>EUR 399</s>]]></property>

Note: The old price is crossed out by default. To omit the strikethrough in your communications, delete <s> and </s>.
10. In the seventh property line, enter your product's current price between <b> and </b>.
<property name="currentPrice"><![CDATA[<b>EUR 299</b>]]></property>

Note: By default, the current price is displayed in bold. To omit
the bold, delete <b> and </b>.
11. In the eighth property line, enter a text label for a product link between the square
brackets after CDATA.
<property name="linkText"><![CDATA[Book now]]></property>
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12. In the ninth property line, enter the URL link to your product between the square brackets after CDATA.
<property name="linkUrl"><![CDATA[http://www.sonnenhungrig.com/paris]]></property>

13. In the tenth property line, enter the URL to your product image between the square
brackets after CDATA.
<property name="imageUrl"><![CDATA[http://www.sonnenhungrig.com/eiffeltower.jpg]]></property>

14. Save the text document. For the file name, use the product ID (the value you inserted
for the id property). For file type. use .xml.
15. Delete the document's file extension. For example, if the document is named ParisTrip01.xml, rename the file as ParisTrip01.
Warning: If you do not remove the file extension, your product
data cannot be loaded.
16. Save the document in your webspace or on your server in the directory that you communicated for the setup of the product paragraph with content interface.
Warning: Do not change the location of the product description
documents without consulting customer support. If you change
directories without consulting customer support, you cannot load
product data using the content interface.
After saving these documents, you can access your product offer in the Template Kit.
Follow the steps in Load and edit product data to upload your product offer into the
Template Kit using the content interface.
Generating dynamic product data on the server
XML files are not prepared manually, but are loaded from a database when requested (by
HTTP request) via the content interface and automatically generated as XML. If you want
to generate dynamic product data, see your system administrator.
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Loading and editing product data
After product data is made available as XML files in your webspace or on your server, and
customer support has stored your data source in your client, you can load product data into
the Template Kit. After the import is complete, you can edit the data in the Template Kit
using the content interface.
Loading product data
1. In the Template Kit, click New: Content Paragraph.

2. Click Product.
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3. In the configuration window, change no settings and click Apply. The new product
paragraph appears on the left, in the preview window.
4. In the menu bar of the new product paragraph, click Content Interface .
5. In the Content element box, enter the ID of the product offer that you want to load
into the Template Kit.
6. On the bottom right of the window, click Apply. When the import is completed, the
product offer appears on the left of the preview window.
Editing product data
If product offers were loaded from your webspace or server via the content interface into
the Template Kit, you can edit them there. The steps for doing this are the same as those
processing product paragraphs needing an extension through the content interface. See
Product paragraph.
Tip: If you use product paragraphs with an extension through the
content interface, you should make changes to product offers in your
system and update the product paragraphs in the Template Kit by
loading the changes. This ensures that your product offers are up to
date and that no outdated, modified content is loaded into the Template Kit later. To update a product paragraph, click Content interface
in the menu bar of the product paragraph, then Apply.

Warning: The product paragraph with the content interface can be
configured by customer support so that your product offers are automatically updated on the ship date. This option is useful if your
products' prices often change between the time of message creation
and shipping. If this option is configured for you, any changes to your
product offers must be made on your system. If you only perform
changes in the Template Kit, they are overwritten on the shipping
date with the old content from your webspace or server.
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Editing HTML layouts
The product paragraph with the content interface provides a default layout for formatting
offer text and images.
Note: To receive an alternate layout customized to your products
and services, contact customer support.

Standard layout
You can change the order of components in your product offer in the default layout. For
example, you can determine whether the current price should be shown first followed by
the old one, or whether the product manufacturer should appear before the product category.
To change the order of product offer components in a default layout, perform the following
steps:
1. In the Template Kit, click Settings. The settings window opens on the right.
2. Click the Products tab.
3. In the Order area, determine the order of product offer components by selecting from
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drop-down lists.
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Standard layout example

Alternate Layout
If customer support sets up an alternate layout, product offers are formatted according to
its specifications. You cannot change the order of components in an alternate layout. To
change an alternate layout, contact customer support.
Tip: If an alternate layout is set up, you cannot access the default layout.

© Optimizely 2022

442 | Optimizely Campaign User Guide 2022-03-14

Alternate layout example

Troubleshooting
This topic describes how to troubleshoot common errors that can arise while working with
the product paragraph with content interface.
Issue

Possible cause

Solution

Product data not loading

Product ID is entered
incorrectly.

Enter the correct product ID.

Product data not loading

XML file has a file extension.

Remove the file extension.

Product data not loading

Corresponding product
offer no longer exists on
your webspace or server.

Save the product offer again on your webspace or server.

Product data not loading

Product data saved in
wrong directory on server
or webspace.

Transfer the product data you are trying
to load to the directory indicated when
setting up the content interface.

Product data not load-

Directory in which the

l
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Issue

Possible cause

Solution
able only after prior authentication
and disable authentication.

ing

product data is stored is
not available.

Some content not loading. For example, the
product image is missing.

Error in XML code you
generated.

Correct the XML code.

Special characters not
displayed correctly,
such as German
umlauts.

Incorrect character encoding in XML.

Set encoding of XML file to UTF-8.

l

Check whether there is a problem
with your server or webspace. Try loading product data again later.

Tip: If the problem continues after you try all suggested solutions,
contact customer support.

Content interface paragraph
Note: To enable this feature, contact customer support.
The content interface paragraph imports product data, such as offer texts and product
images, from your e-commerce system into the Template Kit. Whether Optimizely Commerce, Magento, in-house software development by your company, or another system, the
content interface paragraph is flexible and supports a variety of data sources.
Tip: To learn about importing Optimizely Commerce catalog data,
see Exporting Optimizely Commerce catalog data to Optimizely Campaign.
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The technical implementation supports the open XML standard and CSV file format –
many data sources support both formats.
Export product data from your data source and let Optimizely Campaign process it. In the
Template Kit, create a new content interface paragraph with individual items, then import
your current product offering with just a few mouse clicks.
Your data source can handle product data either by:
l
l
l

saving it as static XML files on your webspace or server
your server generating dynamic XML files when queried
saving product data as a CSV file on the server (both manually or automatically)
Tip: The content interface paragraph is the further development of
the product paragraph with a content interface and supports both CSV
and XML formats. You can use both file formats together.

Static and dynamic content
The content interface paragraph supports static and dynamic content.
l

l

Static content. Product data is loaded when you create the mailing. The data can then
be edited. If you integrate static content, all recipients receive the same content.
Dynamic content. The content is loaded when the message is being sent. You cannot
edit content in advance. However, you can send different product recommendations to
each recipient. For more information, see Dynamic CSV and XML articles.
Tip: You can use static content with dynamic content in the same
mailing. Customer support can advise you about combining content
types.

Paragraph types
There are four paragraph types. Only types enabled in your client appear in the Template
Kit.
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l
l
l
l

Static CSV article
Static XML article
Dynamic CSV article
Dynamic XML article

Setting up the content interface paragraph
To set up the content interface paragraph, provide customer support with the following
information:
l

XML or CSV, or XML and CSV together: Which format do you want for product data?
XML. In which directory on your webspace or server will you store product data? That
directory must allow HTTP requests. If the directory is only accessible with authentication, disable it. You can restrict access to product data to specific IP addresses.
o CSV. What will you call the CSV file to which your product catalog is saved? If you
update the product catalog later, you must save that version of the CSV under the
name given when setting up the content interface.
Static content, dynamic content or a combination of both content types: Do you want to
send the same content or customized product recommendations to your recipients?
o

l

After setup, the Content Interface paragraph type is available in the Template Kit.
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Updating mailing content prior to dispatch
Note: To enable this feature, contact customer support.
Days may pass between a mailing's creation date and its dispatch date. This delay can
cause content to be out-of-date, such as a product that is no longer available.
This add-on verifies the imported content in the mailing when it was created. Product
information is validated with the help of a unique product ID. Also, if a product is not available at dispatch, or if some information is incorrect, the add-on pauses sending.

Standard values of a product offer
The content interface paragraph can load the following product data:
1. the product’s unique ID (not displayed in the message)
2. up to 10 text elements per product offer, in which you can enter the heading for a
product offer, the product description, or the product price
3. up to 3 text links per product offer, such as calls to action (Buy now, Learn more, and so
on)
4. up to 6 product images per product offer (by entering a URL)
l

l

up to 6 links to product images (one link per image) that direct the recipient to
additional information by clicking the image
up to 6 alternative texts for product images in case a recipient cannot load product
images and to support accessible messages
Note: You can also transfer up to 20 additional datasets as metadata
for HTML layout program logic.

The following image shows the components of your product offer.
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Exporting product data with a CSV file
If you select CSV format, your product data is prepared in two steps:
1. Export product data from your e-commerce system or another data source into a CSV
file.
2. Move the CSV file to your personal directory on the server. Optimizely Campaign
retrieves the CSV file then makes its product data available in the Template Kit.
Tip: If you have a personal directory on the server but no login
information, contact customer support to set up a user account.
Export product data from your system as a CSV file. CSV files exported from different systems can differ widely. For example, names and column heading order can be different.
Such differences can create problems when importing product data. If no information is
provided about what the dataset columns contain (for example, the column that contains
the product name), Optimizely Campaign cannot read the CSV file properly nor correctly
classify the individual datasets.
But, if you use an Optimizely integration for one of these e-commerce systems, the content
interface can recognize CSV files with different structures and process them correctly :
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l

Magento

If you use Optimizely integration with one of these systems, you can export product data
using the Optimizely plug-in with no adjustment.
Note: If you do not use an Optimizely integration, you must use
Optimizely Campaign's generic CSV structure.

Generic CSV structure
Optimizely Campaign's generic CSV structure standardizes the structure and naming of
column headings in CSV files, ensuring the correct import of product data.
If your system/your data source has a feature that supports the export of datasets to a
CSV file (such as a plug-in), configure the CSV file with the following structure and column
headings:
"id";"name";"category";
"text1";"text2";"text3";"text4";"text5";
"text6";"text7";"text8";"text9";"text10";
"link1Text";"link1Url";
"link2Text";"link2Url";
"link3Text";"link3Url";
"image1ImageUrl";"image1AltText";"image1Link";
"image2ImageUrl";"image2AltText";"image2Link";
"image3ImageUrl";"image3AltText";"image3Link";
"image4ImageUrl";"image4AltText";"image4Link";
"image5ImageUrl";"image5AltText";"image5Link";
"image6ImageUrl";"image6AltText";"image6Link";
"additionalData1";"additionalData2";"additionalData3";"additionalData4";"additionalData5";
"additionalData6";"additionalData7";"additionalData8";"additionalData9";"additionalData10";
"additionalData11";"additionalData12";"additionalData13";"additionalData14";"additionalData15";
"addi-
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tionalData16";"additionalData17";"additionalData18";"additionalData19";"additionalData20";

Tip: Configuring an export feature generally requires programming.

Warning: When configuring the export feature, observe the following:
l

l
l
l

The CSV file must be RFC-compliant. Technical notes are contained in RFC
4180.
Set character encoding for the CSV file to UTF-8 without BOM.
Use the semicolon (;) as a separator.
If some product data includes quotation marks (inverted commas), mask them
with escape characters. Use the quotation mark " as the escape character. If
you do not mask quotation marks, they are misinterpreted as code, and the
product data import fails.
Example: You surround a word or a word group with quotation marks, such
as "Savoir Vivre." In your CSV file, wrap the quoted text with double quotation marks: ""Savoir Vivre"". The outer quotation marks are recognized as
escape characters so are not displayed in the message text.

Creating a CSV file manually
If your system/your data source does not have a feature for exporting product datasets to
a CSV file, and you want to manually create a CSV file with product data, perform the following steps:
1. Download the template for the generic CSV structure here: template generic structure.csv

2. Open the template using a spreadsheet program, such as Microsoft Excel or LibreOffice Calc.
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Note: When opening the template, if you need to enter a separator, select semicolon. If you need to specify character encoding, use UTF 8 without BOM. Some programs, such as Microsoft
Excel, do not provide UTF-8 without BOM. In that case, select
UTF-8.

Warning: When filling out the template in the generic CSV structure, you must observe the following:
If some product data includes quotation marks (inverted commas), mask them with escape characters. Use the quotation mark
" as the escape character. If you do not mask quotation marks,
they are misinterpreted as code, and the product data import
fails. Example: You surround a word or a word group with quotation marks, such as "Savoir Vivre." In your CSV file, wrap the
quoted text with double quotation marks: ""Savoir Vivre"". The
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outer quotation marks are recognized as escape characters so
are not displayed in the message text.
3. Begin entering product data in row 2. Enter the data for each product side by side (see
image).
Warning: Do not change the column headings or their order in
row 1. If you do, your product data cannot be loaded into the Template Kit.

To add another product offer, insert the data again side-by-side in the next row (see
image).

Template column
heading

Product data to enter

id

Enter the unique product ID. It is not shown in your messages. You
may only enter a product ID in the document once.

name

Enter a name for your product offer. Later, in the Template Kit, you
can select the product offer by its name to include it in your messages (static CSV article only). It is not shown in your messages.
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Template column
heading

category

Product data to enter

Enter the product category. It is not shown in your messages. With
the product category, you can create overview category trees in
the Template Kit and compile related products together to find
specific products (static CSV article only). Enter the subcategories
in this field, separated by hash symbols. Example: Mediterraneantravel#Italy#Sicily

Note: A category may have up to 10 subcategories.

Up to 10 text fields are available. Enter one piece of information in
each field. For example:
l

l

the name of the product to be shown in your message, such
as text2 in the text field

l

the description of your product, such as text3 in the text field

l

the old price of your product, such as text4 in the text field

l

text1 – text10

the heading for your product offer, such as text1 in the text
field

l

the current price of your product, such as text5 in the text
field
the supplier/manufacturer of your product, such as text6 in
the text field

You can choose what you want to enter in the text fields. Adapt
the content according to your wants and the requirements of your
product/your service.
It may be best to organize product offer components sequentially
from text1 through text10, which is how they are shown from top
to bottom in the finished product offer. If you are not sure of the
best order, contact customer support.
The formatting (text size and text color) of the text field content is
set later using an HTML layout.
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Template column
heading

Product data to enter

Enter the heading for the link or links to your product offer.
link1Text – link3Text

For example: Offer, More Information or Buy Now.

link1Url – link3Url

Enter links to pages to which recipients are directed if they click a
link (such as the corresponding product page in your web shop).

image1ImageUrl –
image6ImageUrl

Enter the URLs for the corresponding product images. The images
are loaded by Optimizely Campaign and displayed in your messages.

image1AltText –
image6AltText

Enter alternative text for images. This text appears if an image cannot be loaded.

image1Link –
image6Link

Enter a link to the product image. If the image is clicked, the recipient is forwarded to the link target. This can be your web shop or
another address that you want to connect to the image.
Avoid mixing up ImageLink with ImageURL, which indicates the
saved location of the image.

additionalData1 –
additionalData20

Enter additional data records that you can use, such as metadata
for the program logic of the HTML layouts.

4. Save and rename the file.
Warning: Give the file the name you entered for your CSV file
when setting up content interface paragraphs. If you use a different name, the product data import will fail. If you forgot the
name, contact customer support.

Note: When saving the file, make sure the spreadsheet program
does not assign a new file type. The file must have the file type
CSV or file extension .csv.
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Transferring the CSV file to the Optimizely server
After you save the completed and renamed CSV template, transfer it to your personal directory on the Optimizely server.
Tip: If you use an Optimizely integration for Magento, or OXID, the
transfer is automatic. If you do not use an Optimizely integration, but
want to automate the transfer, use a script. Consult your system
administrator or software service provider for a programming solution.
To transfer the completed and renamed Optimizely template in your directory to the
Optimizely server, perform the following steps:
1. Log in to the Optimizely server with your user data.
Tip: If you do not have a user account for the Optimizely server,
contact customer support. See FTP API (Windows) for information
about logging in to the Optimizely server; see FTP API (macOS/OS
X) for macOS.
2. Upload the Optimizely template to your personal directory on the Optimizely server.
Warning: If you have multiple directories on the Optimizely
server, save the template in the directory set up for your CSV files
during the configuration of the content interface. If you save the
template to another directory, your product data import fails.
After you load the completed and renamed template into the correct directory, your
current product offers are available in the Template Kit for integration into your messages.
Note: It can take some time for your product offers, transferred
as a CSV file, to be available in the Template Kit. You should
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automatically perform the data transfer at night.

Loading and editing static CSV product data
If you saved product data as a CSV file in your personal directory on the Optimizely server,
you can load product offers into your messages and edit them as necessary in the Template Kit within a static CSV article. See general settings to change content interface paragraph settings. To integrate dynamic product data into the Template Kit, see Dynamic CSV
and XML articles.
Loading product data
1. While editing a message in the Template Kit, click New: Content Paragraph.
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2. Click Content Interface.

3. Change no settings in the configuration window. Click Apply. The new paragraph
appears on the left in the preview window, and the Content Interface Article button
appears below the new paragraph.
Tip: Your product offers are created as content interface articles,
which are subparagraphs of the content interface paragraphs.
4. Create a new content interface article by clicking Content Interface Article on the
left. The configuration window for that article opens.
5. Change no settings in the configuration window. Click Apply. To the left of the preview
window, the menu for the content interface article expands to include the button Content Interface .
6. Click Content Interface . The Load Content window opens on the right.
7. In the list, select the product offer to load into your message and click Apply. When
the loading is complete, the product offer appears on the left of the preview window.
Tip: To load additional product offers, create a new content interface article for each additional offer.
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Editing product data in content interface article
Once your product offer is loaded into your message, you can edit the offer in the Template Kit. To do this, perform the following steps:
1. On the left of the preview window, in the menu for the corresponding content interface
article, click Static CSV Article. The configuration window for that article opens.
2. Make your changes and click Apply.
Warning: Do not change the layout template if you lack
advanced HTML and CSS skills. Doing so can lead to errors, which
means that your product offers will not display properly. If you
want to modify the layout template but lack HTML and CSS skills,
contact customer support.
Edit the content of your product offers in the CSV file. Then, re-upload the modified
CSV file to the server. This ensures that your product offers are up-to-date and that no
old, subsequently modified content in the CSV file is loaded into the Template Kit.
To update an existing content interface article, go to the article's menu bar, click Content Interface , select the appropriate product offer again, and click Apply.
Warning: Customer support can configure the content interface
paragraph so that product offers are updated at dispatch by comparing it with your CSV file. If this option is configured, changes
to product offers must be made in the CSV file. If you only make
changes in the Template Kit, they are overwritten at dispatch
with old content from the CSV file.

Using XML
You can use the XML format for the content interface paragraphs. If you choose XML
(Extensible Markup Language), do not save your product data with the CSV solution on the
Optimizely server. Instead, Optimizely Campaign retrieve product data from your web
space or server using a HTTP request.
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When the request is made, your product data must:
l

exist on your web space or server as an XML file (static product data)
or

l

be generated dynamically in an XML format (dynamic product data)
Tip: Your company's environment determines whether you import
static or dynamic product data. Contact your system administrator to
learn which implementation is in use.

Saving static product data on the server
To save product data statically as XML files on your webspace or server, each product
must be saved in an XML file. You cannot group multiple products into a single XML file. To
save a product as an XML file, perform the following steps.
1. Open a text editor, such as Notepad (Windows) or Textedit (macOS/OS X).
2. Create a new document.
Warning: Set your text document to use UTF-8 character encoding. If you use another encoding, the text may not be represented
properly.
3. Copy the following code into your document.
Code to copy
<?xml version="1.0" encoding="UTF-8"?>
<element>
<property name="id">123456</property>
<property name="text1"><![CDATA[<b>Text field 1</b>]]></property>
<property name="text2"><![CDATA[Text field 2]]></property>
<property name="text3"><![CDATA[Text field 3]]></property>
<property name="text4"><![CDATA[Text field 4]]></property>
<property name="text5"><![CDATA[Text field 5]]></property>
<property name="text6"><![CDATA[Text field 6]]></property>
<property name="text7"><![CDATA[Text field 7]]></property>
<property name="text8"><![CDATA[Text field 8]]></property>
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<property name="text9"><![CDATA[Text field 9]]></property>
<property name="text10"><![CDATA[Text field 10]]></property>
<property name="link1Text"><![CDATA[Text for link 1]]></property>
<property name="link1Url"><![CDATA[URL for link 1]]></property>
<property name="link2Text"><![CDATA[Text for link 2]]></property>
<property name="link2Url"><![CDATA[URL for link 2]]></property>
<property name="link3Text"><![CDATA[Text for link 3]]></property>
<property name="link3Url"><![CDATA[URL for link 3]]></property>
<property name="image1ImageUrl"><![CDATA[Image URL for image 1]]></property>
<property name="image1AltText"><![CDATA[Alternative text for image
1]]></property>
<property name="image1Link"><![CDATA[Link for image 1]]></property>
<property name="image2ImageUrl"><![CDATA[Image URL for image 2]]></property>
<property name="image2AltText"><![CDATA[Alternative text for image
2]]></property>
<property name="image2Link"><![CDATA[Link for image 2]]></property>
<property name="image3ImageUrl"><![CDATA[Image URL for image 3]]></property>
<property name="image3AltText"><![CDATA[Alternative text for Image
3]]></property>
<property name="image3Link"><![CDATA[Link for image 3]]></property>
<property name="image4ImageUrl"><![CDATA[Image URL for image 4]]></property>
<property name="image4AltText"><![CDATA[Alternative text for image
4]]></property>
<property name="image4Link"><![CDATA[Link for image 4]]></property>
<property name="image5ImageUrl"><![CDATA[Image URL for image 5]]></property>
<property name="image5AltText"><![CDATA[Alternative text for image
5]]></property>
<property name="image5Link"><![CDATA[Link for image 5]]></property>
<property name="image6ImageUrl"><![CDATA[Image URL for image 6]]></property>
<property name="image6AltText"><![CDATA[Alternative text for image
6]]></property>
<property name="image6Link"><![CDATA[Link for image 6]]></property>
<property name="additionalData1"><![CDATA[Additional information 1]]></property>
<property name="additionalData2"><![CDATA[Additional information 2]]></property>
<property name="additionalData3"><![CDATA[Additional information 3]]></property>
<property name="additionalData4"><![CDATA[Additional information 4]]></property>
<property name="additionalData5"><![CDATA[Additional information 5]]></property>
<property name="additionalData6"><![CDATA[Additional information 6]]></property>
<property name="additionalData7"><![CDATA[Additional information 7]]></property>
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<property name="additionalData8"><![CDATA[Additional information 8]]></property>
<property name="additionalData9"><![CDATA[Additional information 9]]></property>
<property name="additionalData10"><![CDATA[Additional information 10]]></property>
<property name="additionalData11"><![CDATA[Additional information 11]]></property>
<property name="additionalData12"><![CDATA[Additional information 12]]></property>
<property name="additionalData13"><![CDATA[Additional information 13]]></property>
<property name="additionalData14"><![CDATA[Additional information 14]]></property>
<property name="additionalData15"><![CDATA[Additional information 15]]></property>
<property name="additionalData16"><![CDATA[Additional information 16]]></property>
<property name="additionalData17"><![CDATA[Additional information 17]]></property>
<property name="additionalData18"><![CDATA[Additional information 18]]></property>
<property name="additionalData19"><![CDATA[Additional information 19]]></property>
<property name="additionalData20"><![CDATA[Additional information 20]]></property>
</element>

Note: The following steps guide you through customizing this
code for your setup. Only product ID (in code, the property id) is
mandatory. Other values are optional. Delete any unused values.
4. In the first property row, enter the product ID . Insert your product ID between the
brackets.
Example: Your product has the product ID "FR123". <property namee="id">FR123</property>

Note: Use only alphanumeric characters (letters and numbers) in
the product ID. If you use special characters, you may encounter
problems importing product data.
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Tip: In all steps below, you insert the value between brackets,
after CDATA.
5. In the 2nd through 11th property rows (text1 through text10), enter up to ten text elements for your product offer. "Text field 1", "Text field 2", "Text field 3" and so on are
entered as placeholders for your text elements.
The text elements can include things such as the heading for the product offer, the
product name, the product category, the product description, the old price, the current price, the manufacturer/supplier, and so on. Adapt the content to your needs and
your product or service's requirements.
Example: The header of the product offer is: Relax in Paris. <property namee="text1"><![CDATA[Relax in Paris]]></property>

Tip: It is best to organize product offer components sequentially,
from text1 through text10, which is how they are shown in the finished product offer. If you are not sure what order is best for you,
contact customer support. The formatting (text size and text color)
of the text field content is set separately using an HTML layout.
6. In the 12th property row, enter the heading for the link to your product offer. For
example: Offer, More Information or Buy Now.
Example: The link text is: Book now. <property name="link1Text"><![CDATA[Book
now]]></property>

7. In the 13th property row, enter the URL that leads to the product page in your web
shop.
Example: The URL of the product page is http://www.sonnenhungrig.com/paris: <property name="link1Url"><![CDATA[http://www.sonnenhungrig.com/paris]]></property>

8. In the property rows 14 through 17, if your product offer needs more than one link, enter
two additional links and link texts. Enter the information as specified in steps 6 and 7.
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Tip: Example: Next to the link to the booking page for the Paris
trip, another link leads to the current weather in Paris.
9. In the 18th property row enter the URL to the product image. Optimizely Campaign
loads the product image using that URL and shows it in your message.
Example: The URL of the product image is "http://www.sonnenhungrig.com/eiffeltower.jpg". <property name="image1ImageUrl"><![CDATA
[http://www.sonnenhungrig.com/eiffeltower.jpg]]></property>

10. In the 19th property row, enter the alternative text for your product image. An alternative text is the text that is shown when an image cannot be loaded. Enter alternative
texts, because visually impaired people can read these using special programs, promoting an accessible Internet.
Example: The alternative text for your product is "The Eiffel Tower in Paris in springtime". <property name="image1AltText"><![CDATA[The Eiffel Tower in Paris
in springtime]]></property>

11. In the 20th property row, enter a URL for the product image. If a recipient clicks on the
image, he or she is led to the associated URL. This can be your web shop or also any
other address that you want to connect to the image.
Warning: To display the image in messages, be certain that you
are using the ImageURL, which indicates the image's saved location. The ImageLink, on the other hand, directs the recipient to
the link target, which has additional information.
Example: The URL associated with your product image is: "http://www.sonnenhungrig.com/sightsinfrance". <property name="image1ImageUrl"><![CDATA
[http://www.sonnenhungrig.com/sightsinfrance]]></property>

12. In the property lines 21 through 35, up to five additional URLs for the locations where
the product images are stored can be entered, and five additional alternative texts and
five additional links that direct the recipient to the link target when clicked. This
means: Up to six product images, each with an alternative text and a link can be associated with each product offer. Enter the information as specified in steps 9 and 11 of
this manual.
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13. In the property lines 36 to 55, enter additional data records that you can use, such as
metadata for the program logic of the HTML layouts.
14. Save the text document. For the file name, use the product ID (the value you inserted
for the id property). For file type, use .xml.
15. Delete the document's file extension. For example, if the document is named ParisTrip01.xml, rename the file as ParisTrip01.
Warning: If you do not remove the file extension, your product
data cannot be loaded.
16. Save the document in your webspace or on your server in the directory that you communicated for the setup of the product paragraph with content interface.
Warning: Do not change the location of the product description
documents without consulting customer support. If you change
directories without consulting customer support, you cannot load
product data using the content interface.
When you have saved your text document in your web space or on your server, you
can access your product offer in the Template Kit. Follow the individual steps in the
Static XML article section to upload your product offer into the Template Kit using the
content interface.
Generating dynamic product data on the server
The preparation of dynamic product data generally follows the same scheme as static
product data, but the XML files are not prepared manually. Instead, they are loaded from a
database when called (by HTTP request) via the content interface and automatically generated as XML. Your company needs to program this process. To generate dynamic
product data, consult your system administrator.
Note: When performing the configuration:
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1. The XML feed must be UTF-8 encoded.
2. The product ID must be positioned at the end of the URL.
Correct: http://request.example.com/product?id=123456789
Incorrect: http://request.example.com/product/123456789/data

Loading and editing static XML product data
When your product data is available as XML files in your web space or on your server, you
can load the data into the Template Kit, then edit it. See general settings to change content
interface paragraph settings. If you want to integrate dynamic product data into the Template Kit, see Dynamic CSV and XML articles.
Loading product data
1. In the Template Kit, click New: Content Paragraph.
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2. Click Content Interface.

3. Do not change settings in the configuration window. Click Apply. The new paragraph
appears on the left, in the preview window.
Tip: Product offers are created as content interface articles,
which are subparagraphs of content interface paragraphs.
4. Create a new content interface article by clicking Content Interface Article on the
left of the preview window. The configuration window opens.
5. Change no settings in the configuration window. Click Apply. On the left side of the
preview window, the menu bar for the content interface article expands to include the
button Content Interface .
6. Click Content Interface . The Load Content window opens on the right.
7. In the Content Element box, enter the ID of the product offer that you want to load
into the Template Kit.
8. On the bottom right of the window, click Apply. Your product data is loaded via the
content interface from your webspace or your server into the Template Kit. When the
import is complete, the product offer appears on the left of the preview window.
Editing XML product data in content interface article
If your product offer is loaded into your message, you can later edit it directly in the Template Kit. To do this, perform the following steps:
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1. On the left side of the preview window, in the menu bar for the corresponding content
interface article, click Static XML Article. On the right, a window for selecting the
paragraph type opens.
2. Make changes and confirm them by clicking Apply.
Warning: Do not change the layout template if you lack advanced
HTML and CSS skills. Doing so can lead to errors, which means that
your product offers will not display properly. If you want to modify
the layout template but lack HTML and CSS skills, contact customer
support.
If you update the content of product offers in the XML file, you can re-upload the modified
file to the server. This ensures that your product offers are up-to-date and that no old, subsequently-modified content in the XML file is loaded into the Template Kit.
To update an content interface article, open the article's menu bar, click Content Interface , enter the corresponding product ID, and click Apply.
Warning: Customer support can configure the content interface paragraph so that product offers are updated at dispatch by comparing it
with your CSV file. If this option is configured, changes to product
offers must be made in the CSV file. If you only make changes in the
Template Kit, they are overwritten at dispatch with old content from
the CSV file.

Dynamic CSV and XML articles
You can send personalized product recommendations with dynamic CSV and XML articles.
Product data is loaded from the CSV or XML source for each individual recipient while
sending.
Note: URLs that reference image files are dynamically inserted into
the mailing during dispatch. Ensure that your server can handle a
large number of requests when the mailing is sent.
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Prerequisites
l
l

Dynamic CSV articles and/or XML items are enabled in your client.
For CSV product data source, see Exporting product data with a CSV file. For XML source,
see Using XML.

Creating a mapping reference
When sending the message, Optimizely Campaign uses the product ID from the mapping
reference to load product data from the data source. This loads different products into the
message for each recipient.
To send a different product to each recipient, create a mapping reference that lists
product recommendations for each recipient using the product ID. There are two ways to
create a mapping reference:
l

l

Recipient list. Import the product IDs to be mapped into a recipient list field in your recipient list.
Mapping file. Create a CSV file that contains the recipient ID of each mailing recipient on
a separate line. Add to each recipient ID an additional column that specifies the product
ID to be mapped.
Structure of the mapping file
A

B

recipient1@example.com

ProductID001

recipient2@example.com

ProductID002

recipient3@example.com

ProductID003

and so on

and so on

Warning: If you enter several product IDs, leave no space after the
separator.
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Wrong: 001, 002, 003
Correct: 001,002,003

Using a recipient list as a mapping reference
1. To set up the recipient list field for mapping product IDs, contact customer support. Up
to 256 characters may be transferred to the recipient list field. If you want more, tell
customer support.
Several methods (including CSV file import and SOAP API) are available for importing
recipient-specific product IDs to recipient lists.
2. Transfer product IDs to the recipient list.

Using a mapping file as a mapping reference
1. Create a CSV file whose first column contains recipient IDs. Each ID must be on a new
line.
2. In the second column, enter the product IDs for each recipient.
3. Transfer the mapping file to the server, in the mapping file location specified when you
set up dynamic articles.
Tip: Alternatively, use the Upload file feature, located in the
Optimizely Campaign menu under More. (To enable this feature,
contact customer support.)

Creating dynamic CSV and XML articles
1. To create a dynamic CSV or XML article, in the Template Kit, create a new content paragraph by clicking New: Content Paragraph.
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2. Select the content interface paragraph type by clicking Content Interface.

3. Click Apply. A new content paragraph of type content interface is created. On the left
of the preview is the Content Interface Article button.
4. Click Content interface article. A new content interface article is created. The configuration window for the article opens.
Configuring dynamic CSV and XML articles
After you create a dynamic CSV or XML article, configure it by following these steps:
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Recipient list as the mapping reference
1. On the right of the content interface article configuration window, open the Recipient
List tab.

2. In the Recipient List Field box, enter the name of the recipient list field that contains
the product ID. Enclose the name with curly brackets: {Name}.
3. If multiple product IDs are contained in the recipient list field, enter the separator used
between product IDs.
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Note: If you enter nothing, a comma is assumed.
4. If the recipient list field contains multiple product IDs, enter the position number of the
product to be loaded.
For example, your recipient list field contains three comma-separated product IDs:
"001,002,003." To select the product with the ID "003", enter position number "3,"
because the product ID "003" is in the third position. If you do not enter a position number, the product in the first position is selected automatically.
5. Click Apply. To the left of the preview, you see configuration data on the content interface article. When the message is sent, product data is loaded from the data source
using this configuration.

Mapping file as a mapping reference
1. On the right of the content interface article configuration window, open the Mapping
File tab.
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2. In the File name box, enter the name of the mapping file.
3. In the Recipient list field that contains the recipient ID (internal name) box, enter
the internal name of the recipient list field. If you do not know the internal name, contact customer support.
4. If the mapping file in the product ID column contains multiple product IDs, enter the
position number of the product to be loaded.
For example, Your recipient list field contains three comma-separated product IDs:
"001,002,003." To select the product with the ID "003", enter position number "3,"
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because the product ID "003" is in the third position. If you do not enter a position number, the product in the first position is selected automatically.
5. Click Apply. To the left of the preview is the configuration data on the content interface article. When the message is sent, product data is loaded from the product data
source using this configuration.

General settings
You create individual product offers as content interface articles, which are subparagraphs
of the content interface paragraphs. Within a single message, you can create multiple content interface paragraphs, using multiple lower-level content interface articles. To apply
changes to a higher-level content interface paragraph, perform the following steps:
In the left side of the preview, click Content Interface in the menu bar of the content
interface paragraph. On the right side, the configuration window for general settings for
the content interface paragraphs open.
See the following tables to set options in the corresponding tabs. Click Apply to confirm
your settings.
General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Show in
desktop version

Select to include this paragraph in the desktop mailing.

Show in mobile
version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in text

Select to show the paragraph in the text version of the mailing.
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Parameter

Description

version
Link
Text

Enter text to describe the link.

URL

Enter a link (such as a landing page for the product group).

Alignment

You can position the link on the right, the left or center.

Button
See Click2Go.
SWYN
You can activate sharing via social networks (SWYN) for each content paragraph. To allow
sharing of these paragraphs in a social network, select the Show check box for the network
in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
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Parameter

Description
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
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Parameter

Description

Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.

Options
You can give each content paragraph a different appearance from the general layout. To
do so, use the layout configuration in this tab.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

The paragraph is displayed over the entire height as standard, taking into
account the content. Alternatively, you can specify a fixed height value here. If
the content exceeds this height, the value is ignored and the content displayed
at the corresponding height.

© Optimizely 2022

Managing content | 477

Parameter
Background
color

Description
The depiction of non-hex web colors may vary from the original, depending on
the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Spacing
between the articles

A space with this height is placed between articles. By default, the first number
in the Padding option is used. This option is enabled only when using the default
layout.
Select Same as image quality in template settings to use the image quality specified under Settings > General. The Normal and High-resolution
options allow you to set the image quality independently of the template settings.

Image quality
If High-resolution is selected, the uploaded image must be at least double
the width of the image in the mailing. Example: For a 640 pixel wide image in
the mailing you need an image with a width of 1280 pixels. This ensures that
images do not lose sharpness during rendering of the mailing.
Layout

Set the general settings for the article layouts in the general settings. If there is
no content available for the selected layout, the default layout is used.

Border
Show

Select if you want to apply a border around the paragraph.

Border width

Enter the thickness of the border. You can set thickness for each side individually.
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Parameter

Description
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:
l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).
Color

The depiction of non-hex web colors may vary from the original, depending on
the browser.

Mobile

Width

Set the width (in percent; 100% default) of the paragraph in the mobile view. If
you want two paragraphs to be displayed next to one another in the mobile view,
set their widths so they combine to 100%. Otherwise, the two paragraphs are displayed on top of one another with the allocated widths.

Table of contents
Show in table of
contents

Select to display the paragraph in the table of contents for the section.

Alternative
table of contents entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.

Click profiles
Parameter
Click profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.
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Target groups
Parameter

Target groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic) .See Target
groups.

HTML layouts
The content interface paragraph has a default layout for formatting offer texts and images.
You can additionally set up up to 5 alternate layouts. For alternate layouts, contact customer support.
If you have advanced HTML and CSS skills, you can set up alternate HTML layouts yourself. If no alternate layouts are saved for the mobile and text versions, the default layout is
used.
Note: In some cases, some text elements will not be in the desired
order.

Sample default layout
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Sample alternate layout

Selecting a layout
1. To select a standard or alternate layout, while editing a message in the Template Kit,
look at the left side of the preview. On the content interface paragraph to which your
product offer belongs, click Content interface. The configuration window opens on
the right.
2. Open the Options tab.
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3. In the Layout area, in the Layout drop-down list, select the layout you want to use.

4. Click Apply. On the left side of the preview, the formatting of your product offer
changes accordingly.
Editing a layout
You can edit alternate layouts at any time. You cannot change the default layout.
Warning: Editing alternate layouts without advanced HTML and CSS
skills can lead to severe errors in your messages.
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1. On the left side of the preview, click Settings.
2. Open the Content Interface tab. Each layout has source text fields for the desktop,
mobile, and text version.

3. Edit the layout source code as desired.
4. Click Apply.

Troubleshooting CSV and XML
This topic describes how to troubleshoot common errors that can arise while working with
the content interface paragraph.
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CSV troubleshooting
Issue

Possible cause

Solution

Product data does not load
or loads incorrectly

Semicolons were not used as
separators.

Change the separating characters in your CSV file to semicolons.

Product data does not load
or loads incorrectly

Quotation marks in texts were
not masked with an escape
character and were erroneously interpreted as code.

Mask quotation marks in texts
with the escape character " (with
an additional quotation mark for
each quotation mark).

Product data was loaded
incorrectly

The CSV file is not encoded as
UTF-8 without BOM.

Encode the CSV file as UTF-8
without BOM or UTF-8.

Product data was loaded
incorrectly

One or more HTML layouts contain incorrect source text.

Correct the source text. If you do
not have advanced HTML and
CSS skills, contact customer support.

Product data is not loading

The CSV import is not (yet) performed.

Contact customer support so that
they can review the CSV import.

Product data is not loading

The CSV file is saved in the
wrong directory on the server.

Transfer the CSV file to the directory you indicated when setting up the content interface.

Product data is not loading
and a server error message
appears.

The CSV file path is incorrect.

Contact customer support.

The content interface paragraph type is not available.

The feature was not activated.

Contact customer support.

Components of a product
offer are not being shown.
For example, a product
image is not displayed.

The source text of the HTML
layout contains invalid code.
For example, a tag is not
closed.

Contact customer support. If you
have advanced HTML and CSS
skills, correct the source text.
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Issue

Possible cause

Links are not being tracked

Solution
Enter the link in a link field. Links
placed into a standard text field
cannot be tracked.

You entered the link into a
standard text field.

XML troubleshooting

Issue

Possible
cause

Solution

Product
data is not
loading

The product
ID is entered
incorrectly.

Enter the correct product ID.

Product
data is not
loading

The saved
XML file has a
file extension.

Remove the file extension.

Product
data is not
loading

The corresponding
product offer
no longer
exists on your
webspace or
server.

Save the product offer again on your webspace or server.

Product
data is not
loading

The product
data is saved
in the wrong
directory on
the server or
webspace.

Transfer the product data you are trying to load into the directory
that you indicated when setting up the content interface.

Product
data is not
loading

The product
ID is not positioned at the
end of the
URL.

Change your system configuration so that the product ID is positioned at the end of the URL.
Correct: https://www.example.com/products/?id=123456789

© Optimizely 2022

Managing content | 485

Issue

Possible
cause

Solution

Incorrect: https://www.example.com/products/?id=123456789?param1=XY?param2=abc
Some content is not
loading. For
example,
the product
image is
missing.

Error in the
XML code
you generated.

Correct the XML code.

The content
interface
paragraph
type is not
available.

The feature
has not been
activated for
you.

Contact customer support.

Components of a
product
offer are not
being
shown. For
example, a
product
image is not
displayed.

The source
text of the
HTML layout
contains
invalid code.
For example,
a tag is not
closed.

Correct the source text. If you do not have advanced HTML and
CSS skills, contact customer support.

Links are
not being
tracked

You entered
the link into a
standard text
field.

Enter the link in a link field. Links placed into a standard text field
cannot be tracked.
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Source code paragraph
You can enter HTML code in the source code paragraph. Email programs do not show
HTML to the full extent, so code entered here may lead to a faulty layout in your mailing.
The source code paragraph can be used by the Content interface paragraph, which you can
use to automatically fill in the content fields.

Creating a source code paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Source Code.

3. In the configuration window, click Apply. The newly created source code paragraph
will appear on the left side in the preview window.

Configuring a source code paragraph
1. On the left side of the preview, in the menu bar of the source code paragraph, click
Source Code.The configuration window opens on the right-hand side.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

HTML

l

Mobile

l

Text

l

Options

l

Click profiles

l

Target groups

HTML
Parameter
Source Code

Description
Enter HTML source code. Do not enter the HTML declaration, meta, or body tags.

© Optimizely 2022

488 | Optimizely Campaign User Guide 2022-03-14

Mobile
Parameter

Source Code

Description
Enter an alternative source code for the mobile version of the mailing. For this
option to take effect, you must activate the setting Activate Mobile Version in
the general settings.If the mobile version is activated and you enter nothing here,
the HTML tab's source code is used for the mobile version.

Text
Parameter

Text

Description
Enter the text for the text version of this paragraph. Do not use HTML or other
formatting. However, you can insert line breaks and special characters for separator elements (for example ***** or ++++++).

Options
You can define an individual layout, different from the general newsletter layout, for each
content paragraph.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Background

To define the color, enter a hexadecimal value preceded by # (such as

© Optimizely 2022

Managing content | 489

Parameter
Color

Description
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Border
Show

Check to apply a border around the paragraph.
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border Width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Mobile
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Parameter

Description
Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Width

Table of Contents
Show in Table
of Contents

Select to display the paragraph in the table of contents for the section.

Heading

Enter a heading to be displayed in the table of contents. If you leave the field
blank, the heading from the General tab is displayed.

Click profiles
Parameter
Click Profile

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Target Group

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic)see Target
groups.

Loading content via the content interface
If the content interface is activated for the source code paragraph in your client, you can
provide the content of the HTML, mobile, and text version in a CSV file and import them
into the source code paragraph. The CSV format cannot be changed.
Format the CSV file as follows:
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id;name;html;mobile;text 1;Source code 1;
<div class="html-version" style="background-color: #ff0000;">HTML version</div>;
"
<div class="mobile-version" style="background-color: #ff0000;">Mobile
version</div>";
Text version

To integrate the content in the source code paragraph, click the menu bar of the paragraph Open

and select the desired content in the right column.

Hints
l

l

l
l

The id and name columns are only used internally. Enter a name to help you identify the
paragraph in the editor.
The html, mobile and text columns can contain HTML source code that is added
unchanged to the source code paragraph.
Values must be CSV-compliant.
To format the content, you must have strong HTML knowledge, particularly of email. The
use of invalid or non-supported HTML code may lead to major display errors in the mailing.

Text/image paragraph
Use the text/image paragraph to add a text block or image to your mailing. You can also
position the elements relative to one another.

Creating a text/image paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Text/Image.

3. In the configuration window, click Apply. The newly created text/image paragraph
appears on the left of the preview window.

Configuring a text/image paragraph
1. On the left side of the preview, in the menu bar of the text/image paragraph, click Text/Image. The configuration window opens on the right side.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Image

l

Button
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l

SWYN

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Text

Enter text using the Rich Text Editor. You can use additional formatting, for
example insert breaks, create lists and tables and use other text decorations and
colors. For formatting purposes, use the Rich Text Editor toolbar.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing. You might do this,
for example, with an image bar paragraph, because images are not displayed in
the text version. Alternative text is displayed there instead.

Link
Text

This text is linked to the URL entered below.

URL

Enter a target URL here, for example a landing page.

Alignment

Alignment can be right, left or centered.
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Image
Parameter
Image

Description
Upload an image from your computer or enter an image URL in the Alternative
external URL field that points to the image file.
Select Same as image quality in template settings to use the image quality
specified under Settings > General. The Normal and High-resolution options
allow you to set the image quality independently of the template settings.

Image Quality

If High-resolution is selected, the uploaded image must be at least double
the width of the image in the mailing. Example: For a 640 pixel wide image in
the mailing you need an image with a width of 1280 pixels. This ensures that
images do not lose sharpness during rendering of the mailing.

Alternative
Text

This text is displayed if a recipient blocks or disables the display of images in
his/her email client, or if the image cannot be displayed for another reason. Enter
a short image description or title.

Link

You can link the image to a landing page or a page from your website. If you
entered a text link in this paragraph, you should use the same link for the image.

Subtitle

Enter an optional image subtitle here.
You can place the image in a separate column next to heading and text block, or
in a separate column next to the text block and below the heading. These positions are recommended in most cases.

Position

If you use large images that cover the entire width of a paragraph or area,
place them centered below the heading, text, or the link. If you select the
Below the heading right aligned or Below the heading left aligned
options, the text floats around the image.

Button
See Click2Go.

© Optimizely 2022

Managing content | 495

SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
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Parameter

Description
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.
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Options
You can define an individual layout, different from the general newsletter layout, for each
content paragraph.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Background
Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Border
Show

Select if you want to apply a border around the entire paragraph.
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Parameter

Description
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border Width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Table of Contents
Show in Table
of Contents

Select to display the paragraph in the table of contents for the section.

Alternative
Table of Contents Entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.
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Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Table of contents paragraph
Use the table of contents paragraph to create a table of contents for your mailing. You can
control the display of items in the table of contents by including only certain areas.
l
l
l
l
l

List paragraphs instead of the header and footer
List paragraphs including the header, except for the footer
List paragraphs including the footer, except for the header
List paragraphs including the header and footer
Only list the paragraphs of a grouping paragraph
Tip: To exclude content paragraphs from the table of contents, edit
the corresponding content paragraph. In the content paragraph's
configuration window, edit the Options tab > Table of Contents setting and enter the desired value.
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Creating a table of contents paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.

2. Click Table of Contents.

3. In the configuration window, click Apply. The new table of contents paragraph appears
on the left.
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Configuring a table of contents paragraph
1. On the left side of the preview, in the menu bar of the table of contents paragraph,
click Table of Contents. The configuration window opens on the right.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Options

l

Target groups

General
Parameter

Description

Content
Heading

Enter a title for the table of contents.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing.

Options
You can define an individual layout, different from the general newsletter layout, for each
content paragraph.
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Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Area

Select the paragraph areas to be included in the table of contents.

Background
Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side individually.

Border Width
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:
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Parameter

Description
l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Lists
List Type

You can layout the table of contents in a default CSS style. Use a custom label or
no label.

Custom List
Item Label

If you want to use a custom list item label, upload a graphic. The maximum width
is 30 pixels.Larger images are scaled down to this size.

Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.
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Image bar paragraph
Create a horizontal or vertical image bar that contains up to ten images. Uploaded images
are automatically scaled and adapted to the available width.

Creating an image bar paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.

2. Click Image Bar.
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3. In the configuration window, click Apply. The new image bar paragraph appears on the
left side in the preview window.

Configuring an image bar paragraph
1. On the left side of the preview, in the menu bar of the image bar paragraph, click
Image Bar. The configuration window opens on the right-hand side.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Button

l

SWYN

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing.

Image 1-10
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Parameter

Description

Image

Upload an image from your computer or enter an image URL in the field Alternatively external URL that points to the image file.

Alternative
Text

This text is displayed, if a recipient has blocked or disabled the display of images
in the email client, or if the image cannot be displayed for any other reason. Enter
an alternative text that may contain a short image description or title.

Link

You can link the image to a landing page or a page from your website. If you have
entered a text link in this paragraph, we recommend that you use the same link
for the image.

Button
See Click2Go.
SWYN
You can enable the SWYN function for social networks for each paragraph. To allow sharing of these paragraphs in a social network, select the Show check box for the network in
which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default Values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
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Parameter

Description
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.
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Parameter
Text

Description
Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Xing
Parameters for Xing are identical to Twitter's.

Options
On the Options tab, define an individual layout, different from the general newsletter layout, for each content paragraph.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds
this height, the value is ignored, and the content is displayed at the default
height.

Separation
space

Enter an integer value (pixels) to create a space between the images.

Arrangement

By default, a horizontal image bar is created. Alternatively, you can laid out the
image bar vertically.

Image quality

Select Same as image quality in template settings to use the image quality specified under Settings > General. The Normal and High resolution
options allow you to set the image quality independently of the template
settings.
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Parameter

Description
If High resolution is selected, the uploaded image must be at least double
the width of the image in the mailing. Example: For a 640 pixel wide image in
the mailing you need an image with a width of 1280 pixels. This ensures that
images do not lose sharpness during rendering of the mailing.

Alignment

Select how the image bar is to be positioned. If you have a horizontal image bar
that uses the entire available width, changing this value does not affect the display.

Background
color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side individually.

Border Width

Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:
l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4
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Parameter

Description
pixel on the left.
If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).
To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original,
depending on the browser.

Color

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are
displayed on top of each another with the assigned widths.

Separation
Space

Enter an integer value (pixels) to create a space between the images.

Table of Contents
Show in Table of
Contents

Select to display the paragraph for the section in the table of contents .

Alternative Table
of Contents
Entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.

Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.
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Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Separator paragraph
You can use the separator paragraph either at the main level for visually separating multiple grouping paragraphs or the second level for separating content paragraphs.

Creating a separator paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Separator.

3. In the configuration window, click Apply. The new separator paragraph appears on the
left.

Configuring a separator paragraph
1. On the left side of the preview, in the menu bar of the separator paragraph, click Separator.The configuration window opens on the right.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Target groups

General
Parameter

Description

Layout
Show Separator Line

Define the layout of the horizontal line in the general settings.

Show Top Link

Define the layout of the top link in the general settings.
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Parameter

Description

Show Image

Upload a custom top link icon in the general settings.

Show Spacing

Define the spacing above and below the horizontal line, and above and below the
top link in the general settings.

Content
Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Target groups
You can assign separator paragraphs to a target group.Test the newsletter layout for target groups using the action button Target group at the upper right of the window.
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

RSS feed paragraph
Note: To enable this feature, contact customer support.
You can use an RSS feed to publish information in a standardized format, effectively providing a type of interface for third-party providers. The Template Kit can access this interface
and incorporate its content into a newsletter. You can edit texts or reposition content after
it is retrieved.
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The Template Kit may contain several RSS feed paragraphs, each of which accesses a different feed.
You can insert RSS feed paragraphs into header and footer spaces and in structural paragraphs. Also, a supplementary tab is activated in the Template Kit's general settings, where
you can set content order in default layout. You can define alternative layouts by entering
HTML/text via the Options tab.

Formatting the RSS feed
For the RSS feed to be processed correctly, it must meet the RSS 2.0 specification. The
required information for the channel node is not processed by the Template Kit, but it
must still be available. Only the subnodes of the item node are used.
Note: Optimizely Campaign only supports JPEG images in RSS feeds.
Sample RSS feed
<?xml version="1.0"?>
<rss version="2.0">
<channel>
<title>RSS Feed</title>
<link>http://www.example.com/</link>
<description>Text</description>
<item>
<title>Title 1</title>
<description>Text</description>
<enclosure url="http://www.example.com/image1.jpeg" length="12345" typee="image/jpeg" />
<link>http://www.example.com/title1</link>
<comments>http://www.example.com/title1/comments</comments>
<category>News</category>
<author>author@example.com</author>
<pubDate>Sun, 19 May 2002 15:21:36 GMT</pubDate>
</item>
<item>
<title>Title 2</title>
<description>Text</description>
<enclosure url="http://www.example.com/image2.jpeg" length="23456" typee="image/jpeg" />
<link>http://www.example.com/title2</link>
<comments>http://www.example.com/title2/comments</comments>
<category>News</category>
<author>author@example.com</author>
<pubDate>Sun, 19 May 2002 15:21:36 GMT</pubDate>
</item>
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</channel>
</rss>

Creating an RSS feed paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.

2. Click RSS Feed.

3. In the configuration window, change no settings and click Apply. The new RSS feed
paragraph appears on the left in the preview window.
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Configuring an RSS feed paragraph
1. On the left side of the preview, in the menu bar of the RSS feed paragraph, click RSS
Feed.
2. See the following tables to set options. Click Apply to confirm your settings.
l

General

l

RSS feed

l

Button

l

SWYN

l

Default values

l

Options

l

Click profile

l

Target groups

General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing.

Link
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Parameter

Description

Text

This text is subsequently linked in the mailing.

URL

Enter the RSS feed landing page (for example) or another URL.

Alignment

Position the link to the right, left, or center.

RSS feed
Parameter
URL

Description
Enter the URL of the RSS feed from which the content is loaded.
The maximum value is 20 entries.
If you do not specify a value, 10 entries (if available) are retrieved from the RSS
feed and inserted into the newsletter. If more entries are available in the RSS
feed, they are ignored.

Maximum Number of Entries

If you enter 0, the default value of 10 entries is retrieved.
This option is only applicable for the retrieval of RSS feeds. Changing this number does not affect the posts that have been loaded. Note that the Category
Filter option is only applied after the entries are retrieved, so that fewer
entries may be displayed.

Date Format

This option is only applicable for the retrieval of RSS feeds. Changing the date
format does not affect the posts that have already been loaded.

Category Filter

Entries in the RSS feed are displayed by default. If your RSS feed is divided into
different categories, you can filter them by a specific term, which is supplied in
the Categories field of the RSS feed.

Button
See Click2Go.
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SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
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Parameter

Description
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.
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Default values
These values are inherited from the RSS feed items integrated with this paragraph. When
the RSS feed is retrieved, existing paragraphs are removed, and available entries are created as new paragraphs. These values can be overwritten if items are manually edited
later.
Parameter

Description

Link
Text

This text is subsequently linked in the mailing.

Alignment

You can position the link to the right, left, or center.

Link to Comments
Text

This text is subsequently linked in the mailing.

Alignment

You can position the link to the right, left, or center.

Image

Position

The image can be positioned in a separate column next to the heading where it
follows the text, or in a separate column under the heading but next to the text.
These positions are recommended in most cases. If you are using large images
that take up the entire available width, you can position them centered under the
heading, under the text, or below the link.

Options
Parameter

Description

Layout
Width

The maximum available width is used as standard. This is
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Parameter

Description
based on the internal spacing and also depends on
whether you are using a sidebar and, if so, on the width of
the sidebar. Enter a different value in pixels. If the maximum available width is smaller than this value, then the
entered value is ignored.

Height

By default, the paragraph is displayed over the available
height, considering the content. Alternatively, you can specify a fixed height. If the content exceeds this height, the
value is ignored, and the content is displayed at the
default height.

Background
Color

To define the color, enter a hexadecimal value preceded
by # (such as #000000). The depiction of non-hex web
colors may vary from the original, depending on the
browser.
Specify white space around the paragraph content. You
can set white space separately for each page.
Enter the values in pixels (integer values) based on the
following example, using spaces to separate multiple
pixel entries:
l

Padding
l

l

10 = sides are uniform with 10 pixels of white space for
the content
10 20 = 10 pixels on the top and bottom, 20 pixels on
the left and right
10 15 20 25 = 10 pixels on the top, 15 pixels on the
right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space Between
the Items

To create height between the items, enter an integer
value (pixels). By default, the first number in the Padding
option is used.
This option is only enabled when using the default layout.
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Parameter

Layout

Description
In the RSS Feeds Tab in the general settings, specify the
layouts for the RSS feed items. If there is no content available for the selected layout, the default layout is used.

Border
Show

Check to apply a border around the paragraph.
Enter the thickness of the border. You can set thickness
for each side individually.
Enter values in pixels (integer values) based on the following example, using spaces to separate multiple pixel
entries:

Border Width

l
l

l

1 = sides uniform with 1 pixel
1 2 = 1 pixel on the top and bottom, 2 pixels on the left
and right
1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel
on the bottom, 4 pixel on the left.

If you leave the field blank, the border has a thickness
of 1 pixel (uniform on all sides).

Color

To define the color, enter a hexadecimal value preceded
by # (such as #000000). The depiction of non-hex web
colors may vary from the original, depending on the
browser.

Mobile

Width

Set the paragraph width (in percent; 100% default) for
mobile view. To display paragraphs next to each another
in mobile view, make sure that the widths of two consecutive paragraphs combine to 100%. Otherwise, the
paragraphs are displayed on top of each another with the
assigned widths.

Table of Contents
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Parameter

Description

Show in Table of
Contents

Select to display the paragraph in the table of contents
for the section.

Area

Select whether the table of contents should display the
heading of the RSS feed paragraph or the titles of individual articles in the RSS feed.

Alternative Table
of Contents
Entry

Optional: If you select the option Show the heading of
the RSS feed paragraph in the table of contents under
Area, you can change the heading of the RSS feed paragraph displayed in the table of contents.

Click profiles
Parameter
Click Profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Description

Target Groups

To show this paragraph to one or more target groups only, select them more than
one target group is selected, just one must match (OR logic). See Target groups.
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Retrieving an RSS feed
1. In the menu bar of the RSS feed paragraph, click the RSS symbol

.

An information window opens. You are asked to confirm the retrieval of the RSS feed.
Note: If you previously retrieved the RSS feed, the previously
loaded and possibly edited content is overwritten with the current RSS feed content.
2. Click Next. The loaded RSS feed items are displayed to the left in the preview.

Editing an RSS feed
1. In the menu bar of the corresponding RSS feed item, click RSS Feed. On the right side,
a window for editing the content of the RSS feed item opens.
2. Edit to the RSS items as desired.
3. Click Apply. The updated content is displayed to the left .
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Note: If you click RSS
in the menu bar of the RSS feed paragraph, the RSS feed is retrieved again, and any edited feed articles
are overwritten with the current feed content. So, if you modify RSS
feed articles, only click RSS

if you want to reset the changes.

Recommendations paragraph
Recommendation generators let you send individualized recommendations in real time
mailings, any time a recipient accesses a mailing. Recommendations are based on recipient
history and algorithms and retrieved via a URL. Depending on the provider, one or more
URLs are made available to each recipient, which they can use to access a variety of elements:
l
l
l

Recommendation image (such as product image)
Recommendation text (shown as graphics, such as product name and description)
Link to a landing page

The recommendation paragraph contains input fields for these URLs for multiple recommendations, providing you with additional layout options. You can place a recommendation paragraph within the header and footer area and inside grouping paragraphs.
The Template Kit can contain multiple recommendation paragraphs. However, the recommendation provider can only provide a limited number of recommendations for a recipient.
Note: Fallback for new recipients and incomplete URLs
Store a fallback for your provider so new recipients with no history
are shown a recommendation and so URLs with missing or incorrect
parameters can be compensated for. Otherwise, an empty image
placeholder might appear in the mailing, because no graphic could
be retrieved from the recommendation server.
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Formatting recommendation URLs
URLs for recommendations include multiple parameters that identify a customer, recipient,
layout, type (text, image, or link), and number of recommendations (for more than one). A
recommendation is only generated if parameters are generated correctly.
The following URL structure is an example. See the provider you have selected for details.
http://host:port/rde_server/res/[NL-RDE-ID]/newsletter/recomm/[Name-of-messagetemplate]/usr/[User-ID] ?requestType=textImage&recoIndex=[Index]&channel=NL
l
l

NL-RDE-ID. Your customer ID; you receive this from the recommendation provider.
Name-of-message-template. The template determines the recommendation stored for
the recommendation provider.
Note: You cannot modify the first two parameters.

l
l

User ID. The recipient ID, used to generate individual recommendations.
Index. Process multiple recommendations for each recipient. Use this parameter to select
the corresponding, consecutive paragraph number.

Creating a recommendations paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Recommendations.

3. In the configuration window, click Apply. The new recommendation paragraph appears
on the left.

Configuring a recommendation paragraph
1. On the left side of the preview, in the menu bar of the recommendation paragraph,
click Recommendations.The configuration window opens on the right.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Button

l

Text
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l

SWYN

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Contents
Heading

Enter a paragraph caption.

Show in
Desktop Version

Select to include this paragraph in the desktop mailing.

Show in
Mobile Version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in Text
Version

Select to show the paragraph in the text version of the mailing.

Recommendation 1-5

Image URL

Enter the URL used to generate the recommendation image that appears in a
mailing. The height and width of the graphic is set by the recommendation provider and cannot be adjusted to fit the template.

Text URL

Enter the URL used to generate the recommendation text that appears in a mailing. The text is displayed as a graphics file. The height and width of the graphic is
set by the recommendation provider and cannot be adjusted to fit the template.

Link

Enter the URL used to generate a link to the landing page that appears in a mailing. The layout of the links (color, text and so on) is set by the recommendation
provider and cannot be adjusted to fit the template.
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Button
See Click2Go.
Text
Recommendations are incorporated into mailings as graphics and are not displayed in the
text version – except for the caption, if one is provided. Instead, you can enter a substitute
text to use in the text version of the mailing. If you do not want the paragraph to appear in
the text version, disable the Show in Text Version option in the General tab.
Parameter
Text

Description
Enter alternate text to use in the text version of a mailing. Recommendations will
not appear in the text version, except for the caption.

SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default Values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.
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Parameter

Description

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the para-
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Parameter

Description
graph via email. If you enter nothing here, the standard title is displayed.
Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Text
Xing

Parameters for Xing are identical to Twitter's.

Options
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the
internal spacing and also depends on whether you are using a sidebar
and, if so, on the width of the sidebar. Enter a different value in pixels. If
the maximum available width is smaller than this value, then the entered
value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the content. Alternatively, you can specify a fixed height. If the
content exceeds this height, the value is ignored, and the content is displayed at the default height.

Recommendation Layout

Images and text used in a recommendation can be placed next to or on
top of each other. Bear in mind the available width when changing the layout.

Space Between Image
and Text

Specify (in pixels) how much space there should be between image and
text in a recommendation.

Space Between the
Recommendations

Specify (in pixels) how much space there should be between multiple
recommendations. This value is irrelevant if you are only inserting one
recommendation.
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Parameter

Description

Arrangement

Indicate whether multiple recommendations should be placed next to
each other in one paragraph (for example, in the main body of the text
space) or on top of each other (for example, in the sidebar next to the
main body of the text space). This value is irrelevant if you are only inserting one recommendation.

Alignment

Specify how the recommendations should be arranged in a paragraph.
This value is only applied if the width of recommendations is less than the
width available in the main body of the text space.

Background Color

The background color is given as a Hex code.To define the color, enter a
hexadecimal value preceded by # (such as #000000). The depiction of
non-hex web colors may vary from the original, depending on the browser.
Specify white space around the paragraph content. You can set white
space separately for each page.
Enter the values in pixels (integer values) based on the following
example, using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on
the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.
Recommendation Image
Width

Enter the width of the recommendation image. If you do not enter anything here, the image's original width is used.

Height

Enter the height of the recommendation image. If you do not enter anything here, the image's original height is used.

Recommendation Text
Width

Enter the width of the recommendation text. If you do not enter anything
here, the text's original width is used.
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Parameter
Height

Description
Enter the height of the recommendation text. If you do not enter anything
here, the text's original height is used.

Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side
individually.
Enter values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Border Width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom,
4 pixel on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on all sides).

Color

To define the color, enter a hexadecimal value preceded by # (such as
#000000). The depiction of non-hex web colors may vary from the original, depending on the browser.

Mobile

Width

Maximum Width of the
Text Image

Set the paragraph width (in percent; 100% default) for mobile view. To display paragraphs next to each another in mobile view, make sure that the
widths of two consecutive paragraphs combine to 100%. Otherwise, the
paragraphs are displayed on top of each another with the assigned
widths.
The maximum width is entered as a percentage. It only takes effect if the
text is positioned to the left or the right of the image.
The value must be between 10 and 90. By default, a maximum width of
50 % is used.
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Parameter

Description

Table of Contents
Show in Table of Contents

Check to display the paragraph in the table of contents for the section.

Alternative Table of
Contents Entry

Enter a heading to be displayed for this section in the table of contents. If
you enter nothing, the heading from the General tab is displayed.

Click profiles
Parameter
Click Profile

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Target Groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Facebook paragraph
Note: To enable this feature, contact customer support.
Use the Facebook paragraph to integrate up to 25 current Facebook posts into a message.
Keep recipients up-to-date with exciting topics from your social network.
Decide whether Optimizely Campaign updates the Facebook paragraph every time you
send a message and automatically loads the latest posts from your Facebook timeline, or
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whether Optimizely Campaign only displays Facebook posts you defined when creating or
modifying the campaign.
l

l

Dynamic integration. Displays your latest social media activities. However, you cannot
permanently delete or edit posts in the Facebook paragraph. If you remove or edit Facebook timeline posts from the Facebook paragraph, those posts are reloaded into the Facebook paragraph when the mailing is sent.
Static integration. Provides more control over posts that appear in the Facebook paragraph. When creating a message, you can manually update which posts to integrate. You
can delete individual posts. When the mailing is sent, Optimizely Campaign does not
update the Facebook paragraph from your Facebook timeline. Changes can be made but
do not happen automatically.
Tip: By default, Optimizely Campaign integrates Facebook posts statically. To use dynamic integration, contact customer support to
change the default integration.

Creating a Facebook paragraph
1. While editing the mailing content in the Template Kit, click New: Content paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Facebook.

3. In the configuration window, click Apply. The new Facebook paragraph appears on the
left.

Configuring a Facebook paragraph
1. On the left side of the preview, in the menu bar of the Facebook paragraph, click Facebook. The configuration window opens on the right side.
2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
l

General

l

Settings

l

Button

l

SWYN

l

Default values

l

Options

l

Click profiles

l

Target groups
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General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Show in
desktop version

Select to include this paragraph in the desktop mailing.

Show in mobile
version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in text
version

Select to show the paragraph in the text version of the mailing.

Link
Text

This text is subsequently linked to in the mailing.

URL

Enter a link , such as the starting page or your public Facebook profile.

Orientation

Position the link on the right, left, or center.

Settings
Parameter

Account name

Description
Enter your public Facebook user name, which is the name used in the web
address for your Facebook timeline. It is the last part of the URL: https://facebook.com/User name.
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Parameter

Description

Warning: If the display of your Facebook page is limited to specific countries, Facebook posts will not load
if you or your recipients are located outside of the countries for which the display is allowed.

Enter the maximum number (up to 25) of Facebook posts to be displayed in your
message.

Maximum number of entries

Tip: If you enter 0 or leave this field blank, a default
value of 10 Facebook posts are used. If fewer than 10
posts are available in your Facebook account, fewer
posts are retrieved and displayed.
Also, if you are using static integration, changing this
value has no effect on any posts already retrieved. You
must manually update the Facebook paragraph for the
new number of posts to take effect.

In the drop-down list, select a date format to be displayed next to your Facebook
posts.

Date format

Tip: If using static integration, changing the date format
has no effect on Facebook posts that have already
been retrieved. You must manually update the Facebook paragraph for a date format change to take effect.

Button
See Click2Go.
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SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
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Parameter

Description
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.
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Default values
Parameter

Description

Link
Facebook posts in your messages are automatically linked to the original Facebook post.
To clarify this for your recipients and to highlight links, add additional text,
such as More information on our Facebook page or Go to original post on
Facebook.
Text

Enter your text into the airfield you do not want to point out that the Facebook post in your mailing will lead to your Facebook page, leave the field
blank.
Tip: Text entered here is added to Facebook posts and
appears with each Facebook post in the message.

Orientation

The text can be aligned to the right, left or center.

Image
From the drop-down list, select the position where images associated with your
Facebook post will display.
Position

Tip: If your Facebook post contains several images, the
first image from the post is assiduous cannot display
subsequent images.

Options
You can give each content paragraph a different appearance from the general layout.
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Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Background
color

The depiction of non-hex web colors may vary from the original, depending on
the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space between
articles

A space with this height is placed between individual admissible default, the first
number in the Padding option is osteopathic option is only enabled when using
the default layout.
Select a layout for your Facebook posts.

Layout

You can choose between the supplied default layout and up to two userdefined absolutist use a custom layout, set it up in advance in the general settings in the Facebook evadable you select a user-defined layout list that you
have not configured, the default layout is automatically used. See Facebook
layouts.
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Parameter

Description

Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).
Color

The depiction of non-hex web colors may vary from the original, depending on
the browser.

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Table of contents
Show in table of
contents

Select to display the paragraph in the table of contents for the section.

Alternative
table of contents entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.
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Click profiles
Parameter
Click profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups
Parameter

Description

Target groups

To show this paragraph to one or more target groups only, select them more than
one target group is selected, just one must match (OR logic). See Target groups.

Loading Facebook posts
1. In the menu bar of the Facebook paragraph, click Load Facebook posts

2. In the configuration window, click Next.
Warning: If the display of your Facebook page is limited to specific countries and you are located outside of these countries,
Facebook posts will not load successfully.
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You can also manually update your Facebook posts in the Facebook paragraph afterwards
and reload them from your Facebook timeline. To do this, click Load Facebook posts
again.

Editing Facebook posts
You can edit your Facebook posts individually after loading them into your mailing.
1. In the menu bar of the corresponding Facebook post, click Facebook Entry.The configuration window opens on the right.
2. Change the settings according to your needs. Confirm by clicking Apply in the lower
right corner.
Note: If you manually update posts in the Facebook paragraph,
the posts are reloaded from your Facebook timeline, overwriting
any manual changes to the Facebook posts. If you are using
dynamic integration, manual changes to Facebook posts are overwritten when the mailing is sent.

Deleting Facebook posts
1. In the menu bar of the Facebook post you want to delete, click Delete
2. Confirm your selection by clicking OK.
Note: If you manually update posts in a Facebook paragraph, previously deleted posts are reloaded unless they were also deleted
from your Facebook timeline. If you are using dynamic integration,
deleted Facebook posts are automatically reloaded into your message when the mailing is sent.

Facebook layouts
This topic describes:
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l
l
l

how customer support sets up alternative HTML layouts
how to select alternative layouts in the Facebook paragraph
how to edit alternative layouts using knowledge of HTML, CSS, and Velocity

To receive up to 2 alternative layouts, contact customer support.
To create HTML layouts, set up alternative layouts for mobile and text versions also. If no
alternative layouts are saved for those versions, the default layout is used.
Note: In some cases, some text elements will not be in the order that
you want.

Selecting a layout
1. To select a default layout or an alternative layout, while editing a message in the Template Kit, on the left side of the preview, in the menu bar of the Facebook paragraph,
click Facebook. The configuration window opens on the right side.
2. Click the Options tab.
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3. In the Layout area, in the Layout drop-down list, select the layout you want to use.

4. Click Apply.
Editing a layout
You can edit alternative layouts but not the default layout.
Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
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mailings.
1. To edit alternative layouts, in the preview on the left, click Settings. The configuration
window opens on the right.
2. Open the Facebook tab. Each layout has source text fields for the desktop, mobile,
and text versions.

3. Edit the source text of the corresponding layout according. Under Inserting content,
read how to place the various content items.
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Tip: Set up alternative layouts for mobile and text versions also. If
no alternative layouts are stored for these versions, the default
layout is used.
4. Click Apply.
Inserting content
Access the content of the Facebook paragraph using Velocity variables and format the
transferred content using HTML style attributes.
The following Velocity variables are available:
l
l
l

Status. Information on current item paragraphs
Present. For using queries that check for the presence of an element
Value. For issuing the content

Notes for the creation of new layouts
l

l

l

Font definitions. If you are using an alternative layout variant, font definitions must exist
in the HTML you entered. The texts are not formatted by the Template Kit to give you complete freedom in visual design.
Widths. Specify a fixed width or a width in percent. You should enter a percentage,
because this prevents elements from sticking out of the layout.
Danger of display errors. If you edit the layouts without in-depth knowledge of HTML,
serious display errors may occur in your mailings.

Status variables
Variable

Type

Description

$facebookItemFirst

Boolean

Is true if it is the first post in the Facebook paragraph,
or is otherwise false.

$facebookItemIndex

Integer

Contains the position of the post within the Facebook
paragraph as a number (1 for the first post, 2 for the
second post and so on).
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Variable
$facebookItemLast

Type
Boolean

Description
Is true if it is the last post in the Facebook paragraph,
or is otherwise false.

Present variables
Variable

Type

Description

$facebookTextPresent

Boolean

Contains true if there is content for the Text
box, or otherwise false.

$facebookAuthorPresent

Boolean

Contains true if there is content for the
Author box, or otherwise false.

$facebookDatePresent

Boolean

Contains true if there is content for the
Date box, or otherwise false.

$facebookLinkTextPresent

Boolean

Contains true if there is content for the Text
box in the Link area, otherwise false.

$facebookLinkUrlPresent

Boolean

Contains true if there is content for the URL
box in the Link area, otherwise false.

$facebookImageUrlPresent

Boolean

Contains true if there is content for the
Image box in the Image tab, otherwise
false.

$facebookImageAltTextPresent

Boolean

Contains true if there is content for the
Alternative text box in the Image tab, otherwise false.

$facebookImageLinkPresent

Boolean

Contains true if there is content for the Link
box in the Image tab, otherwise false.
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Value variables
Variable

Typ

Description

$facebookTextValue

String

Contains the content of the Text box.

$facebookAuthorValue

String

Contains the content of the Author box.

$facebookDateValue

String

Contains the content of the Date box.

$facebookLinkTextValue

String

Contains the content of the Text box in the Link
area.

$facebookLinkUrlValue

String

Contains the content of the URL box in the Link
area.

$facebookImageUrlValue

String

Contains the image URL from the Image tab.

$facebookImageAltTextValue

String

Contains the content of the Alternative text
box in the Image tab.

$facebookImageLinkValue

String

Contains the content of the Link box in the
Image tab.

String

Inserts the paragraph's button bar. This is
required to integrate the button bar into the
table, such as when implementing adjacent
items. If this variable is not available, the button
bar is placed above the item.

$editBar

Twitter paragraph
Note: To enable this feature, contact customer support.
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Use the Twitter paragraph to integrate up to 20 current tweets into your messages. Keep
your recipients up-to-date with exciting topics from your social network.
Decide whether Optimizely Campaign updates the Twitter paragraph every time you send
a message and automatically loads the latest tweets from your Twitter timeline, or if Optimizely Campaign only displays tweets you defined when creating or modifying the campaign.
l

l

Dynamic integration. Displays your latest social media activities. However, you cannot
permanently delete or edit individual tweets in the Twitter paragraph. If you remove or edit
tweets in the Twitter paragraph which are still present in your Twitter timeline, the
removed or edited tweets are reloaded when the mailing is sent and inserted into the Twitter paragraph.
Static integration. Provides more control over the tweets in the Twitter paragraph. When
creating a mailing, you can select which of your current tweets should be integrated. You
can delete individual tweets. When the mailing is sent, Optimizely Campaign does not
update the Twitter paragraph from your Twitter timeline. Changes can still be made, but
do not happen automatically. When using static integration, you can update tweets manually.
Tip: By default, Optimizely Campaign integrates your tweets statically. To use dynamic integration, contact customer support.

Creating a Twitter paragraph
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Twitter.

3. In the configuration window, click Apply. The new Twitter paragraph appears on the
left.

Configuring a Twitter paragraph
1. On the left side of the preview, in the menu bar of the Twitter paragraph, click Twitter.
The configuration window opens on the right.
2. See the following tables to set options in the corresponding tabs. To confirm your settings, click Apply.
l

General

l

Settings

l

Button
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l

SWYN

l

Default values

l

Default values

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Content
Heading

Enter a heading for the paragraph.

Show in
desktop version

Select to include this paragraph in the desktop mailing.

Show in mobile
version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in text
version

Select to show the paragraph in the text version of the mailing.

Link
Text

This text is subsequently linked to in the mailing.

URL

Enter a link here (for example, the landing page for the product group).

Orientation

Position the link on the right, left, or center.
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Settings
Parameter
Account name

Description
Enter your public Twitter user name, the name used in the web address for your
Twitter timeline. It is the last part of the URL: https://twitter.com/User name.
Enter the maximum number of tweets that should be displayed in your message.
The maximum value for this is 20 tweets.

Maximum number of entries

If you enter 0 into this field or leave it empty, a default value of 10 tweets is
used (if fewer than 10 tweets are available in your Twitter account, those
tweets are displayed).
Also, when using static integration, changing this value has no effect on any
tweets already retrieved. You must manually update the Twitter paragraph for
the new number to take effect.

Date format

In the drop-down list, select a date format to be used next to your tweets.
Changing the date format has no effect on tweets that already were retrieved
when using static integration. You must manually update the Twitter paragraph for
the date format change to take effect.

Button
See Click2Go.
SWYN
You can enable the SWYN function for social networks individually for each paragraph. To
allow sharing of these paragraphs in a social network, select the Show check box for the
network in which you want them to appear.
Parameter

Description

General
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Parameter

Description

Alignment

Links (symbols and text) and the introduction text are right-aligned.

Position

Links (symbols and text) and the introduction text are positioned at the bottom
edge of the paragraph.

Default values
Title

Displays up to 50 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other title is indicated for that network.

Text

Displays up to 250 characters in the user's profile if the user shares the paragraph
over a social network, as long as no other text is specified for that network.

Image

Displays up to 100 x 100 pixels in the user's profile next to the text if the user
shares the paragraph over a social network, as long as no other image is specified
for that network. Larger images are scaled down to this size.

Facebook
Show

Lets recipients share the paragraph via their Facebook profile.

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard text is displayed.

Image

Displays up to 100 x 100 pixels if the recipient shares the paragraph on his or her
Facebook profile. If you enter nothing here, the standard image is displayed. Larger images are scaled down to this size.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Twitter
Show

Lets recipients share the paragraph via their Twitter account.
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Parameter

Description

Title

Displays up to 50 characters if the recipient shares the paragraph on his or her
Twitter profile. If you enter nothing here, the standard title is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

WhatsApp
Parameters for WhatsApp are identical to Twitter's.
Email
Show

Lets recipients share the paragraph via email.

Title

Displays up to 50 characters as email subject if the recipient shares the paragraph via email. If you enter nothing here, the standard title is displayed.

Text

Displays up to 250 characters if the recipient shares the paragraph via email. If
you enter nothing here, the standard text is displayed.

Redirect

Creates a landing page that displays the content of the linked paragraph. If you
enable, the link redirects recipients to the URL specified in the General tab.

Xing
Parameters for Xing are identical to Twitter's.

Default values
Parameter

Description

Link
Text

Tweets in your message are automatically linked to the original tweet on your
Twitter page.
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Parameter

Description
To clarify this and highlight links, add additional text, for example, "More
information on our Twitter page" or "View original tweet". That text appears
with each tweet in your message.

Orientation

The text can be aligned to the right, left or center.

Image
Position

From the drop-down list, select the position where an image associated with your
tweet (if any) should be displayed.

Options
To give each content paragraph a different appearance from the general layout, use the
layout configuration in this tab.
Parameter

Description

Layout

Width

The maximum available width is used as standard. This is based on the internal
spacing and also depends on whether you are using a sidebar and, if so, on the
width of the sidebar. Enter a different value in pixels. If the maximum available
width is smaller than this value, then the entered value is ignored.

Height

By default, the paragraph is displayed over the available height, considering the
content. Alternatively, you can specify a fixed height. If the content exceeds this
height, the value is ignored, and the content is displayed at the default height.

Background
color

The depiction of non-hex web colors may vary from the original, depending on
the browser.
Specify white space around the paragraph content. You can set white space
separately for each page.

Padding
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:
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Parameter

Description
l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Space between
articles

A space with this height is placed between individual items. By default, the first
number in the Padding option is used.This option is only enabled when using
the default layout.
Select a Twitter layout.

Layout

You can choose between the default layout and up to two user-defined layouts. To use a custom layout, set it up in advance in the general settings in
the Twitter tab. If you select a user-defined layout that is not configured, the
default layout is used.

Border
Show

Select if you want to apply a border around the entire paragraph.
Enter the thickness of the border. You can set thickness for each side individually.
Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:

Border width

l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.

If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).
Color

The depiction of non-hex web colors may vary from the original, depending on
the browser.

© Optimizely 2022

560 | Optimizely Campaign User Guide 2022-03-14

Parameter

Description

Mobile

Width

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Table of contents
Show in table of
contents

Select to display the paragraph in the table of contents for the section.

Alternative
table of contents entry

Enter a heading to be displayed for this section in the table of contents. If you
enter nothing, the heading from the General tab is displayed.

Click profiles
Parameter

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Click profiles
Alternatively, you can allocate individual links to a click profile in the Tracking
settings for the mailing creation wizard.

Target groups
Parameter

Target groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.
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Loading tweets
1. In the menu bar of the Twitter paragraph, click Load tweets

.

2. In the configuration window, click Next.
You can also manually update your tweets in the Twitter paragraph afterwards and reload
them from your Twitter timeline. To do this, click Load tweets

again.

Editing tweets
You can edit tweets individually after loading them into your mailing.
1. In the menu bar of the corresponding tweet, click Twitter entry.The configuration window opens on the right.
2. Change the settings as needed and confirm your entries by clicking Apply.
Tip: If you manually update tweets in the Twitter paragraph, the
posts are reloaded from your Twitter timeline, overwriting any
manual changes to the tweets. If you are using dynamic integration, manual changes to tweets are overwritten when the mailing is sent.
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Deleting tweets
1. In the menu bar of the tweet you want to delete, click Delete
2. Click OK.

.

Twitter layouts
This topic describes:
l
l
l

how customer support sets up alternative HTML layouts
how to select alternative layouts in the Twitter paragraph
how to edit alternative layouts using HTML, CSS, and Velocity

To receive up to two alternative layouts, contact customer support.
To create HTML layouts, set up alternative layouts for mobile and text versions also. If no
alternative layouts are saved for those versions, the default layout is used.
Note: In some cases, some text elements will not be in the order that
you want.

Selecting a layout
To select a default layout or one of up to 2 alternative layouts, while editing a message in
the Template Kit, do the following:
1. On the left side of the preview, in the menu bar of the Twitter paragraph, click Twitter.
The configuration window opens on the right.
2. Click the Options tab.
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3. In the Layout area > Layout drop-down list, select the layout you want to use.

4. Click Apply.
Editing a layout
You can edit alternative layouts, but not the default layout.
Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
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mailings.
1. In the preview on the left, click Settings. The configuration window opens on the right.
2. Open the Twitter tab. Each layout has source text fields for the desktop, mobile, and
text versions.

3. Edit the source text of the corresponding layout as needed. Under Inserting content,
read how to place the various contents.
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Tip: Set up alternative layouts for mobile and text versions also. If
no alternative layouts are stored for these versions, the default
layout is used.
4. Click Apply.
Inserting content
Access the content of the Twitter paragraph using Velocity variables and format the transferred content using HTML style attributes.
The following Velocity variables are available:
l
l
l

Status. Information on current item paragraphs
Present. For using queries that check for the presence of an element
Value. For issuing the content

Notes for the creation of new layouts
l

l

l

Font definitions. If you are using an alternative layout variant, font definitions must exist
in the HTML you entered. The texts are not formatted by the Template Kit to give you complete freedom in visual design.
Widths. Specify a fixed width or a width in percent. You should enter a percentage,
because this prevents elements from sticking out of the layout.
Danger of display errors. If you edit the layouts without in-depth knowledge of HTML,
serious display errors may occur in your mailings.

Status variables
Variable

Type

Description

$twitterItemFirst

Boolean

Is true if it is the first tweet in the Twitter paragraph, or is
otherwise false.

$twitterItemIndex

Integer

Contains the position of the post within the Twitter paragraph as a number (1 for the first tweet, 2 for the second
tweet and so on).
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Variable
$twitterItemLast

Type
Boolean

Description
Is true if it is the last tweet in the Twitter paragraph, or is
otherwise false.

Present variables
Variable

Type

Description

$twitterTextPresent

Boolean

Contains true if there is content for the Text
box, or otherwise false.

$twitterAuthorPresent

Boolean

Contains true if there is content for the Author
box, or otherwise false.

$twitterDatePresent

Boolean

Contains true if there is content for the Date
box, or otherwise false.

$twitterLinkTextPresent

Boolean

Contains true if there is content for the Text
box in the Link area, otherwise false.

$twitterLinkUrlPresent

Boolean

Contains true if there is content for the URL
box in the Link area, otherwise false.

$twitterImageUrlPresent

boolean

Contains true if there is content for the Image
box in the Image tab, otherwise false.

$twitterImageAltTextPresent

Boolean

Contains true if there is content for the Alternative text box in the Image tab, otherwise
false.

$twitterImageLinkPresent

Boolean

Contains true if there is content for the Link
box in the Image tab, otherwise false.
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Value variables
Variable

Type

Description

$twitterTextValue

String

Contains the content of the Text box.

$twitterAuthorValue

String

Contains the content of the Author box.

$twitterDateValue

String

Contains the content of the Date box.

$twitterLinkTextValue

String

Contains the content of the Text box in the Link
area.

$twitterLinkUrlValue

String

Contains the content of the URL box in the Link
area.

$twitterImageUrlValue

String

Contains the image URL from the Image tab.

$twitterImageAltTextValue

String

Contains the content of the Alternative text box in
the Image tab.

$twitterImageLinkValue

String

Contains the content of the Link box in the Image
tab.

String

Inserts the paragraph's button bar. This is required
to integrate the button bar into the table, such as
when implementing adjacent items. If this variable
is not available, the button bar is placed above the
item.

$editBar

Navigation menu
Note: To enable this feature, contact customer support.
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With the navigation menu paragraph type, you can create navigation bars with links to
landing pages or deep links. And, you can add and edit menu items with no HTML knowledge.
Navigation menu example:

Range of functions
l

l
l
l

Can design each menu item individually: Text and background color, as an image or with
an icon.
Create up to 10 menu items.
Store up to five user-defined layouts and apply them to the navigation menu.
In the mobile version, you can display navigation in two or three columns or as a hamburger menu.The hamburger menu offers the following advantages:
o

simple/minimalistic; can be used almost anywhere in the layout

o

navigation can be folded in and out
space-saving display for small screens

o

Creating a navigation menu
1. While editing the mailing content in the Template Kit, click New: Content Paragraph.
Tip: You can also use the paragraph in the header and footer
area by clicking Header or Footer.
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2. Click Navigation menu.

3. In the configuration window, click Apply. The new navigation menu appears on the left,
in the preview window.

Configuring a navigation menu
1. Click Navigation Menu on the left side of the preview.

2. See the following tables to set options in the corresponding tabs. Click Apply to confirm your settings.
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l

General

l

Separator lines

l

Hamburger menu

l

Options

l

Click profiles

l

Target groups

General
Parameter

Description

Content
Show in
desktop version

Select to include this paragraph in the desktop mailing.

Show in mobile
version

Select to show the paragraph in the mobile version of the mailing. The Activate
mobile version setting in the general settings must be activated for this option
to take effect.

Show in text version

Select to show the paragraph in the text version of the mailing.

Menu item 1-10
Enter the caption of the menu item. To use an image for the menu item instead
of a caption, enter a caption anyway. In this case, the caption is used as the
image's alternative text.
Text

URL

Tip: You can display an image with or without a caption for the menu item. These settings are in the
Options tab under Menu items > Image position.

Enter a URL to which the menu item should refer. If a recipient clicks this menu
item, he/she is directed to the specified URL.
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Parameter

Text color

Description
Specify the text color for the menu item caption. If you leave the field blank, the
text color specified in general settings > Menu items in the navigation menu
> Font settings > Color is used.
Specify a background color for . The setting only affects the selected menu item.

Background
color

To use the same color for all menu items, configure a global background
color. These settings are in the Options tab > Menu items > Background
color.
Upload an image. Click Browse... and select an image in the file browser. Alternatively, in the Alternatively external URL field, you can enter an image URL that
refers to the image source.
Tip: You can display the image together with or
without the caption of the menu item. The corresponding settings are in the Options tab under
Menu items > Image position.

Image
Note: The image size of the uploaded image is not
reduced. So, only upload images that match the size of
the menu item.
If you select a multi-column layout for the mobile version, before sending, use mobile preview to check if
the navigation menu displays correctly with these settings.

Show in mobile
version

Select to show the menu item in the mobile version of the mailing.
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Separator lines
Parameter

Description

Content
Show vertical
separator lines in
the desktop version

Select to insert vertical separator lines between menu items in the desktop version.

Show vertical
separator lines in
the mobile version

Select to insert vertical separator lines between menu items in the mobile version.

Show horizontal
separator lines in
the mobile version

Check this box to show horizontal separator lines between menu items in the
mobile version.
This option only takes effect if you are using the default layout and configure it so that menu items in the mobile version are displayed below each
other (see the Options tab under Layout > Default layout).

Layout

Thickness

Enter the thickness of separator lines between menu items in pixels (integer
value) .If you leave the field blank, the lines are displayed with a 1 pixel thickness. To show no separator lines, enter 0.

Color

Enter the color of the separator lines. If you leave the field blank, the color you
specified in the general settings in the Font settings tab under Menu items in
the navigation menu > Color is used.

Hamburger menu
To save space for display on smart phones and tablets, you can use a hamburger menu to
reduce the navigation menu to an icon.Recipients can expand and collapse the navigation
menu by clicking the icon.
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Note: The hamburger menu is only available for the mobile version.
In addition, Google’s Gmail app does not support this feature and
shows menu items expanded.
Parameter

Description

General
Display

Select to activate the hamburger menu in the mobile version of your mailing.

Menu bar
Heading

Enter the caption of the hamburger menu. The caption displays next to the hamburger menu icon.

Padding

Configure the size of the menu bar by specifying the area around the hamburger
menu symbol. Enter the value in pixels (integer values).

Background
color

Enter the background color for the hamburger menu's menu bar.

Image
Upload an image to replace the menu bar label with an image. Click Browse...
and select an image in the file browser.
Image

Alternative text

Alternatively, in the Alternatively external URL box, enter an image URL
that refers to the image source. If the uploaded image is too wide for the
menu bar, the image is adjusted to the maximum available width.
Enter an alternative text that displays if a recipient blocks the download of
images, or the image cannot be displayed for any other reason. The alternative
text should contains a brief description of the picture.
Enter the URL of a landing page, beginning with the http:// or https:// protocol.

Link
If you already created a landing page for the mailing, a list of those landing
pages appears.
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Parameter

Description

Icon
Position

Select the position of the hamburger menu icon.

Color

Enter the color for the hamburger menu icon. If you leave the field blank, the
color specified in the general settings in the Font settings tab under Menu
items in the navigation menu > Color is used.

Background
color

Enter the background color of the hamburger menu icon.

Rounding contours

Check this box to round the contours of the hamburger menu icon.

Options
Parameter

Description

Layout

Width

Enter at least 30 pixel width. The setting only affects the desktop version. If you
leave the field blank, the paragraph is displayed across the entire width available
in the mailing. If you want to change the available width in the mailing, open the
general settings, open the General tab and make your changes in the Layout
area.
Enter the height of the paragraph in pixels. The setting only affects the desktop
version. If you leave the field blank, the height will automatically be adjusted to
fit the content of the paragraph.

Height

Alignment

Note: If you select a height that is insufficient for the
content of the paragraph, the value you enter is
ignored, and the height is adjusted automatically.

Specify how to position the navigation menu.
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Parameter
Background
color

Description
Enter the background color of the navigation menu.
Specify white space around the paragraph content. You can set white space
separately for each page.
Enter the values in pixels (integer values) based on the following example,
using spaces to separate multiple pixel entries:

Padding

l

10 = sides are uniform with 10 pixels of white space for the content

l

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right

l

10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels on the left

If the value is set to 0, then there will be no padding.

Layout

Select a layout for your navigation menu. You can select between the supplied
default layout and up to five custom user-defined layouts. To use a user-defined
layout, set it up in advance in the general settings in the Navigation menu tab. If
you choose to enter a user-defined layout from the drop-down list that you have
not configured, the default layout is used instead. See Navigation menu layouts.
Select the arrangement of menu items for the mobile version of the default layout.

Default layout

Note: If you use a custom layout, the option selected
here is ignored.

Background image
To upload a background image that covers menu items, click Browse... and
select an image in the file browser. In the Alternatively external URL box, you
can also enter an image URL that refers to the image source.
Image
Note: If you specify a background image, it is used
instead of the selected background colors for menu
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Parameter

Description

items.

Note: Not all email programs and web mailers support
background images. You should only upload background images that contain unimportant information.

Alignment

Specify how to position the background image.

Repeat

Specify whether and how the background image is repeated.

Menu items...
Specify a global background color for the menu items.
Note: If you specify an individual background color for
a menu item, this is used instead of the global background color. To use the global background color for a
menu item, delete the color value in the General tab
under Menu item # > Background color.

Background
color

Enter the width of the menu items in pixels.
Width (desktop
version)

Tip: The recommended width for the menu items is
shown in the preview on the left if you hover over
?Help.

Configure the size of the menu items by specifying the area around the caption.
Padding

You can set each side of the area individually. Enter the values in pixels
(integer values) based on the following example, using spaces to separate
multiple pixel entries:
l

10 = sides of the area a uniform distance of 10 pixels away from the label
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Parameter

Description
l
l

Text alignment

10 20 = 10 pixels on the top and bottom, 20 pixels on the left and right
10 15 20 25 = 10 pixels on the top, 15 pixels on the right, 20 pixels on the bottom, 25 pixels to the left

Specify how to position the captions of the menu items.
Specify where to position captions of menu items next to an image.
Note: This option applies in the following cases:
l

Text position
(next to the
image)

l

l

l

If an image is used in the menu item, and the caption is activated.
If the caption of a menu item wraps to several lines; the caption of the other menu items is positioned according to the
option selected here.

You can set images for each menu item in the General tab
under Menu item # > Image.
Activate the caption with the following Image position option.

Specify whether and where the images next to the captions of the menu items
are displayed.
Image position

Tip: If you select Centered (no label), the stored caption is not displayed but is used for the image's alternative text.

Menu items (mobile version)
Enter the width of the menu items in percent.
Width

Tip: This option only takes effect if you use the default
layout, and it is set so that individual menu items in
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Parameter

Description

the mobile version are displayed next to each another
(see the Options tab under Layout > Default layout).

Text alignment

Specify how to position the captions of the menu items.
Specify how to position the captions of the menu items next to the image.
Note: This option applies in the following cases:
l

Text position
(next to the
image)

l

l

l

If an image is used in the menu item and the caption is activated
If the caption of a menu item wraps to several lines; the caption of the other menu items is positioned according to the
option selected here

You can set images for each menu item in the General tab
under Menu item # > Image.
Activate the caption in the Options tab under Menu items
(desktop version) > Image position.

Border
Show

Select to add a border to the paragraph. Do not forget to specify a color for the
border when you activate the option.
Enter the thickness of the border. You can set thickness for each side individually.

Border width

Enter values in pixels (integer values) based on the following example, using
spaces to separate multiple pixel entries:
l

1 = sides uniform with 1 pixel

l

1 2 = 1 pixel on the top and bottom, 2 pixels on the left and right

l

1 2 3 4 = 1 pixel on the top, 2 pixels on the right, 3 pixel on the bottom, 4 pixel
on the left.
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Parameter

Description
If you leave the field blank, the border has a thickness of 1 pixel (uniform on
all sides).
The depiction of non-hex web colors may vary from the original, depending on
the browser.

Color
Mobile...

Set the paragraph width (in percent; 100% default) for mobile view. To display
paragraphs next to each another in mobile view, make sure that the widths of
two consecutive paragraphs combine to 100%. Otherwise, the paragraphs are displayed on top of each another with the assigned widths.

Width

Click profiles tab
Parameter
Click profiles

Description
Clicks on any link in this paragraph are allocated to the selected click profiles. See
Click profiles.

Target groups tab
Parameter

Target groups

Description
To show this paragraph to one or more target groups only, select them. If more
than one target group is selected, just one must match (OR logic). See Target
groups.

Note: If more than one target group is selected for a paragraph, it is
displayed if only one of them matches. Be aware also that paragraphs
that do not occupy the whole width of the newsletter (for example, a
sidebar) may cause unwanted gaps in the newsletter. Test the newsletter with target groups using the Target groups button in the top
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menu of this window and the Send test email to target group function.

Adjusting font settings
To change general font settings (for example, font, font color, font size and so on), adjust
the options in the general settings in the Navigation menu tab under Menu items in the
navigation menu.

Navigation menu layouts
This topic describes:
l
l
l

how customer support sets up alternative HTML layouts
how to select alternative layouts in the navigation menu
how to edit alternative layouts using in-depth knowledge of HTML, CSS, and Velocity

To receive up to five alternative layouts, contact customer support to set up alternative layouts.
To create HTML layouts, set up alternative layouts for mobile and text versions also. If no
alternative layouts are saved for those versions, the default layout is used.
Note: In some cases, some text elements will not be in the order that
you want.

Selecting a layout
1. To select a default layout or up to five alternative layouts, while editing a message in
the Template Kit, on the left side of the preview, in the menu bar of the navigation
menu, click Navigation Menu.
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2. Open the Options tab.
3. In the Layout area, in the Layout drop-down list, select the layout you want to use.

4. Click Apply.
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Editing a layout
You can edit alternative layouts but not the default layout.
Warning: If you lack knowledge of HTML, CSS, and Velocity, contact
customer support to edit the alternative layouts. If you edit them
without in-depth knowledge, serious display errors may occur in your
mailings.
1. In the preview on the left, click Settings.
2. Open the Navigation menu tab. Each layout has source text fields for the desktop,
mobile, and text versions.
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3. Edit the source text of the corresponding layout as needed. See Insert content to learn
how to retrieve and place the various content items.
Note: Set up alternative layouts for mobile and text versions also.
If no alternative layouts are created for these versions, the
default layout is used.
4. Click Apply.
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Inserting content
Access the content of the navigation menu using Velocity variables and format the transferred content using HTML style attributes.
The following Velocity variables are available:
l
l
l

Status. Information on current item paragraphs
Present. For using queries that check for the presence of an element
Value. For issuing the content

Notes for the creation of new layouts
l

l

l

Font definitions. If you are using an alternative layout variant, font definitions must exist
in the HTML you entered. The texts are not formatted by the Template Kit to give you complete freedom in visual design.
Widths. Specify a fixed width or a width in percent. You should enter a percentage,
because this prevents elements from sticking out of the layout.
Danger of display errors. If you edit the layouts without in-depth knowledge of HTML,
serious display errors may occur in your mailings.

Status variables
Variable

Type

$separatorDesktopEnabled

$separatorDisplayVerticalInMobileVersion

Description

Boolean

Contains true if the Show vertical separator lines in
desktop version check box in
the Content section of the
Separator lines tab is selected,
otherwise false.

Boolean

Contains true if the Show vertical separator lines in mobile
version check box in the Content section of the Separator
lines tab is selected , otherwise
false.
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Variable

Type

$separatorDisplayHorizontalInMobileVersion

$hamburgerMenuEnabled

$hamburgerMenuIconRounded

$navigationItemsAmountValue

$navCurrentParagraphId

Description

Boolean

Contains true if the Show horizontal separator lines in
mobile version check box in
the Content section of the
Separator lines tab is selected
, otherwise false.

Boolean

Contains true if the Show
check box in the General section of the Hamburger menu
tab is selected, otherwise
false.

Boolean

Contains true if the Rounding
contours check box in the Icon
section of the Hamburger
menu tab is selected, otherwise
false.

Integer

Contains the number of menu
items that are displayed. Menu
items are only displayed if a link
and either the text or the image
are specified.

Integer

Contains the ID of the respective navigation menu paragraph.
This ID is particularly important
for the mobile version, because
the CSS classes use this ID as a
suffix in the name.

Present Variables
Variable

Type

$item1TextPresent – $item10TextPresent

Boolean
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Contains true if there
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Variable

Type

Description
is content for the Text
box in the Menu item
# area, otherwise
false.

Boolean

Contains true if there
is content for the URL
box in the Menu item
# area, otherwise
false.

Boolean

Contains true if there
is content for the
Image box in the Menu
item # area, otherwise
false.

Boolean

Contains true if there
is content for the Text
color box in the Menu
item # area, otherwise
false.

Boolean

Contains true if there
is content for the Background color box in
the Menu item # area,
otherwise false.

$navigationLinkColorPresent

Boolean

Contains true if there
is content for the Color
box in the general settings under Font settings > Menu items in
the navigation menu,
otherwise false.

$separatorLayoutThicknessPresent

Boolean

Contains true if there
is content for the Thick-

$item1LinkUrlPresent – $item10LinkUrlPresent

$item1ImageUrlPresent – $item10ImageUrlPresent

$item1ColorPresent – $item10ColorPresent

$item1BackgroundColorPresent – $item1BackgroundColorPresen
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Variable

Type

Description
ness box under Separator lines > Layout,
otherwise false.

$separatorLayoutColorPresent

$hamburgerMenuMenuBarHeadlinePresent

$hamburgerMenuMenuBarPaddingPresent

$hamburgerMenuMenuBarBackgroundColorPresent

$hamburgerMenuMenuBarImagePresent

$hamburgerMenuMenuBarImageAltTextPresent

Boolean

Contains true if there
is content for the Color
box under Separator
lines > Layout, otherwise false.

Boolean

Contains true if there
is content for the Heading box under Hamburger menu > Menu
bar, otherwise false.

Boolean

Contains true if there
is content for the Padding box under Hamburger menu > Menu
bar, otherwise false.

Boolean

Contains true if there
is content for the Background color box
under Hamburger
menu > Menu bar, otherwise false.

Boolean

Contains true if there
is content for the
Image box under Hamburger menu > Image,
otherwise false.

Boolean

Contains true if there
is content for the
Alternative text box
under Hamburger
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Variable

Type

Description
menu > Image, otherwise false.

$hamburgerMenuMenuBarImageLinkPresent

$hamburgerMenuIconColorPresent

$hamburgerMenuIconBackgroundColorPresent

$navigationBackgroundImageUrlPresent

$navigationItemDesktopBackgroundColorPresent

$navigationItemDesktopWidthPresent

Boolean

Contains true if there
is content for the Link
box under Hamburger
menu > Image, otherwise false.

Boolean

Contains true if there
is content for the Color
box under Hamburger
menu > Icon, otherwise
false.

Boolean

Contains true if there
is content for the Background color box
under Hamburger
menu > Icon, otherwise
false.

Boolean

Contains true if there
is content for the URL
box under Options
> Background image,
otherwise false.

Boolean

Contains true if there
is content for the Background color box
under Options > Menu
items, otherwise false.

Boolean

Contains true if there
is content for the Background color box
under Options > Menu
items, otherwise false.
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Variable

Type

$navigationItemDesktopPaddingPresent

$navigationItemMobileWidthPresent

$item1DisplayInMobileVersion – $item10DisplayInMobileVersion

Description

Boolean

Contains true if there
is content for the Padding box under
Options > Menu items,
otherwise false.

Boolean

Contains true if there
is content for the
Width box under
Options > Menu items
(mobile version), otherwise false.

Boolean

Contains true if the
Show in mobile version check box under
General > Menu item
# is selected, otherwise
false.

Value-Variables
Variable

Type

$item1TextValue – $item10TextValue

String

$item1TextFormattedValue – $item10TextFormattedValue

String
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Environment

Description

Desktop,
Mobile, Text

Contains the
unformatted
content of the
Text box from
the Menu
item # area.

Desktop,
Mobile

Contains the
formatted content of the
Text box from
the Menu
item # area.
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Variable

Type

Environment

Description
The text is
formatted
using the font
settings from
the general
settings and
the text color
from the
menu item
itself.

$item1LinkUrlValue – $item10LinkUrlValue

String

Desktop,
Mobile, Text

Contains the
unformatted
content of the
URL box from
the Menu
item # area.
Contains the
formatted content of the
URL box from
the Menu
item # area.

$item1LinkFormattedValue – $item10LinkFormattedValue

String

Desktop,
Mobile

The text is
formatted
using the font
settings from
the general
settings and
the text color
from the
menu item
itself.
Note: If you
have
uploaded an
image for the
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Variable

Type

Environment

Description
menu item
and positioned it to
the right or
left of the
text, the link
is displayed
including text
and image.

$item1ImageUrlValue – $item10ImageUrlValue

$item1ColorValue – $item10ColorValue

String

$item1BackgroundColorValue – $item10BackgroundColorValue

$navigationLinkColorValue

String

String

String
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Desktop,
Mobile, Text

Contains the
content of the
Image box
from the
Menu item #
area.

Desktop,
Mobile

Contains the
content of the
Text color
box from the
Menu item #
area.

Desktop,
Mobile

Contains the
content of the
Background
color box from
the Menu
item # area.

Desktop,
Mobile

Contains the
content of the
Color box
from the general settings >
Font settings
tab > Menu
Items in the
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Variable

Type

Environment

Description
Navigation
Menu area.

$separatorLayoutThicknessValue

String

$separatorLayoutColorValue

String

$hamburgerMenuMenuBarHeadlineValue

String

Desktop,
Mobile

Contains the
content of the
Thickness
box from the
Separator
lines tab >
Layout area.

Desktop,
Mobile

Contains the
content of the
Color box
from the
Separator
lines tab >
Layout area.

Mobile

Contains the
unformatted
content of the
Heading box
from the Hamburger menu
tab > Menu
bar area.

$hamburgerMenuMenuBarHeadlineFormattedValue

String

Mobile

Contains the
formatted content of the
Heading box
from the Hamburger menu
tab > Menu
bar area.

$hamburgerMenuMenuBarPaddingValue

String

Mobile

Contains the
content of the
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Variable

Type

Environment

Description
Padding box
from the Hamburger menu
tab > Menu
bar area.

$hamburgerMenuMenuBarBackgroundColorValue

$hamburgerMenuIconPositionValue

String

String

$hamburgerMenuIconColorValue

String

$hamburgerMenuIconBackgroundColorValue

String

© Optimizely 2022

Mobile

Contains the
content of the
Background
color box from
the Hamburger menu
tab > Menu
bar area.

Mobile

Contains the
content of the
Position box
from the Hamburger menu
tab > Icon
area.

Mobile

Contains the
content of the
Color box
from the Hamburger menu
tab > Icon
area.

Mobile

Contains the
content of the
Background
color box from
the Hamburger menu
tab > Icon
area.
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Variable

Type

$hamburgerMenuMenuBarImageUrlValue

$hamburgerMenuMenuBarImageAltTextValue

$hamburgerMenuMenuBarImageLinkValue

$navigationAlignmentValue

$navigationBackgroundImageUrlValue

String

String

String

String

String
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Environment

Description

Mobile

Contains the
content of the
Image box
from the Hamburger menu
tab > Image
area.

Mobile

Contains the
content of the
Alternative
text box from
the Hamburger menu
tab > Image
area.

Mobile

Contains the
content of the
Link box from
the Hamburger menu
tab > Image
area.

Desktop,
Mobile

Contains the
content of the
Alignment
box from the
Options tab >
Layout area.

Desktop,
Mobile

Contains the
content of the
Image box
from the
Options tab >
Background
image area.
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Variable

Type

$navigationBackgroundImageAlignmentValue

$navigationBackgroundImageRepeatValue

$navigationItemDesktopBackgroundColorValue

$navigationItemDesktopWidthValue

$navigationItemDesktopPaddingValue

String

String

String

String

String
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Environment

Description

Desktop,
Mobile

Contains the
content of the
Alignment
box from the
Options tab >
Background
image area.

Desktop,
Mobile

Contains the
content of the
Repeat box
from the
Options tab >
Background
image area.

Desktop,
Mobile

Contains the
content of the
Background
color box from
the Options
tab > Menu
items area.

Desktop,
Mobile

Contains the
content of the
Width
(desktop version) box from
the Options
tab > Menu
items area.

Desktop,
Mobile

Contains the
content of the
Padding box
from the
Options tab >
Menu items
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Variable

Type

Environment

Description
area.

$navigationItemDesktopAlignmentValue

$navigationItemDesktopVerticalAlignmentValue

$navigationItemImageBehaviorValue

String

String

String

Desktop,
Mobile

Contains the
content of the
Text alignment box
from the
Options tab >
Menu items
area.

Desktop,
Mobile

Contains the
content of the
Text position
(next to the
image) box
from the
Options tab >
Menu items
area.

Desktop,
Mobile

Contains the
content of the
Image position box from
the Options
tab > Menu
items area.

$navigationItemMobileWidthValue

String

Mobile

Contains the
content of the
Width box
from the
Options tab >
Menu items
(mobile version) area.

$navigationItemMobileAlignmentValue

String

Mobile

Contains the
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Variable

Type

Environment

Description
content of the
Text alignment box
from the
Options tab >
Menu items
(mobile version) area.

$navigationItemMobileVerticalAlignmentValue

String

Mobile

Contains the
content of the
Text position
(next to the
image) box
from the
Options tab >
Menu items
(mobile version) area.

Field functions
This topic describes how to work with field functions to personalize or adjust mailing content. Optimizely Campaign uses the template engines Dynamic rendering (ODR) and Velocity that lets you create your own field functions.
ODR is an XML-based script language for field functions; Velocity is a Java-based language. You should have some knowledge of HTML/XML or Java because this documentation provides only the basics of using Dynamic Rendering or Velocity. For the most
common use cases you can also use the Optimizely Campaign field function templates.
Note: Dynamic Rendering and Velocity classes and operations
The special feature, Edit Field Functions, provides a wide range of
personalization options for your mailings. However, only classes, operations, and parameters documented in this manual are permitted for

© Optimizely 2022

598 | Optimizely Campaign User Guide 2022-03-14

the creation of field functions. Velocity or Dynamic Rendering code
not documented here may interfere with or damage your mailing templates and affect the sending of mailings.
Read this documentation thoroughly.
Always test user-defined field functions with the personalized preview. If you have any questions or doubts about the code and its correct utilization, contact customer support.

Adding field functions to mailings

In the context of a mailing (paragraph, subject, and so on), you insert field functions using
a placeholder in curly brackets { }. To add a field function to a paragraph, follow these
steps when editing a mailing.
1. In the editor toolbar, click Insert Field Function
2. In the dialog box, select the desired field.
3. Click OK.

.

Tip: If you know the name of a field function, insert the name
between curly brackets wherever you want it to appear in a mailing.
When the mailing is sent, the field function placeholder is replaced
by the content for which the field function stands.

Field function use cases
Field functions replace or personalize content. The field function definition generates a
string (some text) and inserts it in the mailing. Some field functions are a simple replacement, for example they set the name or a date. Others can distinguish among different
cases and replace the content accordingly. Also, field functions can be defined through
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target groups. These only generate text if the recipient matches the target group. The following list gives examples of field functions:
l
l

l

Date. The current date is inserted.
Salutation. A salutation usually contains one for males, another for females, and neutral
term for recipients whose name and gender are unknown.
Subject line. For example, the name or other personalization strings.
Tip: Personalized links
You can use field functions to create personalized links in your mailings. You also can use field function placeholders in the domain part
or path of a URL and in URL parameters. The link tracking of personalized links works as in regular links.

Editing field functions
To edit a field function, select Administration > Field Functions. The overview shows editable field functions. If you are working in a sub-client, the list also shows field functions
inherited from the main client but these cannot be edited. Select a field function from the
list and click Edit….
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To create a new field function, click Create…. If you remove a field function, make sure it is
not used in an active mailing.
l

l

Inheritable. Select if you want to make the field function available in sub-clients. Users
logged into a sub-client can use inherited functions, but not edit them.
Type. Select which rules are applied for validation and execution of a field function:
Note: Do not change the type if you are not sure of what you are
doing.
JSPX. This type accepts only valid XML code.
o Velocity. This type accepts only Velocity code.
Example. Shows a replacement example. Enter an actual example or a description of the
field function that explains the field function.
Content. Enter the field function definition using either Dynamic Rendering or Velocity for
each mailing type, media type (marketing channel) or content type. This may be static
text, dynamic text or both. To create dynamic content, enter commands and queries that
are executed when the mailing is sent.
o

l

l

o

o

o

o
o

Default Replacement. Contains a fallback that is applied if a field function is not
defined. Also, if you do not want to specify different field functions for each email type,
media type, and element type, use this field and leave the others empty.
Text. Write the code and text for the field function used in the text version of a mailing.
HTML. Write the code and text of a field function used in the HTML version of a mailing.
SMS. Write the code and text of a field function used in SMS mailings.
Subject. Write the code and text of a field function used in the subject line of a mailing.

Template engines
Template engines are software tools to process a field function. That is, they read the commands in a field function, query the database, and create an output string. Optimizely Campaign provides two template engines: the proprietary Dynamic Rendering engine, and the
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Velocity engine. The following paragraph introduces these two and lists available classes
and functions.

ODR – Dynamic Rendering
If your are familiar with XML and HTML tags, you can learn how to write field functions in
the Dynamic Rendering language. The following example shows a salutation logic written
in Dynamic Rendering.
Sample code
<odr:choose>
<odr:when test="%{not empty user.data.firstname and not empty user.data.lastname
and user.data.salutation == 'Mrs.'}">
<odr:out value="Dear Mrs. %{user.data.firstname} %{user.data.lastname}," />
</odr:when>
<odr:when test="%{not empty user.data.firstname and not empty user.data.lastname
and user.data.salutation == 'Mr.'}">
<odr:out value="Dear Mr. %{user.data.firstname} %{user.data.lastname}," />
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam," />
</odr:otherwise>
</odr:choose>

Tip: Remarks
l

l

l

l

Line 1. The choose tag initiates a query of several parameters. It contains no
attributes.
Lines 2 and 7. The when tag initiates the query of a single parameter. Attributes are the parameter itself and the values. In the example, the tag checks
whether the fields first and last name in the recipient list are not empty and
whether the field Salutation contains Mrs. or Mr..
Lines 4 and 8. The out tag contains the output string. This is static or dynamic
text or both, like in the example.
Line 12. The otherwise tag defines the output string for cases that do not
match a previous tag. It contains no attributes
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Line breaks, blank spaces and formatting with Dynamic Rendering
Line breaks and blank spaces between Dynamic Rendering tags are escaped during the
rendering. You can insert blank spaces in the running text inside the quotation marks.
HTML tags inside the Dynamic Rendering expressions (that is, inside the quotation marks)
must be written as entities. Use the following entities to escape the respective characters:
l
l
l
l

&lt;. (< less than)
&gt; (> greater than)
&quot; (" quotation mark)
&amp; (& ampersand)

Velocity
Velocity is a Java-based template engine. Velocity algorithms can appear within HTML in a
mailing or a website. An algorithm may contain conditions and fallbacks, which generate
some text if true and another text or no text if false.
Velocity references are initiated with a $ sign, followed by a class and a function. Two
examples are below.

Example: Insert first and last name of a recipient in a salutation
Dear ${user.data.firstname} ${user.data.lastname}!

You also can use the expression ${user.data.[field_name]} to address any field in the
recipient list by replacing [field_name] with the field name.
If your recipient list contains recipients whose first name is unknown, because it is usually
not a mandatory field, the expression shown above needs to be extended. Otherwise, it
could produce a salutation like "Dear Smith!". With Velocity, you can define an alternative
expression, using "Dear Mrs." or "Dear Mr." plus the recipient's last name.
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Example: Salutation with complete name and fallback
To consider possible cases, write an if-then algorithm. This algorithm is initiated with a
pound sign (#) and the command if. Below, the different cases and an alternative (else) are
formulated. The algorithm ends with #end:
#if("$!{user.data.lastname}" != "" &&"$!{user.data.gender}" != "")Dear
#if($user.data.gender.startsWith("male"))Mr.
#if($user.data.gender.startsWith("female"))Mrs.#end $user.data.lastname
#else$!{null}Dear Sir or Madam#end$!{null}

Tip: Remarks
l

Line 1. To formulate the salutation, the recipient's last name and gender must
be known. In this line, the field function checks whether both exist for a given
recipient. (If lastname is not null AND gender is not null...)
If you formulate an #if operation, use the special operator $!. Otherwise, if
the variable is not defined, Velocity would read the variable's name as a
string (and not its value, because there is none) and, when an expression
"does equal" is formulated, the result would be false, because the string is
unequal to a non existing value. The special operator $! suppresses this
expression if the variable it is not defined.
The whole expression is wrapped in quotation marks. If a field is not defined
for a recipient, a query would deliver the result NULL. The quotation marks
transform this into an empty string, which can be validated with conditions
of the type ="" (is empty) or !="" (is not empty).

l
l

l

Line 2. If the gender is male, the correct form "Mr." is chosen.
Line 3. If the gender is female, the form "Mrs." is chosen, followed by the recipient's last name.
Line 4. The placeholder #else creates a fallback, which is used if the first condition does not match, that is if either the last name or the gender are not
known. In this case, a neutral, general salutation is displayed.
If Velocity commands are inserted directly into continuous text, space characters after such commands are ignored. This may cause text that follows a
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Velocity command to be interpreted together with the command. The result is a syntax error. To avoid such errors, a NULL object must be inserted
between the Velocity command and the text: $!{null}. This object does
not generate any output but closes the preceding command.
Close Velocity-Code with the Tag #end. After this tag, insert a line break.

Velocity classes and functions
Optimizely Campaign provides several classes and functions that you can use to define
field functions.
l

$user.data

l

$bmFormat

l

$bmMimeType

l

$filter

$user.data
Query fields of a recipient list. Use this function either to insert the value of a field (such as
a user's name) in a mailing (placeholder), or to check if the field matches a given value (ifthen-function).
Function

Velocity code

Value equals a string value

$user.data.[field_name] == "string"

Value equals a numeric value

$user.data.[field_name] == X

Value does not equal a string
value

$user.data.[field_name] != "string"

Value starts with a string value

$user.data.[field_name].startsWith ("string")

Value does not equal a numeric

$user.data.[field_name] != X
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Function

Velocity code

value
Value is less than or equals a
numeric value

$user.data.[field_name] <= X

Value is greater than or equals a
numeric value

$user.data.[field_name] >= X

Value is greater than a numeric
value

$user.data.[field_name] > X

Special function: IsOnlineVersion

$user.data.bmIsOnlineVersion

Use IsOnlineVersion to check whether the online version of a newsletter is currently displayed. The return value is true. To hide the link to the online version, if it is already displayed, specify the following Velocity code:
#if($user.data.bmIsOnlineVersion)cLICK <a href="{Online-Version-Link}"
target="_blank">here</a> to read an online version of this newsletter.

$bmFormat
Format a value within this expression. You can only format dates and numeric values, but
you can add an optional pattern or the number of decimal places (precision). The following
code show an example of using $bmFormat:
You registered with us on $bmFormat.formatDate($user.data.created)

Function

Velocity code

Format as percentage

$bmFormat.formatPercentage

Format as currency. If the parameter includeCurrencySymbol is set to true, the currency symbol is displayed.

$bmFormat.formatCurrency
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Function

Velocity code

Format a date

$bmFormat.formatDate

Format a date and time

$bmFormat.formatDateTime

Format a time

$bmFormat.formatTime

Attributes for formatting numeric values
Attribute

Description
l

Numeric values. Use the pattern ###,###,###.## or 000000.000.
# stands for a digit, 0 for leading or trailing zeros.
The dot indicates a decimal separator and can only appear once in the pattern. The comma is used is used as a grouping symbol and can appear any
number of times, except after the decimal point where it may not appear.

pattern

Note: The output that this creates has numeric values appear with German formatting; that is, the
grouping symbol (comma in the pattern) is displayed
as a dot and the decimal separator (dot in the pattern) is displayed as a comma—for example
"1.000,00". English formatting (for example
"1,000.00") is not supported.
Examples for the value 1000:
Pattern

Output

###,###,###.##

1.000

000,000,000.00

000.001.000,00

##,##.0###

10.00,0

###.###.###.##

✘ invalid, there are too many dots
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✘ invalid, the comma appears after the dot
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Attribute

Description
l

Date values. Use the pattern dd.MM.yyyy.

l

Time values. Use the pattern hh:mm:ss.
For more information about formatting numbers and dates, see the Java
documentation from Oracle.

precision

Integer value that specifies the number of decimal places to which the output
value should be rounded.

$bmMimeType
Query the mime type of the mailing that is currently rendered.
Mime Type

Velocity code

Plain text emails

$bmMimeType == "text/plain"

HTML emails

$bmMimeType == "text/html"

$filter
Invoke a target group. The submitted string must match a target group ID of your Optimizely Campaign client. To get the IDs of your target groups, contact customer support. Do
not use an ID if you are not sure it matches a target group; otherwise, your template does
not work properly. The Velocity code for this function is as follows:
$filter.filterByRevisionedFilter

Field function templates
The following topics provide you with Velocity and ODR templates that let you create your
own field functions:
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l

Personalized salutations

l

Recipient data

l

Mailing details

l

External data

l

Special functions

l

Hashing and encoding

Personalized salutations
This topic describes ODR and Velocity salutation logics. By default, Optimizely Campaign
uses ODR salutation logic.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.

ODR
Below you can find standard and special ODR salutation logics including field function templates.
Note: ODR cannot display special characters as HTML codes. Since
some email programs require the respective HTML codes to display
special characters correctly, you must use Velocity for these cases.

Salutations without title
You can use the following ODR code for the personalized salutation Dear Mrs., Dear Mr. or
Dear Sir or Madam:
<odr:set value="%{lower(user.data.salutation)}" var="salut"/>
<odr:set value="%{user.data.lastname}" var="lname"/>
<odr:choose>
<odr:when test="%{not isEmpty(lname) and (salut eq 'mr' or salut eq 'mrs')}">
<odr:choose>
<odr:when test="%{salut eq 'mr'}">
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<odr:out value="Dear Mr." />
</odr:when>
<odr:when test="%{salut eq 'mrs'}">
<odr:out value="Dear Mrs." />
</odr:when>
</odr:choose>
<odr:out value=" %{lname}" />
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam" />
</odr:otherwise>
</odr:choose>

Salutations with title
If your recipient list contains a recipient list field for the salutation title, you can display it
with the following ODR code:
<odr:set value="%{lower(user.data.salutation)}" var="salut"/>
<odr:set value="%{user.data.title}" var="title"/>
<odr:set value="%{user.data.lastname}" var="lname"/>
<odr:choose>
<odr:when test="%{not isEmpty(lname) and (salut eq 'mr' or salut eq 'mrs')}">
<odr:choose>
<odr:when test="%{salut eq 'mr'}">
<odr:out value="Dear" />
</odr:when>
<odr:when test="%{salut eq 'mrs'}">
<odr:out value="Dear" />
</odr:when>
</odr:choose>
<odr:choose>
<odr:when test="%{not isEmpty(title)}">
<odr:out value=" %{title}" />
</odr:when>
</odr:choose>
<odr:out value=" %{lname}" />
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam" />
</odr:otherwise>
</odr:choose>

Mixed salutations
If you have different entries in the recipient list field for the salutation, you can use the following ODR code
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<odr:set value="(m|1|male|mr|mr.)" var="male" />
<odr:set value="(w|2|f|female|mrs|mrs.)" var="female" />
<odr:set value="%{user.data.lastname}" var="lastname" />
<odr:set value="%{lower(user.data.salutation)}" var="salutation" />
<odr:choose>
<odr:when test="%{!isEmpty(lastname) and (matches(salutation, male) or matches
(salutation, female))}">
<odr:choose>
<odr:when test="%{matches(salutation, female)}">
<odr:out value="Dear Mrs." />
</odr:when>
<odr:when test="%{matches(salutation, male)}">
<odr:out value=Dear Mr." />
</odr:when>
</odr:choose>
<odr:out value=" %{lname}" />
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam" />
</odr:otherwise>
</odr:choose>

Tip: The code example assumes that the recipient list field contains
the values M, 1, Male, Mr, Mr. or W, 2, F, Female, Mrs, Mrs..

Note: If Mr and Mrs are queried, the female salutation must be given
first, since Mr applies to both male and female. Otherwise, the male
salutation is always displayed.

Multiple salutations
If you have multiple recipient list fields for different salutations, you can use the following
ODR code as default replacement:
Note: You must reference appropriate recipient list fields for both
salutations and last names.
<odr:set
<odr:set
<odr:set
<odr:set

value="%{lower(user.data.salutation)}" var="salut"/>
value="%{user.data.lastname}" var="lname"/>
value="%{lower(user.data.salutation2)}" var="salut2"/>
value="%{user.data.lastname2}" var="lname2"/>
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<odr:choose>
<odr:when test="%{(not isEmpty(lname) and (salut eq 'mr' or salut eq 'mrs'))
and (not isEmpty(lname2) and (salut2 eq 'mr' or salut2 eq 'mrs'))}">
<odr:choose>
<odr:when test="%{(salut eq 'mrs') and (salut2 eq 'mrs')}">
<odr:out value="Dear Mrs. %{lname}," />
<odr:out value="&lt;br&gt;"/>
<odr:out value="dear Mrs. %{lname2},"/>
</odr:when>
<odr:when test="%{(salut eq 'mr') and (salut2 eq 'mrs')}">
<odr:out value="Dear Mrs. %{lname2}," />
<odr:out value="&lt;br&gt;"/>
<odr:out value="dear Mr. %{lname},"/>
</odr:when>
<odr:when test="%{(salut eq 'mrs') and (salut2 eq 'mr')}">
<odr:out value="Dear Mrs. %{lname}," />
<odr:out value="&lt;br&gt;"/>
<odr:out value="dear Mr. %{lname2},"/>
</odr:when>
<odr:when test="%{(salut eq 'mr') and (salut2 eq 'mr')}">
<odr:out value="Dear Mr. %{lname}," />
<odr:out value="&lt;br&gt;"/>
<odr:out value="dear Mr. %{lname2},"/>
</odr:when>
</odr:choose>
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam" />
</odr:otherwise>
</odr:choose>

You must also add the following ODR code as text content:
Note: You must reference appropriate recipient list fields for both
salutations and last names.
<odr:set value="%{lower(user.data.salutation)}" var="salut"/>
<odr:set value="%{user.data.lastname}" var="lname"/>
<odr:set value="%{lower(user.data.salutation2)}" var="salut2"/>
<odr:set value="%{user.data.lastname2}" var="lname2"/>
<odr:set value="%{character('10')}" var="br"/>
<odr:choose>
<odr:when test="%{(not isEmpty(lname) and (salut eq 'mr' or salut eq 'mrs'))
and (not isEmpty(lname2) and (salut2 eq 'mr' or salut2 eq 'mrs'))}">
<odr:choose>
<odr:when test="%{(salut eq 'mrs') and (salut2 eq 'mrs')}">
<odr:out value="Dear Mrs. %{lname}," />
<odr:out value="%{br}"/>
<odr:out value="dear Mrs. %{lname2},"/>
</odr:when>
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<odr:when test="%{(salut eq 'mr') and (salut2 eq 'mrs')}">
<odr:out value="Dear Mrs. %{lname2}," />
<odr:out value="%{br}"/>
<odr:out value="dear Mr. %{lname},"/>
</odr:when>
<odr:when test="%{(salut eq 'mrs') and (salut2 eq 'mr')}">
<odr:out value="Dear Mrs. %{lname}," />
<odr:out value="%{br}"/>
<odr:out value="dear Mr. %{lname2},"/>
</odr:when>
<odr:when test="%{(salut eq 'mr') and (salut2 eq 'mr')}">
<odr:out value="Dear Mr. %{lname}," />
<odr:out value="%{br}"/>
<odr:out value="dear Mr. %{lname2},"/>
</odr:when>
</odr:choose>
</odr:when>
<odr:otherwise>
<odr:out value="Dear Sir or Madam" />
</odr:otherwise>
</odr:choose>

Velocity
You can use the following Velocity code as standard replacement for the personalized
salutation Dear Mrs., Dear Mr. or Dear Sir or Madam:
Tip: To convert special characters into HTML code, the Velocity code
includes the function $HtmlUtils.encodeEntities().
#set($salutation = $!user.data.salutation)
#set($lastname = $!user.data.lastname)
#if (!$StringHelper.isEmpty($salutation) && !$StringHelper.isEmpty($lastname) &&
($salutation.equals("Mr") || $salutation.equals("Mrs")))
#if ($salutation.equals("Mr"))
Dear Mr.
#else
Dear Mrs.
#end
$HtmlUtils.encodeEntities($user.data.lastname)
#else
Dear Sir or Madam
#end

You must also add the following Velocity code (without the function $HtmlUtils.encodeEntities()) as single-line text content:
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#set($salutation = $!user.data.salutation)#set($lastname = $!user.data.lastname)#if (!$StringHelper.isEmpty($salutation) && !$StringHelper.isEmpty
($lastname) && ($salutation.equals("Mr") || $salutation.equals("Mrs")))#if ($salutation.equals("Mr"))Dear Mr. #else$!{null}Dear Mrs. #end$user.data.lastname#else$!{null}Dear Sir or Madam#end

Recipient data
This topic describes how you can use field functions to process recipient data and modify
texts and time specifications.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.

Formatting dates
For example, if you have a recipient list field for the date of the last purchase, you can use
a field function to display the date in the mailing text: We miss you! You last ordered something on 14.01.2020 and we would be happy to see you again! Enclosed you will find a $10
shopping voucher!
Since the date is stored in a standard format and would be displayed in the mailing text as
2020-01-14 10:12:00.0, for example, you can format the date using the following Velocity
code:
$DateTimeHelper.formatDate("dd.MM.yyyy", $user.data.date)

Displaying dates from recipient list fields
To display dates from recipient list fields as formatted text, you can use the following Velocity code:
#if(!$StringHelper.isEmpty($!user.data.date))$DateTimeHelper.formatDate
("dd.MM.yyyy", $user.data.date)#end
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Displaying the current date
To display the current date as formatted text, you can use the following Velocity code:
$DateTimeHelper.formatDate("dd.MM.yyyy", $DateTimeHelper.getCurrentDate().getTime
())

Displaying the current calendar week
To display the current calendar week as formatted text, you can use the following Velocity
code:
$DateTimeHelper.formatDate("ww", $DateTimeHelper.getCurrentDate().getTime(), $Common.locale("en", "EN", ""))

Displaying periods in years
To output the period in years between the current date and the date in a recipient list field
as formatted text, you can use the following Velocity code:
#set($date = $user.data.DATE_RECIPIENT_LIST_FIELD_NAME)
#if ($StringHelper.isEmpty($date))
#set($date = $DateTimeHelper.getCurrentDate().getTime())
#end
#set($durationList = $StringHelper.splitToList($DateTimeHelper.getDuration
($date), 'd', false, true))
#if ($durationList.size() > 1)
#set ($days = $StringHelper.string2int($durationList.get(0), 0))
#else
#set ($days = 0)
#end
#set($years = $days / 365)
#if ($years >= 1)
You are our customer for #if ($years == 1)year#else$years years#end!
#end

Tip: The Velocity code displays, for example, the following text: You
are our customer for 26 years!
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Numbers and comparisons
You can use Velocity to compare numbers from recipient list fields.

Greater than
#if($user.data.RECIPIENTLISTFIELD > 10)
OUTPUT
#end

Greater or equal
#if($user.data.RECIPIENTLISTFIELD >= 10)
OUTPUT
#end

Less than
#if($user.data.RECIPIENTLISTFIELD < 10)
OUTPUT
#end

Less or equal
#if($user.data.RECIPIENTLISTFIELD <= 10)
OUTPUT
#end

Equal
#if($user.data.RECIPIENTLISTFIELD == 10)
OUTPUT
#end
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Unequal
#if($user.data.RECIPIENTLISTFIELD != 10)
OUTPUT
#end

Generating random numbers
To generate a random number, for example to load a random image from the file server,
you can use the following Velocity code:
#set ($random = $MathHelper.random(10))$random

Tip: The Velocity code displays a number between 0 and 10. It can
also be a 0.

Replacing texts
To replace text from recipient list fields (for example HTML code with special characters
for the text version), you can add the following ODR code as text content:
<odr:set value="%{user.data.RECIPIENTLISTFIELD}" var="content"/>
<odr:set value="WHAT" var="what"/>
<odr:set value="WITH" var="with"/>
<odr:set value="%{replace(content,what,with)}" var="newtext"/>
<odr:out value="%{newtext}"/>

Adding blank lines to the text version
To convert HTML breaks (<br>) to blank lines for the text version, you can add the following ODR code as text content:
<odr:set value="%{user.data.RECIPIENTLISTFIELD}" var="content"/>
<odr:set value="WHAT" var="what"/>
<odr:set value="%{character('10')}" var="with"/>
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<odr:set value="%{replace(content,what,with)}" var="newtext"/>
<odr:out value="%{newtext}"/>

Upper or lower case letters
You can use the following Velocity code to display text from recipient list fields as uppercase letters:
$user.data.RECIPIENTLISTFIELD.toUpperCase()

You can use the following Velocity code to display text from recipient list fields as lowercase letters:
$user.data.RECIPIENTLISTFIELD.toLowerCase()

Generating bar codes
If you use the coupon system to generate machine-readable bar codes, you can use Velocity to create bar code field functions based on your recipient list fields.
To create bar code field functions, you need the following information:
l

l

Recipient list field. Internal name of the recipient list field you want to use for the bar
code.
Bar code type. Select one of the following bar code types:
o
o

EAN-13 bar code. Use the value ean13barcode.
Code 128 bar code. Use one of the following values:
Default character set: code128barcode (automatically switches between the character sets A, B, and C)
n Character set A: code128abarcode
n Character set B: code128bbarcode
n Character set C: code128cbarcode
Interleaved 2 of 5 bar code. Use the value twooffivebarcode.
n

o
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Tip: For more information about bar code types, see Creating
coupon blocks.
l

Bar code size. You can specify the bar code size using the width and height in pixels or
the line thickness in pixels (1-10). If you do not specify any size, the default size of 350
pixels (width) and 200 pixels (height) is used.

Insert the field function into your mailing using the image tag (<img src="
{fieldfunction}"/>). Alternatively, you can create the field function directly with image tag,
for example, <img src="${barcodeCouponImage.getImageUrlFor($user.data.coupon, "twooffivebarcode", 9)}"/>.

Width and height size option
${barcodeCouponImage.getImageUrlFor($user.data.RECIPIENTLISTFIELD, "BARCODETYPE",
WIDTH, HEIGHT)}

Line thickness size option
${barcodeCouponImage.getImageUrlFor($user.data.RECIPIENTLISTFIELD, "BARCODETYPE",
LINETHICKNESS)}

Generating QR codes
If you use the coupon system to generate machine-readable QR codes, you can use Velocity to create QR code field functions based on your recipient list fields.
To create QR code field functions, you need the following information:
l

l
l

Recipient list field. Internal name of the recipient list field you want to use for the QR
code.
Bar code type. For the line thickness size option, specify the type "qrcode".
QR code size. You can specify the QR code size using the width and height in pixels (1001850) or the line thickness in pixels (1-10).

Insert the field function into your mailing using the image tag (<img src="
{fieldfunction}"/>). Alternatively, you can create the field function directly with image tag,
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for example, <img src="${barcodeCouponImage.getImageUrlForQrCode($user.data.coupon, 300)}"/>.

Width and height size option
${barcodeCouponImage.getImageUrlForQrCode($user.data.RECIPIENTLISTFIELD,
WIDTHANDHEIGHT)}

Line thickness size option
${barcodeCouponImage.getImageUrlFor($user.data.RECIPIENTLISTFIELD, "qrcode",
LINETHICKNESS)}

Mailing details
This topic describes how to process mailing details using field functions.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.

Displaying an email's dispatch date
To display an e-mail's dispatch date as formatted text, you can use the following Velocity
code:
#if($user.data.bmIsOnlineVersion)$DateTimeHelper.formatDate('dd.MM.yyyy',
$m2u.created)#else$DateTimeHelper.formatDate('dd.MM.yyyy', $DateTimeHelper.getCurrentDate().getTime())#end

Tip: The dispatch date refers to the time when the online version of
the email (bmIsOnlineVersion) is created. This is most important for
transactional mails, where the actual dispatch of the email only starts
as soon as a trigger (such as generated post-click) is fired or an event
(such as anniversary) occurs.
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Processing the dispatch date
To display the dispatch date plus a defined time period as formatted text, you can use the
following Velocity code:
#set($daysToAdd = 50)#if($user.data.bmIsOnlineVersion)$DateTimeHelper.formatDate
('dd.MM.yyyy', $DateTimeHelper.addDays($m2u.created, $daysToAdd))#else$DateTimeHelper.formatDate('dd.MM.yyyy', $DateTimeHelper.addDays
($DateTimeHelper.getCurrentDate().getTime(), $daysToAdd))#end

Tip: The Velocity code adds 50 days to the dispatch date. This is useful, for example, to indicate the validity of promotional offers.

Displaying the sender's address
To display the email's sender's address, you can use the following Velocity code:
$mailing.mailingConfig.messageConfig.header.from.email.render(null)

Displaying the recipient list name
To display the recipient list name, you can use the following Velocity code:
$user.data.userlist.name

To use the recipient list name in a URL, you must encode it first:
$NetHelper.urlEncode($user.data.userlist.name)

Displaying the recipient list ID
To display the recipient list ID, you can use the following Velocity code:
$user.data.userlist.id
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Displaying the recipient ID
To display the recipient ID, you can use the following Velocity code:
$user.data.id

Displaying the client ID
To display the client ID, you can use the following Velocity code:
$mailing.mailingGroup.id

Displaying the client name
To display the client name, you can use the following Velocity code:
$mailing.mailingGroup.name

Displaying the mailing name
To display the mailing name, you can use the following Velocity code:
$mailing.name

Displaying the mailing description
To display the mailing description, you can use the following Velocity code:
#if (!$StringHelper.isEmpty($mailing.description))$NetHelper.urlEncode($mailing.description)#else$!{null}unknown#end

Tip: The mailing description is displayed URL-encoded, for example
This+is+a+test+mailing. If no description is available, unknown is displayed.
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Comparing recipients with target groups
To check whether a recipient belongs to a certain target group and display a corresponding text, you can use the following Velocity code:
#if($filter.filterByRevisionedFilters("TARGETGROUPID", false))Foo#else$!
{null}Bar#end

Tip: In the Velocity code, Foo is the output if the recipient belongs to
the target group and Bar is the output if the recipient does not
belong to the target group.

Displaying the image host
To display the host of the file server where an image is stored, you can use the following
ODR code:
<odr:set value="%{imageHost(m2u)}" var="host"/>
<odr:out value="%{host}"/>

Yo can also display the image host using the following Velocity code:
$!bmOdr.out("%{imageHost(m2u)}")$!{null}

External data
This topic describes how to process external data using field functions.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.
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Displaying a JSON string as text in a mailing
If you retrieve data via API and store it as a JSON string, you can display the content as
text with the following velocity code:
#set ($jsonContent = $json.readFromString(${jsonString}))

If recipient list fields contain data as JSON, you can display the content as text using the
following velocity code:
#set ($jsonContent = $json.readFromString($!{user.data.RECIPIENTLISTFIELD}))

Example
You have a recipient list with a custom field in text format that contains the following
JSON string:
{"clearname": "John Smith", "unsubscribelink": "http://www.example.com/unsubscribe/user-id-1234"}

In the mailing, you can use the JSON string using velocity code as follows:
#set ($jsonContent = $json.readFromString($!{user.data.custom}))
Hello ${jsonContent.clearname}! To unsubscribe from the newsletter, click <a hreff="${jsonContent.unsubscribelink}">here</a>.

Displaying post-click data
Velocity lets you access the following post-click data and display it in a mailing:

l

service ("name_of_service")
stringValue("x")

l

is()
o isNot()
floatValue("X")

l

o

o
o

isGreaterThan("y")
isLessThan("y")
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o
o

isGreaterThanOrEqualTo("y")
isLessThanOrEqualTo("y")
Tip: Using velocity field functions, you can display only the most
recent post-click data. You cannot display older data.

Example
The following Velocity code lets you display the value of gvalue10 in the serviceName service:
#set($strGvalue = $!postClick.find().where().service().is("serviceName").getStringResult(10))
$strGvalue

Special functions
This topic describes special field functions in Velocity and ODR.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.

Different unsubscribe confirmation pages by recipient list
By default, the unsubscribe link in the mailing only redirects to one confirmation page. To
display different unsubscribe confirmation pages depending on the recipient list (such as
by language), you can use the following ODR code:
<odr:set value="%{user.data.userlist.id}" var="elid"></odr:set>
<odr:set value="(RECIPIENTLISTID_01|RECIPIENTLISTID_02)" var="de" ></odr:set>
<odr:set value="(RECIPIENTLISTID_03)" var="pl" ></odr:set>
<odr:choose>
<odr:when test="%{matches(elid,de) or matches(elid,pl)}">
<odr:choose>
<odr:when test="%{matches(elid,de)}">
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe.html"></odr:out>
</odr:when>
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<odr:when test="%{matches(elid,pl)}">
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe_pl.html"></odr:out>
</odr:when>
</odr:choose>
</odr:when>
<odr:otherwise>
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe_en.html" ></odr:out>
</odr:otherwise>
</odr:choose>

In this example, all recipients who are addressed via the recipient lists with the IDs
RECIPIENTLISTID_01 or RECIPIENTLISTID_02 are forwarded to the German confirmation
page after clicking the unsubscribe link. Recipients who are addressed via the recipient list
with the ID RECIPIENTLISTID_03 are forwarded to the Polish confirmation page after clicking the unsubscribe link. Fallback is the English confirmation page.

Different unsubscribe confirmation pages by language
The following ODR code lets you redirect recipients whose language is stored in a recipient list field to the appropriate language version of the confirmation page after they click
the unsubscribe link:
<odr:set value="%{lower(user.data.language)}" var="language"></odr:set>
<odr:set value="(german)" var="de" ></odr:set>
<odr:set value="(polish)" var="pl" ></odr:set>
<odr:choose>
<odr:when test="%{matches(language,de) or matches(lang,pl)}">
<odr:choose>
<odr:when test="%{matches(language,de)}">
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe.html"></odr:out>
</odr:when>
<odr:when test="%{matches(language,pl)}">
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe_pl.html"></odr:out>
</odr:when>
</odr:choose>
</odr:when>
<odr:otherwise>
<odr:out value="http://api.campaign.episerver.net/http/mail/{bmMailId}/unsubscribe?bmUrl=http://www.srv2.de/unsubscribe_en.html" ></odr:out>
</odr:otherwise>
</odr:choose>
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Different online versions by language
The following Velocity codes let you display a text in the email header with a link to the
online version of the mailing in different languages. Depending on which language is
stored in the language recipient list field, the corresponding language version is displayed.

Online version with sending domain and mail ID
#set($lang = $!user.data.language.toLowerCase())
#if ($lang.equals("de"))
Wenn diese E-Mail nicht richtig angezeigt wird, klicken Sie <a hreff="https://www.example.com/ov?m2u={bmMailId}">hier</a>.<br />
#else
If this email does not display correctly <a href="https://www.example.com/ov?m2u=
{bmMailId}">click here</a> to view the online version.<br />
#end

Note: If you change the shipping domain, the online version can no
longer be retrieved.

Online version via HTTP API
#set($lang = $!user.data.language.toLowerCase())
#if ($lang.equals("de"))
Wenn diese E-Mail nicht richtig angezeigt wird, klicken Sie <a hreff="https://api.campaign.episerver.net/http/mail/{bmMailId}/onlineversion?bmMailingId=$mailing.id">hier</a>.<br />
#else
If this email is not displayed correctly <a hreff="https://api.campaign.episerver.net/http/mail/{bmMailId}/onlineversion?bmMailingId=$mailing.id">click here</a> to view the online
version.<br />
#end

Tip: This Velocity code makes the online version independent of the
sending domain.
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Hashing and encoding
This topic describes how to encode data and create hash values using field functions.
Note: Use your specific data and recipient list fields, and test the
field functions before using them in a mailing.

Base64
Base64 is an encoding method to not display data in clear text.
Note: Base64 is not an encryption method, as you can decode the
encoded data.
To encode the content of a recipient list field using Base64, you can use the following Velocity code as a default replacement:
#if(!$StringHelper.isEmpty($!user.data.RECIPIENTLISTFIELD))${bmMisc.encodeBase64
($user.data.RECIPIENTLISTFIELD)}#end

Tip: Since the contents of recipient list fields can also be empty
(unknown, NULL value), the code example converts possible NULL
values into empty string values.

MD5
MD5 is a hash method that lets you create checksums, for example to verify data integrity.
Note: MD5 is not an encryption method. Hashing is not reversible. In
addition, MD5 is not collision free, because different inputs can lead
to the same hash value.
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The following field function templates additionally use a key to increase the security
factor:

Velocity
#set ($key = "1234567890")
#set ($string = "STRINGWERT$key")
$StringHelper.md5($string)

ODR
<odr:set var="key" value="1234567890" />
<odr:set var="string" value="STRINGWERT%{key}" />
<odr:out value="%{md5(string)}" />

MD5 and Base64
The following Velocity code uses a key (0123456789) for MD5 hashing. The recipient data
is encoded using Base64. The code also checks if the recipient list field is empty. Finally,
the function $StringHelper.md5() generates a hash value from the sequential Base64
values.
#set($key = "0123456789")
#set($email = "$bmMisc.encodeBase64($!user.data.email)")
#if(!$StringHelper.isEmpty($!user.data.salutation))
#set($salutation = "$bmMisc.encodeBase64($!user.data.salutation)")
#end
#if(!$StringHelper.isEmpty($!user.data.firstname))
#set($firstname = "$bmMisc.encodeBase64($!user.data.firstname)")
#end
#if(!$StringHelper.isEmpty($!user.data.lastname))
#set($lastname = "$bmMisc.encodeBase64($!user.data.lastname)")
#end
#if(!$StringHelper.isEmpty($!user.data.sender))
#set($sender = "$bmMisc.encodeBase64($!user.data.sender)")
#end
#set($name = "$bmMisc.encodeBase64($mailing.name)")
#if(!$StringHelper.isEmpty($!user.data.shopsource))
#set($shopsource = "$bmMisc.encodeBase64($!user.data.shopsource)")
#end
#set($string = "$!email$!salutation$!firstname$!lastname$!sender$!name$!shopsource$!key")
$StringHelper.md5("$string")

© Optimizely 2022

Managing content | 629

SHA256
SHA256 is another method to create hash values from recipient data.
Note: SHA256 can only process String values in Velocity.
To encode the content of a recipient list field using SHA256, you can use the following
Velocity code as your default replacement:
#set($string = "STRINGVALUE")
$StringHelper.sha256($string)

SHA256 and Base64
The following Velocity Code uses SHA256 and Base64 to encode the recipient's email
address:
${bmMisc.hashSha256AndEncodeBase64($user.data.email)}

Coupon system
Note: To enable this feature, contact customer support.
The coupon system lets you:
l
l
l
l

Include coupon codes in mailings that recipients may redeem in your web shop.
Integrate blocks of coupon codes with a placeholder.
Manually or automatically add coupon codes to a coupon block.
On request: Display coupon codes as machine-readable bar codes or QR codes.

You can manage the coupon system via the Optimizely Campaign user interface. You can
also manage the coupon system remotely using the following Optimizely Campaign programming interfaces:
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l

REST API

l

SOAP API via web services CouponBlockWebservice and CouponCodeWebservice

Assigning coupon codes
During dispatch, static or dynamic coupon codes are assigned to the mailings and recipients (MailingToUser ID). This ensures that each coupon code of a coupon block is only
sent once.

Tracking coupon codes sent in a mailing
In the Manage Coupon Blocks window, click Download Assignments to download the
assignment of sent coupon codes in a CSV file. The file contains the
l
l
l
l
l
l

coupon block ID
coupon code
recipient ID (generally, the email address)
recipient list ID
mailing ID
mailing's creation and modification dates

Inserting coupon codes in a mailing
To send coupon codes in a mailing, insert a placeholder where the code will be displayed.
Find the placeholder in the Details area of the Manage Coupon Blocks window.
{Coupon Block:12345678901}

The coupon code is displayed as plain text in the email.
If you want to send several coupons in an email, use several coupon blocks. However, if
you insert the same placeholder several times in a mailing, only one coupon code is sent.

Testing emails
By default, coupon codes in test emails are disabled, and a special placeholder with no
function replaces the active coupon code.
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To enable real coupon codes for test cases, check the box Use valid coupon codes in
test emails in the details of a coupon block or when creating coupon blocks.

Coupon blocks
Coupon codes are organized using containers known as coupon blocks. You manage
coupon blocks on a client level, so you can use the same coupon block in multiple mailings
in your client.
A mailing may only contain one coupon code from the same coupon block. If you insert two
coupon codes from the same block, the mailing displays the same code twice but uses only
one coupon code.
In contrast, if you want recipients to receive several different coupons in a mailing, include
coupon codes from different coupon blocks. Also, a recipient can receive several coupon
codes from the same coupon block if they are sent in separate mailings.

Managing coupon blocks
To manage and edit coupon blocks, open the Optimizely Campaign menu and select More
> Manage Coupon Blocks.

In the list, click a coupon code to display its details.
l
l

Name. Used internally by the coupon code system.
Field function. Use this placeholder to insert the coupon block in a mailing.
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l

Type. One of the following:
Static
o Generated
o EAN-13 bar code
o Code 128 bar code
o Interleaved 2 of 5 bar code
o QR code
Created. The creation date of the coupon block.
Last modified. The modification date of the coupon block.
Total coupon codes. Number of codes a coupon block contains (for static and bar code
blocks) or how many codes were already generated (for generated blocks).
Free coupon codes. Number of free codes in a coupon block. For generated coupon
blocks, the value is infinite.
Use valid coupon codes in test emails. Check this box to use valid coupon codes in
your test emails.
o

l
l
l

l

l

The buttons below the overview let you perform the following actions:
l

Creating coupon blocks

l

Renaming coupon blocks

l

Deleting coupon blocks

l

Deleting unused codes

l

Importing codes

l

Downloading assignments

l

Downloading codes

l

Editing thresholds

l

Editing bar code blocks

Creating coupon blocks
Prerequisite: If you want use static coupon blocks, you must first import them. See Importing codes.
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1. In the overview, , click Create…. The Create New Coupon Block window opens.
2. In the Name box, enter a descriptive name for the coupon block, so you can identify it
later.

3. In the Type area, select a coupon block type.
Tip: Bar codes and QR codes are additional features to be requested from customer support.
l

l

Static. Use if you want to release a limited number of coupon codes or generate
coupon codes from your CMS. Static coupon blocks are imported into Optimizely
Campaign in a CSV file format. See Importing codes.
Generated. Coupon blocks are dynamically generated by Optimizely Campaign
during dispatch and are typically unlimited. These coupons are generated with one
coupon block.
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l

l

EAN-13 bar code. Bar code blocks convert a 13-digit code into a machine-readable bar code and insert it as a graphic into a mailing. The encoding of the bar
code conforms to the EAN-13 specification. The coupon system ensures that bar
codes are unique and only used once. No items are encoded, but a unique code is
assigned to each recipient. To manually import coupon codes into a bar code
block, see Importing codes.
Code 128 bar code. Bar code blocks convert an alphanumeric code of any length
into a machine-readable bar code and insert it as a graphic into a mailing. The
Code 128 bar code supports the full ASCII character set and automatically
switches between the Code 128 bar code character sets A, B, and C to best encode
your data.
You can also select the Code 128 bar code character set manually:
o
o
o

Character set A. Supports the ASCII character set without lower case letters.
Character set B. Supports the ASCII character set without control codes.
Character set C. Supports pairs of digits from 00 to 99.

To manually import coupon codes into a bar code block, see Importing codes.
Interleaved 2 of 5 bar code. Bar code blocks convert a numeric code of any
length into a machine-readable bar code and insert it as a graphic into a mailing.
The Interleaved 2 of 5 bar code is a numeric bar code that only supports pairs of
digits from 00 to 99. To manually import coupon codes into a bar code block, see
Importing codes.
l
QR code. QR code blocks convert an alphanumeric code of any length into a
machine-readable QR code and insert it as a graphic into a mailing. The QR code
supports the full UTF-8 character set. To manually import coupon codes into a QR
code block, see Importing codes.
4. To use valid coupon codes in your test emails, check the Use valid coupon codes in
test emails box.
5. Click Save.
l

Tip: For more individual coupons you can also use field functions to
create bar codes and QR codes that refer to a specific recipient list
field. See Recipient data.
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Renaming coupon blocks
In the overview, select the coupon block you want to rename and click Rename…. Enter a
new name and click Submit.

Deleting coupon blocks
In the overview, select the coupon block you want to delete and click Delete Block
> Delete. Coupons in the block that have been sent but not redeemed remain valid.
Note: When deleting a coupon block, its histories and any assignments are lost.

Deleting unused codes
In the overview, select the coupon block you want to empty and click Delete Unused
Codes. Unused codes are deleted, but the block remains intact. Later, you can add new
coupon codes to the block.
Note: You can only delete unused codes in static and bar code
coupon blocks.

Importing codes
Prerequisite: Your computer contains coupon codes in a CSV file. The file should only contain one column with the codes. You should know the CSV file's encoding, column delimiter, escape character, and if the CSV file contains a header row.
To learn how to define the minimum number of codes for that block, see Editing thresholds.
Note: Codes for EAN-13 bar code coupon blocks must consist of a 13digit number, digits only. Codes for Interleaved 2 of 5 bar code
coupon blocks can consist of any number of digits, but the number

© Optimizely 2022

636 | Optimizely Campaign User Guide 2022-03-14

must be even.
1.
2.
3.
4.
5.
6.
7.

8.
9.
10.

In the overview, select the coupon block to which you want to import codes.
Click Import Codes…. The Import Coupon Codes window opens.
Click Browse… and select the CSV file that contains coupon codes to be imported.
Click Preview.
In the File Charset drop-down list, select the encoding used in the CSV file. If you are
not sure about this, select Auto.
In the Column Delimiter drop-down list, select the character (semicolon, comma, tabulator, and so on) that separates the data fields in the uploaded file.
In the Escape Character drop-down list, select the character with which each individual data field is enclosed. Some database programs use a single quote (') or double
quote (") around each data field when exporting.
If the CSV file contains a header, in the Skip First Row drop-down list, select Yes.
Optionally, in the Maximum Number of Rows to Preview drop-down list, select the
number of records to display in the preview.
Click Refresh Preview to reload the records.

11. Click Import Coupon Codes. The last tab shows how many codes were imported.
After the import, the coupon block is ready for use.

Downloading assignments
To download a CSV file containing the already used coupon codes and their corresponding mailing and recipient assignments:
1. In the overview, click the desired coupon block.
2. Click Download Assignments.

Downloading codes
To download codes of a coupon block:
1. In the overview, select the desired coupon block.
2. Click Download Codes.
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Note: Due to their inherent unlimited nature, you can only download
the list of used coupons as a CSV file for dynamic and bar code
coupon blocks.

Editing thresholds
If you are using static or bar code coupon blocks, you must ensure that sufficient coupon
codes are available. Depending on the type of mailing, Optimizely Campaign uses several
security questions.
To define the threshold values, perform the following steps :
1. In the overview, select the coupon block whose thresholds you want to edit.
2. Click Edit Thresholds….
3. Define the threshold values in the Configuration area.
Warning threshold value 1. Enter an integer warning threshold value for transactional mailings. If this threshold is reached, a notification email is sent, but the
sending continues. You should then upload new coupon codes.
l
Termination threshold value 1. Enter an integer threshold value for transactional
mailings. If this threshold is reached, a notification email is sent and dummy
coupon codes with no function are used in the mailing. You must upload new
coupon codes.
l
Warning threshold value 2. Enter the percentage of recipients of regular and
Smart Campaign mailings for which the coupon block must still contain coupon
codes after sending. If this threshold is reached, a notification email is sent, but the
sending continues. You should upload new coupon codes.
l
Termination threshold value 2. Enter the percentage of recipients of regular and
Smart Campaign mailings for which the coupon block must still contain coupon
codes after sending. If this threshold is reached, the sending is canceled. You must
upload new coupon codes before restarting the mailing.
l
Email addresses. Enter one or more email addresses to which a notification is sent
if a threshold value is reached.
4. Click Save.
l
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Note: Threshold usage
For triggered mailings (for example, birthday mailings), the coupon
system uses the thresholds for regular mailings. For transactional
mailings sent using the REST API, HTTP API or Marketing Automation,
the coupon system uses the thresholds for special mailings.

Editing bar code blocks
1. In the overview, select the bar code block you want to edit and click Edit Bar Code
Block….
2. Specify the size of the bar code block either through height and width or line thickness:
l

l

In the Size Options drop-down list, select Height and Width, and enter the
desired values in pixels.
In the Size Options drop-down list, select Line Thickness, and in the Line Thickness drop-down list, select a value from 1 to 10 pixels.

Editing QR code blocks
1. In the overview, select the QR code block you want to edit and click Edit Bar Code
Block….
2. Specify the size of the QR code block either through height and width or line thickness:
l

l

In the Size Options drop-down list, select Height and Width, and enter the
desired value in pixels. For example, if you enter 300, the QR code will have a size
of 300x300 pixels.
In the Size Options drop-down list, select Line Thickness, and in the Line Thickness in (Pixels) drop-down list, select a value from 1 to 10 pixels.
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Countdown timers
Note: To enable this feature, contact customer support.
The countdown timer lets you increase your recipients’ attention and conversion rates by
counting down the time until your offer runs out.
The countdown timer displays the number of days, minutes, hours and seconds currently
remaining on an offer, regardless of when a recipient opens your newsletter. The countdown timer is dynamic, agile and flexible. You can customize the timer and the graphic layout.
The following topics describe how to graphically design offers with a countdown timers
and incorporate them into your messages. If you encounter problems, see Troubleshooting
countdown timers.
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How it works
Optimizely Campaign support two types of countdown timers:
l

Non-animated countdown timer with static display of time remaining.
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If you integrate a non-animated countdown timer into your mailing, when the recipient
opens the mailing, a static image with the currently remaining time is generated,
loaded into your mailing, and displayed.
l

Animated countdown timer with live countdown.
If you incorporate an animated countdown timer into your mailing, the counter is active in your top offer for 60 seconds. Animated countdown timers use the GIF (Graphics
Interchange Format) image format. This way, the newsletters contains a ticking clock.
Note: If a countdown timer uses a complex graphic design for its
background, your animation may be several megabytes, which is too
much for a newsletter and your recipients' inbox. So, the countdown
timer file size is limited to 1.5 megabytes.

You can create consistent and attractive layouts while keeping the file size small by splitting a product offer into two parts that you bring back together. Save the product image
and/or your key visual as a normal image file (JPEG or PNG) and save the counter as a GIF
animation in Optimizely Campaign.
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Preparing graphics explains how to split a product offer with a countdown timer into two

parts then bring them together into a single graphic in your message.

Preparing graphics
Tip: If you want to insert the timer into a message without a graphic
or photo, see Creating a countdown timer.

Requirements
To prepare a countdown timer with a background graphic or photo, you need:
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l
l

image editing software, such as Adobe Photoshop
a product image or key visual

Example of preparing graphics
To create a countdown timer with a background graphic or photo, prepare two parts (see
How it works):
l
l

the product image or key visual
the graphic on which the timer will be placed

To prepare both parts, follow these steps.
1. Open your product image or key visual with an image editing program.
2. Set the width of the product image or key visual between 100 and 800 pixels. In the
example, the image width is 776 pixels.
Note: By default, the maximum width is limited to 800 pixels. If
your message template or paragraph is limited to a smaller width,
do not exceed it. The countdown timer is not scaled to the maximum value of your message template or paragraph.
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3. Optional: Insert additional graphic elements into your image. A blue banner and a headline are inserted in the example.
Note: Do not use graphic elements with transparency, as they
are displayed incorrectly.
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4. Export the image as a JPEG or PNG.
5. Create the area for the countdown timer. For this area, start with a new graphic file or
continue working with your finished product image/key visual using the file in your
image editing program (not in the exported JPEG or PNG!). Later only export the countdown timer area.
Note: Do not use graphic elements with transparency, as they
are displayed incorrectly.

Tip: Continue to work on the product image/key visual file. This
makes it easier to see the final result and how both parts will work
together in your message.
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Note: When creating an animated countdown timer
For the countdown timer area, avoid using complex graphic
designs such as patterns, photo scenes, many colors and color
gradients. This is because Optimizely Campaign will convert the
JPEG or PNG into a GIF animation with 60 individual images. This
GIF animation may not exceed 1.5 MB.
Even if you use a highly compressed JPEG with a file size of a few
KB that contains many colors, the subsequently generated GIF
animation may exceed the maximum size of 1.5 MB.
When creating a static, non-animated countdown timer
The maximum file size for the countdown timer area is 500 KB.
6. To test the positioning of the countdown timer, which will come later, create a test
timer with the testing tool for your image editing program. The example uses Arial font
with the color white (#FFFFFF).

© Optimizely 2022

Managing content | 647

You can select among the following formats:
Static countdown timers
l
l
l
l
l

Days, hours, minutes, seconds (dd:hh:mm:ss)
Hours, minutes, seconds (hh:mm:ss)
Days, hours, minutes (dd:hh:mm)
Hours, minutes (hh:mm)
Days only (dd)

Animated countdown timers
l
l

Days, hours, minutes, seconds (dd:hh:mm:ss)
Hours, minutes, seconds (hh:mm:ss)

You can use the following fonts/typefaces:
l
l

Arial
Arial bold
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l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l

Arial italics
Arial black
Arial Unicode MS
Comic Sans MS
Comic Sans MS bold
Courier New
Courier New bold
Courier New italics
Courier New bold and italics
Times New Roman
Times New Roman bold
Times New Roman italics
Times New Roman bold and italics
Trebuchet MS
Trebuchet MS bold
Trebuchet MS italics
Trebuchet MS bold and italics
Verdana
Verdana bold
Verdana italics
Verdana bold and italics
Tip: Note the font and hexadecimal code for your font color. You
will need this information later.

7. Optional: Insert additional graphic elements into your test timer. The example places a
border around the timer, labels the timer with days, minutes, hours and seconds, and
inserts the text Offer ends in:.
Note: Do not use graphic elements with transparency, as they
are displayed incorrectly.
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8. If you are satisfied with your layout, remove the key visual from your graphic so that
the area for the countdown timer stands alone. You can do this in Adobe Photoshop,
for example, using the crop tool. The example uses the crop tool to reduce the graphic
to the area with the timer.
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9. Remove the test timer by deactivating or deleting the corresponding layer. If you inserted other graphic elements, leave them activated. The example deactivates the layer
with the test timer in Adobe Photoshop. The border, the timer labels and the lines of
text are still active.
Tip: Insert the final timer later in Optimizely Campaign using the
information you recorded regarding font and font color. The
graphical representation of the area you created will later serve
as the background for the final timer.

10. Export the area or background for the timer as a JPEG or PNG. Make sure that the file
size does not exceed 20 KB (approximate value). When creating a static, non-animated
countdown timer, the maximum file size is 500 KB.
You have now prepared both parts of the countdown timer. Creating a countdown timer
shows how to create the final timer in Optimizely Campaign and place it on your background graphic.
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Creating and managing countdown timers
To create and manage countdown timers, open the Optimizely Campaign menu and select
More > Countdown Timer.

Creating countdown timers
Prerequisite: Prepared background image, see Preparing graphics.
1. Click Create…. The Create Countdown Timer window opens.
2. You can make the following settings:
l
l

l

l

l

l

Name. Enter a name for your countdown timer.
End Time. Enter the date (left part of box) and the time (right part of box) at which
your countdown timer will end.
Format. Select the timer format and if your timer is animated or non-animated. See
How it works.
Separator. Enter the separator you want to use between the counter digits. By
default, the colon (:) is used. You can use a string of up to 5 characters. If you do
not want to use a separator between digits, enter a space.
Background Color. Select a background color for the timer by entering a hexadecimal value or using the color selection tool. If you prepared graphics for the
countdown timer, you do not need to enter a background color. The timer is then
automatically set to have no background color for your background image.
Background Image for Running Countdown Timer. Upload a prepared background image (in JPEG, PNG, BMP or GIF format, with height and width values
between 100 and 800 pixels) by clicking Upload and selecting an image. If you followed Preparing graphics, upload the second part of your top offer into the area
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you created for the timer. You will use the prepared product image/key visual later.
Then, you will combine the product image/key visual and the finished countdown
timer into a single graphic and insert it into your message (see Inserting a countdown timer into a message).
Note: Make sure to follow the design guidelines for background images.
Background Image for Finished Countdown Timer. To upload a background
image (in JPEG, PNG, BMP or GIF format, with height and width values between
100 and 800 pixels) to be displayed in your messages when the countdown timer
has run out. Click Upload and choose an image. If you do not, when the time runs
out, the background image for running countdowns is displayed with digits set to
zero.
l
Width (in Px). Enter the width of the timer background. If you uploaded a background image, its width is entered.
l
Height (in Px). Enter the height of the timer background. If you uploaded a background image, its width is entered.
l
Font. Select the font and the font style for the digits of the timer. If you followed
the example in Preparing graphics, enter the font you used for the test timer in your
image editing program.
l
Font Size. Enter the font size of the timer in pixels (px), at least 12 px. If you followed the example in Preparing graphics: enter the font size you used for the test
timer in your image editing program.
l
Font Color. Enter the font color for the timer as a hexadecimal code or use the
color selection tool. If you followed the example in Preparing graphics, enter the
font color you used for the test timer in your image editing program.
l
Left Text Margin (in Px). Enter the distance between the timer and the left edge
of the image. Use the preview to review the desired placement of the timer.
l
Top Text Margin (in Px). Enter the distance between the timer and the upper
edge of the image. Use the preview to review the desired placement of the timer.
3. Click Save.
4. Click Close. The Countdown Timer window opens. If you select a created countdown
timer from the list, a preview of the countdown timer is shown.
l
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Tip: When you create a countdown timer, two field functions are generated that you can insert into your message:
l

l

Image tag field function. Default. Insert the image tag field function directly into the text.
Image URL field function. Alternative, in case the image tag
field function is not rendered correctly. Insert the image URL
field function into the source code as follows: <img src="
{countdownImageUrl:0123456789}"/>.

Managing countdown timers
In the Countdown Timer window, you can edit, copy and delete countdown timers.
Option

Edit

Copy

Action steps
1.

Select a countdown timer and click Edit….

2.

Edit the countdown timer as described under Creating a countdown timer.

3.

Click Save.

1.

Select a countdown timer and click Copy.

2.

Optional: Edit the countdown timer as described under Creating a countdown
timer, and give it a new name.

3.

Click Save.

Warning: Do not delete countdown timers that are in use
in ongoing mailings.
Delete
1.

Select a countdown timer and click Delete.

2.

Click Delete Countdown Timer
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Inserting countdown timers into messages
You can insert a countdown timer into a message by itself, or combine it with a product
image/key visual to make a single graphic.

Inserting freestanding countdown timers
Tip: The following instruction shows the procedure using the Template Kit. If you use a custom template, the steps may differ.
1. Select your message and click Edit…. The Edit Content window opens.
2. Click New: Content Paragraph to create a new content paragraph.
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3. Click Text/Image.
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4. Click Insert field function

in the Text area.

5. Select the field function of the countdown timer you want to insert into your message.
Click OK.
Note: If you use an image URL field function, insert it into the
source code as follows: <img src="{countdownImageUrl:0123456789}"/>.
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6. Click Apply.
Tip: The countdown timer does not show in real time in the preview. But, you can send a test message to yourself to preview the
countdown timer before mailing the newsletter. To do so, click
Test message in the upper right of the Template Kit.

Combining countdown timers with product images/key visuals
If you prepared graphics for the countdown timer (see Prepare graphics) and created the
counter for the countdown timer (see Create a countdown timer), you can combine the
product image/key visual and the countdown timer into a single graphic.
Tip: The following instruction shows the procedure using the Template Kit. If you use a custom template, the steps may differ.
The basic procedure places the product image/key visual and the timer separately into
two paragraphs positioned one above the other, with no spacing between. For the combining process, create a new grouping paragraph.
1. Select your message and click Edit…. The Edit Content window opens.
2. Click New: Paragraph to create a new grouping paragraph in your message.
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3. Click Grouping Paragraph.

4. Enter 0 under Layout, in the Space between content paragraphs box.
Note: If you forget to enter 0 here, in some cases, your product
image/key visual and the countdown timer will not be seamlessly
combined.
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5. Click Apply.
6. To insert a new content paragraph for your product image/key visual into the grouping
paragraph, click New: Content Paragraph on the left side of the preview, under the
new grouping paragraph.

© Optimizely 2022

Managing content | 661

7. Click Text/Image.

8. Open the Image tab, click Browse... and select an image in the file browser to upload
your product image/key visual. If your visual is saved externally, enter the URL.
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9. Center the product image/key visual by selecting one of the centering options from
the list found under Position, for example Centered below the link.
10. Click Apply.
11. To insert another new content paragraph for the countdown timer into your grouping
paragraph, click New: Content Paragraph on the left side of the preview. On the right,
a window for selecting the paragraph type opens.
12. Click Text/Image.
13. Click Insert field function in the Text area. A window with a list opens. The list contains field functions that were saved in your client.
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14. In the list, select the field function for the countdown timer that you want to insert into
the content paragraphs and click OK.
Note: If you use an image URL field function, insert it into the
source code as follows: <img src="{countdownImageUrl:0123456789}"/>.
15. Click Center to center the inserted field function.

16. To save your changes, click Apply.
Tip: The countdown timer does not show in real time in the preview, but you can send yourself a test message to check that the
image merge is successful.

Troubleshooting
The following are common errors that can arise while working with the countdown timers.
Tip: If the issue continues after you attempted the suggested solution, contact customer support.
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Issue

Possible cause

Solution

In the message, the
countdown timer is displayed wider than the
product image, even
though the original file
for the countdown
timer has the same
width.

The global message
width for your Optimizely
Campaign template or
your paragraph is smaller
than the width of the
countdown timer.

Make the global width of the message or the
width of the paragraph the same as the
width of the countdown timer, or reduce the
countdown timer width.

A gap between the
product image and
the countdown timer.

A margin is defined for
your content paragraphs.

Set the margin for your content paragraphs
to 0.

Animated countdown
timers are not animated in Microsoft
Outlook

Microsoft Outlook (version 2007 and above)
does not support animated GIFs.

Open the mailing in Microsoft Outlook using
the View in browser view.

The generated animated countdown timer
exceeds 1.5 MB even
though the uploaded
background image is
significantly smaller.

Optimizely Campaign
generates an animated
GIF with a total of 60
images from the single
background image. The
file size increases exponentially and exceeds
the factor 60 because
Optimizely Campaign
adds the timer for the
countdown timer to your
background image.

The countdown timer
is not animated.

A non-animated time
format was selected in
the countdown timer's
settings.

Under Countdown Timer, select the
affected countdown timer and click Edit. In
the Settings area, in the Format drop-down
list, select a time format that has the addition (animated) and click Save.

The image URL field
function is not

The image URL field function was added directly

Insert the image URL field function into the
source code as follows: <img src="{count-

Reduce the file size of your background
image. The recommended maximum size is
20 KB. Also, avoid using complex graphic
designs such as patterns, photo scenes,
many colors, color gradients, and so on.
Even if you use a highly compressed JPEG
with a file size of a few KB, if it contains
many colors, the subsequently generated
GIF animation may exceed 1.5 MB.

© Optimizely 2022

Managing content | 665

Issue
replaced with the corresponding countdown timer.

Possible cause
to the mailing content,
like the image tag field
function.

Solution

downImageUrl:0123456789}"/>.

Click2Go
Note: To enable this feature, contact customer support.
This topic describes the Click2Go feature that lets you create buttons for your mailings,
with no HTML expertise, directly in Optimizely Campaign's content management system.
Click2Go is integrated directly into the Optimizely Template Kit and can be used in any
paragraph type.
Buttons are call-to-action elements with great potential for capturing attention and directing readers to landing pages for products, campaigns, profile pages, and so on.
Tip: Test your button's potential
To test how much attention a button captures in the context of a
mailing, use the automated attention analyses from Optimizely Campaign. Attention analysis indicates whether a button's location captures a high level of attention and directs readers to desired content.

Activating Click2Go
When Click2Go is activated, content paragraphs display a new Button tab. Design the buttons as described below, and test them using a test email.

Inserting and designing buttons
To insert a button into a paragraph and edit it, perform the following steps:
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1. Edit the paragraph in which you want to add a button.
2. Select the Button tab in the top tab bar. The following areas are displayed:
l

l

l

Template. In this area, you can insert two button templates into your mailing. The
templates are provided along with the Click2Go function.
Options. In the tabs (described below), you can create a new button or edit an
available template.
Preview. Shows the current design of your button in real time.
Tip: When you are finished, test your buttons in a test email.

General
Parameter
Text

Description
Enter the button text.
Insert a destination URL to which your button should link.

URL

Alignment

Note: If you do not name a destination URL, the button
will appear in your messages.

Set the position of your button in relation to other content elements of your mailing.

Text
Parameter

Description

Font type

Select the text font.

Color

To define the color of your button border, click the displayed value then set the
desired color in the selection window.
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Parameter

Description

Size

To set your text size, adjust the value manually or via the slider.

Bold

To make your text bold, select the check box.

Italic

To make your text italic, select the check box.

Underline

To make your text underlined, select the check box.

Background
Parameter
Color

Description
To select your button's background color, click the displayed value then select
the color in the selection window.
To select a background image for the button, click Browse... and select the
image from your computer. Alternatively, use the Alternatively external URL
box.

Image

Background images may not be displayed, depending on the email software
and the recipient's security settings.
Note: If you select a background image, specify an
additional background color as a fallback, in case the
background image is not displayed.

Alignment

Set the position of your background in relation to the other content elements.

Repeat

Select an uploaded image to be repeated in various arrangements.
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Symbol
Parameter

Description
To select a symbol for your button, click Browse... and select the image from
your computer. Alternatively, use the Alternatively external URL box.

Image
Background images may not be displayed, depending on the email software
and the recipient's security settings.
Position

Specify the position of the symbol in the foreground of your button.

Margin left

Set spacing for your border's left side of by adjusting the value manually or using
the slider.

Margin right

Set spacing for the border's right side by adjusting the value manually or using
the slider.

Padding
Parameter

Description

Top
Bottom

Internal spacing (padding) indicates how much spacing is between the text and
the outer edge of the button.

Left

Change this value to change the size and visual appearance of the button.
You can individually define the internal spacing for each side.

Right
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Border
Parameter

Description

Width

To set the width of your border, adjust the value manually or use the slider.

Color

To select the color of the button border, click the displayed value then set the
desired color in the selection window.

Radius

Define the shape of your button. A higher value produces rounder corners.

Easy Copy
Note: To enable this feature, contact customer support.
This topic describes the Easy Copy feature. When creating messages, you can apply individual paragraphs (including text and images) from other messages – from any client. You
can edit the imported content and adapt it to the new message.
Note: The source message and the target message must have the
same paragraph structure. The source paragraph must be at the
same structural level as the target paragraph.
To copy content from other messages to a new message, perform the following steps while
in the edit mode of the Template Kit.
1. To the left of the message preview area, click New: Content Paragraph. The right edit
window shows a selection of paragraph types.
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2. Click Import Paragraph. A new window opens. You are asked to select the source content.

3. In the Source Client drop-down list, select the client that contains the message or
message template that you want to import.

© Optimizely 2022

Managing content | 671

4. In the Source Content drop-down list, select the message or message template which
contains the content you want to import.
Tip: If you are unsure of which message or message template contains the content, click a message or message template in the
overview list to preview its content.
5. Select the message or message template containing the content you want to import.
Tip: To import content from several messages or message templates, repeat steps 1 to 8 after you complete an import from a
message.
6. Click Next. The Select paragraphs window opens.
7. Select the content you want to import by checking the relevant check box.

8. Click Import Paragraphs. You can now edit the content.

Mobile Fusion
Note: To enable this feature, contact customer support.
The Mobile Fusion feature makes your newsletter templates fit for mobile devices, such as
smart phones and tablets. From a usability perspective, smart phones and tablet PCs are
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quite different from a traditional computer. Their display sizes are significantly smaller,
depending on the type of device. So, the available space should be used optimally.
Scrolling should be limited to vertical, not horizontal. To increase usability, images should
be displayed as large as possible, that is "fit-to-screen". Avoid a floating layout or columns.
Finally, the newsletter should support the optional switch from portrait to landscape mode
by rotating the device.

Checklist for a mobile version of your newsletter
l
l
l
l
l
l

Layout's minimum width is 320 pixels
Additional layout for a maximum width of 480 pixels recommended
Adaption of the layout to full-screen mode
Images displayed at optimal size
Single-column layout preferred
Automatic detection of display width used to adapt the newsletter layout

Adapting your template
You can adapt any message template to a mobile layout. Optimizely offers a full-service
adaptation, where you get everything "from scratch". Or, send Optimizely your mobile layout and let us implement it into your template.
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Full-service adaptation
1. You indicate the template you want to adapt for a mobile version.
2. Optimizely creates a layout with flexible widths (two widths, flexible display according
to display size) or another layout using fixed width.
3. You choose a layout.
4. Optimizely implements it into the template.

Benefits
l

l

You get everything from one source and benefit from Optimizely's experience in template
design.
You can be confident that Optimizely's layouts work in your template.

Implementing your own layout
1. You indicate the template for which you want to implement a mobile version.
2. Optimizely checks if the indicated template is suitable for flexible width or fixed width
mobile layout.
3. You provide a layout with flexible or a fixed width.
4. Optimizely implements the layout into the template.
Note: The mobile layout's e Elements must follow the same order
and structure as the HTML layout. For example, you cannot change
the position of an image above text to a position within text.

Flexible vs. fixed-width
Ideally, mobile layouts are implemented with a flexible width that adapts to the display size
("fit-to-screen"). The best way to achieve this is a flexible layout using two widths. Any
width in between the two is scaled to fit automatically, so the available display space is
used optimally. At a defined width between the two defined values, the layout switches
from one to the other. Displays with a higher resolution use the regular HTML layout.
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Note: For complex template layouts, such as where text is rendered
into an image, a flexible width layout cannot be implemented. Optimizely offers a fixed layout width for your mobile version.
Layout

Width

Flexible width

320 / 480 px

Fixed width

320 px

Tip: The values in the table are default values. If you want different
values, contact customer support.

Optimizing newsletters for mobile devices
The Optimizely Template Kit is optionally available with Mobile Fusion, which applies the
Template Kit's flexibility to the mobile version of your newsletters. This section helps you
design mobile newsletters and integrate them into the mobile version of your mailings.
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Prerequisites
l

l

l

If you have not installed Mobile Fusion or are not currently using the Template Kit, contact
customer support to get Mobile Fusion with the Template kit.
Template Kit describes paragraphs, setup and configuration of the Template Kit, including
mobile options.
Mobile Fusion describes design options for the mobile layout of newsletters.

What does the Template Kit with Mobile Fusion offer?
l

Enable or disable mobile version. If you enable the mobile version, Optimizely Campaign
automatically generates a version of your mailing optimized for mobile devices; this
increases the size of each emailing. See General settings.

© Optimizely 2022

676 | Optimizely Campaign User Guide 2022-03-14

l

l

l

l

Place the sidebar above/below the main body. In each paragraph, you can indicate
whether to display the sidebar (if present) before or after the main body. See Grouping
paragraphs.
Hide/display paragraphs in the mobile version. You can indicate, by paragraph,
whether to integrate that paragraph into the mobile version. You can also indicate if a
paragraph should appear in the mobile version only. See Content paragraphs.
Set paragraph width in the mobile version. You can set the width of each paragraph (in
%) for mobile display. See Content paragraphs.
Set the width of paragraph separation in the mobile version. You can set the width of
the paragraph separators (in %) in the general settings for the template. See General settings.

Creating mobile versions
1. Create a click profile for the mobile version.
You can also specify a click profile for the mobile version to later evaluate how many
recipients clicked it. Create a click profile and select this profile by accessing the
Mobile tab of the template's general settings > Click profile drop-down list.
Tip: Landing pages
Mobile Fusion also automatically creates mobile versions of landing pages and SWYN pages. The mobile versions of landing pages
can also be adapted using the settings described here.
2. Create the desktop version first.
Before creating a mobile version of a mail, create the desktop version. The default settings for Mobile Fusion were selected for the template kit so that content paragraphs
are automatically copied to the mobile version. The sidebar is displayed beneath the
main content area; the table of contents is hidden. You can change default settings
later.
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3. Hide content that should not appear in the mobile version.
You can enable individual paragraphs for the mobile version. By default, this option is
already active for paragraphs, except for the table of contents. To make your mobile
newsletter more compact, remove selected paragraphs from the mobile version by
removing the Show in mobile version check mark.
Note: Do not hide main elements such as the header, footer or
editorial, to ensure that the mobile newsletter remains complete.
4. Create alternative paragraphs for the mobile version.
Some content paragraphs may not display correctly or as desired in the mobile version,
because the images look awkward or the paragraph has too much text. To add these
paragraphs to the mobile version, create two variants—one for desktop viewing and
one for mobile viewing. Deactivate the unused view in the settings of both paragraphs.
Note: Only use this option if adjustments to the mobile layout did
not result in desired effect. Also, make sure that only one paragraph version appears in the newsletter.
5. Add paragraphs to be displayed in the mobile version only.
To send information only to recipients with mobile devices, add a paragraph at the corresponding position and hide this paragraph in the desktop version by clearing the
Show in desktop version check box.
Note: Do not hide important content in the desktop version.
6. Position the sidebar.
In the mobile version, the sidebar of a structuring paragraph is displayed above or
beneath the main content area for display purposes. This causes the arrangement of
elements to shift.
If you insert a table of contents or the newest messages into the sidebar, display the
sidebar above the main area or to hide the table of contents in the mobile version. Test
to see whether the content of the mobile version is displayed in the correct order.
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When using multiple structuring paragraphs in a single mail, you can configure this setting separately for every structuring paragraph.
7. Adjust the paragraph width for the mobile version.
You can create a multi-column layout by specifying a percentage width for content
paragraphs in the mobile version. This setting only takes effect if you adjust the width
in two consecutive paragraphs so that you get 100% width. You can use this option to
force an image to be displayed next to a specific text.
Use a paragraph with an image and another paragraph with a text for this purpose.
Then, specify 30% width for the image paragraph and 70% width for the text paragraph.
Only use this option for short texts and simple images or graphics, as multi-column layouts reduce the visual quality and readability for mobile viewers.

Tips for optimizing the mobile version
l

l

l

l

Optimize the general settings of the template. You can select spacings, borders, colors and other configurations. Most settings, except the newsletter's width
and outer edge, are copied to the mobile version. You can also change the appearance of the mobile version using these settings.
Test the newsletter using Outlook. The HTML and mobile preview shows a simulated view of the mail in email programs and on mobile devices. The actual view
varies depending on software and hardware. Views provided by Microsoft Outlook
2007 or 2010 are a good indicator for the correct display of the newsletter. If
Outlook displays correctly without errors, it is likely that other programs and web
mailers also display the mail as intended.
Change to the mobile view in editing mode. You can change between the
desktop and mobile view by making the editing window in Optimizely Campaign
smaller and decreasing the width using the cursor. When the window width is less
than 600 pixels, the view changes to the mobile view.
The mobile version may not display uniformly in all email applications and can deviate from the preview layout or the testing emails.
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Tips and examples
Desktop version
The desktop version of this newsletter is the basis for the mobile version. If the mobile version is activated, paragraphs are copied into the mobile version by default.

Mobile version 1
This mobile version is created from the desktop version with minor adjustments.
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Mobile version 2
In this adjusted mobile version, a table of contents is displayed. The two small paragraphs
after the editorial were positioned next to each other, both with a width of 50%.
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Mobile version with errors
This mobile version contains common errors. You should check the mobile view of your
newsletter and, if possible, test it using mobile devices to avoid such mistakes.
The width of this paragraph is set to 50%. But the width of the following paragraph was
unchanged. So, the first paragraph only occupies half of the available width and creates a
gap. For both paragraphs to be adjacent, adjust the width of the following paragraph so
that both add up to 100%.
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Images and attachments
The Images and Attachments feature provides an overview of attachments and images
saved in the Optimizely Campaign content database, and also lets you edit those files.
To access the overview, open the Optimizely Campaign menu and select Campaigns >
Images and Attachments.

You can perform the following actions:
l

Add
See Adding images and Adding attachments.

l

Edit
1. In the overview, click an image or attachment.
2. Click Edit…. The Edit Image/Edit Attachment window opens.
3. Enter a new file name for the image or a new file name and a description for the
attachment.
Tip: The name you apply to the file should match the original
file, so as not to confuse the mailing recipient.
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Note: Do not use uppercase, spaces, umlauts, or special characters, and add the file extension. Otherwise, the attachment
does not load correctly. Example: flowers_for_you.pdf.

l

4. If you want to change the file, that is, use another file (by uploading a new file or
specifying another URL), click Previous and make the change.
5. Click Save.
Delete

l

1. In the overview, click an image or attachment.
2. Click Delete.
Clear selection
Click Clear selection

to deselect the image or attachment.

Categories
Click the Images tab to display images, or the Attachments tab to display attachments.

Images
The Images overview displays the following information:
l
l

l

l

Name. The file name.
URL. Where the image is stored. If it is physically uploaded to Optimizely Campaign, the
URL is an internal URL (http.//img.example.com/...). If you selected External URL, the file's
original URL is shown.
Location. Indicates whether the image is stored on Optimizely Campaign (server) or located externally.
Dimensions. The image's dimensions in pixels.
Tip: Select an image in the overview to display an image preview.
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Attachments
The Attachments overview displays the following information:
l
l
l

l

l

Description. The attachment description.
File Name. The file name.
URL. If you selected External URL while importing the attachment, the file address
appears. If the file was physically imported into Optimizely Campaign, this field is empty.
Location. Indicates if the file is stored on the Optimizely Campaign (server) or located
externally.
Type. The file format (PDF, DOC and so on). This is the original file format as recognized by
Optimizely Campaign when the file was added, not the format you applied while naming it.
Tip: The type you apply to the file should match the original file,
so as not to confuse the mailing recipient.

l

Size. The file size in bytes. Use discretion with the file size, so recipients are not annoyed
by large attachments.

Adding images
To add images and use them later as mailing attachment in Optimizely Campaign, do the
following:
Note: The image's file format must be .gif, .jpg, .jpeg or .png.
1. Open the Optimizely Campaign menu and select Campaigns > Images and Attachments.
2. Open the Images tab and click Add….
3. Select one of the following options:
l

Upload. Click Browse… and select a file from your computer. The image is still available even if your local version no longer exists.
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External URL. In the URL text field, enter the web address where the file can be
found, beginning with http://. The image is not physically imported into Optimizely Campaign. Mailings include only a link to the image.
4. In the File Name text field, enter a name that helps you recognize the image when creating a mailing or in the content overview.
5. Click Save.
l

Adding attachments
To import files into Optimizely Campaign and use them later as mailing attachment, do the
following:
1. Open the Optimizely Campaign menu and select Campaigns > Images and Attachments.
2. Open the Attachments tab and click Add….
3. Select one of the following options:
l

Upload. Click Browse… and select the desired file from your computer. The file is
available even if your local version no longer exists.

External URL. In the URL text field, enter the web address where the file can be
found, beginning with http://. The file is not physically imported into Optimizely
Campaign. Mailings include only a link to the file.
4. In the File Name text field, enter a name that helps you recognize the file when creating a mailing or in the content overview. Maintain the file extension (.pdf or .doc) so
recipients recognize the file type.
l

5. In the Description text field, enter a file description.
Tip: The description is used internally and is not part of the mailing.
6. Click Save.

Sending personalized attachments
The Personalized attachments feature lets you include attachments to particular recipients when sending transactional mails. For example, you can send invoices or order confirmations.
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Before sending, transmit the attachments to Optimizely Campaign via HTTP API.

Prefix or suffix subject line
Note: To enable this feature, contact customer support.
This additional feature automatically adds a prefix or suffix to the subject line of any mailing. For instance, the suffix "TEST" may be added to each test email subject line.

Uploading files
Note: To enable this feature, contact customer support.
Upload a file (such as a CSV file) manually into your Optimizely Campaign client. This is
helpful if you do not upload files regularly and automatically, for example price catalogs.
The uploaded file can contain any content and is processed internally according to the file
name and the processes and jobs associated with this file name. For example, upload
product data if you use a content interface and update product details manually.

Publish mailings
Note: To enable this feature, contact customer support.
This feature lets you publish a mailing or parts of a mailing into another client or template.
It is a useful tool for reusing content from an existing mailing in another context or client.
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Video emails
Incorporating videos into a mailing is a great way to get the recipient's attention and sur-

prise them with your creativity. Videos are better than both text and still images at showing a recipient what he wants to know, in very little time and without requiring a word.
Videos convey the value of your products much better.
For example, using a 360 degree view, you can demonstrate the features and design of a
new product. Videos are also a great tool for obtaining higher response rates and guiding
recipients to specific landing pages.

Video email tips
l
l
l
l
l

An email teaser should be no longer than 20 seconds.
Landing page videos should be no longer than 60 seconds.
Rapid intercutting between images attracts greater attention.
Use animation in intros, animate info graphics and transitions.
Place a call-to-action at the end of a video.

Incorporating videos into emails
This topic describes different methods to incorporate videos into emails.
Note: The Flash format is not a suitable option for videos in emails,
because most email programs block Flash applications for security
reasons. However, there are other ways to incorporate moving
images into emails.

Animated GIF
This is the best format for showing a video directly in an email, because many email programs can play GIFs without difficulty. Compared to other formats, the quality of animated
GIFs is limited and they do not allow audio playback.
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A comparison of advantages and disadvantages shows that animated GIFs can be used
primarily as teasers lasting only a few seconds. To incorporate full videos, add a playback
button to animated GIFs, linked to a landing page. The email should explain that there is
no audio playback.
Advantages

Disadvantages
l

l

Videos run directly in an email
l

l

Broadly supported by current email programs and web mailers
l

l

Unsupported email programs (such as
Microsoft Outlook) display the first frame as
a fixed image (fallback)
l

No audio
Limited quality (in terms of color intensity,
image frequency)
No compression (that is file size increases
proportionally with frame rate, each individual image is stored)
No control elements

Note: The width of the GIF must be less or equal to the width of the
content paragraph in your mailing. Example: If you are adding a GIF
with a width of 650 pixels to a Text/Image paragraph with a content
width of 600 pixels, the GIF will be compressed and lose its animation.

Landing page
Rather than integrating a video into an email, insert a screenshot from the video (such as
the opening image) into a newsletter, along with a playback button that links to a landing
page containing the video. You can couple this variant with an animated GIF. The recipient
sees a moving image in the email with a teaser lasting several seconds. If he/she clicks on
it, the actual video starts running in the landing page.
Advantages
l

l

Disadvantages

Simplest way of linking videos and
emails

l

Supported by current formats (Flash,
MP4, HTML5)

l

Large videos or high click rates require a hosting
service
This sort of "fake player" can irritate recipients,
who may expect the video to run in the email
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Advantages
l

Practically unlimited video length and
quality

l

Video and audio

l

Control elements may be used

l

Disadvantages

Does not require videos to be adjusted to your newsletter's specific
format

To accommodate recipients who set their email programs to suppress images, include a
text link to the video in addition to the fake player. To avoid irritation caused when the
video begins running in the browser rather than in the email, include a note indicating that
the video will run externally.

YouTube videos
Several email programs (Google Mail, Outlook, Yahoo) allow videos hosted on YouTube to
be played back directly in an email.
Advantages
l

l

Videos are hosted on a widely
used platform
Supported by many email programs (playback in the email)

Disadvantages
l

l

Video URLs may not be substituted with tracking
URLs, to ensure reliable identification
Identified URLs are extracted; does not allow incorporating the player into email

Videos recognized by email programs are displayed across or at the bottom of the body of
an email. If the recipient clicks the link, the video generally starts running in a layer (Lightbox).

HTML5 video
Mobile devices in particular, like iPhones and iPads, run videos in their email programs.
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Advantages
l

Allows embedding of high-quality
videos.

l

Audio track.

l

Displays control elements.

Disadvantages

l
l

Not supported by many email programs.
Only useful as a supplement in combination with
other options.

HTML5 videos can be combined with animated GIFs or a landing page to enable recipients
to play back videos. HTML5 video tags and an image tag with an animated GIF or fake
player are incorporated into the email source code. The relevant variant is then delivered
to the recipient, according to the type of email program he/she uses. Insert the HTML code
snippet directly into the email, for example into the source code paragraph of the Template
Kit.

Testing and evaluation – Finding the right technical implementation
To give your video email strategy the greatest opportunity for success, you can test how
well each integration method works by applying A/B tests to a representative sampling of
your recipients. This is an easy way to determine the best approach for embedding videos
and which offers the highest conversion rates.
The chart below shows a split test with results for the variants described above.
Video embedding

Split A

Split B

Split C

Animated GIF and landing page

✓

✓*

✓*

Landing page with embedded video

✓

✘

✘

HTML5 video

✘

✓

✘

Youtube video

✘

✘

✓

Note: The animated GIF in Split B and Split C should be included as
a fallback option; recipients who cannot display the embedding variant used only see an animated GIF.
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Reporting
Evaluating clicks on video links is easy using conventional tracking. Depending on the technique being used, you also can collect data on playback time and playback rate. At minimum, measure conversion and click-through rates to evaluate the effectiveness of your
videos. In particular, assess the following steps/actions:
l
l
l

Recipient clicked on the landing page in the newsletter
Recipient ran video (web analysis accessibility required)
Time spent on landing page (web analysis accessibility required)

To assess how many recipients made a purchase after viewing a video, set up a segment in
your web analysis software that links two actions:
1. Recipient made a purchase in the product category.
2. Incoming page (the page clicked on to reach the product page) equals video landing
page.

Example: Video in a newsletter
This example uses a mailing containing an animated GIF teaser that links to a landing page
with a full-scale, high-quality video. The animated GIF is created from a short sequence
taken from the video and loaded into the mailing as a normal image file. This animated GIF
is set in a text/image paragraph, together with the teaser text. The mailing would appear
this way in an inbox:
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The animated GIF links to a landing page. The full, high-resolution video is integrated into
this landing page. The video itself can be hosted on YouTube, Vimeo or another hosting service. These services supply a snippet of code that you insert into the source code:
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Creating a video mailing with an animated GIF and landing page
1. Load the video to a hosting service (such as YouTube or Vimeo), if you are not hosting
it yourself.
Tip: Use a standard video format such as the widely available and
high-quality MP4 format.
2. Create an animated GIF to use as a teaser. Animated GIFs can be created using standard editing programs like Adobe Photoshop.
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Note: The width of the GIF must be less or equal to the width of
the content paragraph in your mailing. Example: If you are adding
a GIF with a width of 650 pixels to a Text/Image paragraph with a
content width of 600 pixels, the GIF will be compressed and lose
its animation.
3. Set up a mailing in the client where you want to insert the teaser.
4. Create a landing page based on this mailing.
5. Switch back to the mailing and insert a text/image paragraph. Upload the animated
GIF in the Image tab and compose the paragraph in the usual manner.
6. Select the landing page from the list in the Link field.
7. If needed, add a note indicating that the video will open in an external browser window.
8. Open the landing page and insert a source code paragraph containing the code snippet that embeds the video. You can get this code snippet from YouTube by going to
the video and clicking Share and then Embed. You can get the code from Screencast
by hovering over the video icon and then clicking Share.
9. Save and test the mailing.
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Recipients
This section shows how to manage active and inactive recipients, create target groups and
send personalized content to customer segments.
l

Recipients overview. Functions for working with recipient data sets.

l

Trial import. Check the data in a recipient list before the actual import.

l

Import. Import recipients into a recipient list.

l

Export. Export recipients to a CSV file.

l

Cross-checking recipients. Identify the recipients of a mailing and the internal lists used.

l

Recipient lists. Copy, edit and clear recipient lists.

l

Target groups. Generate, use and analyze segments.

l

Opt-in. Information on the opt-in procedure.

l

Unsubscribers. Manage recipients who have unsubscribed from a mailing.

l

Recipient history. Display mailing progress with individual recipients.

l

Export mailing and performance data. Export response data as CSV or XML.

l

Click profiles. Create, edit and assign click profiles.

l

Responses. View bounces and replies.

l

Blocklist overview. Manage the blocklist.

l

Preference Center. Set up a Preference Center for profile self-administration.

l

Connect for Campaign. An add-on that connects Optimizely CMS, Optimizely Forms, and
Optimizely Campaign.

Recipient overview
To open the recipients overview, open the Optimizely Campaign menu and select Recipients > Overview.The recipient overview provides access to functions for working with
recipient data sets.
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Option

Action steps

Show recipient
datasets

Select a recipient list.

Filter selected
datasets

Select a target group from the Target Group list and click Apply.

Search

To search for a recipient or key word within a dataset, enter a search term
into the Free text search box and click Apply.

Create recipient

1.

Click Create Recipient…. An row of input boxes appears.

2.

Enter data for the new recipient.

3.

Click Confirm. The list is re-sorted. See also Add element.

1.

Select a recipient from the list and click Edit Recipient…. Editable fields
change to input boxes.

2.

Click Submit.

Edit recipient

Note: Only use Delete Recipient to remove a recipient whose email address does not exist. Recipients
who should not receive email from you because of a
complaint should be added to the blocklist.

Delete recipient
1.

From the list, select a recipient and click Delete Recipient.

2.

Confirm.

See Blocklist overview.
1.

Select a recipient from the list and click Block Recipient. The Block
Recipient dialog box appears.

2.

Optionally, enter a blocklisting reason, such as, complaint by telephone.

3.

Click Apply. The recipient is added to the blocklist.

Block recipient

Anonymize
tracking

Note: To enable this feature, contact customer support.
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Option

Action steps
Lets you deactivate personalized tracking of opens and clicks for a recipient.
If you do, the recipient is no longer included in action-based target groups
(that is, has clicked link B in mailing A), even if the recipient meets the target
group's conditions.
1.

To deactivate personalized tracking for a recipient, select a recipient
and click Anonymize Tracking.

2.

In the dialog box that opens, confirm.
Note: Personal action-based data is anonymized
from the time of activation. Action-based data
from the recipient history is not retrospectively
anonymized. If you later reactivate personalized
tracking, anonymized action data is not restored
and assigned to the recipient.

Tip: You can also use the Optimizely Campaign HTTP
API to set up the tracking opt-out option in your mailings. See HTTP API on Optimizely World.

Note: You need the permission to download recipient
lists.
To save recipients in a recipient list or a selected set of recipients to a CSV
file, click Save
Download
recipient

at the bottom of the list.

Warning: Take care when handling the downloaded data
A recipient list or set of recipients downloaded with
this function also contains data for unsubscribed
recipients, blocked recipients, and recipients for
whom the bounce limit is exceeded. Do not use this
dataset for sending messages or mailings from other
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Option

Action steps

clients or mailing systems. To export only active recipients in a recipient list, use Recipient export instead.

Test import
This topic describes how to use the test import to determine how many recipients in a file
are recognized by Optimizely Campaign versus how many are new.
Tip: Unlike import, no changes are made to a recipient list during a
trial import.
To perform a test import of your recipient data, follow these steps:
l

Step 1: Start

l

Step 2: Recipient list

l

Step 3: Row mapping

l

Step 4: Import type and import options

l

Step 5: Import

Step 1: Start
1. Open the Optimizely Campaign menu and select Recipients > Trial Import.
2. Click Browse… and select the file with the recipient data.
Note: The maximum allowed file size is 50 MB. To upload larger
files, see Transferring files through SCP and Automatic recipient
import.
3. Click Next. The file is uploaded to the Optimizely server.
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Step 2: Recipient list

1. In the Select Recipient List area, click the list to which you want to import new recipients.
2. In the File Options area, specify the characters your CSV file uses to separate the
entries.
Separator. Select a character (semicolon, comma, tabulator and so on) that separates data fields on the lines of the uploaded file.
l
Escape character. Some database programs use a single quote (') or double quote
(") around each data field when exporting. Select which one is used in the
uploaded file.
3. Click Next.
l

Tip: You cannot add new recipient lists. New recipients are added to
an existing list.

Step 3: Row mapping
You must assign each column of the recipient list to a corresponding column in the imported recipient list. The left column of the Row Mapping tab lists fields of the Optimizely
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Campaign recipient list into which you are importing. The right column contains column
headers from the imported list.

1. Assign fields according to their content. Typically, Optimizely Campaign suggests the
correct assignment (such as matching first name with first name). However, if first
name in the recipient lists corresponds to name in the file, you must select the correct
assignment.
2. If you prefer to import data fields selectively (for example, only recipients' last names
have changed), select the --- option for fields that should not be changed.
3. Select the Fixed value check box to change the pop-up menu to an entry field in
which you can enter any text or value. This value or text is then imported into the corresponding field for each record.
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For example, you generate email addresses of newsletter subscribers through your
website as well as other sources (cooperation partners and so on). If you import
records supplied by a cooperation partner, use the Origin field to indicate the partner's name or a corresponding code, so you can track the subscription's origin. You can
also evaluate the activity of subscribers from various sources.
For another example, if your recipient list also contains mobile numbers, enter a country code for these fields during import if the imported numbers do not contain them.
The country code is automatically prepended to the telephone number, and the telephone number may be standardized (eliminating the 0 before the area or network
code).
4. Under Content Options, the Action drop-down list lets you select whether to replace,
prepend, or append contents of recipient list fields of type "String" and "Text".
Tip: See also: Data types.
When you select the Prepend or Append action, the Separator drop-down list
appears. Select a character (semicolon, comma, tabulator and so on).
5. Click Next.

Step 4. Import type and import options
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1. In the Select Import Type area, select the import type.
Depending on the configuration of your client and your user authorization, you may
see only some options.
l

l

l

l

Simple import. Imports new recipients into your list. Existing records, unsubscribes
or blocked recipients are skipped.
Import new recipients and update existing records. Default import type. New
recipients are added to the recipient list. Existing records are checked and
updated as required. Optimizely Campaign identifies recipients by recipient ID, usually email address. If a recipient's email address has changed, he is imported again,
becauseOptimizely Campaign does not recognize it as an existing recipient.
Update only. Does not import new recipients. Only updates existing records as
needed. If a recipient's email address changed, the recipient is skipped, because
Optimizely Campaign does not recognize it.
Clear recipient list before importing. Overwrite existing recipient list in Optimizely Campaign with data from the uploaded file. You should upload your complete
address data.
Overwriting can be practical if recipients can unsubscribe both by clicking in the
newsletter and through the call center. In this case, the unsubscribe information
must find its way to Optimizely Campaign so that these recipients are unsubscribed and receive no further mailings. If your call center deletes a record from
your database or CRM software, you can guarantee that this recipient is deleted by
selecting Clear recipient list before importing.

2. In the Set Import Options area, select one or more of the following import options:
l

l

l

Skip first row. Often, the uploaded file has field names in the first row. Select to
skip the table headers and start importing with the second row.
Import unsubscribers. If this option is displayed, you can import recipients who
are marked as unsubscribed in your client. Newly-imported recipients receive mailings right after importing them with this import option.
Import global unsubscribers. Activate this option to reimport recipients that globally unsubscribed from all channels previously, so that you can send them mailings
again.
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Note: This option is only active together with option Import
unsubscribers.

Note: Permission is required for recipients. Do not send newsletters to unsubscribed recipients, if no permission (opt-in) exists.
3. Add opt-in processes if you want to import recipients from a source that is not linked
to an automatic opt-in process, such as from a telephone campaign. Imported recipients receive a welcome or a confirmation email with an activation link. You can select
this option only if the confirmation mailing is set up and edited beforehand.
Note: Only import recipient lists once
If a double opt-in process is selected, imported recipients only
appear in the list after they have clicked the activation link in the
confirmation email. Optimizely Campaign automatically sends
this email after the import, if an opt-in process is selected.
Only import recipients once, even if they do not appear in the list
after the import. Otherwise, a confirmation email is sent each time
you carry out an import.
4. Click Trial Import. The import starts and the Import tab opens.

Step 5: Import
When the import is finished, Save
were found. Click Save

appears next to each category for which records

to download those records.
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The number of processed records and the import result are listed for each category:
l
l
l
l

l

l

Records processed. Number of processed records.
Records added. Number of newly added records.
Records updated. Number of updated records.
Records skipped (error in file). The column assignment did not correspond with the
selected values in the third step. For example, a record may contain only three columns
instead of the indicated four columns.
Records skipped (error in list). Number of skipped records; because they already existed, no changes were found, or you selected the option Update only and new records
were found in the list.
Records skipped (on blocklist). Recipients that are blocked. Depending on your client
hierarchy, there might be several blocklists. A blocked recipient might not appear in the
blocklist of your client, but be blocked on the list of the main client.
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l

l
l

l
l

l

Records skipped (exceeded the bounce limit). Recipients that exceeded the bounce
limit.
Records skipped (prior unsubscribes). Recipients who previously unsubscribed.
Records skipped (prior target group). The recipients were not imported because your
client or the confirmation email (confirmed or double opt-in) uses target groups that do
not match.
Duplicates in file. Recipients only imported once to avoid duplicates in the recipient list.
Records already in recipient list. Recipients already in the recipient list are skipped to
avoid duplicates.
Erroneous records. Optimizely Campaign validates data when importing them. Erroneous
records may contain invalid characters or, in case of email addresses, a missing @ symbol
or an invalid domain. Such records are not imported.
Tip: You can download the analyzed records to filter out duplicates
or invalid email addresses. To do so, in the overview, click Save
next to the corresponding category.

Importing recipients
Import a file that contains recipient data using a CSV file. If the source file is not in this
format, or to export recipient data from your local database or CRM first, ask your IT department for assistance. If the source file is a spreadsheet, convert it to CSV with the Save as
command.
Tip: Trial import
Before importing, run a Test import to check recipient list data and
the correct assignment to a Optimizely Campaign recipient list.
To import your recipient data, follow these steps:
l

Step 1: Start

l

Step 2: Recipient list
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l

Step 3: Row mapping

l

Step 4: Import type and import options

l

Step 5: Import

Step 1: Start
1. Open the Optimizely Campaign menu and select Recipients > Import.
2. Click Browse and select the file with the recipient data.
Note: The maximum allowed file size is 50 MB. To upload larger
files, see Transferring files through SCP and Automatic recipient
import.
3. Click Next. The file is uploaded to the Optimizely server.

Step 2: Recipient list

1. In the Select Recipient List area, click the list to which you want to import new recipients.
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Note: If you want the recipients to be imported to go through an
opt-in process, you must select an opt-in recipient list. You can
make further settings for the opt-in process in step 4.
2. In the File Options area, specify the characters your CSV file uses to separate the
entries.
Separator. Select a character (semicolon, comma, tabulator and so on) that separates data fields on the lines of the uploaded file.
l
Escape character. Some database programs use a single quote (') or double quote
(") around each data field when exporting. Select which one is used in the
uploaded file.
3. Click Next.
l

Tip: You cannot add new recipient lists. New recipients are added to
an existing list.

Step 3: Row mapping
You must assign each column of the recipient list to a corresponding column in the imported recipient list. The left column of the Row Mapping tab lists fields of the Optimizely
Campaign recipient list into which you are importing. The right column contains column
headers from the imported list.
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1. Assign fields according to their content. Typically, Optimizely Campaign suggests the
correct assignment (such as matching first name with first name). However, if first
name in the recipient lists corresponds to name in the file, you must select the correct
assignment.
2. If you prefer to import data fields selectively (for example, only recipients' last names
have changed), select the --- option for fields that should not be changed.
3. Select the Fixed value check box to change the pop-up menu to an entry field in
which you can enter any text or value (except for the Email field). This value or text is
then imported into the corresponding field for each record.
For example, you generate email addresses of newsletter subscribers through your
website as well as other sources (cooperation partners and so on). If you import
records supplied by a cooperation partner, use the Origin field to indicate the partner's name or a corresponding code, so you can track the subscription's origin. You can
also evaluate the activity of subscribers from various sources.
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For another example, if your recipient list also contains mobile numbers, enter a country code for these fields during import if the imported numbers do not contain them.
The country code is automatically prepended to the telephone number, and the telephone number may be standardized (eliminating the 0 before the area or network
code).
4. Under Content Options, the Action drop-down list lets you select whether to replace,
prepend, or append contents of recipient list fields of type "String" and "Text".
Tip: See also: Data types.
When you select the Prepend or Append action, the Separator drop-down list
appears. Select a character (semicolon, comma, tabulator and so on).
5. Click Next.

Step 4: Import type and import options
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1. In the Select Import Type area, select the import type.
Depending on the configuration of your client and your user authorization, you may
see only some options.
l

l

l

l

Simple import. Imports new recipients into your list. Existing records, unsubscribes
or blocked recipients are skipped.
Import new recipients and update existing records. Default import type. New
recipients are added to the recipient list. Existing records are checked and
updated as required. Optimizely Campaign identifies recipients by recipient ID, usually email address. If a recipient's email address has changed, he is imported again,
because Optimizely Campaign does not recognize it as an existing recipient.
Update only. Does not import new recipients. Only updates existing records as
needed. If a recipient's email address changed, the recipient is skipped, because
Optimizely Campaign does not recognize it.
Clear recipient list before importing. Overwrite existing recipient list in Optimizely Campaign with data from the uploaded file. You should upload your complete
address data.
Overwriting can be practical if recipients can unsubscribe both by clicking in the
newsletter and through the call center. In this case, the unsubscribe information
must find its way to Optimizely Campaign so that these recipients are unsubscribed and receive no further mailings. If your call center deletes a record from
your database or CRM software, you can guarantee that this recipient is deleted by
selecting Clear recipient list before importing.

2. In the Set Import Options area, select one or more of the following import options:
l

l

l

Skip first row. Often, the uploaded file has field names in the first row. Select to
skip the table headers and start importing with the second row.
Import unsubscribers. If this option is available, you can import recipients who are
already marked as unsubscribed in your client. Newly-imported recipients receive
mailings right after importing them with this import option.
Import global unsubscribers. If this option is available, the Import unsubscribers option only affects the marketing channels (media types) of the selected
recipient list. If you activate both options, you import recipients that globally
unsubscribed from all marketing channels.
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Note: This option is only active together with the Import
unsubscribers option.

Note: Permission is required for recipients. Do not send newsletters to unsubscribed recipients, if no permission (opt-in) exists.
3. Add opt-in processes if you want to import recipients from a source that is not linked
to an automatic opt-in process, such as from a telephone campaign. Select Standard
for a Single Opt-In process or DOI for a Double-Opt-In process. Imported recipients
receive a welcome or a confirmation email with an activation link. You can select this
option only if the confirmation mailing is set up and edited beforehand.
Note: Only import recipient lists once
If a double opt-in process is selected, imported recipients only
appear in the list after they have clicked the activation link in the
confirmation email. Optimizely Campaign automatically sends
this email after the import, if an opt-in process is selected.
Only import recipients once, even if they do not appear in the list
after the import. Otherwise, a confirmation email is sent each time
you carry out an import.
4. Click Import. The import starts and the Import tab opens.

Step 5: Import
When the import is finished, Save
were found. Click Save

appears next to each category for which records

to download those records.
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The number of processed records and the import result are listed for each category:
l
l
l

Records processed. Number of processed records.
Records added. Number of newly added records.
Records updated. Number of updated records.
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l

l

l

l

l
l

l
l

l

Records skipped (error in file). The column assignment did not correspond with the
selected values in the third step. For example, a record may contain only three columns
instead of the indicated four columns.
Records skipped (error in list). Number of skipped records; because they already existed, no changes were found, or you selected the option Update only and new records
were found in the list.
Records skipped (on blocklist). Recipients that are blocked. Depending on your client
hierarchy, there might be several blocklists. A blocked recipient might not appear in the
blocklist of your client, but be blocked on the list of the main client.
Records skipped (exceeded the bounce limit). Recipients that exceeded the bounce
limit.
Records skipped (prior unsubscribes). Recipients who previously unsubscribed.
Records skipped (prior target group). The recipients were not imported because your
client or the confirmation email (confirmed or double opt-in) uses target groups that do
not match.
Duplicates in file. Recipients only imported once to avoid duplicates in the recipient list.
Records already in recipient list. Recipients already in the recipient list are skipped to
avoid duplicates.
Erroneous records. Optimizely Campaign validates data when importing them. Erroneous
records may contain invalid characters or, in case of email addresses, a missing @ symbol
or an invalid domain. Such records are not imported.
Tip: You can also import recipients automatically on a regular basis,
for example to synchronize them with an external distribution list. For
more information, see Scheduled jobs.

Importing recipients by category
Note: To enable this feature, contact customer support.
If you maintain distribution lists in an external system, this additional feature lets you synchronize your external distribution list with Optimizely Campaign recipient lists. This feature lets you automatically import recipients into your client.
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You can import the following categories in individual CSV files or as multiple lists with markers for each category:
l
l
l
l

Recipients
Unsubscribers
Blocked recipients
Post clicks (requires a web analysis program with an export function)

Exporting recipients
Note: You need special user rights to use this function.
You can export recipients by status into a CSV file:
l
l
l
l

Active recipients
Unsubscribed recipients
Blocked recipients
Recipients that exceeded the bounce limit

To export recipients:
1. Open the Optimizely Campaign menu and select Recipients > Export.
2. Select the recipients you want to export.
3. Click Options.
l

l

Active Recipients. Click the recipient list whose recipients you want to export. To
export only recipients of a specific marketing channel, select the marketing channel from the Media Type drop-down list (available for active recipients only). You
can also limit the recipient list by selecting one or more target groups from the Target Groups drop-down list.
Unsubscribed Recipients. Enter a start and/or an end date.
o

If you do not enter a start or end date, all recipients in the selected status are
exported.
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o

o

If you enter only a start date, recipients from that date to the present are exported.
If you enter only an end date, recipients from the creation of your client until
the entered date are exported.
Tip: If you use unsubscribe lists based on recipient lists, also
select an unsubscribe type:
o

o

l
l

Global. Exports client-wide unsubscribers that are not
assigned to any particular recipient list.
Recipient List. Exports unsubscribers that are assigned
to one or more recipient lists.

Blocked Recipients. Click the recipient list whose recipients you want to export.
Recipients That Exceeded the Bounce Limit. Enter a start and/or an end date.
o

o

If you do not enter a start or end date, all recipients in the selected status are
exported.
If you enter only a start date, recipients from that date to the present are exported.

If you enter only an end date, recipients from the creation of your client until
the entered date are exported.
4. Click Finish.
o

Tip: You can start several exports for different statuses simultaneously, but only one export per status.

Exporting recipients by category
Note: To enable this feature, contact customer support.
This function lets you automatically export recipient data by category into CSV files.
l
l

Active recipients
Blocked recipients
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l
l

Post clicks (requires web analytics software with an export function)
Recipients that exceeded the bounce limit

An individual CSV file is created for each category. Alternatively, you can create a multiple
lists with flags for each category.

Cross-checking recipients
Optimizely Campaign identifies the recipients of a mailing and which internal lists are used
for this purpose. If you maintain recipient lists outside the Optimizely Campaign environment, this information can help keep your lists consistent. If you have questions regarding the operation and configuration of your client, contact customer support.
Optimizely Campaign validates recipient data in the following modules and functions:

l

Importing recipient lists
Calculating recipients for a mailing
Sending out a mailing

l

Editing the blocklist

l
l

The following lists, managed internally by Optimizely Campaign, also impact the validation
of recipients for mailing dispatches:
l

Unsubscribe list

l

Bounce counter

Cross-checking recipient lists
Duplicates
When you import a recipient list, Optimizely Campaign filters out duplicates. Duplicates
within imported CSV files are also checked, so only one record per recipient is imported.
Tip: If you select the Clear recipient list before importing option,
the list is not cross-checked because it is deleted before any data is
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imported.
If you select the Import new recipients and update existing
records option, existing records are not treated as duplicates but are
overwritten with new values.

Blocklist
Imported records are cross-checked against the blocklist. Blocked recipients, including
those serving as placeholders, are not imported.

Unsubscribers
Unsubscribers are included on an unsubscribe list, which usually applies to clients (though
not inherited). You can create unsubscribe lists based on recipient lists and permanently
linked to a recipient list, which do not affect other recipient lists in the same client.
Unsubscribers are not deleted from the database and not imported a second time.

Incorrect data records
During import, Optimizely Campaign checks the following email address criteria:
l
l
l
l

An address must contain exactly one @ symbol.
An address's local element (before @) may not begin or end with a dot.
Two consecutive dots cannot occur
Blank spaces and the following special characters are not permitted: ( ) [ ] \ ; : , <
>

l

An address's domain element (after @) must conform to the domain name system rules

Imported records must also have fields in the recipient list that match columns in the
imported list. Incorrect records are not imported.
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Analyzing records that are not imported
After importing a recipient list, you can download the non-imported records as a CSV file
for each category described above. Use this file to manage the original list.

Cross-check for mailing dispatch
When you initiate a mailing, recipients are selected based on the following criteria and
algorithms:
l

l
l

Recipients on a blocklist, unsubscribers, and recipients with a bounce overflow are not
contacted.
Where applicable, target groups and maximum numbers of recipients are determined.
Email addresses are checked for correctness (see Incorrect data records).

After a mailing is sent out, responses are analyzed. Recipient addresses that produce a
bounce generate an automatic reply to the return address. The replies are analyzed by
Optimizely Campaign. Hard and soft bounces are counted separately for each recipient. A
recipient who reaches the bounce limit for hard or soft bounces will not be contacted
again. These recipients remain on the recipient list but are skipped when mailings are sent
out (see Bounces).
Recipients who click the unsubscribe link are placed on the unsubscribe list. These recipients still appear in the recipient list but will not be sent mailings. The unsubscribe list
records the email, a time-stamp, and the mailing the recipient received when he/she
unsubscribed. These records make it easier to track cancellations – in the event of a complaint, for instance.

Cross-checking bounces
A bounce is generated whenever an email fails to reach a recipient's email server or mailbox. It informs the sender that the email could not be delivered.

Soft bounces
A soft bounce is generated when a mailbox is temporarily unavailable, such as when a mailbox is full and unable to accept more email until the user deletes some. Soft bounces
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seldom occur, because memory is usually large enough to handle a large number of emails.

Hard bounces
A hard bounce is generated when a server address or mailbox does not exist due to a technical problem (such as a server is down). A hard bounce is also generated if a mailbox no
longer exists, which may have several reasons:
l
l

The email address is entered incorrectly (even though syntactically correct).
The user canceled the email account.

Bounce counter and bounce limits
Bounce limits for soft and hard bounces are set when configuring the client. The standard
limit is three hard bounces or five soft bounces. Once reaching this limit, the recipient
receives no more mailings. Bounces are counted across clients for each recipient.
l

How can I see how many bounces a recipient has generated?
You cannot view bounces from the Optimizely Campaign user interface but you can
retrieve the number of bounces via the Optimizely Campaign REST API. If you use the
SOAP API, the getBounceCounter method also shows the number of bounces.

l

Can I view recipients who have generated a bounce overflow?
You cannot view bounced out recipients from the Optimizely Campaign user interface.
However, you can use the Exporting recipients by category feature to download
bounced out recipients as a CSV file. Contact customer support for assistance.
You can also use the Optimizely Campaign REST API to get information whether a recipient has exceeded the bounce limit. If you use the SOAP API, the isBounceCounterThresholdExeeded method also shows if a recipient has exceeded the bounce limit.

l

Can I reset the number of bounces generated by the recipient?
You cannot reset a recipient's bounce count from the Optimizely Campaign user interface. To reset the bounce count, contact customer support. But you can reset the
bounce count via the Optimizely Campaign REST API, or if you use the SOAP API, the
resetBounceCounter method also resets the bounce count to 0.
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l

If an email account cannot be contacted, does it matter whether and how often I
send mailings to it? It may be reactivated at some point.
That may be true in theory. In practice, however, mailings to unavailable or non-existent emails are saved and analyzed by the internet service provider. If a sender sends
too many emails to unavailable addresses, the provider places the sender on a blocklist
and treat those emails as spam. So, it is better to stop mailings to a recipient who generates three/five bounces.

Cross-checking blocklists
Blocklists contain recipients who should not be contacted, including recipients who have
submitted complaints, but also known spam traps and postmaster accounts which are
standard for every email account.

Blocklist hierarchy and delegation
Depending on the how a client is structured, it can have one or more blocklists. Entries in a
blocklist are inherited by sub-clients from main clients. If you lack authorization to access
the main client, you cannot view its blocklists. The main client blocklists also apply to the
sub-clients.

Placeholders
Blocklists, unlike recipient lists, can use placeholders. For example, you can block a
domain. So while a recipient's email address is not specifically on the blocklist, a recipient's
domain can block the recipient.
l

Can I define a blocklist for a single recipient list?
No. A recipient list applies across clients.

l

Can I view blocklist entries in higher level blocklists?
You must have authorization to access a higher level client.
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l

Can I prevent a blocklist from being inherited by sub-clients or define exceptions?
No. Blocklist entries are inherited by sub-clients. You cannot circumvent this type of
inheritance. Also, you cannot define exceptions for blocklist entries.

Cross-checking unsubscribe lists
Recipients who unsubscribe from a mailing by using an unsubscribe link or de-registration
form are marked as unsubscribed. However, they are remain on the recipient list. When a
mailing is sent, these recipients are filtered out.
l

Can I view the unsubscribe list in my client?
You may not view unsubscribe lists using the Optimizely Campaign user interface.
There are several ways to retrieve unsubscribers.
1. Using the Download unsubscribers feature, download an unsubscribe list as a
CSV file through the user interface.
2. If you are using the REST API, use the GET method to retrieve information about all
unsubscribes.

l

3. If you are using the SOAP API, use the contains and containsAll methods to query
whether one or more recipients are on an unsubscribe list.
Can I configure an unsubscribe list so that it only applies to one recipient list?
Yes. You can set up an unsubscribe list based on a recipient list. Whether it makes
sense to do so depends on the recipient list and how a client is structured. Contact customer support for assistance.

l

Can I use the Optimizely Campaign user interface to place a recipient on the
unsubscribe list or remove him/her from it?
No. Only the recipient can complete the unsubscribe process. To rescind an unsubscription, the recipient must re-register (by using the opt-in option, depending on the
configuration).

l

Can I unsubscribe a recipient by deleting him/her from the recipient list?
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If you deleted from the recipient list, the recipient no longer receives mailings from this
list. If appearing in multiple lists, however, the recipient will continue to receive mailings via the lists from which the recipient is not deleted.
Note: You should not delete a recipient from the list because the
recipient's de-registration is not recorded, so the recipient can
be added to a recipient list again. This can result in a complaint if
the recipient continues to receive mailings after unsubscribing.
l

I manage my recipient list myself and import it to Optimizely Campaign prior to
each mailing. What should I keep in mind when doing this?
Make sure that you import only active recipients into the recipient list. Import unsubscribers into the unsubscribe list so that the cross check can take place before dispatch.
You also can use specially designed jobs/services to import unsubscribe lists or multiple lists. These jobs/services are not accessible via the Optimizely Campaign user
interface. The lists are transferred onto the Optimizely Campaign server per SFTP and
automatically imported to the client:
o

o

Importing an unsubscribe list. Import your local unsubscribe list to the unsubscribe
list on your client.
Importing recipients including unsubscribers. Import an individual recipient list
that contains active recipients for a variety of recipient lists and unsubscribers. The
status of a recipient, or the list to which it is being imported, must be entered in a separate recipient list column to keep your lists consistent.
Tip: Contact customer support for configuration of jobs/services.
Imported data must have a defined name and be stored in a
defined directory per SFTP.
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Recipient lists
Tip: To create a new recipient list or change properties and data
fields of existing recipient lists, you can use Recipient list management
(Beta).
In the Optimizely Campaign menu under Recipients > Recipient Lists you can copy, edit
or clear recipient lists. The overview area shows recipient lists for your client, and the number of recipients in each list. If you select a recipient list, the Recipient list details area
provides additional information about the included recipient list fields.

Copying recipient lists
Creates a new recipient list that contains the same data fields as the selected source list.
Only the list structure is copied, not the entries.
To copy a recipient list, select a recipient list and click Copy.

Editing recipient lists
Change the name or description of a list. You can also set any recipient list as a test list.
Use test lists only for sending test emails, not regular sending.
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Note: Do not use real customer data for test lists.
To edit a recipient list, select a recipient list and click Edit.

Clearing recipient lists
Deletes entries from a recipient list. The list itself is not deleted and can be used again.
To clear a recipient list, select a recipient list and click Clear.
Tip: To delete and/or unsubscribe multiple recipients from multiple
recipient lists, use Cleanup.

Displaying recipient list details
If Separate data storage is activated in your client, you can use Details to access the settings to hide or display recipient list fields (data fields) with personal data for users of your
client.
1. Click Details. The Show recipient list details opens.
2. In the list, select the recipient list field you want to hide or display for users of your client.
3. Click Edit. In the Shown data column, a drop-down list opens.
4. In the drop-down list, select:
Master data. Display the recipient list field only to users with appropriate permissions.
l
Properties. Display the recipient list field to all users.
5. Click Submit.
6. If necessary, repeat these steps for additional recipient list fields.
7. To save the changes for recipient lists, click Apply changes to all lists. To save the
changes only for the selected recipient list, click Apply changes.
l
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Tip: Separate data storage supports three user permissions for displaying personal recipient data:
l
l

l

View Properties fields only
View Master data fields and Properties fields separately (so a user cannot
associate properties with a recipient)
View Master data and Properties fields

For details about Separate data storage and individual user permissions, contact customer support.

Data fields
Every recipient list contains an unlimited number of data fields. One data field is reserved
for the recipient ID, usually the email address. You cannot edit the recipient ID field.
Instead of the email address, you can use any other ID, such as a customer ID.

Data types
Each data field can store a certain data type, which is selected when the recipient list is
created. According to the data type, you can perform mathematical and/or logical operations with the value of a data field. For example:
l

l

l
l

Numbered fields. Numbers can be integers (32-bit/64-bit) or floating decimals. Compare
the value of a field with a given value (equals/is less than/is greater than).
Date fields. Compares date and time (is older than/is younger than/is prior a given time/date/is past a given time/date/is exactly ... old).
Boolean fields. Perform is true or is false operations.
String fields. Congruity or incongruity of strings and characters (begins with, end with,
does not begin with, does not end with, contains, does not contain).

The following data types and range of values are permitted for recipient list data fields:
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Data
type
Boolean

Range

true/false

Example

Registration via website, interested in promotional newsletters
Registration date. Supported date formats:

Note: Programming interfaces
(APIs) only support date formats
according to ISO 8601.

Date format

Date

date

single-precision 32-bit
IEEE 754 floating point

Example

yyyy-MM-dd

Date with
separator

2017-05-07

yyyy-MM-dd
HH:mm:ss

Date and
time

2017-05-23
09:50:04

yyyy-MMdd'T'HH:mm:ss

Date and
time according to ISO
8601

2017-0523T09:50:04

yyyy-MMdd'T'HH:mm:ss,SSS

Date and
time with milliseconds

2017-0524T08:03:59,123

Date and
time with
time zone offset

2017-0507T12:18:54+02:00 2017-0507T08:18:5402:00

yyyy-MMdd'T'HH:mm:ssXXX

Float

Description

Conversion volume, customer score
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Data
type

Range

Integer

32-bit-signed; 2,147,483,648 2,147,483,647

Customer's year of birth

Long

64-bit-signed; 9,223,372,036,854,775,808 9,223,372,036,854,775,807

Customer ID

String

up to 255 characters

Email address, first name, last name, city, postal code

Text

up to 65,535 characters

Email address, first name, last name, city, postal code

Example

Cleaning up recipients
Cleanup lets you automatically delete and/or unsubscribe recipients from recipient lists.
You upload a CSV file with the recipients you want to delete or unsubscribe, then select
the lists.
Note: To delete and/or unsubscribe recipients, you must have the
appropriate rights.
1. Create a CSV file containing the IDs of the recipients you want to delete or unsubscribe.
Tip: Optimizely Campaign identifies recipients by recipient ID,
usually email address.
2. Open the Optimizely Campaign menu and select Recipients > Cleanup.
3. In the Upload File tab, click Browse….
4. Select the CSV file created in step 1 and click Preview. The file is uploaded to the
Optimizely server. The Preview tab shows the uploaded recipients.
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Note: The Recipient column must contain recipient IDs. On
import, only this column is considered.
5. If email addresses do not display correctly, change the Character Encoding option.
6. If the first line of the CSV file contains column names, in the Skip First Row list, select
Yes.
7. Click Refresh Preview to check your settings.
Tip: To only unsubscribe recipients, go to step 10. To only delete
the recipients, go to step 12.
8. Click Delete.
9. In the Delete Recipients area, select the Delete recipients check box. In the Recipient Lists area, select one or more recipient lists from which you want to delete the
recipients.
10. Click Unsubscribe.
11. In the Unsubscribe Recipients area, select the Unsubscribe recipients from all
recipient lists check box to unsubscribe recipients from recipient lists.
12. Click Summary. In the Summary tab, all actions to be performed are displayed.
13. To make changes, click the corresponding tab and perform the appropriate steps.
14. Click Finished. The recipients are deleted and/or unsubscribed according to your settings. You receive a notification email to your email address once the process is complete.
Note: While the process is running, you cannot run a new one.

Tip: You may need to export the data from your recipient database,
CRM application or similar. If the source file is not a CSV file or if you
want to export the recipient data from your local database or CRM
first, ask your IT department for assistance. If the source file is a
spreadsheet file, you can convert it into a CSV file. Open the file with
your spreadsheet application (for example Microsoft Excel), select
Save as -> .csv file and save it to your local hard drive.
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Recipient list management (Beta)
Note: The recipient list management is in beta phase and will be
released for all users soon. To use this feature at this stage, contact
customer support.
In the Optimizely Campaign menu under Recipients > Recipient Lists, you can manage
recipient lists and recipient list fields. The recipient list overview shows all available recipient lists and the number of recipients in each list. If you select a recipient list, the Recipient List Details area provides additional information about the included recipient list
fields.

Managing recipient lists
You can create, edit, copy and clear recipient lists.

Creating recipient lists
Create a recipient list from scratch or based on an existing recipient list.
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New recipient list
1. In the recipient list overview, click Create….
2. Click Create List.

3. In the Create recipient list dialog box, configure the recipient list.

l
l

Name. Enter a name for the recipient list.
Description. Optional. Enter a description for the recipient list.
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l

Type. Select one of the following list types from the drop-down list:
Default. Select the default type if you have already recorded the recipient's
opt-in in your system. See Opt-in.
o Opt-in. Select the opt-in type if you want to execute the double opt-in process
in Optimizely Campaign as soon as a new recipient is added to the list. See
Opt-in processes.
o Transaction. Select the transaction type if you want to use the recipient list
for transactional mails. See Transactional mails.
Test List. To set up the recipient list as a test list, select the check box. See Test
dispatch.
o

l

Note: Do not use real customer data for test lists.
4. Click OK.
5. Drag and drop the desired recipient list fields from the left Recipient List Fields area
into the right Recipient Lists area. Alternatively, you can select the recipient list fields
and assign them to the recipient list via the context menu or by clicking Assign Field .

Note: Assign at least one media type recipient list field (marketing channel) to the recipient list.

Tip: You can filter available recipient list fields by typing the
name of the recipient list field or part of the name into the search
field.

© Optimizely 2022

734 | Optimizely Campaign User Guide 2022-03-14

Tip: An eye icon
appears after the field name of fields that
have different field names in different recipient lists.
6. To create additional recipient list fields, click Add Field…. See Creating recipient list
fields.
7. Set one recipient list field as primary key by selecting the recipient list field and clicking Set as Primary Key in the context menu.

Note: One recipient list field is reserved for the ID of the recipient dataset (primary key) - usually the email address. This recipient list field cannot be changed later. You can also set another
recipient list field as primary key instead of the email address, for
example, the customer ID.

Tip: A key icon
appears after the field name of the recipient
list field set as primary key.
8. Optional: Specify which recipient list fields are required by selecting the appropriate
recipient list fields in right Recipient Lists area and clicking Set as required in the
context menu. You cannot remove these recipient list fields from the recipient list afterwards.
Tip: A lock icon
appears after the field name of recipient list
fields set as required.
9. Click Save.
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Tip: You can also create a recipient list by assigning the recipient list
fields first and then clicking Create List.

Based on existing recipient list
1. In the recipient list overview, click Create….
2. Select a recipient list from the drop-down list.

Tip: You cannot select grayed-out recipient lists.
3. Click Create list > Copy….
4. In the Copy recipient list dialog box, configure the recipient list.

l

Name. Enter a name for the recipient list.
Description. Optional: Enter a description for the recipient list.
Type. Select one of the following list types from the drop-down list:

l

Default. Select the default type if you have already recorded the recipient's
opt-in in your system. See Opt-in.
o Opt-in. Select the opt-in type if you want to execute the double opt-in process
in Optimizely Campaign as soon as a new recipient is added to the list. See
Opt-in processes.
o Transaction. Select the transaction type if you want to use the recipient list
for transactional mails. See Transactional mails.
Test List. To set up the recipient list as a test list, select the check box. See Test

l
l

o
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dispatch.

Note: Do not use real customer data for test lists.
5. Click OK.
6. To assign additional recipient list fields to the recipient list, drag and drop the desired
recipient list fields from the left Recipient List Fields area into the right Recipient
Lists area. Alternatively, you can select the recipient list fields and assign them to the
recipient list via the context menu or by clicking Assign Field.
Tip: An eye icon
appears after the field name of fields that
have different field names in different recipient lists.
7. To create additional recipient list fields, click Add Field…. See Creating recipient list
fields.
8. To remove recipient list fields from the recipient list, drag and drop the desired recipient list fields from the right Recipient Lists area into the left Recipient List Fields
area. Alternatively, you can select the recipient list fields and remove them via the context menu or by clicking Unassign Field .
9. Optional: Specify which recipient list fields are required by selecting the appropriate
recipient list fields in right Recipient Lists area and clicking Set as required in the
context menu. You cannot remove these recipient list fields from the recipient list afterwards.
Tip: A lock icon
appears after the field name of recipient list
fields set as required.
10. Click Save.

Editing recipient lists
Note: If you change recipient lists, you may have to adjust target
groups with recipient-data-based conditions as well as scheduled
jobs.
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1. Select a recipient list in the recipient list overview.
2. Click Edit….
3. Click List Settings….

4. In the Edit recipient list dialog box, configure the recipient list as described under
Creating recipient lists.
Tip: You cannot change the list type. Create or copy a recipient
list and select a new list type.
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5. To assign additional recipient list fields to the recipient list, drag and drop the desired
recipient list fields from the left Recipient List Fields area into the right Recipient
Lists area. Alternatively, you can select the recipient list fields and assign them to the
recipient list via the context menu or by clicking Assign Field.
Tip: An eye icon
appears after the field name of fields that
have different field names in different recipient lists.
6. To create additional recipient list fields, click Add Field…. See Creating recipient list
fields.
7. To remove recipient list fields from the recipient list, drag and drop the desired recipient list fields from the right Recipient Lists area into the left Recipient List Fields
area. Alternatively, you can select the recipient list fields and remove them via the context menu or by clicking Unassign Field
.
8. Optional: Specify which recipient list fields are required by selecting the appropriate
recipient list fields in right Recipient Lists area and clicking Set as required in the
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context menu. You cannot remove these recipient list fields from the recipient list afterwards.
Tip: A lock icon
appears after the field name of recipient list
fields set as required.
9. Click Save.

Copying recipient lists
1. Select a recipient list in the recipient list overview.
2. Click Copy….
Tip: Only the list structure without recipients is copied.
3. Edit the copied recipient list as described under Editing recipient lists.

Clearing recipient lists
To delete all recipients from a recipient list, select the recipient list in the recipient list
overview and click Clear. The list itself is not deleted and can be used again.
Tip: To delete or unsubscribe multiple recipients from multiple recipient lists, you can use the Cleanup feature.

Managing recipient list fields
You can create, edit and delete recipient list fields, and show assigned recipient lists.
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Creating recipient list fields
1. In the recipient list overview, click Create….
2. Click Add Field….

3. In the Create Field dialog box, configure the recipient list field.

l

l

Field Name. Enter a name for the recipient list field. The internal name is automatically created from the entered field name.
Data Type. Select a data type for the recipient list field from the drop-down list.
o
o

o

Boolean. Select the Boolean data type for truth values (true or false).
Date. Select the date data type for date and time specifications. For example:
2022-01-01 12:00:00.
Decimal. Select the decimal data type for exact decimal numbers, such as
prices. For example: 29.99.
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o

o

o

o

o

Float. Select the float data type for rounded floating point numbers like the
generated revenue. For example: 1.2345.
Integer. Select the integer data type for small numbers, such as the customer's
year of birth. For example: 1984.
Long. Select the long data type for large numbers, such as the customer ID. For
example: 1234567890.
String. Select the string data type for texts of up to 255 characters. For
example: email address or first name.
Text. Select the text data type for texts of up to 65,535 characters. For
example: descriptive texts.
Tip: For more information about the different data types, see Data
types.

4. Click Apply.

Editing recipient list fields
Note: For assigned recipient list fields, you can only change the field
name. The change affects all recipient lists to which the recipient list
field is assigned.
1. Select a recipient list field and click Edit field in the context menu.

2. Edit the recipient list field in the Edit field dialog box as described under Creating
recipient list fields.
3. Click Apply.
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Deleting recipient list fields
Note: You cannot delete assigned recipient list fields.
To delete a recipient list field, select the recipient list field and click Delete field in the
context menu.

Showing assigned recipient lists
To show assigned recipient lists, select a recipient list field and click Show assigned lists
in the context menu.

Separate data storage
Note: To enable this feature, contact customer support.
The additional feature Separate data storage lets you restrict the visibility of recipient
data for users of a client.
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Recipient data
Recipient data is divided into:
l

l

Master data. Personal data such as email address and name. Master data is only displayed to users with the appropriate permission. See User management.
Properties. Action-based profile data such as events and sales promotions. Properties are
displayed to all users.

User permissions
The following user permissions are available for viewing recipient data:
l
l

l

Only Properties fields
Master data fields separated from Properties fields (so that a user cannot associate properties with a specific recipient)
Master data and Properties fields together

Changing the visibility of recipient list fields
1. Select a recipient list in the recipient list overview.
2. Click Edit….
3. Select a recipient list field and click Set as master data in the context menu. The
respective recipient data is only displayed to users with the appropriate permissions.
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Tip: An eye icon
appears after the field name of recipient list
fields set as master data.
4. To enable the visibility of a recipient list field, click Set as properties in the context
menu of the recipient list field.
5. Click Save.

Data types
The following data types and range of values are permitted for recipient list fields:
Data
type
Boolean

Range

true/false

Example

Registration via website, interested in promotional newsletters
Registration date. Supported date formats:

Note: Programming interfaces
(APIs) only support date formats
according to ISO 8601.

Date format
Date

date

Description

Example

yyyy-MM-dd

Date with
separator

2022-05-07

yyyy-MM-dd
HH:mm:ss

Date and
time

2022-05-23
09:50:04

yyyy-MMdd'T'HH:mm:ss

Date and
time according to ISO
8601

2022-0523T09:50:04
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Data
type

Range

Example

yyyy-MMdd'T'HH:mm:ss,SSS

yyyy-MMdd'T'HH:mm:ssXXX

Date and
time with milliseconds

Date and
time with
time zone offset

2022-0524T08:03:59,123
2022-0507T12:18:54+02:00
2022-0507T08:18:5402:00

Decimal

Decimal numbers with
up to 8 places before
the decimal point and 2
places after

Price information

Float

single-precision 32-bit
IEEE 754 floating point

Conversion volume, customer score

Integer

32-bit-signed; 2,147,483,648 2,147,483,647

Customer's year of birth

Long

64-bit-signed; 9,223,372,036,854,775,808 9,223,372,036,854,775,807

Customer ID

String

up to 255 characters

Email address, first name, last name, city, postal code

Text

up to 65,535 characters

Descriptive texts

© Optimizely 2022

746 | Optimizely Campaign User Guide 2022-03-14

Target groups
A target group is a subset of recipients defined by specific rules and conditions. Each target group may contain several rules and conditions and a logic relation between them. Use
target groups to send a mailing to a predefined group of recipients (such as recipients in
the US) or to create dynamic content and subject lines. Dynamic paragraphs let you show,
for example, different items to male and female recipients. You can use dynamic subject
lines to create specific attention even before a recipient has opened the mailing.
You can define a target group using the following classes of conditions:
l

l

l

l

l

Action-based conditions. Criteria based on an action or event (such as click, open) that a
recipient has performed. Those conditions apply only after a mailing is sent. An example
for an action is: Recipient has received a specific mailing and has clicked on a specific link
in it.
Recipient list-based conditions. Determines whether recipients are contained in specific recipient lists.
Recipient data-based conditions. Criteria based on any field of the recipient list (such
as City or Interest).
Optimizely Campaign-based conditions. Determines whether recipients are currently
passing through or already passed through Marketing Automation campaigns.
Target group-based conditions. Determines whether recipients are contained in
another target group.

If your client is configured for post-click tracking, you can track actions that are made on
your website. For example, select recipients who have bought a certain product from your
shop or have spent a certain amount in your shop. To configure a target group with post
clicks, select Actions from the first drop-down list and then has created one or more
post clicks.
Example: Define a target group that contains male recipients in the US. You may now vary
this target group by adding further rules, such as recipients who clicked on a specific link
in the last mailing they received. Use this target group to send a special offer or a promotional email to selected recipients. If you apply the target group to the whole mailing,
only the target group receives the mailing. If you apply it to a paragraph, it is shown only to
these recipients, while the others receive the regular mailing.
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Note: If you want to see the matches of a target group in the recipients overview and the selected target group contains user-based
data (for example, user actions), you get an error after clicking Apply.
Due to data privacy reasons, you are not allowed to analyze a single
user's data. When using this target group to send a mailing or to create dynamic content, it will work properly, though.

Tip: You can use segments created in Optimizely Visitor Intelligence
as target groups.

Managing target groups
To manage target groups, open the Optimizely Campaign menu and select Recipients >
Target Groups. Existing target groups appears. If you click a target group, its definition
appears in the bottom of the window. Every target group definition is made up of one or
more rules. For example, The email address contains "@example.com" or The first name is
"Mark".

Tip: You can organize target groups in folders.

Creating target groups
You can create a new target group from scratch or based on an existing target group.
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New target group
1. Click Create > New….
2. In the Client drop-down list, select the client for which you want to create a target
group.

3. Under Target Group Definition, define the rules and conditions for the target group
by clicking + and performing steps described in Defining a target group.
4. Optionally, you can execute a target group analysis.
5. Click Properties.
6. Select the folder where you want to save the target group. See also: Lists and folders.
7. Enter a name and an optional description for the new target group.
8. Click Create.
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From existing target group
1. Click Create > Copy….
2. In the Source Client drop-down list, select the client of which you want to use a target group as template.

3. In the Target Group drop-down list, select a target group.
4. In the Client drop-down list, select the client for which you want to create a new target group.
5. Under Target Group Definition, define the rules and conditions for the target group
by clicking + and performing steps described in Defining a target group.
Note: If you select a different target group template afterwards,
the target group definition is overwritten.
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6.
7.
8.
9.
10.

Optionally, you can execute a target group analysis.
Click Properties.
Select the folder where you want to save the target group. See also: Lists and folders.
Enter a name and an optional description for the new target group.
Click Create.

Copying target groups
1. Select a target group you want to copy and click Copy….
2. In the Client drop-down list, select the client to which you want to copy the target
group.
3. In the Target Group Definition area, define the rules and conditions for the target
group by clicking + and performing steps described in Defining a target group.
4. Optionally, you can execute a target group analysis.
5. Click Properties.
6. Select the folder where you want to save the target group. See also: Lists and folders.
7. Enter a name and an optional description for the new target group.
8. Click Create Copy.
Note: Recipient field does not exist in target client
If the target group you want to copy contains a recipient field based
on a rule that uses a recipient field that does not exist in the recipient lists of the target client, the respective name of the field is
shown like this: ???Name???. You can still copy the target group.
Next, open the target client and select the copied target group.
Change the field name by selecting a field from the drop-down list
and save the target group.

Editing target groups
1. Select a target group you want to edit and click Edit…. The Edit Target Group window
opens.
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2. In the Target Group Definition area, edit the rules and conditions or add new ones for
the target group. To edit a rule, click it and perform steps described in Defining a target
group.
3. Optionally, you can now execute a target group analysis.
4. Click Properties.
5. You can change the name or description of the target group, or add and edit rules and
conditions.
6. Click Save.

Using Optimizely Visitor Intelligence segments as target group
If you have Optimizely Visitor Intelligence on your website, you can use segments as target
groups for your campaigns. See Creating a marketing segment for an instruction on how to
create a segment in Optimizely Visitor Intelligence based on website visitor profiles. You
can then use the created segments in Smart Campaigns and Marketing Automation.
See Using marketing segments as target groups for mailing campaigns in the Optimizely
User Guide.

Target group definition
When creating a new target group, the Target Group Definition area is empty, except for
a plus icon +.
1. Click Add + and, in the very left drop-down list, select whether you want to create a
negative condition. Select Not if the criteria you define for it is false. To create a positive condition, leave this first drop-down field blank.
Note: Sometimes you want to formulate rules in a negative fashion. Select the not option from the first drop-down list while creating a rule. For example, to find recipients not from Berlin, the
rule would be: not Recipient list field "Location" is equal to "Berlin".
2. In the next drop-down list, select whether you want to create an action-based, campaign-based, recipient list-based, recipient data-based or target group-based
condition.
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As another option, you can use the parentheses to hierarchically handle more complex
definitions. Rules within parentheses are applied first and then the rules in the second
level and so on. Use AND or OR logic relations between two conditions. To change the type
of relation, click it. Due to correctness and logical unambiguousness, target groups without
parentheses can only contain one type of logic relation. Thus, if you click a relation, relations between the rules are changed. If you want to use different types of logic relations,
use parentheses as in the following example.
Example
You are looking for recipients located in Berlin or Hamburg and with email accounts at
example.com.
(Recipient location equals Berlin OR Recipient location equals Hamburg) AND email
address contains @example.com
The parentheses makeOptimizely Campaign select recipients from Berlin or Hamburg first.
Then out of this subset, recipients with an example.com email account are selected.
Tip: Use drag-and-drop to sort rules and conditions or put them into
parentheses. If you hover over a rule, a context menu appears on the
right side. Click Add + to add a new condition at a specific position;
click Remove — to delete a condition. The Copy symbol creates a
copy of a condition.

Defining target groups based on recipient data conditions
If you selected Recipient list field in the second drop-down list, the following drop-down
list shows fields from your recipient list. Select the field you want to query, such as ZIP
code.
Depending on the type of field, in the next step you can select an operator. The operator
compares the content of the selected recipient field with a targeted value. The following
table shows all available operators. You complete other rules by entering a matching value
in the last field.
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Operator

Data field type

is equals to

String, numeric field, date field, boolean

is not equal to

String, numeric field, date field, boolean

is greater than

Numeric field, date field

is greater than or
equal to

Numeric field, date field

is less than

Numeric field, date field

is less than or equal
to

Numeric field, date field

is one of the following values

String, numeric field
See Multiple values.

contains

String

begins with

String

ends with

String

empty/unknown

String, numeric field, date field, boolean
See Empty fields (NULL values).

is not empty/unknown

String, numeric field, date field, boolean
See Empty fields (NULL values).

in exactly X hours

Date field

in exactly X days

Date field

is anniversary

Date field
Compares the day and month of the date field entry with the current day
and month so you can filter recurring events such as birthdays and
anniversaries.
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Operator

Data field type

is anniversary in
exactly X days

Date field

was exactly X days
ago

Date field

was less than X
days ago

Date field

is more than X days
ago

Date field

was lass than X
months ago

Date field

is more than X
months ago

Date field

Month is current
month

Date field
Compares only the month of the date field entry with the current month.

Day is current day

Date field
Compares only the day of the date field entry with the current day.
However, this does not mean today because all dates that have the same
day, will match.

Note: Comparing date field entries
The following conditions let you compare date field entries to consider time periods prior to today:
l
l
l
l
l

was exactly X days ago
was less than X days ago
is more than X days ago
was lass than X months ago
is more than X months ago
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Example 1: 2022-01-01 was exactly 5 days ago. If today was 2022-0106, the condition would apply.
Example 2: 2022-01-01 is more than 5 days ago. If today was 202201-07, the condition would apply.
Example 3: 2022-01-01 was less than 5 days ago. If today was 202201-05, the condition would apply.

Action-based conditions
If you selected Action in the second drop-down list, you can define the rule through recipient-specific actions or events (such as opens, clicks).
The following actions are available:
Action

Description

generated a hard bounce

Recipients who have generated a hard bounce. In the Mailing drop-down list, select either all mailings, mailings of a specific type or specific mailings.

generated a soft bounce

Recipients who have generated a soft bounce. In the Mailing
drop-down list, select either all mailings, mailings of a specific
type or specific mailings.

clicked a link

Recipients who have clicked one or more links. Select a time
period, the desired mailings, and the corresponding links. In
the drop-down list Count you can define the number of
clicks on a link (exact value or minimum number, optionally
with upper limit).

clicked links of click profiles

Recipients who have made a certain number of clicks in a
selected click profile. Select a time period and the desired
mailings. You can select the number of clicks and the desired
click profile in the drop-down list Clicks.

received mailing

Recipients to whom a mailing was sent, which means that
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Action

Description
the subscriber is not unsubscribed, blocked, or outbounced. Note that a recipient matching this criterion can
still create a hard or soft bounce. To exclude these recipients, create the target group as follows: has received mailing AND has NOT created soft/hard bounce.
Note: If you use Mailings Classic,
please see the note in the FAQs.

opened mailing

Recipients who have opened mailings one or more times.
Select a time period and the desired mailings. In the Count
drop-down list you can define the number of openings (exact
value or minimum number, optionally with upper limit).

responded

Recipients who have responded to mailings. Select a time
period and the required mailings.

created one or more post clicks

Recipients who have created one or more post clicks.

Note: Relative time period filter
In most action-based filters, you can select the Period filter Within
the last... n Hours/Days. The relative time period filter takes into
account the time span from the time of the calculation to the last relevant time stamp and calculates n further days/hours back from
there. Example: The period filter Within the last 1 hours takes into
account the currently started hour plus the last full hour. The highest
possible time value of this filter is 119 min 59 s.

Selecting a mailing
From the Mailing drop-down list, select one or multiple mailings for the target group definition.
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Note: Select only sent mailings. If you select, for example, paused,
canceled or incomplete mailings, you cannot use the target group
definition.
l
l

All mailings. All sent mailings.
Mailings of type. All sent mailings of a specific type:
o

o
o

o
o
o

Regular. Optimized mailings of an A/B test (Smart Campaigns) and mailings from Mailings Classics (deprecated).
Special. Transactional mails.
Transactional message. Split mailing of a transactional mail. See A/B test for transactional mails.
Confirmation email. Confirmations.
Split. Split mailings from Mailings Classics (deprecated).
Campaign. Mailings and split mailings of a Smart Campaign (without optimized mailings).
Tip: To select all mailings of an A/B test in a Smart Campaign,
select both options Regular (to select the optimized mailing) and
Campaign (to select the split mailings).

l

The following mailings. Select one or multiple mailings from the list.

Post click conditions
If post-click tracking is configured for your client, actions that a recipient does on your
website are tracked. You can create target groups using the post-click data, for example,
from select recipients who have bought a certain item in your web shop.
You can track post-click data using the proprietary Optimizely Campaign post-click tracking or a full-featured web analytics software. Optimizely maintains partnerships with several vendors, for example, Adobe, Webtrekk, Econda, Google Analytics and eTracker. If you
are interested in this option, contact your Optimizely account manager.
To create a target group with post-click data, perform the following steps:
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1. In the second drop-down list, select Action and in the following drop-down list, select
has created one or more post clicks. The input mask changes according to the postclick setup of your client.
2. If you use more than one post-click or web analytics service, select the one you want
to use from the Service drop-down list.
Tip: The internal Optimizely Campaign post-click tracking is
called default. If you use only one service, this drop-down list will
not appear when creating the target group. The service is displayed, though when you save the target group condition.
3. In the Mailing list, you can select post clicks that are created through a designated
mailing. If you leave this selection empty, any mailing, or no mailing at all, respectively,
is taken into account.
Tip: Post-click data that were not created through a mailing can
be processed only if they carry a user ID identical to the recipient
ID within Optimizely Campaign. Therefore, the ID your customers
use when logging in to your web shop should be the same as the
recipient ID used in Optimizely Campaign. Usually, the email
address is used as recipient ID. New customers and customers
that do not want to receive promotional emails can also receive
system emails (such as order confirmations) via Optimizely Campaign. If customers register for your newsletter, their post-click
data is completely available.
4. To delimit post clicks to a period or date, select a type in the Period field and enter a
date or a number of days in the calendar interface. The following scenarios are available:
l
l
l
l
l
l

No restrictions. Post-clicks are not delimited by time.
From ... until .... Post-clicks must be created in the designated period.
On .... Post-clicks must be created on a designated date.
Not on .... This scenario excludes the selected date.
After or on .... Post-clicks must be created on the selected date or later.
Before or on .... Post-clicks must be created on the selected date or earlier.
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l

Older than ... days. Post-clicks must be created X days ago or earlier.

l

In regular mailings, the time range is calculated from the sending date.
In system mailings, the time range is actualized every day.
Exactly ... days ago. Post-clicks must be created exactly X days ago.
o
o

l

In regular mailings, the date is calculated from the sending date.
o In system mailings, the date is actualized every day.
Within the last ... days. Post-clicks must be created within the last X days.
Within the last ... months. Post-clicks must be created within the last X months.
Today. Post-clicks must be created on the current day.

l

In regular mailings, this day is the sending date.
o In system mailings, an actualization is made every day.
Current month. Post-clicks must be created in the current month.

o

l
l

o

In regular mailings, this is month in which the mailing is sent.
o In system mailings, an actualization is made every day.
5. Select a category.
o

Tip: You can define categories individually and contain a string
(such as product name) or a float value (such as revenue). You
can combine several categories in one target group condition
and therefore select recipients who have bought product A and B
or have bought products from group X for more than 500 dollars.
By combining several post-click categories you may create recipient segments for discounts, cross- and up-selling offers, and so
on.
6. If the selected category is a string, you can select one of the following operators from
the list:
l
l
l
l
l

equals
does not equal
contains
is empty/unknown
is not empty/unknown
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starts with
l
ends with
7. Enter the identifier in the field next to the operator.
l

Tip: The automatic completion function helps you to exactly
match the name you are looking for. By default, the automatic
completion shows the first ten or fewer matches.
8. If the selected category is a float value (for example, a product price), you can select
one of the following operators from the drop-down list:
l
l
l
l
l
l

equals
does not equal
is greater than
is less than
is less than or equals
is greater than or equals

Optional: To aggregate post-click values, select one of the following operators from
the drop-down list that appears to the left:
one occurence in
l
sum of
l
average of
l
number of
9. In the field next to the operator, enter a value.
l

Note: When the selected operator is equals, the entered value
must match exactly the value given by the system, including
decimal places. Follow the instructions for entering multiple
values.
10. Click Apply.
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Recipient list-based conditions
If you selected Recipient list in the second drop-down list, the system checks whether
recipients are contained in a recipient list. Perform the following steps:
1. In the Recipient list, click a recipient list.
2. To add the condition to your target group, click Apply

.

Note: Optimizely Campaign identifies recipients by recipient ID, usually the email address. If you are using custom recipient IDs (that is,
no email addresses), you have to select recipient lists that use the
same custom recipient IDs.

Campaign-based conditions
If you selected MA campaign in the second drop-down list, the system checks whether
recipients are currently passing through or have already passed through a specific Marketing Automation campaign. You can select multiple campaigns for this condition also:
1. In the drop-down list, select has passed through MA campaign X or is currently
passing through MA campaign X.
2. In the following drop-down list, select one or more campaigns.
3. To add the condition to your target group, click Apply

.

Target group-based conditions
If you selected Target group in the second drop-down list, the system checks whether
recipients are contained in a target group. Perform the following steps:
1. In the drop-down list, select Recipient matches target group X.
2. In the following drop-down list, select the desired target group.
3. To add the condition to your target group, click Apply
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Use this condition to add target groups that are used many times (such as Men, Women,
...) as a component to other, more complex target groups. Thus, you only have to define
these component target groups once and can reuse them whenever they are needed.
Note: When defining target groups with a target group-condition,
take care that they do not exclude each other reciprocally. For
example, the target group you want to create matches recipients
from the Greater London area. To do so, you define a condition that
matches the respective postal codes. If you add a target groupbased condition to this target group matching recipients from Northern England, these two conditions would exclude each other reciprocally and there would be no matching recipients in this target
group.

Selecting multiple values
If you select is one of the following values, you can enter multiple values in one text box.
For example, if you want to copy values from a CSV file:
1. Select the operator is one of the following values.
2. Enter the values, for example, comma-separated.
3. Open the drop-down list, click the scissors symbol (Separate multiple values) and in
the box, enter the used delimiter symbol.
4. Click Apply. The entered values are now handled as single values.

Managing empty fields
There are generally three types of fields.
l
l
l

Fields which contain a value (Place of residence = "Berlin")
Fields which contain no value and are empty (Place of residence = "")
Fields which are unknown (Place of residence = unknown)

For example, if you acquired additional newsletter subscribers through an external action
(such as a sweepstakes) and imported these into your recipient list, some will not contain
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information for Place of residence. If you want to select recipients in your target group who
do not live in Berlin, the condition would be as follows:

With this, recipients are selected who have entered a place of residence other than Berlin
(such as Boston). However, the rule does not consider null values (unknown or no place of
residence) because the Optimizely Campaign logic assumes that it cannot be determined
whether the recipient resides in Berlin or not.
However, with another rule, you can modify the target group so that recipients whose
places of residence are unknown are also selected. To do this, add the rule .Recipient list
field "City" is empty/unknown and link both rules with or:

Thus, you include recipients without an explicit place of residence by using the query is
empty/unknown.

Target group analysis
The target group analysis lets you check a target group for correct functionality. You can
check how many recipients from recipient lists the target group definition matches. You
can also change the definition, if necessary, before sending the mailing.
1. Open the Optimizely Campaign menu and select Recipients > Target Groups.
2. Select a target group and click Analysis….
3. In the Recipient List drop-down list, select one or more recipient lists for which you
want to perform the target group analysis.
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Note: Ensure that all selected recipient lists have at least one
media type in common. If several lists with more than one media
type in common are selected, then select which media type represents the marketing channel. For example, if you want to send
emails, then select the media type Email.

4. If you use a default target group but you do not want this to be included in the calculation, select Disable default target group for this calculation.
5. Click Calculate. The calculation is started in the background. If the analysis is completely calculated, the graphical analysis is displayed.
The analysis contains the following information:
l

Recipients. Displays all recipients of the selected recipients lists that match the
target group. The recipients are sorted by the following categories:
o

o

ready. Matches the target group and ready for dispatch. You can send mailings
to these recipients.
bounced. Matches the target group but is not ready for dispatch, because
they are too many bounces.
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blocked. Matches the target group but is not ready for dispatch, because they
are blocked.
o unsubscribed. Matches the target group but is not ready for dispatch,
because they are unsubscribed.
Recipient Lists (Ready). Displays the number of recipients of the corresponding
recipient lists that match the target group and can send a mailing to; recipients
that create too many bounces, that are blocked, or unsubscribed are not taken into
account here.
o

l

Tip: If you want to change the target group, because it does not
match the desired number of recipients, edit the definition and
perform the analysis again.
6. If the Example recipients feature is enabled in your client, after the analytical calculation you can display sample recipients (up to 100 datasets) that meet the target
group definition. To do so, click Example recipients. A window with up to 100 sample
recipients opens.
Note: To enable the Example recipients feature, you need the
consent of your recipients to view and use personal data. If you
have this consent, complete a declaration of release for the use
of personal tracking data, sign it, and send it to customer support.
This form is available from customer support.

Counting recipients in several lists and list order
If a recipient is contained in several recipient lists, the recipient is counted only once. The
order of the recipient lists is crucial for the final result, too.
Example:
l

l

Recipient list Premium customers with a total of four recipients: Peter Marston, Mark
Smith, Lea Harris, Sarah Howard
Recipient list Default customers with a total of four recipients: Peter Marston, Mark
Smith, Julia Green, Sarah Howard

Perform the following steps:
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1. Create a target group women.
2. First, select the recipient list Premium customers and then the recipient list Default
customers. On the left, the analysis shows that mailings can be sent to only three
recipients (Lea, Sarah, Julia); the recipient Sarah Howard is contained in both recipient
lists so is listed once. On the right, two recipients (Lea, Sarah) of the recipient list
Premium customers and one recipient (Julia) of the recipient list Default customers
match the target group:

3. Swap the order of the two recipient lists and perform the analysis again. The two recipients (Julia, Sarah) of the recipient list Default customers and one recipient (Lea) of
the recipient list Premium customers match the target group:

Also, you can use the target group analysis to evaluate your recipient lists. For
example, you can quickly get the number of women contained in your recipient list. To
do so, create the target group definition The value of the field Salutation equals Mrs.
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and perform a target group analysis for a recipient list. However, perform such evaluations only on single recipient lists because recipients that are contained on multiple
recipient lists are only counted once (as described above).

Opt-in
The opt-in method forms the basis for operating legally compliant email and omnichannel
marketing campaigns. An opt-in method requires recipients to give a sender explicit permission to send them advertising mails. For this, the recipient:
l
l
l

actively agrees to receiving advertising emails by, for example, ticking a box, or
separately states that this acceptance relates solely to the receipt of advertising emails, or
agrees to a declaration that clearly defines the scope (Who is the advertiser? What is
being advertised? How often?).

This topic provides detailed information about the opt-in procedure and the double opt-in
to ensure you have evidence that permission was given.
Note: The following information is not legally binding.

Legal basis
In accordance with paragraph 7, section 2 UWG (the German Unfair Competition Act), sending advertising emails to consumers without their prior express consent is considered an
unreasonable nuisance and unfair competition.
To protect consumers from receiving unwanted email (spam), legally compliant email and
omnichannel marketing are based on permissions. The sender must have the consumer’s
consent to receive emails (for example, newsletters).
If a recipient has given permission via an opt-in method, the sender has valid proof of consent in the event of a complaint by the recipient.
Should legal action arise, the opt-in must be demonstrable in a court of law. Precise version management of the opt-in processes is advisable for use in practice.
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Exceptions
Transactional mails do not generally require an opt-in. For example, registration and order

confirmation emails may be sent without an opt-in. However, this only applies if the transactional mails do not contain additional advertising.

Omnichannel marketing: Separate opt-ins
In accordance with mandatory documentation requirements of data protection legislation,
ensure that you collect and record a separate opt-in for each advertising medium (telephone, text message, email and so on).
The opt-in text must exclusively seek consent for sending promotional material and – as
opposed to generic "general consent" for types of advertising – the text must precisely
describe the promotional materials. For example, you should differentiate between a regular newsletter and a reminder message that is sent when a customer does not respond to
an offer.

Validity of the permission
An opt-in may expire as established by current case law. This is generally be the case if
you do not contact a recipient for over one year. The previously given consent will no
longer apply if you begin contacting the recipient again after this period.
To prevent opt-ins from expiring, contact recipients regularly.

Opt-in method types
l

Double opt-in method
Note: Optimizely recommends the use of this opt-in method.
The double opt-in method is a procedure in which the end user consents to receiving
emails from the sender before any promotional emails are sent. Recipients receive an
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email with a double opt-in link, which they must click to confirm their newsletter registration.
Their addresses are only added to the recipient list after they click the link. This
method is intended to ensure that end users are not signed up for services against
their will by third parties. This not only aggravates the end users but also forces them
to tediously unsubscribe from the services.
Reasons to useOptimizely Campaign to manage double opt-ins
o
o

The entire process is managed from a single source.
Almost the entire subscription process can be managed by a single system.

By comparison, managing the process using an external system requires recipient data
to be synchronized and/or imported prior to every dispatch, which is a lot more work.
l

Single opt-in method
Warning: Optimizely does not recommend use of this opt-in
method.
Using the single opt-in method, an end user agrees to receive emails from the sender.
Their email address is then entered into the recipient list. Unlike the double opt-in
method, confirmation links are not sent. From a legal standpoint, the single opt-in
method is not recommended because it cannot be assumed that recipients have
entered their email addresses into the recipient list themselves.

l

Confirmed opt-in method
Warning: Optimizely does not recommend the use of this opt-in
method.
In the confirmed opt-in, an end user agrees to receive emails from the sender. The
recipient receives an email confirming that their data is recorded, and that they will
receive newsletters by email. This method suffers the same problems as the single optin method, except that the recipients are directly informed that their data was entered
into a recipient list.
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Implementing the double opt-in method with Optimizely Campaign
Setup
With the Optimizely Campaign Opt-in processes feature you can create and manage opt-in
processes and its confirmation mailings (opt-in emails). The opt-in email for the double
opt-in method must include the double opt-in link. The double opt-in link refers to the confirmation page, which is provided by Optimizely or hosted by you.
Insert the {Double Opt-in Link} field function into the mailing text or add it to the HTML

code, for example <p>To confirm your newsletter subscription, click the following link: <a href="{Double Opt-in Link}">Confirm subscription</a><p>.

Adapting your website
In the next step, you update your website so that the opt-in process you set up is initiated
when a new recipient subscribes to the newsletter using the form. If you are using the
REST API, you can add one or multiple recipients to a recipient list. You can also set up the
connection using the add2 or addAll3 methods, using the SOAP API, or using the subscribe
operation in the HTTP API. The opt-in process IDs required for this are available in the API
overview.
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Examples
Newsletter subscription
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Confirmation email
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Confirmation page

Frequently asked questions about the double-opt-in method
1. How do I explain the additional steps to new subscribers when they sign up for
the newsletter?
l

l

Information. After new subscribers enter their information, clearly inform them that an
additional step is required to activate the newsletter subscription ("We have added your
email address to our list. To activate ... "). Explain why this step is necessary. For example,
"to prevent other people from subscribing using your email address" or "to validate your
email address".
Link. Instruct recipients to activate their subscription after entering their information. If
possible, provide a link to their mailbox for activating the subscription. You can use the
domain parts of the email address to determine which email provider the recipient is using
and to create a link to the specific service. Example: If the new subscriber has an
xxxx@example.com address, then you can display a "Go to my email inbox" link that takes
them to the login page at www.example.com.
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l

When to send the confirmation email. You should send the confirmation email as soon
as possible after the sign up, so it can be activated quickly. The recipient may otherwise
forget the reason for the confirmation email or lose interest in the newsletter.

2. What should I be aware of when setting up the activation email?
l

l

l

l

Subject. Ensure that your activation email has a meaningful subject line that directly
prompts the user to take action. For example, "Please confirm your email address".
Sender.The sender name is often the first thing that a person sees and should be recognizable. You should use a consistent sender name for emails, including the activation
email. Give your potential subscriber an option to reply to the activation email (avoid using
a noreply@...email address).
Presentation. The activation email should avoid using large blocks of text and complicated layouts. Your recipient needs to click the confirmation link. Help them by providing concise and accurate instructions along with a clearly visible confirmation link.
Spam suspicion. Inform new subscribers that emails from new and previously unknown
senders may land in their spam/junk mail or unknown mail folders. If the recipient cannot
find the confirmation email, they should check these folders.

3. What problems can arise when using the confirmation link in an activation email?
l

l

Short length. Make sure that the confirmation link is not too long. Otherwise, there is a
danger that it may get broken across two lines and no longer work. In case this happens,
you should offer a solution to your subscribers, for example, "If the link does not work, copy
both lines into the address bar of your browser." You should further ensure that the confirmation link stands out from the other text in the message, even if the email preview area
is small.
Correct link. A further potential source of problems is a confirmation link that does not
work. This can happen if the link contains a special character, which causes Outlook or
Thunderbird to incorrectly highlight it and thus send the user to a blank page. Another frequent link problem is forgetting to use the HTML anchor tag properly. Check that the confirmation link is correct.

4. How can I avoid any possible problems with the sign up process?
l

Address book entry. Tell new subscribers to add your email sender address to their personal address book or list of secure senders. You can say something like "To ensure that
you receive our newsletter...". This will ideally be supplemented with a link to instructions

© Optimizely 2022

Recipients | 775

l

l

for common email programs and webmail providers to help with this step. You can also
provide a vCard that can be used with some email programs to add your contact data to
the address book with a single mouse click.
Help / contact options. Give the user options for providing feedback or contacting you
(email address, chat, free phone number, "not working" button) in case of problems with
registration or confirmation. This can also be an important feedback channel for identifying problems or areas for improvement in the process. A more elegant solution is to
provide contact information for a personal adviser or customer support representative , if
this would be appropriate or possible.
Resending. Provide the recipient the option of having the activation email resent in the
event that it has not arrived within the first few minutes or the recipient is unable to find it.
Tip: With the help of a special function you can automatically send
the last newsletter sent to newly subscribed recipients as soon as
they have gone through the opt-in process. For more information,
see Scheduled jobs.

Best practices for permission-based email marketing
This document examines the double opt-in process, which lets you get consent from your
recipients and provides documentation to prove that consent was given. Optimizely
provides the best practices for putting together an opt-in mailing.

What is an initial opt-in?
With the initial opt-in, you can use a standardized procedure to obtain the permission of
your recipients and verify the provided email addresses.
The address data that you provided is imported into Optimizely Campaign within the framework of the initial opt-in. An automatic system email is sent to these addresses. The recipients of this email can click the provided link to confirm their agreement to receive your
newsletter. Each subscriber who gives permission in this way is added to the recipient list
in Optimizely Campaign. Your recipient list will only include subscribers who have explicitly
requested the newsletter.
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As the sender of the newsletter, you profit from an initial opt-in because you are in possession of your recipients' consent to receive marketing communications in case of complaint.

Best practices for putting together the opt-in mailing
When composing a professional opt-in mailing, take note of the following:

Inbox
Every mailing has certain content elements that your recipients will notice at first glance
in their inbox. You should draft your opt-in mailings in a way that your recipients know
what they are dealing with:
l
l

Clear sender identification (email address and sender name)
Clear, free of advertisements and enticingly formulated subject line
o
o

l

Example: Renew your newsletter subscription now.
Example: Please confirm your subscription to the new [Company] newsletter now.

Pre-header with additional subject line and link to online version

Contents
The content elements of your opt-in mailing should entice the recipients to click. They
must be absolutely free of advertising:
l
l
l
l

l
l

l
l

The confirmation link must be clearly recognizable even when images are deactivated
Branding: logo placement at most (ideally without linking)
Clear formulation of the mailing objective but without the character of an advertisement
Best practice: It should be understandable from the text that the recipient is being asked
to reconfirm the subscription to the newsletter
Stress the option to unsubscribe at any time in every mailing
3-4 confirmation links should be placed (visible and clearly identifiable), for example within
the text of the message and as a button
No advertising content
No links to social media channels
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l
l

l
l

No unnecessary links but rather a clear focus on the confirmation link
Clear and enticing formulation of the confirmation link: "Yes, I want to continue to receive
the newsletter."
Explanation of what happens if the confirmation link is not clicked
Reference to the source of the original subscription

Footer
Provide information about the company and data protection:
l
l
l
l

Full legal imprint
Reference to data protection
Link to the data protection provisions found on your homepage
Mention the addressee's email address in the footer

Creating subscription and unsubscribe forms
This topic describes how to create forms for users subscribing to and unsubscribing from
newsletters. On request, Optimizely creates customized subscription and unsubscribe
forms for you. To do so, contact customer support.

Required data
To subscribe to a newsletter, you typically need at least a user's email address. Generally,
you want to additional information from a user, to address recipients personally. When
requesting information, distinguish between required and optional fields.
To comply with legal provisions, you must also specifically identify any personal information that is required to make use of a service (only applies to email addresses), and any
personal information collected with or without the user's knowledge. With respect to your
subscription form, this means:
l
l

The only required field is the recipient's email address.
Other fields are optional (because they are not absolutely necessary to receive a newsletter). The personal information collected in them is provided voluntarily. These may
include a user's interests, age and place of residence (or zip code). The user can select
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l

from a list of interests by clicking check boxes. Age and zip code can be selected from a
list. This information does not require the recipient's declaration of consent. If you want to
make these required fields, include a reference to the rules on data privacy protection.
Personal information collected without a recipient's knowledge that occurs through that
recipient's actions (click data), for example, by opening a newsletter, requires the recipient's consent.
Note: Each data field in a form must have a corresponding recipient list field to which the data is imported.

Creating the design and text
The design of form pages should be as simple and clear as possible. Ideally, the user
should not need to use the scroll bar to reach the bottom of a page. This means that the
fields used in a form, data protection notices, and the Send button should be arranged so
that they display in the most commonly used screen and font sizes without needing to
scroll.
If the form is to be integrated into your web page, for example, your shop site, specify your
frame size (width in pixels). In this case, make sure that your website's HTML code supports
scroll bars; otherwise, the form may not display correctly.

Using an HTML template
A good idea is to send Optimizely the pages as HTML templates. You need a separate template for each page (for example, subscribe page, unsubscribe page).
If you use this option, texts (except error messages) must be included in the template in
their final form. In addition, specify the error messages to be displayed if a field is not completed or filled out incorrectly.
If you want to provide the template as a graphic, send the text in a separate text file.

Displaying error messages
Indicate which error messages should appear and where they should be displayed. For
example:
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Error

Error message

Where to be displayed

No email address
entered

Please enter an email address.

Next to email input
field

Consent not provided

You must confirm that you want to receive this
newsletter.

Next to check box

Required field not completed

Please complete all required fields.

Next to the applicable field

Note: Error messages should appear as text directly above, alongside, or below the applicable field in a form. Alternately, they may
appear at the top of a page, with a reference to the applicable field.
It is best if error messages are placed as close as possible to the referenced field, so their meaning is clear. Highlight the relevant field in
color. Specify the font size, color and other style elements (background color, frames and so on) to be used in error messages, or
provide Optimizely with a graphic template.

Specifying confirmation texts
Specify text to display on the confirmation page (after registration is completed). Specify a
sample layout (see above).

Setting up a confirmation email
If subscriptions use a confirmed or double opt-in process, you need to send a confirmation
email to the recipients. Optimizely can set up this email in your Optimizely Campaign client
so that it is sent automatically when a subscription is submitted. You can manage the content of this email through Optimizely's systems and change the texts at any time.
To set up a confirmation email, specify the following information:
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l
l
l
l

Type of email (text, HTML or multi-part)
Name and email address of sender
Subject
Personalization (for example, salutation)

Handling user-provided data
Recipient data is forwarded to a recipient list in Optimizely Campaign. Only data for which
a corresponding field exists in the recipient list can be recorded.
You should first decide if you want to use an existing recipient list in your client. Which
fields are available are determined by the fields in those recipient lists.
To create and manage recipient lists, see Recipient lists. In general, the following apply:
Form field type

Recipient list field type

Free-form text

Text

Pop-up menu

Text (with set values)

Age, zip, and so on

Numerical

Check box

Boolean (possible values are true and false)

Option

Text, numerical or boolean

Sample text and forms
The following are sample texts and forms. You may use the texts either as they appear or in
modified form.

Data privacy notice on use of personal information provided voluntarily
Your personal information will only be stored if you provide it to us voluntarily, for example,
when registering, completing a survey or as part of a contract. By providing this
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information to us, you are indicating your consent to the storage, use and processing of
this information. We will not disclose your information to third parties without your consent. You may withdraw your consent to the storage and disclosure of your personal information at any time.

Data privacy notice on the use of data collected without the user's knowledge and stored in aggregate form
To personalize our newsletters and better address your specific interests, we analyze and
store your clicks on links in our newsletters. We guarantee that the analysis and use of this
information is carried out only in aggregate form and that under no circumstances will this
information be transferred to third parties. By subscribing, you are indicating your consent
to the collection of this information. You can cancel your subscription at any time. Your
data will be deleted in its entirety upon cancellation.

Data privacy notice on the undisclosed collection of personal information
To personalize our newsletters and better address your specific interests, we analyze and
store your clicks on links in our newsletters. We guarantee that the analysis and use of this
information is carried out only in aggregate form and that under no circumstances will this
information be transferred to third parties. By subscribing, you are indicating your consent
to the collection of this information. You can cancel your subscription at any time. Your
data will be deleted in its entirety upon cancellation.

Error messages
l
l
l
l

Please enter an email address.
Please enter a correct email address.
Please complete all required fields.
Please indicate that you accept the data privacy provisions and the terms of participation.

Confirmation page
l

Simple "Thank you" page: Thank you for your subscription to our newsletter, which will
be sent to example@example.com.
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l

l

l

"Thank you" page (confirmed opt-In): We are delighted to periodically provide you with
information about what's new at www.example.com. You will receive an email shortly confirming your subscription. You may of course cancel the newsletter at any time. You will
find an unsubscribe link at the bottom of each newsletter.
"Thank you" page (double opt-In): We are delighted to periodically provide you with
information about what's new at www.example.com. You will receive an email shortly asking you to confirm your subscription. To confirm your subscription, please click the activation link contained in this email. You may of course cancel the newsletter at any time. You
will find an unsubscribe link at the bottom of each newsletter.
Unsubscribe page: You have been unsubscribed from our newsletter.

Unsubscribers
This topic describes how Optimizely Campaign processes mailing unsubscriptions, and
how to manage unsubscribers and insert an unsubscribe link into a mailing.

Consequences of a mailing unsubscription
If a recipient unsubscribes from your newsletter by clicking the unsubscribe link or using
the unsubscribe form, Optimizely Campaign writes the recipient in a system-internal unsubscribe list.
The recipient's data record is not deleted from your recipient list. The recipient ID, which
Optimizely Campaign uses to identify the recipient, is duplicated and copied to the system-internal unsubscribe list.
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Tip: By default, the system-internal unsubscribe list is linked to all
recipient lists of a client. The unsubscribe list is not inherited by
other clients in your user account.
If you want to link the system-internal unsubscribe list to only one recipient list in your client, contact customer support to change the configuration.

How it works
For each sending, Optimizely Campaign compares your recipient list with the systeminternal unsubscribe list, then excludes recipients on the unsubscribe list. Optimizely Campaign takes this approach so you can continue to analyze periods when the unsubscriber
was active. To remove unsubscribers from your recipient list, manually delete them from
your recipient list using the Cleanup feature.
If subscribing to the newsletter again, the recipient is deleted from the system-internal
unsubscribe list after confirming the double opt-in. The recipient begins to receive mailings again.
Tip: Unsubscribes or new subscriptions are also possible via, REST
API, SOAP API and HTTP API.
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Querying a system-internal unsubscribe list
In the Optimizely Campaign user interface, you cannot see the system-internal unsubscribe list. But you can use the REST API to retrieve information about all unsubscribes. If
you are using the SOAP API, use the contains and containsAll methods to query whether
one or more recipients are on an unsubscribe list.
You can also export unsubscribers as CSV files. See Exporting recipients.

Deleting unsubscribers from a recipient list
Use Cleanup to delete unsubscribers from a recipient list.

Inserting an unsubscribe link into a mailing
If you use the Optimizely Campaign's unsubscribe logic, Optimizely sets up a field function
to insert the unsubscribe link into your mailing. You can integrate the unsubscribe link in
your mailing in two ways:
l

l

Display the unsubscribe link URL: For example: To unsubscribe from the newsletter, click
here: example.com/unsubscribe/123456abcdefg.
Link the unsubscribe link to a word or phrase, such as To unsubscribe from the newsletter,
click here.

Displaying the URL of the unsubscribe link
1. Open the editor window of the mailing and click the name of the paragraph that will
contain the unsubscribe link (such as text/image paragraph or footer paragraph).
2. In the editor text field, insert the note for unsubscribing the mailing, such as To unsubscribe from the newsletter, click here:.
3. To insert the URL of the unsubscribe link directly, click where you want to insert the
URL and click Insert field function .
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4. From the list, select the field function for the unsubscribe link and click OK.
5. Click Apply. In the left preview area, the field function is displayed in curly brackets:
{Unsubscribe Link}. When the mailing is sent. Optimizely Campaign resolves the field
function and inserts the URL of the unsubscribe link into the mailing individually for
each recipient.

Linking the unsubscribe link to a word or phrase
1. In the mailing's editor window, click the name of the paragraph that will contain the
unsubscribe link (for example text/image paragraph or footer paragraph).
2. In the editor on the right side, insert the note for unsubscribing the mailing, such as To
unsubscribe from the newsletter, click here.
3. Highlight the word or phrase to be linked to the unsubscribe link, such as here.
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4. Click Link

.

5. Enter the URL field {Unsubscribe Link} in curly brackets. In the Protocol drop-down
list , the type changes automatically to <other>.

6. Click OK.
7. Click Apply.
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Changing the confirmation page URL
Note: For this feature you need administrator rights in Optimizely
Campaign.
To change the URL of the confirmation page the unsubscribe link points to, do the following:
1. Open the Optimizely Campaign menu and select Administration > Unsubscribe Link.
2. In the input field, make your changes to the URL of the confirmation page.
Note: The URL must begin with the http:// or https:// protocol.
Make sure that the confirmation page is accessible at any time.

Tip: If you do not have your own confirmation page, you can use
the following default page: https://www.srv2.de/unsubscribe_
en.html.
3. Click Save.

FAQs
l

Can I add a recipient to the unsubscribe list or remove a recipient from the unsubscribe list using Optimizely Campaign?
No. The unsubscribe process can only be carried out by the recipient himself. To cancel unsubscription, the recipient has to subscribe to the newsletter again (depending
on the configuration with opt-in).

l

Can I unregister a recipient by deleting the recipient from the recipient list?
If deleted from a recipient list, the recipient receives no more mailings via this list. If
existing on more than one list, the recipient continues to receive mailings via other
recipient lists from which he or she has not been removed.
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Warning: This procedure is not recommended, as the deletion is
not recorded and the recipient can be accidentally added to a
recipient list again, for example when importing recipients. The
legal consequence can be a warning if the recipient receives mailings despite unsubscribing.
l

I maintain my recipient list by myself and import it to Optimizely Campaign before
each sending. What do I have to consider?
Make sure that you import only active recipients into the recipient list. Import unsubscribers into the unsubscribe list so that the cross check can take place before dispatch.
You can import unsubscribe lists or multiple lists via specially set up jobs/services.
These scheduled jobs cannot be accessed via the Optimizely Campaign user interface.
The corresponding lists are transferred to the Optimizely Campaign server via SFTP
and automatically imported into the client:
o

o

Import unsubscribe list. Import your local unsubscribe list into the unsubscribe list of
your Optimizely Campaign client.
Import recipients including unsubscribers. Import a single recipient list that contains active recipients from different lists and unsubscribers. Enter the status of the
recipient or the list into which you want to import in a separate column of the recipient
list. In this way, you always have consistent lists.

For more information, see Scheduled jobs.
l

What are list unsubscribe headers?
By using list unsubscribe headers in a newsletter, recipients can unsubscribe from a
mailing via the user interface of their email program (such as Gmail or Outlook). Searching for the unsubscribe link in a mailing is not necessary this way.

Recipient history
Note: To enable this feature, contact customer support.
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Use the recipient history to view the message history (Mailings Classic and Smart Campaigns), the Marketing Automation history and the campaign analysis (Smart Campaigns),
view the opening and click behavior of your recipients and the third-party ID. This lets you
see which email, which SMS, which push message you have sent and to whom it was sent.
In the Right to be forgotten tab you can also irrevocably delete recipient data.
For example, if a recipient contacts you to say that a newsletter was not received, you can
investigate the reason why. In the recipient history, enter the recipient’s data to see an
overview of their communications. Using this information, you can check to see whether
the recipient has perhaps inadvertently unsubscribed. You might see that the newsletter is
sent and you should ask the recipient to check in their spam folder for the newsletter. You
can even check to see if the recipient is currently in a Wait node and will receive the
expected newsletter later on in the day.
You also can see how each recipient reacted to your communication with them: which messages they opened, and which links they clicked.
Note: Recipient history is not available for print messages.
To open the recipient history, open the Optimizely Campaign menu and select Recipients
> Recipient History.

Showing message history
1. In the Search Recipient Based On drop-down list, select the type of information to
use to find the message history for the recipient. You can use the recipient ID, email
address, mobile phone number, fax number or a push token.

2. In the Search Value field, enter the recipient ID, email address, mobile phone number
or push token to search for.
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3. You can limit the time period for which the message history is displayed by entering
start and end dates under Define Reporting Period (Optional). If you do not enter a
start and end date, the entire message history for the recipient is shown.

4. By default, recipient lists within the entered data sets for your client is searched. If you
want to limit the search to specific recipient lists, use the Search In drop-down list and
select the check box next to each recipient list you want to search.

5. When you have completed the fields, click Start Search.
Tip: The search may take several minutes depending on the number of recipient lists being searched. The message "Loading,
please wait..." is displayed at the bottom right in the status bar to
indicate that a search is being executed.
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When the search has completed, the message history for the recipient is shown. The
list starts with the most recent message.

The message history provides the following information:
l
l
l
l
l
l
l
l
l
l
l

recipient ID
recipient lists in which the recipient can be found
mailing IDs of messages sent to this recipient
marketing channels of the messages sent (email, SMS, Mobile Push)
start times of the messages
mailing types (regular, special, temporary (test messages) or campaign)
mailing name
subject
send date
number of openings
number of clicks in the messages
Note: To display the number of openings and clicks, the users
of your client must have permission to view action data. If
your users need this permission, contact an administrator or
customer support.

send status
6. To view the content of a message, click Show Mailing. Depending on the media type
selected, you can select a display option from the drop-down list to the left of the button. For example, if the media type is Email, you can choose to display the message as
either HTML or plain text.
l
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Note: The current message content is displayed. Older versions
cannot be reconstructed. Therefore, the displayed message may
differ from the message that a recipient previously received if the
message is subsequently modified.

Showing consent history
A consent is an email of the mailing type Confirmation email in which a recipient provides
consent by clicking a confirmation link. The consent has a version and time stamp, so you
can see when it was registered.
To access archived consent information:
1. Identify recipients for whom you want to view confirmation emails. For example, use
the Email address criterion to search for a recipient.
2. Under Message History, search for a message of the mailing type Confirmation
email.
3. Click Show Sent Mail. The consent email appears.
4. Use the HTML and Text tabs to see the selected email in its HTML and text version as
it was sent at the time stated. Click Header to get detailed information about the
header data of the email. The tab Opt-in Details provides information about when the
opt-in request was sent and when it was confirmed.
5. Optionally download the consent email.

Showing opening and click behavior
The recipient history can show you the messages that the recipient opened and the links
that the recipient clicked in the message.
Note: To display the number of openings and clicks, the users of your
client must have permission to view action data. If your users need
this permission, contact an administrator or customer support.
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To display the opening and click behavior of recipients for individual messages, perform
the following steps:
1. In the Message History tab, select the message for which you want to see the opening and click behavior.
Tip: The number of opens and clicks is shown in the message history list in the Opens and Clicks columns.
If opening and click data is available for the selected message, then Show Opens and
Clicks is enabled.
2. Click Show Opens and Clicks. A new list expands showing the action data type (open
or click), the time, the mailing name, the mailing ID, which links were clicked, and the
media type., then you can choose to display the message as HTML or plain text.
3. To see the message associated with the opening and click behavior, click Show Mailing. Depending on the media type selected, you can select a display option from the
drop-down list to the left of the button. For example, if the media type is Email, then
you can choose to display the message as HTML or plain text.

Showing campaign analysis
If a message in message history is part of a campaign or Smart Campaign, you can display
the associated campaign analysis.
1. In the Message History tab, click the message for which you want to view the campaign analysis.
2. Click Show Campaign Analysis. A new window opens with the campaign analysis. See
also Analysis.

Showing Marketing Automation history
1. Next to the Message History tab, click the Marketing Automation History tab. The
Marketing Automation history is displayed in a list that shows the recipient ID, campaign ID, start date, campaign name, recipient status, and a preview of the history.
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2. To get an ordered overview of the recipient's entire history, select the corresponding
Marketing Automation campaign from the list by clicking the entry. The action list for
the Marketing Automation campaign opens, showing recipient actions within the Marketing Automation campaign and the associated date.
Display

Event

Example

Started in "..."
node #...

The recipient has started in the specified
node. The corresponding node ID is shown
after the # symbol.

Started in "New
recipient" node
#123456789

Started in campaign "..." (#...)

The recipient is delegated within a campaign
to another campaign. The corresponding campaign ID is shown after the # symbol.

Started in campaign
"More offers for you"
(#123456789)

Forwarded to
"..." node #...

The recipient is forwarded to the specified
node. The corresponding node ID is shown
after the # symbol.

Forwarded to "Wait"
node #123456789

Wait until...

The recipient is waiting or has waited in a Wait

Wait until 2016-09-
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Display

Event
node until the specified time.

Example
01 11:15:31

The message is sent to the recipient. The message media type (Email, SMS or Mobile Push),
the name of the message and the message ID
(after the #) is shown.
... message "..."
(#...) sent to
recipient

To view the message content, select the corresponding entry and click Show mailing.
Depending on the media type selected, you
can select a display option from the dropdown list to the left of the button.

Email message "Welcome" (#123456789)
send to recipient

For example, if the media type is Email, you
can display the message as HTML or plain text.

Message ... sent
to recipient
(details no
longer available)

completed in
node #...

Not completed
in node #...;
Error: "..."

The message is sent to the recipient. The sending time is displayed. Further details cannot
be displayed, as these are no longer available.
This message usually relates to test messages
that were sent and whose content is not permanently stored by Optimizely Campaign.
The recipient passed through the campaign
and is completed. The corresponding node ID
is shown after the # symbol.
The recipient did not pass through the campaign. The corresponding node ID is shown
after the # symbol. The error is displayed as a
numerical code:
-1

Default error (a possible reason could be a
mailing dispatch error)

1 The recipient is on the blocklist.
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Message 2016-0901 11:15:31 sent to
recipient (details no
longer available)

completed in node
#123456789

Not completed in
node #123456789;
Error: "1"
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Display

Event

Example

2 The recipient is on an unsubscribe list.
3

The recipient has exceeded the bounce
limit.

4 The recipient was not found.
5 The recipient is already existing.
6 Invalid mailing status

The recipient is edited in Marketing Automation in the Change recipient node. The corresponding change is shown.

Recipient edited:
The value of the
"Customer status"
field changed to
"Premium customer"

Recipient not
modified Recipient is not
in the recipient
list "..." (#...)
defined in the
"Change recipient" node

The recipient has not been edited in the
Change recipient node because the recipient
is not in the specified recipient list. The recipient list ID is shown after the # symbol.

Recipient not modified - Recipient is
not in the recipient
list "Existing customers"
(#123456789)
defined in the
"Change recipient"
node

Copied to recipient list "..."
(#...)

The recipient has already been copied to the
specified recipient list. The recipient list ID is
shown after the # symbol.

Copied to recipient
list "Premium customers"
(#123456789)

The recipient is not copied to the recipient list
because they are already in the specified
recipient list. The recipient list ID is shown
after the # symbol.

Recipient not
copied – the recipient is already contained in recipient
list "Existing customers"
(#123456789)

Recipient
edited: ...

Recipient not
copied – the
recipient is
already contained in recipient list "..."
(#...)
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Display

Event

Example

Recipient not
copied – the
copy option
was not selected

The recipient is started in a parallel Marketing
Automation campaign via the Start in node.
The additional option First copy to is not
selected.

Recipient not
copied – the copy
option was not
selected

Updated in
recipient list
"..." (#...)

The recipient is copied to a recipient list that
has an existing entry for that recipient. The
recipient dataset is updated in the target
recipient list. The ID of the target recipient list
is shown after the #.

Updated in recipient list "Existing
customers"
(#123456789)

Updated in
recipient list
"..." (#...( and
deleted in "..."
(#...)

The recipient is copied to a recipient list that
has an existing entry for that recipient. The
recipient dataset is updated in the target
recipient list. The recipient dataset is deleted
from the source recipient list. The names and
ID (after the #) for the corresponding recipient
lists are shown.

Updated in recipient list "Active customers"
(#123456789) and
deleted in "Inactive
customers"
(#1122334455)

Matched target
group "..." (#...)

The recipient is assigned to a target group.
The ID of the target group is shown after the
#.

Matched target
group "Women"
(#123456789)

Code

Description

-1

DEFAULT_ERROR_CODE. Default error code.

1

BLACKLISTED_ERROR_CODE. Blocked recipient.

2

UNSUBSCRIBED_ERROR_CODE. Unsubscribed recipient.

3

OUTBOUNCED_ERROR_CODE. Outbounced recipient (exceeded the bounce
limit).
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Code

Description

4

RECIPIENT_NOT_FOUND_ERROR_CODE. Recipient could not be found.

5

RECIPIENT_ALREADY_EXISTING_ERROR_CODE. Already existing recipient.

6

INVALID_MAILING_STATUS_ERROR_CODE. Invalid mailing.

Showing the third-party ID
In the Third-Party ID tab, you can find the pseudonymized ID of the selected recipient.
To view the third-party ID, click Third-Party ID next to Marketing Automation History.

The Third-Party ID tab provides the following information:
l
l
l

Recipient ID. ID of the recipient selected in Search Recipient Based On.
Email Address. Email address of the recipient.
Third-Party ID. Pseudonymized ID of the recipient.
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Right to be forgotten
According to Article 17 of the General Data Protection Regulation (GDPR), the right to be
forgotten, every person has the right to have personal data deleted.
In the Right to Be Forgotten tab, you can irrevocably delete all recipient data except
blocklist entries. To delete blocklist entries, see blocklist overview. You can also delete
blocklist entries via REST API.
Note: The users of your client need the permission to wipe the recipient history. To grant this permission, contact an administrator or customer support.
To delete recipient data, do the following:
1. In the Search Recipient Based On drop-down list, select Recipient ID.
2. In the Search Value field, enter the recipient ID or part of the ID of the recipient whose
data you want to delete.
3. Click Start Search.
4. Click the Right to Be Forgotten tab.

5. Under Reason, optionally enter a reason for the deletion.
6. Under Clients, select the clients in which you want to delete the recipient data.
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7. Click Delete.
Warning: You cannot restore deleted data.
8. Confirm by clicking OK.
Tip: Depending on how many clients you have selected and how
much recipient data is deleted, the process can take several minutes.

Exporting mailing and performance data
Note: To enable this feature, contact customer support.
This feature lets you export mailing and performance data to further process it in an
external system. The data is exported to a CSV or XML file.
The export runs at a defined interval, such as daily at midnight or once a week. You can
download exported data via SFTP from a secure server.

Click profiles
Using click profiles, you can create target groups. The clicks users make are the basis of
click profiling. For example, email recipients who frequently click Blu-ray offers can be segmented via a click profile then supplied with targeted and highly relevant information.
Click profiling lets you create profiles – manually or automatically and independent of individual mailings or links – that are associated with the tracked links in your mailings. When
created, tracking links are tagged.
Tip: Click profiling complements tracking link management – and its
functions remain preserved. You can still edit links in a mailing individually via the Tracking tab in the Edit Mailing wizard. Determine
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whether the link in the HTML and text version should be tracked and
enter a description of the link.
To manage click profiles, open the Optimizely Campaign menu and select Recipients
> Click Profiles.

Creating and editing click profiles
To create a click profile, do the following:

© Optimizely 2022

802 | Optimizely Campaign User Guide 2022-03-14

1. In the Click Profiles window, click Create….
2. Enter a name and an optional description.

3. Optional: In the Folder drop-down list, select a folder in which to save the new click
profile.
4. Click Finish.
To edit a click profile, select it from the list and click Edit….
To assign links to the newly created profile, see Assigning click profiles.
To create a rule-based profile and automatically assign links, see Assigning rule-based click
profiles automatically.

Assigning click profiles
To assign links manually to one or more click profiles, do the following:
1. In the Click Profiles window, select the desired click profiles and click Assign….
2. In the Mailings drop-down list, select one ore more mailings to display links from these
mailings in the Tracking Links list.
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3. In the Tracking links list, select one or more links that you want to assign to a profile.
The Click Profiles drop-down list below this list shows profiles. If you already selected
a profile in the overview window, it is displayed.
4. You can change, add or remove profiles.
5. To save the assigned links, click Add.

Removing assigned click profiles
Note: Automatically assigned profiles cannot be removed.
1. In the Click Profiles window, click Assign… and select one or more mailings.
2. Select a link.
3. Click Remove to unassign the profiles from that link.
Tip: If you unassign a profile, it is only removed from the link. The profile itself cannot be deleted.

Assigning click profiles when editing a mailing
1. From the list in the Tracking tab, select a link and click in the Profiles field.
2. Select one or more profiles from the selection window and click OK.
If you use a message template that is configured accordingly, you see a Click Profiles tab
in the editor window of a paragraph. To assign a profile to links of a paragraph, select the
check box next to the desired profile.
Tip: Manually assign rule-based profiles
You also can assign rule-based profiles manually to a link that does
not match the rule using the function described in the previous paragraph. These links may be considered the exceptions to the rule.
Reciprocally, rule-based profiles cannot be removed from a link that
does match the rule.
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Rule-based assignment
Rule-based click profiles automatically assign tracking links. To enable this, the link URL is
analyzed according to the character strings it contains or on the basis of regular expressions. The rules for automatic assignment are configured during the creation or editing of a
click profile. Two fields are allocated for this purpose.
l

l

Rule. Contains details of the character string the URL of a link must contain, or what rules
the construction of a URL must follow, so that a profile can be assigned. You can use wildcards (?, *) to track link URLs with specific recurring character sequences to be categorized. You can also use regular expressions.
Rule Type. The rule and rule type must match together for rule-based assignments to
function.

Test rule-based click profiles to ensure the desired result is achieved. Rule-based click profiles can be adjusted at any time, and assignments are automatically updated.
Tip: Rule-based assignments cannot be removed. If you change a
rule, assignments are updated. This means that links that are no
longer applicable will are not shown in the corresponding profile.

Wildcard example
The following link is to be analyzed with a wildcard click profile:
www.example.com/new_article/xy/ref=1234

If tracking links to the newest articles in your web shop contain .../new_article/... in
the URL, you would formulate the following wildcard rule to automatically tag the link:
*/new_article/*

Regular expression example
Regular expressions let you formulate sets and subsets of character strings with the help
of syntactic rules. For example, you can define that a URL contains or does not contain
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specific characters. Regular expressions also allow the filtering of number ranges. They
treat URLs as a character sequence (string) and analyze them according to the formal criteria of the regular expression.
The following link is to be analyzed with a regular expression. In contrast to the URL in the
previous example, this link does not contain a section that can be analyzed using a rule.
But you can solve the problem using a number range filter:
www.example.com/xy/ref=1234

In this case, the regular expression examines letter code and the article reference:
.*[x-z][x-z]/ref=12[0-9][0-9]
l
l

A dot and an asterisk (.*) stand for any characters.
Square brackets ([]) denote a range. In this case, the letters x, y, or z can be in the first or
second position.
o
o

The expression filters xx, xy, xz, yx, yy, yz, zx, zy and zz.
This expression filters numbers from 1200 to 1299. The first two numerals must be 1 or
2. The numerals in third or fourth place can range from 0-9. Four numerals must exist.

Responses
Responses are messages sent back to the sending server (in this case, the Optimizely Campaign server) for various reasons.
Responses are classified by filters (autoresponders, hard bounces, soft bounces, replies,
keyword SMS). Optimizely Campaign automatically manages bounces and adds recipients
that have generated a defined number of bounces to a corresponding list.
Tip: You can also export hard and soft bounces automatically on a
regular basis, for example to synchronize them with an external distribution list. For more information, see Scheduled jobs.
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Displaying responses
To display responses, do the following:
1. Open the Optimizely Campaign menu and select Responses.
2. Select one of the following response types from the Response Type drop-down list:
l
l

l

l
l

l

All. Responses from all categories.
Hard bounce. Unreachable email addresses. This occur if recipients change providers/web mailers. You should not manually erase these recipients because Optimizely Campaign stops sending them emails after the third hard bounce. This
threshold can be altered for your account/client.
Soft bounce. Temporarily unavailable email accounts. This can occur if a recipient
mailbox reaches its capacity, and can only accept new email after some is deleted.
You should not manually edit soft bounces because the addresses may be reachable again.
Autoresponder. Automatic reply email, such as On holiday until May 26.
Keyword SMS. Incoming SMS that can be assigned to a running SMS process. See
SMS processes.
Reply. Replies from mailing recipients. The standard Optimizely Campaign setting
is that such replies are not sent to you but to the system. If you want to receive
these replies in your email account, contact customer support.
Tip: Filters for the response type
Optimizely Campaign filters are set to specify a response with
maximum likelihood as a hard bounce, soft bounce,
autoresponder, or keyword SMS. If an email cannot be
assigned to one of these categories, it is moved to the Reply
category so that no real reply is lost. You may also find
autoresponders and undelivered email in this category.

l

Spam. Spammers do not send from their own mail servers but from computers of
unsuspecting users. Worms or Trojans (malware) infiltrate user's computers, where
they can be misused to send spam. If your mailing is sent to a recipient whose computer is infiltrated, it automatically sends spam to the mailing return address. The
Optimizely Campaign server's spam filter places the spam in the spam category.
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3. Select one or more mailings from the Mailings drop-down list.
4. Click Show. The Overview area displays all matching responses.

Overview
The list in the Overview area displays all responses that match your search profile. You
can find the following information:
l

l

l
l

Subject. Subject line of the returned message with information about the reason for
return.
Received. The sending date of the email. Bounces and autoresponders are usually sent
the same day the mailing is sent. Responses can be sent several days afterwards.
Type. The response type.
Recipient. The sender of the email.

Recipient details
The Recipient Details tab displays response details including email address, recipient
registration date, and other data. You can also blocklist or delete recipients.
l

Block Recipient. See Blocklist overview.
1. Select a recipient from the list and click Block Recipient. The Block Recipient dialog box appears.
2. Optionally, enter a blocklisting reason, such as, complaint by telephone.

l

3. Click Apply. The recipient is added to the blocklist.
Delete Recipient.
Note: Only use Delete Recipient to remove a recipient whose
email address does not exist. Recipients who should not receive
email from you because of a complaint should be added to the
blocklist.
1. From the list, select a recipient and click Delete Recipient.
2. Confirm.
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Reply
The Reply tab displays the text of the recipient's reply email.

Blocklists
When a recipient is placed on a blocklist, the recipient will receive no more email from you
via Optimizely Campaign, even if the recipient registers to receive mailings again. This
ensures that your recipient lists have no dissatisfied recipients. And, a clean recipient list
with just a few complaints has a positive impact on the deliverability of your mailings.
To display the blocklist, open the Optimizely Campaign menu and select Blocklist > Overview. You can perform the following actions for the blocklist.

Adding recipients to a blocklist
1. Click Add…. A blank line is added to the list.
2. In the Pattern field, for example, enter the email address or phone number of the recipient you want to block.
3. In the Reason field, optionally enter a reason for blocklisting (for example, complaint).
4. Click Submit.

Adding recipients to a blocklist automatically
If a recipient marks an unwanted email as spam, Optimizely Campaign is notified by the
email service provider, and the recipient is added to the blocklist.
Typical reason of a automatic blocklist entry:
type=automatic;rule=FBL: AOL;mailing=12345678;m2u=987654321

Tip: The m2u parameter refers to the mailing-to-user ID, also known
as mail ID. The mail ID associates a recipient with a mailing.
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Editing a blocklist entries
Note: You cannot edit automatic blocklist entries.
1.
2.
3.
4.

To change the reason for blocking, click the entry you want to edit.
Click Edit….
Edit the content of the Reason box.
Click Submit.

Deleting blocklist entries
Note: You cannot delete automatic blocklist entries.
1. Click the entry you want to remove from the blocklist.
2. Click Delete.
3. Confirm the deletion. The recipient is deleted from the blocklist and can receive your
mailings again.

Using wildcards
Instead of entering a complete email address, you can use wildcards in the blocklist
entries.
l

Use the asterisk (*) as placeholder for one or more characters. For example, to block email
addresses from a specific domain such as example.com, specify *@example.com.
Note: Searching the blocklist may result in multiple entries. For
example, axel@example.com and *@example.com may both be on
the blocklist. If axel@example.com is removed from the blocklist,
Axel would still not receive mails because the example.com
domain is blocked.

l

Use the question mark (?) as placeholder for a single character. For example, you are not
sure about how a name is spelled correctly, such as Mar? for Mark, Marc, or Mary.
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l

You can use placeholders in the domain part of an email address. For example, abuse@*
blocks email addresses starting with abuse. This account name is usually configured by
companies and providers as a default email account for customer complaints. If somebody
registers for your newsletter with such an email address, it can be both annoying and
cause serial problems and damage your internet reputation.

Blocklist import
When you initially import recipients into Optimizely Campaign, or if you frequently import
recipients from a local list, you should also import a blocklist. This function lets you import
a CSV file with blocked recipients or wildcard blocklist entries into your client. A blocklist
entry can be a complete email address or contain placeholders. See also: Wildcards.
To import a blocklist, perform the following steps:
Prerequisite: A CSV file that contains blocklist entries.
1. Open the Optimizely Campaign menu and select Blocklist > Import.
2. Click Browse... and select a CSV file from your computer that contains the blocklist
entries.
3. Click Import Options. The Preview area shows entries encountered in the CSV file.
The Rule column must contain the respective email addresses or wildcards to be
bocked. Only this first column is imported.
4. If the columns are not displayed correctly, select an encoding type from the File Charset list by changing the separator and escape characters.
5. If the first line of the CSV file contains a table head with column designations, select
Yes in the Skip First Row drop-down list.
6. Click Refresh Preview to check your settings.
7. Click Reason. Optionally, you can enter a reason for blocklisting the imported entries.
The reason you enter here applies to all imported entries.
8. Click Finished.
Tip: You can also import and export blocklist entries automatically on
a regular basis, for example to synchronize them with an external distribution list. For more information, see Scheduled jobs.

© Optimizely 2022

Recipients | 811

Blocklist cleanup
Note: This feature deletes blocklist entries by reason. If you want to
delete a single email address or a blocklist rule (wildcard), use the
delete entry function.
To clean up the blocklist, do the following:
1. Open the Optimizely Campaign menu and select Blocklist > Cleanup.
2. In the Reason field, enter the reason why you want to delete entries, such as complaint. Use the asterisk * placeholder for multiple characters, and a question mark ? for
a single character.
3. Click Count to see how many entries with this reason exist.
4. Click Confirm Deletion.
5. Click Delete Blocklist Entries.

Custom blocklists
Note: To enable this feature, contact customer support.
This optional feature lets you exclude mailing recipients who are not part of the global
blocklist.
You can create multiple custom blocklists and fill them manually or via CSV data import.
Then, use a Block node to add custom blocklists to a campaign in Smart Campaigns or to a
transactional mail. As a result, you specify which recipients besides the global blocklist
should not receive a mailing.

Creating custom blocklists
1. Open the Optimizely Campaign menu and select Blocklist > Custom Blocklists.
2. Click Create….
3. Enter a name for the custom blocklist.
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4. Select one of the hash algorithms supported by Optimizely Campaign. If the entries in
your blocklist do not use hash algorithms, select None.
Tip: As long as your custom blocklist is empty, you may change
the hash algorithm anytime.

5. Click Submit.
Tip: You can delete all entries in a custom blocklist by clicking
Clear.

Adding and editing recipients manually
1. Open the Optimizely Campaign menu and select Blocklist > Overview.
2. Under Blocklist Selection, click Custom Blocklist and select the blocklist you want
to edit.
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3. Edit the custom blocklist by clicking the Add…, Edit… and Delete button. For more
information, see Blocklist overview.

Importing blocklists
To import entries from a CSV file into a custom blocklist, perform the following steps.
1. Open the Optimizely Campaign menu and select Blocklist > Import.
2. Under Upload, click the Browse… button and select a CSV file on your local hard disk.
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3. Click Import Options to upload the file.
4. Under Blocklist Selection, click Custom Blocklist.
5. Select the custom blocklist to which you want to import the CSV file.

6. Under Specify the Hash Algorithm Used in the Import File, select your CSV file's
hash algorithm. Select None if your CSV file entries use no hash algorithm.
Note: The CSV file's hash algorithm must match the hash
algorithm of the selected blocklist. If not, an error appears. Correct
your selection under Specify the Hash Algorithm Used in the
Import File. Or, under Custom Blocklists, change the hash
algorithm of the custom blocklist. You may also create a new custom blocklist with the correct hash algorithm.
7. Under Character Encoding and CSV Options, you can change CSV file options. For
more information, see Import blocklists.
8. Click the Reason button. You can optionally enter a reason for blocklisting the imported entries. The reason applies to all imported entries.
9. Click Finished.
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Preference Center
The Preference Center lets recipients set their own preferences and update personal
information. Do this through a form that you incorporate into your web presence as a standalone element, or integrate into a template using an iFrame.
Recipients can access the page via a website link or in a mailing, then edit their personal
information. The information is transferred by REST API, SOAP API or HTTP API to Optimizely
Campaign and stored in the recipient data. You can use the generated data to create lifecycle marketing campaigns and tailor-made mailings.
For example, mailing recipients can make the following settings in the Preference Center:
l
l
l
l

Updating personal information (email address, name, postal address)
Specifying interests
Selecting topics (channels)
Setting up the frequency of receiving mailings (for example, bi-weekly, monthly)

Requested data
Data that a recipient enters in his/her profile is considered voluntarily disclosed personal
information. As long as this information is submitted voluntarily and not disclosed to third
parties, there is no limit on the type of data you can request.
Ensure data minimization and transparency:
l
l

l

The recipient should readily understand the purpose of the data request.
Only request information that you need and that serves to optimize the service you are
providing to the recipient.
Indicate which information is mandatory and which is voluntary. See Legal compliance.

If you are already conducting email marketing through Optimizely Campaign, you can use
the recipient lists in your client to see what recipient-based data is currently available.
Users can edit this data in the Preference Center.
To optimize the content of your mailings, recipients should be provided with additional
options. For example, you may want to furnish a listing of various areas of interest and
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allow the recipient to select one or more. Alternatively, you could offer several channels for
the recipient to subscribe to. Through dynamic marketing, you can place specific content
in mailings associated with each channel, content that only subscribers to those channels
receive, while withholding content from channels to which the recipient has not subscribed.

Legal compliance
The data protection notice must contain information about the collection, storage, use and
transfer of data. It must also reference the user's right to have data deleted and the obligation of the party collecting the data to provide information about that data. The text of a
data protection notice need not be included on the form page itself. You can include a link
to the appropriate page.
Although not mandatory, you should emphasize that none of the information collected is
disclosed to third parties. The same applies to notifications about data security protection.
In email marketing, collect data from required email address fields only if it is essential for
the purpose of distributing mailings; other fields, like Recipient name, should not be
required. You should indicate the purpose for which personal information collected
through the Preference Center is used. For example, you should emphasize that names are
collected solely for the purpose of personalizing mailings. If you request address information, indicate that it is collected to provide news about offers limited to a specific geographic area and so on. There are no limits on the information you can collect except for
email addresses and information must be provided voluntarily.

Exchanging data
The exchange of data between the Preference Center and Optimizely Campaign is carried
out via REST API or SOAP API. When a recipient opens the Preference Center through a
mailing, the recipient ID is transmitted and the recipient data contained in the Optimizely
Campaign database is imported. When the recipient edits his/her profile, the updated data
is transmitted back to Optimizely Campaign.
Note: You can also use HTTP API for the Preference Center except
that you cannot import recipient data into a web form. For example,
you can forward the mailing ID and recipient ID (usually the email
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address) from a mailing, and record the recipient data in the database, but the recipient cannot view his/her old data.
If you link to the Preference Center from your website, you cannot identify the recipient ID.
In this case, the recipient must first enter a recipient ID (usually the email address). The
same rule applies: If you are using REST API or SOAP API, you can import recipient data,
which you cannot do using HTTP API.

Form fields
Depending on the type of fields used, you can configure the Preference Center form fields
in different ways. Fields into which text is entered are set up as text fields. These include
the fields Email Address and Name. You can set up fields with fixed values as lists or
check boxes. Fields that list interests or topics should allow for multiple selections. If only a
single item may be selected (such as frequency of mailings), use either a drop-down list or
a radio button. The available fields are:

Caption

Type

Required
field

Standard

Email address
(required)

single-line text field

✓

—

Last name

single-line text field

✘

—

First name

single-line text field

✘

—

Salutation

radio button, drop-down list

✘

—

Date of birth

data field with selection window

✘

—

Age

drop-down list (for example, B. 20-30,
30-40)

✘

—

Interests

list with check boxes

✘

—
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Caption

Type

Required
field

Standard

Mailing frequency
(standard)

radio buttons (for example, weekly, biweekly, monthly)

✘

yes

Other fields, as
requested

radio buttons, text fields, drop-down
lists, check boxes

✘

—

Displaying error messages
Error messages should appear as text directly above/alongside/beneath the applicable
form. Alternatively, these messages may also appear at the top of the page, referencing
the applicable field. The field being referenced should be highlighted in color. The following provides several sample error messages:
Error

Error message

No email address entered

Please enter an email address.

Consent not provided

You must indicate that you want to receive this newsletter.

Required information not entered

Please complete all required fields.

Design/templates tips
Keep form pages simple and clearly arranged. Ideally, the user should not have to scroll to
reach the bottom of a page. Fields in a form and the Send button should be arranged to
display on standard screens and in commonly used font sizes without using the scroll bar.
If Optimizely creates and integrates a Preference Center for you, it is set up as a separate
page. You can link directly to this page or integrate it into a template using an iframe. If
you choose the latter option, you need to coordinate page width and height with customer
support to make sure the content displays correctly.
To create a web form, provide Optimizely with a template in HTML format or a layout template and the accompanying error messages.
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Security tips
Password protection
To protect recipient data from misuse, access to the Preference Center must be password
protected. Make sure that users can only access the Preference Center (their data) after
they verify authorization.

Changing email addresses
To prevent misuse, users should not be able to freely change their email address. The procedure used for changing email addresses could look like the following:
1. The recipient enters a new email address, which is saved temporarily.
2. A double opt-in process is initiated for the new email address.
3. The address is changed only after the recipient confirms the change. If not confirmed,
the original email address is restored.
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Analytics
This section describes Optimizely Campaign’s analysis tools to gather statistics after dispatch, or check and optimize your mailings before you send them. If you want to use thirdparty analysis tools, see Web analytics integrations.
l

Performance Dashboard (Beta). Create a graphical overview of your marketing activities.

l

Deep Analytics. Create cross-client analyses with more than 30 measurement variables.

l

Live Analytics. Create RFM analyses.

l

Deliverability preview. Check displays and spam suspicion with the most important email

l

providers before dispatch.
Post-click tracking. Analyze actions of recipients on your website.
Visual link analysis. Graphically display link clicks.
Visual link analysis of post clicks. Graphically display sales volume and number of orders
generated via a link.
Attention analysis. Create heat maps.

l

Activity overview. Display marketing activities within a defined period.

l
l
l

Tip: Using webhooks, you can also externally process real-time event
data on sent mailings, opens, and clicks.

Performance Dashboard (Beta)
The Performance Dashboard gives you an overview of your mailing activities. Customize
the Performance Dashboard and use it for example for graphically appealing presentations.
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To open the Performance Dashboard, open the Optimizely Campaign menu and select Analytics > Performance Dashboard (Beta).
Tip: All users of a client have the same access permission to the Performance Dashboard.
You can display the following widgets in the Performance Dashboard:
l

l

l

l

KPI chart (time-based). A simple diagram to illustrate a KPI. KPI charts consist of a graph-

ically highlighted key figure and a diagram behind it.
Basic chart (time-based). Has more configuration options than a KPI chart and is especially
suitable for analysis and comparison of different KPIs (2 dimensions).
Basic chart (mailing-based). Two-dimensional basic chart that, unlike the time-based basic
chart, allows analysis based on selected mailings.
Bubble chart (mailing-based). Display of different KPIs as colored bubbles (3 dimensions).

By default, the following widgets are displayed:
1.
2.
3.
4.

KPI charts Recipients, Opens, Clicks, Responses and Unsubscribes
Basic chart Dispatch Overview with a complete overview of all KPIs
Basic chart Clicks, Responses, Unsubscribes
Basic chart Unsubscribes
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You can customize and export each widget directly in the Performance Dashboard overview
or configure it individually in edit mode.
Tip: Hover over a specific day or mailing in the graph to view the corresponding KPIs and metrics.

Widget features
You can customize the diagram display of each widget directly in the Performance Dashboard to show or hide data series, set time periods, and zoom in on areas. You can also export
widgets as an image file, PDF or CSV.

Showing or hiding data series
Note: This function is not available for the widget type KPI chart.
To show or hide series in diagrams with several KPIs, click the respective series titles in the
right list.
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Setting time periods
Note: This function is only available for widget types KPI chart and
Basic chart (time-based).
The KPIs displayed in the widgets KPI chart and Basic chart (time-based) are absolute values and refer to all messages of a client in the selected time period.
To set the time period:
1. Hover over the widget for which you want to change the time period. A drop-down list
appears.

2. Select one of the following options:
l
l
l

Last 7 days. Data source are the last seven days.
Last 14 days. Data source are the last 14 days.
Last month. Data source is the last month. Example: On April 17, the period goes
back to March 17.
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l

l
l

Last year. Data source is the entire last year. Example: On April 17, 2019, the period
goes back to April 17, 2018.
Overall. Data source is the entire period recorded in the client.
Custom period. Define a time period.

Zoom
Note: This function is not available for the widget type KPI chart.
The zoom function lets you zoom in on areas in the widget type Basic chart, and enlarge
and display bubbles more precisely in the widget type Bubble chart.
To use the zoom function:
1. Move the cursor to the start or end point where you want to zoom in.
2. Hold the left mouse button and move to the left or right to define the area you want to
zoom in.

3. Repeat step 2 to zoom in closer.
4. Click Reset Zoom to reset the chart to the original setting.

© Optimizely 2022

826 | Optimizely Campaign User Guide 2022-03-14

Exporting widgets

You can export widgets as an image file, PDF or CSV file. Do the following:
1. Click the export icon
in the upper right corner of the widget you want to export.
2. Select one of the following file formats from the drop-down list: PNG, JPEG, SVG, CSV
or PDF.
Tip: Exported image files have the double image format of the displayed widget. When you export a CSV file, the data sources shown
in the graph are sorted either by date (for time-based graphs) or by
recipient number (for mailing-based graphs).

Edit mode
In edit mode, you can customize, move, delete or add widgets, or rebuild your Performance
Dashboard from scratch. In Performance Dashboard overview, click Edit… to open the edit
mode.
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The following options are available:
1. Restore Default. Discard all changes made to the Performance Dashboard and restore
the default settings.
2. Add Widget…. In the Widget Type drop-down list, select KPI chart, Basic chart (timebased), Basic chart (mailing-based) or Bubble chart. Make the desired settings for the
new widget and click Apply. The new widget will insert either below or between the
existing widgets, depending on its size and on the space available on the Performance
Dashboard.
3. Cancel. Discard your changes and return to the Performance Dashboard overview.
4. Apply. Apply your changes and return to the Performance Dashboard overview.
5. Edit, Copy, Delete

. Hover over a widget. The following options are displayed:

l

Edit

. Open the Edit widget window. See Editing widgets.

l

Copy . Open the Copy widget window. Customize the copy (See Editing widgets) and click Apply. The copied widget will insert either below or between the
existing widgets, depending on its size and on the space available on the Performance Dashboard.

l

Delete

. The selected widget is deleted.

Customizing widgets
In edit mode, you can customize widgets and change their position and size:

© Optimizely 2022

828 | Optimizely Campaign User Guide 2022-03-14

l
l

Change position. Hold the left mouse button and drag a widget to a free space.
Change size. Drag the right side or bottom side of a widget to change the height or width
of the widget. The lower right corner lets you adjust the height and width of a widget at
the same time.

Editing widgets
You can edit either a new, an existing or a copy of a widget.
In edit mode, double-click a widget or hover over a widget and click Edit . A window
opens with the settings of the respective widget type: KPI chart, Basic chart (time-based) ,
Basic chart (mailing-based) or Bubble chart.

KPI chart settings
In edit mode, double-click a widget or hover over a widget and click Edit
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You can make the following settings:
l

l

Title. Title of the KPI chart. It is displayed centered in a predefined font size. Leave the
field blank if you do not want to display a title.
Value type. Define the output type of your data source.
Sum. Sums up the data of the selected data source. (Example: A total of 955,000 messages were opened.)
o Average. Calculates the average of the selected data. (Example: An average of
120,000 messages were opened per day.)
o Minimum. Displays the lowest value of the data source of a day within the selected
time period. (Example: The minimum number of open mails is 465.)
o Maximum. Displays the highest value of the data source of a day within the selected
time period. (Example: The maximum number of open mails is 511,000.)
Value style. Define the style in which the key figure is to be displayed. Click Edit… and in
the Edit Style window, select the property you want to edit from the drop-down list. Click
o

l

Plus
o

o

to add the property to the style set.

Font color. Define the font color by entering a hexadecimal value preceded by # (for
example #000000). Alternatively, you can specify a color value using the color selector.
Opacity. Set a value between 0 and 1 for the opacity of the key figure.
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o

o

Background color. The background is displayed in the form of a colored stripe behind
the key figure. Define the font color by entering a hexadecimal value preceded by #
(for example #000000). Alternatively, you can specify a color value using the color
selector.
Text-align. Place the key figure on the left, centered or to the right of the widget. By
default, the key figure is centered.

Border. In the text field, enter a CSS standard frame definition, such as 2px dotted
orange for a 2 pixel wide, orange dotted frame.
o Padding. Specify a pixel value to change the vertical position of the key figure, for
example, 20px (the higher the pixel value, the lower the position of the key figure).
o Font size. The font size is calculated automatically. Changes do not affect the output.
Data source. Select the KPI you want to create a KPI chart for. The KPIs are absolute values and refer to the messages stored in your client.
o

l

Recipients. Number of recipients to whom messages are sent.
Clicks. Clicked Links.
o Opens. Opened messages.
o Responses. Messages that return to the sending mail server (including reply,
autoresponder, hard and soft bounce).
o Unsubscribes. Registered unsubscribes.
Chart color. Color of the chart displayed in the background of the KPI chart. Define the
font color by entering a hexadecimal value preceded by # (for example #000000). Alternatively, you can specify a color value using the color selector.
o
o

l

Note: For better readability, the diagram color is slightly transparent. This results in color changes (for example red becomes
pink).
l

Chart type.
o
o
o
o

Area-spline. Line chart with rounded corners and colored area.
Area. Line chart with colored area.
Line. Line chart.
Spline. Line chart with rounded corners.
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l

Time Period Options.
o

Add Time Period…. Add a custom time period.
n
n
n
n

o
o
o

Title. Enter a name for the newly created period.
Type. Select whether you want the time period to be absolute or dynamic.
From/To (Absolute). Specify a start date and an end date.
From/To (Dynamic). Starting from the current date, specify a time period in days.
Use minus values to go back in the past.

Click Minus
to remove periods from the selection.
Preselected time period. Specify which period is to be displayed by default.
Display time period selection. Show or hide the drop-down list for time period selection in the Performance Dashboard overview.

Basic chart settings (time-based)
In edit mode, double-click a widget or hover over a widget and click Edit

You can make the following settings:
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l

l

Chart title. Title of the chart. It is displayed centered in a predefined font size. Leave the
field blank if you do not want to display a title.
Chart type.
Bar. Display as bar chart.
o Line. Display as line chart.
o Column. Display as column chart.
Axis title. Title of the Y-axis of the diagram. Leave the field blank if you do not want to display a title.
Title color. Select a color for the axis title. Define the font color by entering a hexadecimal
value preceded by # (for example #000000). Alternatively, you can specify a color value
using the color selector.
Display on opposite side. By default, the axis title is on the left side. Enable this option to
display the axis title on the right side.
Data source. Select the KPI you want to create a KPI chart for. The KPIs are absolute values and refer to the messages stored in your client.
o

l

l

l

l

o
o

Recipients. Number of recipients to whom messages are sent.
Clicks. Clicked Links.

l

Opens. Opened messages.
o Responses. Messages that return to the sending mail server (including reply,
autoresponder, hard and soft bounce).
o Unsubscribes. Registered unsubscribes.
Series title. Enter a significant name for the created chart.

l

Series type. Select the display format of the chart.

o

Area. Line chart with colored area.
o Area-Spline. Line chart with rounded corners and colored area.
o Column. Column chart.
o Line. Line chart.
o Spline. Line chart with rounded corners.
o Scatter. Values are displayed as separate points.
Dash type. Select the desired dash type from the drop-down list.
Color. Select a color for the displayed chart. Define the font color by entering a hexadecimal value preceded by # (for example #000000). Alternatively, you can specify a color
value using the color selector.
o

l
l
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l

l
l

l

Display series. Disable this option to hide the graph. You can reactivate a hidden data
series in the Performance Dashboard overview at any time.
Add Data Series. Click Add Data Series… to add another graph.
Add Axis Definition. Click Add Axis Definition… to add another Y-axis to the graph. The
scale of the new Y-axis depends on the data series you create under this axis definition.
Time Period Options.
o

Add Time Period…. Add a custom time period.
n
n
n
n

o
o
o

Title. Enter a name for the newly created period.
Type. Select whether you want the time period to be absolute or dynamic.
From/To (Absolute). Specify a start date and an end date.
From/To (Dynamic). Starting from the current date, specify a time period in days.
Use minus values to go back in the past.

Click Minus
to remove periods from the selection.
Preselected time period. Specify which period is to be displayed by default.
Display time period selection. Show or hide the drop-down list for time period selection in the Performance Dashboard overview.

Basic chart settings (mailing-based)
In edit mode, double-click a widget or hover over a widget and click Edit
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You can make the following settings:
l

l

Title. The title of the bubble chart. It is displayed centered in a predefined font size. Leave
the field blank if you do not want to display a title.
Mailings.
Number of regular mailings. Enter the number of most recently created regular mailings that you want to display. Transactional mails, test mails, and confirmation mails are
excluded.
o Select mailings. Select one or more mailings. You can select transactional mails as well
as regular mailings.
o Group by campaign. Select the check box to group the selected mailings according
to the assigned campaign.
Axis Definition.
o

l

o

Axis title. Title of the Y-axis of the diagram. Leave the field blank if you do not want to
display a title.
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o

o

o

Title color. Select a color for the axis title. Define the font color by entering a hexadecimal value preceded by # (for example #000000). Alternatively, you can specify a
color value using the color selector.
Display on opposite side. By default, the axis title is on the left side. Enable this
option to display the axis title on the right side.
Data source. Select the KPI you want to create a KPI chart for. The KPIs are absolute
values and refer to the messages stored in your client.
n
n

Recipients. Number of recipients to whom messages are sent.
Opens. Opened messages.
(absolute). Total number of opens.
n (unique). Total number of unique opens. Multiple opens by a recipient are
seen as a unique open.
n (absolute) in %. Percentage of total opens in relation to the number of recipients.
n (unique) in %.Percentage of unique opens in relation to the number of recipients.
Clicks. Clicked links.
n

n

n
n

n

(absolute). Total number of clicks.
(unique). Total number of unique recipients that clicked an arbitrary link in a
mailing. It does not matter how often and which link was clicked.
(absolute) in %. Percentage of total clicks in relation to the number of recipients.

(unique) in %. Percentage of unique clicks in relation to the number of recipients.
Bounces. Messages for which bounces have been registered, including soft and
hard bounces.

n

n

(absolute). Total number of bounces.
(unique). Total number of unique bounces.
n (absolute) in %. Percentage of total bounces in relation to the number of recipients.
n (unique) in %. Percentage of unique bounces in relation to the number of
recipients.
Soft bounces. Messages for which soft bounces have been registered.
n
n

n

© Optimizely 2022

836 | Optimizely Campaign User Guide 2022-03-14

(absolute). Total number of soft bounces.
n (unique). Total number of unique soft bounces.
n (absolute) in %. Percentage of total soft bounces in relation to the number of
recipients.
n (unique) in %. Percentage of unique soft bounces in relation to the number of
recipients.
Hard bounces. Messages for which hard bounces have been registered.
n

n

(absolute). Total number of hard bounces.
n (unique). Total number of unique hard bounces.
n (absolute) in %. Percentage of total hard bounces in relation to the number of
recipients.
n (unique) in %. Percentage of unique hard bounces in relation to the number of
recipients.
Responses. Messages that return to the sending mail server (including reply,
autoresponder, hard and soft bounce).
n

n

n
n

(absolute). Total number of responses.
(unique). Total number of unique responses.

(absolute) in %. Percentage of total responses in relation to the number of
recipients.
n (unique) in %. Percentage of unique responses in relation to the number of
recipients.
Unsubscribes. Registered unsubscribes.
n

n

(absolute). Total number of unsubscribes.
n (unique). Total number of unique clicks on an unsubscribe link.
n (absolute) in %. Percentage of total unsubscribes in relation to the number of
recipients.
n (unique) in %. Percentage of unique clicks on an unsubscribe link in relation to
the number of recipients.
Series title. Enter a significant name for the created chart.
Series type. Select the display format of the chart.
n

o
o

n
n

Area. Line chart with colored area.
Area-Spline. Line chart with rounded corners and colored area.
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Column. Column chart.
n Line. Line chart.
n Spline. Line chart with rounded corners.
n Scatter. Values are displayed as separate points.
Dash type. Select the desired dash type from the drop-down list.
Color. Select a color for the displayed chart. Define the font color by entering a hexadecimal value preceded by # (for example #000000). Alternatively, you can specify a
color value using the color selector.
Display series. Disable this option to hide the graph. You can reactivate a hidden data
series in the Performance Dashboard overview at any time.
Add Data Series. Click Add Data Series… to add another graph.
Add Axis Definition. Click Add axis Definition… to add another Y-axis to the graph.
The scale of the new Y-axis depends on the data series you create under this axis
definition.
n

o
o

o

o
o

Bubble chart settings
In edit mode, double-click a widget or hover over a widget and click Edit
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You can make the following settings:
l

l

Title. The title of the bubble chart. It is displayed centered in a predefined font size. Leave
the field blank if you do not want to display a title.
Mailings.
Number of regular mailings. Enter the number of most recently created regular mailings that you want to display. Transactional mails, test mails, and confirmation mails are
excluded.
o Select mailings. Select one or more mailings. You can select transactional mails as well
as regular mailings.
o Group by campaign. Select the check box to group the selected mailings according
to the assigned campaign.
X, Y, Z axis values.
o

l

o
o

Recipients. Number of recipients to whom messages are sent.
Opens. Opened messages.
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(absolute). Total number of opens.
n (unique). Total number of unique opens. Multiple opens by a recipient are seen as
a unique open.
n (absolute) in %. Percentage of total opens in relation to the number of recipients.
n (unique) in %.Percentage of unique opens in relation to the number of recipients.
Clicks. Clicked links.
n

o

(absolute). Total number of clicks.
n (unique). Total number of unique recipients that clicked an arbitrary link in a mailing. It does not matter how often and which link was clicked.
n (absolute) in %. Percentage of total clicks in relation to the number of recipients.
n (unique) in %. Percentage of unique clicks in relation to the number of recipients.
Bounces. Messages for which bounces have been registered, including soft and hard
bounces.
n

o

(absolute). Total number of bounces.
(unique). Total number of unique bounces.
n (absolute) in %. Percentage of total bounces in relation to the number of recipients.
n (unique) in %. Percentage of unique bounces in relation to the number of recipients.
Soft bounces. Messages for which soft bounces have been registered.
n
n

o

(absolute). Total number of soft bounces.
n (unique). Total number of unique soft bounces.
n (absolute) in %. Percentage of total soft bounces in relation to the number of recipients.
n (unique) in %. Percentage of unique soft bounces in relation to the number of
recipients.
Hard bounces. Messages for which hard bounces have been registered.
n

o

n
n
n

(absolute). Total number of hard bounces.
(unique). Total number of unique hard bounces.
(absolute) in %. Percentage of total hard bounces in relation to the number of
recipients.
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(unique) in %. Percentage of unique hard bounces in relation to the number of
recipients.
Responses. Messages that return to the sending mail server (including reply,
autoresponder, hard and soft bounce).

n

o

(absolute). Total number of responses.
n (unique). Total number of unique responses.
n (absolute) in %. Percentage of total responses in relation to the number of recipients.
n (unique) in %. Percentage of unique responses in relation to the number of recipients.
Unsubscribes. Registered unsubscribes.
n

o

n
n
n

n

l

(absolute). Total number of unsubscribes.
(unique). Total number of unique clicks on an unsubscribe link.
(absolute) in %. Percentage of total unsubscribes in relation to the number of
recipients.
(unique) in %. Percentage of unique clicks on an unsubscribe link in relation to the
number of recipients.

Display of the x and y axis.
o
o

Linear. The axis values are displayed linearly - in successive steps.
Logarithmic. The axis values are displayed exponentially.

Deep Analytics
Deep Analytics is a report suite that you can configure to measure the success of your campaigns and evaluate mailings in detail. Select measures and group them by time period, target groups, click profile, and other factors.
To manage reports and report templates, open the Optimizely Campaign menu and select
Analytics > Deep Analytics.
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Tip: Up-to-date data
When you execute a Deep Analytics report, it aggregates up-to-date
data. The report's measures may vary slightly from those in the mailing overview, because the data is not aggregated at each request,
but in fixed chronological intervals.
Learn more:
l

Creating report templates

l

Executing reports

l

Displaying reports

l

Opening CSV files with Excel

l

Pivot tables

Creating report templates
To create a new report template, click Create….
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The creation process consists of 3 steps:
l

Step 1. Selecting report data

l

Step 2. Configuring the report template

l

Step 3. Sending the report

Note: To delete a report template, click a report template in the
Report Templates list then click Delete. Deleting or changing a template does not affect already executed reports. Reports that are
executed from deleted templates are shown as Not assigned to a
template in the list.

Step 1. Selecting report data
The Report Data tab lets you define which data is evaluated in a report. You can specify
recipients, mailings, measures, and groupings.
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Recipients and mailings
In the Recipients and Mailings area, define recipient segments, mailings, and clients that
you want to analyze. If you do not perform the following steps, relevant data is used for the
report.
1. To analyze recipients by target group, click Add
2. In the list, select a target group and click OK .
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3. Repeat these steps to use multiple target groups for this report.
Note: Selected target groups are applied to selected clients
when the report is executed. This may lead to unwanted results if
a target group uses filter rules that do not match recipients in
selected clients. See the following mailing example to learn more.
4. To analyze certain mailings, click Add below Mailings to Be Included in the
Report:.
5. To create an exclusive condition (such as is not, contains not, has not), in the left dropdown list, select not.
6. In the next drop-down list, you can select the following options.

l

( ... ). Create nested conditions by clicking the parentheses.
Client. Only available if you have access to more than one client. By default, the client to which you are logged in is selected.
Folder. Only mailings from specific folders.
Mailing. Only specific mailings.

l

Mailing type. Select one or more mailing types:

l
l

l

o

o
o

o
o
o

Regular. Optimized mailings of an A/B test (Smart Campaigns) and mailings
from Mailings Classics (deprecated).
Special. Transactional mails.
Transactional message. Split mailing of a transactional mail. See A/B test for
transactional mails.
Confirmation email. Confirmations.
Split. Split mailings from Mailings Classics (deprecated).
Campaign. Mailings and split mailings of a Smart Campaign (without optimized
mailings).
Tip: To select all mailings of an A/B test in a Smart Campaign,
select both options Regular (to select the optimized mailing)
and Campaign (to select the split mailings).

l

Start date. Select the start date in the next step.
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Reporting period. A reporting period lets you specify the time frame from which
data is collected and used for the analysis. By default, only mailings started in the
given period are analyzed. If you remove this filter, also opens, clicks, unsubscribes,
responses and post clicks that are created from mailings started prior to the reporting period but were only opened, clicked, unsubscribed, and so on within the given
period, are analyzed. For the mailings and recipients measures, this difference is
irrelevant.
7. In the next drop-down list, click the value for the selected filter option.
8. To combine several conditions, click Add
to add a new condition. Between two conditions, an AND or OR logic relation appears, which you can change by clicking it.
l

Note: Due to correctness and logical disambiguation, target
groups without parentheses can contain only one type of logic
relation. Thus, if you click a relation, relations between the rules
are changed. If you want to use different types of logic relations,
use parentheses.
Parentheses group rules hierarchically to handle them with priority, like in a mathematical equation. Rules within the parentheses are applied first, followed by rules in the second level,
and so on. Parentheses are especially useful if a complex condition is planned and different logic terms (AND or OR) will be
used.
9. Click OK

.

Measures and groupings
Measures "measure" the success of your campaigns and evaluate mailings in detail. Select
measures and group them by time period, target groups, click profile, and other factors.
Example: To get an overview of your past mailing activities, you can select in Measures
the unique number of recipients, the unique number of opens and, for example, the number of unique clicks. In Groupings, under Date or Time, you can select Year, Calendar
week and Date to group the Measure data by time period.
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Measures
A measure is defined as a numerical measure of a user interaction (for example openings,
clicks or unsubscribes) or characteristic of your mailing (recipients number, sent emails,
responses). Measures have the following characteristics:
l
l

l
l

Measures are expressed in form of a number.
Measures are stand-alone entities. If you look at a metric in a stand-alone fashion, it
provides information about the overall performance of your mailing.
Measures form the columns of a report structure.
You can combine measures in a report.
Tip: For a description of available measures, see Measures.

In the Measures area, define measures to be evaluated for this report:
1. Click Add Measure… .
2. Select a measure from the menu.
3. Repeat these steps for measures you want to analyze.
Tip: You can drag and drop a measure to the desired position if you
want to change it.

Groupings
Groupings (dimensions) have the following characteristics:
l
l

l
l

Groupings are non-numerical data fields.
Unlike measures, groupings are not stand-alone entities, that is, they are not generally
meaningful when viewed individually.
Groupings, when coupled with measures, provide meaningful context to the data.
Groupings are used to segment a measure.
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Tip: For an overview and a description of all available groupings, see
Groupings.
In the Grouping area, select groupings with which the measures will be matched:
1. Click Add Grouping… .
2. Select a grouping from the menu.
3. In the list, select a value (for example, HM TargetGroup) if you want to specify the
grouping more exactly.
4. Repeat these steps for groupings the report will evaluate.

Time-based reports
To arrange recipient-specific actions (such as, opens) for a mailing according to the start
date of the mailing (mailing-time-based analysis), select the All groupings by time are
based on the start date of the mailing check box.
If you clear the check box, recipient-specific actions are arranged separately according to
when they occurred (time-action-based analysis).
l
l

Mailing "New Year Newsletter" was started on 01/01/2018.
Mailing "Information Newsletter" was started on 06/02/2018.
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l

Time-action-based analysis (check box cleared):
Calendar week

l

Mailing

Opens (absolute)

01/2018

New Year Newsletter

5

03/2018

New Year Newsletter

5

04/2018

New Year Newsletter

10

06/2018

Information Newsletter

5

08/2018

Information Newsletter

5

09/2018

Information Newsletter

5

Mailing-time-based analysis (check box selected):
Calendar week

Mailing

Opens (absolute)

01/2018

New Year Newsletter

20

06/2018

Information Newsletter

15

Removing doublings
You can remove double counts from the Click Profile, Link, and Target Group groupings
automatically.

For example, a recipient in the target groups Men and Age 30-40 years is counted twice if
you use both target groups in a report. Thus, the sum line contains doublings. To prevent
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this, select the Remove doublings check box in the grouping, so the report shows only
one match for an arbitrary (applicable) target group of a recipient.
l
l

The recipient belongs to the target groups "Men" and "Age 30-40 years".
If you clear the Remove doubling check box, the following is shown in the report:
Target Group
Men

1

Age 30-40 years

1

Sum line
l

Recipients (absolute)

2

If you select the Remove doubling check box, the following is shown in the report:
Target Group

Recipients (absolute)

Men

1

Age 30-40 years

0

Sum line

1

Combinations
You can combine multiple groupings to get multidimensional reports. For example, select
the groupings Mailing and Target Group to get a report that shows measures per mailing
and for each target group.

User-defined arrangement
The arrangement of groupings affects the result of the report. You can drag and drop selected groupings to the desired position. If you commute the groupings Mailing and Target
Group, you get an evaluation of target groups and each target group is evaluated according to mailings.
Tip: Calculation of rates
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To calculate rates (as percentages), such as open or click rates, make
sure to select a grouping that delivers meaningful report data. For
example, to get the open rate (as percentage) of a mailing, the Mailing grouping must be selected. In the same way, the open rate by target group can be displayed. However, open rates in a time-based
report do not deliver meaningful values.

Step 2. Configuring the report template

To configure the automatic execution and sending of your template, perform the following
steps after adding measures and groupings:
1. In the Create Report window, in the Report Data tab, click Save as Report
Template.
2. In the Name box, enter the name of the report template.
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3. In the Folder list, select a folder to which you want to save the report template. To use
an Excel template, click Browse… and select a template. If no template is uploaded,
the Optimizely default template is used.
4. In the Interval area, click the interval for the generation of reports from this template.
If you change the interval, make sure that the last execution has run at least one hour
ago.
Manually. Reports can only be executed manually.
l
Weekly. Select the day of the week and the time of day when the report should be
executed.
l
Monthly. Select the day of the month and the time of day when the report should
be executed.
5. In the Reporting Period area, select one of the following options.
l

l

Since last execution to define that the report contains only data added since the
last execution of the report. The selected interval is already taken into account for
the first execution. If you select the Weekly interval, a reporting period of one week
is used for the first execution. If you change the weekly execution interval, such as
from Monday to Wednesday, the next execution uses the reporting period beginning Wednesday of the previous week.

No restrictions to define that available data is evaluated each time the report is
being executed. By using this option, the amount of data to be evaluated can be
very large. The execution of such reports may take some time.
6. Click Sending Options.
l

Tip: Reporting Period
Reporting period lets you specify the time frame from which data
used in the analysis is derived. The No restrictions option relates
only to the previously-defined global report parameters and measured data. If you evaluate openings in a report and define that only
mailings started in 2018 should be considered, openings for mailings
of the year 2018 are counted. The Incremental option evaluates data
added since the last execution of the report.
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Step 3. Sending the report
Tip: If you do not want to send the reports via email, leave these
fields empty.

To send the report via email, perform the following steps:
1. In the Recipients box, enter the email addresses of the recipients. Separate multiple
email addresses with a comma.
2. In the Subject box, enter the subject of the email.
3. In the Message Text box, enter the message text of the email. Executed reports are
attached as Excel files to the emails.
4. Click Save.
5. Close the window. The new report template appears in the upper section of the Deep
Analytics window.

Executing ad hoc report
After performing the step 1 and step 2 to create a report template, you can execute the
report without configuring or saving it as a template:
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1. In the Deep Analytics overview, click Execute Report Now….

2. To use an Excel template, click Browse… and select a template. If you do not upload
an Excel file, the default template is used.
3. In the Reporting Period area, select one of the following options:
Specify period. Specify the reporting period, a start date and an end date for the
period you want to analyze.
l
No restrictions. Define that all available data is analyzed at execution of the
report. Note that by using this option the amount of data to be analyzed can be
very large in the course of time. The execution of such reports may take some time.
4. Click Sending Options and follow the steps under Sending options.
5. Click Start Execution. After execution, the report is shown in the overview window
and can also be downloaded as an Excel or CSV (comma-separated values) file.
l

Measures
You can use the following measures for Deep Analytics reports:

Mailings
Measure
Number of mailings

Description
Total number of outgoing mailings
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Measure

Description

(absolute)
Total volume

Number of recipients + Number of responses (total, non-unique) less
skipped recipients

Recipients
Measure

Description

Unique recipients

Number of unique recipients. If a recipient receives multiple mailings,
the recipient is only counted once.

Recipients (absolute)

Total number of recipients

Recipients minus
bounces (absolute)

Total number of recipients whose email addresses did not produce a
bounce (message of non-deliverability)

Recipients minus
bounces (%)

Percentage of recipients whose email addresses did not produced a
bounce (message of non-deliverability)

Opens
Measure

Description

Unique opens (absolute)

Total number of unique opens. Multiple opens by a recipient are seen as
one single open.

Opens (absolute)

Total number of opens

Unique open rate (%)

Percentage of unique opens in relation to the number of recipients minus
bounces

Open rate (%)

Percentage of total opens in relation to the number of recipients minus
bounces
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Measure

Description

Unique gross open
rate (%)

Percentage of unique opens in relation to the total number of recipients

Gross open rate (%)

Percentage of total opens in relation to the total number of recipients

Clicks
Measure

Description

Unique clicks

Number of unique recipients that clicked an arbitrary link in a mailing. It does
not matter how often and which link was clicked.

Clicks (absolute)

Total number of clicks

Click rate (%)

Percentage of total clicks in relation to the number of recipients minus
bounces

Unique click rate
(%)

Percentage of unique clicks in relation to the number of recipients without
bounces

Unique gross
click rate (%)

Percentage of unique clicks in relation to the total number of recipients

Gross click rate
(%)

Percentage of total clicks in relation to the total number of recipients

Effective unique
click rate (%)

Percentage of unique clicks in relation to the unique opens

Responses
Measure
Unique responses

Description
Total number of unique responses
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Measure

Description

(absolute)
Unique response rate
(%)

Percentage of unique responses in relation to the number of recipients
minus bounces

Unique autoresponder
(absolute)

Total number of unique autoresponder messages

Unique autoresponder
rate (%)

Percentage of unique autoresponder messages in relation to the number
of recipients minus bounces

Unique replies (absolute)

Total number of unique replies

Unique reply rate (%)

Percentage of unique replies in relation to the number of recipients
minus bounces

Unique bounces (absolute)

Total number of unique bounces

Unique bounce rate (%)

Percentage of unique bounces in relation to the number of recipients

Unique hard bounces
(absolute)

Total number of unique hard bounces

Unique hard bounce
rate (%)

Percentage of unique hard bounces in relation to the total number of
bounces

Unique soft bounces
(absolute)

Total number of unique soft bounces

Unique soft bounce
rate (%)

Percentage of unique soft bounces in relation to the total number of
bounces
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Unsubscribes
Measure

Description

Unique unsubscribes
(absolute)

Number of unique clicks on the unsubscribe link

Unique unsubscribe
rate (%)

Percentage of unique clicks on the unsubscribe link in relation to the number of recipients minus bounces

Unique net unsubscribe rate (%)

Percentage of unique clicks on the unsubscribe link in relation to the total
number of recipients

Post-click
These measures are available only if post-click tracking is configured for your client. If you
select the Post-click... measure, a new window opens where you can define the measure.
To do this, perform the following steps:
1. Enter a name.
2. Select a service. (If you use only one service, it is already selected.)
3. Select whether the measure you want to create is a number (count), a sum or an average.
If you select Sum or Average, select a post-click value from the drop-down list. If
you do not want to filter this value further, save the definition.
l
If you select Count, no filters are added.
To add filters, in the Filter area, click Add and select an operator. The operators
depend on whether the selected post click represents a number or a string value.
Enter a reference value to compare the post-click value with. This comparison is
executed according to the operator selected in the previous step.
Click Submit .
To add more filter values, click Add and repeat the previous steps.
Click Save. The newly created post-click measure appears in the New Report window
in the Report Data tab.
l

4.
5.
6.
7.
8.
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Tip: Entering multiple values
If you select is one of the following values, you can enter multiple
values in one text box; for example, if you want to copy values from a
CSV file:
1. Select the operator is one of the following values and enter the values,
for example, comma-separated.
2. Open the drop-down list, click the scissors symbol (Separate multiple values) and in the box, enter the used delimiter symbol.
3. Click Submit . The entered values are now handled as single values.

Groupings
You can use the following groupings for Deep Analytics reports:
Grouping

Description
Select one of the following groupings:

Date or Time

Domain

l

Year

l

Calendar Week

l

Month

l

Date

l

Hour of the Day

l

Week Since Day of the Week

l

Day of the Week

l

Day of the Month

Recipient domain
Select one of the following groupings:

Recipient List

Recipient List

l

Recipient List Name

l

Recipient List ID

Various fields in recipient lists
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Grouping

Description

Field
Click Profile

Used click profiles

Link

Links used in the mailing
Select one of the following link types used in the mailing:

Link Type

l

Link

l

Double opt-in link

l

Online version link

l

Send-to-a-friend link

l

SWYN link

Select one of the following groupings:
Mailing

l

Mailing Name

l

Mailing ID

Name or ID of the clients you are allowed to access. Select one of the following
groupings:
Client

Folder

l

Client Name

l

Client ID

Folders in which you store mailings
Subject lines used in mailings

Subject

Tip: Only the standard subject line is considered.
Additional target group-controlled subject lines are
ignored.

Target Group

Recipients who belong to specific target groups

Browser, OS,

Select one of the following groupings:
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Grouping

Description
l

l

Device

l

Device Type
o

Camera

o

Car multimedia

o

Video game console

o

Desktop computer

o

Feature phone

o

Phablet

o

Portable media player

o

Smart display

o

Smartphone

o

Tablet

o

Smart TV

o

Wearable

o

Peripheral

Browser
o

Android Browser

o

Chrome

o

Firefox

o

Internet Explorer / Edge

o

Microsoft Outlook

o

Opera

o

Outlook Express

o

Safari

o

Thunderbird

Operating System
o

Android

o

BlackBerry

o

GNU/Linux

o

iOS

o

Mac

o

Symbian

o

Unix

o

Windows
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Grouping

Description
o
l

Windows Mobile

Operating System Version

Media Type

Media type (marketing channel)

Contact Frequency

Number of messages received by a recipient within a reporting period

Executing reports
1. In the Report Templates area, click a report template on which the new report will be
based.
2. Click Execute Report Now….

3. To use an Excel template, click Browse… and select a template. If you select nothing
here, the Optimizely Campaign default template is used.
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4. In the Reporting Period area, select an option:
l
l

Specify Period. Specify the reporting period for which data will be evaluated.
Since last execution. Data added since the last execution of the report. The selected interval is already considered for the first execution. If the report is executed
weekly, a reporting period of one week is used for the first execution. If you change
the weekly execution interval, such as from Monday to Wednesday, the next execution uses the reporting period beginning Wednesday of the previous week.

No restrictions. All available data. The amount of data can be very large and its
execution may take some time.
5. Click Sending Options.
l
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6. If you want to send the report via email:
a. In the Recipients box, enter the email address of recipients (separate email
addresses with a comma).
b. In the Subject box, enter the email subject.
c. In the Message Text box, enter the email message text.
7. Click Start Execution. When the report is executed, you can select it under Executed
Reports.
Use the buttons below the list to display the report as a Pivot table or download it as
Excel or CSV file. See also Displaying and downloading a Deep Analytics report.

Displaying and downloading reports
1. In the Report Templates area, select a report template. The area Executed Reports
displays reports that have been executed from the selected template.
To display a report that is not executed from a template, click Not assigned to a template in the Report Templates area.
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2. In the Executed Reports area:
l

l

l

To display the report as a pivot table, click Show as Pivot Table. See Aggregating
data with pivot tables.
To display the report in a standard HTML table without formatting, select a report
and click Show as Table.
To download the report as a chart using Microsoft Excel, click Download as Excel
File.
Tip: The Excel format provides many possible ways of reporting and displaying data. You may use your own Excel template or the Optimizely default template to create analyses
and display data in charts or pivot tables. To learn more, see
Data evaluation using Microsoft Excel.

l

To download the report in a CSV (comma-separated values) file, click Download as
CSV File. See also: Opening CSV files in Microsoft Excel.

Opening CSV files in Microsoft Excel
Optimizely Campaign creates CSV (comma-separated values) files in UTF-8 without BOM.
Microsoft Excel incorrectly interprets the format as ISO-88591. To correctly open CSV files
in Excel, perform the following steps:
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1.
2.
3.
4.

Open a blank Excel workbook.
In the Data tab, click Get Data > From File > From Text/CSV.
Select the file to open and click Import.
In the File origin area, select 65001: Unicode (UTF-8) and Semicolon in the Delimiters area.
5. Click Load.

Evaluating data with Microsoft Excel
The Excel format allows rich formatting, calculations, and output in pivot tables and in a
chart.
To use your own Excel template, download the default template, customize it then upload
it. This Excel template contains the report data in the first worksheet grouped by the selected groupings. The second worksheet contains a copy of the data without sum fields. Use
this worksheet to reference data you want to display in other tables or charts (for example,
pivot tables).
In general, the following standards apply when formatting the Excel templates:
l

l

l

l

Supported file formats. Optimizely Campaign supports the Excel '97 format (file suffix
.xls) and Excel 2007 (file suffix .xlsx). However, Optimizely does not guarantee support of
functions and formatting of these two formats.
Data export and data format. Exported data is exported into the first table with sum
fields and second worksheet table without sum fields. Do not change these worksheets;
otherwise, the correct export of the data fails. The format of the header page is completely
adopted, but not the content. The data formats of the first data row (row 2 in the Excel
worksheet) are adopted. Thus, values can be formatted and the formatting can be
changed.
Evaluations. You can perform evaluations on the second and subsequent worksheets.
Because an unlimited number of rows may be added when executing the report, chart
data, pivot tables and formulas must be designed for a very large number of data rows.
This especially applies to reports without time restriction.
Pivot tables. Automatic updates must be turned on startup. You find this option under
PivotTable Options > Data > Refresh data when opening the file.
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Tip: Upon request, Optimizely creates Excel templates with pivot
tables, charts and using the layout of your choice. Contact customer
support.

Aggregating data with pivot tables
To organize and display large amounts of data created with Deep Analytics, use pivot
tables in the online view and the downloadable Excel templates. Pivot tables can show
what is important without losing details. In a pivot table, you can change the orientation
and grouping of the data, and the hierarchical order of groups and categories. You can use
one pivot table to display different kinds of scenarios.
Raw data is stored in the background. If you group data or omit categories in the table or
chart display, no data is eliminated, and you can return to display data at any time.

Example 1: Analysis by mailing
Prerequisites: To create the following example pivot tables, you need a Deep Analytics
report that contains the measures and groupings as shown on the image. For more information on how to create reports, see Creating a report template.
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The following examples demonstrate how to use pivot tables for an exact analysis of
desired data and details, using different criteria in the same report. By grouping, sorting
and omitting data, you can capture reports at a glance. You do not lose any data, though. If
you need to show more details, unfold the table and re-order groups and categories.
The following image shows an analysis of recipients, clicks, opens, and responses by mailing.
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To change or rearrange the pivot table, click Fields or the arrow icon pointing to the bottom left.

In the left Fields area, select the fields you want to use for the evaluation. You can drag
and drop each field into one of the four areas. For the above example, click the measures
Recipients, Unique clicks, Unique opens and Unique responses to add them as values
to the Columns area.
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Example 2: Analysis by time
To create a time-based analysis, deselect the Mailing grouping under Fields and drag the
relevant time dimensions into the Columns field. Drag the Values into the Rows field.
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Click Apply, to create a new analysis:

Click the left arrow next to a field name to display the dimension organized below.
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To change the hierarchy of these drop-down dimensions, drag one of the bold field filters
in the upper area before or after other filters.
The example below shows Calendar week > Year > Date. By dragging the Year field filter
to the far left, the year value will become top of the drop-down dimension hierarchy (green
box).

Click the bold field filters to select and deselect fields or refine filters.

In the dialog box, click Filter by: Labels to specify conditions that are related to names.
Example: Labels Contain newsletter filters field values with "newsletter" as part of their
name. Click Filter by: Values to filter for numeric values. Example: Sum of Recipients Top
10 filters the 10 highest recipients field values. Click Apply to accept the changes.
To display your pivot table as a chart, click Charts in the menu in the upper left corner and
select a suitable chart. Select the Multiple values checkbox to display multiple field values in one table. Use the Select Measures button to add or deselect individual measures.
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Click Grid to return to the grid view of the pivot table.

Further Menu options
Under Format in the top right menu, you can specify the formatting of individual cells or
create conditional formatting.

Click Format > Format cells to adjust the cell properties of all or some field values. You
can, for example, add a currency symbol to some values of the table.
To add conditional formatting, select Format > Conditional formatting. Conditional
formatting lets you, for example, configure that numbers below 150 are displayed in red.
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Click Options in the upper right menu to change individual layout properties.

Live Analytics
Live Analytics lets you create RFM analyses in real time from the entire recipient dataset,
or a subset of recipients. Live Analytics stores recipient action data from mailing lists then
analyzes that data from the previous 12 months. The data is updated daily.
Live Analytics ensures high performance for the analysis of large quantities of data. Running analyses show an up-to-date image of the customer lifecycle, preferences, sales
volume, and recipients' purchases.

RFM analysis
RFM analysis is an effective procedure for the analysis, prediction, and optimization of the
customer base. RFM stands for the following three parameters, indicators of the probability that a customer will react to a marketing campaign in the future:
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l

l
l

Recency. When a customer's most recent action was made, including purchases, aborted
orders, or a product view.
Frequency. The frequency with which a customer performed the above actions.
Monetary. The sales volume a customer generated; only the purchase action is analyzed.

You can increase profitability and ROI (return on invest) of your campaigns with the combination of these three parameters. Each recipient is assigned to an RFM segment. You
can view the entire recipient base as well as individual segments, further constrain them,
and define them as a target group for a campaign.

Live Analytics packages
You can run up to three Live Analytics analyses simultaneously using the standard package. If you need more analyses, contact customer support to expand it.
To start Live Analytics, open the Optimizely Campaign menu and select Analytics > Live
Analytics. The Live Analytics window shows running analyses in the selected display (pie,
line or bar chart).
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You can arrange analyses in the desired order using drag and drop. To do this:
1. Move the pointer over an analysis in the blue bars on the upper edge until the pointer
switches to the drag and drop symbol
2. Drag the analysis to the desired position.

.

Then, perform the following actions:
l

Create. See Create and edit Live Analytics analysis.

l

Detail view. Move the pointer over the analysis and click Show details
lytics detail view.

l

Edit. Move the pointer over the analysis and click Edit Analysis
Live Analytics analysis.

l

Delete. Move the pointer over the analysis, click Delete Analysis

. See Live Ana-

. See Create and edit
then Delete.

Creating a Live Analytics analyses
1. To create a new analysis, in the Live Analytics, window click Add
lysis window opens.

. The Create Ana-

Note: To edit an already existing analysis in the Live Analytics
window, move the pointer over the desired analysis and click Edit
analysis

. The Edit Analysis window opens.
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2. Drag the desired Live Analytics analysis items from the left action area to the Limitations (to perform a pre-selection of the analyzed recipients) and Charts areas.

3. To edit an analysis item, move the pointer over the desired item in the Limitations or
Charts area and click Edit Chart…
.
4. To change the chart type of an analysis item, move the pointer over the desired item in
the Charts area and click the desired chart symbol for pie, line, or bar charts.
l

Pie Chart
. Each piece of the pie represents one recipient segment for a
period, frequency, or sales volume. Click a piece to constrain the selection to this
segment.
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l

Line Chart
. Each point of the line represents one recipient segment for a
period, frequency or sales volume. Click a point to constrain the selection to this
segment.

l

Bar Chart
. Each bar represents one recipient segment for a period, frequency or sales volume. Click a bar to constrain the selection to this segment.
5. Configure the analysis items as described in Analysis items.
6. To remove an analysis item, move the pointer over the item and click Delete Chart
.
7. You can arrange the analysis items in the desired order, both under Limitations and
Charts. To move an item, move the pointer over the item. The pointer switches to the
Move symbol
. Click and drag the item to the desired position.
8. Click Apply.
9. In the Name field, enter a name for the analysis and click Apply. The analysis is shown
in the overview. If no analysis data is available, a notification appear. When the computation of the analysis data is concluded, the charts and data are displayed.
Note: Limitations
l
l
l

An analysis must include at least one chart.
An analysis can include multiple charts.
Invalid parameters or missing configurations are displayed when you add
an analysis item as a constraint or chart.

Analyzing analysis items
Analysis items form dimensions that you can use as a limitation or chart in an analysis.
Restrictions apply to the use of analysis items as a limitation.
The following table shows analysis items and their options. Click an analysis item to read
about its use and configuration.
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Analysis item

Description

Constraint

Chart

Recipient list

Constrains recipients to one or more recipient
lists or analyzes recipients sorted according to
recipient lists.

✓

✓

Recipient list field

Constrains recipients to a recipient list with a
specific value or analyzes recipients sorted
according to the values of a recipient list field.

✓

✓

✓

✓

Constrains recipients to one or more target
groups or analyzes recipients sorted according
to target groups.
Target
group

Note: Target groups
must have been created
in the Target groups function.

Monetary value

Analyzes recipients sorted according to sales figures within the past 12 months.

✘

✓

Last
action

Analyzes recipients sorted according to the time
period of their last action (purchase, product
view, abandoned shopping cart) within the last
12 months.

✘

✓

Frequency

Analyzes recipients sorted according to the frequency of an action (purchase, product view,
abandoned shopping cart) within the last 12
months.

✘

✓

Limitations
A limitation limits the data to be analyzed with the aid of an analysis item. You can add or
remove limitations in running analyses. You can also create analyses without limitations.
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To use an analysis item, drag it from the left action area to the Limitations and Charts
areas. You can make limitations in the analysis by using to the following analysis items:
l
l

l

Recipient Lists. Select recipient lists to include in the analysis.
Recipient List Fields. Select a recipient list field and a value range to include only recipients with these attributes in the analysis.
Target Groups. Select target groups to include in the analysis.
Tip: If you make no limitations, all active recipients of your client are
considered for the analysis. You can deactivate selected limitations
later in the detail view of an analysis.

Chart
In a chart, the value range of an analysis item is displayed segmented, according to the
selected dimension. The segment can be carried out according to time, frequency, sales
volume, grouping or defined values.
Tip: For items that use charts: you can change the chart type at any
time, even in running analyses.

Recipient list
Limitation
1. Drag the analysis item from the left action area to the Limitations area.
2. Enter an optional name for the limitation. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the desired recipient lists.
4. Click Close.
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Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the recipient lists. If you enter multiple recipient lists, you receive a
segmented evaluation in the chart.
4. Click Close.
5. Move the pointer over the added analysis item and click the desired chart symbol:
.

Recipient list field
Limitation
1. Drag the analysis item from the left action area to the Limitations area.
2. Enter an optional name for the limitation. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the desired recipient list field (for example, country, age, modified).
Depending on the file type, you can configure discrete values, value ranges, or intervals:
l

Text Fields. Enter a value to use as the filter for the selected recipient list field,
such as France.
You must enter the value exactly as specified in the recipient list (including
capitalization).
o To filter the recipient list field by up to 10 filters, click Add
and enter another
value. Repeat for values that you want to use as filters.
Numeric Fields. In the list, select whether you want to display a multiple selection,
an interval, or a threshold value.
o

l

o

If you selected Multiple values can be selected, proceed as described in
Text fields.
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If you selected Interval or Threshold option, in the Unit field, enter a unit (for
example, years) and a lower or upper limit in the following fields.
o If you define a threshold value, also select whether you want to filter values
above or below the threshold value.
l
Date Fields. In the list, select a date field (such as modified) by which you want to
segment the evaluation. Select the time interval later, in the detail view of the analysis.
4. Click Close.
o

Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the desired recipient list field for example, country, age, modified.
Depending on the file type, you can configure discrete values, value ranges or intervals:
l

Text Fields. In the box below, enter a value to use as the filter for the selected
recipient list field, such as France.
Enter the value exactly as specified in the recipient list (including capitalization).
o To filter the selected recipient list field by up to 10 filters, click Add
and
enter another value. Repeat this step for values that you want to use as filters.
o If you enter multiple values here, you receive a segmented evaluation in the
chart.
Numeric Fields. Define the value ranges (intervals) that you want to display in the
chart, starting with the smallest segment. In the box after Values lesser than or
equal to, enter a numerical value, such as 10. Then, click Add
and add the next
higher value range, such as 20, 50, 100. Repeat until you define all value ranges.
o

l

You can define up to 10 values ranges per chart.
If you enter multiple value ranges here, you receive a segmented evaluation in
the chart.
Date Fields. In the Reporting Period list, select an evaluation period for the data:
within the last 7 days, 8 weeks, 12 months, or 10 years. You can also display values
outside the selected evaluation period by checking the Show values beyond the
o
o

l
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reporting period box. In the chart, an additional segment for previous events and
an additional segment for recipients without a corresponding event (Remainders)
are displayed.
Example: If you selected the reporting period the last 12 months for the recipient
list field Last changed, with activated Show values beyond the reporting
period option, 14 segments are displayed in the diagram.
one each for the last 12 months
o another for recipients whose datasets last changed more than 12 months ago
o one for recipients whose datasets have not changed since being created.
4. Click Close.
5. Move the pointer over the added analysis item and click the desired chart symbol:
.
o

Target group
Limitation
1. Drag the analysis item from the left action area to the Limitations area.
2. Enter an optional name for the limitation. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the desired target groups.
4. Click Close.
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Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. In the list, select the desired target groups. If you enter multiple target groups, you
receive a segmented evaluation in the chart.
4. Click Close.
5. Move the pointer over the added analysis item and click the desired chart symbol:
.

Monetary value
Note: You cannot use this item as a limitation.

Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. If you are using multiple post-click services, select a post-click service in the list below
it. If you are only using one post-click service, this list is not displayed.
4. In the Revenue Field list, select the post-click value that tracks sales. The name of this
value can be different depending on the post-click service and configuration, such as
revenue, sales, and so on.
5. Define the value ranges (intervals) that you want to display in the chart, starting with
the smallest value. In the box after Values less than or equal to, enter a numerical
value, such as 10. Then click Add and add the next higher value range, such as 20,
50, 100. Repeat this step until you define the desired value ranges.
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You can define up to 10 values ranges per chart.
l
If you enter multiple value ranges, you receive a segmented evaluation in the
chart.
6. Click Close.
7. Move the pointer over the added analysis item and click the desired chart symbol:
.
l

Last action
Note: You cannot use this item as a limitation.

Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. If you are using multiple post-click services, in the drop-down list, select a post-click
service. If you are only using one post-click service, this list is not displayed.
4. Select the desired period in the Reporting Period list.
5. Optionally, you can display values outside the selected evaluation period by activating
the control box Show values beyond the reporting period. An additional segment
with recipients whose most recent action took place further in the past than the selected period of time, and a segment with recipients that performed no action (Remainders) are displayed in the diagram.
Example: If you selected the evaluation period within the last 7 days, then for the
activated option Show values beyond the reporting period, nine segments are displayed in the diagram.
one each for the last 7 days
l
one for actions taken more than 7 days ago
l
one with recipients who performed no action (Remainders).
6. Click Close.
l
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7. Move the pointer over the added analysis item and click the desired chart symbol:
.

Frequency
Note: You cannot use this item as a limitation.

Chart
1. Drag the analysis item from the left action area to the Charts area.
2. Enter an optional name for the chart. If you are using multiple analysis items of the
same type, names help you differentiate them.
3. If you are using multiple post-click services, in the drop-down list, select a post-click
service. If you are only using one post-click service, this list is not displayed.
4. Define the value ranges (number of actions) to display in the chart, starting with the
smallest segment, for example, 0. Then click + and add the next higher value range, for
example, 2, 5, 10. Repeat until you define all desired value ranges.
You can define up to 10 values ranges per chart.
l
If you enter multiple value ranges here, you receive a segmented evaluation in the
chart.
5. Click Close.
l

6. Move the pointer over the added analysis item and click the desired chart symbol:
.

Live Analytics detail view
The detail view shows limitations selected in the analysis accompanied by recipient segments as a chart. The upper right corner of the window shows the total number of recipients of segments and the analysis parameters. Use the Save as Target Group button to
save the selected segments as a target group.
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Displaying recipients
In the left column, at the top in each detail view of an analysis, use the Show drop-down
list to choose between display options:
l

l

Potential recipients. Potential recipients of the selected segments; that is, recipients
from the recipient lists that correspond to the defined criteria. If you change the limitations of an analysis or select individual segments, the number of potential recipients is
adjusted in real time. This number can include recipients who currently receive no mailings because they unsubscribed from the newsletter, exceeded the bounce limit, or are
blocked.
Contacted recipients. Recipients in the current selection who received at least one mailing. This does not mean that a campaign was sent with the segment shown in the analysis;
it means that recipients were addressed using the same recipient lists and target groups
as in the current analysis.
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Activating limitations
The selected limitations are displayed in the left column. Refine or expand the displayed
analysis by activating or deactivating limitations:
l
l
l

l

Entire limitation. Clear to exclude the entire limitation.
Individual segments of a limitation. Clear to exclude a segment from an analysis.
Interval or threshold value for numeric values. To adjust the limitation interval or
threshold value, move the slider for an interval or threshold value limitation.
Time interval for date fields. To set or adjust the time interval, click the left date field
and enter a starting date using the calendar. Then, click the right date field and enter an
end date.
Note: Limitations
l

l

l

If you select some limitations (not all), the number of potential recipients in
an analysis decreases or remains the same.
If you select a limitation but the number of potential recipients does not
change, the limitation is not relevant for the analysis.
If you select all limitations, the number of potential recipients increase,
because all recipients from your client are considered.

Displaying ad-hoc segmentation
To receive the selected recipient segment, click a bar, point, or slice of the pie in a chart.
The display of analysis data in the upper right changes to display the potential recipients
and contacted recipients in the selected segment. If you created multiple charts in an analysis, the display changes in these charts too. Only recipients from the segment selected in
the first chart are still displayed there.
You can now refine the selection of recipients by selecting an additional segment in these
charts. After each selection, the display of the other charts adjusts to the refined selection.
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Tip: The order in which you make the selection does not matter. You
can start with any chart then select a segment in the other charts.
Example: Recipient segment from an RFM analysis:
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1. Recipients whose most recent action (purchase, product view, abandoned shopping
cart) took place in the last 6 weeks are selected.
2. These recipients are further limited to ones who performed one or two actions in the
last 12 months. Purchases, product views and abandoned shopping carts are evaluated
here too.
3. These recipients are limited to those whose purchases exceeded €150 in the last 12
months.

Saving a segment as a target group
After you select the desired recipient segment, you can save it as a target group to
address these recipients in a campaign.

Note: If a recipient is included in multiple categories, the potential
recipients displayed in Live Analytics may differ from the actual number of recipients. If you want to calculate the exact number of potential recipients, use the analysis feature in the Create Target Group
window (see also Target group analysis).
To save a segment as a target group, perform the following steps:
1. Hover over the gray field in the upper right corner in which the analysis data is displayed. The field becomes active and highlighted.
2. Click Save as Target Group. The Create Target Group window opens.
3. In the Target Group Definition area, in the Client list, select the client for which you
want to create the target group.
4. Click Properties.
5. Optionally, select a folder in which you want to save this target group.
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6. The name of the target group is generated according to the scheme Created from
[analysis title] on [date] at [time]. If you want to give it a distinct name, delete this
and enter the desired name.
7. Optionally, enter a description of the target group.
8. Click Create.
You can now select the target group in a regular campaign (in the menu item Smart Campaigns), or in an automated campaign (in the menu item Marketing Automation) and create a campaign for these recipients.

Deliverability preview
The deliverability preview lets you check your mailing before dispatch, whether the contents are displayed correctly and whether your mailing has been classified as spam by the
most popular email providers. Optimizely works together with an external software service
provider to analyze and create the deliverability preview.
To create or view a deliverability preview, open the Optimizely Campaign menu and select
Analytics > Deliverability Preview.
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Creating a deliverability preview
Note: Deliverability previews have additional costs. For more information, contact customer support.
Prerequisite:
l

Test recipient list (see Recipient lists)

To create a deliverability preview:
1. Click Create….
2. In the Select Mailing drop-down list, select the mailing for which you want to create a
deliverability preview.
3. In the Select Test Recipient drop-down list, select a recipient list.
Note: Only use test lists and no real customer data. See also
Recipient lists.
4. In the Name field, enter a name for the deliverability preview.
5. Click Create.
Tip: The analysis and creation of the deliverability preview may
take several minutes.
6. Click Close.

Viewing a deliverability preview
In the Select Preview drop-down list, select a deliverability preview.
Tip: The results may not display immediately. In the Select Preview
drop-down list, you can check the progress of each analysis under
Status.
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The deliverability preview has two tabs:
l

Display

l

Spam suspicion

Display
The Display tab lets you preview how the graphics and fonts in your mailing are displayed
by the most popular email providers and browsers.
To filter the results, enter a search term in the Filter results... field.
Tip: For example, enter iPad to check the appearance on Apple
iPads, or enter Gmail for the Gmail email provider.
Click a thumbnail to display the respective image. For some images, you can change the
format from Portrait (vertical) to Landscape (horizontal). Click the desired format in the
upper left corner of the image.
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Spam suspicion
The Spam Suspicion tab provides an overview of whether your mailing has been classified
as spam by the most popular email providers.
l

The red icon

indicates that your mailing has been classified as spam.

l

The green icon

indicates that your mailing has arrived at the respective email provider.

l

The violet icon

indicates that no result is available yet.

If available, the spam score is also displayed and you can view further information on the
spam filters by hovering over the info symbol
ent.

. See also: Notes on spam filters of each cli-

— Notes on spam filters of each client—
Client

Description

Inbox folder test

Gmail

Gmail's spam filter is part of the standard Gmail service. Gmail is supported in all
browsers and in several mobile applications. The test uses Gmail's default spam
filter settings.
In Gmail, recipients can manage incoming messages using filters that allow
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Client

Description
them to automatically label, archive, delete, star or forward an email, or keep
it from entering the spam folder in the future. They can also add senders to
the address book to prevent future emails to be sent to the spam folder.
These options are not considered for this test.
Note: Gmail's spam filters also work in IMAP clients.
IMAP clients can be used on iPhone, iPad, Android,
Kindle Fire, Thunderbird, Apple Mail, Outlook 2003,
Outlook Express and others. This means that your
email might have to pass a combination of two filters
to access the inbox. Gmail recommends turning off
any additional anti-spam or junk mail filters within
those clients to improve performance. However, this is
not enabled by default and some clients might not
allow different spam settings for several accounts.

Outlook.com

Outlook.com's spam filter is part of the Hotmail service. The test uses Hotmail's
default spam filter settings. Recipients can add senders to their address book to
prevent that future emails are sent to the spam folder. This option is not considered for this test.

Outlook 2003,
2007, 2010,
2013, 2016, 2019

Outlook's spam filters are part of the respecting Outlook desktop client of version 2003, 2007, 2010, 2013, 2016 or 2019. The test uses Outlook's default spam
filter settings.

Yahoo!

Yahoo!'s spam filter is part of the Yahoo! service. The test uses Yahoo!'s default
spam filter settings. Recipients can add senders to their address book to prevent that future emails are sent to the spam folder. This option is not considered
for this test.

Fastmail

Fastmail's spam filter is part of the Fastmail service. Recipients can add senders
to their address book to prevent that future emails are sent to the spam folder.
This option is not considered for this test.

GMX

GMX's spam filter is part of the GMX service. The test uses GMX's default spam
filter settings. Recipients can add senders to their address book to prevent that
future emails are sent to the spam folder. This option is not considered for this
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Client

Description
test.

Hushmail

Hushmail's spam filter is part of the Hushmail service. The test uses Hushmail's
default spam filter settings. Recipients can add senders to their address book to
prevent that future emails are sent to the spam folder. This option is not considered for this test.

Mail.com

Mail.com's spam filter is part of the Mail.com service. The test uses Mail.com's
default spam filter settings. Recipients can add senders to their address book to
prevent that future emails are sent to the spam folder. This option is not considered for this test.

Google Apps

Google purchased this service formally known as "Postini" and merged all of the
functionality into its Google Apps offering. Since then, few information in
regards to reasons for SPAM is available. Google Apps now only reports if an
email is considered "Spam" or "Phishy". If an email is marked as "Phishy" it will
also be marked as "Spam".

Apple Mail 10, 11

Apple Mail's spam filters are part of the respecting Apple Mail desktop client of
version10 or 11. The test uses Apple Mail's default spam filter settings.

Anti-spam filter test

Spam Assassin

The rating system of Spam Assasin consists of positive or negative scores, with
positive values indicating "spam" and negative values indicating "ham" (nonspam messages). By default, Spam Assassin considers a score over 5 to reflect a
probable spam message. However, this can be changed to a lower or higher
value depending on the recipient's spam restriction preferences.
l

Symantec Cloud

Symantec MessageLabs Email Security.cloud service combines advanced email
antivirus, antispam, and content filtering capabilities in a solution that requires
no on-site hardware or software.
l

Barracuda

Score < 5 is recommended

Score < 7 is recommended

Barracuda is a Gateway Appliance which eliminates spam and virus intrusions
while safeguarding an organization's reputation through content inspection

© Optimizely 2022

896 | Optimizely Campaign User Guide 2022-03-14

Client

Description
based on policy for both inbound and outbound email.
Barracuda Spam scores are as follows:
l

Score < 3.5 is recommended

l

3.5 – subject line gets modified.

l

6– message gets blocked.

l

10 – message gets quarantined.

Cloudmark

Cloudmark's spam filter is offered as an email client plug-in and gateway service. The test uses the default spam filter settings that is standard in either the
plug-in or gateway service.

Symantec Messaging Gateway
(formerly Brightmail)

Symantec Messaging Gateway service combines advanced email antivirus, antispam, and content filtering capabilities in either a hosted solution or a virtual
appliance.

Validation test

SPF

Sender Policy Framework (SPF) is an email validation system designed to prevent email spam by detecting email spoofing by verifying sender IP addresses.
SPF allows administrators to specify which hosts are allowed to send mail from a
given domain by creating a specific SPF record (or TXT record) in the Domain
Name System (DNS).

DKIM

DomainKeys Identified Mail (DKIM) is a method for associating a domain name to
an email message, thereby allowing a person, role, or organization to claim
responsibility for the message. The association is set up by means of a digital signature which can be validated by recipients.

Note: Optimizely cannot view nor influence the parameters used to
check the spam suspicion. The results of this analysis do not guarantee that your mailing will lead to the same ratings of a real mailing
dispatch. The reputation of Optimizely Campaign as an email service
provider is not considered in the analysis.
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Tip: To learn how to optimize your mailing, see Deliverability basics.

Post-click tracking
Note: This topic is for administrators and developers with administration access rights in Optimizely Campaign.
Post-click tracking lets you analyze actions by email recipients on your website. You can
see if a customer placed or canceled an order, viewed a product, and based marketing
actions on this information.
To integrate post-click tracking and use collected data in email marketing, every visitor
action must be assigned to a recipient with an email address. Post-click tracking and target
groups include these functions:
l

l

l

l

Date and time range selection. Configure post-click filters so that only post clicks generated in a defined time range or at a specific date are matched.
Autocomplete for product names. Input fields for product names or similar, are
designed as drop-down lists or with an autocomplete function, to ensure correct entries
when creating target groups.
Mailing-independent customer actions. Import post-click data not assigned to a mailing, but with an email address. For example, if a new customer orders for the first time
providing an email address, order details are available as post clicks in the target group
module when this customer registers for a newsletter.
Universal interface for integrating web analytics software. Integrate almost any web
analytics software in a unidirectional way, such as Google Analytics, eTracker, Adobe Analytics and Webtrekk.
Note: To correctly associate post-click tracking with a recipient list,
recipients must have at least a mailing ID and a recipient ID.
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Setup
In your Optimizely Campaign client
If post-click tracking is set up together with your client configuration, you can use one or
more post-click services (this is either Optimizely's post-click tracking or the web analytics
software you are using) in one client. If you are not sure that post-click tracking is configured in your client, contact customer support. For each post-click service, the desired
categories to be tracked are defined. Typical categories are purchased products, viewed
product, product group or numeric values like product price or revenue. Use these categories to define target groups or evaluate the success of mailings.

On your website
The proprietary post-click tracking uses tracking pixels, a transparent image file (GIF) of
one pixel width and height, which is loaded from a server when a customer clicks on a link.
Loading of the file will not be noticed, and when done, the URL of the tracking pixel and
attached parameters are submitted to the post-click tracking server.
The parameters represent the defined categories, the mailing ID (except for customer
actions where no mailing is necessary), and the recipient ID, usually the email address.
Integrate the tracking pixel on an appropriate page, such as the "thank you" page displayed after placing an order. The post-click tracking server stores the data in a database
available to Optimizely Campaign, together with the detected click time.
One tracking pixel can transmit up to 19 values (nine string values and ten numeric values).
One parameter is reserved as an identifier, ensuring that each post click is only tracked
once, such as when a page is reloaded.

Storing the SSL certificate
If the site where the tracking pixel is implemented uses an SSL certificate, the post-click
tracking also needs this. To order and store the certificate on Optimizely's server, provide
Optimizely with the following:
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l
l

l

l

A domain. Domain name, such as example.com, for which the certificate is issued.
A contact person from your IT department. First name, last name, company name,
address, CIP code, phone number, email address and fax address (if available).
A contact person for organizational issues. First name, last name, company name,
address, CIP code, phone number, email address and fax address (if available).
An administrative email address. For administering the certificate, must have the same
domain part as the domain the certificate is issued for. Example: If your domain is newsletter.example.com, the email address must be one of admin@example.com, administrator@example.com, hostmaster@example.com, or webmaster@example.com. Note that
only the local parts admin, administrator, hostmaster or webmaster are allowed.

Creating a tracking pixel
A tracking pixel consists of an image URL, which is added to your website:
<img src="{url}" width="1" height="1" alt="" border="0">

The placeholder {url} must be replaced by the actual URL, to which the submitted parameters are attached. You can create a tracking pixel with or without a cookie.

Tracking pixel with cookie
When a mailing recipient clicks on the tracking link, a cookie is created that contains recipient data such as recipient ID and mailing ID. You can use additional parameters for the
tracking pixel, for example to attach product names, prices and item numbers.
In the example, replace news.example.com with your URL.
http://news.example.com/pc
?mg=1234567890&bi=0&service=default
&fvalue1=[product ID]
&fvalue2=[number of items]
&fvalue3=[price]
&gvalue1=[category1]
&gvalue10=[order number+product ID]

© Optimizely 2022

900 | Optimizely Campaign User Guide 2022-03-14

Parameters
l

l

l

l

l
l

mg. Mailing group. Submits the ID of your Optimizely Campaign client. To see the client ID,
open the Optimizely Campaign menu and select Administration > API Overview > REST
API.
bi. Browser identifier. Is set to 0 by default. The user agent of the browser is used. If you
have a proprietary implementation identifying the user agent, you can submit the value
with this parameter.
service. Identifies the post-click service to be used. In this example, the proprietary Optimizely Campaign post-click tracking (default) is used.
fvalue1 to fvalue10. Can be used to submit ten different numeric values (example names
in brackets).
gvalue1 to gvalue9. Can be used to submit categories (string values).
gvalue10.Is reserved for the identifier, for example shopping cart ID. If multiple tracking
pixels are used for each product, this identifier must also contain the product ID, to differentiate the tracking pixels.
Note: The identifier is an indispensable parameter that assures
the creation of unique post-click data. Missing or incorrect identifiers may cause data loss or incorrect sales figures.

Use case
A common use case is tracking of sales figures like revenue, number of bought items, order
number, and shopping cart ID. Place a tracking pixel on the order placement page. Only
one tracking pixel is necessary. The URL, including attached parameters, is as follows:
/pc?mg=1461858149&bbi=0&service=default&fvalue1=20.0&fvalue2=3&fvalue3=8866442211&gvalue1=
mark.spencer@example.com&gvalue10=1234567890
l
l
l

/pc?mg=1461858149&bi=0&service=default&fvalue1=20.0 = Revenue
&fvalue2=3 = Number of bought items
&fvalue3=8866442211 = Order number
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l
l

&gvalue1=mark.spencer@example.com = Customer's email address
&gvalue10=1234567890 = Shopping cart ID

For more data, you can load a tracking pixel for each item bought. The URL used for the
tracking pixel is identical for each tracking pixel; only the attached parameters are different. With this setting, post-click data for product ID, product name, and price, can be
submitted. The tracking pixel URL is the same as in the example above. An additional parameter with the product ID (fvalue) and/or the product name (gvalue) is submitted.

Tracking pixel without cookie
If you use a tracking pixel without a cookie, you must append the mailing ID and recipient
ID directly as parameters. You send the data to Optimizely Campaign, where you can analyze it as a post click. You can use additional parameters for the tracking pixel, for example,
to attach product names, prices and item numbers.
In the example, replace news.example.com with your URL.
http://news.example.com/pc
?type=userEvent
&authToken=[Autorisierungs-Code]
&service=default
&recipientId=[Empfänger-ID]
&mailingId=[Mailing-ID]
&fvalue1=[Artikelnummer]
&fvalue2=[Anzahl]
&fvalue3=[Einzelpreis]
&gvalue1=[Kategorie1]
&gvalue10=[Bestellnummer+Artikelnummer]

Parameters
l

l

type. Identifies the tracking pixel type. The userEvent type does not contain a cookie with
additional recipient data.
authToken. Authorization code for the data transfer to Optimizely Campaign. To see the
authorization code, open the Optimizely Campaign menu and select Administration > API
Overview > Post-Click Tracking. You can find the authorization code in the User Event
Basic URL.
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l

l
l
l

l
l

service. Identifies the post-click service to be used. In this example, the proprietary Optimizely Campaign post-click tracking (default) is used.
recipientId. Recipient ID, usually the email address.
mailingId. Mailing ID.
fvalue1 to fvalue10. Can be used to submit ten different numeric values (example names
in brackets).
gvalue1 to gvalue9. Can be used to submit categories (string values).
gvalue10. Is reserved for the identifier, for example shopping cart ID. If multiple tracking
pixels are used for each product, this identifier must also contain the product ID, to differentiate the tracking pixels.
Note: The identifier is an indispensable parameter that assures
the creation of unique post-click data. Missing or incorrect identifiers may cause data loss or incorrect sales figures.

Working with post-click data
Note: Third party web analytics programs
To create reports and analyses with third party web analytics programs, use the web interface of the respective program. See the
respective user documentation for reporting options.

Analyzing and monitoring mailing campaign success
Use Optimizely Campaign Deep Analytics to add a post-click measure to a report:
1.
2.
3.
4.

Create or edit a report template or an ad-hoc report, see Deep Analytics.
In the Report Data tab, click + Add measure.... and then Post Click....
In the Name box, enter a name for the post-click measure.
If using more than one service (provider), select the provider from the Service dropdown list.
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5. In the Value drop-down list, select whether the measure you want to create is a number, a sum or an average.
6. If you have selected Sum or Average in the previous step, select a post-click value
from the drop-down list. If you do not want to filter this value further, the definition can
be saved. If you have selected Number in the previous step, no filters can be added.
7. To add filters, in the Filter area, click Add +.
8. In the Category drop-down list, click a post-click value/category and select an operator. Options depend on whether the selected post click is a number or a string value.
9. Enter a reference value to compare the post-click value with.
10. Click Apply ✔ .
11. To add further filters values, click Add + and repeat the previous steps.
12. Click Save.
13. Continue editing the template/ad-hoc report as described in the user documentation,
and execute the report.

Example: Create the post-click measure Men's fashion revenue
1. In the Value drop-down list, click Sum and then in the of drop-down list, click Revenue.
2. In the Filter area, click Add +.
3. In the Category drop-down list, click Shop category and select the equals operator.
4. Enter the reference value Men's fashion.
5. Click Apply ✔ .
6. Click Save.
Note: The example requires that a parameter with the shop category is passed in your tracking pixel.

Filtering target groups with post clicks
Do the following to create a target group with a post-click filter:
1. Open the Optimizely Campaign menu and select Recipients > Target Groups.
2. Click Create.
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3. In the Name box, enter a name for the target group and in the Target Group area,
click Add +.
4. In the second drop-down list, click Action.
5. In the following drop-down list, click has created post click.
6. If using more than one service (provider), select the provider from the Service dropdown list.
7. To only consider post clicks created from mailings, select the mailings from the Mailing
drop-down list. If no mailing is selected, both mailings and actions not created from a
mailing (customer actions) are considered.
8. Select a date or time in the Period drop-down list to select only post clicks created
within a defined time range or at a certain date. Time entered as a number of days
("Exactly 30 days ago") refer to the current day.
9. In the Category drop-down list, click a post-click value/category and select an operator.
10. Enter a reference value to compare the post-click value with.
11. Click Apply ✔ .
12. To add further filters values, click Add + and repeat the previous steps.
13. Click Create.

Example: Create the target group "Buyers—Men's fashion"
To define a target group that contains buyers of men's fashion of the first quarter of 2022,
do the following in the Create target group window:
1. In the Name box, enter Buyers—Men's Fashion and in the Target Group area, click
Add +.
2. In the second drop-down list, click Action and in following drop-down list, click has
created post click.
3. In the Period drop-down list, click From...until... and select the period from 1 January
2022 to 31 March 2022.
4. In the Category drop-down list, click Shop category and select the equals operator.
5. Enter the reference value Men's fashion.
6. Click Apply ✔ .
7. Click Create.
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Note: The example requires that a parameter with the shop category is passed in your tracking pixel.

Visual link analysis
The visual link analysis shows how often each link in a mailing is clicked. The analysis data
is displayed directly over a screenshot of the original mailing to reveal correlations that
might not be obvious, such as if recipients tend to click links in a certain area.
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To create a visual link analysis, perform the following steps:
1. Open the Optimizely Campaign menu and select Analytics > Visual Link Analysis. The
Visual Link Analysis window opens.
2. Click the Mailings box and the mailing you want to analyze.
3. In the Show Click Rate drop-down list, click the type of clicks you want to analyze:
l
l

All clicks. Each click is counted, including multiple clicks from the same recipient.
Unique clicks. Multiple clicks from the same recipient on one URL are only counted once. If a recipient clicks on different links to the same URL (such as text and
image), this is one unique click also, because not the link itself, but the URL to
which it links, is decisive.
Note: Calculation of the unique click rate
The unique click rate for each link is calculated in relation to the
total number of unique clicks on each link in the mailing. This differs from the unique click rate of the whole mailing, as given in
the mailing report.
In the visual link analysis, one recipient can generate one unique
click for each link in the mailing. The total number of unique
clicks is usually higher than the total number of unique clicks as
given in the mailing reports, because some recipients click various links in the mailing. The percentage of unique clicks for each
link is calculated in relation to this number. Note that unique
clicks in the overall mailing report and unique clicks in the visual
link analysis are not identical, since they are calculated differently.

4. In the Reference Parameter list, click the reference value you want to use to display
the attractiveness of the individual links:
l

l

Percent of all recipients. Shows the clicks on a link in relation to recipients of the
mailing.
Percent of all (unique) clicks. Shows the clicks on a link in relation to unique
clicks on links of the mailing.
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Percent of all recipients/(unique) clicks. Shows the clicks on a link in relation to
unique clicks on links in the mailing and in relation to recipients of the mailing.
5. If your client is set up for post-click tracking , in the Additional Data list, you can
select the post-click option. It shows the post-click actions created from each link,
such as the number of items bought. The data shown in this option depends on the
kind of data tracked via post-click tracking.
6. Click Show. The visual link analysis is started.
7. To show only elements assigned to specific target groups, click Target Groups…,
select one or more target groups, and click Submit Selection. In the background, a
screenshot of the mailing is shown. Over each link, the respective numbers (clicks and
percentages) are shown.
l

Tip: You can switch between versions of your mailings by clicking the
appropriate tab (HTML, Mobile and Text). Optionally, you can save
the analysis result by clicking Save result as image.
The box also has a color indicator: White means a link has not been
clicked; yellow indicates a low click rate, orange medium click rate,
while red means frequent click rate.

Note: Multiple links with the same link target
Multiple links to the same URL, such as an image and a text link, are
not analyzed separately. That is, the total number of clicks/unique
clicks is shown for each link item to the same URL. You cannot
determine if recipients preferred clicking an image or a text link to
the URL.

Visual link analysis of post clicks
Note: To enable this feature, contact customer support.

© Optimizely 2022

Analytics | 909

The visual link analysis feature displays a graphical representation of post clicks. You can
configure several post-click parameters, such as item price, item number, or total price.
The selected parameters are displayed as a sum, average, or quantity. This allows various
analyses to be visualized, such as:
l
l
l

Total revenue generated by a link
Average revenue generated by a link
Number of orders resulting from a link

Attention analysis
Using the attention analysis, you can test the usability of your mailings, templates or drafts
before sending them out. A graphical analysis lets you check if crucial elements (logo, callto-action, promotional offers) are placed to immediately draw a viewer's attention.
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To access Attention Analysis, open the Optimizely Campaign menu and select Analytics >
Attention Analysis. The overview shows how many analyses you created, and a list of created and requested analyses.

How it works
Attention analysis forecasts the first seconds of viewing a mailing. Like any image, upon
first glance, an email scanned by the human eye. During scanning, the focus rests several
times on the fixation points. Image information is processed subconsciously at this time.
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The Optimizely Campaign attention analysis is not a semantic analysis; that is, it does not
analyze the meaning of words, the content of images, and so on. It analyzes visual, physical
stimuli and deduces how much attention each item and area of the image receives.
Each analysis consists of more than 50 image properties, such as colors, brightness, contrast, size, position, color saturation, outlines, and textures. This data is processed to forecast the viewing behavior. The forecast model was designed using attention signatures of
real, test persons. WhiteMatter Labs develops and verifies this model constantly. The result helps to optimize size, color, and placement of items to make them more eye-catching.

EyeQuant Software by WhiteMatter Labs
Attention analysis is based on the EyeQuant Software developed by WhiteMatter Labs.
WhiteMatter Labs is a spin-off founded by Prof. Dr. Peter König, one of the leading
European neuroscientists from the University of Osnabrueck. WhiteMatter Labs makes the
results of long-term fundamental research usable in marketing.
Until this time, analyzing user behavior meant conducting expensive eye tracking studies
with large sample sizes. With EyeQuant, real test persons are no longer necessary. Neuroscientific models allow forecasting of viewing patterns within seconds. The attention analysis is specifically developed to analyze newsletters, websites, and related items. The
seamless integration in Optimizely Campaign lets you run Attention Analysis as an part of a
continuous optimization process for mailing campaigns:
l
l
l

Evaluation of different design drafts at the first stage
Pre-test of templates, landing pages and micro sites
Testing of special design elements in the course of perception

Validity
The forecast model of attentional deployment is based on a statistical evaluation of more
than 15,000 tested images. The viewing behavior of more than 300 test persons is analyzed to create attentional signatures and to calibrate the model. A comparative study
with empirical eye tracking data on the predictive power has found a high correlation of
both – empirical data and computed data. While eye tracking studies reached a predictive
accuracy (that is, correlation of forecast and effective eye movement) of approximately
90%, automatically created attention analyses reached about 85%.
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Predictive power (in percent)
red = EyeQuant model
gray = Eye tracking study

Creating attention analyses
You can create attention analyses based on an uploaded screenshot or a mailing or landing page.

Analyzing a screenshot
Note: Attention analyses have additional costs. For more information,
contact customer support.
1. In the Attention Analysis window, click New Analysis…. The New Attention Analysis
window opens.
2. Click Screenshot Upload and then Select.
3. Click Browse… and select the screenshot from your local hard disk.
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4. Optionally, enter a description of the analysis and click Preview.
5. If you are satisfied with the screenshot shown in the preview, click Start Analysis.
l
l
l

Maximum file size: 5 MB
Supported formats: PNG, JPEG, BMP and GIF
The image is scaled automatically. This may result in very small images, for
instance if the original page orientation is an extreme portrait.

Analyzing an existing mailing or landing page
Note: Attention analyses have additional costs. For more information,
contact customer support.
1. In the Attention Analysis window, click New Analysis…. The New Attention Analysis
window opens.
2. Click Mailing then Select.
3. In the mailing overview, select the mailing you want to analyze. To analyze a landing
page, you must also select the mailing with which it is associated.
4. In the Mailing Part to Analyze area, in the list, select the mailing or the landing page.
If you have not created any landing pages for your mailing, the mailing is the only
option in this list.
5. Optionally, enter a description of the analysis and click Preview.
6. If you are satisfied with the screenshot shown in the preview, click Start Analysis.
After a few seconds, the analysis is available. You can select between the following
modes:
l

Perception Map. The first layer of the attention analysis shows which areas gain
most attention in the first moments of perception. These areas should contain
logos, specially formatted product information, and so on. Small areas mean more
focused attention, while larger areas indicate a more dispersed attention. Images
with little contrast in color and brightness probably disperse the initial attention
more widely.
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l

Attention Map. The second layer analyzes the attentional potential of the elements in the overall context of the mailing. Red and yellow areas indicate a high
attentional potential, while blue and turquoise areas indicate a low attentional
potential. Items with red and blue parts have a high attentional potential, because
they are perceived as one item. As said above, a high contrast between an item
and the background leads to a more focused attention.
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Tip: Attention analysis is based upon universal laws of perception.
But some aspects, such as the perception of an image from above
left to below right, are cultural patterns so only apply to occidental
viewers.

Displaying a previously-generated analysis
1. Open the Optimizely Campaign menu and select Analytics > Attention Analysis. The
overview displays generated analyses.
2. To view the result, click an analysis in the Analyses list, then either Perception map or
Attention map.
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Interpreting results
Attention analysis gives useful indicators on how to optimize mailings or landing pages:
l
l
l

Are products you want to promote in the newsletter eye-catchers?
Is the product information (description, image, price) properly placed and grouped?
Are the calls-to-action integrated in the perception path, so a viewer can follow them easily?

Too much attention might have a negative impact on the mailing performance:
l
l
l

Less important items might be more eye-catching than other, more important items.
The viewer might be distracted by too many items with a high attentional potential.
Very eye-catching items might appear too blatant for certain recipients.

Optimizing options
l

l

l

l

l
l

l

l
l

Strong contrasts of fore- and background attract the attention. Contrasts can be achieved
through brightness (black/white) and through colors.
Complementary colors (for example red/green) create a higher contrast and more attention than colors that lie closer in the color space.
Images are more eye-catching when the background is masked and uncolored (high figure-background contrast).
The general attention path in the occident goes from the top left to the lower right. You
can follow this pattern or break it up intentionally using an eye-catching item.
The left upper corner gains high attention. Usually, logos are placed here.
A second area that gains particular attention lies between the left upper corner and center. This area is often the viewer's point of entry.
Grouping eye-catching items with less eye-catching ones (relative positioning) can
heighten the attention for all items. For example, to make an item more eye-catching,
place it close to an item that receives a lot of attention.
To heighten attention for an item, place it in a "calm" environment.
Less is more. Few eye-catching items may be better than too many. The more eye-catching items you place in your newsletter, the more they compete against each other.
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Optimization example
This sample newsletter, at first glance, is clearly structured and well-arranged. The title is
eye-catching, but the attention analysis shows that only one of the three promoted
products below receives some attention. The product price, although in red, is not focused
on by the viewer:

Initial design
The analysis perception map shows a focus on the first product shown.
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This is an optimized version of the same newsletter. Some changes are made: The price is
positioned closer and top-left to the product. Instead of the red font, an inverted font, similar to the title, is used. These changes cause a significant shift of attention:
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Optimized
The perception is equally distributed on the three products – a focus is on the prices.
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Activity overview
Note: To enable this feature, contact customer support.
The activity overview shows mailings for a defined period. The view's information helps you
evaluate marketing activities, such as which customer dialogs you have sent, are currently
sending, and are about to send. Transactional mails, registration confirmations and running
Marketing Automations are also supported.
If your company has subsidiaries, branches, or affiliate companies, you can plan, steer, and
control campaigns from your branches and associated companies using the activity overview.
The activity overview display has four areas:
l

Area 1. Select one or more clients.

l

Area 2. Select the period.

l

Area 3. Filter mailings by mail type, media type (marketing channel), and mailing status.

l

Area 4. The activity overview shows a content preview of a selected mailing, opens a cam-

paign analysis, switches to the edit window of a selected element or pauses/deactivates a
campaign or a mailing.
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Area 1: Select client
1. Open the Optimizely Campaign menu and select Analytics > Activity Overview. The
Activity Overview window opens.
2. In the Select Clients list, choose one or more clients to display in the overview.
l

l

The client you to which are logged in is selected. To stop analyzing this client, clear
the corresponding check box.
If you want to select clients of your user account, select the check box on the
upper left, in the list header.

Area 2: Select period
To select the period for which to display marketing activities, perform one of the following
steps.

l

Click a button: last 30 days, last 14 days, last 7 days, current week, next 7 days, next
14 days or next 30 days.
Select the Start Date and End Date with the date selector.

l

Drag the date slide to the desired start and end dates.

l

Note: Entering a time period has no effect on the action data displayed (openings, clicks, bounces, subscription cancellations) nor
on the number of recipients shown in the transactional mail and
registration confirmation overviews. The action data displayed
and the number of recipients represent the value for the entire
time period in which a transactional mail or registration confirmation is, or was, active.

Area 3: Filter mailings and campaigns
To filter for campaigns and messages, media type (marketing channel), or mailing status,
perform the following steps:
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l

Campaigns and Messages. Select mailings or Marketing Automation campaigns.
Tip: Transactional mails include Marketing Automation mailings.
To include mailings from Marketing Automation campaigns in the
activity overview, check the box next to Transactional Mails.

l
l

Media Types. Select media types to include in the activity overview.
Mailing Status. Select the mailing statuses to include in the activity overview.

Area 4: Open activity overview and other features
If you selected at least one client, mailing type, media type (marketing channel) and mailing status, the activity overview appears in area 4. The activity overview is automatically
updated if you change settings in areas 1, 2 or 3.
The following buttons let you perform actions on the overview.
l
l

l

Preview. Mark the mailing that you want the content preview to show and click Preview.
Analysis. Mark the campaign for which you want to open the campaign analysis and click
Analysis.
Edit. Mark the element for which you want to open the edit window and click Edit….
Note: This function only applies to mailings that have not been
sent yet.

l

Pause.
o

Smart Campaigns: In the Smart Campaigns Messages overview, select messages in
status Sending. Click Pause. Paused mailings can only be restarted in the Smart Campaigns overview of the corresponding client.
Note: Mailings that have not started yet will only be displayed if the corresponding campaign has a Wait- or A/B
test node with a send date within the selected time period.

o

Marketing Automation: In the Marketing Automation Campaigns overview, select
campaigns in status Running. Click Pause. Paused Marketing Automation campaigns
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can only be restarted in the Marketing Automation overview of the corresponding client.
Note: The time period you selected in area 2 will be ignored
when filtering Marketing Automation campaigns.
l

Deactivate. In the Smart Campaigns Messages overview, select mailings in status Activated. Click Deactivate.
Note: When deactivating a mailing, the complete campaign the
mailing belongs to and all of the campaign's mailings will change
status to Activation required. The campaigns can only be reactivated in the Smart Campaigns overview of the corresponding client.
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Integration and interfaces
This section describes Optimizely Campaign’s integration options and interfaces. You can
find information on how to link your web shop, CRM, web analytics program or product
database with Optimizely Campaign. Also, this section explains how to control Optimizely
Campaign from an external system.
l

Optimizely platform. Supporting the entire digital marketing chain.

l

E-Commerce. Link to e-commerce systems.

l

Web analytics. Link to web analytics applications.

l

CRM. Link to CRM systems.

l

Translation interface. Create multilingual mailings.

l

Closed-loop Interface. Link to data warehouses.

l

File exchange via SCP. Load files onto the Optimizely server via SCP( Secure Copy Pro-

tocol).
l

Webhooks. Send event data in real time.

l

API overview. Access specific information required for integrations.

l

l

l

l

REST API. Configure and use the REST API (Optimizely Campaign Developer Guide on
Optimizely World).
SOAP API. Configure and use the SOAP API (Optimizely Campaign Developer Guide on
Optimizely World).
HTTP API. Configure and use the HTTP API (Optimizely Campaign Developer Guide on
Optimizely World).
SMTP API. Control dispatch via SMTP API (Optimizely Campaign Developer Guide on
Optimizely World).

Optimizely Platform
Integrate Optimizely Campaign with other features of the Optimizely Digital Experience Platform (DXP) to create customer-centric experiences. For example, use product data from
Optimizely Commerce for your mailing campaigns, visitor profiles from Optimizely Visitor
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Intelligence for target groups in Optimizely Campaign, or personalized product recommendations for shopping cart abandoners.

Optimizely Commerce
The Optimizely Commerce integration lets you import the latest product data into Campaign, and make catalog content available when adding product recommendations to mailings. The content interface paragraph imports product data such as offer texts and product
images, from your e-commerce system into the Template Kit.
To get the product data into Optimizely Campaign, you set up a periodic transfer of the
latest product data from Optimizely Commerce. For more information, see Commerce-Campaign integration on Optimizely World.

Optimizely Connect for Campaign
With this extension, you can connect Optimizely Campaign with Optimizely CMS and
Optimizely Forms, to collect visitor data entered in website forms, and pass that on to be
used in mailings. For more information, see Connect for Campaign on Optimizely World.

Optimizely Visitor Intelligence
Optimizely Visitor Intelligence is a user interface for viewing and filtering visitor profiles,
and creating customer segments that you can use in your omnichannel marketing campaigns. The Optimizely Visitor Intelligence information is based on tracking of online visitor
behavior, such as viewing content or products. For more information, see Optimizely Visitor
Intelligence on Optimizely World.

Optimizely Email Product Recommendations and Triggered
Messages
You can use Optimizely Email Product Recommendations and Triggered Messages to create triggers for sending automated personalized emails through Optimizely Campaign.
These transactional mails are initiated by on-site actions of an email recipient, for example
abandoning a shopping cart on an e-commerce site. For more information, see Personalization on Optimizely World.
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E-commerce integrations
This topic gives an overview of e-commerce integrations with Optimizely Campaign. You
can synchronize recipient data and import product data directly into your message template, using the power of Optimizely's sending infrastructure. Registration of new recipients and management of your product data are carried out as usual in your e-commerce
system. Data is synchronized automatically and imported into your Optimizely Campaign
client, making it easy to manage cross- and up-selling offers in mailings, or to design
remarketing campaigns with personalized recommendations.
See the E-commerce integration guide for an introduction to working with Optimizely
Campaign and e-commerce systems.

Optimizely Commerce
Manage product content and discounts from one user interface, and import catalog content into Optimizely Campaign. With the Campaign-Commerce integration you can import
the latest product data into Optimizely Campaign, and access catalog content when
adding product recommendations to mailings. See Optimizely platform.

Other e-commerce systems
Integration

Magento 1

Magento 2

Shopware

Spryker

Recipient management via
Optimizely Campaign

✓

✓

✓

✘

Recipient status synchronization

✓

✓

✓

✘

Product data import

✓

✓

✓

✘

Opt-in process via Optimizely
Campaign

✓

✓

✓

✓
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Integration

Magento 1

Magento 2

Shopware

Spryker

Unsubscribe management via
Optimizely Campaign

✓

✓

✓

✓

Transactional mails via Optimizely Campaign

✓

✓

✓

✓

Setup

Setup

Setup

Setup

E-commerce integration guide
This section provides an introduction to working with Optimizely Campaign, and integrations with e-commerce systems.
Using Optimizely Campaign, you can register advertising consents for receiving newsletters in your e-commerce system, send transactional mails, and import product data and
use it for mailings.
l

l

l

Opt-in management. Incoming newsletter registrations in the web shop are processed via

Optimizely Campaign. Optimizely Campaign handles the opt-in and opt-out processes,
and the dispatch of confirmation e-mails.
Transactional mails. Optimizely Campaign provides API operations for sending individual
emails (order confirmations, registrations, and so on). For this purpose, separate transaction recipient lists are created, whose structure and fields you can define. You benefit
from the increased delivery rates when sending via Optimizely Campaign and you can
design the transactional mails in Optimizely Campaign yourself.
Product data import. Transfer the product catalog of your web shop via content interface
into Optimizely Campaign including images, links and prices. When creating a newsletter,
you can simply insert this product data into the mailing.

Using the HTTP API
Optimizely Campaign's HTTP API provides all the functionality needed to manage opt-ins
and send transactional mails. You can trigger double opt-in processes, uptdate data in a
recipient list, remove a recipient from a list and send transactional mails.
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Clients and recipient lists
An Optimizely Campaign client can contain one or more recipient lists which you use to
store recipient data and for transactional mails.
Note: Contact customer support for the setup and configuration of
recipient lists.
You can use the HTTP API to manage recipients; add recipient data to a recipient list,
update and remove recipients from the list. You can retrieve values of the recipient list
fields, such as first name and last name, using field functions and use them in mailings. You
can use field functions to personalize your mailings; Hello { salutation} {surname} becomes
for example Hello Mrs. Miller.
In addition to recipient lists, a client can contain mailing templates which are used for the
mailing design. A client is also used to handle opt-in and opt-out processes.

Accessing the HTTP API
You access the HTTP API via the endpoint api.campaign.episerver.net/. In the
developer documentation of the HTTP API on Optimizely World, in the Basics section under
Formatting rules, you can find information about the valid number and date formats.
You usually request the API with a program or via a program library such as cURL. For testing, you can also enter the API request directly in the address line of your web browser.
You use the POST method to send data and the GET method to retrieve data.
A complete API request has the following structure:
https://api.campaign.episerver.net/http/[Service]/[AuthorizationCode]/
[Operation]?[Parameter]
l

l

Service. Use the form and mail services to connect shop systems and manage profile data.
See Services and operations on Optimizely World.
AuthorizationCode. Use the authorization code to authorize access to the API and the
recipient list associated with the code. To see the authorization codes of your recipient
lists, open the Optimizely Campaign menu and select Administration > API Overview >
Recipient lists.
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l

l

Operation. Specify which action the API request should trigger. For example, subscribe is
used to make a subscription and trigger an opt-in process. With sendtransactionmail you
send a transactional mail.
Parameter. You must specify the parameters of the API request correctly. Besides the
parameters that are mandatory for the operation, such as bmRecipientId for the subscribe
operation, you can also specify the names of recipient list fields, for example lastname=Meier.
Tip: The HTTP API uses ISO-8859-1 encoding by default. You can
change the encoding by assigning the value utf-8 to the bmEncoding parameter.

For testing you can use the nop operation. The nop operation only accepts parameters,
but does not perform any action. You can use the following request to test the network
connection between the shop or test system and Optimizely Campaign:
https://api.campaign.episerver.net/http/form/1234567890/nop?parameter=wert&bmEncoding=utf-8

Information in the API overview
You can find the information required to use the HTTP API in the API overview.
l

l

l
l

Recipient list ID. Open the Optimizely Campaign menu and select Administration > API
Overview > Recipient lists.
AuthorizationCode. Open the menu and select Administration > API Overview > Recipient lists. Select a recipient list and click Manage authorization codes.
Client ID. Open the menu and select Administration > API Overview > REST API.
Opt-In-Prozess-ID (bmOptinId). Open the menu and select Administration > API Overview > Opt-in processes.

Managing opt-ins
Let your customers subscribe for or unsubscribe of newsletters in your web shop. The data,
which includes not only the email address but also other customer data such as name,
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address or areas of interest, is written in fields of the Optimizely Campaign recipient list.
You can update this data afterwards.
Your shop system is considered the leading system that collects the data and forwards it
to Optimizely Campaign. In the case of opt-in and opt-out processes, you must ensure that
the customer is logged in or out of the web shop after clicking the respective confirmation
link. This is done, for example, via a confirmation page, which you use to process an additional recipient ID parameter.

Structure of the recipient list
To adjust the structure of the recipient lists in Optimizely Campaign, you define in advance
which user data from your shop system should be synchronized with Optimizely Campaign.
Contact customer support to configure the recipient list so that the names of the recipient
list fields conform to Optimizely conventions.
In addition to the email address and the personal data, the recipient list must contain an ID
field to identify the data record in the shop system. You should ideally use a coded hash
value.
Specify the bmOptinSource field, which indicates the source of the opt-in. Enter a string
such as ShopSystem/ShopName/Version, for example WebShop/Shoe Shop/1.1.2.

Overview of the opt-in process
If a customer is to register for a newsletter from the shop system, the opt-in process consists of the following steps:
1. Your shop system requests the Optimizely Campaign HTTP API and initiates the opt-in
process. In addition to the email address, an ID is also transferred to identify the data
record in the web shop.
2. Optimizely Campaign sends the recipient an email requesting to confirm the registration by clicking a confirmation link.
3. The recipient clicks on the confirmation link.
4. Optimizely Campaign registers the confirmation and the recipient appears in the optin recipient list.
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5. Optimizely Campaign redirects the recipient via HTTP forwarding to the web shop and
adds the parameter used to identify the data record in the web shop to the URL; for
example https://www.example.com/newsletter/success?id=781278TZ.
Note: You must provide the URL of the confirmation page for the
opt-in process in Optimizely Campaign in advance.
6. The integration in the web shop accepts the request under /newsletter/success and
accesses the value of the id parameter. Using the value 781278TZ, the customer record
is identified and added to the newsletter recipients in the shop system.
Note: You must generate and temporarily store the ID for identifying
the customer data record in the shop system. This ID is stored in the
Optimizely Campaign recipient list.

Initial recipient data transfer and start of the opt-in process
To add a recipient to a recipient list and initiate an opt-in process, the API operation subscribe is requested with the parameters bmRecipientId and bmOptInId. Furthermore, the
bmOptinSource field should be specified with the source of the opt-in, for example
WebShop/Shoe Store/1.1.2. The customer-id field contains the ID of the customer record.
You can append other fields from the recipient list as parameters and use them to personalize the mailing, for example, salutation, firstname and lastname.
Sample HTTP request:
https://api.campaign.episerver.net/http/form/[AuthorizationCode]/subscribe?bmRecipientId=abc@example.com&bmOptInId=987654321&customerid=1234ABCD&salutation=Mr.&firstname=John&lastname=Smith&bmOptinSource=WebShop/ShoeStore/1.1.2
The bmRecipientId parameter is the primary key of the recipient list (usually the email
address). The bmOptInId parameter specifies the opt-in process to be triggered. The opt-
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in process contains the mailing for registration confirmation configured in the client and
the URL of the confirmation page to which the recipient is forwarded.

Confirmation link and confirmation page
You must include a confirmation link in the opt-in mailing as field function {Double-OptIn-Link}. See Opt-in processes.
The field function is converted to an individual confirmation link of the recipient and the
customer-id parameter is added: {Double-Opt-In-Link}?customer-id={customer-id}.
Tip: The customer-id parameter contains the respective value of the
opt-in recipient list.
When the mailing recipient clicks on the confirmation link, the recipient is redirected to
the provided confirmation page: https://www.example-shop.com/newsletter/success?customer-id=8122.
You must configure the integration in the shop system in such a way that when the /newsletter/success path is requested, the value of the customer-id parameter is read and used
further within the shop system.
You can add further parameters to the confirmation link, as long as your recipient list contains the respective fields. For example, if your recipient list contains the field shop-id, you
can add the shop-id parameter to the confirmation link: {Double-Opt-In-Link}?customer-id={customer-id}&shop-id={shop-id}.

Unsubscribe link and confirmation page
While you can create several opt-in processes in one client, only one unsubscribe link is
configured per client.
The unsubscribe link is placed in a proper place in the mailing (for example in the footer)
so that the recipient can unsubscribe from the newsletter with just one click.
Like the confirmation link, the unsubscribe link first redirects the recipient to Optimizely
Campaign to register the unsubscription. The recipient is then redirected to a confirmation
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page. To add or change the URL of the confirmation page, see Changing the confirmation page URL.
You can also add further parameters to the unsubscribe link if your recipient list contains
respective fields: https://www.example.com/newsletter/unsubscribe?customer-id={customer-id}&shop-id={shop-id}.
You have to configure the integration in your shop system in such a way that a request for
the path /newsletter/unsubscribe results in a unsubscription of the recipient customer-id.
Depending on the system, you can also use the shop-id parameter to address a specific
web shop or subpage. Both customer-id and shop-id are already known to the shop system, since both values were written to the recipient list by the shop system when the recipient logged on.

Updating customer data
If a customer changes his or her data in the web shop (for example, address or telephone
number), you can update the fields in the recipient list using the HTTP API request updatefields. The email address is used as the primary key for identification (bmRecipientId parameter): https://api.campaign.episerver.net/http/form/
[AuthorizationCode]/updatefields?bmRecipientId=abc@example.com&city=Boston&zip=02108.
With the API request you change the values of the recipient list fields city and zip to
Boston and 02108 for the recipient abc@example.com.

Removing recipients from a recipient list
If a recipient unsubscribes a newsletter from within your web shop, for example via a link or
a checkbox, you can register this unsubscription in Optimizely Campaign using the unsubscribe operation: https://api.campaign.episerver.net/http/form/[AuthorizationCode]/unsubscribe?bmRecipientId=abc@example.com.
The bmRecipientId parameter uniquely identifies the recipient by his or her email address
and the API request unsubscribes the recipient from the newsletter. The recipient is
entered in a separate unsubscribe list and is no longer contacted. See Unsubscribers.
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Sending transactional mails
You can send transactional mails using the HTTP API operation sentransactionmail. The
recipient's email address is specified with the bmrecipientId parameter and the transactional mail to be sent is defined with the bmMailingId parameter.
Tip: To see the mailing ID, open the Optimizely Campaign menu and
select > Campaigns > Transactional Mails.
You can also add additional parameters for salutation, first and last name, web shop and
language of the recipient: https://api.campaign.episerver.net/http/form/1234ABC/sendtransactionmail?bmRecipientId=abc@example.com&bmMailingId=1234567&ssalutation=Mr.&firstname=John&lastname=Smith&shopname=ShoeStore&language=en.
If you use the operation onlineversion instead of sendtransactionmail, you can open the
transactional mail directly in the browser. This resolves all field functions. You can use this
operation to test the encoding of the values and the design of the mailing without sending
yourself an email for each test.
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Using field functions
When sending transactional mails, personalized mailing content is transferred to the transaction recipient list using the parameters of the HTTP request and inserted at the respective position in the mailing using field functions.
Text with field functions:
Hello {salutation} {firstname} {lastname}, thank you for your registration in our web shop
{shopname} on {registerdate}.
Text with personalized content:
Hello Mr. John Smith, thank you for your registration in our web shop ShoeStore on 202201-01.
The field function {registerdate} reads the value of the field Registration time and specifies
it in the mailing without time.

Importing product data
Using the content interface, you can import the product catalog of your web shop directly
into Optimizely Campaign. The products contained in the catalog are available when you
create a mailing. In addition to the product name, you can also insert images, links, prices,
and descriptions directly into the mailing. The product data import is usually done via a
predefined CSV file, which is transferred daily via SFTP to the Optimizely Campaign server.

SFTP data transfer
The SFTP protocol is used for data transfer. To transfer data, you must connect to the
Optimizely Campaign server using an authentication key. The shop integration must therefore support working with authentication keys. See Transferring files through SCP.
If you have a PHP-based shop system, you can for example use the phpseclib library
(http://phpseclib.sourceforge.net/).
Provide customer support with the file name so they can configure the respective imports
in your client.
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Tip: Create the folder structure based on client IDs. So you can connect a shop installation on which different web shops with different
languages have been configured, using a SFTP account.

Structure of the CSV file
The CSV file has the following defined header structure:
"id";"name";"category";"text1";"text2";"text3";"text4";"text5";"text6";"text7";"text8";"text9";"text10";"link1Text";"link1Url";"link2Text";"link2Url";"link3Text";"link3Url";"image1ImageUrl";"image1AltText";"image1Link";"image2ImageUrl";"image2AltText";"image2Link";"image3ImageUrl";"image3AltText";"image3Link";"image4ImageUrl";"image4AltTex-
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t";"image4Link";"image5ImageUrl";"image5AltText";"image5Link";"image6ImageUrl";"image6AltText";"image6Link";"additionalData1";"additionalData2";"additionalData3";"additionalData4";"additionalData5";"additionalData6";"additionalData7";"additionalData8";"additionalData9";"additionalData10";"additionalData11";"additionalData12";"additionalData13";"additionalData14";"additionalData15";"additionalData16";"additionalData17";"additionalData18";"additionalData19";"additionalData20"

Each product is written in one line. Columns for which no values are available in the shop
system must still be empty and cannot be deleted. Also note the following information:
l
l
l

The columns id, name and category must be specified.
The value of the id column must be unique in the CSV file and identify the product.
In the category column, specify the category as a string and separate the hierarchies with
#, for example men#shoes#summer.
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l
l

Select UTF-8 as text encoding.
Remove HTML code or make sure that the HTML code is error-free.

Magento 1 integration
Note: The Magento 1 integration is no longer supported with
updates. Updates will only be made for the Magento 2 integration.

Note: This topic is for administrators and developers with administration access rights in Magento 1.
If you are using Magento 1 as e-commerce platform, you can integrate this with Optimizely
Campaign and manage customer data via Optimizely's email marketing platform. The
entire recipient management, from registration to the opt-in process through to updating
of the recipient data and unsubscriptions, is done in Optimizely Campaign. The Magento 1
integration allows for sending of transactional mails and regular email campaigns via
Optimizely's server. You can also import product data into Optimizely Campaign to display
products in remarketing campaigns and recommendations.

Supported versions
Magento CE

Magento EE

1.7

✓

1.12

✓

1.8

✓

1.13

✓

1.9

✓

1.14

✓

Installation
The installation should be carried out by an administrator or Dev operator. For the integration, you need to install the Optimizely Campaign extension in Magento. You need at
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least PHP 5.3 and phpseclib 0.3.6 on your Magento server (the official distribution from
Version 0.3.6.). You can install this via PEAR: http://phpseclib.sourceforge.net/pear.htm.
Install the Optimizely Campaign extension via the file system. You need an FTP connection
to your server to transfer the installation package.
1. Unpack the ZIP archive containing the installation onto your local PC.
2. Establish an FTP connection to your Magento server.
3. Copy the app folder to your Magento server.
Note: Test the installation and configuration first in a non-production (live) environment.

Configuring in Optimizely Campaign
When setting up your Optimizely Campaign extension, certain data should be available for
the configuration. If you are operating several store views, stores and/or websites with a
Magento installation, see Configuring multiple-clients.
Log in to your Optimizely Campaign client and select the required client. Copy the following IDs and codes:
l

l

l

l

Client ID. Open the Optimizely Campaign menu and select Administration > API Overview > REST API.
Authorization code. Open the Optimizely Campaign menu and select Administration >
API Overview > Recipient lists. Select the required recipient list and click Manage
authorization codes. If no code is set up for the selected list, click Create authorization
code.
Opt-in ID. Open the Optimizely Campaign menu and select Administration > API Overview > Opt-in processes. Select the opt-in process that you want to use for the Magento
store (see following section).
Opt-in link. Edit the system mailing you are using for the registration confirmation (opt-in)
of customers from your Magento shop and replace the default field function for the opt-in
link: {Double-Opt-In-Link} with the parameterized string: {Double-Opt-In-Link}?id=
{bmecssid}&code={bmecsscc}
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Customer support will further configure in Optimizely Campaign. Optimizely needs the fol-

lowing information from your Magento shop:
l
l

l

The IP address of your Magento shop. This is stored in your client.
Forwarding email address. Should be an administrative email address to where ARF
reports, bounces, spam, auto-replies and responses are sent.
The transmission domain of your shop. Must be delegated to Optimizely and stored in
your client as a transmission domain.

Importing recipient data
When setting up the integration, customer support sets up a recipient list with the standard fields from Magento in your Optimizely Campaign client. The recipient list contains the
following fields:
Field name

Data type

Description

email

String

Email address

salutation

String

User's title

firstname

String

First name

lastname

String

Last name

language

String

ISO code for the language from the StoreView via which the user
has registered.

street

String

Street address

zip

String

Postcode or international ZIP code

city

String

City

state

String

State

country

String

Country
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Apart from the mandatory email address and automatic language, fields are optional. To
receive the data, create an expanded subscription form or an edit-profile form and integrate this into your shop pages.

Adding and exporting additional recipient data fields
In Magento, you can add recipient data called customer attributes to save with the default
recipient data and export the data to Optimizely Campaign. Customer attributes let you
adapt your sales approach. You can use customer attributes like any other default value to
personalize newsletters or to create highly customized customer segments.
Note: The function to add customer attributes (steps 1-7) is not available in Magento Community Edition. Instead, there are third-party
extensions available that add this functionality to the browser.
1. Select Customers > Attributes > Manage Customer Attributes.
2. Click Add New Attribute and define first the Attribute Properties.
3. In the field Attribute Code, enter a unique internal name.
4. In the Input Type drop-down list, select the desired data type.
Note: The export to Optimizely Campaign only supports the field
types Text Field, Text Area, Date and Yes/No.
5. Define the further settings for the customer attribute.
6. Click the Manage Label/Options tab and define the titles for the customer attribute,
as you want them to be displayed in the admin back end and in the different languages
of your shop. You must enter a title in the Admin field. If you leave the other fields
empty, the Admin value is used for them as a default value.
7. Click Save Attribute.
8. Select System > Configuration > optivo broadmail.
9. Open the HTTP-API panel and, in the the Customer Attributes to optivo list, select
customer attributes you want to export to Optimizely Campaign. Use CTRL to select
multiple attributes.
10. Click Save Config. The selected attributes are sent to Optimizely Campaign at every
HTTP API request.
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11. To process the sent data, communicate the field names and types of the customer
attributes to customer support who configure the recipient lists in your Optimizely Campaign client. When this is done, you can access the customer attributes in Optimizely
Campaign as a recipient field and can be used to create personalized content or target
groups based on these data.

Importing product data into a template
If you are configuring the product data export in Magento, you need a correspondingly
equipped message template with a content interface to integrate the imported data into
your mailings (for example in the form of recommendations or cross and upselling offers).
Note: An individual template and the content interface are additional functions, subject to a charge, and are not part of the standard
scope of supply for the Magento integration. For more information,
contact customer support.
The Magento integration transfers the following product data to Optimizely Campaign:
Field name

Data type

Description

id

Long

Product ID

name

String

Product title

category

String

Product category (final path)

description

String

Product description

short_description

String

Short description of the product

sku

String

Item number

product_url

String

URL to product landing page

price

String

Product price
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Field name

Data type

Description

special_price

String

Special price

special_from_date

String

Offer valid from

special_to_date

String

Special valid until

base_image

String

Product image

small_image

String

Downsized product image

thumbnail

String

Thumbnail image

Configuring in Magento
Open the system configuration tool in Magento, then, in the optivo menu, select the menu
item optivo broadmail.
Tip: If a 404 error message (Page not found) appears, log out and log
back in again.

General
Open the General area and complete the fields using the data that you copied from your
Optimizely Campaign client in the previous step:
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l
l

l
l

Client ID. Client ID
Client Name. Optionally, enter the name of your Optimizely Campaign client. This is used
for orientation purposes, because the client ID can be difficult to remember.
Authorization Code. Authorization code
Opt-in ID. Opt-in ID

HTTP API
Open the HTTP-API area, enter the confirmation page URL for the double opt-in, and
enter the confirmation page URL for the unsubscription process in the second field.

Tip: The CMS page for the confirmation (Newsletter Confirm Page) or
unsubscription (Newsletter Unsubscribe Page) can also be a CMS
page created specially for this case.
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SMTP API
Open the SMTP-API area and select whether you want to use the Optimizely Campaign
SMTP-API to send transaction mails. If you have select Yes here, enter the appropriate
data in the following fields:
l
l

User name of the API user. Provided by customer support.
Password of the API user. Provided by customer support.

You also have to configure the Store Email Addresses in Magento. Open the Store Email
Addresses menu item and, for the email addresses specified here, specify the domain you
have delegated to Optimizely during the SMTP setup.

FTP API
Open the FTP-API (Product Export) area and select whether you want to activate the
product data export as per Optimizely Campaign. If you select Yes here, fill in the following
data fields with the corresponding information:
l
l
l

User name of the API user. This is provided by customer support.
Private key is encrypted. Select Yes from the list of options.
Private key. A key pair must be generated for data exchange via SFTP. See FTP access via
SCP. Enter the private key here and inform Optimizely of the public key.
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l

Daily Export at. Select the time at which the daily product data export should take place.

Transactional mail address
In the System configuration, in the General menu, select the Store email addresses
menu item. Open the mailing address that you want to use for your transactional mails via
Optimizely Campaign and enter a sender name and a sender address. The mailing address
Sales representative is used as standard for transactional mails (for example, order confirmations). You can also configure a different mailing address (such as Adapted email 1).
To store this mailing address for transactional mails, go to the Sales emails menu item in
the Sales area, and select the corresponding mailing address for each sales campaign.
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Note: The transmission domain for the transactional mails must be
delegated to Optimizely and also be stored in your Optimizely Campaign client as a transmission domain. The administration of the delegated domains is carried out by Optimizely. Do not use your shop's
main domain (example.com), but instead set up a subdomain for
transactional mails (transactions.example.com) and delegate this subdomain.

Configuring transactional mails
You can configure and send a transactional mail for shop actions (orders, shipments,
changes to customer and shipping data and so on) using Optimizely Campaign. Adjust or
set up corresponding templates in your Magento shop to do this. To create a template:
1. Select System > Transactional mails. Transactional mail templates are now displayed
in a table.
Note: The Template Type column shows whether a template is
configured for sending using the Magento shop (template type:
HTML) or using Optimizely Campaign (template type: optivo). You
can change the template type so that templates, that are configured for sending via the Magento shop, are sent using Optimizely Campaign. To do so, go to step 6.
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2. Click Insert New Template and from the Load default template area, select a template; empty templates cannot be created with Magento.
3. Select an area schema from the list below. This schema determines the formatting of
prices and dates.
4. Click Load template to copy the content.
5. In Template Information, enter a name for the template. This name is only used internally.
6. Select the send with optivo broadmail check box. The two new fields optivo authcode and optivo bmmailid are now displayed.
7. In optivo authcode, enter the authorization code for the recipient list that should be
used for the transactional mail.
a. Open the Optimizely Campaign menu and select Administration > API Overview >
Recipient lists.
b. Select the required recipient list and click Manage authorization codes. A new
window opens that displays a list of authorization codes for the selected recipient
list.
c. Copy the ID of the desired authorization code and enter it into the corresponding
field in Magento. If no authorization code is currently available, click Create
authorization code to generate a new code.
8. In optivo bmmailid, enter the ID of the transactional mail in Optimizely Campaign that
you want to send with this transaction. The transactional mail must be set up in your
Optimizely Campaign client beforehand; see Transactional mails.
9. Remove the HTML code from the Template content field.
10. Enter recipient parameters to transfer with this template to Optimizely Campaign
using the following format:
[parameter]={{var order.getOptivoBillingData('[variable]')}}

Note: Replace the string [parameter] with the name of the parameter in Optimizely Campaign, and replace the string [variable]
with the name of the variable used by Magento for the order
object. For example, the line lastname={{var order.getOptivoBillingData('lastname')}} sends the last name
of the recipient to Optimizely Campaign. See Recipient and billing

© Optimizely 2022

950 | Optimizely Campaign User Guide 2022-03-14

data for a list of recipient parameters.

11. To add a parameter, start a new line.
12. In addition to the variables provided by the function getOptivoBillingData, you can
also send the shop-specific standard variables to Optimizely Campaign to use them in
the transactional mail. Use the following format to do this:
[parameter]=[variable]

Note: For each variable to be transferred, a corresponding field
[parameter] is required in the target recipient list in Optimizely
Campaign. To insert a variable, click Insert Variable... and select
the desired variable from the list. For example, the line:
resetPassword={{htmlescape var=$customer.password}}
sends a new password to the resetPassword field. This lets you

send a transactional mail to a recipient who has requested a new
password.
13. Likewise, enter order items that you want to send with this template to Optimizely Campaign using the following format:
orderPositions={{var order.getOptivoProducts('product_
id','sku','name','price','qty_ordered)}}

The five standard parameters (product ID, order number, name, price and quantity) are
sent using the above format. If you do not require one of these parameters, you can
remove it from the schema. If you want to send additional order parameters, you need
to program a custom template. See Order details for a list of available order parameters
and notes about templates.
Note: To carry out the programming, you need PHP knowledge
and knowledge of the Magento object model.
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14. Click Save Template.
Note: The template is not activated when saved; that is, no transactional mails are sent using it.

15. To activate the template and link it to an action, select System > Configuration.
16. Locate the Sales section in the menu on the left and click Sales Emails. This displays
actions that trigger a transactional mail to be sent.
17. Open the panel for the desired action and select the desired template from the dropdown list (there is a template for each registered user and guest).
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Configuring multiple clients
Magento and Optimizely Campaign provide the option of displaying multiple clients. Configure each individual client exactly as described in the configuration sections. Ensure that
the clients are allocated correctly in Optimizely Campaign and Magento.
For each client, you need the client ID, client name, authorization code and opt-in ID. You
can configure the confirmation pages for the opt-in and the unsubscription confirmation
separately for each client, or you can use the same URLs for clients. The configuration for
the SMTP-API and the FTP-API is global, and only needs to be carried out once.
Note: To ensure that the clients are correctly allocated in Optimizely
Campaign and Magento, contact customer support to help you with
the configuration.

Selecting a client in Magento
Clients are depicted in Magento via websites, stores and store views. See User Guide from
Magento. The client selection section is at the top left-hand side of the configuration.
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Integrating the subscription form
Subscription to your newsletter is performed via the online registration form on your shop
pages. The registration data is transferred to Optimizely Campaign by means of an HTTP
request. The standard template for the subscription form can be integrated onto any CMS
page. Connection to Optimizely Campaign is automatic when you are using the standard
template. For standard newsletter subscriptions, only the email address is requested in the
standard form. Magento also automatically transfers to Optimizely Campaign the language
in which new subscribers are registered in the Magento shop. You can use this information
to send newsletters in different languages, for example.
To request additional recipient data, you need an extended subscription form. For this
type of form, you need extended programming knowledge in HTML. See Importing recipient
data for information about the data that you can request and process with the integration.

Integrating the subscription form on a CMS page
1.
2.
3.
4.

In the top menu bar, go to the CMS menu item.
In the Pages overview, go to the Manage content menu item.
Select Add new page or edit an existing CMS page.
In the Editor field, enter the following code fragment:
{{block type="core/template" template="newsletter/subscribe.phtml"}}
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5. Click Save, or Publish.
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Integrating the subscription form on category pages
1.
2.
3.
4.

In the top menu bar, go to the Catalog menu item.
In the Categories overview, go to the Manage categories menu item.
Select the required category and a client (optional), and go to the Own design tab.
Enter the following code fragment in the Editor field. Your subscription may have a different column layout and positioning, so adjust accordingly.
<!-- Newsletter Box -->
<reference name="right">
<block type="newsletter/subscribe"
name="right.newsletter"
template="newsletter/subscribe.phtml"/>
</reference>

This code fragment integrates the subscription form into the right-hand layout column.
If you want to integrate the newsletter into the left-hand column, replace the tag
<reference name="right"> with the tag <reference name="left">

and replace the attribute name="right.newsletter" with name="left.newsletter".
Depending on the integration and to ensure a correct display on different end devices,
you also may make changes in CSS.
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5. Click Save, or Publish.

Note: Additional integration options
This section listed only the possible integration options from the
back-end. The integration can also take place almost everywhere via
the Magento template system. These changes require design experience and access to the Magento installation file system.
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Error handling
Activating Magento logging
By default, general logs are written to the system.log file, and errors and exceptions to the
exception.log file. You can change these file names at var/log/.
Activate writing log files in Magento for error analysis.
1. Select System > Configuration.
2. Click Progress and then Developer.

3. Set the Enabled option to Yes.

Activating developer module
To analyze errors and ensure that effective logging is taking place, activate the developer
mode in Magento via .htaccess or directly in the index.php of Magento:
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The log file for the Optimizely Campaign extension is located in the /var/log/ directory
within the Magento installation. The name of the log file is optivo_broadmail.log.

Conflicts with other Magento extensions
There may be conflicts between the Optimizely Campaign extension and other extensions
if these extend the same Magento core functions. In particular, conflicts may occur in connection with other Magento extensions that also provide newsletter, SMTP or similar functions to the Optimizely Campaign extension.
Furthermore, local code adjustments in the code pool local can lead to additional byeffects or side effects in the interplay.
During error analysis, pay attention to which extensions and in-house developments are
integrated in the Magento installation.
Tip: To prevent these types of conflicts and integration malfunctions,
first install your Magento platform with the Optimizely Campaign
extension and other extensions being used onto a test system. Then,
reproduce a range of different test scenarios there before carrying
out the installation in a production environment.

Recipient and billing data
Note: This topic is for administrators and developers with administration access rights in Magento 1.
If you are using Magento 1 as e-commerce platform, you can integrate the system with
Optimizely Campaign. The following recipient data is provided by Magento and, using a
transactional mail template, can be sent to Optimizely Campaign. When configuring the template, the variables from Magento are each assigned to a recipient list field in Optimizely
Campaign. If you want to transfer variables that do not have a corresponding field in your
transactional recipient list, contact customer support.
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Field name

Date type

entity_id

Integer

parent_id

Integer

customer_address_id

Integer

quote_address_id

Integer

region_id

Integer

customer_id

Integer

region

String

postcode

String

lastname

String

street

String

city

String

email

String

telephone

String

country_id

String

firstname

String

address_type

String

prefix

String

middlename

String
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Field name

Date type

suffix

String

company

String

vat_id

String

vat_is_valid

Boolean

vat_request_id

Integer

vat_request_date

String

vat_request_success

Boolean

giftregistry_item_id

Integer

country

String

salutation

String

Order details
Note: This topic is for administrators and developers with administration access rights in Magento 1.
If you want to send more than the five standard order parameters (product ID, order number, name, price and quantity) provided by the function getOptivoProducts to Optimizely
Campaign, you can use a custom template that aggregates and calculates the required
variables. This template is linked using the following line and defined in the file items.phtml.
{{layout area="frontend" handle="optivo_email_order_items" order=$order}}
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Note: To program the template, you need relevant PHP skills and
good knowledge of the Magento object model or order items. Any
changes must be applied only after consultation with customer support.
Field name

Data type

item_id

Integer

order_id

Integer

parent_item_id

Integer

quote_item_id

Integer

store_id

Integer

created_at

Date

updated_at

Date

product_id

Integer

product_type

String

product_options

String

weight

Float

is_virtual

Boolean

sku

String

Name

String

Description

String
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Field name

Data type

applied_rule_ids

String

additional_data

String

free_shipping

Boolean

is_qty_decimal

Boolean

no_discount

Boolean

qty_backordered

Float

qty_canceled

Float

qty_invoiced

Float

qty_ordered

Float

qty_refunded

Float

qty_shipped

Float

base_cost

Float

price

Float

base_price

Float

original_price

Float

base_original_price

Float

tax_percent

Float

tax_amount

Float
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Field name

Data type

base_tax_amount

Float

tax_invoiced

Float

base_tax_invoiced

Float

discount_percent

Float

discount_amount

Float

base_discount_amount

Float

discount_invoiced

Float

base_discount_invoiced

Float

amount_refunded

Float

base_amount_refunded

Float

row_total

Float

base_row_total

Float

row_invoiced

Float

base_row_invoiced

Float

row_weight

Float

gift_message_id

Integer

gift_message_available

Integer

base_tax_before_discount

Float
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Field name

Data type

tax_before_discount

Float

ext_order_item_id

String

weee_tax_applied

String

weee_tax_applied_amount

Float

weee_tax_applied_row_amount

Float

base_weee_tax_applied_amount

Float

base_weee_tax_applied_row_amnt

Float

weee_tax_disposition

Float

weee_tax_row_disposition

Float

base_weee_tax_disposition

Float

base_weee_tax_row_disposition

Float

locked_do_invoice

Boolean

locked_do_ship

Boolean

price_incl_tax

Float

base_price_incl_tax

Float

row_total_incl_tax

Float

base_row_total_incl_tax

Float

hidden_tax_amount

Float
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Field name

Data type

base_hidden_tax_amount

Float

hidden_tax_invoiced

Float

base_hidden_tax_invoiced

Float

hidden_tax_refunded

Float

base_hidden_tax_refunded

Float

is_nominal

Integer

tax_canceled

Float

hidden_tax_canceled

Float

tax_refunded

Float

event_id

Integer

giftregistry_item_id

Integer

base_tax_refunded

Float

discount_refunded

Float

base_discount_refunded

Float

gw_id

Integer

gw_base_price

Float

gw_price

Float

gw_base_tax_amount

Float
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Field name

Data type

gw_tax_amount

Float

gw_base_price_invoiced

Float

gw_price_invoiced

Float

gw_base_tax_amount_invoiced

Float

gw_tax_amount_invoiced

Float

gw_base_price_refunded

Float

gw_price_refunded

Float

gw_base_tax_amount_refunded

Float

gw_tax_amount_refunded

Float

qty_returned

Float

Magento 2 integration
Note: This topic is for administrators and developers with administration access rights in Magento 2.
If you are using Magento 2 as e-commerce platform you can integrate this with Optimizely
Campaign to take advantage of your e-commerce and customer communication marketing
activities.
With the Magento 2 integration, customers can subscribe/unsubscribe to newsletters directly in your shop. The integration transfers customer data received during registration to
Optimizely Campaign so that you can use the information to personalize emails. You can
also automatically send transactional mails like order confirmations and invoices. When
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registered customers change their data in the shop, customer data is synchronized. The
integration also lets you transfer the product catalog to Optimizely Campaign daily.
The Magento 2 integration supports multiple clients, and the connection of several shops
to Optimizely Campaign.

Feature range and supported versions
The Magento 2 integration provides the following features for Magento 2.0, 2.1, 2.2 and 2.3
(Community Edition).
l
l
l

Newsletter subscription and unsubscription
Transactional mails via HTTP API and SMTP API
Export product catalog into Optimizely Campaign

Setting up in Optimizely Campaign
To set up the Magento 2 integration, contact customer support to get the integration software package.
Provide Optimizely with the following information:
l
l

The version number of your Magento 2 system.
The recipient list structure for your newsletter recipients. Let Optimizely know if you want
to add additional fields.

The Magento 2 integration offers two ways to send transactional mails via Optimizely Campaign:
1. Via the HTTP API. When you want to use the Optimizely Campaign templates for your
transactional mails. Optimizely requires the transaction recipient list for your transactional mails. Optimizely provides a default template for the transaction recipient list
structure that is suitable for many applications/scenarios. Optimizely can discuss with
you whether the standard template meets your requirements. See Transactional mails
via HTTP API.
2. Via the SMTP API. When you want to use the Magento 2 templates for your transactional mails and Optimizely Campaign only for sending. If you want to use the SMTP
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API, provide the IP address of your web shop for configuration purposes. See Transactional mails via SMTP API.
l

l

l

For product catalog export to Optimizely Campaign, you need a user account on the
Optimizely server. If you do not have a user account, contact customer support. Provide a
public key and a key fingerprint to securely transfer the data. See .
If you are running multiple shops (including sub-shops and shops that are localized in
other languages), let Optimizely know the number of shops you want to connect to; see
Advanced configuration.
If you are integrating multiple shops, you may need:
o
o
o

Separate clients for the individual web shops.
A separate client for your transactional mails.
Setup of a recipient-list-based newsletter subscription.

Installation
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to install the Magento 2 integration, if you are using Magento as
e-commerce platform with Optimizely Campaign.

Installing the integration package
Note: To prevent problems and conflicts, first install and test the
Magento 2 integration on a test system.
When you have received the integration software package (ZIP archive) from customer support, install it in Magento 2 as described in the following.
1. Unzip the ZIP archive.
2. Upload the unpacked folder to the directory app/code/Optivo/Broadmail in your
Magento 2 system.
3. Clear the cache of the Magento 2 system.
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4. Verify the successful upload of Magento 2 integration with the following console command:
php bin/magento module:status

If the upload is successful, the Magento 2 integration is displayed in the List of disabled modules.
5. Use the following console command to activate the Magento 2 integration:
php magento module:enable Optivo_Broadmail

Installing updates
If you receive an updated version of the integration from customer support, do the following to install the upgrade:
1. Unzip the ZIP archive.
2. Upload the unpacked folder to the directory app/code/Optivo/Broadmail in your
Magento 2 system.
3. Use the following console command:
php bin/magento setup:upgrade

Uninstalling the integration package
Do the following to uninstall the Magento 2 integration:
1. Disable the Magento 2 integration by using the following console command:
php bin/magento module:disable Optivo_Broadmail

2. Clear the cache with the following console command:
php bin/magento cache:clean

3. Delete the Magento 2 integration files.
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Configuring subscribes and unsubscribes
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to configure the newsletter subscription and unsubscription feature, if you are using Magento 2 as e-commerce platform with Optimizely Campaign. It also
shows how to transfer other recipient data to Optimizely Campaign, data that is not
included in the standard configuration of the Magento 2 integration.
To configure subscribes and unsubscribes, do the following:
1. Configure the opt-in mailing (registration confirmations) in Optimizely Campaign, and
then use a field function to reference the confirmation link to your shop.
2. Create two landing pages in Magento 2, one to display a successful newsletter subscription confirmation, and one to display a successful unsubscribe confirmation.
3. Store the client ID, the authorization code for the API access, and the ID of the opt-in
process the shop.
4. Optional: Expand the recipient list structure, to transfer other recipient/customer data
that is not included in the standard configuration of the Magento 2 integration.
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Configuring the opt-in mailing
1. Open the Optimizely Campaign menu and select Campaigns > Opt-in Processes.
2. Select the opt-in process for the connection to your shop and click Edit….

3. On the Email node, click Properties

.
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4. Click Edit Content….

5. Click the name of the paragraph that contains the registration confirmation link.
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6. In the Text area, click Source.

7. Replace the existing link with the following code lines/field functions:
{Double-Opt-In-Link}?id=${user.data.bmecssid}&code=${user.data.bmecsscc}

You will find the link to be replaced in the <a> tag between the quotation marks.
Example
The following link is contained in the <a> tag in the source code:
<a href="http://srv2.de/subscribe.html">Complete registration</a>
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Replace the link between the quotation marks as follows:
<a href="{Double-Opt-In-Link}?idd=${user.data.bmecssid}&code=${user.data.bmecsscc}">Complete registration</a>

Note: The parameters id and code enable the Magento 2 integration to map to the data sets in your shop.
8. Click Apply > Close > Save and close.
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Creating landing pages
1. Log in to Magento 2 with administrator rights.
2. Select Content > Pages.
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3. Click Add New Page.

4. In the Page Title field, enter a name for the landing page.

Note: Assign unique names to the landing pages, for example
Optimizely Campaign opt-in confirmation or Optimizely Campaign opt-out confirmation.
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5. Click Content.

6. In the Content Heading box, enter the title that you want to display on the landing
page.
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7. In the text box, enter the text that you want to display on the landing page.

8. Optional: If required, change other settings on the form, such as layout adjustments
under Design.
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9. Click Save Page.

10. Repeat steps 3–9 for the second landing page you want to create.

Storing authorization code, opt-in, and client IDs
Note: Do not confuse the recipient list for your newsletter recipients
with the transaction recipient list for your transactional mails. Customer support will set up two different types of recipient lists for the
sending of newsletters and the sending of transactional mails (for
example order confirmations, invoices).
l

l

l

Authorization code. For the Optimizely Campaign recipient list (created for you by customer support and saved in your client). You can locate the authorization code in your
Optimizely Campaign client in the API overview. Open the Recipient lists tab and select
the relevant recipient list. Click Manage authorization codes and copy the authorization
code from the list. If no authorization code is available for the selected recipient list, click
Create authorization code.
opt-in ID. To see the opt-in ID, open the Optimizely Campaign menu and select Administration > API overview > Opt-in processes.
client ID. To see the client ID, open the Optimizely Campaign menu and select Administration > API Overview > REST API.
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1. To store the parameters, log in to Magento 2 with administrator rights.
2. Select Stores > Configuration.

3. Select Episerver > Episerver Campaign.
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4. In General Settings, enter the following data:
l
l

l
l
l

Client ID. Enter the client ID.
Client Name. Enter a name for the client. You can choose any name for the client.
However, use the same name as in Optimizely Campaign.
Authorisation Code. Enter the authorization code.
Opt-In ID. Enter the opt-in ID.
Debug Mode. Select Yes.
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5. In the HTTP API area, from the Landing page for newsletter subscription confirmation drop-down list, select the landing page that you created for the newsletter
registration in Magento 2.

6. In the HTTP API area, from the Landing page for newsletter unsubscribe confirmation drop-down list, select the landing page that you created for the newsletter
unsubscription in Magento 2.
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7. Save your changes.
Note: Coded values (Client ID, Private key) must be entered
anew with each saving process. Otherwise the coded value is
coded anew.

Transferred attributes in the standard configuration
The Magento 2 integration only transfers the email addresses of customers who subscribe
to the newsletter with their email address, but are not logged into their customer account.
The data listed in the following table is transferred for customers who are logged into the
customer account.
If a customer or an administrator changes the customer data in the shop system, the
changes are automatically transferred to the Optimizely Campaign recipient list. Changes
to customer data entered in a recipient list in Optimizely Campaign are not synchronized
with your shop system by Magento 2 integration. For this reason, change customer data in
your Magento 2 system to keep the information synchronized.
l
l
l
l
l

Email. Email address of the customer/recipient
Salutation. Title
Firstname. First name
Lastname. Last name
Language. Language of the shop set up in Magento 2 in which the customer has
registered
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l
l
l
l
l
l

l

l
l
l

Street. Street
Zip. Postal code
City. City
State. State
Country. Country
bmecssid. ID generated by Magento 2 integration and used for identification during communication with Optimizely Campaign
bmecsscc. Confirmation code generated by Magento 2 integration and used for identification during communication with Optimizely Campaign
store_id. ID of the web shop in which the customer has registered
dob. Date of birth
group_id. Customer group

Expanding the recipient list structure and transferring additional recipient
data
You can transfer other recipient/customer data from Magento 2 to Optimizely Campaign,
in addition to the standard attributes. To set up the transfer, you need to:
l

Request additional recipient list fields.

l

Enable the additional recipient data in Magento 2.

Note: The additional attribute fields in Magento 2 must be programmed in accordance with the specifications of Magento 2. Additional attribute fields that have not been programmed according to
the Magento 2 specifications cannot be transferred to Optimizely
Campaign.

Requesting additional recipient list fields
To request additional recipient list fields, contact customer support and let Optimizely
know which additional recipient list fields you require for user-defined attributes. Customer
support will expand your list of recipients with the additional recipient list fields as per your
requirements.
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Enabling the transfer of additional recipient data
After customer support adds the requested recipient list fields, activate the transfer of the
corresponding recipient data via HTTP API in Magento 2.
1. Log in to Magento 2 with administrator rights.
2. Select Stores > Configuration.
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3. Select Episerver > Episerver Campaign.

4. In the HTTP API area, in the Configure additional customer attributes to transmit
list, select the additional recipient data that you want to transfer to Optimizely Campaign in addition to the standard attributes.
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Tip: Hold down CTRL to select multiple attributes at the same
time.
5. Save your changes.

Configuring transactional mails via HTTP API
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to configure sending of transactional mails via HTTP API with
Magento 2. For transactional mails via the SMTP API, see Transactional mails via SMTP API.

How it works
Sending of transactional mails via HTTP API uses these templates:
l

A Sender template in Magento 2, which sends the variables of the transaction (for example
customer name, ordered products) via the HTTP API.
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l

A Recipient template in Optimizely Campaign, which uses field functions to insert sent variables into relevant locations. This creates the finished transactional mail with layout.

Sending and receiving the content of the variables takes place using the transaction recipient list as a buffer.
1. The Magento 2 template sends the variables.
2. The variables are written to the transaction recipient list: each variable into the relevant recipient list field.
3. Using field functions, Optimizely Campaign copies the template with the individual variables from the transaction recipient list and places it in the desired location in the
transactional mail.

Configuration steps
1.
2.
3.
4.

Set up a transaction recipient list.
Create the template in Optimizely Campaign.
Create and activate the template in Magento 2.
Configure transactional mails and transfer Magento 2 variables.

Step 1. Setting up a transaction recipient list
To set up the transaction recipient list. contact customer support. Plan in advance which
variables you want to transfer from Magento 2 into Optimizely Campaign for your transactional mails.
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List the Magento 2 variables for which you require a corresponding recipient list field in
your transaction recipient list. Also, let Optimizely know the naming of the recipient list
fields.
Note: The scope of the transaction recipient list is limited. For this
reason, you should request generic names for the recipient list fields,
for example custom_string_1, custom_string_2, custom_date_1 and so
on.

Step 2. Creating a template in Optimizely Campaign
Create the template and add the desired transactional mail texts (the unchangeable,
static texts that are to be sent to recipients) and insert field functions in the places where
the content of the Magento 2 variables should be.

Field functions
Field functions are placeholders that refer to a specific recipient list field in your trans-

action recipient list. The variables and content of the variables sent from Magento 2 are
written into the relevant recipient list fields in your transaction recipient list. The field functions you place load relevant content from the referenced recipient list field in the next
step.
Example
Set up a transactional mail text that greets each customer using the last name and the
order date. For this you need these variables: salutation, lastname and orderdate.
The content of the variables is first written to a relevant recipient list field of the transaction recipient list (from Magento 2 via the HTTP API). To access these recipient list fields,
insert the individual field functions into the Optimizely Campaign template and place the
name of the recipient list field in curly brackets. To import the variable contents, the static
text and field functions in the Optimizely Campaign template could look like this:
Hello, {salutation} {lastname}!
Thank you for your online order from {orderdate}.

© Optimizely 2022

990 | Optimizely Campaign User Guide 2022-03-14

The example will appear in the sent transactional mail as follows:
Hello, Mr. Miller!
Thank you for your online order from August 3.

Adding static texts and field functions to a template
1. Open the Optimizely Campaign menu and select Campaigns > Transactional Mails.
2. Click Create.

3. From the left action pane, drag the Recipients node into the workspace.
4. In the Recipient lists drop-down list in the context menu, select your transaction
recipient list.
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Note: Customer support has set up a separate transaction recipient list for you. Make sure you use this transaction recipient list,
instead of a regular recipient list. To see if a recipient list is a
transactional recipient list, check the column Transaction API.
5. From the left sidebar, drag the message node for the desired marketing channel (email,
SMS) into the workspace.
6. In the Name box in the context menu, enter a name for your transactional mail (for
example Order confirmation).
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7. In the context menu for the message node, click Edit content.
8. In the Template list, select the desired template and confirm your selection by clicking
Next.
9. Configure the template for the transactional mail according to your requirements.
Enter a subject and insert the static texts that recipients will receive, into the content
paragraphs. Insert the relevant field function for the recipient list field of the transaction recipient list into places where variables from the Magento 2 template should
appear (see example above).
10. Click Apply.
11. Click Close.
12. Connect the Recipients node with the message node.
13. Click Save and Close.
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14. Select the mailing in the overview and click Start to activate your transactional mail
and to start the sending process.
Step 3. Creating and activating the template in Magento 2
Create a template in Magento 2 that sends the variables to Optimizely Campaign via HTTP
API.

Prerequisites
l

Authorization code. For your transaction recipient list in to Optimizely Campaign.
Open the Optimizely Campaign menu and select Administration > API Overview >
Recipient lists tab and select the desired transaction recipient list. Click Manage
authorization codes and copy the authorization code from the list. If no authorization
code is available for the selected recipient list, click Create authorization code.

l

Mailing ID. For the template in Optimizely Campaign.
Open the Optimizely Campaign menu and select Campaigns > Transactional Mails.
Copy the relevant mailing ID of the template in the list in column ID.

Configuration options
With Magento 2, you have two template configuration options for transferring variables:
1. Use a template included in the standard Magento 2 installation and customize it to fit
your needs. If you choose this option, the template's HTML code loads in the template
content field. The code contains the available variables, for example {{trans
"%name," name=$customer.name}} (for addressing customers by their names). Clean
up the template around the HTML code and reduce the template to the variables. In
the next step, map the corresponding recipient list fields of your transaction recipient
list in Optimizely Campaign. See Mapping: Here’s how you do it.
2. Create an empty template and manually insert the variables to be sent to Optimizely
Campaign via the HTTP API.
Do the following to create a template, add the variables and map these to the recipient list
fields of your transaction recipient list.
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1. Log in to Magento 2 with administrator rights.
2. Select Marketing > Email Templates.

Note: If you already created templates that are sent to Optimizely Campaign, these appear as the template type Episerver.
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3. Click Add New Template.

4. In the Template Information area, fill in the fields:
l
l

Template Name. Enter a name for the new template.
Template Subject. Leave empty.
Note: The subject is automatically entered later using the
subject from the template created in Optimizely Campaign.

l
l

l

Episerver Campaign. Select Enabled.
Authcorisation Code. Enter the authorization code for the transaction recipient
list in Optimizely Campaign.
bmMailingId. Enter the mailing ID of the template in Optimizely Campaign.

5. In the Template Information box, enter which variables from Magento 2 should be
transferred to which recipient list field of the transaction recipient list in Optimizely
Campaign. To add a variable, click Insert Variable...
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6. Select the desired variable by clicking it.
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7. Map the inserted variable with the corresponding recipient list field in Optimizely Campaign. If required, click Insert Variable... to add further variables.
How to do the mapping
Magento 2 integration from Optimizely Campaign uses the following structure for mapping:
Name of the recipient list=name of the Magento 2 variables

Enter the mapping assignment for each variable line by line, and separate the individual variables/mapping instructions with a line break.
Example:
lastname={{config path="trans_email/ident_custom1/name"}}
url={{config path="web/secure/base_url"}}

Map with both example lines and transfer:
l

Value of the Magento 2 variables {{config path="trans_email/ident_custom1/name"}} into the transaction recipient list field lastname
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l

Value of the Magento 2 variables {{config path="web/secure/base_url"}}
into the transaction recipient list field url

8. Click Save Template.
9. After you create the template, activate it and map an event (for example an order process, or newsletter registration). At which point in the admin interface you map and
activate the template to an event depends on the type of the event.
Example: To map and activate the template to the event type Order, do the following:
a. Select Stores > Configuration.
b. Select Sales > Sales Emails.
c. Activate the template by selecting it in the Order area in the New Order Confirmation Template drop-down list.
d. Save your changes.
Step 4. Configuring transactional mails and transferring Magento 2 variables
To transfer customer orders and billing and delivery addresses to the template in Optimizely Campaign, using the template in Magento 2, you need additional configuration, and

© Optimizely 2022

Integration and interfaces | 999

create a special field function (for order access) in your Optimizely Campaign client.
Note: Magento 2 provides the customer orders and billing and delivery addresses as HTML code. This needs to be changed to simple
text so that Optimizely Campaign can process the information.

Converting HTML code to simple text
The following functions in the Magento 2 integration are for converting the HTML code
into simple text:
getEpiserverBillingData( )
With getEpiserverBillingData( ), you get access to the individual parameters of the
billing address. This feature is available via the following instruction, used in an example
for the salutation of the customer:
{{var order.getEpiserverBillingData('salutation')}}

You transfer the return value of the function call (parameter salutation) into the recipient
list field salutation as simple text with the following mapping:
salutation={{var order.getEpiserverBillingData('salutation')}}

getEpiserverBillingData( ) parameters
No.

Parameter

Description

1

salutation

Title

2

firstname

First name

3

middlename

Middle name

4

lastname

Last name

5

company

Company
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No.

Parameter

Description

6

email

Email address

7

telephone

Telephone number

8

suffix

Extension

9

fax

Fax number

10

street

Street

11

postcode

Postal code

12

city

City

13

region

Region/state

14

country

Country

getEpiserverShippingData()
With getEpiserverShippingData( ), you receive access to the individual parameters of
the customer's delivery address. The feature is available via the following mapping, in this
example for the customer's last name:
{{var order.getEpiserverShippingData('lastname')}}

You transfer the return value of the function call (parameter lastname) into the recipient
list field lastname as simple text with the following mapping:
lastname={{var order.getEpiserverShippingData('lastname')}}

getEpiserverShippingData() parameters
No.
1

Parameter
salutation

Description
Title
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No.

Parameter

Description

2

firstname

First name

3

middlename

Middle name

4

lastname

Last name

5

company

Company

6

email

Email address

7

telephone

Telephone number

8

suffix

Extension

9

fax

Fax number

10

street

Street

11

postcode

Postal code

12

city

City

13

region

Region/state

14

country

Country

getEpiserverOrderData()
With getEpiserverOrderData( ), you access the customer's orders.
Note: Accessing orders differs from accessing the billing and the
delivery addresses, as you transfer a list with several parameters into
a single recipient list field, instead of transferring individual parameters.
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The function is available via the following instruction (in this example, product ID, storage
unit, product name, quantity ordered and price):
{{var order.getEpiserverOrderData('product_id','sku','name','qty_ordered',
'price')}}

You transfer a string with the order information specified in the order_positions_csv into
the recipient list field with the following mapping:
order_positions_csv={{var order.getEpiserverOrderData('product_id',
'sku','name','qty_ordered','price')}}

getEpiserverOrderData( ) parameters
No.

Parameter

1

increment_id

2

state

3

status

4

coupon_code

5

shipping_description

6

is_virtual

7

store_id

8

base_discount_amount

9

base_discount_canceled

10

base_discount_invoiced

11

base_discount_refunded

12

base_grand_total
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No.

Parameter

13

base_shipping_amount

14

base_shipping_canceled

15

base_shipping_invoiced

16

base_shipping_refunded

17

base_shipping_tax_amount

18

base_shipping_tax_refunded

19

base_subtotal

20

base_subtotal_canceled

21

base_subtotal_invoiced

22

base_subtotal_refunded

23

base_tax_amount

24

base_tax_canceled

25

base_tax_invoiced

26

base_tax_refunded

27

base_to_global_rate

28

base_to_order_rate

29

base_total_canceled

30

base_total_invoiced
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No.

Parameter

31

base_total_invoiced_cost

32

base_total_offline_refunded

33

base_total_online_refunded

34

base_total_paid

35

base_total_qty_ordered

36

base_total_refunded

37

discount_amount

38

discount_canceled

39

discount_invoiced

40

discount_refunded

41

grand_total

42

shipping_amount

43

shipping_canceled

44

shipping_invoiced

45

shipping_refunded

46

shipping_tax_amount

47

shipping_tax_refunded

48

store_to_base_rate
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No.

Parameter

49

store_to_order_rate

50

subtotal

51

subtotal_canceled

52

subtotal_invoiced

53

subtotal_refunded

54

tax_amount

55

tax_canceled

56

tax_invoiced

57

tax_refunded

58

total_canceled

59

total_invoiced

60

total_offline_refunded

61

total_online_refunded

62

total_paid

63

total_qty_ordered

64

total_refunded

65

base_shipping_discount_amount

66

base_subtotal_incl_tax
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No.

Parameter

67

base_total_due

68

shipping_discount_amount

69

subtotal_incl_tax

70

total_due

71

base_currency_code

72

discount_description

73

global_currency_code

74

order_currency_code

75

shipping_method

76

store_currency_code

77

store_name

78

customer_note

79

created_at

80

updated_at

81

total_item_count

82

shipping_incl_tax

83

base_shipping_incl_tax

84

coupon_rule_name
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After the transfer to Optimizely Campaign, the individual parameters in the recipient list
field of your transaction recipient list are separated by a semicolon. If multiple products
are transferred, the individual products are separated by a line break. The string written in
the recipient list field corresponds to the structure of a table that is saved in the CSV
format.

Creating a special field function for order data
If you want to use order data in a transactional mail, you must create a new special field
function in your Optimizely Campaign client. This must use the template engine of Optimizely Campaign to transfer the string to HTML, as described in the following.
1. Open the Optimizely Campaign menu and select Administration > Field Functions.
Tip: If the Field functions menu item is not available in your client, contact customer support.
2. Click Add.

3. Under General, in the Name box, add a concise name for the new field function, for
example CSVOrderObjects.
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4. In the Type drop-down list, select Velocity.
5. In the Content area > Default replacement tab > Default replacement box, enter
the following code:
<table>
<tr>
<td>Product ID</td><td>SKU</td><td>Name</td><td>Quantity</td>
<td>Price</td>
</tr>
#set ("csvContent = "csv.readFromString("user.data.order_positions_csv))
#foreach("row in "csvContent)
<tr>
#foreach("item in "row)
<td> "item </td>
#end
</tr>
#end
</table>
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6. Click Save.
Insert the field function at the desired location in the Optimizely Campaign template.
When the transactional mail is sent and the recipient list field order_positions_csv contains a CSV context object, a simple HTML table is displayed in the sent transactional
mail.
Note: See Field functions how to customize the layout of the
table as desired (HTML knowledge is required).

Configuring transactional mails via SMTP API
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to configure sending of transactional mails via SMTP API with
Magento 2. For transactional mails via the HTTP API, see Transactional mails via HTTP API.
Prerequisites: You need an SMTP API user account for the SMTP connection between
Optimizely Campaign and your shop. To set up the account, contact customer support. You
will receive a user name and password for the SMTP API.
To configure transactional mails via SMTP API, do the following:
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1. Log in to Magento 2 with administrator rights.
2. Select Stores > Configuration.
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3. Select Episerver > Episerver Campaign.

4. In the SMTP API area:
l
l
l

Use Episerver Campaign SMTP API. Select Yes.
Username. Enter your SMTP API user name.
Password. Enter your SMTP API password.
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5. Save your changes.

Configuring the catalog export
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to configure the catalog export, when using Magento 2 as e-commerce platform with Optimizely Campaign. You can for example transfer promotional texts
and product images, and use this data in your newsletters. See Content interface paragraph.
The Magento 2 integration exports your catalog into a CSV file (comma-separated values),
and automatically transfers the catalog to the Optimizely server via a secure SFTP connection at specific time intervals.

Prerequisites
You need an SSH key pair and an SFTP user account to set up a secure connection.

Creating an SSH key pair
Follow these instructions to create a key pair:
l

FTP access via SCP for Windows

l

FTP access via SCP for MacOS/OS X
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Requesting an SFTP user account
When you have created the key pair, do the following to request a user account:
1. Contact customer support. Providing the name of the CSV file with your product catalog.
2. Email your public key (the file with the .pub extension) to customer support.
3. Send your key fingerprint in a separate email to customer support.
Note: For security reasons, always send your public key and key fingerprint in two separate emails.
When your account is configured, you receive your user account information by email.

Activating the catalog export in Magento 2
In the following steps, you activate the catalog export and save your private SSH key.
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1. Log in to Magento 2 with administrator rights.
2. Go to Stores > Configuration in the menu bar on the left.
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3. In the left pane, select Episerver > Episerver Campaign.

4. In the FTP API (Product data export) area, in the Use Episerver Campaign product
data export drop-down list, select Yes.
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5. In the Username box, enter the user name of your SFTP user account.

6. If you want to protect your SSH key with a password, select Yes in the Private key is
encrypted drop-down list, and add a password in the Password box.
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7. In the Private key box, enter your private key.

8. Under Time for daily export (hh:mm:ss), select the time your product catalog should
be exported.
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9. Save your changes.
Note: Coded values (Client ID, Private key) must be entered
anew with each saving process. Otherwise the coded value is
coded anew.

Note: The product catalog export fails if the Cron Jobs functionality is incorrectly configured in Magento 2. This functionality is
part of the standard installation. See the Magento 2 documentation
for details.

Configuring shops and adapting messages
Note: This topic is for administrators and developers with administration access rights in Magento 2.
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This topic describes how to configure shops, connect templates and clients, and adapt
front-end messages, when using Magento 2 as e-commerce platform with Optimizely Campaign. You can set up a specific client in Optimizely Campaign that is only used for sending
transactional mails.

Configuring multiple shops individually
The settings for the "Default" shop will also apply to other shops set up in a Magento 2
installation. However, the Magento 2 integration lets you connect multiple shops and store
views individually with different templates and different clients in Optimizely Campaign.
For example, this lets you run multi-language shops and send order or newsletter subscription confirmations in the individual language of the recipient.
Do the following to configure this:
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1. Log in to Magento 2 with administrator rights.
2. Go to Stores > Configuration via the menu bar on the left.

3. From the drop-down list under Store View, select the shop/store view you want to configure. Confirm your selection.
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4. Click OK.
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5. In the left pane, click Episerver > Episerver Campaign.

6. Clear the check boxes for the configurations that you want to change for the store.
The grayed entry is activated and can be edited.
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7. Change the configuration.

Note: To send out newsletter registration confirmations or transactional mails in other languages, you must first create these in
their respective language. See Configuring the newsletter and
Transactional mails via HTTP API.
8. Save your changes.
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Adapting front end messages
To translate or change front end messages displayed to website visitors, for example when
logging in, you can edit the integration text files. Front end messages are located in the directory src/i18n. The files are simple text files that follow the Magento 2 standard.
Tip: Install and test the Magento 2 integration on a test or staging
system before you use it in production. If you are planning a test
phase, report the URLs of the test system to customer support, to reference the subscribe and unsubscribe links during the test phase.

Troubleshooting
Note: This topic is for administrators and developers with administration access rights in Magento 2.
This topic describes how to manage integrated-related issues when using Magento 2 as ecommerce platform with Optimizely Campaign, how to get help with problems during
installation and configuration, and how to activate error logging, and known issues.

Installation issues
If problems occur during the installation and configuration of Magento 2 integration, contact customer support and provide the following information:
l
l
l

The version number of the Magento 2 system you are using.
The output of the command phpinfo().
A description of when and in what context the error occurred.
Note: Conflicts may occur with other expansion modules for
Magento 2. If you cannot determine, limit, or resolve the conflicts,
provide Optimizely with a list of the modules you use.
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Activating error logging
Error logging displays operating status of the integration and any errors that occurred.
1. Log in to Magento 2 with administrator rights.
2. Select Stores > Configuration.
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3. Select Episerver > Episerver Campaign.
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4. In the General settings area, in the Debug Mode drop-down list, select Yes.

5. Click Save Config.
The Magento 2 integration saves errors in the var/log/optivo_broadmail.debug.log
file. If you cannot fix a problem yourself, send the lines that were recorded after the error
occurred to customer support.
Entries in the error log have the following structure:
[2017-06-30
[2017-06-30
[]
[2017-06-30
[] []
...
[2017-06-30
[2017-06-30
Not Found

10:25:03] optivoLogger.DEBUG: processFallbackQueue:start [] []
10:25:03] optivoLogger.DEBUG: processFallbackQueue:maxRetries 10 []
10:25:03] optivoLogger.DEBUG: processFallbackQueue:process 1 entries
10:25:03] optivoLogger.DEBUG: _checkResponse [] []
10:25:03] optivoLogger.DEBUG: a:7:{s:8:"response";s:207:"HTTP/1.0 404

Known issues
The following errors in Magento 2 can affect the Optimizely Campaign integration:
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Problem

Possible cause

Version 2.1.0. In the back end (under Customer
Information in the tab Newsletter), you cannot
unsubscribe customers by clearing the Subscribed
to Newsletter check box.

Documented
Magento 2 error.

Solution
Unsubscribe customers via Marketing
> Newsletter Subscribers by deleting
the corresponding
customer from the
list.

Versions 2.0.7 and 2.1.0.
l

l

At checkout, the customer cannot specify a new
default address or change their address.
If customers have not stored an address in their
customer account, they can create a new
address at the checkout. This is, however, committed as a shipping address and not as a billing
address – despite the existing option to use the
same address for billing and shipping.

Currently
unknown.

No solution currently
available.

Error in the
Magento 2 system, not an error
in the Magento 2
integration from
Optimizely Campaign.

No solution currently
available.

Both errors affect the correct transfer of address
information of the customer into transactional
mails.

All versions. Magento displays the message You
have registered for the newsletter on the confirmation page only after a delay.

Shopware integration
Note: This topic is for administrators and developers with administration access rights in Shopware.
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This topic gives you an overview of the Shopware integration with Optimizely Campaign.
With the Shopware integration, customers can subscribe and unsubscribe to newsletters
directly in your shop. The integration transfers customer data received during registration
to Optimizely Campaign so that you can use the information to personalize emails.
You can also automatically send transactional mails like order confirmations and invoices.
When registered customers change their data in the shop, customer data is synchronized.
The integration also lets you transfer the product catalog to Optimizely Campaign daily
and supports the connection of multiple shops.
You get the following features on Shopware Professional, Professional Plus and Enterprise
5.2–5.6:
l
l
l

Newsletter subscription and unsubscribes
Transactional mails via HTTP API
Export product catalogs into Optimizely Campaign

Setting up Shopware integration
To set up the Shopware integration in your client, contact customer support and request
the integration software package.
Provide Optimizely with the following information:
l
l

Your Shopware version number.
The number of desired recipient lists for your newsletter recipients.
Note: The structure and fields of newsletter recipient lists are
determined by Shopware and cannot be customized.

l

l

l

For transactional mails, Optimizely sets up a separate customizable transaction recipient
list. Provide Optimizely with the desired structure and the names of these fields.
For product catalog export to Optimizely Campaign, you need a user account on the
Optimizely server. If you do not have a user account, contact customer support. Provide a
public key and a key fingerprint to securely transfer the data. See .
If you are running multiple shops (including sub-shops and shops that are localized in
other languages), provide Optimizely with the number of shops you want to connect to;
see Advanced configuration.
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If you are integrating multiple shops, you may need:
l
l
l

Separate clients for the individual shops.
A separate client for your transactional mails.
Setup of a recipient-list-based newsletter subscription.

Installation
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to install the Shopware integration with Optimizely Campaign.
To install the Shopware integration, do the following:
1. After you receive the download link to the software package (ZIP archive) from customer support, download the file and log in to the back-end of Shopware using administrator rights.
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2. Go to Configuration > Plugin Manager.
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3. Click Installed.
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4. Ensure that the Cron plug-in is installed.

Note: The Cron plug-in is included in the standard Shopware
installation. If it is not installed, look for the Cron plug-in in the
Uninstalled section, and click Install
to add it.
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5. Click Upload plug-in to upload the Shopware integration.

6. Click Select and go to the location where you saved the ZIP archive of the Shopware
integration.

7. Click Upload plug-in. When uploaded, the Shopware integration is displayed in the
Uninstalled section with the name Episerver Campaign.
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8. Click Install
to install the integration. The installation begins. You may be asked to
clear individual caches. Confirm by clicking Yes. When finished, you are asked to activate the integration.
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9. Click Activate.

When completed, the installation is displayed under the Installed section in the Plugin
Manager window.
Note: To change the installation settings at a later time, click Edit
in the overview of installed plug-ins.
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Installing an update
If you receive an updated version of the Shopware integration from customer support, do
the following to delete the old version and install the upgrade:
1.
2.
3.
4.

Log in to the back end of Shopware using administrator rights.
Go to Configuration > Plugin Manager.
On the left side of the menu bar, click Installed.
Locate the Shopware integration named Episerver Campaign in the Plugin Manager
and click Uninstall . When completed, the integration appears under Uninstalled.
During the uninstallation, you are asked if you want to keep the data from the old version. Confirm to retain the data in accordance with your requirements.

5. Click Delete
to delete the old version, and confirm by clicking Yes.
6. Install the new version by following Steps 5–9 in the previous section.

Uninstalling the integration
1.
2.
3.
4.

Log in to the back end of Shopware using administrator rights.
Go to Configuration > Plugin Manager.
On the left side of the menu bar, click Installed.
Locate the Shopware integration named Episerver Campaign in the Plugin Manager
and click Uninstall . When completed, the integration appears under Uninstalled.

5. Click Delete

to delete the old version, and confirm by clicking Yes.
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Configuring subscribes and unsubscribes
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to configure the newsletter subscription and unsubscription feature, if you are using Shopware as an e-commerce platform with Optimizely Campaign. The
Shopware integration uses standard formulas that contain Shopware for newsletter registration. You cannot add fields.
Note: See Advanced configuration how to work with multiple subshops and language versions.
To configure subscribes and unsubscribes, do the following:
1. Configure the opt-in mailing (registration confirmations) in Optimizely Campaign, then
use a field function to reference the confirmation link to your shop.
2. Insert the opt-in ID and the authorization code (for recipient consent) in Shopware.
3. Enable the use of the double opt-in method in Shopware.
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Step 1. Configuring the opt-in mailing
1. Open the Optimizely Campaign menu and select Campaigns >Opt-in processes.
2. Select the opt-in process for the connection to your shop and click Edit….

3. On the Email node, click Properties

.
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4. Click Edit Content….

5. Click the name of the paragraph that contains the registration confirmation link.
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6. In the Text area, click Source.

7. Replace the existing link with the following code lines or field functions:
{Double-Opt-In-Link}?hash={customer-id}&shop-id={shop-id}&shop={shop}

You can find the link that you need to replace between the <a> tags in quotation
marks.
Example
In the source code, the following link is contained in <a> tags:
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<a href="http://srv2.de/subscribe.html">Confirm subscription</a>

Replace the link marked in red in quotation marks as follows:
<a href="{Double-Opt-In-Link}?hash={customer-id}&shop-id={shop-id}&shop=
{shop}">Confirm subscription</a>

Note: The Shopware integration accepts the referral (the call),
and identifies the customer by the hash parameter and the store
or subshop, using the shop-id and shop parameters, respectively.
8. Click Apply > Close > Save and close.

Step 2. Inserting the opt-in ID and the authorization code
For this step, you need to insert two values in your Shopware system:
l

l

The opt-in ID used to record recipient consent. To see the opt-in ID, open the Optimizely
Campaign menu and select Administration > API overview > Opt-in processes.
The authorization code for the recipient list that Optimizely customer support has generated to connect your shop. To locate this in Optimizely Campaign, select Administration > API overview > Recipient lists tab. Select the corresponding recipient list and
click Manage authorization codes. If no authorization code is presently available for this
recipient list, click Create authorization code.
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Note: Do not confuse the recipient list for your newsletter recipients with the transaction recipient list for your transactional mails.
Customer support sets up two different types of recipient lists for the
sending of newsletters and the sending of transactional mails (for
example order confirmations, invoices).
1. Log in to the back-end of Shopware using administrator rights.
2. Go to Configuration > Plugin Manager.
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3. On the left side of the menu bar, click Installed.

4. In the list, find the Shopware integration for Episerver Campaign in the Plugin Manager, and click Open .
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5. In the Configuration area, in the optivo bmOptInID box, enter the opt-in ID.
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6. In the Configuration area, in the optivo Authorization Code box, enter the authorization code of your recipient list.

7. Click Save.
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Step 3. Enabling the double opt-in method
1. In Shopware, go to Configuration > Basic settings.
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2. Go to Additional settings > Privacy.
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3. In the Double opt in for newsletter subscriptions drop-down list, select Yes.

4. Click Save.

Configuring transactional mails
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to configure sending of transactional mails when using Shopware
as e-commerce platform with Optimizely Campaign.

How it works
Sending of transactional mails uses these templates:
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l

l

A Sender template in Shopware, which sends the variables of the transaction (for example
customer name, ordered products) via the HTTP API.
A Recipient template in Optimizely Campaign, which uses field functions to insert sent
variables into relevant locations. This creates the finished transactional mail with layout,
and sends it to the recipient.

The sending and receiving of the content of the variables use the transaction recipient list
as a buffer.
1. The Shopware template sends the variables.
2. The variables are written into the transaction recipient list: each variable into the relevant recipient list field.
3. Using field functions, Optimizely Campaign copies the template with the individual variables from the transaction recipient list and places it in the desired location in the
transactional mail.

Configuration steps
1.
2.
3.
4.
5.

Set up the transaction recipient list.
Configure the template in Optimizely Campaign.
Configure the template in Shopware.
Configure the details of transaction mails.
Set up the transactional mails for multiple shops.
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Step 1. Setting up a transaction recipient list
To set up a transaction recipient list, contact customer support. Plan in advance which variables you want to transfer from Shopware into Optimizely Campaign for your transactional
mails.
List the Shopware variables for which you require a corresponding recipient list field in
your transaction recipient list. Also, let Optimizely know the naming of the recipient list
fields.
Step 2. Creating a template in Optimizely Campaign
Create the template and add the desired transactional mail texts (the unchangeable,
static texts to be sent to recipients) and insert field functions in the places where the content of the Shopware variables should be.

About field functions
Field functions are placeholders that refer to a specific recipient list field in your trans-

action recipient list. The variables and content of the variables sent from Shopware are
written into the relevant recipient list fields in your transaction recipient list. The field functions you place load relevant content from the referenced recipient list field in the next
step.
Example
Set up a transactional mail text that greets each customer using the last name and the
order date. For this you need these variables: salutation, lastname and orderdate.
The content of the variables is first written to a relevant recipient list field of the transaction recipient list (from Shopware via the HTTP API). To access these recipient list fields,
insert the individual field functions into the Optimizely Campaign template and place the
name of the recipient list field in curly brackets. To import the variable contents, the static
text and field functions in the Optimizely Campaign template could look like this:
Hello, {salutation} {lastname}! Thank you for your online order from {orderdate}.

The example will appear in the sent transactional mail as follows:
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Hello, Mr. Miller!
Thank you for your online order from August 3.
To create the template, do the following:
1. Open the Optimizely Campaign menu and select Campaigns > Transactional Mails.
2. Click Create….

3. Drag the Recipients node from the left action area to the working area on the right.
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4. In the Recipient lists drop-down list, select your transaction recipient list.

Note: Customer support sets up a separate transaction recipient
list for you. Be sure you use this transaction recipient list, instead
of a regular recipient list. To see if a recipient list is a transactional recipient list, check the column Transaction API.
5. From the left action pane, drag the message node for the desired marketing channel
(email, SMS) into the workspace.
6. In the Name box, assign a concise name to your transactional mail (such as Order confirmation).
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7. In the context menu for the message node, click Edit Content….
8. In the Template drop-down list, select the desired template and confirm your selection by clicking Next.
9. Configure the template for the transactional mail according to your requirements.
Enter a subject and insert the static texts that you want recipients to receive, into the
content paragraphs. Insert the relevant field function for the recipient list field of the
transaction recipient list into places where variables from the Shopware template
should appear (see the previous example in this topic).
10. Click Close.
11. Connect the Recipient node with the message node.
12. Click Save and Close.
13. To activate your transactional mail and to start the sending process, select the mailing
in the overview and click Start.
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Step 3. Configuring the template in Shopware
Configure a transactional mail template that sends variables to Optimizely Campaign via
the HTTP API.
Prerequisites
l

l

Authorization code for your transaction recipient list in to Optimizely Campaign. To see
the authorization code, open the Optimizely Campaign menu and select Administration
> API Overview. Open the Recipient lists tab and select the desired transaction recipient list. Click Manage authorization codes and copy the authorization code from the list.
If no authorization code is available for the selected recipient list, click Create authorization code.
The mailing ID for the template in Optimizely Campaign. To see the mailing ID, open the
the Optimizely Campaign menu and select Campaigns > Transactional mails. Copy the
relevant mailing ID of the template in the list in column ID.

The Shopware integration contains two functional templates for demonstration purposes:
l

sREGISTERCONFIRMATION

l

sORDER
Note: Do not use the system template sOPTINNEWSLETTER, which
is included in the Shopware standard, to set up the newsletter registration. If you do, newsletter registration with Optimizely Campaign
will not work.
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1. Log in to the back-end of your Shopware system with administrator rights.
2. Go to Configuration > Email templates.
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3. Go through the directory structure to the template that you want to configure.

4. To send the template variables to Optimizely Campaign via the HTTP API, select
optivo broadmail ("Send with optivo broadmail").

© Optimizely 2022

1058 | Optimizely Campaign User Guide 2022-03-14

5. In the optivo authcode box, enter the authorization code of your transaction recipient
list in Optimizely Campaign.
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6. In the optivo bmMailingId box, enter the mailing ID of the template in Optimizely Campaign.
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7. Open the optivo broadmail tab.

Note: If the mailing is activated via Optimizely Campaign, the
field values in the tabs Plaintext, HTML-Text, and Attachments
are ignored.
8. In the fields of the optivo broadmail tab, map the Shopware variables with the corresponding recipient list fields in your transaction recipient list to Optimizely Campaign. To see available variables for the respective template, click Sample variables.
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Mapping ("Assigning")
The Shopware integration from Optimizely Campaign uses the following structure for
mapping:
Name of the recipient list field=name of the Shopware variable

Enter the mapping assignment for each variable line-by-line, and end each line with a
semicolon. Separate the individual variables/mapping assignments with line breaks.
Example:
salutation={salutation};
firstname={firstname};
lastname={lastname};
smail={sMAIL};
shopname={config name=shopName};

Use the example lines to map and transfer:
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l
l
l
l
l

Shopware variable value {salutation} to transaction recipient list field salutation
Shopware variable value {firstname} to transaction recipient list field firstname
Shopware variable value {lastname} to transaction recipient list field lastname
Shopware variable value {sMAIL} to transaction recipient list field smail
Shopware variable value {config name=shopName} to transaction recipient list
field shopname
Note: Make sure that you map the Shopware variables to be
transmitted to existing recipient list fields. Contact customer support to set these up. Determine in advance which data/content to
transfer to Optimizely Campaign, and which content you can
implement as static text in the Optimizely Campaign template.

9. Click Save template.
Step 4. Configuring transactional mails
The language template in Shopware writes the ordered products as a character string to
the recipient list field orderPositions in the transaction recipient list. In the template
sORDER, which contains the Shopware integration by default, you will find the following
line next to the standard customer data:
orderPositions={foreach item=details key=position from=$sOrderDetails}
"{$details.ordernumber}"{literal};{/literal}
"{$details.quantity}"{literal};{/literal}
"{$details.price} EUR"{literal};{/literal}
"{$details.amount} EUR"{literal};{/literal}
"{$details.articlename}"{literal};{/literal}{/foreach};

The foreach loop summarizes ordered products in a character string in CSV format. The
individual columns (order number, quantity, price, total price, and article name) are separated by semicolons. The individual products are separated by line break characters.

Adjusting the foreach loop
1. Go to Configuration > Email templates.
2. Go to the supplied template sORDER in the System emails directory of the Shopware
integration.
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3. Open the optivo broadmail tab.
4. Make changes in the mapping instruction line for the recipient list field
orderPositions. For example, replace EUR with another currency, such as USD.
Note: If you have good knowledge of Shopware template features, you can also use these functions to configure data to be
transmitted. Observe the correct masking of special characters
when making adjustments. In addition, the masking of the separator (semicolon) with {literal} must be retained within the loop.
5. Click Save template.

Creating a field function for ordered products
To use the ordered products that are transmitted as a character string in a transactional
mail, you need a specific field function in your client. This must use the template engine
from Optimizely Campaign to transfer the character string to HTML, and to display ordered
products in a table inside the transactional mail.
1. Open the Optimizely Campaign menu and select Administration > Field Functions.
Tip: If Field functions is not available in your client, contact customer support to enable this feature.
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2. Click Create….

3. Under General, in the Name field, enter a name for the new field function, such as
CSVOrderObjects.
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4. In the Type drop-down list, select Velocity.
5. In the Default replacement tab in the Content area, enter the following code in the
Default replacement field.
<table>
<tr>
<td>Product ID</td><td>SKU</td><td>Name</td><td>Quantity</td>
<td>Price</td>
</tr>
#set ($csvContent = $csv.readFromString($user.data.orderpositions))
#foreach($row in $csvContent)
<tr>
#foreach($item in $row)
<td> $item </td>
#end
</tr>
#end
</table>

6. Click Save.
Note: If you have HTML knowledge, you can customize the layout
of the table. See Field functions.

Step 5. Setting up transactional mails for multiple shops
If you have additional sub-shops in different languages in Shopware, you can set up individual templates in multiple languages to send transaction mails. You may need separate
transaction recipient lists, contact Optimizely customer support in advance.
You may for example want to set the registration confirmation language for your newsletter to English for non-German-speaking recipients. Insert the English translation into
the template, and use the corresponding field functions created for the English-speaking
customers, in the places where the content of the variables provided by Shopware is to be
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used. If you do not have any field functions for international parameters in your client, contact customer support.
1. Configure an individual template for transactional mails in Optimizely Campaign as
described in Create a template in Optimizely Campaign.
2. Log in to the back end of Shopware using administrator rights.
3. Go to Configuration > Email templates.
4. To find the desired template, go through the list on the left.
5. In the text box, click the globe icon.
6. Select the sub-shop or the language version for the shop from the menu bar on the
left.
7. In the optivo authcode box, enter the authorization code for the corresponding transaction recipient list in Optimizely Campaign.
8. In the optivo bmMailingId box, enter the mailing ID of the individual template you
want to use in Optimizely Campaign.
9. Click Save translations.

Configuring the catalog export
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to configure the catalog export, when using Shopware as e-commerce platform with Optimizely Campaign. You can transfer promotional texts and product
images, and use this data in your newsletters. See Content interface paragraph.

How it works
The integration reads a feed created in Shopware and transmits feed data to Optimizely
Campaign. You can use filters in Shopware to exclude product categories. The integration
exports the catalog to a CSV file (comma-separated values), and automatically transfers
the catalog to the Optimizely server via a secure SFTP connection at specific time intervals.
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Prerequisites
You need an SSH key pair and an SFTP user account to set up a secure connection. To
create a key pair, see:
l

FTP access via SCP for Windows

l

FTP access via SCP for MacOS/OS X

When you have created the key pair, do the following to request a user account:
1. Contact customer support, providing the name of the CSV file with your product catalog.
2. Email your public key (the file with the .pub extension) to customer support.
3. Send your key fingerprint in a separate email to customer support.
Note: For security reasons, always send your public key and key fingerprint in two separate emails.
When your account is configured, you will receive your user account information by email,
and you can start the configuration.

Configuration steps
1. Configure the feed for the catalog that is to be exported.
2. Configure your Shopware integration for catalog export.
3. Configure and activate the cron job Episerver Campaign Product Export in Shopware to automate daily catalog exports.
Step 1. Configuring your feed for catalog export
The Shopware integration includes a standard feed that you can copy and customize
(recommended).
Do the following to configure a feed:
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1. Log in to the back end of Shopware with administrator rights.
2. Go to Marketing > Item export.

3. In the list, find the entry optivo broadmail and click Edit item feed
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4. In the Format tab, in the Encoding drop-down list, select UTF-8.

Note: Entries in the Header and Body tabs were created by the
Shopware integration at the time of installation and are required
for the product data exchange with the content interface. Do not
change the entries in the Header tab. You can change the Body
tab as needed in steps 5 and 6.
5. Optional: In the Body tab, adjust the sending time by changing the number of days (10
by default).
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Note: Do not change the variables and the filters used (such as
|escape).
6. Optional: In the Body tab, change the shipping service provider and the shipping
method.
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Note: Deutsche Post Standard is the default shipping service
provider and shipping method.

Note: Do not change the variables and the filters used (such as
|escape).
7. To exclude product categories from being transferred to Optimizely Campaign in the
catalog export, open the Blocked categories tab and select the corresponding check
box.
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8. Click Save and Close.
9. Find the optivo broadmail feed and right-click the file name in the File name column.
In the context menu of your browser, select the option Copy link location.
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10. Copy the Feed URL to your clipboard, or save the URL in a text document.
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Step 2. Configuring Shopware integration for catalog export
1. In Shopware, go to Configuration > Plugin Manager.
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2. On the left side of the menu bar, click Installed.

3. Find the Shopware integration for Episerver Campaign in the Plugin Manager, and
click Open

.
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4. In the Configuration area, insert the data below:

Product export. Select Yes.
l
Export Name. Enter the file name for your catalog export.
l
Product export link. Enter the URL of the feed for your catalog export.
l
SFTP Username. Enter the user name for your Optimizely server account.
l
SFTP keyfile password. Enter the password for your private SSH key.
l
SFTP Private Keyfile. Enter your private SSH key.
5. Click Save.
l
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Step 3. Configuring and activating the Cron job
To automate daily catalog exports, you must configure and activate the Cron job
Episerver Campaign Product Export in Shopware.
1. In Shopware, go to Configuration > Basic settings.
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2. Go to System > Cronjobs.
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3. In the list, find the Cron job Episerver Campaign Product Export and click Edit

4. Select Active.
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5. In the Interval drop-down list, select a time interval, such as 1 day.

6. Click Save.
7. To activate the Cron job and start the automatic schedule, invoke the URL. Typically,
this is something like: http://<your store URL>/backend/cron.
Note: When the URL is invoked, you can find the job in the list of running Cron jobs under the Processing Episerver Campaign Product
Export (if the execution is scheduled).

Advanced configuration
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to individually configure multiple shops, opt-in mailings, language versions, front-end messages, and catalog exports, when using Shopware as e-
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commerce platform with Optimizely Campaign. Contact customer support for advise regarding setup of multiple shops with separate clients for transactional mails, and recipient listbased newsletter subscriptions.

Configuring individual opt-in mailings and catalog exports
To configure an individual catalog export or a language version of your shop, you must create a separate feed in Shopware; see Configuring the catalog export. Specify a unique file
name for the catalog export, or language version, of your main shop (for example
products_fr.csv for French). Do not use the same file name because the individual catalog
exports will overwrite each other.
1.
2.
3.
4.

Log in to the back-end of Shopware with administrator rights.
Go to Configuration > Plugin Manager.
Click Installed.
Find the Shopware integration for Optivo broadmail in the Plugin Manager, and click
Edit . If you have configured multiple shops, these are displayed in individual tabs
under Configuration.

5. Click the tab of the shop to configure.

6. Enter the desired settings.
7. Click Save.
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Configuring multiple newsletter subscriptions
By default, the Shopware integration supports registering for one newsletter per email
address. If a recipient registers with the same email address for another newsletter, including that of a sub-shop or different language for the shop, no opt-in operation is triggered.
Configure recipient groups to allow multiple newsletter subscriptions.
1. In Shopware, go to Marketing > Newsletter Manager.

2. Open the Administration > Recipient groups tab.
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3. Click Create newsletter group.

4. Specify a descriptive name for the recipient group, such as Newsletter recipients IT.

5. Click OK.
6. From the ID column, note the ID of the new recipient group.
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7. Go to Configuration > Basic settings.
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8. Go to Frontend > Login / registration.

9. Open the tab for the sub-shop/language version of the main shop for which to create a
recipient group.
10. In Standard recipient group ID for registered customers (system / newsletter),
enter the ID from step 6.
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11. Click Save.

Adapting front-end messages
To translate or change front-end messages displayed to website visitors, such as when subscribing or unsubscribing, you can modify integration text files. The integration supports
localization features in Shopware, and there are several standard texts in German and (British) English that you can modify.
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1. Log in to the back-end of Shopware with administrator rights.
2. Go to Configuration > Snippets.

3. Go to Namespaces > frontend > plug-ins > Optivo broadmail. Switch between available messages under the Default / de DE and default / en GB tabs.
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4. Select the message to edit, and click Edit selected snippets. The Edit snippets window opens.

5. Change the message.

6. If you have other languages in Shopware, the text elements for the other languages
are empty. Insert the corresponding translations for these.

© Optimizely 2022

Integration and interfaces | 1089

7. Click Save.

Customizing and localizing salutations
You can customize and localize the texts in the Optimizely Campaign recipient list field
salutation for individual subshops or language versions of your shop. By default, the German salutations Frau and Herr are transmitted to Optimizely Campaign.
1. Go to Configuration > Snippets.

2. Go to Namespaces > backend > plugins > optivo.
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3. Select the tab of the corresponding shop for which you want to change the salutation.

4. Select the salutation to modify, and click Edit selected snippets.
5. Enter the salutation.

6. Click Save.

Troubleshooting
Note: This topic is for administrators and developers with administration access rights in Shopware.
This topic describes how to manage integrated-related issues when using Shopware as ecommerce platform with Optimizely Campaign. Find out how to get help with Shopware
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problems during installation and configuration, and how to initiate the logging of events

and executed tasks to monitor operations and to locate error sources.

Installation issues
If problems occur during installation, configuration, and operation that you cannot solve,
contact customer support.

Common sources of errors
Problem

Customers cannot subscribe to
newsletter.

The catalog
export fails.

Possible cause

Solution

The shop system's firewall is
blocking the connection to
Optimizely Campaign.

Check the network configuration for your
shop system.

The authorization code of the
recipient list is invalid.

Check the authorization code of the recipient list and create a new authorization
code if necessary.

The opt-in ID is invalid.

Check and correct the opt-in-ID.

The shop system's firewall is
blocking the connection to
Optimizely Campaign.

Check the network configuration for your
shop system.

The private SSH key is incomplete or incorrect.

Re-enter the SSH key.

The password for the private
SSH key is incomplete or incorrect.

Re-enter the password for the private SSH
key.

Logging
The Shopware integration contains a feature for logging events and executed tasks, including the catalog export. If there are issues with the integration, use log files to find the
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sources of error. To access the logging, you need to activate a Cron job in Shopware.
Configuring the logging
1. Log in to the back end of Shopware with administrator rights.
2. Go to Configuration > Basic settings.
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3. Go to System > Cronjobs.

© Optimizely 2022

1094 | Optimizely Campaign User Guide 2022-03-14

4. In the list, find the Cron job optivo ErrorHandler and click Edit

.

5. Select the Active check box.

6. In the Interval drop-down list, select a time interval for the Cron job. This is used to
determine the intervals at which individual log records are grouped together.
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7. Click Save.
8. To activate the Cron job and start logging, invoke the URL. Typically, this is something
like http://<your store URL>/backend/cron.
Note: In the list of Cron jobs, you see the entry Processing Optivo
ErrorHandler (if the job execution is initiated by its interval settings).
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Accessing the back-end log
1. Select Configuration > Logfile.

2. Copy the logged events from the list, and click Details (the magnifying glass icon) in
the Options column. Entries added by the Shopware integration can be identified by
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the name optivo under User.

Log files in the system log
The Shopware integration writes messages to the broadmail channel in the System log
tab. Here you will find the most recent entries that have not been archived by the Cron
job.

Click Details (the magnifying glass icon) to see error message details.
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Example: The following message indicates that the product export started, but execution
failed because a user ID is missing from the Shopware integration settings.
CronJobsSubscriber::onoptivoProductExport: missing export sftp username

To see archived entries, select a log file from the drop-down list next to Download. To save
a log file to your computer, click Download.
Note: If you receive PHP programming language error messages,
send screenshots of these together with a description of the process
that was running when the error occurred to Optimizely customer
support. You may also have to provide Optimizely with the exact error
messages in the Linux system log file.

Spryker integration
Note: This topic is for administrators and developers with administration access rights in Spryker.
This topic gives you an overview of the Spryker integration with Optimizely Campaign.
With the Spryker integration, you can reliably manage your advertising consent: your customers can sign in to your newsletter directly in your Spryker shop and unsubscribe simply
by clicking the unsubscribe link in the newsletter.
The Spryker integration provides the following features:
l

Newsletter subscription and unsubscribes

l

Transactional mails via HTTP API

Setting up Optimizely Campaign
To set up the Spryker integration in your client, contact customer support.

© Optimizely 2022

Integration and interfaces | 1099

Preparing recipient lists
Provide Optimizely with the names of your Optimizely clients. Customer support adapts the
recipient lists to the Spryker integration.
Note: A recommended client setup uses two separate clients: one for
sending newsletters and the other for sending transactional mails.
Optimizely offers a standard template for the required recipient lists
that is suitable for many applications and scenarios. To check if the
standard template meets your requirements, contact customer support.

Referencing opt-in emails to Spryker
After customers have subscribed to the newsletter in your Spryker shop, Optimizely Campaign sends a registration confirmation with a confirmation link that completes the newsletter registration process. To reference the confirmation link to Spryker, adjust the field
function in the confirmation link.
1.
2.
3.
4.

Open the Optimizely Campaign menu and select Campaigns > Opt-in Processes.
Select the opt-in email that is to reference to your Spryker shop.
Click Edit.
In the Edit confirmation mailing window, hover over the message node and click

Properties
.
5. Click Edit content.
6. In the Edit content window, click the name of the paragraph that contains the confirmation link.
7. In the right Content area, in the Text field, click Source .
8. Replace the opt-in link with the following code: {Double-Opt-In-Link}?id={subscriber_key}
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Note: If you ordered a new confirmation mailing from customer
support, the mailing is empty. Edit the mailing and insert the
desired content. Use the code above for the double opt-in link.
9. Click Apply > Close > Save and close.

Setting up Spryker
Requirements:
l
l

l

Credentials from your Optimizely client.
Authorization codes of the recipient lists you are going to use. Open the Optimizely Campaign menu and select Administration > API Overview > Recipient lists > Manage
authorization codes.
Mailing IDs of the transactional mails you are going to use. Open the Optimizely Campaign
menu and select Campaigns > Transactional Mails.
Tip: If you are missing the ID column in the Transactional mails
window, click the down arrow v in the upper right corner of the
table header and activate the ID check box.

When you have the necessary information from Optimizely Campaign, follow the steps on
the Spryker documentation website.

Configuring subscribes and unsubscribes
Note: This topic is for administrators and developers with administration access rights in Spryker.

© Optimizely 2022

Integration and interfaces | 1101

This topic describes how to configure the newsletter subscription and unsubscription feature, if you are using Spryker as an e-commerce platform with Optimizely Campaign. Learn
which data fields are to be transmitted to Optimizely Campaign and how to reference the
unsubscribe link in your newsletter to your Spryker e-commerce platform.

Transmitting registration data to Optimizely Campaign
The registration data is transmitted via HTTP request to Optimizely Campaign. The following data fields are transmitted:
Field name

Data type

Description

Mandatory field

email

String

Recipient's email
address – also the
recipient's unique
ID

salutation

String

Title (Mr/Ms) of the
recipient

✘

firstname

String

Recipient's first
name

✘

lastname

String

Recipient's last
name

✘

customer_shop_locale

String

Language of the
shop via which the
customer has
registered

✓ (transferred
automatically)

spryker_id

String

Spryker-internal
shop customer ID

✘

customer_shop_url

String

Shop URL of the
customer

✓ (transferred
automatically)

customer_login_url

String

Login URL of the
customer

✓ (transferred
automatically)
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Field name

Data type

subscriber_key

String

Description
Individual key of
user in Spryker
Commerce

Mandatory field
✓ (transferred
automatically)

Referencing the unsubscribe link to Spryker
Recipients of a commercial mailing must have the possibility to unsubscribe, see Deliverability best practices. Usually this is guaranteed by an unsubscribe link located in the
footer of the newsletter. To redirect the unsubscribe link to Spryker, adjust the field function in the unsubscribe link.
Note: This example refers to a message template. You must change
the unsubscribe link in all mailings that have already been created
but not yet sent.
1. Open the Optimizely Campaign menu select Campaigns > Message Templates.
2. Select the message template you want to edit, and click Edit.
3. In the Edit message template window, in the left Edit area, click the name of the paragraph that contains the unsubscribe link.
4. In the right Content area, in the Text field, click Source .
5. Replace the unsubscribe link with the following code: {Unsubscribe Link}?Subscriber_key={subscriber_key}

6. Click Apply > Close > Save and close.
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Sending transactional mails
Note: This topic is for administrators and developers with administration access rights in Spryker.
This topic describes how to configure sending of transactional mails when using Spryker as
e-commerce platform with Optimizely Campaign. The sending is done via HTTP-API directly from Spryker.
You can use transactional mails to respond to customers' actions in your shop, such as
order confirmations, or to send system emails, which include:
l
l
l

Login confirmation
Password changes and confirmation
Order confirmations

Configuring transactional mails in Optimizely Campaign
Sending of transactional mails requires a template in Optimizely Campaign, which uses
field functions to insert sent variables into relevant locations. This creates the finished
transactional mail with layout, and sends it to the recipient. The sending and receiving of
the content of the variables takes place using the transaction recipient list as a buffer.
1. The Spryker integration sends the variables.
2. The variables are written into the transaction recipient list: each variable into the relevant recipient list field.
3. Using field functions, Optimizely Campaign copies the template with the individual variables from the transaction recipient list and places it into the desired location in the
transactional mail.
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Recipient list fields in Optimizely Campaign's transaction recipient list
By default, the transaction recipient list contains the following fields.
Field name

Data type

Description

email

String

Email (required)

salutation

String

Title

firstname

String

First name

lastname

String

Last name

spryker_id

String

Spryker ID

customer_shop_locale

String

Language setting in customer shop

customer_shop_url

String

Customer shop url

customer_login_url

String

Customer login url

customer_reset_link

String

Customer reset link

language

String

Language
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Field name

Data type

Description

order_number

String

Order number

order_comment

String

Order comment

order_orderdate

String

Order date

order_subtotal

String

Order Subtotal

order_discount

String

Discount on order

order_tax

String

Tax on order

order_grand_total

String

Total sum of order

order_total_delivery_costs

String

Delivery costs

order_total_payment_costs

String

Payment costs

subscriber_key

String

Individual key of user in Spryker Commerce

Creating a template in Optimizely Campaign
Create a template and add the desired transactional mail texts (the unchangeable, static
texts that are to be sent to recipients). Insert field functions in places where you want to
show content of the Spryker variables.

About field functions
Field functions are placeholders that refer to a specific recipient list field in your trans-

action recipient list. The variables and content of the variables sent from Spryker are written into the relevant recipient list fields in your transaction recipient list. Your field
functions load relevant content from the referenced recipient list field in the next step.
Example
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Set up a transactional mail text that welcomes each customer using the last name and the
order date. For this you would need the variables salutation, lastname and order_orderdate.
The content of the variables is first written to a relevant recipient list field of the transaction recipient list (from Spryker via the HTTP API). To access these recipient list fields,
insert the individual field functions into the Optimizely Campaign template and place the
name of the recipient list field in curly brackets. To import the variable contents, the static
text and field functions in the Optimizely Campaign template could look like this:
Hello, {salutation} {lastname}!
Thank you for your online order from {oder_orderdate}.

The example will appear in the sent transactional mail as follows:
Hello, Mr. Miller! Thank you for your online order from August 3.
To create the template, do the following:

© Optimizely 2022

Integration and interfaces | 1107

1. Open the Optimizely Campaign menu and select Campaigns > Transactional Mails.
2. Click Create….

3. Drag the Recipients node from the left action area to the workspace area on the right.
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4. In the Recipient lists drop-down list, select your transaction recipient list.

Note: Customer support sets up a separate transaction recipient
list. Be sure you use this transaction recipient list, instead of a regular recipient list. To see if a recipient list is a transactional recipient list, check the column Transaction API.
5. From the left action pane, drag an Emailmessage node into the workspace.
6. In the Name box, assign a concise name to your transactional mail (for example, Order
confirmation).
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7. In the context menu for the message node, click Edit Content….
8. In the Template drop-down list, select the desired template and confirm your selection by clicking Next.
9. Configure the template for the transactional mail according to your requirements.
Enter a subject and insert the static texts that you want recipients to receive, into the
content paragraphs. Insert the relevant field function for the recipient list field of the
transaction recipient list into places where variables from Spryker should appear (see
the previous example in this topic).
10. Click Close.
11. Connect the Recipient node with the message node.
12. Click Save and Close.
13. To activate your transactional mail and start the sending process, select the mailing in
the Transactional mails overview and click Start.
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Configuring transactional mails in Spryker
To set up transactional mails in Spryker, follow the steps on the Spryker documentation website.

Web analytics integrations
This topic gives an overview of web analytics integrations with Optimizely Campaign. Data
transfer is usually bi-directional, so that mailing, recipient, and tracking data is available in
both Optimizely Campaign and the web analysis software. The raw data Optimizely Campaign receives from the web analysis software is available as post clicks you can use in target groups, campaigns, and reports.

Log in to the client interface of the web analysis software to set up and configure the integration. Customer support sets up the integration for your Optimizely Campaign client.
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Web analysis systems
econda

etracker

Google Analytics

intelliAd

Webtrekk

Campaign tracking

✓

✓

✓

✓

✓

Purchased products

✓

✓

✘

✘

✓

Viewed products

✓

✓

✘

✘

✓

Abandoned shopping carts

✓

✓

✘

✘

✓

Revenue

✓

✓

✘

✘

✘

Remarketing campaigns*

✓

✓

✘

✘

✓

Recommendations

✓

✘

✘

✘

✘

User-defined segments**

✘

✘

✘

✘

✓

Setup

Setup

Setup

Setup

Setup

Integrations

Note: * Remarketing campaigns support only bi-directional integrations.
** User-defined segments are configured once at the initial integration setup, and submitted with each data transfer to Optimizely
Campaign.
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Data generation
Web analytics software tracks any website visitor action, from entry to the exit point.
Actions are aggregated to get click paths, segments or funnels. Additional actions, such as
viewed or purchased products and abandoned carts, are enriched with product data (ID,
price, category, number of purchased items and so on). Finally, this data is correlated with
a recipient in your Optimizely Campaign client. This can be done in two ways:
l

l

The entry point is a click a link in a mailing. The email address of the recipient is known
and is associated with every action the recipient carries out (Post-click tracking). Until the
recipient leaves the website, actions are associated with this email address.
The customer logs in or registers with an email address. Actions are tracked and
stored with a temporary ID. If the visitor uses an email address to log in or register, you can
associate these actions with the email address retroactively (user event tracking). If the visitor's browser accepts cookies, you can store and associate actions even if the visitor
leaves the current session and returns later.

Triggered campaigns
Use web analysis software to trigger automated campaigns where a mailing is sent to a
recipient based on criteria matching:
l

l

l

Remarketing. Recipients that viewed a certain product or have put it in the shopping cart
receive a mailing with recommendations for similar products. This can be combined with a
coupon code for these products.
Cross and upselling. Customers who have ordered a certain product receive an order
confirmation with complementary products.
Reactivation. Inactive customers receive an incentive mailing with recommendations
according to their customer history. These can be combined with a coupon code valid for a
limited time.

Regular campaigns
Integrate a web analysis software into regular mailings to increase relevance for recipients:
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l

l

Recommendations based on recipient history. Generate product recommendations
that take into account previous purchases, as recipients pay more attention to personalized offerings with products of interest. Mailings with personalized recommendations
have a higher conversion rate than other mailings.
Recommendations based on products from same price segment. Analyze the preferred price range for a recipient, and send product recommendations from the same price
segment, to increase conversion rate.

Econda Analytics integration
Note: This topic is for administrators and developers with administration access rights in econda.

Note: Available only in Germany, Austria, and Switzerland.
This topic describes the econda Analytics integration with Optimizely Campaign that lets
you use product data from econda Analytics in mailing campaigns. With econda Analytics,
you can collect visitor activity data that can be used to create fine-tuned segments in
Optimizely Campaign. For example, you can specifically address customers with abandoned shopping carts in a remarketing campaign.

Setting up the integration
To access exchanged data, you first need to implement econda Analytics on your website.
The econda customer support will configure the Event Data Stream for data export and
the import of key mailing data. Optimizely customer support will configure the import of
data from the Event Data Stream and the export of the key mailing data. The data from the
Event Data Stream is updated hourly and is available for your regular mailings, transactional mails and Marketing Automation.
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Data generation
Key mailing data
In the forward channel of Optimizely Campaign, key mailing data (KPIs) are automatically
transferred to the econda Analytics. You can access the following data at any time in
econda Analytics:
l
l
l
l
l
l
l
l
l
l
l
l

Date of creation
Mailing ID
Mailing name
Mailing description
Media code (see Processing of analytical data)
Date of dispatch
Number of sent emails
Number of delivered emails
Openings (only absolute values -not unique- are transferred)
Clicks (only absolute values -not unique- are transferred)
Unsubscribes
Bounces

Using behavior data in Optimizely Campaign
In the return channel, the behavior data of newsletter recipients is transferred to Optimizely Campaign, divided into these categories:
l
l
l

Product purchase
Product view
Abandoned shopping cart

You can use this data to create segments in Optimizely Campaign, by creating the corresponding target groups (see below). Use these parameters to create target groups:
l

eventtype. Category of the event (product:buy, product:view or product:cart:abandonment)
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l
l
l
l
l
l

product:pid. Product’s order number
product:category. Product category
sid. Order or process number
order:number. Number of the placed order
product:count. Number of exemplars placed in the shopping cart
product:price. Product price

Identification of the recipients is done using the Recipient ID and the Mailing ID, attached
to the links in the newsletter.

Processing analytical data
When creating a mailing, you can specify a media code to the message node, to be used
for grouping multiple mailings in econda Analytics. For example, assigning mailings within a
multi-stage campaign to the same media code, lets you evaluate these mailings together.
No further configuration is necessary.
Note: To track clicks on individual mailing links and analyze these in
key indicator funnels in econda, contact customer support. Use the
newsletter parameter in econda, enter the media code as the value,
and save this as default setting.
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Creating target groups for use with econda
To use web analytics data, you must first create target groups. Do the following:
1.
2.
3.
4.

Open the Optimizely Campaign menu and select Recipients > Target Groups.
Click Create.
In the Target group definition area, click Add +.
In the second drop-down list, select Action and in the third list, has created one or
more post clicks.
5. If you are using multiple post-click services, select Web analytics in the Service dropdown list.
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6. In the Mailing drop-down list, select the mailings to which the data refers. If nothing is
selected, all mailings are analyzed.
7. Select a date or time in the Period drop-down list to only select post clicks created
within a defined time range or at a certain date. Time entered as a number of days
("Exactly 30 days ago") refer to the current day.
8. In the Category drop-down list, select eventtype then the operator equals.
9. Enter the desired category, for example product:purchase. Note the spelling to make
sure it is identical to the name used by econda. The auto-complete feature assists you
in avoiding errors.
10. Click Apply ✔ . This target group rule will select recipients who have purchased any
type of product. To refine the target group to recipients who purchased a specific
product, add another rule.
11. In the Target group definition area, click Add +.
12. In the Category drop-down list, select product:category then the operator equals.
13. Enter the name of the category as a reference value.
14. If required, add more rules to the target group. You can combine the econda web analytics data with other recipient and campaign data, make sure to test the created target group before first use. In the Analysis area, select a recipient list and click
Calculate
15. Click Apply ✔ .
16. Open Properties and enter a name for the target group. Optionally, enter a description.
17. Click Create.

Etracker Analytics integration
Note: This topic is for administrators and developers with administration access rights in etracker.

Note: Available only in Germany, Austria, and Switzerland.
This topic describes the etracker Analytics integration with Optimizely Campaign that
makes website visitor activity and product data available for email campaigns from the
etracker Analytics. The etracker Remarketing Feed lets you collect visitor activity data
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that can be used for creating segments for target groups and in Marketing Automation. You
can send remarketing emails, addressing customers with specific product views, purchases, and abandoned shopping carts.

Setting up the integration
Contact etracker support to enable the inbound channel and the Remarketing feed function for your etracker account.

Linking extension and outbound channel
If required, create the corresponding campaign in etracker Campaign Control before
sending a mailing.
Optimizely Campaign extends mailing links with these parameters:
l
l
l
l
l
l
l

etcc_rid. RecipientID (unique, coded ID of the recipient)
ettc_mid. MailingID (unique, coded ID of the mailing)
etcc_med. Medium ("email")
etcc_par. Partner ("Optimizely")
etcc_cmp. (name of the mailings)
etcc_var. Media code
etcc_date. Start date of the mailings

To get the exact link in the mailing of etracker, add the parameter etcc_plc to selected
links in your mailing.

Importing segments from etracker
Based on website visitor activities, etracker generates data sets for every event in the
return channel and transfers them to Optimizely Campaign. An event can be a product purchase, a product view or an abandoned shopping cart. To create a segment from these
events, define a target group that filters data sets belonging to the same event type, for
example "product purchase". You can also add additional parameters, for example data
from particular mailings, where applicable.
The following data is transferred hourly:
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Name

Data type

Description

Notes
Instead of these standard
event types, you can define
others on the administrator
page of your etracker
account, for example productRating or the like.

Event

String

One of the following: abandonment, order or productView

context

String

The product ID from your
shop system.

price

Float

The price of the product.

The gross price that is transferred.

Integer

The number of products for
each item.

The total price for each item
can be calculated from the
number of products and the
product price.

String

The order number when
the order is initiated. Using
the order number, data
sets for various products
can be allocated to an
order if they have coinciding order numbers.

String

If no order is initiated, the
session ID helps allocate
multiple products to one
shopping cart.

Number

Order number

Session ID

Creating target groups for use with etracker
To use web analytics data, you must first create target groups in Optimizely Campaign. Do
the following:
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1.
2.
3.
4.
5.
6.
7.

8.
9.
10.
11.

Open the Optimizely Campaign menu and select Recipients > Target Groups.
Click Create.
In the Target group definition area, click Add +.
In the second drop-down list, select Action and in the third drop-down list, select has
created post click.
If you are using multiple post-click services, in the Service drop-down list, select Web
analytics.
In the Mailing drop-down list, select the mailings to which the data refers. If nothing is
selected, all mailings are analyzed.
Select a date or time in the Period drop-down list to only select post clicks created
within a defined time range or at a certain date. Time entered as a number of days
("Exactly 30 days ago") refer to the current day.
In the Category drop-down list, select a value and assign an operator, for example
equals. Use values from Recipient segments, or one of the values previously defined.
Enter a reference value.
Click Apply ✔ .
To combine multiple categories, click Add + and repeat the steps.

12. In the Properties tab, enter a name for the target group.
13. Click Create.
Example: Buyers of a certain product select
1. Open the Optimizely Campaign menu and select Recipient >Target Groups.
2. Click Create.
3. In the Target group definition area, click Add +.
4. In the second drop-down list, select Action and in the third drop-down list, select has
created post click.
5. In the Service drop-down list, select Web analytics.
6. In the Category drop-down list, select event type and assign the operator equals.
7. Enter the reference value order.
8. Click Add + and repeat the actions described under 6 and 7. Instead of event type,
select context and in the reference box, enter XYZ (the name of your product).
9. Open Properties and enter the name buyer of product XYZ . Optionally, enter a
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description and select a folder for saving the target group.
10. Click Create.

Google Analytics integration
Note: This topic is for administrators and developers with administration access rights in Google Analytics.
This topic describes the Google Analytics integration with Optimizely Campaign that
allows for the allocation of mailing recipients and website visitors, to use the evaluation
capabilities of Google Analytics to measure the results of mailing campaigns. The Google
Analytics integration offers a central platform for the evaluation of online campaigns, as
click rates recorded by Optimizely Campaign can be evaluated alongside financial success
of campaigns.

Setting up the integration
You need a Google Analytics user account to access the Google Analytics interface. To set
up the integration in your client, contact customer support. No mailing setting adjustments
are needed, all mailing data is automatically transferred to Google Analytics.

Transferring data
The integration uses an automatic, generic link extension which adds parameters used by
Google Analytics for the allocation of campaigns to links used in the mailing. Google Analytics uses cookies to identify returning visitors. Recipients who initially accessed the website via an mailing campaign, are identified as mailing campaign visitors also when
returning via the website.
Using the link extension, global shipping data is transferred to your Google Analytics
account after dispatch of a mailing. You can view and influence the data aggregation analysis in Google Analytics.
These parameters are used for link extension and data transfer:
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l
l
l
l
l

utm_source
utm_medium
utm_campaign
utm_term
utm_content

Use these standard parameters to automatically transfer data, for example:
l
l
l
l
l
l

Date of creation
Mailing ID
Mailing name
Mailing description
Mailing type
Recipient list fields

Examples:
l

l

To transfer the mailing type Newsletter to Google Analytics, use the utm_source parameter.
To transfer the mailing type, use the utm_medium parameter, and for the mailing name,
the utm_campaign parameter.

You can also combine two data sets and transfer them together using one standard parameter. The mailing name and the corresponding creation date can for example be combined using the utm_campaign parameter. For other combinations and more information,
contact Optimizely customer support.

Viewing data in Google Analytics
Open Google Analytics and select Aquisition > Campaigns > All Campaigns.
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Under All Campaigns, all campaigns are listed by campaign name. Click the campaign title
to view available values in order of time. Website hits generated by a mailing are labeled
by source and medium.
For a better overview, you can sort the data by source (for example, newsletter), medium
(for example, email), source/medium ( for example, newsletter/email) or other criteria.

© Optimizely 2022

1124 | Optimizely Campaign User Guide 2022-03-14

Google Tag Manager integration
Note: This topic is for administrators and developers with administration access rights in Optimizely Campaign.
When using Google Tag Manager (GTM) to implement tracking codes and conversion pixels
on your website, you can connect it with post-click tracking. This lets you set up a data
transfer to Optimizely Campaign to collect data of recipients who have been sent from a
mailing to your website by clicking a link. You can use this data to segment recipients
according to actions on your website and create precisely tailored target groups.
To transfer the action data to Optimizely Campaign, you have to configure a cookie and the
data transfer in Google Tag Manager.
To start the data transfer, finally publish the changes in the Google Tag Manager workspace.
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Prerequisites
l

l

l

Implement Google Tag Manager on your website. See Enhanced Ecommerce (UA)
Developer Guide.
Set up post-click tracking. Let customer support know that you want to use post-click tracking with Google Tag Manager.
Create tracking pixels with and without cookie. If no cookie is created or tracking is disabled, the tracking pixel without cookie (user event tracking) is used.
Note: To access the data in the data layer, see the configuration
steps and notes in the Enhanced Ecommerce (UA) Developer Guide.

Configuring the cookie
To configure the cookie, create a tag in Google Tag Manager as well as associated triggers
and variables.

Creating a tag
A cookie is required to store action data on your website and transfer it to Optimizely Campaign. In Google Tag Manager, you use a tag to create the cookie and embed it on your
website. Do the following:
1. Sign in to Google Tag Manager.
2. Select the container in which you want to configure the cookie.
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3. Click Add a new tag.

4. Enter a name for the tag, for example Cookie-Webshop-Home.
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5. In the Tag Configuration area, click Edit

.

6. Select the Custom HTML tag type.

7. Enter the following script into the input field:
Tip: The following script represents an exemplary implementation. For example, you can extend the cookie to include
and store the UID (unique identifier).
<script>
var cookieName = "o4oclClientId"; // Gives the cookie a name. Replace
"ClientId" with your client ID.
var cookieValue = "true"; // Assigns a value to the cookie.
var expirationTime = 2592000; // Defines the expiration time of the
cookie (30 days).
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// Converts the expiration time into milliseconds.
expirationTime = expirationTime * 1000;
var date = new Date();
var dateTimeNow = date.getTime();
// Sets the expiration time (current time + one month).
date.setTime(dateTimeNow + expirationTime);
// Converts the milliseconds into a UTC time string.
var date = date.toUTCString();
// Sets the cookie for all subdomains.
document.cookie = cookieName+"="+cookieValue+"; expires="+date+"; path=/;
domain=."+location.hostname.replace(/^www\./i, "");
</script>

8. Click Save.

Creating a trigger
Define when the tag is triggered. You can configure individual triggers, for example for the
actions opened detailed view of a product, added a product to the shopping cart, removed
a product from the shopping cart, bought a product. Do the following:
Note: At least one trigger must be assigned to each tag to be
triggered.
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1. In the left menu bar, click Tags.

2. Select the created cookie tag.
3. In the Trigger area, click Edit
4. To add a new trigger, click Add

.
.
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5. Enter a name for the trigger, for example Trigger AddToCart.

6. In the Trigger Configuration area, click Edit
.
7. Select a trigger type, for example Custom event trigger.
Tip: For information about the different trigger types, see
www.support.google.com.
8. Click Save.
9. In the tag's window, click Save.

Creating a variable
To implement the cookie, you have to create a user-defined variable that references Optimizely Campaign. Do the following:
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1. In the left menu bar, click Variables.

2. In the User-Definded Variables area, click New.

3. Enter uid in Episerver Campaign Cookie as name for the variable.
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4. Click Edit

.

5. Click 1st Party Cookie.

6. Enter o4oclClient-ID in the Cookie Name field. Replace Client-ID with your client ID,
for example o4ocl0123456789.

7. Click Save.
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Configuring the data transfer
To configure the data transfer, create a tag in the Google Tag Manager as well as associated triggers and variables.

Creating a tag
To transfer the action data from your website to Optimizely as post-click data, you have to
create a tag. The tag accesses the collected data of the previously created cookie. Do the
following:
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1. In the left menu bar, click Tags.
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2. Enter a name for the tag, for example Tracking-Webshop-Home.

3. In the Tag Configuration area, click Edit

.
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4. Select the Custom HTML tag type.

5. Enter the following script into the input field:
Tip: The following script represents an exemplary implementation. Depending on how you collect and store customer
data, the implementation may differ.
</script>
var campaignCookie = {{uid in Episerver Campaign Cookie}}; // Variable
that stores the cookie name.
var uid = {{uid}}; // Variable for identifying the user via shop login,
GTM data layer and so on
var products = {{ecommerce add products}}; // Variable for the information of the GTM data layer.
var standardBasicUrl = "https://domain.tld/pc?mg=ClientID"; // Tracking
URL including the client ID. Replace "ClientId" with your client ID.
var userEventBasicUrl = "https://domain.tld/pc?type=userEvent&authToken=XXX-YYY-ZZZ"; // Tracking URL including authentication token.
var service = "serviceName_ClientId"; // Post-click tracking service used
in Optimizely Campaign. Replace "ClientId" with your client ID.
// Queries whether a cookie is set on the website. If not, user event tracking is used.
if (typeof campaignCookie !== "undefined") {
var basicUrl = standardBasicUrl
+ "&bi=0"
+ "&service=" + service;
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} else if (typeof uid !== "undefined") {
var basicUrl = userEventBasicUrl
+ "&bi=0"
+ "&recipientId=" + uid
+ "&service=" + service;
}
// Extracts the data in the GTM data layer and merges them into a URL.
if (typeof basicUrl !== "undefined" && typeof products !== "undefined") {
for (var i = 0; i < products.length; i++) {
var product = products[i];
if (typeof product !== "undefined") {
var url = basicUrl
+ "&fvalue1="+ product.price
+ "&fvalue2="+ product.quantity
+ "&gvalue1="+ product.name
+ "&gvalue2="+ product.id
+ "&gvalue3="+ product.brand
+ "&gvalue4="+ product.category
+ "&gvalue5="+ product.variant
+ "&gvalue10="+ Date.now();
var scriptElement = document.createElement("script");
scriptElement.src = url;
document.body.appendChild(scriptElement);
}
}
}
</script>

6. Click Save.

Creating a trigger
Define when the tag is triggered. You can configure individual triggers, for example for the
actions opened detailed view of a product, added a product to the shopping cart, removed
a product from the shopping cart, bought a product. Do the following:
Note: At least one trigger must be assigned to each tag to be
triggered.
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1. In the left menu bar, click Tags.

2. Select the created cookie tag.
3. In the Trigger area, click Edit
4. To add a new trigger, click Add

.
.
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5. Enter a name for the trigger, for example Trigger AddToCart.

6. In the Trigger Configuration area, click Edit
.
7. Select a trigger type, for example Custom event trigger.
Tip: For information about the different trigger types, see
www.support.google.com.
8. Click Save.
9. In the tag's window, click Save.

Creating variables
To transfer data to Optimizely Campaign, you have to create user-defined variables for the
data in the GTM data layer and for user identification from other sources (shop login, and
so on).
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GTM data layer
1. In the left menu bar, click Variables.

2. In the User-Definded Variables area, click New.
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3. Enter ecommerce add products as name for the variable.
4. Click Edit

.

5. Click Data Layer Variable.

6. In the Data Layer Variable Name field, enter the name that refers to the GTM data
layer, for example ecommerce.add.products.

7. Click Save.
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Setting up the data layer on your website
To enable the variables to receive data and transmit it to Epi, your website requires a data
layer. See the Enhanced Ecommerce (UA) Developer Guide.
The following script shows an example integration of a data layer for collecting user data
when products are added to the shopping cart. Insert the script before the GTM code in
the HTML header of your website.
</script>
window.dataLayer = window.dataLayer || []; // Creates the data layer object.
dataLayer.push({
'event': 'addToCart',
'ecommerce': {
'currencyCode': 'EUR',
'add': {
'products': [{
'name': 'ProductName',
'id': '12345',
'price': '29.99',
'brand': 'BrandName',
'category': 'Category',
'variant': 'Color',
'quantity': 1
}]
}
}
});
</script>
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User idetification
1. In the left menu bar, click Variables.

2. In the User-Definded Variables area, click New.
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3. Enter uid as name for the variable.
4. Click Edit

.

5. Click Custom JavaScript.

6. Enter the following JavaScript code into the input field:
function() {
var uid = new URLSearchParams(window.location.search).get('uid');
if (uid) {
return uid;
} else{
return;
}
}

7. Click Save.

IntelliAd integration
Note: This topic is for administrators and developers with administration access rights in intelliAd.
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This topic describes the intelliAd integration with Optimizely Campaign that lets you evaluate and optimize email campaigns together with other online channels. In addition to the
email channel, intelliAd can analyze search engine marketing, affiliate marketing and price
search engines. Clicks from newsletters are tracked and assigned to an email channel, and
displayed in the campaign overview.
The integration uses link masking to redirect links in a tracked mailing via the intelliAd
server. The masked links are automatically generated and include multiple parameters
enabling them to be assigned to a specific client. You generate an ID string in intelliAd and
enter it in the intelliAd tab when creating the mailing. When clicking a masked link, the
recipient will first be redirected to the intelliAd tracking server (without noticing). The
tracking server analyzes the parameters included in the extension and saves them in the
database. The recipient is then redirected to the actual target page.

Setting up the integration
You need an intelliAd account but the integration does not require any direct data
exchange between Optimizely Campaign and intelliAd. In Optimizely Campaign, intelliAd is
integrated into the mailing creation process.

Extending links
These parameters are added to each mailing link:
l
l
l
l

intelliAdcustomerId. Identifies the intelliAd customer.
marktId. Identifies Optimizely Campaign as the source of the link.
channelId. Identifies the marketing channel, usually email or newsletter, for mailing links.
campaignId. Identifies a campaign in intelliAd. Multiple channels can be combined into a
single campaign.
Note: This ID does not belong to a Marketing Automation campaign in Optimizely Campaign.

l
l

adGroupId. Identifies an AdGroup.
subId. Generated from the mailing ID and the subject of the mailing.

© Optimizely 2022

1146 | Optimizely Campaign User Guide 2022-03-14

Configuring mailings
When creating a mailing, enter the ID string in the intelliAd tab in your intelliAd account.
The ID string consists of six blocks of numbers using this format:
9353935333236323131303-100-4363735313236323131303-101-101-101

Each block of numbers encodes one of the link parameters specified above with the exception of the subId parameter, which is generated from Optimizely Campaign. The intelliAd
tracking is activated when an ID string is saved for a mailing. Links in the mailing are created when the email is delivered, using this format :
http://t23.intelliad.de/index.php
?redirect=http://www.beispiel.de/shop/products/raincoat-blue
&cl=12345
&bm=100
&bmcl=123
&cp=111
&ag=222
&subid=12345|FirstNewsletter|ProductLink

Note: The redirect parameter includes the original URL and is URLencoded. In this example, breaks are added and encoding is omitted
for readability reasons.

Links without tracking
By default, the following links are not tracked via intelliAd.
l
l
l
l
l

Link to the online version
Unsubscribe link
double opt-in link
Links to landing pages
SWYN links
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Analyzing intelliAd performance
Sign in to intelliAd and select the channel optivo broadmail in the dashboard. The
timeline displays clicks in the selected channel, and you can filter results according to the
criteria you defined.

Webtrekk integration
Note: This topic is for administrators and developers with administration access rights in Webtrekk.

Note: Available only in Germany, Austria, and Switzerland.
This topic describes the Webtrekk integration with Optimizely Campaign that makes website visitor action and product data from Webtrekk Q3 available in for designing
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remarketing campaigns, and adding personalized recommendations or a coupon code to
mailings. The integration allows bi-directional exchange of mailing statistics, dispatch and
action data.

Setting up the integration
You need a Webtrekk account and the website to be tracked must be configured accordingly. See the Webtrekk documentation or contact the Webtrekk customer support to set
up the site tracking. The setup of the data interface integration with Optimizely Campaign
is done by Optimizely customer support. When completed, web analytics data is automatically imported into Optimizely Campaign.

Data generation
Key mailing data
The outbound channel from Optimizely Campaign to Webtrekk transmits the key mailing
data (KPI), triggered automatically after a mailing is dispatched. The data is updated daily.
The following data is available in Webtrekk:
l
l
l
l
l
l
l
l
l
l
l

Creation date
Mailing-ID
Mailing name
Mailing description
Media code
Number of sent emails
Unsubscribes
Opens (only absolute values -not unique- are transferred)
Clicks (only absolute values -not unique- are transferred)
Soft bounces
Hard bounces
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Recipient segments
The inbound channel transmits segments based on activities of website visitors to Optimizely Campaign. Each segment contains events (data sets) identical in reference to a
defined criterion, for example a product purchase.
The following segments are defined by the integration:
l
l
l

orders. Product purchases.
productViews. Product views.
abandonments. Abandoned shopping cart items.

Each data set contains additional parameters, that can be used to refine target groups in
Optimizely Campaign:

l

Mailing-ID. ID of the mailing from which the action is initiated.
Recipient-ID. ID of the recipient carrying out an action.
Mailing-To-User-ID. Unique ID which combines mailing and recipient IDs.
Datum. A random date, formatted internationally. Actions are stored by the hour.

l

Context. Product designation or additional context data.

l
l
l

Data security
Personal data security is guaranteed for both output and return channels. Mailing links are
expanded with anonymized recipient and campaign data. This prevents parameters from
being associated with a recipient, either directly or by fraud via third parties. The return
channel re-associates the anonymized data with the mailing recipients and campaigns.

Configuring data exchange
Optimizely customer support configures the key mailing data that you can import into
Webtrekk, as well as import of segments generated by Webtrekk. Contact Webtrekk customer support to configure your Webtrekk account.

Creating target groups in Optimizely Campaign
Do the following to create a target group from recipient segments generated by Webtrekk.
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1.
2.
3.
4.
5.
6.
7.

8.
9.

10.

Open the Optimizely Campaign menu and select Recipients > Target Groups.
Click Create.
Enter a name for the target group and click Add + in the Target group definition area.
In the second drop-down list, select Action and in the third drop-down list, select has
created post click.
If you are using multiple post-click services, select web analytics in the Service dropdown list.
In the Mailing drop-down list, select the desired mailings. If nothing is selected, all
mailings are analyzed.
Select a date or time in the Period drop-down list to only select post clicks created
within a defined time range or at a certain date. Time entered as a number of days
("Exactly 30 days ago") refer to the current day.
In the Segment drop-down list, select product purchases (orders), product views (productViews), or abandonments (abandonments) to filter.
Optionally, in the Context box, enter a product ID to only filter recipients that viewed,
bought or placed a certain product in the cart. If nothing is specified, products will be
considered.
Click Apply ✔ .

11. To combine multiple categories, click Add + and repeat previous steps.
12. Open Properties, enter a name for the target group. Optionally, enter a description.
13. Click Create.
Example: Creation of the target group Transaction aborted
To define a target group capturing aborted shopping cart transactions during the first
quarter of 2022, do the following in the Create target group window:
1. Create a new target group and in the Target group definition area, click Add +.
2. In the second drop-down list, select Action and in the third drop-down list, select has
created post click.
3. In the Period drop-down list, select from... to... and use the calendar to select the
period from 1 January 2022 to 31 March 2022.
4. In the Segment drop-down list, select Abandonments.
5. Click Apply ✔ .
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6. Open Properties and enter Abandonments in the Name field.
7. Click Create.

CRM integrations
The Optimizely Campaign CRM integrations lets you manage campaigns and select leads
and contacts as in your CRM system, and work with mailing creation and dispatch in Optimizely Campaign. You can send personalized content and measure campaign performance
directly in CRM, and based on the data, design multistage and re-mailing campaigns.
See the CRM integration guide for an introduction to working with Optimizely Campaign
and CRM systems.

CRM systems
Theme

DOI Round-Trip

Campaigns

Recipients

Integration

Microsoft
Dynamics
CRM

Salesforce

SAP

Automatic synchronization of
unsubscribes

✓

✓

✓

Send DOI

✓

✘

✘

Import DOI

✓

✓

✘

Multiple DOI per entity

✓

✓

✓

Flexible DOI mapping — Multi
client mapping

✓

✓

✓

Selections in CRM

✓

✓

✘

Start campaign

✓

✓

✘

Assign Optimizely Campaign
reactions

✓

✓

✘

Transmission of custom fields

✓

✓

✓

Synchronization of recipient

✓

✓

✓
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Microsoft
Dynamics
CRM

Salesforce

SAP

Use Marketing Automation

✓

✓

✓

Use Smart Campaigns functions

✓

✓

✓

Custom fields

✓

✓

✓

Flexible client mapping

✓

✓

✓

Scalability

✓

✓

✓

Support newest versions

✓

✓

✓

Full featured admin interface

✓

✓

✘

Send transactional-mails

✓

✘

✘

Omni-channel support (E-Mail,
SMS, Mobile Push)

✓

✓

✓

Bounce management

✓

✓

✓

Support PersonAccounts
(Salesforce)

✘

✓

✘

Support managed packages

✓

✘

✘

Theme

Integration

lists

Admin

Messaging

Platform specific

CRM integration guide
This section provides an introduction to working with Optimizely Campaign, and integrations with CRM systems. You can integrate email service providers with campaign management, and CRM and business and customer intelligence systems.
Optimizely Campaign provides email sending, and SMS, as well as synchronized advertising
consents and recipient lists.
l

Campaign management. With its closed-loop interface, Optimizely Campaign auto-

matically captures transfer of recipient data and return of response data, for example opt-
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l

l

out and bounces, for flexible management of recipient data from the CRM system. You can
enrich mailing openings, clicks, bounces, and unsubscriptions, so these events become
available as leads or contacts in CRM.
Opt-in management. You can exchange double opt-in information between Optimizely
Campaign and a third-party system. Advertising consents can refer to many types of
media, for example email, and SMS.
Synchronize recipient data. Optimizely Campaign’s entire range of features is available with
the synchronization of recipient lists. Marketing Automation or Smart Campaigns are independent of a CRM system, and can return bounces and unsubscriptions.

Managing campaigns
CRM (customer relationship management) systems generally have the ability to define
campaigns. Leads and contacts are added to a campaign – sometimes indirectly via marketing lists or dynamically via machine-learning algorithms – and campaign activities are
subsequently defined and executed. Using the closed-loop service, you can transfer members of a campaign to Optimizely Campaign. With additional meta-information (Client ID
and/or opt-in ID and mailing ID), the appropriate mailing is triggered in Optimizely Campaign. Events that follow the campaign, such as openings, clicks, bounces or unsubscriptions, are then made available to the CRM system. See Closed-loop Interface.

Personalizing and formatting a recipient
Note: Contact customer support to help you define the recipient list
format - the columns containing information transferred to Optimizely Campaign.
The recipient list must contain the desired personalization information. For example, to use
recommendations from CRM, place the product information in the recipient list. To use a
personalized greeting and/or complimentary close (so the contact’s sales owner appears
as point of contact in the salutation), transfer the corresponding sales owner fields.
You can also add recipient list fields to response data, making it easier to assign events in
CRM, such as open or click. For example, providing two fields in the recipient list for identifier of entities, these can be transferred back in the response data.
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Example: A contact has a unique ID <contact-id> and each campaign has a unique identifier <campaign-id>. Both fields are added to the recipient list, and the entities are transferred to Optimizely Campaign. When clicking the link in the sent email, the recipient
receives the result with the corresponding <contact-id> and <campaign-id>, so you can
assign events to a contact or a campaign response.
The displayed fields depend on the CRM system. Typical identification fields may be <contact-id>, <lead-id>, <campaign-id>, <campaign-member-id>, <member-id> or <list-id>.
Protocols and feedback
You can use either SFTP or SOAP protocols for data transfer. SOAP transfers the data via
XML (extensible markup language); you have better performance with sending CSV files
via SFTP, especially for large campaigns with several hundred thousand campaign members.
When a campaign is sent, Optimizely Campaign can create feedback messages such as an
email notification. Optimizely Campaign can also call up SOAP services and systemically
display the processing and send status.
Process sequence
After the CSV file is delivered or data transfer is completed through the SOAP service, no
further action is required on the part of the CRM or the requesting party. The following process automatically takes place in Optimizely Campaign:
1. After successful transfer, the recipient data is automatically loaded into a recipient list.
The recipient lists used for this purpose are subject to a check by the closed-loop services and have the Z_CampaignUserList prefix. Lists with this prefix are automatically
created and managed. These special lists may not be used for other purposes – neither
through interfaces nor through Optimizely Campaign’s front-end. These lists may not
be used, filled nor otherwise addressed using an Optimizely Campaign API (application
programming interface) method.
2. After the recipient data is fully imported, the specified mailing will automatically be
copied. If you start a campaign from the CRM system via the closed-loop service, you
will also find a sent mailing in the mailing overview.
3. After the mailing is sent, results are recorded, prepared and made available. These
include opens, clicks, bounces and unsubscriptions. Bounces and unsubscriptions are
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directly linked to an email address and should be saved at the appropriate entities in
CRM. For instance, there is no point in continuing to send messages to an email
address that has bounced out. If someone unsubscribes, then this must be saved in
the appropriate contact and/or lead and, if necessary, in an advertising consent.
Note: Recipient lists match database tables. These are generally generated individually according to your requirements in a format specified by customer support. This format is static and may not be
changed without consulting customer support.

broadmail_ID parameter
The broadmail_ID denotes a mailing. The advertising channel (email, SMS) also appears on
the mailing. Therefore, the broadmail_ID can also be used to trace back the medium. In
addition to the mandatory broadmail_ID, the CRM system can also issue a numerical
wave-ID for a mailing, with which the mailing wave is identified. If a mailing is sent in multiple steps, then the mailing identity can be inferred using the wave_ID. The broadmail_ID
and the wave_ID must be unique Grouping different mailings into one mailing wave is not
possible. Furthermore, the recipient’s email address is a mandatory field in the recipient
list.
Example: The following code block shows an implementation example of how a campaign
with two recipients can be started by Optimizely Campaign using SOAP services. The surrounding category provides the necessary member variables, for instance, the
closedLoopWebservice object makes available the methods documented in the SOAP
API.
/**
* Use case: Initialise and start campaign
* The following class is an implementation on how to start a campaign
* via Closed Loop Webservice.
*/
private class ImportRecipientsAndStartCampaign extends UseCase {
@Override
void runExceptional() throws Exception {
// create a waveId, fix the template mailing
_waveId = _closedLoopWebservice.prepareNewWave(
_session.getSessionId(), TEMPLATE_CAMPAIGN_ID);
// The recipient field names can be different for every client
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// and are defined once during the configuration process in
// optivo broadmail. Within the example code we used
// recipientFieldNames are for demo purposes with most common
// used fields.
String[] recipientFieldNames =
{ "salutation"
, "firstname"
, "lastname"
, "title"
, "birthday"
, "mobile"
, "email"
, "street"
, "zipcode"
, "city"
, "state"
, "country"
, "extentityid"
, "extcampaignid"};
String[][] recipientFieldValues =
{
{ "Mr."
, "John"
, "Doe"
, "Phd"
, "17.2.1956"
, "0049307680780"
, "it-demo-mr@example.com"
, "Wallstrasse 16"
, "10179"
, "Berlin"
, "Berlin"
, "Germany"
, "SAP-321XWZ654987"
, "SAP-987ABG654223"
}
, { "Mrs."
, "Jane"
, "Doe"
, "Phd"
, "17.2.1952"
, "0049307680780"
, "004930768078199"
, "it-demo-mrs@example.com"
, "Wallstrasse 16"
, "10179"
, "Berlin"
, "Berlin"
, "Germany"
, "SAP-321XWZ654988"
, "SAP-987ABG654223" } };
_closedLoopWebservice.importRecipients(
_session.getSessionId()
, _waveId
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, recipientFieldNames
, recipientFieldValues);
// initialise the point in time the campaign will start to
// generate response data
_since = _closedLoopWebservice.getCurrentTime(
_session.getSessionId());
_closedLoopWebservice.importFinishedAndScheduleMailing(
_session.getSessionId(), _waveId);
}
}

You can request the mailing status after transferring a campaign. The following category
shows the methods that need to be invoked.
/**
* Use case: Receive campaign status.
* Use this code to ask campaign status from optivo broadmail. This
* makes sense after calling the use case "Initialise and start campaign"
*/
private class DetermineCampaignStatus extends UseCase {
@Override
void runExceptional() throws Exception {
if (_waveId <= 0) {
throw new IllegalStateException("waveId not positive.");
}
// Since the campaign is copied before it is started, we
// have to translate the wave id to the campaign id that
// was actually sent ...
long campaignId;
do {
campaignId = _closedLoopWebservice.getMailingIdByWaveId(
_session.getSessionId(), _waveId);
if (campaignId <= 0) {
sleepOneMinute();
}
} while (campaignId <= 0);
// customise this to your needs. After a campaign switched to
// status SENT, the status will be immutable
while (true) {
String campaignStatus = _mailingWebservice.getStatus(
_session.getSessionId(), campaignId);
if ("DONE".equals(campaignStatus)) {
break;
}
if ("PAUSED".equals(campaignStatus) || "CANCELED".equals(
campaignStatus))
{
throw new RuntimeException(
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"Campaign is " + campaignStatus);
}
String campaignName = _mailingWebservice.getName(
_session.getSessionId(), campaignId);
// Log status for messages of campaign too.
long[] messageIds =
_splitMailingWebservice.getSplitChildIds(
_session.getSessionId(), campaignId);
for (long messageId : messageIds) {
String messageStatus = _mailingWebservice.getStatus(
_session.getSessionId(), campaignId);
String messageName = _mailingWebservice.getName(
_session.getSessionId(), messageId);
}
sleepOneMinute();
}
}
private void sleepOneMinute() throws InterruptedException {
Thread.sleep(TimeUnit.MINUTES.toMillis(1));
}
}

You can also show your campaign manager the available templates. The following example
shows a query for the Smart Campaigns.
/**
* Use case: Read available campaigns for closed loop scenario
* This is a usability method. You can show available Smart Campaigns
* to your campaign manager. Scenario for smart campaigns only.
*/
private class GetCampaignData extends UseCase {
@Override
void runExceptional() throws Exception {
String campaignType = "regular";
String campaignStatus = "ACTIVATION_REQUIRED";
long[] campaignIds = _mailingWebservice.getIdsInStatus(
_session.getSessionId(), campaignType, campaignStatus);
for (long campaignId : campaignIds) {
String campaignName = _mailingWebservice.getName(
_session.getSessionId(), campaignId);
String description = _mailingWebservice.getDescription(
_session.getSessionId(), campaignId);
long[] messageIds =
_splitMailingWebservice.getSplitChildIds(
_session.getSessionId(), campaignId);
for (long messageId : messageIds) {
String messageName = _mailingWebservice.getName(
_session.getSessionId(), messageId);
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String messageDescription =
_mailingWebservice.getDescription(
_session.getSessionId(), messageId);
}
}
}
}

Processing response data
Response data processing must be implemented when a campaign is being executed.
Bounces, unsubscriptions and replies are part of these processes. You have the choice of
using Optimizely Campaign’s features for managing unsubscriptions or implementing proprietary processes in CRM. Processing unsubscriptions and replies is mandatory due to
applicable rules on advertising consents and competition law.

Unsubscribing via Optimizely Campaign
An unsubscribe link must be included in every email. If the link points to Optimizely Campaign, the recipient is added to the unsubscribed list in Optimizely Campaign, and receives
no more email. The unsubscribed list in Optimizely Campaign has precedence over additional mailings. This means that recipients do not receive emails even if they are included
in a CRM selection which is transferred to Optimizely Campaign. The unsubscription can
only be revoked using a new double opt-in process.
If the recipient has unsubscribed using the Optimizely Campaign processes, the unsubscription is sent back to the CRM using the closed-loop interface. The CRM system must
process the unsubscriptions obtained in this manner and save them in applicable entities.
The transferred selections may not contain any recipients that have effectively revoked
their advertising consent.
If an unsubscription is performed via another method, such as through the customer center in a shop system, then these unsubscriptions do not necessarily have to be sent to
Optimizely Campaign, provided that the unsubscriptions are actively saved in the referentially-leading system. In any case, it must be ensured that active unsubscriptions are
not included in selections and campaigns sent to Optimizely Campaign.
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Unsubscribing via third-party systems
If you use your own unsubscription links, Optimizely Campaign will not receive any information about unsubscriptions. Forwarding is not possible. In this case, the systemic responsibility for properly using advertising consents lies fully with CRM.

Reply emails
Recipients can answer emails and express additional requests such as an unsubscription.
Either of these returned emails are processed in the Optimizely Campaign’s user interface,
or forwarded to the inbox of your choice, as configured in Optimizely Campaign.

Data formats
Each field in the recipient list can be filled via the closed-loop interface or HTTP API. The
data format in the transferred files can be mapped to fields in the recipient list, irrespective of the set-up of the closed-loop interface. Therefore, the format of the recipient
list does not necessarily match the one that the closed-loop interface expects. Contact
customer support for exact data formats.
Conversely, the HTTP API can directly fill fields in the recipient list. The names of the HTTP
parameters here must directly match the ones stated in the recipient list. See HTTP API.

Event emails
Event emails are typically triggered by a certain event. For instance, this can be a registration, or an order placement or cancellation. This type of email can ideally be sent over
the HTTP API. Here, you can save a decided recipient list suitable for sending these special
mailings. You can link as many mailings as you want to this recipient list and send resultbased emails individually. This type of integration is also suitable for Marketing Automation
campaigns triggered based on events and points in time.
Implementation example
The following code block shows an example of how response data can be retrieved.
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/**
* Use case: Get response data
* This use case shows how to receive and process reponse data.
* Response data are fetched within a certain interval, usually
* 1-4 h, and processed according to your system needs.
*/
private class GetResponseData extends UseCase {
@Override
void runExceptional() throws Exception {
long until = _closedLoopWebservice.getCurrentTime(
_session.getSessionId());
int numberOfRows = 1000;
int startRow = 0;
String[][] recipients;
do {
recipients = _closedLoopWebservice.getRecipients(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(recipients);
startRow += numberOfRows;
} while (recipients.length >= numberOfRows);
startRow = 0;
String[][] clicks;
do {
clicks = _closedLoopWebservice.getClicks(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(clicks);
startRow += numberOfRows;
} while (clicks.length >= numberOfRows);
startRow = 0;
String[][] opens;
do {
opens = _closedLoopWebservice.getOpens(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(opens);
startRow += numberOfRows;
} while (opens.length >= numberOfRows);
startRow = 0;
String[][] links;
do {
links = _closedLoopWebservice.getLinks(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(links);
startRow += numberOfRows;
} while (links.length >= numberOfRows);
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startRow = 0;
String[][] responses;
do {
responses = _closedLoopWebservice.getResponses(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(responses);
startRow += numberOfRows;
} while (responses.length >= numberOfRows);
startRow = 0;
String[][] unsubscribes;
do {
unsubscribes = _closedLoopWebservice.getUnsubscribes(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(unsubscribes);
startRow += numberOfRows;
} while (unsubscribes.length >= numberOfRows);
startRow = 0;
String[][] mailingUnsubscribes;
do {
mailingUnsubscribes =
_closedLoopWebservice.getMailingUnsubscribes(
_session.getSessionId(),
_since, until, startRow, numberOfRows);
processData(mailingUnsubscribes);
startRow += numberOfRows;
} while (mailingUnsubscribes.length >= numberOfRows);
_since = until;
}
// customize this method according to your needs. This
// includes creating campign reactions or upsert subscription// or bounce status to your entities.
private void processData(String[][] values) {
if (values.length == 0) {
// process no values here
} else {
for (String[] click : values) {
// process your business logic/campaign reactions here
}
}
}
}

The following code demonstrates how a recipient’s bounce status can be reset.
/**
* Use case: Reset bounce status
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* This is an example of how to reset the bounce status
* of a recipient.
*/
private class ResetBounceStatus extends UseCase {
@Override
void runExceptional() throws Exception {
resetBounceCounter(EMAIL_ADDRESS);
}
private void resetBounceCounter(String emailAdress)
throws WebserviceException {
_responseWebservice.resetBounceCounter(
_session.getSessionId(), emailAdress);
}
}

Managing opt-ins
Optimizely lets you display multi-channel advertising consents, which can also be synchronized with different fields in the CRM (customer relationship management) system
provided it has this feature. This lets a contact or a lead issue multiple different advertising
consents for different newsletters, to get an overview of consents for channels in your
CRM.

How it works
You can connect multiple clients in Optimizely Campaign from your CRM. The advertising
consents in CRM are already saved or you already performed the necessary adjustments
for them. In either case, the CRM provides a full view of recipients, and changes to the
advertising consents from third-party systems carry over.
For example, the advertising consents can be represented by Boolean fields or a check box
at the contact, lead, or account entities. They can refer to a channel (email, SMS) and/or a
certain newsletter. The CRM does not have to make any content-related distinctions, and
can immediately handle the consents. The types of consents (contact, lead, account) must
be the same for relevant entities (Boolean value check box or tick box). The types of consents required depend on your campaign plans and data structure. You are responsible for
depicting it in your CRM.
Events such as unsubscriptions or bounces relate to a specific advertising consent. For the
systems involved to be consistently aware of the consent and related medium, you must
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save the appropriate information in CRM. The easiest way is using a table with the advertising consents you are using. In this table, each row represents an advertising consent
where you can assign the consent using a unique identification. If you need to process an
unsubscription from Optimizely Campaign, the transferred identification is used to determine the affected advertising consent. You can also delete advertising consents for the
appropriate marketing channel for a contact or lead in case of a hard bounce. An email
address bouncing has nothing to do with a specific advertising consent.

Data structure
This list shows a data structure for advertising consents:
l

l
l

l

l

l

opt-in-ID. Generic field for a unique ID issued by CRM (not visible, quasi an AUTOINCREMENT field, sequence or GUID).
description. Unique name displayed to the user and used for identification (visible).
media-type. Marketing channel. The user can select email, email and SMS in this dropdown list (visible).
broadmail-client-id. Reference to a client-ID in Optimizely Campaign configured in CRM
(visible).
reference-bounce. Reference to a bounce field (visible). If empty, then no bounce is managed for the channel. Mandatory for email channel.
reference-opt-in. Reference to an advertising consent in the contact, lead, or account
entity. You can save the contact or lead field that needs to be administrated.

Instead of saving tables and references, you can archive the logic in code or XML files for
simple applications. The data model in this example shows what advertising consents may
look like when linking advertising consent to a client in Optimizely Campaign.

CRM-ID

Name

Reference field

Type

Client

Reference
bounces

AS10345761204

Fan
newsletter

crm.custom.lead.fanopt-in

Email

10344523412435

crm.custom.lead.fanbounces

FG10457145612104

Premium fur-

crm.custom.lead.premium-

Email

14351098251023

crm.custom.lead.premium-
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CRM-ID

SMS10016784235

Name

Reference field

Type

Client

Reference
bounces

niture

opt-in

bounces

SMS
ticker

crm.custom.lead.smsticker-opt-in

crm.custom.lead.smsticker-bounces

SMS

1456123461025

Controlling campaigns and transferring data
If a campaign needs to be sent from CRM, select the advertising consent and the message
template. You can determine the client to use in Optimizely Campaign by using the data
model for advertising consents.
The technical connection of the closed-loop services must be expanded by additional
fields in this scenario. The following additional parameters are transferred to Optimizely
Campaign, in addition to the data of the determined recipient list: consent description,
opt-in ID and media type (marketing channel). The opt-in ID and the media type are sent
back to CRM as a component of the closed-loop circle for bounces, unsubscriptions, and
so on. When an unsubscription or bounce occurs, CRM enters the cancellation of the
advertising consent or the bounce into the appropriate entity (i. e. lead, contact) accordingly. Using the transferred parameters, you can tell which contacts/leads/accounts and
which advertising consent are affected. You also can carry out additional actions through
the media-type field, as described above.

Changing bounce or subscription status
Optimizely Campaign blocks an email address from sending more messages when there
are too many bounces. You can change the bounce status of a recipient in CRM, for
example when the recipient has ensured that the error would be resolved after a temporary problem. The usual design patterns for implementing this functionality as part of
CRM are save interceptors or observers with which you can respond to data changes. This
is only an example, if required the CRM will use its own design pattern for this case.
The bounce counter is set per client in Optimizely Campaign. Therefore, unlock clients in
which the bounce counter was exceeded. You must save the appropriate information to
CRM or, alternatively, reset the bounce counter in configured clients. To do this, use the
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resetBounceCounter method from the responseWebservice, carefully following the

instructions in the documentation on changing the media type (marketing channel).
To set the subscription status, use the advertising consent to determine the correct client,
then trigger a new DOI process for the subscription in question. Unless the unsubscriptions are also processed in Optimizely Campaign, you should manage the DOI process
using Optimizely Campaign also. In this case, an unsubscription is re-delivered after a successful DOI.

Synchronizing recipient data
Data such as reports, marketing lists, or comparable filters in recipient lists, contained in
CRM (customer relationship management) , should be individually copied into Optimizely
Campaign, for example with a daily transfer.
To manage campaigns in Optimizely Campaign, copy the recipient data from your CRM
into the regular recipient lists. Depending on requirements and the CRM data structure,
you can define fixed export formats. CRM users can filter contacts, leads and/or accounts
through reports or marketing lists, which are automated and regularly transferred to Optimizely Campaign. Using a CMS database, you can fill recipient lists in clients in Optimizely
Campaign, and use the data for Smart Campaigns and other Optimizely Campaign features.

Implementation
l
l
l
l

Relate the selection of recipients to precisely one advertising consent.
Do not mix advertising consents.
Specify the desired fields with customer support beforehand.
Transfer technical fields: opt-in-id, description, media-type, entity-type (contact, lead,
account, ...), entity-id (ID of the contact/lead/account from CRM).

Incremental export processes have proved less robust. You should clear the list daily using
the clear method from RecipientWebservice, and fully re-fill it using the addAll3 method
from RecipientWebservice.
Unsubscriptions and bounces from Optimizely are imported into CRM before the data
transfer using two CSV files (bounces and unsubscriptions), requested by Optimizely Campaign via SOAP. This prevents unsubscribed and bounced out subscribers from being readded to the recipient list during the copy process.
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Response data
Response data is asynchronously prepared through regular, ongoing jobs (once a day by
default). Shorter intervals can also be configured depending on your requirements. The lifetime of the response data is set between 14 and 30 days. The recipient list is recycled after
a certain period of time when using the closed-loop interface. Response records are still
available, but can no longer be clearly categorized.
If recipient data from synchronized recipient lists is used for campaigns in Optimizely Campaign, then the respective campaign context is unknown in CRM and it does not make
sense to make information such as opens or clicks available to CRM in the feedback channel. This data can be made available if the CRM can process it.
In contrast, bounces and unsubscriptions refer to entities such as contact, lead, or account
in CRM. This data is made available and needs to be processed by CRM. The applicable
bounce status or the advertising consent must be then set to the applicable entities.
If a response data flow is configured, then the response data is exported for a client’s mailings, which you can import into CRM. It does not matter whether an email is sent via the
HTTP API, as a campaign email via closed-loop, or as a standalone mailing in Optimizely
Campaign. The opens and clicks are ignored for campaign responses that did not have any
campaign in the CRM.

Concluding information
l

l

l
l
l

Blocklists use the email address as a primary criterion. If an email address is entered into
the blocklist, then no emails are sent to the address. You can manage blocklists using
Optimizely Campaign’s front-end.
All features can be used in parallel in Optimizely Campaign. Note the limitations for the
recipient lists.
Use UTF-8 as data format.
Use unique file names, including when delivering campaign data.
If you use the file API, use the header rows to make troubleshooting easier.
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Salesforce add-on
Note: This topic is for administrators and developers with administration access rights in Salesforce.
With the Salesforce add-on, you can send mailings from Salesforce, and use contact and
lead data to automatically personalize the content. You can transfer customer-specific
fields (up to the third level) to recipient lists, and personalize salutations for leads and contact owners. After the mailing is sent, you receive response data such as openings, clicks,
outbounces, direct replies and unsubscriptions for each recipient.

Features and supported versions
The following features are supported for Enterprise, Unlimited, and Performance Editions:
l
l
l
l
l
l

l
l

Campaign management.
Transfer of recipient data.
Transfer of response data: Openings, clicks, direct replies.
Synchronization of unsubscriptions and bounces.
Support for contacts, leads, and personal accounts.
Administration of advertising permissions for the marketing channels of email and text
message.
Import of advertising permissions (double opt-in) submitted via Optimizely Campaign.
Synchronization of contacts, leads, and personal accounts with Optimizely Campaign
recipient lists.

Setup
To set up the Salesforce add-on, contact customer support. Provide Optimizely with the following information:
l

Your SOAP API user name in Optimizely Campaign. If you do not have a SOAP API user
account, contact customer support. Use a separate email address that is not used for logging into Optimizely Campaign.
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l

l

Any additional CRM data in addition to the standard data you want to be transferred to
the Optimizely Campaign recipient list. See Configuring the integration.
The client IDs for the integration. To see the client ID, open the Optimizely Campaign
menu and select Administration > API overview > SOAP API.

Installation
The Salesforce add-on is delivered as an Unmanaged Package. Install this package independently in your Salesforce Org according to the standard Salesforce approach. If you
need help with the installation, contact customer support. After the installation is complete,
you can access the Salesforce add-on features via the following tabs:
1. Mandators (Episerver Campaign): Store the access data for your Optimizely Campaign clients in this tab.
2. Administration (Episerver Campaign): This tab contains options for configuring, starting, and stopping the data exchange between Optimizely Campaign and Salesforce.
3. Opt-Ins (Episerver Campaign): Configure and manage the advertising permissions
for your leads, contacts, and personal accounts in this tab.
4. DOI Stage Objects (Episerver Campaign): In this tab, manually assign double opt-in
advertising permissions (see Manual assignment of double opt-ins) that cannot be automatically linked to a lead, contact, or personal account. This is the case if a data set –
for example an email address – exists multiple times in Salesforce and is therefore not
unambiguous.
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Configuring advertising permissions
Note: This topic is for administrators and developers with administration access rights in Salesforce.
The Salesforce add-on supports the administration of advertising permissions for the marketing channels of email and text message in your Salesforce Org. It is also possible to
import double opt-ins from Optimizely Campaign.
The configuration of advertising permissions consists of the following steps:
1. Create Boolean reference fields (true/false) for the marketing channels you use (email,
text message) for your leads, contacts, and personal account. The reference fields will
later be displayed in the personal information of your leads, contacts, and personal
accounts as check boxes (Advertising permission present or Advertising permission not present).
2. In Salesforce, configure your Optimizely Campaign clients.
3. Assign the created reference fields to an advertising permission with the corresponding
marketing channel.
4. Enable automatic import to import completed double opt-ins from Optimizely Campaign.
5. Alternatively, you can assign double opt-ins manually.

Creating reference fields
1. Go to the Setup area in Salesforce.
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2. In the left menu bar, click Objects and Fields > Object Manager.

3. In the Object Manager window, select the entity that you want to create a new reference field for, such as Contact.
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4. In the Object Manager window of the selected entity, click Fields & Relationships.
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5. Click New.

6. In the New Custom field window, select the Checkbox option under Data Type.

7. Click Next.
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8. Enter a name for the new field in the Field Label field, for example Newsletter.

9. Under Default value, leave the option on Unchecked.
10. The selected field name will automatically be added in the Field name field. Optionally, enter another field name.
11. Optional: Enter a description in the Description field.
12. Optional: Enter a help text in the Help Text field.
13. Click Next.
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14. Configure the field level security according to your requirements.

15. Click Next.
16. Add the page layouts according to your requirements or remove unneeded page layouts.
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17. Click Save.
Repeat the steps for the other marketing channels you use and for the corresponding entities (leads, contacts, personal accounts).
Tip: Create identical fields for leads, contacts, and personal
accounts. In this way, advertising permissions will be automatically
transferred if a lead becomes a contact, for example. If you create different fields, you need to use Rules to transfer the advertising permission (such as from a lead that has become a contact).

Storing client IDs and SOAP API user data
Note: If you do not have a SOAP API user account, contact customer
support.

© Optimizely 2022

Integration and interfaces | 1177

1. Log in to Salesforce CRM.
2. Open the Mandators (Episerver Campaign) tab.

3. Click New to create an Optimizely Campaign client in Salesforce.

Tip: If you would like to change the settings of a previously created client, click the respective client and then Edit. The list
views in Salesforce may hide clients. If necessary, click All in the
list views.
4. In the Optimizely Campaign Client window, specify the following fields:
a.
b.
c.
d.
e.

Name. Name of the client (as it should be displayed in Salesforce). You can chose
the name freely. For greater clarity, use the same name as in Optimizely Campaign.
Client ID. Client ID. To see the client ID, open the Optimizely Campaign menu and
select Administration > API Overview > REST API.
API User. Your SOAP API user name.
Password. Your SOAP API password.
Active. Select the check box.
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5. Click Save.
Repeat these steps for additional clients to connect to Salesforce CRM.

Assigning reference fields
1. Open the Opt-Ins (Episerver Campaign) tab.

2. In the Opt-Ins (Episerver Campaign) window, click New.
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3. In the Configure advertising permission window, specify the following fields:
a. Name. Name for the advertising permission (for example Product newsletter).
b. Mandator. Optimizely Campaign client to which the advertising permission is to be
assigned.
c. Opt-In Type. In the drop-down list, select the marketing channel for which the
advertising permission applies (for example Email).
d. Reference field. In the drop-down list, select the reference field that you want to
assign the advertising permission to (the Boolean field that you have created the
advertising permission for, see Creating reference fields).

4. Click Save.

Importing opt-ins from Optimizely Campaign
1. Select the check box Episerver Campaign Synchronization.

2. In the DOI list Id field, enter the ID of the recipient list containing the double opt-ins.
To see the recipient list ID, open the Optimizely Campaign menu and select Administration > API overview > Recipient lists.
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3. In the DOI process Id field, enter the ID of the opt-in process. To see the opt-in ID,
open the Optimizely Campaign menu and select Administration > API overview
> Opt-in processes.

4. Click Save.

Manual assignment of double opt-ins
If a double opt-in advertising permission via Optimizely Campaign has not been assigned –
because it has multiple contacts or leads for the same email address, for example – you
need to assign it manually. Perform the following steps:
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1. Open the DOI Stage Objects (Episerver Campaign) tab.

The DOI Stage Objects (Episerver Campaign) window shows you the advertising permissions that were unable to be assigned automatically.

2. To see detailed information about an advertising permission, click the unassigned
advertising permission.
3. To assign the advertising permission, click the downward-pointing triangle on the
upper right.
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4. Select Assign DOI manually in the drop-down list.

5. Under Select Contact or Lead, search for the person to whom you want to assign the
double opt-in advertising permission.
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6. Click Assign DOI.

Repeat the steps for every advertising permission that has not been assigned.
Tip: Check regularly whether marketing permissions are unable to be
assigned and then assign them manually. This keeps your database
updated at all times.

Configuring data fields
Note: This topic is for administrators and developers with administration access rights in Salesforce.
This topic describes how to configure data fields in Salesforce to send contact data of
leads or contacts to Optimizely Campaign.
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Transferring default data fields
You can use contact data of leads or contacts to personalize mailings and for target group
segment in Optimizely Campaign. See Field functions and Target groups.
By default, the following data is sent from Salesforce to Optimizely Campaign:

Field name

Data
type

Description

email

String

Email address of the contact or lead

salesforceid

String

Unique ID for the contact/lead in Salesforce

sfcampaignid

String

Unique ID of the Salesforce campaign

entity_type

String

Contains the type of the Lead, Contact, or Personal
Account type

optinname

String

Name of the opt-in

optintype

String

Media type of the opt-in

salutation

String

Recipient's salutation

firstname

String

Recipient's first name

lastname

String

Recipient's last name

title

String

Recipient’s title (for example Dr., Prof. and so on)

mobilephone

String

Recipient's mobile telephone number

fax

String

Recipient's fax number

street

String

Recipient’s street and house number from the Lead type

postalcode

String

Recipient’s postal code from the Lead type
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Field name

Data
type

Description

city

String

Recipient’s place of residence from the Lead type

state

String

Recipient’s state from the Lead type

country

String

Recipient’s country from the Lead type

birthdate

Date

Recipient’s date of birth from the Contact type

mailingstreet

String

Recipient’s street and house number from the Contact type

mailingpostalcode

String

Recipient’s postal code from the Contact type

mailingcity

String

Recipient’s city from the Contact type

mailingstate

String

Recipient’s state from the Contact type

mailingcountry

String

Recipient’s country from the Contact type

Transferring additional fields
In addition to the standard setup, you can transfer other Salesforce data fields to Optimizely Campaign. The Salesforce add-on can directly access linked data sets (Salesforce
objects up to the third level). For example, the contact person who manages the contact or
lead in your organization, or the name of the department head, in addition to contact or
lead data and attributes.
This lets you, for example, customize greetings, so that a contact or lead is greeted by the
member in your organization that manages the lead or contact.
To set up the transfer, first configure the additional data fields in Salesforce. Then, contact
Optimizely customer support to request the addition of these fields to your recipient lists.
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Configuring additional data fields
1. Log in to Salesforce CRM.
2. Open the Administration (Episerver Campaign) tab.

The Administration (Episerver Campaign) window opens. In the fields area, you can
find the data fields that can be transferred to Optimizely Campaign, separated by
leads, contacts, and personal accounts.
3. When data synchronization is enabled, you can disable data synchronization by clicking Stop scheduler next to Scheduler control.
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4. In the lists on the left under Lead, Contact, or Personal Account, select the data field
that you want to transfer to Optimizely Campaign. To select multiple data fields at the
same time, hold down the CTRL key on your keyboard.
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Note: The lists on the left contain Salesforce objects that can be
transferred. Lists on the right contain objects that are currently
transferred.

5. To add one or more data fields, click the right arrows >>.

6. Optional: Select a data field and click Up or Down to change the order in which the
data fields are transferred.
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7. Click Save.

Under Resulting field list for Episerver Campaign, the list of data fields that are to
be transferred are expanded by the newly-added data fields. If you want to discard
your changes and return to the default settings, click Reset to default.
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Tip: Keep this window open, as it is needed when Requesting additional fields to be added to recipient lists.
Since all Salesforce objects cannot be displayed in the Lead, Contact and Personal
Accounts lists at the same time, you can use a filter to hide data fields or data field groups
to display other Salesforce objects. If data fields that you want to transfer are missing from
the list, you can hide the data field group Owner:
1. Be sure to save all changes to the data fields to be transferred.
Warning: When you edit and apply the filter, unsaved changes to
the data fields are lost. Save any changes prior to editing the filter.
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2. In the Filter field, add the entry Owner, separated by a comma; do not use spaces.

3. Click Apply filter and save. Data fields that start with Owner are now hidden and previously invisible Salesforce objects are displayed.

4. Locate the desired field and add it to the data fields to be transferred using the arrow
button >>.
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Requesting additional fields to be added to recipient lists
1. Under Resulting field list for Episerver Campaign, highlight the entire, comma-separated list of data fields to be transferred.

2. Copy the highlighted list to the clipboard.
3. Insert the copied list into the message text of an email and send to customer support.
4. When you receive the confirmation email, click Start scheduler in the Administration
(Episerver Campaign) tab to enable automatically data synchronization.
Once data exchange is enabled, the additional data fields are automatically transferred to
Optimizely Campaign. You can use the corresponding Salesforce objects to personalize
your mailings via field functions.

Sending campaign mailings
Note: This topic is for administrators and developers with administration access rights in Salesforce.
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This topic describes how to send mailings via Optimizely Campaign from your Salesforce
CRM. After the mailing is sent, response data (openings, clicks, direct replies, unsubscriptions and outbounces) are automatically imported into Salesforce from Optimizely
Campaign.
Note: Response data can not be transferred for campaigns initiated
directly in Optimizely Campaign or the activities of Marketing Automation.
These are the steps to send a mailing:
1. Prepare a Smart Campaign with at least one mailing in Optimizely Campaign.
2. Create a CRM campaign in Salesforce and add members.
3. Start the dispatch of the Optimizely Campaign mailing in Salesforce.

Preparing a Smart Campaign in Optimizely Campaign
The Smart Campaign set up requires at least these nodes:
l

l
l

Recipients node, to which you assign the Master recipient list of the closed-loop
interface. This is set up by the Optimizely customer support, when your client is configured.
Wait node, to enable the Wait until import has been finished option.
Message node, containing the mailing to be sent.

To configure a Smart Campaign, do the following:
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1. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
2. In the Campaigns window, click Create….

3. Drag the Recipients node from the left action area to the working area on the right.
4. Select the master recipient list in the Recipient lists drop-down list of the context
menu.
Note: Only use the master recipient list and no other recipient
list.
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5. Drag the Wait node from the left action area to the working area on the right.
6. In the context menu, enable the option Wait until import has been finished.
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7. Drag a message node (Email, SMS) from the left action area to the working area on the
right.
8. Click Edit Content…, select a template and insert your message content into the mailing. Design your Smart Campaigns mailing as usual, using available tools and features.
See Edit mailing content.
9. Click Close.
10. Connect the campaign nodes.
11. Click Save and Close, enter a campaign name and click Save.
Note: Do not activate and send the campaign mailing. If you do, you
cannot start and send it from Salesforce anymore. If you start and
send the mailing from Salesforce later, the mailing is automatically
duplicated. You can delete the original in Optimizely Campaign after
it is sent.

Creating a CRM campaign and adding members
The CRM campaign in Salesforce controls the Smart Campaign created in Optimizely Campaign. With the CRM campaign, you trigger the mailing dispatch in Optimizely Campaign
and transfer the selected contacts and leads (members of the CRM campaign) into the
Optimizely Campaign recipient list.
Use the regular features in Salesforce to create a CRM campaign and assign members. The
following steps shows an example of how to do this.
1. Log in to Salesforce CRM.
2. Click Campaigns.
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3. Click New.

4. Enter the desired campaign information and description.

5. In the Advertisement Consent field, enter the advertising permission that you want
to assign to the campaign.
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6. In the Episerver Mandator field, select the client in which you have prepared the mailing that is to be sent. (In the example, the client's name is Episerver Campaign).
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7. Click Save.

8. In the Campaign Members area, click Add Contacts or Add Leads or Add Person
Accounts.
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9. Select the contacts or leads or personal accounts that you want to add to the campaign.
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10. Click Next.

11. Click Submit.

The <Your campaign name> Campaign window opens again. Keep this window open
as it is needed in the next step: Starting the mailing dispatch in Salesforce.
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Starting the mailing dispatch in Salesforce
1. In the <Your campaign name> Campaign window, click the downward-pointing triangle on the upper right side and select the Start mailing option.

2. In the Episerver Campaign window, check under Opt-In that the correct advertising
permission has been selected. Use the drop-down list to change the advertising permission if necessary.

3. Click Load mailing IDs.
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The Mailing ID drop-down list loads the mailing ID of the mailings you prepared. For
multiple mailings, the IDs for these are loaded.

4. For multiple mailings, select the ID for the desired mailing from the Mailing ID dropdown list. To see the mailing IDs, open the Optimizely Campaign menu and select Campaigns > Smart Campaigns. Copy the relevant mailing ID from the ID column of the
campaigns overview.

5. Click Start mailing (in Salesforce). The contacts/leads that you added to your CRM
campaign as members are transferred to Optimizely Campaign.
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6. To check the current dispatch status for the mailing, click Back.

The <Your campaign name> Campaign window opens.
7. Check the sending status in the Details tab. A selected check box indicates that the
mailing was sent successfully.

© Optimizely 2022

1206 | Optimizely Campaign User Guide 2022-03-14

Copying data sets in recipient lists
Note: This topic is for administrators and developers with administration access rights in Salesforce.
This topic describes how to copy and synchronize Salesforce data sets of contacts, leads,
and personal accounts with your Optimizely Campaign recipient lists. For this purpose, the
Salesforce add-on adds two Apex classes to the Salesforce Process Builder:
l
l

Upsert Recipient. Updating recipients or adding new recipients.
Delete Recipient. Deleting leads, contacts, and personal accounts from an Optimizely
Campaign recipient list.

Requirements
Optimizely customer support must prepare your Optimizely Campaign recipient lists for the
Salesforce synchronization. Provide information about the client in which you want to use
recipient lists for the Salesforce synchronization.

Generating processes and using Apex classes
Once customer support has prepared the desired recipient lists, set up processes in Salesforce to automatically copy contacts, leads, and personal accounts in Optimizely Campaign recipient lists. For example, you can set up processes that filter customers according
to a certain status and transfer them to a corresponding recipient list, such as new customers in a recipient list that only contains new customers.
For contacts, leads, and personal accounts in this example, a Boolean reference field (true/false) called Premium Customer was created first that you will need for configuring the
process. See Creating reference fields.
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Setting up processes
1. Go to the Setup area in Salesforce.

2. In the left menu bar, click Process Automation > Process Builder.
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3. In the My Processes window, click New.

4. In the Process Name field, enter a name for the process, such as Premium Customers.

5. Enter a name under API Name, such as Premium_Customers.
6. Optional: Enter a description in the Description field.
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7. Select A record changes in the The process starts when drop-down list.

8. Click Save.
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Adding criteria and defining Apex classes
1. Click Add object in the flowchart.

2. In the Choose Object and Specify When to Start the Process window, select the
entity in the Object drop-down list that you want to set up the process for: Lead,
Contact, or Person Account.

© Optimizely 2022

Integration and interfaces | 1211

3. Under Start the process, enable when a record is created or edited.

4. Click Save.
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5. Click + Add criteria.

6. In the right window, enter a name for the criterion in the Criteria Name field, such as Is
Premium Customer.
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7. Under Criteria for Executing Actions, select Conditions are met.
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8. Under Set conditions, select the Premium Customer reference field from the dropdown list under Field and confirm your selection.
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9. Set the Operator to Equals, the Type to Picklist, and the Value to Primary.

10. Under Conditions, select the All of the conditions are met (AND) option.
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11. Click Save.
12. Click Add action under Immediate actions in the flowchart.

13. In the Select and Define Action window, select the Apex entry from the Action Type
drop-down list.
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14. Enter a name under Action Name, such as Add Premium Customer.
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15. Select the Upsert Recipient entry from the Apex Class drop-down list.

Note: You need to configure three variables for the Upsert
Recipient Apex class: recipientId, recipientListId, and
sfOptInId.
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16. Under Set Apex Variables, click Add Row three times.

17. In the first drop-down list under Field, select the recipientId variable and set the type
to Field Reference. Depending on the desired entity type, select the Lead Id, the
Contact Id, or the Personal Account Id in the Value field.
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18. In the second drop-down list under Field, select the RecipientListId variable and set
the value to the ID of the Optimizely Campaign recipient list to which the Premium Customers are to be copied. To see the recipient list ID, open the Optimizely Campaign
menu and select Administration > API overview > Recipient lists.
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19. In the third drop-down list under Field, select the sfOptInId variable and set the value
to the Salesforce ID of the created advertising permission. The type will automatically
be set to String; do not make any changes here.
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20. Click Save.

Deleting recipients from one recipient list and adding them to another
recipient List
For example, a Premium Customer has achieved high revenues and qualified as a Platinum
Customer. You want to delete this customer from the premium list and add it to the platinum list.
To delete recipients from one recipient list and add them to another, set up the Delete
recipient class (which deletes the customer from the premium list) along with the Upsert
Apex class (which adds the customer to the platinum list). Configure the Delete recipient
Apex class only with the recipientId and recipientListId parameters. See steps 18 and 19
in the previous section.
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Enabling synchronization of deleted contacts, leads, and personal
accounts
To completely delete deleted contacts, leads, and personal accounts from your recipient
list in your Salesforce database as well, do not set up a separate process in Salesforce. The
Salesforce add-on takes care of synchronizing your deleted Salesforce data sets if you
enable automatic synchronization of deleted contacts, leads, and/or personal accounts.
Perform the following steps:
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1. Open the Administration (Episerver Campaign) tab.

2. In the Administration (Episerver Campaign) window, click Start scheduler under
Synchronization of deleted recipients.

Tip: Click End to interrupt synchronization of the deleted data sets.
This may be necessary, for example if the configuration is faulty, and
you need to correct it.
Click Start under Synchronize manually to perform (one-time)
manual data synchronization. A manual start lets you limit the period
of access between Salesforce and Optimizely Campaign in the log
files, thereby helping to diagnose any errors.

Import response data to Salesforce
Note: This topic is for administrators and developers with administration access rights in Salesforce.
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This topic describes how to automatically import the response data of your recipients
(openings, clicks, unsubscribes, bounces, and direct replies) to Salesforce.
After sending a campaign, you need to enable synchronization of the response data by
starting the data exchange. Once you have enabled synchronization, you will be able to
view the response data and use it for additional marketing activities.

Starting data exchange
If you have set up at least one client in Salesforce (see Configuring advertising permissions),
start the data exchange between Salesforce and Optimizely Campaign. Perform the following steps:
1. Log in to Salesforce CRM.
2. Open the Administration (Episerver Campaign) tab.

The Administration (Episerver Campaign) window opens.
3. Under Response data synchronization > Scheduler control, click Start scheduler.
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The Start scheduler button will be grayed-out when data synchronization is enabled.
In addition, the icon next to Response Data Sync Scheduler will light up green.

Tip: Click Stop scheduler to interrupt synchronization of the
deleted data sets. This may be necessary, such as if the configuration
is faulty and you need to correct it.
Click Start data synchronization under Synchronize manually to
perform (one-time) manual data synchronization. A manual start lets
you limit the period of access between Salesforce and Optimizely
Campaign in the log files, thereby helping to diagnose any errors.

Viewing response data
After an mailing has been sent, the Salesforce add-on automatically imports the response
data from your contacts and leads to your CRM. The detail pages of the CRM campaigns,
campaign members, and contacts/leads provide you with access to the following data:
l
l
l
l
l
l

Dispatch status of the mailing
Openings
Clicks
Bounces
Unsubscribes
Direct replies
Note: The response data of your contacts/leads is not transferred to
Salesforce in real time. This data import may be delayed by several
hours.
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Microsoft Dynamics CRM integration
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
With the integration you can send campaigns from Microsoft Dynamics CRM via Optimizely
Campaign. Send large information volumes securely via email and SMS. Add contacts and
leads to a campaign, and use contact data for automatic personalized mailings in Optimizely Campaign.
Start campaign mailings in Microsoft Dynamics, and receive reports with sent and returned
response data (opens, clicks, direct replies, outbounces and unsubscribes).
You can copy CRM (customer relationship management) marketing lists into Optimizely
Campaign recipient lists, and automatically include new CRM contacts in a Marketing Automation campaign to for example send welcome and birthday mailings.

Features and supported versions
Microsoft
Dynamics 365

Microsoft Dynamics CRM 2016

Microsoft Dynamics CRM 2015

Optimizely Campaign management

✓

✓

✓

Transfer of recipient data

✓

✓

✓

Copy marketing lists into
Optimizely Campaign

✓

✓

✓

Transfer of response data

✓

✓

✓

Synchronize unsubscribes
and outbounces

✓

✓

✓

Feature
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Note: Microsoft's Mainstream Support for Microsoft Dynamics CRM
2015 ended on January 14, 2020.

Setup
To set up the Microsoft Dynamics integration, contact customer support.
Provide Optimizely with the following information:
l

l

l

l

Your SOAP API user name in Optimizely Campaign. If you do not have a SOAP API user
account, contact customer support. Use a separate email address that is not used for logging into Optimizely Campaign.
Any additional CRM data in addition to the standard data you want to be transferred to the
Optimizely Campaign recipient list. See Configuring additional fields for the recipient list.
The client IDs for the integration. To see the client ID, open the Optimizely Campaign
menu and select Administration > API Overview > REST API.
The IDs of the corresponding recipient lists, if you want to synchronize marketing lists with
Optimizely Campaign. Alternatively, customer support can create new recipient lists. To
find recipient list IDs, open the Optimizely Campaign menu and select Administration >
API overview > Recipient lists.

See Troubleshooting and maintenance if there are issues with the integration.
These instructions apply to the Microsoft Dynamics 365 online version. Procedures are similar for on-premises versions.

Installation
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to install the Microsoft Dynamics CRM integration, if you are
using this with Optimizely Campaign.
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Installing the software package
1. Install the software package you received from customer support in Microsoft Dynamics
CRM.
2. Log in to Microsoft Dynamics CRM with administrator rights.
3. Open the settings and click Solutions in the Customization menu.

4. Click Import and select the file to upload.

5. Select the compressed software package ZIP file and click Next. When uploaded, package information including name, publisher, and type is displayed.
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6. Click Next.
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7. Select Enable any SDK message processing steps included in the solution.

8. Click Import. When completed you can download the log files. The CRM settings now
has an additional Episerver Campaign area.

The integration provides two CRM roles:
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l

l

Episerver Campaign Administrator. For administering the integration and modifying
settings.
Episerver Campaign User. For working with campaigns via Optimizely Campaign.

Installing updates
The difference compared to an initial installation is that you will be notified that the
uploaded file is an update for an installed solution. To keep your integration settings, user
accounts, passwords, and response data, activate the option Maintain customizations
(recommended).

Extended recipient list connector
The current version of Microsoft Dynamics CRM cannot address more than 100,000 recipients per campaign. The extended recipient list connector for Optimizely Campaign is an
external Windows service that removes the technical limitation and controls campaigns
and the transmission of marketing lists with more than 100,000 recipients. See Extended
recipient list connector.

Multi client setup
The Microsoft Dynamics CRM integration allows you store up to three Optimizely Campaign clients in one organization. A reverse mapping from multiple Microsoft Dynamics
CRM organizations to one Optimizely Campaign client is not possible.

Configuration
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to configure the Microsoft Dynamics CRM integration, if you are
using this with Optimizely Campaign.
The configuration includes these steps:
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1.
2.
3.
4.
5.

Enter SOAP API user data.
Enter client IDs.
Start response data workflows.
Assign Optimizely Campaign test lists
Create advertising consents and link to client.

To transfer fields not included in the standard configuration, you must also configure the
additional fields for your Optimizely Campaign recipient list.

Entering SOAP API user data
Communication and data exchange between Microsoft Dynamics and Optimizely Campaign uses the SOAP API. To link CRM with Optimizely Campaign via the interface, you
must enter your SOAP API user data in Microsoft Dynamics.
Note: If you do not have a SOAP API user account, contact customer
support.
1. Log in to Microsoft Dynamics CRM with administrator rights.
2. Open Microsoft Dynamics CRM and select Settings > API data.
Tip: The integration adds a new Episerver Campaign section to
your CRM settings.

3. Click New.
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4. For API User, enter your SOAP API user name.
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5. For API Password, enter your SOAP API password.

6. Click Save & Close.

Entering client IDs
To run campaigns, specify which Optimizely Campaign client you want to use in CRM for
sending.
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1. Open Microsoft Dynamics CRM and select Settings > Clients.

2. Click New.
3. For Client ID, enter the ID of the client to use for sending campaigns.

Tip: You can find the client ID in the Optimizely Campaign menu
under API Overview > REST API.
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4. For Description, enter the name of the client.

Tip: The name of client is displayed at top right in the menu bar
in Optimizely Campaign.
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5. For API User, select your SOAP API user. See Enter SOAP API user data.

6. Click Save & Close. To add more clients, repeat the steps for each additional client.

Starting response data workflows
To feed campaign response data from contacts and leads in Optimizely Campaign into
CRM, start the response data workflows for each individual client. The workflows query and
import recipient response data in 60-minute intervals.
These workflows are available for each response type:
Workflow

Response type

Optimizely: Get opens

Mailing opened

Optimizely: Get clicks

Link clicked in the mailing

Optimizely: Get responses

Direct reply to the mailing

Optimizely: Get unsubscribes

Newsletter unsubscribes
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Workflow
Optimizely: Get outbounces

Response type
Outbounce (the recipient has exceeded the bounce limit)

Do the following to start workflows:
1. Select the clients to start workflows for. If the list of clients does not open, go to Settings > Clients.

2. Click Run Workflow.
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3. Select a workflow and click Add.

4. Click OK to confirm.
5. Repeat steps 1–4 for each workflow.
You can see workflow activity in the Information view for the client. Click the corresponding client ID in the list to open it. Under access data, you can see when the workflow was last run, and timestamp for the most recently imported data.

Assigning Optimizely Campaign test lists
To check the campaign mailings before dispatch, you can send them to a Optimizely Campaign test list. To do this, you must assign the Optimizely Campaign test list in Microsoft
Dynamics CRM. Do the following:
1. Go to Settings > Episerver Campaign > Episerver Campaign > Clients.
2. Click Client.
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3. Click Add Testlist record.

4. Enter a name for the test list.
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5. Enter the recipient list ID of the test list. To see the recipient list ID, open the Optimizely Campaign menu and select Administration > API overview > Recipient lists.
Tip: If you are missing the ID column, click the down arrow v in
the upper right corner of the table header and activate the ID
check box.
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6. Click Save and close the window.

Tip: To assign more test lists, repeat the steps for each additional
test list.

Creating consents and linking to client
To send mailings, you need advertising consent from contacts and leads. The consent protects recipients from unwanted omnichannel marketing. See also Opt-in. The integration
checks two fields in Microsoft Dynamics for each contact and lead, to see if consent is
given or withdrawn, and will not transfer recipients without consent.
Furthermore, you record the bounce status for the contact, lead or account, which makes a
statement about the functionality of the advertising agreement.
Perform the following steps:
1. Creating a bounce status field
2. Adding the bounce status field to a form
3. Creating advertising consent and associating the bounce status field
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Creating a bounce status field
1. Log in to Microsoft Dynamics CRM with administrator rights.
2. Go to Settings > Customizations.

3. Click Customize the System.
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4. Use the side navigation to go to Components > Entities > Contact or Lead or
Account > Fields.
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5. Click New.
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6. Specify the following fields:

l
l

Display Name. Enter an intuitive name, for example EpiOutbounce E-Mail.
Name. Click into any other field. The entry is automatically copied to the Name box
(without spaces or special characters), with the prefix new_ added. Change the
automatically created entry in the Name box, such as changing it to new_epioutbounce eMail. Do not use spaces or special characters. Note the entry in the
Name box, you will need this later for the advertising consent.
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l
l
l
l
l
l

Field Requirement: Select Optional.
Searchable: Select Yes.
Field Security. Select Disable.
Auditing. Select Enable.
Description. Optional: Enter a field description.
Data Type. Select Two Options. A field containing the options No and Yes
appears.
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l

Field Type. Select Simple.
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7.

Click Save and Close.

Adding the bounce status field to a form
1. Use the side navigation to go to Components > Entities > Contact or Lead or
Account > Forms.
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2. Click the form for which you want to add the advertising consent presence field.
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3. Click the area, for example Marketing, where the field for presence of advertising consent should appear. When the area is selected, the surrounding dashed line becomes
solid.

4. On the right, open the Field Explorer and browse for the field you created for the
advertising consent presence.
Tip: You can filter the number of fields shown.
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5. Double-click the advertising consent field to add it to the selected area.

6. Click Safe.
7. Click Publish.
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Creating advertising consent and associating the bounce status field
1. Open Microsoft Dynamics CRM and select Settings > Advertising Consents.

2. Click New.

3. For Opt-in-ID, enter a unique identifier. Do not use special characters or characters
with accents. The Opt-in-ID should be intuitive, for example OptinProductNewsletterEmailContact. It will display, for example, when selecting advertising consent for sending a campaign.
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4. Optional: For Description, enter a description for the advertising consent.
5. For Type, select the communication channel (email, SMS ) to which the advertising
consent applies.

6. For Entity, select the customer type (Contact or Lead or Account) for which the
advertising consent is used.
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7. For Reference Bounce Field, enter the name of the field indicating the functionality
of the advertising consent. This is the name that automatically had new_ added when
creating the field.

8. For Episerver Campaign client, select the client used for sending the advertising consent by clicking the magnifying glass symbol.
Note: The allocation of a client to an advertising consent cannot
be changed.
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9. Click Save & Close. The new advertising consent is displayed in the overview list.

Repeat steps 1–9 to add more advertising consents for the same channel. Additional
advertising consents can refer back to the bounce status field that was already created.
This applies to the entire channel, for example an Email channel.
You have successfully created an advertising consent. Irrespective of whether the agreements are obtained through an opt-in process in Optimizely Campaign or from another
source, you will find the assignment of the advertising consents to the individual contacts,
leads or accounts under the menu item Opt-in Histories.
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In the Opt-in History Assigned View overview, you can see the advertising consents granted. If the advertising consent is withdrawn again, the entry can be deleted, or an Opt-out
entry is created on basis of the unsubscribe response data. In this case, CRM uses the time
stamp to recognize the current status of the withdrawn advertising consent. In both cases,
no more mailings that require the corresponding consent are sent to this data record.
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Connecting the advertising consent to an Optimizely Campaign opt-in process
On the configuration page of the advertising consent, you find another Opt-in area where
you can can connect the created advertising consent to the opt-in process in Optimizely
Campaign. This enables you to send opt-in mailings with a confirmation link via Optimizely
Campaign.
Prerequisites:
l
l

You completed configuring the integration, including an advertising consent.
You created an opt-in process. You require the ID of the opt-in process and the ID of the
opt-in recipient list used in the process.

To connect an advertising consent to a double opt-in process:
1. In the Opt-in area, in the Synchronize Double Opt-in field, select Yes.

2. In the Opt-in Recipient List ID field, enter the ID of the recipient list that is used in
the opt-in process. To see the recipient list ID, open the Optimizely Campaign menu
and select Administration > API overview > Recipient lists.
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3. In the Opt-in Process ID field, enter the ID of the Opt-in process from Optimizely Campaign. To see the opt-in ID, open the Optimizely Campaign menu and select Administration > API overview > Opt-in processes.
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4. Optional: In the Konfiguration DOI field, enter a XML configuration that assigns
information from the contact fields to the recipient list fields in the opt-in recipient list.
Note: The entry in <optinsource> is freely customizable. Note
that the root node is named <episerver> here.
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5. Click Save & Close.

You have successfully combined an advertising consent in CRM with an opt-in process in
Optimizely Campaign. You can now trigger the sending of an opt-in mailing via Optimizely
Campaign by clicking the Send Opt-in Mail button in the respective entity.

Customizing the campaign activity form
To complete the configuration, update the campaign activity form adding fields from the
Microsoft Dynamics integration. These fields are usually added when the integration is
installed. However, depending on your CRM configuration, this step may have been
missed.
The integration has these fields:
No.
1

Field name
Recipients sent to Optimizely Campaign

© Optimizely 2022

1266 | Optimizely Campaign User Guide 2022-03-14

No.

Field name

2

Sent successful

3

Recipient Packages created

4

Mailing Description

5

Mailing ID

6

Mailing ID by Wave ID

7

Mailing name

8

Mailing Status

9

Optimizely Campaign client

10

Recipient Packages sent

11

Preprocessed recipients

12

Wave ID

13

Advertising Consent

Do the following:
1. In Microsoft Dynamics, go to Settings > Customizations.
2. Click Customize the System.
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3. Select Components > Entities > Campaign Activity > Forms.
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4. Click Campaign activity in the list to open the Campaign Activity form.
5. In the field explorer, from the Filter drop-down list, select Custom Fields and clear the
Only show unused fields check box. The 13 fields from the Microsoft Dynamics Integration are shown.
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6. Drag the 13 fields into the Episerver Campaign area of the structure view of the form.
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7. Click Save and Close.

Transferring data fields
When transferring data fields from the CRM to Optimizely Campaign, a distinction is made
between data fields transferred by default and additional optional fields that must be configured.
Note: The integration transmits all values as a string, regardless of
which data type is created in CRM.

Data fields transferred by default
The default settings for the integration send the following data from Microsoft Dynamics to
Optimizely Campaign:
Field name

Date type

Description

entityType

String

Indicates whether this is a lead or a contact

salutation

String

Title

firstname

String

First name

lastname

String

Last name

fullname

String

First name and last name

mobile

String

Mobile phone number (required for SMS campaigns)

email

String

Email (required for email campaigns)

street

String

Street

city

String

City
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Field name

Date type

Description

state

String

State

zip

String

Zip code

country

String

Country

Configuring additional fields for the recipient list
This configuration applies to both campaign management and synchronization of recipient
lists and advertising consents (clients). Remember to consider this during planning to
avoid costly reconfiguration and additional work. The field configurations must be identical
for both leads and contacts. Changing only one type will cause the other to fail to send.
Options for custom configuration of recipient lists:
l
l

Remap a custom CRM field and write it to an existing standard field in the recipient list.
Transfer a custom CRM field to an additional field not in the standard configuration of the
recipient list .

Remapping CRM fields
1. Open Microsoft Dynamics CRM and select Settings > Mappings.

2. Click New.
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3. For Entity, select the type Contact.

4. In the Map From box, enter the name of the field in CRM.
5. For Map To, select the standard field in the recipient list into which the value of the
CRM field should be written. For example, if you created a field called new_custom_
country, then you can copy the value of this field into the Country field in the recipient list. The standard CRM Country field is no longer transferred to Optimizely Campaign.

6. Click Save.
Repeat steps 1–6 for type Lead (at step 3, select Lead under Entity).
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Transferring CRM fields
Prior to transferring, contact customer support to add the additional fields to your recipient
list. In the request, provide the fields in a consecutively numbered list starting at 1, including numbering and field names. Note the numbering and field names (do not change
them), you will need these for the configuration.
Do the following when the fields have been added:
1. Go to Settings > Episerver Campaign > Episerver Campaign Mappings in
Microsoft Dynamics CRM.
2. Click New.
3. For Entity, select Contact.
4. In the Map From box, enter the name of the CRM field.
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5. For Map To, select Custom.

6. In the Field box, enter the name of the additional recipient list field requested.

7. In the Position box, enter the position number of the additional recipient list field. The
position numbers are oriented to the order of the additional recipient list fields requested.
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8. If the Map From field is of the OptionSet type, use OptionSet Language to select the
language to use to transfer the values.

9. Click Save.
10. Repeat steps 2–10 for type Lead (at step 4, select Lead under Entity).

Sending mailings
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to send campaign mailings directly from Campaign Activity in
Microsoft Dynamics CRM, when using this with Optimizely Campaign. After the mailing is
sent, response data (opens, clicks, direct replies, unsubscribes and outbounces) is automatically imported into CRM from Optimizely Campaign.

Prerequisites
l
l

Configuration of the integration completed. See Configuration.
The ID of the campaign mailing to be sent. Make a note of the mailing ID as this is
required to send the mailing from CRM.
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Preparing a Smart Campaign in Optimizely Campaign
The Smart Campaign set up requires at least these nodes:
l

l
l

Recipients node, to which you assign the Master recipient list of the closed-loop interface. This is set up by the Optimizely customer support, when your client is configured.
Wait node, to enable the Wait until import has been finished option.
Message node, containing the mailing to be sent.

To configure a Smart Campaign, do the following:
1. Open the Optimizely Campaign menu and select Campaigns > Smart Campaigns.
2. In the Campaigns window, click Create….

3. Drag the Recipients node from the left action area to the working area on the right.
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4. Select the master recipient list in the Recipient lists drop-down list of the context
menu.
Note: Only use the master recipient list and no other recipient
list.

5. Drag the Wait node from the left action area to the working area on the right.
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6. In the context menu, enable the option Wait until import has been finished.

7. Drag a message node (Email, SMS) from the left action area to the working area on the
right.
8. Click Edit Content…, select a template and insert your message content into the mailing. Design your Smart Campaigns mailing as usual, using available tools and features.
See Edit mailing content.
9. Click Close.
10. Connect the campaign nodes.
11. Click Save and Close, enter a campaign name and click Save.
Note: Do not activate and send the campaign mailing. If you do, you
cannot start and send it from Microsoft Dynamics CRM anymore. If
you start and send the mailing from Microsoft Dynamics CRM later,
the mailing is automatically duplicated. You can delete the original in
Optimizely Campaign after it is sent.
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Configuring marketing lists and CRM campaigns
Before sending a campaign mailing via Optimizely Campaign, you must do the following in
Microsoft Dynamics CRM:
l

Create a marketing list with leads and contacts who will receive the mailing.
Note: Contacts and leads for which you do not have advertising
consent will not receive the mailing, even if they are in the marketing list.

l

Create a CRM campaign and add the marketing list.

Creating a marketing list
1. Open Microsoft Dynamics CRM and select Marketing > Marketing Lists.

2. Click New. The integration supports both static and dynamic list types. The name for
the marketing list and its options (such as Currency) are not relevant for sending mailings via Optimizely Campaign.
3. When done, click Save.
4. Click the plus icon + for Members to add desired contacts or leads to the marketing
list.
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5. When done, click Save.
Creating a CRM campaign and adding the marketing list
1. Open Microsoft Dynamics CRM and select Marketing > Campaigns.

2. Click New.
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3. In the Name box, enter a name for your campaign.

4. In the Currency box, specify a currency for the campaign.

5. Click Save.
6. In the Marketing Lists area, click the plus icon +, select the desired marketing list and
click Add.
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7. Click Save. Keep the window open for the next step.
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Preparing campaign activity for dispatch
1. Click the plus icon + in the Campaign Activities area.

2. In the Subject box, enter a subject for your campaign activity.
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3. Under Channel, select Episerver Campaign.

4. Under Advertising Consent in the new options area, click Search and select the corresponding advertising consent.
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5. Click Save.

6. Click Select Campaign.
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7. Select the mailing to be send and click Select Mailing.

8. Close the Select Mailing window and reload the Campaign Activity screen. The mailing ID is now assigned to the campaign activity.

Checking mailing content before dispatch
Check the mailing content before dispatch by sending the mailing to a Optimizely Campaign test list. Do the following:
Prerequisite: You must assign a Optimizely Campaign test list in Microsoft Dynamics CRM.
See Assigning Optimizely Campaign test lists.
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1. On the Campaign Activity screen, select a Optimizely Campaign test list.
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2. Click Test Message.

3. Select the mailing you want to send to the test list.
Note: The list shows all mailings that are related to campaigns in
the status Activation required in Optimizely Campaign. You must
know the names of the corresponding mailings. The mailing name
does not necessarily correspond to the campaign name. In the
case of A/B tests, mailings typically have different names than
the campaigns.
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4. Click Select test mailing to send the mailing.

Starting and monitoring dispatch workflows
Starting the workflow
1. Click Run Workflow in the campaign activity screen in Microsoft Dynamics CRM.
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2. Select Episerver: Send campaign activity to Episerver Campaign and click Add. Do
not start the workflow Episerver: Start mailing in Episerver Campaign. This is automatically called by the integration.

Contacts and leads from the marketing list are transferred to Optimizely Campaign via
the interface through Recipient packages, and the Mailing status changes from
Planned to Transmitting.
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Monitoring workflow activity
1. Open Microsoft Dynamics CRM and select Settings > System Jobs.

2. Under View, open My System Jobs from the drop-down list. You can see the current
workflow status under Status Reason.

Note: If an error is displayed under Status Reason, click the corresponding workflow to see details.
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Sending transactional mails
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to send transaction mails in Optimizely Campaign from Microsoft
Dynamics CRM using a workflow in CRM. After sending, response data (opens, clicks) are
automatically transferred into CRM.

Prerequisites
l
l
l

l

Configuration of the integration completed, see Configuration.
Campaign mailing prepared in Optimizely Campaign.
The ID of the campaign mailing to be sent. You can find the ID under Transactional
mails in Optimizely Campaign. Select the column ID in the drop-down list to the right.
The authorization code of the recipient list used by the transactional mailing.

Configuring transactional mailings and workflows
Before sending a transactional mailing from Optimizely Campaign, you need to configure
the transactional mailing in Microsoft Dynamics CRM. You can send these mailings to contacts, accounts or leads even without advertising consent. You also need to define a workflow to trigger the transactional mailing.
Configuring the transactional mailing
1. Open Microsoft Dynamics CRM and select Settings > Configurations.

2. Click New.
3. Enter a name for the configuration.
4. In the Value field, define the configuration using an XML format. The fields
<authCode> and <bmMailingID> are mandatory.
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For <authCode>, enter the authorization code for the transactional mailing's recipient
list. For <bmMailingId>, enter the mailing ID of the transactional mailing.
Other fields can be optionally linked, as long as the information is available in CRM.
<root>
<authCode>authorization.Code</authCode>
<bmMailingId>mailing.ID</bmMailingId>
<firstname>object.firstname</firstname>
<lastname>object.lastname</lastname>
<salutation>object.salutation</salutation>
</root>

When sending from another entity except contact, lead or account, a lookup references to the connected bmRecipientId. Furthermore, data fields in contact, lead or
account are integrated via lookups.
<root>
<authCode> Authorisierungs-Code </authCode>
<bmMailingId> Mailing-ID </bmMailingId>
<bmRecipientId>object.new_exampleentityfor.emailaddress1</bmRecipientId>
<dynamicsId>object.new_exampleentityfor.contactid</dynamicsId>
<first_name>object.new_exampleentityfor.firstname</first_name>
<last_name>object.new_exampleentityfor.lastname</last_name>
</root>

You can find the name of the lookup element that is inserted between the object and
the field name (for example, contactid) in the Fields overview. Search for the name of
the field in which the lookup for contact, lead, or account is performed. In the example,
the name is new_exampleentityfor.
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5. Click Save & Close.
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Note: The configuration can be updated and saved if needed.

Configuring the workflow
1. Open Microsoft Dynamics CRM and select Settings > Processes.

2.
3.
4.
5.
6.
7.

Click New.
Enter a name in Process name.
Under Category, select Workflow.
As Entity, select Contact, Lead or Company.
Keep the selection Run this workflow in the background.
Select New blank process, if you are not using an existing workflow as template,
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8. Click OK.

9. Under Activate As define if the workflow is to be created as process or as template.
10. Under Available to Run, select the dependencies of the process. For manual start,
select As an on-demand process.
11. Under Workflow Job Retention, define if the workflows should be automatically
deleted after completion.
12. Under Options for Automatic Processes, define who can start the process.
13. Under Start when, define which action should trigger automatic dispatch. If nothing is
selected, the dispatch is started manually in CRM.
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14. Select Add Step > Episerver Campaign > Send Transaction Mail.

15. Click Set Properties.
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16. In the Value column, search for and select the previously created configuration.

17. Click Save and Close.

Checking return values of the process
You should add error handling steps, configuring how the process should handle different
return values of incorrectly sent transactional mails. Transactional mailings are sent using
the sendtransactionmail operation of the HTTP API. Here is an example for canceling an
unsuccessful process.
1. In the Process window in Microsoft Dynamics CRM, click Add Step > Check Condition.
2. Click <condition> (click to configure).
3. Click Select.
4. Click Send Transaction Mail.
5. Click Service Response in the second drop-down list.
6. Click Does Not Begin With in the third drop-down list.
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7. Click Enter value and enter the return value enqueued.
8. Click Save and Close.

9. Click Select this row and click Add Step.
10. Select Add Step > Stop Workflow.
11. Select Canceled in the status drop-down list.
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12. Click Set Properties.
13. Click in the Value column.
14.
15.
16.
17.
18.

In the drop-down list, select Look for:> Send Transaction Mail.
In the drop-down list, select Service Response.
Click Add.
Click OK.
Click Save and Close.
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19. Under Process in the menu bar, click Convert to a real-time workflow.
20. Click Activate, and Activate in the Process Activate Confirmation dialog box.
21. In the Process window, click Close.

Send out transactional mailing
The workflow is now fully created, activated and starts according to the preconfigured
action or may be triggered manually. A transaction mailing is started manually from the
entity specified in the process.
1. Select Run Workflow in the entity.
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2. The Lookup Record dialog box opens. Select the workflow of the transaction mailing
and click Add.

3. The dialog box Confirm Application of Workflow opens. Click OK.
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Copying marketing lists
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
With the Microsoft Dynamics CRM integration you can copy contacts and leads from a marketing list to an Optimizely Campaign recipient list on a daily or weekly basis. You can then
use this data to send welcome or birthday mailings in a Marketing Automation campaign.
The copying is one-way from CRM to Optimizely Campaign. Unsubscribes and outbounces
are updated back into CRM. Other data will not be updated in CRM if changed in Optimizely Campaign.

Prerequisites
To configure a corresponding recipient list in the relevant client, contact customer support.
Furthermore, you must configure the marketing list for the copying process and start the
workflow for automatic copying.
Note: The recipient list format is the same as for campaign management. If you need additional fields in your recipient list, contact
customer support before configuring copying of marketing lists.

Configuring the marketing list for the copying process
After the recipient list is configured, do the following:
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1. Open Microsoft Dynamics CRM and select Marketing > Marketing Lists.

2. Select the marketing list to synchronize and click Edit.
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3. Click Yes in the field next to the Episerver Campaign Recipient list.

Click Yes in the field next to Transmission active.
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Note: Transmission active must be set to Yes for the copying to
start. If needed, you can disable the copying later by setting the
field to No, without losing the configuration.
4. Under Advertising Consent, select the marketing permission to be used as criterion
when selecting contacts and leads to transfer. Click the magnifying glass symbol in the
field and select the relevant marketing permission.
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5. In the Recipient List ID box, enter the ID of the Optimizely Campaign recipient list
into which the marketing list is to be copied.
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Tip: To see the recipient list ID, open the Optimizely Campaign
menu and select Administration > API overview > Recipient
lists.
6. Under Interval, select the time interval for the copying (daily or weekly) by clicking in
the field.

7. When done, click the disc symbol at the bottom right to save.
If the copying process is running successfully, the Transmission Status field will show
Running. If there is an error, the status field will show Error. See Maintenance and
Troubleshooting) for error messages.
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Starting and monitoring copying workflows
Starting the workflow
1. Click Run Workflow in the campaign activity screen in Microsoft Dynamics CRM.
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2. Select Episerver: Send marketing list to Episerver Campaign and click Add.

Monitoring workflow activity
You can view the current status of the workflow at any time under Settings > System >
System Jobs.
If the workflow fails, the time for Nächste Übertragung (Next Transmission) is automatically changed to the next day or week. To export the marketing list before the next
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automatic export after resolving the error, click in the field next to Nächste Übertragung
(Next Transmission) and select the date and time.

Feeding response data to Microsoft Dynamics CRM
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to send recipient response data back to Microsoft Dynamics
CRM, when integrating this with Optimizely Campaign. By default, the response data is
accessed hourly.
The response data includes:
l
l
l

Mailing opened
Link clicks in the mailing
Direct replies to the mailing
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l
l

Unsubscribes (opt-outs)
Bounced recipient email addresses
Note: To display unsubscribes (opt outs) and outbounces, the
required fields must first be configured. See Configuring the integration.

Unsubscribe (opt out)
When an unsubscribe is registered in Optimizely Campaign, this information is transferred
to Microsoft Dynamics. As a result, the lead or contact's advertising consent gets an optout entry in the opt-in history. If the most recent entry for an advertising consent according to the time stamp is an opt-out entry, the contact or lead no longer receives a newsletter. Furthermore, with a current opt-out entry, there will be no transmission of recipient
data when the marketing list checks for the existence of advertising consent during synchronization.
If the contact or lead has given his advertising consent for more than this newsletter, all
other subscriptions remain active.
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Outbounce
Note: The display of outbounces requires the configuration of the
field in the form. See Creating consents and linking to client.
If Optimizely Campaign detects that an email is no longer reachable, the outbounce status
is changed from No to Yes. This status applies to all advertising consents on the channel
and across all clients – regardless of whether the outbounce was registered in every client.

Opens, clicks, and direct replies
When a campaign is run, opens and clicks are imported as replies/campaign responses,
and assigned to the campaign in CRM (saved in the campaign). The import differentiates
between these response categories:
l
l
l
l
l

Open
Click
Reply
Autoresponder
Unsubscription

Use these categories for further segment in CRM.
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Note: Opens, clicks and replies are only imported for mailings sent
using campaign management. Opens and clicks from a copied marketing list are not returned to the CRM.

Extended recipient list connector
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.

Note: The documentation refers to connector version 1.584 and
higher.
The current version of Microsoft Dynamics CRM cannot address more than 100,000 recipients per campaign. The extended recipient list connector for Optimizely Campaign is an
external Windows service that removes the technical limitation and controls campaigns
and the transmission of marketing lists with more than 100,000 recipients.
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Prerequisites
l
l
l
l

Installation file. Contact customer support.
Microsoft Dynamics CRM online or on-premise (local)
SQL database, such as LocalDB or SQL Express.
Port reservation
1. Open the command prompt as administrator.
2. Run the netsh configuration program.
3. Reserve the port using the prompt add urlacl url=http://+:20000/ userr=domain\username.
Note: The specification of the port +:20000 must match the
later port specification in the IntegrationService.config installation file.

Technical requirements
l

SQL server

l

Microsoft SQL Server 2008R2 (all versions with LocalDB) and later
Microsoft SQL Azure
Windows Identity Foundation 3.5 (Windows feature)

l

.NET Version 4.6.2

o
o

Installation
1. Unzip the installation file that you have received from the customer support.
2. Open the IntegrationService.exe.config file in a text editor.
3. Optional: Configure the proxy settings.
<add key="proxy.Domain" value= />
<add key="proxy.UserName" value= />
<add key="proxy.Password" value= />
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<add
<add
<add
<add

key="proxy.Protocol" value= />
key="proxy.Host" value= />
key="proxy.CredentialType" value= />
key="proxy.Port" value= />

Note: The configuration does not replace the proxy configuration
for the CRM. This is still necessary for functionalities such as
double opt-in or transactional mails.
4. Adjust the connectionStrings element as follows:
<connectionStrings>
<add name="Hangfire.Storage" connectionString="Server= ; Database=
;
Trusted_Connection=True; MultipleActiveResultSets=true" />
<add name="CRM" connectionString="RequireNewInstance=true;
Url={https://server/organization/}; Domain= ; Username= ; Password= ;" />
</connectionStrings>

Microsoft Dynamics CRM online
l

For the connectionString parameter, prefix the URL with the parameter AuthTypee=Office365; as follows:
connectionString="AuthType=Office365;
Url={https://server/organization/}; Domain= ; Username= ; Password= ;"

l

The parameters Username and Password are required.

Microsoft Dynamics CRM on-premise
l

If you sign in using the following Windows services, the Domain, Username, and
Password parameters are not required in the connectionString:
o

Microsoft Dynamics CRM Asynchronous Processing Service (MSCRMAsyncService)
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Microsoft Dynamics CRM Sandbox Processing Service (MSCRM SandboxService)
5. Save the IntegrationService.exe.config file.
6. Open the Command Prompt as administrator.
7. Enter the connector path and install the Integrationservice.exe file with the prompt
integrationservice.exe install.
o

8. Open Windows Services and start Episerver Campaign Integration Service.
Note: If you want to update or modify the configuration, you must
first stop the connector via Windows Services.

Configuring the connector
In the IntegrationService.exe.config file, you can adjust the following parameters for the
data transfer.
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Description

Default
value

MaxSendRetries

Number of attempts to transmit a recipient
package when an attempt fails, for
example, due to a timeout.

3

TimeoutCrmConnection

Maximum time in seconds for the transmission of a recipient package from the
CRM to the service before a timeout error
occurs.

60

TimeoutEpiserverConnection

Maximum time in seconds for the transmission of a recipient package from the service to Optimizely Campaign before a
timeout error occurs.

120

UseSoapServiceForRecipientLists

Choice between data transfer via SOAP or
REST API. REST API is used by default.

false

BatchSize

Size of the recipient package when transferring from the service to Optimizely Campaign. When transferring using SOAP API,
the maximum value is 1000.

5000

CrmBatchSize

Size of the recipient package when transferring from the CRM to the service.

1000

MaxThreads

Number of parallel threads when transferring via API. The maximum number is 6.

5

Parameter

Configuration in Microsoft Dynamics CRM
1. Open Microsoft Dynamics CRM and select Settings > Configurations.

2. Click New.
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3. Enter the name Use Windows Service.

Tip: You can leave the Value field blank. No definition is required.
4. Click Save & Close.

Troubleshooting
With the Hangfire tool you can view and manage planned, running and executed workflows. You install Hangfire automatically with the connector and access the tool in your
web browser at the following address: http://localhost:20000/hangfire.
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To view the log data of the service, open the logs.txt file in the installation directory. You
can find the log data of the past days in the archives folder.

Uninstallation
To uninstall and completely remove the extended recipient list connector, do the following:
Note: The extended recipient list connector must be inactive. Open
Windows Services and stop Episerver Campaign Integration Service.
1. Open the Command Prompt as administrator.
2. Enter the connector path and uninstall the Integrationservice.exe file with the prompt
integrationservice.exe uninstall.

Tip: The installation directory still remains. Delete the directory
including the log data.
3. Open Microsoft Dynamics CRM and select Settings > Configurations.
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4. Select the Use Windows Service configuration data set and click Delete.

Troubleshooting and maintenance
Note: This topic is for administrators and developers with administration access rights in Microsoft Dynamics.
This topic describes how to troubleshoot and maintain the Microsoft Dynamics CRM integration for Optimizely Campaign. The following is included:
l
l
l
l
l

Checking workflows for activity and errors.

Common error messages.
Reducing storage space used by the integration.
Managing divergent time stamps.
Service updates for Microsoft Dynamics 365 Online

Checking workflows for activity and errors
Active and running workflows are shown in the CRM settings under System jobs. You can
apply a filter for the Optimizely Campaign workflows under Entity. There are these categories:
l
l
l
l

API data
Recipient Packages
Client
Mapping
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Regularly check the Client and Recipient Packages workflows for errors. See Workflow
error messages.
Do the following to check workflow activity for a client:
1. In Microsoft Dynamics CRM, open the settings and click Clients under Episerver Campaign.
2. Double click the client. The following is under Information, providing the time of the
last data import:
l
l
l
l
l

Last clicks date.
Last opens date.
Last responses date.
Last unsubscribes date.
Date of last bounce limit overruns.
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If one or more imports were done more than an hour ago, the workflow is no longer active. This can be due to insufficient resources within the CRM, or a network problem.
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3. Click Run Workflow and select the workflow to restart. If the problem persists after
restart, contact your system administrator.

Viewing workflow error messages
If a workflow did not run successfully, Status Reason under Settings > System > System
Jobs shows the message Failed.

1. Click the name of the corresponding system job to see a detailed description of the
error.

2. Resolve the error.
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3. If you are unable to resolve the error, click Details to see the trace for the workflow.

4. Copy the trace text and error message with the time stamp for the error, and contact
customer support providing the information.
Common error messages
Error message

Description

The specified mailing is not assigned to the
mandator.

You have selected a mailing for the campaign that is
not assigned to the same client as the selected marketing permission.

The number of flat recipient field values (57)
is not a multiple of the number of recipient
field names (18).

The configuration of the fields to be transferred
does not match the recipient list fields of the Optimizely Campaign client.
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Reducing used disk space
Reducing used disk space is optional. The integration operation will not be affected if this
is not done. However, you will save storage resources and have a better overview of workflows.
The following options are available:
l
l

Delete recipient packages no longer required.
Delete completed workflow jobs.

Deleting recipient packages no longer required
1. Open Microsoft Dynamics CRM and select Settings > Recipient Packages.

2. Click the arrow next to Active Episerver Campaign Recipient Packages.
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3. In the drop-down list, select Old Episerver Campaign Recipient Packages.

4. Select the recipient package to delete and click Delete.
Deleting completed workflow jobs
By default, Microsoft Dynamics keeps completed workflow jobs. To configure automatic
deletion of completed workflow jobs, do the following:
1. Open Microsoft Dynamics CRM and select Settings > Processes.

2. Click the arrow next to the title.
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3. In the drop-down list, select the corresponding option, such as Activated Processes.

4. Click the workflow for which the job should be automatically deleted after completion.
5. Under Workflow Job Retention, select Automatically delete completed workflow
jobs (to save disk space).

Note: To select the check box you may have to deactivate the
workflow for a short period. When you have selected the check
box, reactivate the workflow.
6. Click Close.
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Managing divergent time stamps
The behavior of the date fields in Microsoft Dynamics CRM can lead to divergent time
stamps in CRM and Optimizely Campaign. When using date fields with time specifications,
use the User Local field type, as this will consider the time zone set for the user during
data synchronization.
Do the following to check the data format in the field settings:
1. In Microsoft Dynamics CRM, locate the affected date and time field.
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2. Edit the field, and check the properties to see if the field is defined as User Local.

If the field is defined as Time-Zone Independent, it will not consider the time zone set
in CRM. Optimizely Campaign, will convert the time for display to the time zone of the
user, so that deviations may occur.
Once the field has been saved in CRM as Time-Zone Independent, it can no longer be
changed. In this case, the field should be deleted and recreated.

Service updates for Microsoft Dynamics 365 Online
Microsoft releases service updates for Microsoft Dynamics 365 Online on different
times without an announcement. Service updates might affect the functionality of the
Microsoft Dynamics CRM integration for Optimizely Campaign. Optimizely cannot
exclude possible malfunctions in advance. For more information about service
updates, see Microsoft Support.

Translation interface
Note: To enable this feature, contact customer support.
This topic describes the semi-automatic translation interface for Optimizely Campaign that
lets you create and send mailings in multiple languages. You select the mailing, source and
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target language, order the translation and Optimizely Campaign notifies you as soon as the
mailing is ready for dispatch in the desired language versions.

How it works
Optimizely Campaign creates an XML file with the content for translation and sends it via
email to the translation service provider you specified.
When the translation is ready, Optimizely Campaign generates a new mailing from it in the
target language. As soon as all requested language versions are available, the mailing can
be sent.

Setup
Optimizely customer support sets up the translation interface for you. Provide the following
information:
l
l

Users who are to access the translation interface
Email address to which translation orders are to be sent. This can be a translation agency
or a colleague from your company.
Tip: You can specify a different email address for each language.

Ordering translations
1. Open the Optimizely Campaign menu and select More > Mailing-Übersetzung
starten (Start mailing translation).
2. Under Mailing, select the desired mailing.
3. Select the source and the target language. Use multiple selection (CTRL + left mouse
button) to select multiple target languages.
Tip: You can add a comment to your translation order and specify, for example, whether and how image names and URL
addresses are to be translated.
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4. Confirm the order by selecting the check box.
5. Click Übersetzung starten (Start translation). Optimizely Campaign sends an email
with the content to be translated to the translation agency. The XML file contains
information about the source language and the target language.

6. The translation service provider sends back an email with the translated texts. The service provider must enter the translations in the XML file sent by Optimizely Campaign
and return it to Optimizely Campaign as an email attachment.

7. Optimizely Campaign checks the translation for formal correctness and completeness.
If errors occur, the process is terminated and an error message is sent to all parties. If
the translation is technically correct, the original mailing is copied and all text modules
are exchanged for the new texts in the XML file.
8. The persons in charge specified by you receive a success message and the translated
mailing is ready for dispatch.
Tip: If your recipient list contains information about the language
of the recipients, you can control the recipients of the respective
language version using a recipient data-based target group.
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Closed-loop interface
This topic describes the closed-loop interface that is used for bi-directional handling of
actions and data exchange between Optimizely Campaign and external systems. For
example, using the closed-loop interface, you can create and send personalized newsletters automatically in Optimizely Campaign from an external campaign management system.

Setup
Contact customer support regarding setup of the closed-loop interface, and terms and conditions that apply when accessing this type of non-anonymized action-based data.
Tip: Because the response data consists of non-anonymized actionbased data, you have to indemnify and hold Optimizely harmless in
advance from any potential liabilities and third-party claims which
may result from making this functionality available to you.

How it works
The closed-loop interface consists of two modules: the import module and the response
data export.
To create and send mailings automatically, you must first create a source mailing in Optimizely Campaign and submit the mailing ID to your external system, for example, a campaign
management system (CMS). In the CMS, you select the recipients and provide the recipient data.
The import module transfers the recipient data including the ID of the source mailing to
Optimizely Campaign. After the import, you receive a status notification. In Optimizely Campaign, a campaign copy is created with the personalized content (for example, product
recommendations) and the mailing is sent - either directly, or at a specified time. Optionally, you can resend the mailing manually if recipients have generated soft bounces, for
example.
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The response data export transfers the response data (opens, clicks, responses, unsubscribes) of the sent mailing back to your CMS. You can then process the response data further in the CMS or a third-party system, such as a data warehouse.

The import module and the response data export can be configured and used independently of each other.

Exchanging data
The data exchange is done using an SFTP server set up at Optimizely, and recipient data is
transferred to that server. Response data is available for download from the same server.
Running transfers must have a temporary file name to avoid incomplete file exchange, see
Data transfer troubleshooting. Naming conventions are described below.
Note: The data exchange does not respect strict separation of clients. All user data can be transferred through one SFTP account. You
can set up client-specific SFTP accounts if required for security reasons. Alternatively, you can set up separate sub-directories in one client. In both cases, the recipient data import module must then
commit one file per client/directory.
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Transferring recipient data
Recipient data can be transferred at any time to the Optimizely Campaign SFTP server.
The name convention of the transferred files must be as follows:
YYYYMMDDHHMMSS_subscribers.csv

The recipient file is a CSV file with the following properties:
l
l
l
l

l
l

Phrase and field lengths are variable within the limits of the recipient list.
A semicolon (;) is used as separator.
Line feed is used for line breaks.
Quotation marks ("") are used as field boundaries. To designate quotation marks within a
field, wrap them in quotation marks.
The file does not contain declarations regarding columns and field lengths.
Empty fields (NULL) remain empty in a data set. The number of field separators must be
constant.

Recipient data is processed automatically every 10 minutes. The SFTP server of Optimizely
Campaign provides log files for download within 30 days after creation.
Note: According to the specifications, fields of the main recipient list
must be committed. Fields supposed to not contain any value are
committed as empty columns. Existing fields and the field sequence
are fixed. Do not change them without the consent of both parties.

Using personalization and recommendations
It is possible to enhance the delivered recipient data with personalization, for example by
adding product recommendations to the mailing.
One or more fields reserved for a product ID are added to the CSV file with the recipient
data. Product information (such as title, description, image-URL) for recommended
products is transferred in a second CSV file. Product information is inserted into the mail-
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ing using field functions and a placeholder. Assigning product IDs to recipients is done by
the customer.
With web analysis software, recommendations are available via a CSV file. Other recommended products are assigned to each product. Product information is rendered into the
mailing using a special field function, similar to the process described above. You do not
need to assign products to a recipient, as this is automatically done by the web analysis
software in accordance with the initial configuration.
Note: To add personalized content, you need a new template.
Contact customer support.

Creating source mailings and sending mailings
As a basis for the campaign you are going to send, you create a source mailing in Smart
Campaigns and submit the mailing ID to the external system. A so called master list serves
as recipient list for the source mailing. Placeholders referencing a specific field of the recipient list are inserted into the mailing paragraphs. Using these placeholders you can individually assign and insert product data and other information into the mailing.
To send multiple newsletters, or send newsletters at the same time, you have to create multiple source mailings. The source mailing is never sent and must remain in status New or
respectively Activation required. Do not activate the mailing, otherwise the copy cannot
be created. Instead the system automatically creates a copy of it and sends that, so the
source mailing can be reused.
Note: If you create a mailing using the REST API, you cannot use the
mailing for the closed-loop interface. Create the source mailing only
in Smart Campaigns.

Triggering the dispatch
When a file containing recipient data is stored in the corresponding directory on the SFTP
server, the mailing is sent. Every 10 minutes, a Cron job checks this directory for new files.
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If a new file exists, it is imported into the recipient list of the corresponding client, and
assigned to the source mailing using the parameter BROADMAIL_ID.
There are different ways to add content to a mailing:
l

l

Directly from the file. The content is imported along with the recipient data in a CSV file.
This method is only applicable for texts and hyperlinks.
Referenced content. URLs in the imported CSV files are used to reference the content.
When sending the mailing, the content is retrieved from the external server of the customer through the content interface. You can add texts, pictures, attachments, and hyperlinks types of content to a mailing.

When the data is imported, the mailing is automatically sent, and gets a unique ID.
You can send test emails using the closed-loop interface by storing test data instead of
real data on the server. The CSV file must have the same structure as the file containing
the real recipient data. Every time a test email is sent, a new mailing is created in Optimizely Campaign.
Note: Mailings are triggered only by storing a file on the server configured for the closed-loop interface. You cannot send mailings by
using the Optimizely Campaign user interface.
You can customize the source mailing for different newsletters. Only change the source
mailing after the previous mailing is sent. Additionally, ensure that the correct mailing ID of
the source mailing is used in the recipient CSV file.

Troubleshooting data transfer
If a problem occurs transferring the data, a notification is sent to an email address configured beforehand. An error file is generated and the transfer stopped. During implementation you can configure the exact interface behavior in case of an error. When the
implementation is completed, you can switch off this setting.
If an error occurs, the interface must be restarted in accordance with the error file. These
are the cases:
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l
l

Data import failed.
Error when mailing is started after data import.

Errors during data transfer are handled by customer support, since these can only be
resolved manually.

Monitoring and sending status
After a recipient data import, the status of the process is sent via email and registered in a
log file. This assures that actions within the interface are properly logged and documented
in Optimizely Campaign.
Structure of the main recipient list
Column
name

Data type

Example

Description

Email

Varchar(255)

user@example.com

Email address of the recipient

broadmail_ID

Bigint/Long

44018617811

Mailing ID in Optimizely Campaign
(broadmail_ID)

46623317811

Identifies the selection/sending
wave for unambiguous assignment
of user actions. This parameter is
optionally set by the external system when importing the recipient
data.

WAVE_ID

Bigint/Long

Salutation

Varchar(255)

Field from existing recipient list.

First name

Varchar(255)

Field from existing recipient list.

Last name

Varchar(255)

Field from existing recipient list.

Note: The list configuration described above is an example. More
fields can be added if required for personalization purposes. Contact
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customer support beforehand, and document them in the interface

setup.

Specifying response data
Response data is generated daily from the log files, and is available for download at a configured time via an SFTP server within Optimizely Campaign. The files contain the most
recent data. The files containing the mailing data are available for download for 30 days
after starting the mailing.
The response data consists of eight CSV files. Each of these can be read as a table. The
response data is exported as String data type. You can also convert numeric values such
as the mailing and client ID to the Long data type. See detailed type information for each
file below.
Tip: The names used in the following documentation are examples.
File names can be configured.

Sent mailings
YYYYMMDD_mailings.csv contains mailings sent in the referenced period.
Column name

Description

Example

id (mailingId)

Mailing ID

51106527229

compoundMasterId

Campaign ID in Smart Campaigns

71206365463

mailingGroupId

Client ID (BROADMAIL_ID)

44018617811

mailing.recipientLists

Recipient list ID

58243723257

started

Start time of the mailing

2022-01-01
12:07:55
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Column name
finished

Description

Example

Key

2022-01-01
12:09:10

End time of the mailing

Sending Log
YYYYMMDD_mailingrecipients.csv contains recipient-related data. The sending log
refers to the mailings contained in the file YYYYMMDD_mailings.csv.
Column name

Description

Example

Key

id (mailingToUserId)

Encoded assignment
of the recipient

25951836752

Primary key

mailingId

Mailing ID

51106527229

Foreign key

mailingGroupId

Client ID
(BROADMAIL_ID)

44018617811

userId

Email address of the
recipient

user@example.com

created

Sending date and
time

2022-01-01 12:07:55

sendingStatus

Sending status

l

sending - Mailing is sent

l

sent - Mailing was sent

l

could_not_be_sent - Mail-

ing could not be sent

deliveryStatus

response.category

Delivery status

Response category

l

OK - Mailing was delivered

l

HARD - Hard bounce

l

SOFT - Soft bounce

l

unknown - The recipient

sent a response to the mailing
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Column name

Description

Example
l

bounce - Soft bounce

l

temporary_bounce - Soft

Key

bounce
l

fatal_bounce - Hard

bounce
l

autoresponder -

Autoresponder

Links
YYYYMMDD_links.csv contains links from the mailing. Data is only available for links with
activated link tracking.
Column name

Description

Example

Key

id (linkId)

Link ID

44018617936

Primary key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment of
the recipient

25951836752

Foreign key

mailingGroupId

Client ID (BROADMAIL_
ID)

44018617811

name

Link name

Impressum

url

Link target (URL)

http://www.example.com

Clicks
YYYYMMDD_clicks.csv contains mailing clicks generated by recipients, within the referenced period. Clicked links/URLs can be found in the file YYYYMMDD_links.csv.
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Column name

Description

Example

Key

linkId

Link ID

44018617936

Foreign key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment of the
recipient

25951836752

Foreign key

mailingGroupId

Client ID (BROADMAIL_ID)

44018617811

userId

Email address of the recipient

user@example.com

Date and time of the click

created

Note:
There can
be multiple
clicks from
one recipient within
one
second.

2022-01-01 12:07:55

click.browser

Web browser

Firefox 64.1

click.platform

Operating system

Windows 10

click.device

Device type

Desktop

Opens
YYYYMMDD_opens.csv contains mailings opened by recipients in the referenced period.
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Column name

Description

Example

Key

linkId

Link ID

44018617936

Foreign key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment of the
recipient

25951836752

Foreign key

mailingGroupId

Client ID (BROADMAIL_ID)

44018617811

userId

Email address of the recipient

user@example.com

Date and time when the recipient opened the mailing

created

Note: One
recipient
can open a
mailing several times.
In this
case, each
opening
generates
a singular
data set.

2022-01-01 12:07:55

open.browser

Web browser

Firefox 64.1

open.platform

Operating system

Windows 10

open.device

Device type

Desktop
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Automatic opens
YYYYMMDD_automated_opens.csv contains automatic opens in the referenced period.
See Apple Mail Privacy Protection.
Column name

Description

Example

Key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment of the
recipient

25951836752

Foreign key

mailingGroupId

Client ID (BROADMAIL_ID)

44018617811

userId

Email address of the recipient

user@example.com

created

Date and time of the generated open

2022-01-01 12:07:55

open.browser

Web browser

Apple Mail Privacy Protection

open.platform

Operating system

unknown

Unsubscribes
YYYYMMDD_unsubscribes.csv contains unsubscribes by recipients in the referenced
period.
Column name

Description

Example

Key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment of the
recipient

25951836752

Foreign key
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Column name

Description

Example

mailingGroupId

Client ID (BROADMAIL_ID)

44018617811

userId

Email address of the recipient

user@example.com

created

Date and time of the unsubscribe

2022-01-01 12:07:55

Key

Responses
YYYYMMDD_responses.csv contains emails returned to the sender address from any user
within the referenced period.
Column name

Description

Example

Key

mailingId

Mailing ID

51106527229

Foreign key

mailingToUserId

Encoded assignment
of the recipient

25951836752

Foreign key

mailingGroupId

Client ID (BROADMAIL_
ID)

44018617811

userId

Email address of the
recipient

user@example.com

created

Sending date and time

2022-01-01 12:07:55
l

unknown - The recipient sent

a response to the mailing

category

Response category

l

bounce - Soft bounce

l

temporary_bounce - Soft

bounce
l

fatal_bounce - Hard

bounce
l

autoresponder -

© Optimizely 2022

Integration and interfaces | 1351

Column name

Description

Example

Key

Autoresponder

Transferring files through SCP
This topic describes options for transferring data files to an Optimizely server. This data
exchange is needed for various integrations of external systems with Optimizely Campaign.
To upload or download files securely between your computer and the Optimizely server,
you use Secure Copy Protocol (SCP), which protects data from third-party access during
transmission.
To use SCP, you install an SCP program on your computer, then provide access data for
the server and an authentication key. After establishing an encrypted server connection,
you can securely exchange files.
These options are available:
l

Configuring SCP transfer for macOS/OS X

l

Configuring SCP transfer for Windows

Configuring SCP for macOS/OS X
This topic describes how to configure and use secure encrypted data transfer with macOS
(previously OS X) via Secure Copy Protocol (SCP). File transfer is often needed for data
exchange when integrating external systems with Optimizely Campaign.

Configuration steps
1.
2.
3.
4.

Creating a key pair
Downloading and installing Cyberduck
Downloading and installing Cyberduck
Establishing an SCP server connection
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Step 1: Creating a key pair
1. From the Utilities folder, open Terminal.

2. Enter ssh-keygen and press Enter.
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3. Enter a file path and file name for the key pair. For example, to save the key pair to your
desktop in a file called key, enter /Users/<name of your user folder>/Desktop/key. Press Enter to confirm.

By default, Terminal suggests the hidden .ssh folder in your user folder as the file location, and the id_rsa as the file name. Unless changed, the key pair is saved in that directory using that file name. The private key is given the id_rsa file name, while the
public key is assigned the .pub extension. In this example, the public key name is id_
rsa.pub.
Note: To see the name of your user folder, click Go>User folder
in the MacOS Finder menu. Finder opens a window with the user
folder name at the top.
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4. In the Enter passphrase dialog box, enter your password (not visible).

Note: Remember your password, you need it later to establish a
server connection.
5. Re-enter your password and press Enter.
6. The key fingerprint is shown in the Terminal window following The key fingerprint is:.
Copy the key fingerprint to a text document and save it.
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Step 2: Configuring a user account for SCP access
1. Email your public key (file with .pub extension) to Optimizely customer support.
2. In a separate email, send your key fingerprint to Optimizely customer support.
Note: For security reasons, do not send the public key and key
fingerprint together.
3. Optimizely customer support configures the account, and sends you an email with your
user account data.

Step 3: Downloading and installing Cyberduck
Cyberduck is a free program used for establishing a connection to the server.
1. Using a browser, go to https://cyberduck.io.
2. Click Download Cyberduck for Mac.
3. When the download finishes, open the folder with Cyberduck. No specific installation is
required.
4. Optional: move Cyberduck to a permanent folder, such as Programs or Utility programs.
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Step 4: Establishing an SCP server connection
1. Open Cyberduck.
2. To create a bookmark for connecting to the server, click the plus icon + at the bottom.

3. Click the top options menu and select SFTP (SSH File Transfer Protocol).
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4. Fill out the information as follows.

l
l
l
l

Nickame: Enter a name to the bookmark.
Server: Enter the address ftpapi.campaign.episerver.net.
Username: Enter name as provided by Optimizely.
Open More options and enable Use Public Key Authentication.
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5. Go to your private key folder and select the private key.

Note: Do not confuse the private key with the public key. For the
Use Public Key Authentication option, use your private key.
6. Click Choose on the bottom-right.
7. Close the bookmark configuration dialog box by clicking the red close button.
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8. To establish a server connection, double-click the saved bookmark.

9. When prompted for a password, enter the one from Step 1: Creating a key pair.

Configuring SCP for Windows
This topic describes how to set up secure file transfer via Secure Copy Protocol (SCP) for
Windows using WinSCP. File transfer is often needed for data exchange when integrating
external systems with Optimizely Campaign.

Configuration steps
1. Downloading and installing WinSCP
2. Creating a key pair
3. Transmitting keys to Optimizely
4. Establishing a WinSCP connection

Step 1: Downloading and installing WinSCP
1. Click http://winscp.net/eng/download.php.
2. Click Download.
3. Run the setup program.
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Step 2: Creating a key pair
1. Run the PuTTYGen program (part of WinSCP).

a. Parameters: Select RSA (Optimizely only supports RSA).
b. Number of bits in a generated key: Enter 2048.
c. Click Generate.
2. Make random computer mouse movements across a gray field to generate key values.
A progress bar indicates the progress.
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When generation is completed, the keys are displayed.
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3.

Fill in the fields as follows:

a. Key comment: Enter a description such as "Optimizely Campaign-<your_companyname>".
b. Key passphrase: Enter a password. For security reasons, use at least an eight-digit
word containing letters, numbers and special characters.
c. Confirm passphrase. Enter the password again.
4. Click Save public key.
5. Click Save private key.
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Step 3: Transmitting keys to Optimizely
1. Copy the public key and email it to Optimizely customer support.
2. Copy the key fingerprint and email it separately to Optimizely customer support.
Note: For security reasons, do not send the public key and key
fingerprint together.
3. Optimizely sends a confirmation when your SCP (Secure Copy Protocol) access is active.
Note: Protect your keys from unauthorized access. If lost, immediately contact Optimizely and generate a new key pair as described
above.
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Step 4: Establishing a WinSCP connection
1. Launch the WinSCP program.
2. In the login window, click New Site.

3. Fill out the information as follows.
Host name: Enter ftpapi.campaign.episerver.net.
l
User name: Enter name as provided by Optimizely.
4. Click Advanced...
l
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5. Select Environment > SFTP and enable Allow SCP fallback.

6. Select SSH > Authentication, click Browse (...) in Private key file and select the previously generated private key.
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7. Click OK.
8. Click Save, enter a name for the connection, and click OK.
9. In the WinSCP login window, select the connection name and click Login.

Webhooks
Note: To enable this feature, contact customer support.
This topic describes how to use webhooks to receive real-time event data about your mailings. You can create webhooks for the following events:
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l
l
l
l
l
l

sent mailings
opens
clicks
bounces
unsubscribes
spam complaints

For example, you can use the data for notifications and analyses in external systems such
as CRM software. You manage webhooks using the Optimizely Campaign REST API.
l

Creating webhooks

l

Retrieving webhooks

l

Updating webhooks

l

Verifying webhooks

l

Activating webhooks

l

Deactivating webhooks

l

Deleting webhooks

Creating webhooks
1. Open the operation Create a webhook and click Try it out.

2. Enter the following information in the corresponding mandatory fields:
l

clientId. Client ID. To see the client ID, open the Optimizely Campaign menu and
select Administration > API Overview > REST API.
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l

targetUrl. URL to which the event data is to be sent.
Prerequisites:

l

URL must be accessible and able to receive data via HTTP POST requests from
the IP address 193.169.180.1 at any time
o current HTTPS version and standard port 443 for HTTPS connections
type. Type of the event data to be sent.

l

open. Opened mailing.
o click. Clicked links.
o sent. Sent mailing.
o bounce. Generated hard or soft bounce.
o unsubscribe. Unsubscribed from newsletters. See also: Unsubscribers.
o spamcomplaint. Message marked as spam.
format. Data format in which the event data is to be sent.

o

o

Note: The following data format is currently available: JSON.
3. Optionally, enter the following information if you want to submit the Basic HTTP
Authentication header:
basicAuthUsername. User name.
l
basicAuthPassword. Password.
4. Click Execute. If the creation was successful, you receive the HTTP response status
code 201.
l

Retrieving webhook information
To retrieve information about a webhook, such as webhook ID, target URL, and event type,
do the following:
1. Open the operation Get information about all webhooks and click Try it out.
2. In the clientId mandatory field, enter your client ID. To see the client ID, open the
Optimizely Campaign menu and select Administration > API Overview > REST API.
3. Click Execute.

© Optimizely 2022

Integration and interfaces | 1369

Tip: You need the webhook ID for updating, verifying, activating, deactivating and deleting the webhook.

Updating webhooks
1. Open the operation Update a webhook and click Try it out.
2. Enter the following information in the corresponding mandatory fields:
clientID. Your client ID. To see the client ID, open the Optimizely Campaign menu
and select Administration > API Overview > REST API.
l
webhookId. Webhook ID. You can retrieve the webhook ID with the operation Get
information about all webhooks.
3. Update the information as described in Creating webhooks.
4. Click Execute. If the update was successful, you receive the HTTP response status
code 200.
l

Verifying webhooks
To verify that the webhook is ready to use and can send event data to the specified URL,
do the following:
1. Open the operation Verify a webhook and click Try it out.
2. Enter the following information:
l

l

clientID. Your client ID. To see the client ID, open the Optimizely Campaign menu
and select Administration > API Overview > REST API.
webhookId. Webhook ID. You can retrieve the webhook ID with the operation Get
information about all webhooks.

mailinId. ID of a valid mailing, for example a test mailing in Smart Campaigns.
3. Click Execute. If the verification was successful, you receive the HTTP response status
code 200.
l
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Activating webhooks
To export event data in real time, you must activate the corresponding webhook. Do the following:
1. Open the operation Activate a webhook and click Try it out.
2. Enter the following information in the corresponding mandatory fields:
clientID. Your client ID. To see the client ID, open the Optimizely Campaign menu
and select Administration > API Overview > REST API.
l
webhookId. Webhook ID. You can retrieve the webhook ID with the operation Get
information about all webhooks.
3. Click Execute. If the activation was successful, you receive the HTTP response status
code 200.
l

Event data
As soon as a mailing recipient performs an action, Optimizely Campaign sends the corresponding event data via a HTTP POST request to the target URL. The event data is sent
in batches (lists) consisting of a maximum of 100 events each.
Note: After successful data receiving, the target URL must return the
HTTP response status code 200. Otherwise the export is retried
every 10 seconds. If no data can be delivered three days after the
event is created, the event is discarded.

[
{
"type":"open",
"recipientId":"123456789005",
"userListId":123456789003,
"remoteAddress":"10.420.3.42",
"clientId":123456789001,
"mailingId":123456789004,
"created":1564590054000,
"subscriptionId":1234567,
"mailId":"3P5W8B4-3P5W0LI-BSLXEC",
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
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},
"device":"desktop",
"operatingSystem":"Windows 10",
"browser":"Firefox 64.1"
},
{
"type":"open",
"recipientId":"123456789005",
"userListId":123456789003,
"remoteAddress":"10.420.3.42",
"clientId":123456789001,
"mailingId":123456789004,
"created":1564590054000,
"subscriptionId":1234567,
"mailId":"4P6W8B4-4P6W0LI-BSLXEC",
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"device":"desktop",
"operatingSystem":"Windows 10",
"browser":"Firefox 64.1"
}
]
{
"type":"click",
"link":"https://www.optimizely.com",
"mailingId":10230355206,
"remoteAddress":"10.420.3.42",
"linkId":10180855027,
"device":"desktop",
"browser":"Safari 13.1",
"operatingSystem":"Mac 10.13",
"created":1617108763000,
"mailId":"4P6W8B4-4P6W0LI-BSLXEC",
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"userListId":10180860004,
"recipientId":"john.smith@example.com",
"subscriptionId":10227900201,
"clientId":10180860001
}
{
"mailingType":"campaign",
"type":"sent",
"id":"0a673110-17883138caf-178832ea49f-2690c03e51f4cc26",
"mailingId":10230355206,
"mediaType":"EMAIL",
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"mailingName":"Welcome",
"created":1617108575391,
"mailId":"4P6W8B4-4P6W0LI-BSLXEC",
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"userListId":10180860004,
"recipientId":"john.smith@example.com",
"subscriptionId":10227900201,
"clientId":10180860001
}
{
"type":"bounce",
"id":"0a673102-178d27b2c8c-178d2cac0e4-c7420699923845e",
"recipientId":"john.smith@example.com",
"userListId":10180860004,
"clientId":10180860001,
"created":1617108575391,
"subscriptionId":10227900201,
"mailId":"4P6W8B4-4P6W0LI-BSLXEC",
"mailingId":10230355206,
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"category":"softbounce",
"mediaType":"EMAIL",
"reason":"other",
"thresholdExceeded":false
}

Tip: The "category" parameter defines the bounce category; "softbounce" or "hardbounce". The "reason" parameter defines the
bounce reason; "spam-related" or "other". The "thresholdExceeded" parameter defines whether the recipient exceeded the
bounce limit.

{
"type":"unsubscribe",
"reason":"Unsubscribe via REST API",
"id":"0acb3115-17aa6042099-17aaa1c69bf-6efb42209c0b1",
"mailingId":10230355205,
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"mediaType":"EMAIL",
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"subscriptionId":10237984200,
"mailId":"4P6W7B7-4P5W0LI-BALXEC",
"created":1617108763000,
"recipientId":"john.smith@example.com",
"userListId":10180860009,
"clientId":10180860001,
}
{
"mailingType": "campaign",
"providerName": "AOL",
"id": "0a0a3742-17k7f11690c-13c82b66689-63eb542f53667a61",
"mailingId": 365704742069,
"type":"spamcomplaint",
"mediaTypesToAddresses": {
"EMAIL":"john.smith@example.com"
},
"subscriptionId":10237984200,
"mailId":"4P6W7B7-4P5W0LI-BALXEC",
"created":1617108763000,
"userListId":10180860009,
"recipientId":"john.smith@example.com",
"clientId":10180860001,
}

Deactivating webhooks
If you no longer want to export event data, you must deactivate the webhook. The webhook still exists and you can reactivate it later. Do the following:
1. Open the operation Dectivate a webhook and click Try it out.
2. Enter the following information in the corresponding mandatory fields:
clientID. Your client ID. To see the client ID, open the Optimizely Campaign menu
and select Administration > API Overview > REST API.
l
webhookId. Webhook ID. You can retrieve the webhook ID with the operation Get
information about all webhooks.
3. Click Execute.
l

Deleting webhooks
For example, if you no longer need a webhook or want to create new webhooks, but the creation limit per client is reached, you can delete webhooks. Do the following:
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Note: You can only delete deactivated webhooks. See Deactivating a
webhook.
1. Open the operation Delete a webhook and click Try it out.
2. Enter the following information in the corresponding mandatory fields:
clientID. Your client ID. To see the client ID, open the Optimizely Campaign menu
and select Administration > API Overview > REST API.
l
webhookId. Webhook ID. You can retrieve the webhook ID with the operation Get
information about all webhooks.
3. Click Execute.
l

API overview
The API overview provides access to specific data like URLs, IDs and authorization codes
required when integrating Optimizely Campaign using for example REST and SOAP APIs.
To open the API overview, open the Optimizely Campaign menu and select Administration
> API Overview.
See also API documentation on Optimizely World:
l

REST API

l

SOAP API

l

HTTP API

l

SMTP API
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Information in the API overview

REST API
The ID of the client you are logged in to and a link to the REST API User Manual.

SOAP API
The ID of the client you are logged in to and a link to the SOAP API User Manual.

HTTP API
Here you find a link to the HTTP API User Manual with more information and examples.

Post-Click Tracking
l
l

Standard Basic URL. The default URL for the tracking of post clicks.
User Event Basic URL. The URL for the tracking of post clicks that are not related to a
mailing.
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Recipient Lists
Overview of the recipient lists in your client, and information required for the HTTP and
SOAP APIs.
You can also manage authorization codes for recipient lists:
1. Select a recipient list in the listing.
2. Click Manage Authorization Codes….
3. Click Create Authorization Code to add a new code for the recipient list. Or, select
an authorization code in the list and click Deactivate Authorization Code, to deactivate it.

Target Groups
Target groups are available in your client, with information required for the HTTP and SOAP

APIs.
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Opt-in Processes
Opt-in processes are available in your client, with information required for the HTTP and

SOAP APIs.

Special Mailings
Special mailings are available in your client, with information required for the SMTP API.
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Support
This section provides contact details of the Optimizely customer support if you have any
questions or problems. You can also find out about Optimizely's wide range of services
such as training or the full-service dispatch.
l

Customer support. Contact details of the Optimizely customer support.

l

Full-service dispatch. Mailing dispatch by Optimizely.

l

Trainings. Recorded video trainings and individual trainings.

l

Configuration of scheduled jobs. For regular tasks such as data imports and exports, cus-

tomer support can create automated jobs.

Customer support
Country

Germany,
Austria,
Switzerland

Product

Optimizely
Campaign

Email

Telephone

Availability

campaignsupport@optimizely.com

+49 (0)30-76
80 78 400

Monday to
Friday, 9 a.m.
to 6 p.m.
(CET)

support@optimizely.com

See the support portal

Any other

All others

Any

Full-service dispatch
If you want to send mailings to your customers at regular intervals but do not have time to
import new recipients, create new mailing content, and run a quality check before sending
a mailing, use Optimizely's full-service mailing dispatch. Supply Optimizely with addresses,
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the latest content, and your message template, and Optimizely takes care of the rest,
including reporting after the process is finished. To ensure quality, Optimizely sends a test
mailing for your approval prior to the actual dispatch.
And, you can use the layout for subsequent newsletters – just supply Optimizely with
updated content.

Needed information
Optimizely needs the following information to generate a full-service mailing dispatch:
l

Recipient data and test recipients as a CSV file (containing at least an email address)
o

o

l
l
l

For a personalized mailing, include a salutation or title, first and last name, and other
desired criteria.
If target groups are being used, include supplementary columns (for example, only distribute to recipients who specified "mobile device" when registering, or addresses
whose code that starts with 49)

Newsletter template as an HTML file or graphic.
Subject line for the mailing.
Sender (such as Your Company Product News) and return address (such as news@example.com).
Note: You need to delegate the sending domain to Optimizely
beforehand. This can take up to 72 hours;Optimizely cannot control the time required. Also, you cannot use a domain delegated
to Optimizely for any other purpose (for example, as a log-in
page), because the selection would produce no response. If you
cannot delegate a sending domain, contact customer support.

l
l
l

Email address for replies.
Current content, where it differs from the template.
Planned dispatch date.

To avoid complaints about unsolicited emails, observe these guidelines:
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l

l

You received an opt-in for all addresses, confirming the recipients' desire to receive promotional emails.
Optimizely may require confirmation of this approval.

Lead time
Plan sufficient lead time to ensure that you can send mailings on schedule. When Optimizely has all necessary information, Optimizely creates a timetable containing:
l
l
l
l
l

Date for sending a test mailing
Date by which correction requests must be submitted
Date by which corrections are incorporated and a second test mailing is sent
Date by which mailing must be approved
Date for sending actual mailing

Allow approximately five working days to evaluate the test mailing, incorporate correction
requests, and provide final approval.

What Optimizely does for you
After you supply Optimizely with information and the planned sending date, Optimizely
does the rest. This includes:
l

Scheduling. Sends you a schedule showing when
the mailing is ready for testing
o your correction requests must be submitted
o corrections are incorporated
o your final approval is needed
Address check. Checks for problem addresses before importing recipients. If a significant
number of addresses may be a problem, Optimizely contacts you.
Importing addresses. Compiles a recipient list that matches your address list, then
imports recipients.
Creating the mailing. Creates a multi-stage mailing based on your message template.
Any graphics included in the template increase your cost. So, it is best to include graphics
as HTML files in the message template.
o

l

l

l
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l

l

l

l

l

l

Modifying content. Incorporates the new text and images if current mailing content differs from the template.
Testing and quality control. Tests mailing before it is sent to test recipients. Optimizely
checks whether major providers and freemailers (T-Online, web.de, GMX , and so on)
deliver the mailing to intended in-boxes, or if spam filters catch any of them, and whether
the contents are displayed correctly.
Sending test emails. When your mailing passes quality control, it is sent to the supplied
test recipients. You screen the content one last time. After that, either send Optimizely
your correction requests, or notify Optimizely by email your approval of the mailing.
Incorporating corrections. Incorporates your changes into the mailing and sends it to
test recipients a second time.
Mailing to a distribution list. When Optimizely receives your final approval, the mailing is
sent to recipients on the distribution list as scheduled.
Sending report. Within two work days of the sending date, you receive an initial report
containing the following information (in both diagrams and data). You get a final report
within ten work days.
o
o

Recipients
Emails opened
unique opens
n opens over time
Opening rate (%)
Clicks
n

o
o

unique clicks
n clicks over time
n total clicks by link
Click-rate (%) and effective unique click-rate (%)
Number of responses and response rate (%)
Number of unsubscriptions and unsubscribe rate (%)
n

o
o
o
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Trainings
Let the professionals educate you - live or via recorded video training. Optimizely offers a
range of regular and customized training formats aimed at both beginners and experienced users. If you would like individual training, please contact customer support.

Individual trainings
Web-based
With an individual, web-based training you will learn how to use the software in a very
short time. The training courses are held for up to five participants with the help of the
web learning software Zoom. Optimizely uses realistic scenarios to teach the basic functions of Optimizely Campaign. If you would like to add more topics to the training, you can
discuss the content with the trainer in advance and make an appointment. The training
courses last from one and a half hours to a maximum of two hours. The participants need a
telephone and Internet access for the briefing.

On-site
This training format is suitable for getting to know the software intensively and for conveying special scenarios. Optimizely develops a training program with tasks and gives an
intensive introduction into the use of Optimizely Campaign. The standard modules include
recipient import and administration, creating and sending mailings, creating and interpreting reports. On request, we can integrate content and exercises into the training that
correspond to your specific application scenarios. After the training, all participants
receive handouts. The training is designed for a maximum of five participants. Premises, a
projector, a computer for the trainer and, if possible, one computer for each participant (all
computers must have an Internet connection) are provided by you.
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Scheduled jobs
On request, customer support sets up scheduled jobs for you that automate regular tasks
like recipient list based import and export. CSV files form the basis for regular automatic
imports and exports.

Scheduled jobs overview
Note: To enable this feature, contact customer support.
To view the scheduled jobs configured in your client, open the Optimizely Campaign menu
and select Administration > Scheduled Jobs. To display job details, select a scheduled
job from the list.
You can also use the Optimizely Campaign REST API to retrieve information on which
scheduled jobs are configured or running in your client.

Configuring scheduled jobs
Note: To use this feature, you need an SCP account that Optimizely
customer support has set up for you. Contact customer support if you
do not have an account yet.
You can find a selection of available scheduled jobs under Scheduled jobs on Optimizely
World. Click a job to open a description page that contains a link to the corresponding
online form.
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To use the online form, you need to log in to Optimizely World or create a new account
within a few steps. Open the form and fill in all mandatory fields and add optional information.
Note: Upon submission of the form, processing fees are incurred in
the amount of the contractually agreed support costs. If there are
additional setup costs besides the processing fee, customer support
will contact you with an offer.
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Automatic data import
Automatic import jobs let you synchronize your external distribution list with Optimizely
Campaign's recipient lists. You can decide whether the import should take place daily,
weekly or monthly.
The file is transmitted via SCP (Secure Copy Protocol) and stored on a server provided by
Optimizely. The import to your client is handled automatically. You receive a success notification after each import.
Optimizely Campaign supports automatic recipient list imports, automatic blocklist imports
and unsubscriber imports.

Automatic data export
The automatic recipient export writes list entries from Optimizely Campaign to a CSV file
and stores it on a server provided by Optimizely. You can then download the CSV file automatically or manually from this server.
Optimizely Campaign supports automatic recipient list export, automatic blocklist export,
automatic unsubscriber exports and outbounced recipients exports.

Other features
In addition to the import and export jobs, there are more features such as the dispatch of
the latest mailing after double opt-in feature that automatically sends the last mailing to
newly registered recipients when they have gone through the double opt-in process.
For more information on available jobs and features, see Scheduled jobs on Optimizely
World.
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Optimizely Digital Experience
Platform
The Optimizely Digital Experience Platform unifies digital content, commerce and marketing in one platform, including omnichannel solutions for intelligent campaigns. The
platform uses artificial intelligence and behavioral analytics to deliver personalized experiences everywhere. With our secure, reliable platform you can quickly increase engagement, revenue and productivity, while getting the fastest time to value.

About Optimizely
At Optimizely, we're on a mission to help people unlock their digital potential. We equip teams
with the tools and insights they need to experiment in new and novel ways. Now, companies
can operate with data-driven confidence to create hyper-personalized experiences. Building
sophisticated solutions has never been simpler. Learn how we unleash new limits at optimizely.com.

www.optimizely.com

